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calibre is een e-boekbibliotheek manager. Het kan e-boeken bekĳken, converteren en catalogiseren in de meeste grote
e-boekformaten. Het kan ook praten met veel e-boek readers. Het kan naar internet gaan en metadata voor uw boeken
ophalen. Het kan kranten downloaden en omzetten in e-boeken voor gemakkelĳke lezen. Het is cross platform, draait op
Linux, Windows en MacOS.
U bent net begonnen met het gebruik van calibre. Hoe moet het verder? Voor calibre iets kan doen met uw e-boeken,
moet het ze leren kennen. Sleep een aantal e-boeken in calibre, of klik op de “boeken toevoegen” knop en blader voor de
e-boeken die u wil gebruiken. Eenmaal de boeken zĳn toegevoegd, verschĳnen ze in het hoofdscherm zoals hieronder:

Zodra u de lĳst met boeken hebt bewonderd die u zojuist hebt toegevoegd, wilt u er waarschĳnlĳk een lezen. Om dat te
doen, moet u het boek converteren naar een formaat dat uw reader begrĳpt. Bĳ het eerste gebruik van Calibre wordt de:
guilabel: Welkom wizard gestart en wordt calibre voor uw reader ingesteld. Conversie is een eitje. Selecteer gewoon het
boek dat u wilt converteren en klik op de knop “Boeken converteren”. Negeer voor nu alle opties en klik op “OK”. Het
kleine pictogram in de rechterbenedenhoek begint te draaien. Als het klaar is met draaien, is uw geconverteerde boek
klaar. Klik op de knop “Bekĳken” om het boek te lezen.
Als u een boek op uw reader wil lezen, sluit de reader aan op de pc en wacht tot calibre hem detecteert (10-20 seconden).
Klik vervolgens op de knop “Verzenden naar toestel”. Zodra het pictogram stopt met draaien, afkoppelen en lezen! Als
u het boek niet geconverteerd heeft bĳ de vorige stap, zal calibre het boek converteren naar het formaat dat uw reader
begrĳpt.
Voor meer geavanceerd gebruik, zou u moeten lezen overDeGrafische Gebruikersinterface (pagina 3). Voor nog krachtiger
functies, leer Opdrachtpromt (pagina 305). Tevens zal u de lĳst Veel gestelde vragen (pagina 131) nuttig vinden.
Als u meer vragen hebt, of calibre wilt bespreken met ander gebruikers of hulp vragen met specifieke dingen, er zĳn
forums en andere hulpbronnen beschikbaar1.

Paragrafen

1 https://calibre-ebook.com/nl/help
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De Grafische Gebruikersinterface

De Grafische Gebruikersinterface (GUI) biedt toegang tot alle bibliotheekbeheer en e-bookformaat conversie functies.
De basis werkstroom voor gebruik van calibre is eerst boeken toevoegen aan de bibliotheek van uw harde schĳf. calibre
probeert automatisch de metadata te lezen uit de boeken en toe te voegen aan de interne database. Als ze in de database
zitten, kunt u er verschillende: ref: actions op uitvoeren, zoals conversie van één formaat naar een ander, overbrengen naar
de e-reader, bekĳken op uw pc en bewerken van de metadata. Dat laatste omvat o.a. wĳzigen van de omslag, omschrĳving
en labels. Merk op dat calibre kopieën maakt van de bestanden die u toevoegt. Uw originele bestanden blĳven onaangetast.
De weergave is verdeeld in verschillende secties:

• Acties (pagina 4)
• Voorkeuren (pagina 10)
• Catalogi (pagina 11)
• Zoeken & sorteren (pagina 11)
• De zoek interface (pagina 12)
• Zoekopdrachten opslaan (pagina 17)
• Searching the full text of all books (pagina 18)
• Virtuele bibliotheken (pagina 18)
• Temporarily marking books (pagina 18)
• Raadt metadata op basis van bestandsnamen (pagina 18)
• Boekgegevens (pagina 20)
• Labelbrowser (pagina 22)
• Omslagenrooster (pagina 25)
• Omslagbrowser (pagina 26)
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• Adding notes for authors, series, etc. (pagina 27)
• Snel-weergave (pagina 28)
• Taken (pagina 29)
• Toetsenbord sneltoetsen (pagina 29)

1.1 Acties

De acties werkbalk biedt handige snelkoppelingen naar veelgebruikte acties. Als u met de rechtermuisknop op de knoppen
klikt, kunt u variaties op de standaardactie uitvoeren. Houd er rekening mee dat de acties werkbalk er enigszins anders
uit zal zien, afhankelĳk van of u een e-boek reader op uw computer hebt aangesloten.

• Boeken toevoegen (pagina 4)
• Metadata bewerken (pagina 5)
• Boeken converteren (pagina 6)
• Tonen (pagina 6)
• Naar apparaat sturen (pagina 6)
• Nieuws ophalen (pagina 7)
• Bibliotheek (pagina 7)
• Apparaat (pagina 8)
• Op schĳf opslaan (pagina 9)
• Verbinden/delen (pagina 9)
• Boeken verwĳderen (pagina 10)

1.1.1 Boeken toevoegen

The Boeken toevoegen actie heeft zeven verschillende opties bĳ rechter muisklik op de knop.
1. Boeken toevoegen uit een map: Opent een bestandskiezer en laat u opgeven welke boeken uit een map toe te

voegen. Deze actie is contextgevoelig d.w.z. het hangt ervan af welke catalogus (pagina 11) u heeft geselecteerd.
Indien u de Bibliotheek heeft geselecteerd, worden de boeken aan de bibliotheek toegevoegd. Heeft u de e-reader
geselecteerd worden de boeken geüpload naar het toestel enz.

2. Boeken toevoegen uit mappen en submappen: Laat u een map kiezen. De map en al z’n submappen worden
recursief doorzocht en gevonden e-boeken worden toegevoegd aan de bibliotheek. U kan kiezen tussen calibre alle
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bestanden in een map aan één enkel boek record of meerdere records laten toevoegen. calibre gaat ervan uit dat
elke map een enkel boel bevat. Alle e-boekbestanden in een map worden verondersteld hetzelfde boek te zĳn in
verschillende formaten. Deze actie is het omgekeerde van Opslaan op schĳf (pagina 9) , d.w.z. u kunt Opslaan op
schĳf, de boeken verwĳderen en opnieuw toevoegen in één boek per map modus zonder informatie te verliezen
behalve de datum (ervan uitgaande dat u geen instellingen heeft gewĳzigd voor de Opslaan op schĳf actie).

3. Meerdere boeken toevoegen uit archief (ZIP/RAR): Laat u meerdere e-boeken toevoegen opgeslagen in de
geselecteerde ZIP of RAR bestanden. Een handige optie die vermĳdt eerst de ZIP archieven uit te pakken en dan
de boeken toe te voegen met een van de twee opties boven.

4. Voeg leeg boek toe (Boek record zonder formaat) Laat u toe een blanco boek record te maken. Kan gebruikt
worden om later manueel de informatie in te vullen van een boek dat u nog niet in uw collectie heeft.

5. Toevoegen van ISBN: Toestaan om boeken toe te voegen door gebruik van ISBN-nummers.
6. Voeg bestanden toe aan geselecteerde boekrecords: Laat u bestanden van een bestaand boek in uw bibliotheek

toevoegen of aanpassen.
7. Add data files to selected book records: Allows you to add any number of extra files that will be stored in a data

sub-directory in the book directory. See Adding extra data files to a book (pagina 129) for details.
8. Voeg leeg bestand toe aan geselecteerde boek records*: Laat toevoegen van leeg bestand van gespecificeerde formaat

aan geselecteerde boek records toe.
De actie Boeken toevoegen kan de metadata lezen van vele e-boekformaten. Daarnaast probeert het de metadata te ra-
den uit de bestandsnaam. Zie de sectie Raadt metadata op basis van bestandsnamen (pagina 18) om te leren hoe dit te
configureren.
Om een bĳkomend formaat toe te voegen aan een bestaand boek kan u drie dingen doen:

1. Sleep het bestand en zet het neer op het Boek details paneel rechts in het hoofdvenster
2. Klik rechts op het Boeken toevoegen en kies Voeg bestanden toe aan geselecteerde boeken.
3. Klok op de:guilabel:Boeken toevoegen knop rechtsboven in de Metadata bewerken dialoog, toegang via de

:ref:``edit_meta_information` actie.

1.1.2 Metadata bewerken

De Metadata bewerken actie heeft vier verschillende opties die zichtbaar worden door rechts te
klikken op de knop.

1. Metadata individueel bewerken: Laat u metadata van boeken één voor één bewerken met de optie om metadata,
inclusief omslagen, op te halen van internet. Laat u ook bepaalde e-boekformaten van een boek toevoegen of
verwĳderen.

2. Metadata bewerken in bulk: Laat u veel gebruikte velden van metadata voor grote hoeveelheden boeken tegelĳk
bewerken. Heeft effect op alle boeken geselecteerd in de Bibliotheek weergave (pagina 11).

3. Metadata en omslagen downloaden: Downloadt metadata en omslag (indien beschikbaar) voor de geselecteerde
boeken.

4. Boekrecords samenvoegen: Laat u metadata en formaten van twee of meer boekrecords samenvoegen. U kunt
kiezen om de records die niet eerst werden aangeklikt te verwĳderen of te behouden.

5. Manage data files: Manage the extra data files associated with the selected books.
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Voor meer details, zie Metadata van e-boeken aanpassen (pagina 127).

1.1.3 Boeken converteren

E-boeken kunnen geconverteerd worden van een aantal formaten in elk formaatdat uw e-reader
bevalt. Vele e-boeken te koop zĳn beschermd door Digital Rights Management (pagina 375) (DRM) technologie. calibre
zal deze e-boeken niet converteren. Het is gemakkelĳk om het DRM te verwĳderen van vele formaten, maar omdat dat
mogelĳk illegaal is, moet u zelf het gereedschap vinden om uw boeken te bevrĳden en daarna calibre gebruiken om ze te
converteren.
Meestal is een conversie een kwestie van één muisklik. Als u meer wilt weten over het conversieproces, ga naar E-boek
conversie (pagina 61).
De Convert books actie heeft drie verschillende opties die zichtbaar worden door rechts te klikken op de knop.

1. Individueel converteren: Laat u de conversieopties instellen om de conversie van elk geselecteerd e-boek aan te
passen.

2. Bulk converteren: Laat u eenmalig keuzes opgeven om een aantal e-boeken tegelĳk te converteren.
3. Catalogus maken van de boeken in uw calibre bibliotheek: Laat u een volledige lĳst genereren van de boeken

in uw bibliotheek, inclusief alle metadata, in meerdere formaten zoals XML, CSV, BIBTeX, EPUB en MOBI.
Deze catalogus bevat alle boeken momenteel getoond in de bibliotheekweergave. Dit laat u toe de zoekfunctie te
gebruiken om het aantal boeken dat gecatalogiseerd wordt te beperken. Als u daarnaast meerdere boeken selecteert
met behulp van de muis, worden alleen deze boeken toegevoegd aan de catalogus. Indien u de catalogus genereert
in een e-boek formaat zoals EPUB, MOBI of AZW3 zal de volgende keer als u verbindt met uw e-boekreader de
catalogus automatisch verzonden worden naar het toestel. Voor meer informatie over hoe een catalogus werkt, lees
Creëren van AZW3 • EPUB • MOBI-catalogi (pagina 245).

1.1.4 Tonen

De Tonen actie toont het boek in een e-boekreader. calibre heeft een ingebouwde reader voor veel
e-boekformaten. Voor andere formaten gebruikt het de standaard applicatie van het besturingssysteem. U kunt instel-
len welke formaten met de interne reader moeten worden geopend via Voorkeuren → Interface → Gedrag. Als een boek
meerdere formaten heeft, kunt u een bepaald formaat weergeven met een rechterklik op de knop.

1.1.5 Naar apparaat sturen

De Naar apparaat sturen actie heeft acht verschillende opties die zichtbaar worden door rechts
te drukken op de knop.
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1. Naar hoofdgeheugen: De geselecteerde boeken worden overgedragen naar het hoofdgeheugen van de e-reader.
2. Naar kaart (A): De geselecteerde boeken worden overgedragen naar de geheugenkaart (A) van de e-reader.
3. Naar kaart (B): De geselecteerde boeken worden overgedragen naar de geheugenkaart (B) van de e-reader.
4. Bepaald formaat naar: De geselecteerde boeken worden overgedragen naar de geselecteerde locatie van het ap-

paraat en in het formaat dat u opgeeft.
5. Apparaat uitwerpen: Verbreekt verbinding tussen Calibre en het apparaat.
6. Standaard naar apparaat actie instellen: Hier kunt u welke van de opties 1 t/m 5 hierboven of 7 hieronder de

standaard actie wordt wanneer u op de hoofdknop klikt.
7. Verstuur en verwĳder uit bibliotheek: De geselecteerde boeken worden overgedragen naar de geselecteerde

locatie op het apparaat en verwĳderd uit de Bibliotheek.
8. Aantekeningen ophalen (experimenteel): Draagt aantekeningen die u heeft gemaakt bĳ een e-boek op uw toestel

over naar de commentaren-metadata van het boek in de calibre bibliotheek.
U kunt bestandsnaam en mapstructuur van bestanden verstuurd naar het apparaat bepalen door een sjabloon in te stellen
in Voorkeuren → Import/Export → Boeken versturen naar toestellen. Lees meer De calibre sjabloontaal (pagina 162).

1.1.6 Nieuws ophalen

De Nieuws ophalen actie downloadt nieuws van diverse websites en converteert dit in een e-boek dat
gelezen kan worden op uw e-reader. Normaal wordt het nieuw aangemaakte e-boek toegevoegd aan uw bibliotheek, maar
als een e-reader verbonden is als de download stopt, wordt het nieuws automatisch geüpload naar de e-reader.
De Nieuws ophalen actie gebruikt simpele recepten (10-15 regels code) voor elke nieuwssite. Om te leren hoe u een recept
kunt maken voor uw eigen nieuwsbron, zie Uw favoriete nieuws website toevoegen (pagina 33).
De Nieuws ophalen actie heeft drie opties, toegankelĳk via rechts klikken op de knop.

1. Schema nieuws download: Met deze optie kunt u de download inplannen voor uw geselecteerde nieuwsbronnen
van een lĳst van honderden die beschikbaar zĳn. Voor elke nieuwsbron kunt u een schema instellen en is flexibel
zodat u specifieke weekdagen kunt selecteren of het aantal dagen tussen downloads.

2. Een aangepaste nieuwsbron toevoegen: Laat u een eenvoudig recept creëren om nieuws te downloaden van een
speciale nieuwssite die u wilt gebruiken. Het recept creëren kan zo simpel zĳn als een RSS nieuws-feed URL
specificeren, of u kunt meer normatief zĳn door Python gebaseerde code te creëren voor de taak. Voor meer
informatie, kĳk op Uw favoriete nieuws website toevoegen (pagina 33).

3. Alle ingeplande nieuwsbronnen downloaden: Hiermee zal Calibre onmiddellĳk beginnen met het downloaden
van alle nieuwsbronnen die u heeft ingepland.

1.1.7 Bibliotheek

Met de Bibliotheek actie kunt u een Bibliotheek aanmaken, schakelen tussen, hernoemen of verwĳ-
deren. U maar zo veel bibliotheken aanmaken als u wilt. U kunt bĳvoorbeeld een fictie-bibliotheek aanmaken, eentje
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voor non-fictie, eentje voor vreemde talen, een projecten bibliotheek of elke structuur die u wenst. Bibliotheken zĳn
de hoogste organisatorische structuren binnen Calibre. Elke bibliotheek heeft zĳn eigen boeken, labels, categorieën en
geheugenlocaties.

1. Bibliotheek schakelen/aanmaken…: Met deze optie kunt u: a) verbinding opnemen met een bestaande biblio-
theek op een andere locatie, b) een lege bibliotheek aanmaken op een nieuwe locatie of c) de huidige bibliotheek
verplaatsen naar een nieuw te specificeren locatie.

2. Snel schakelen: Met deze optie kunt u schakelen tussen bibliotheken die aangemaakt zĳn binnen Calibre.
3. Bibliotheek hernoemen: Hiermee kunt u een Bibliotheek een andere andere naam toekennen.
4. Neem een willekeurig boek: Kiest een willekeurig boek voor u uit de bibliotheek
5. Bibliotheek verwĳderen: Laat u toe een bibliotheek te deregistreren uit calibre.
6. Export/import van alle calibre data: Laat u toe ofwel calibre data te exporteren voor migratie naar een nieuwe

pc ofwel vroeger geëxporteerde data te importeren.
7. <library name>: Acties 7, 8 enz… kunt u meteen wisselen tussen meerdere bibliotheken die u heeft gemaakt of

naar gelinkt. Deze lĳst bevat enkel de 5 meest gefrequenteerde bibliotheken. Voor de hele lĳst, gebruik het Snelle
Wissel menu.

8. Bibliotheek onderhouden: Met deze optie kunt u de huidige bibliotheek controleren op gegevens-consistentie en
de gegevensbank van de huidige bibliotheek herstellen van back-ups.

Notitie

Metadata over uw e-boeken, bv. titel, auteur en labels, zit in een enkel bestand in uw calibre bibliotheekmap, meta-
data.db genaamd. Als dit bestand beschadigd wordt (gebeurt zeer zelden) kunt u de metadata kwĳt raken. Gelukkig
back-upt calibre automatisch de metadata van elk boek in z’n map als een OPF bestand. Met de Database herstel-
len actie onder Bibliotheekonderhoud zoals boven beschreven, kunt u calibre het bestand metadata.db opnieuw laten
opbouwen met de individuele OPF-bestanden.

U kunt boeken kopiëren of verplaatsen tussen verschillende bibliotheken (nadat u meer dan een bibliotheek heeft ingericht)
door rechts te klikken op het boek en de actie te kiezen Kopieer naar bibliotheek.

1.1.8 Apparaat

Met de Apparaat optie kunt u boeken lezen in de hoofdopslag of opslagkaarten van uw apparaat of the
apparaat uitwerpen (loskoppelen van Calibre). Dit pictogram wordt automatisch getoond op de hoofdwerkbalk in Calibre
wanneer u een apparaat aansluit dat wordt ondersteund. U kunt erop klikken om de boeken te bekĳken op uw apparaat.
U kunt ook boeken van uw Calibre bibliotheek slepen en neerzetten op het pictrogram om deze over te dragen op uw
apparaat. Andersom kunt u boeken verslepen en plaatsen van uw apparaat op het bibliotheek-icon van de werkbalk om
boeken over te dragen van uw apparaat naar de Calibre bibliotheek.

8 Hoofdstuk 1. De Grafische Gebruikersinterface
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1.1.9 Op schijf opslaan

Het opslaan op disk heeft 5 variaties, deze vind u door een rechterklik te geven op de knop.
1. Opslaan op schĳf: Slaat de geselecteerde boeken op op de schĳf, georganiseerd il mappen. De map-

structuur lĳkt op

Author_(sort)

Title

Book Files

U kan de bestandsnaam en mapstructuur van op schĳf opgeslagen bestanden controleren door een template
in te stellen in Voorkeuren → Import/export → Boeken opslaan op schĳf. Kĳk ook bĳ De calibre sjabloontaal
(pagina 162).

2. Opslaan op schĳf in één map: Slaat de geselecteerde boeken op op de schĳf in één map.
Voor 1. en 2. worden alle beschikbare formaten naast metadata op schĳf opgeslagen voor elk geselecteerd
boek. Metadata wordt bewaard in een OPF-bestand. Opgeslagen boeken kunnen opnieuw geïmporteerd wor-
den in de bibliotheek zonder gegevensverlies met behulp van de optie Boeken toevoegen (pagina 4).

3. Bewaar alleen *<your preferred>* formaten op schĳf: Slaat de geselecteerde boeken op op schĳf
in de mapstructuur getoond in (1.) maar enkel in uw geprefereerd e-boekformaat. U kunt uw voor-
keursformaat instellen in Voorkeuren → Interface → Gedrag → Voorkeur uitvoerformaat

4. Bewaar alleen *<your preferred>* formaat op schĳf in één map: Slaat geselecteerde boeken op
op schĳf in een enkele map maar enkel in uw e-boek voorkeursformaat. U kunt uw voorkeursformaat
instellen in Voorkeuren → Interface → Gedrag → Voorkeur uitvoerformaat

5. Bewaar enkel formaat op schĳf…: Slaat de geselecteerde boeken op op schĳf in de mapstructuur
getoond in (1.) maar enkel in het formaat dat u kiest uit de pop-uplĳst.

1.1.10 Verbinden/delen

De Verbinden/delen actie laat u handmatig verbinden met een toestel of map op uw computer. Het
laat u ook toe uw calibre bibliotheek in te stellen voor toegang per webbrowser of e-mail.

De Verbinden/delen actie heeft vier varianten, toegankelĳk via een rechtse klik op de knop.
1. Verbinden met map: Met deze optie kunt u een verbinding maken met elke map op uw computer

alsof het een apparaat is en gebruik maken van alle faciliteiten die Calibre biedt aan apparaten. Nuttig
als uw apparaat niet ondersteund wordt door Calibre maar wel verbonden is met een USB-aansluiting.

2. Content server starten: Start calibre’e ingebouwde webserver. Na opstarten is uw calibre bibliotheek
toegankelĳk met een webbrowser vanaf het internet (indien gewenst). U kunt instellen hoe de webserver
toegankelĳk is door voorkeuren in te stellen op Voorkeuren → Delen → Delen over het net

3. Instellen e-mail gebaseerd delen van boeken: Hiermee kunt u boeken delen en mailinglĳsten per e-
mail. Nadat u e-mailadressen heeft ingericht, verstuurd Calibre nieuws- en boeken-updates naar de in-
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gevoerde e-mailadressen. U kunt instellen hoe Calibre de e-mails verstuurd in de voorkeursinstellingen
op Voorkeuren → Delen → Boeken delen per e-mail. Wanneer u eenmaal een of meer e-mailadressen
heeft ingericht, zal deze optie worden vervangen door opties om boeken te versturen naar de ingevoerde
e-mailadressen.

1.1.11 Boeken verwijderen

De Boeken verwĳderen actie verwĳdert boeken voorgoed, voorzichtig gebruiken dus. Het is
contextgevoelig, d.w.z. hangt af van welke catalogus (pagina 11) u heeft geselecteerd. Wanneer u Bibliotheek heeft gese-
lecteerd worden boeken verwĳderd uit de bibliotheek. Hebt u de e-reader geselecteerd, worden boeken verwĳderd uit
het toestel. Om enkel een specifiek formaat van een boek te verwĳderen, gebruik de Metadata bewerken (pagina 5) actie.
Boeken verwĳderen heeft ook vĳf opties toegankelĳk door rechts te klikken op de knop.

1. Geselecteerde boeken verwĳderen: Hiermee verwĳdert u alle boeken voorgoed die geselecteerd zĳn in het boe-
kenoverzicht.

2. Bestanden verwĳderen van een bepaald formaat van geselecteerde boeken…: Hiermee verwĳdert u voorgoed
e-boekbestanden van een bepaald formaat van boeken geselecteerd in de boekenlĳst.

3. Alle formaten verwĳderen van geselecteerde boeken, behalve…: Hiermee verwĳdert u voorgoed e-
boekbestanden van elk formaat behalve een bepaald formaat van boeken geselecteerd in de boekenlĳst.

4. Alle formaten verwĳderen van geselecteerde boeken: Hiermee verwĳdert u voorgoed alle e-boekbestanden van
boeken geselecteerd in de boekenlĳst. Alleen metadata blĳven over.

5. Opslagen verwĳderen van geselecteerde boeken: Hiermee kunt u afbeeldingen van omslagen voorgoed verwĳ-
deren van boeken die geselecteerd zĳn in het boekenoverzicht.

6. Overeenkomende boeken verwĳderen van toestel: Met deze optie verwĳdert u e-boekbestanden van een ver-
bonden apparaat die overeenkomen met boeken geselecteerd in de boekenlĳst.

7. Restore recently deleted: Allows you to undo the removal of books or formats.

Notitie

Note that when you use Remove books to delete books from your calibre library, the book record is deleted, but the
books are temporarily stored, for a few days, in a trash folder. You can undo the delete by right clicking the Remove
books button and choosing to Restore recently deleted books.

1.2 Voorkeuren

Met de Voorkeuren actie kunt u de werkwĳze van Calibre aanpassen. Er zĳn vier opties die zichtbaar
worden door rechts op de knop te klikken.
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1. Voorkeuren: Hiermee kunt u de werkwĳze van Calibre op een aantal punten aanpassen. Het klikken op de knop
voert deze actie ook uit.

2. Welkom wizard starten: Laat u de Welkom wizard starten die zichtbaar werd toen u calibre voor de eerste keer
starte.

3. Plugins ophalen omCalibre uit te breiden: Opent een nieuw venster dat plugins toont voor Calibre. Deze plugins
zĳn ontwikkeld door derden om de functionaliteit van Calibre uit te breiden.

4. Herstarten in debug modus: Hiermee kunt u de foutenopsporing activeren die Calibre-ontwikkelaars helpen om
problemen op te lossen waar u eventueel tegenaan loopt. Voor de meeste gebruikers moet dit uitgeschakeld blĳven
behalve als u gevraagd wordt door een ontwikkelaar om deze optie te activeren.

1.3 Catalogi

Een catalogus is een verzameling boeken. Calibre kan twee soorten catalogi beheren:
1. Bibliotheek: Dat is een verzameling boeken die bewaard worden in uw Calibre bibliotheek op uw computer.
2. Toestel: Dat is een verzameling boeken die bewaard wordt in uw e-reader. Deze wordt beschikbaar als u de reader

verbindt met uw computer.
Veel bewerkingen zoals toevoegen van boeken, verwĳderen, bekĳken enz. zĳn contextgevoelig. Als u bv. op de Tonen knop
klikt wanneer u de Toestel catalogus heeft geselecteerd, zal calibre de bestanden op het toestel openen om te tonen. Als
u de Bibliotheek catalogus heeft geselecteerd, worden in plaats daarvan de bestanden in uw calibre bibliotheek geopend.

1.4 Zoeken & sorteren

Met Zoeken & Sorteren kunt u enkele krachtige acties uitvoeren op uw boekenverzamelingen.
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• U kunt ze sorteren op titel, auteur, datum, waardering etc. door op de kolomnamen te klikken. U kunt ook hi-
erarchisch op meerdere kolommen sorteren. Als u bĳvoorbeeld klikt op de titel-kolom en daarna de auteur-kolom
zullen de boeken worden gesorteerd op auteur en dan alle boeken van dezelfde auteur op titel.

• U kan naar een bepaald boek of boekenset zoeken via de Zoekbalk. Meer hierover hieronder.
• U kan snel en eenvoudig metadata bewerken door de door het item te selecteren dat u wilt veranderen en te drukken

pop de E toets.
• U kan Acties (pagina 4) uitvoeren op boekensets. Om meerdere boeken te selecteren kan u ofwel:

– Houd de Ctrl-toets ingedrukt en klik op de te selecteren boeken.
– Houd de Shift-toets ingedrukt en klik op het eerste en laatste boek van een te selecteren boekenreeks.

• U kunt instellen welke velden getoond worden met behulp van de Voorkeuren (pagina 10)-dialoog.
• To perform complex multiple column based sub-sorting add the Sort by tool to a toolbar via Preferences → Toolbars

& menus.

1.5 De zoek interface
U kunt alle boek-metadata doorzoeken door zoektermen in te voeren in de Zoekbalk. Bĳvoorbeeld:

Asimov Foundation format:lrf

Alle boeken in uw bibliotheek die Asimov en Foundation in hun metadata hebben staan en beschikbaar zĳn in LRF
formaat worden gevonden. Nog een paar voorbeelden:

author:Asimov and not series:Foundation

title:"The Ring" or "This book is about a ring"

format:epub publisher:feedbooks.com

Zoek soorten

Er zĳn vier zoeksoorten: bevat, gelĳk aan, reguliere expressie (bekĳk regular expressions2), en karakter variant. U kiest
de zoeksoort met een voorvoegsel karakter.
‘Bevat’ opzoeking

Opzoekingen zonder voorvoegselkarakter zĳn bevat en zĳn standaard hoofdletterongevoelig. Een item komt overeen als
de zoekstring eender waar voorkomt in de aangeduide metadata. U kan bevat opzoekingen hoofdlettergevoelig maken
door de optie Hoofdlettergevoelig zoeken aan te vinken in Voorkeuren / Zoeken. Als de zoekoptie Karakters zonder accent
komen overeen met die met accent en interpunctie wordt genegeerd is aangevinkt, komt een karakter overeen met al z’n
varianten (bv e komt overeen met é, è, ê en ë) en alle interpunctie en witte ruimte wordt genegeerd. Als bv. de Karakters
zonder accent… is aangevinkt, in geval van de rwee boektitels:

1. Big, Bothéred, and Bad
2. Big Bummer

deze opzoekingen vinden dan:
• title:"er" komt met beiden overeen (‘e’ met zowel ‘é’ als ‘e’).
• title:"g " komt met beiden overeen want spaties worden genegeerd.
• title:"g " komt met beiden overeen want de komma wordt genegeerd.
• title:"gb" komt met beiden overeen want ‘, ‘ wordt genegeerd in boek 1 en spaties in boek 2.

2 https://en.wikipedia.org/wiki/Regular_expression
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• title:"g b" komt met beiden overeen want komma en spatie worden genegeerd.
• title:"db" komt overeen met #1 want de spatie in ‘and Bad’ wordt genegeerd.
• title:"," komt met beiden overeen (komt eigenlĳk met alle boeken overeen) want komma’s worden genegeerd.

Als de Karakters zonder accent… optie niet is aangevinkt zĳn alle karakter varianten, interpunctie en spatiëring van
betekenis.
U kan slechts één van de zoekopties Hoofdlettergevoelig zoeken en Karakters zonder accent komen overeen met die met en
interpunctie wordt genegeerd.
‘Gelĳk aan’ opzoeking

Gelĳk aan opzoekingen worden aangegeven door de zoekstring te laten voorafgaan door een “is gelĳk aan” teken (=). Bv
de opzoeking tag:"=science" komt overeen met science, maar niet science fiction of hard science. Karaktervarianten
zĳn van betekenis: é komt niet overeen met e.
Two variants of equality searches are used for hierarchical items (e.g., A.B.C): hierarchical prefix searches and hierarchical
component searches. The first, indicated by a single period after the equals (=.) matches the initial parts of a hierarchical
item. The second, indicated by two periods after the equals (=..) matches an internal name in the hierarchical item.
Examples, using the tag History.Military.WWII as the value:

• tags:"=.History" : Waar. History is een voorvoegsel van het label.
• tags:"=.History.Military" : Waar. History.Military is een voorvoegsel van het label.
• tags:"=.History.Military.WWII" : Waar. History.Military.WWII is een voorvoegsel van het label, zĳ

het een onpassend.
• tags:"=.Military" : Onwaar. Military is geen voorvoegsel van het label.
• tags:"=.WWII" : Onwaar. WWII is geen voorvoegsel van het label.
• tags:"=..History" : Waar. De hiërarchie bevat de waarde History.
• tags:"=..Military" : Waar. De hiërarchie bevat de waarde Military.
• tags:"=..WWII" : Waar. De hiërarchie bevat de waarde WWII.
• tags:"=..Military.WWII" : Onwaar. De .. opzoeking kĳkt naar enkelvoudige waardes.

‘Reguliere expressie’ opzoekingen

Regular expression searches are indicated by prefixing the search string with a tilde (~). Any Python-compatible regular
expression3 can be used. Backslashes used to escape special characters in regular expressions must be doubled because
single backslashes will be removed during query parsing. For example, to match a literal parenthesis you must enter \\(
or alternatively use super-quotes (see below). Regular expression searches are ‘contains’ searches unless the expression is
anchored. Character variants are significant: ~e doesn’t match é.
‘Karakter variant’ opzoekingen

Karakter variant opzoekingen geeft u aan door de zoekstring te laten voorafgaan door een caret (^). Deze opzoeking is
vergelĳkbaar met de bevat opzoeking (boven) behalve dat:

• hoofdlettergebruik wordt altĳd genegeerd
• karakter varianten komen altĳd overeen
• interpunctie en witte ruimte/spaties zĳn altĳd belangrĳk

De zoekopties Karakters zonder accent komen overeen met die met en interpunctie wordt genegeerd en Hoofdlettergevoelig
zoeken worden genegeerd. Ze hebben geen effect op het gedrag van deze opzoeking.

3 https://docs.python.org/library/re.html
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Het volgende vergelĳkt deze opzoeking met een bevat opzoeking ervan uitgaand dat de Karakters zonder accent… optie
is aangevinkt (zie boven) met twee dezelfde boektitels:

1. Big, Bothéred, and Bad
2. Big Bummer

dan vinden deze karaktervariant opzoekingen:
• title:"^er" komt met beiden overeen (‘e’ met zowel ‘é’ als ‘e’).
• title:"^g" komt met beiden overeen
• title:"^g " komt met #2 overeen want de spatie is van betekenis
• title:"^g " komt met #1 overeen want de komma is van betekenis
• title:"^gb " komt met niets overeen want de komma en de spatie zĳn van betekenis
• title:"^g b" komt met #2 overeen want de komma is van betekenis
• title:"^db" komt met niets overeen
• title:"^, " komt met #1 overeen (ipv alle boeken) want de komma is van betekenis

Zoekopdracht Syntaxis

Een zoekexpressie is een opeenvolging van zoektermen optioneel gescheiden door de operatoren and en or. Twee zoekter-
men zonder scheidende operator duiden op and. De and operator heeft prioriteit op de or operator; bv: de de expressie
a or b and c is hetzelfde als a or (b and c). U kan haakjes gebruiken om de prioriteit te veranderen; bv (a or

b) and c laat de or evalueren voor de and. U kan de operator not gebruiken om het resultaat van het evalueren van
een zoekexpressie om te keren. Voorbeelden:

• not tag:foo vind alle boeken die het label foo niet bevatten
• not (author:Asimov or author:Weber) vind alle boeken niet geschreven door Asimov of Weber.

The above examples show examples of search terms. A basic search term is a sequence of characters not including spaces,
quotes ("), backslashes (\), or parentheses (( )). It can be optionally preceded by a column name specifier: the lookup
name of a column followed by a colon (:), for example author:Asimov. If a search term must contain a space then
the entire term must be enclosed in quotes, as in title:"The Ring". If the search term must contain quotes then they
must be escaped with backslashes. For example, to search for a series named The “Ball” and The “Chain”, use:

series:"The \"Ball\" and The \"Chain\"

Als u echt een schuine streep links nodig hebt, iets dat regelmatig gebeurt in reguliere expressie opzoekingen, gebruik er
dan twee (\\).
It is sometimes hard to get all the escapes right so the result is what you want, especially in regular expression and template
searches. In these cases use the super-quote: """sequence of characters""". Super-quoted characters are used
unchanged: no escape processing is done.
“Meer informatie”
Om te zoeken naar een string die begint met een is gelĳk aan, tilde of caret, zet een schuine streep links voor de string.
Omsluit zoekstrings met aanhalingstekens (”) als de string haakjes of spaties bevat. Bv. om boeken te zoeken met het label
Science Fiction moet u zoeken naar tag:"=science fiction". Als u zoekt naar tag:=science fiction` vindt u
alle boeken met het label science en het woord fiction in eender welke metadata.
U kan gemakkelĳk geavanceerde opzoekingen bouwen met Geavanceerde zoekdialoog toegankelĳk door klikken op de
knop lsbil links van het zoekvak.
Beschikbare zoekvelden zĳn:tag, title, author, publisher, series, series_index, rating, cover,

comments, format, identifiers, date, pubdate, search, size, vl en aangepaste kolommen. Als een
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toestel aangesloten is, wordt het veld ondevice beschikbaar wanneer u de calibre bibliotheekweergave doorzoekt. Om
de zoeknaam (de zogenaamde opzoeknaam) te vinden van een aangepaste kolom, zweef met de muis over het kolomkop
in de bibliotheekweergave.
Datums

De syntaxis voor zoeken daar gegevens is:

pubdate:>2000-1 Will find all books published after Jan, 2000

date:<=2000-1-3 Will find all books added to calibre before 3 Jan, 2000

pubdate:=2009 Will find all books published in 2009

Als de datum twĳfelachtig is, wordt de huidige landinstelling gebruikt voor datum vergelĳking. Bv. in een mm/dd/yyyy
landinstelling wordt 2/1/2009 geïnterpreteerd als 1 Feb 2009. In een dd/mm/yyyy locale wordt het 2 Jan 2009. Er zĳn
enkele speciale datumstrings beschikbaar. Today wordt vandaag’s datum, eender welke dag het is. Yesterday` and this-
month (of de vertaalde equivalenten in de huidige taal) werken ook. Bĳkomend kan de string daysago (ook vertaald)
gebruikt worden om te vergelĳken met een datum een aantal dagen geleden. Bĳvoorbeeld:

date:>10daysago

date:<=45daysago

Om eventuele problemen te voorkomen met vertaalde uitdrukkingen voor een niet-Engelse versie van Calibre zĳn de
uitdrukkingen _today, _yesterday, _thismonth en _daysago altĳd beschikbaar. Deze worden niet vertaald.
Datums en numerieke waardes doorzoeken met relationele vergelĳkingen

Datum en numerieke velden ondersteunen de relatieve operatoren = (is gelĳk), > (groter dan), >= (groter dan of is gelĳk),
< (kleiner dan), <= (kleiner dan of is gelĳk) en != (niet gelĳk). Beoordelingsvelden worden beschouwd als numeriek. Bv
zoeken naar rating:>=3 vindt alle boeken beoordeeld 3 of hoger.
U kan zoeken naar boeken die een formaat hebben van een bepaalde grootte zoals dit:

• size:>1.1M zoekt boeken met een formaat groter dan 1.1MB
• size:<=1K zoekt boeken met een formaat kleiner dan of gelĳk aan 1KB

You can search for the number of items in multiple-valued fields such as tags using the character # then using the same
syntax as numeric fields. For example, to find all books with more than 4 tags use tags:#>4. To find all books with
exactly 10 tags use tags:#=10.
Series indices

Series indices are searchable. For the standard series, the search name is series_index. For custom series columns,
use the column search name followed by _index. For example, to search the indices for a custom series column named
#my_series, you would use the search name #my_series_index. Series indices are numbers, so you can use the
relational operators described above.
Saved searches

The special field search is used for saved searches (pagina 17). If you save a search with the name “My spouse’s books”
you can enter search:"My spouse's books" in the Search bar to reuse the saved search. More about saving searches
below.
Virtual libraries

The special field vl is used to search for books in a Virtual library. For example, vl:Read will find all the books in the
Read Virtual library. The search vl:Read and vl:"Science Fiction" will find all the books that are in both the
Read and Science Fiction virtual libraries. The value following vl: must be the name of a Virtual library. If the Virtual
library name contains spaces then surround it with quotes.
Whether a field has a value
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You can search for the absence or presence of a value for a field using “true” and “false”. For example:
• cover:false finds all books without a cover
• series:true finds all books that are in a series
• series:false finds all books that are not in a series
• comments:false finds all books with an empty comment
• formats:false finds all books with no book files (empty records)

Yes/no custom columns

Searching Yes/no custom columns for false, empty, or blank will find all books with undefined values in the column.
Searching for true will find all books that do not have undefined values in the column. Searching for yes or checked
will find all books with Yes in the column. Searching for no or unchecked will find all books with No in the column.
Note that the words yes, no, blank, empty, checked and unchecked are translated; you can use either the current
language’s equivalent word or the English word. The words true and false and the special values _yes, _no, and
_empty are not translated.
Identifiers

Identifiers (e.g., ISBN, DOI, LCCN, etc.) use an extended syntax. An identifier has the form type:value, as in
isbn:123456789. The extended syntax permits you to specify independently the type and value to search for. Both
the type and the value parts of the query can use any of the search kinds (pagina 12). Examples:

• identifiers:true zal boeken vinden met een willekeurige identificator.
• identifiers:false zal boeken vinden zonder identificatoren.
• identifiers:123 zoekt naar boeken van elk type met de waarde die 123 bevat.
• identifiers:=123456789 zoekt naar boeken met elk type die een waarde heeft die gelĳk is 123456789.
• identifiers:=isbn: en identifiers:isbn:true vinden boeken met een type gelĳk aan ISBN met iedere

waarde
• identifiers:=isbn:false vindt boeken zonder type zoals ISBN.
• identifiers:=isbn:123 vindt boeken met type gelĳk aan ISBN en waarde bevattend 123.
• identifiers:=isbn:=123456789 vindt boeken met type gelĳk aan ISBN en waarde gelĳk aan 123456789.
• identifiers:i:1 vindt boeken met een type dat een i bevat en een waarde van 1 bevatten.

Categories visible in the Tag browser

The search in_tag_browser:true finds all books that are in categories (tags, authors, etc.) currently shown in the Tag
browser. This is useful if you set the two preferences Preferences → Look & feel → Tag browser → Hide empty categories
and Find shows all items that match. With those two preferences set, doing a Find in the Tag browser shows only categories
containing items matched by the Find. Then, the search in_tag_browser:true additionally finds books with these
categories / items. You can easily run this search by pressing the key Ctrl+Alt+Shift+F or clicking the configure
button in the Tag browser and choosing the Show only books that have visible categories entry.
Search using templates

You can search using a template in De calibre sjabloontaal (pagina 162) instead of a metadata field. To do so you enter a
template, a search type, and the value to search for. The syntax is:

template: (the template) #@#: (search type) : (the value)

The template is any valid calibre template language template. The search type must be one of t (text search), d
(date search), n (numeric search), or b (set/not set (boolean)). The value is whatever you want, and can use the search
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kinds (pagina 12) described above for the various search types. You must quote the entire search string if there are spaces
anywhere in it.
Voorbeelden:

• template:"program: connected_device_name('main')#@#:t:kindle" – is true when the kindle

device is connected.
• template:"program: select(formats_sizes(), 'EPUB')#@#:n:>1000000" – finds books with

EPUB files larger than 1 MB.
• template:"program: select(formats_modtimes('iso'), 'EPUB')#@#:d:>10daysago" – finds

books with EPUB files newer than 10 days ago.
• template:"""program: book_count('tags:^"' & $series & '"', 0) != 0#@#:n:1""" – finds

all books containing the series name in the tags. This example uses super-quoting because the template uses both
single quotes (') and double quotes (") when constructing the search expression.

You can build template search queries easily using the Advanced search dialog accessed by clicking the button .

You can test templates on specific books using the calibre Template tester, which can be added to the toolbars or menus
via Preferences → Toolbars & menus. It can also be assigned a keyboard shortcut via Preferences → Shortcuts.
Advanced search dialog

Fig. 1: Geavanceerde zoekdialoog

1.6 Zoekopdrachten opslaan
calibre laat u vaak gebruikte zoekopdrachten opslaan onder een speciale naam en deze opnieuw gebruiken met één klik.
Maak een zoekopdracht aan door die ofwel in de zoekbalk in te geven of met de Label browser. Voer dan de naam in in
het vak Opgeslagen Zoekopdrachten naast de Zoekbalk. Klik op het plus-icoon naast het vak opgeslagen zoekopdrachten
om deze te bewaren.
Nu kunt u uw opgeslagen zoekopdracht vinden in de Label Browser onder Opgeslagen Zoekopdrachten. Een enkele klik
laat u een complexe zoekopdracht makkelĳk opnieuw uitvoeren zonder deze terug aan te maken.
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1.7 Searching the full text of all books

calibre can optionally index the full
text of books in the library to allow for instant searching of words inside any book. To use this functionality click the FT
button at the left edge of the search bar.
Then, enable indexing for the current library. Once indexing is complete you can search all the text in the full library.
When you add new books to the library, they will be automatically indexed in the background. This search allows you to
quickly find all books that contain a word or combination of words. You can even search for words that occur near other
words, as shown in the examples in the search popup window. Note that this search tool will find only one occurrence
of the search query in a particular book, not list every occurrence, for that it is best to search inside the book using the
calibre E-book viewer.
You can re-index an individual book by right clicking on the Book details panel in calibre and choosing Re-index this book
for full text searching.

1.8 Virtuele bibliotheken
Een Virtuele Bibliotheek is een manier om te doen alsof uw calibre bibliotheek maar een paar boeken heeft in plaats van
z’n hele collectie. Dit is een prima manier om uw grote verzameling boeken in kleinere hanteerbare stukken te verdelen.
Om te leren hoe Virtuele bibliotheken te maken en gebruiken, zie de handleiding: Virtuele bibliotheken (pagina 249).

1.9 Temporarily marking books
You can temporarily mark arbitrary sets of books. Marked books will have a pin on them and can be found with the
search marked:true. To mark a book press Ctrl+M or go to Preferences → Toolbars & menus and add the Mark books
button to the main toolbar.
You can mark books with a specific text label by right clicking the Mark books button and choosing Mark books with text
label. Books marked with text labels can later be found using the search marked:"=the-text-you-entered".

1.10 Raadt metadata op basis van bestandsnamen
Gewoonlĳk haalt calibre metadata op uit het boekbestand. U kunt instellen dat metadata in plaats daarvan moeten worden
gelezen uit de bestandsnaam via Voorkeuren → Import/Export → Boeken toevoegen → Lees metadata uit bestandinhoud.
You can also control how metadata is read from the filename using regular expressions (see Alles over het gebruik van
reguliere expressies in calibre (pagina 216)). In the Adding books section of the configuration dialog, you can specify a
regular expression that calibre will use to try and guess metadata from the names of e-book files that you add to the
library. The default regular expression is:

title - author

dat betekent, het programma gaat ervan uit dat alle tekens tot de eerste - tot de titel van het boek behoren en volgende
tekens de naam van de auteur van het boek. Bĳvoorbeeld, de bestandsnaam:
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Foundation and Earth - Isaac Asimov.txt

wordt geïnterpreteerd als titel: Foundation and Earth en auteur: Isaac Asimov

Tip

Indien de bestandsnaam geen koppelteken bevat zal de bovenstaande reguliere expressie mislukken.

1.10. Raadt metadata op basis van bestandsnamen 19



calibre Gebruikershandleiding, Release 8.7.0

1.11 Boekgegevens

De Boekdetails tonen het omslag en de metadata van het huidige geselecteerde boek. Dat kan verborgen worden met
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de Layout knop rechtsonder in het hoofdvenster. De namen van de auteurs zichtbaar in het Boekdetails scherm zĳn
aanklikbaar, ze verwĳzen u standaard naar de auteur z’n pagina in Wikipedia. Dit kunt u aanpassen door rechtsklikken
op de auteursnaam en te kiezen Deze auteur beheren.
Als u metadata voor het boek downloadt, zal het Boekdetail-scherm automatisch een link tonen naar webpagina’s van het
boek op Amazon, WorldCat enz. waar de metagegevens vandaan werden gehaald.
U kunt rechtsklikken op een individueel e-boekformaat in het Boekdetailscherm om het te verwĳderen, te vergelĳken
met hun originele versies, te bewaren op schĳf, te openen met een extern programma enz.
U kunt de omslag van het boek wĳzigen door eenvoudig een afbeelding te slepen en neer te zetten op het Boekdetailscherm.
Wilt u de omslagafbeelding bewerken met een extern programma, rechtsklik erop en kies Open met.
U kunt ook e-boekbestanden toevoegen aan het huidige boek door de bestanden op het Boekdetailscherm te slepen en
neer te zetten.
Dubbelklikken op het Boekdetailscherm open het in een extra pop-upvenster.
Tenslotte kunt u precies aanpassen welke informatie getoond wordt in het Boekdetailscherm via Voorkeu-
ren → Interface → Uitstralin & gevoel → Boekdetails.
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1.12 Labelbrowser

Met de Labelbrowser kunt u gemakkelĳk uw collectie doorzoeken op auteur/labels/reeksen/enz. Als u op een item klikt
in de Labelbrowser, bĳvoorbeeld de auteursnaam Isaac Asimov, toont de lĳst met boeken rechts ervan alleen boeken van
deze auteur. U kunt ook op categorienamen klikken. Bv. na het klikken op “Reeksen” worden alle boeken getoond in alle
reeksen.
De eerste klik op een item zal de lĳst van boeken beperken tot diegene die het item bevatten of er mee overeenkomen.
Voortgaande op het voorbeeld hierboven, klikken op Isaac Asimov zal boeken van deze auteur tonen. Nogmaals klikken
zal veranderen wat er getoond wordt, afhankelĳk of het item kinderen heeft (zie subcategorieën en hiërarchische items
hieronder). We gaan terug naar het Isaac Asimov voorbeeld, opnieuw op Isaac Asimov klikken zal de lĳst beperken tot
alle boeken niet geschreven door Isaac Asimov. Een derde klik zal de beperking verwĳderen en alle boeken tonen. Door
Ctrl of Shift ingedrukt te houden en te klikken op meerdere items, zullen beperkingen aangemaakt worden, gebaseerd
op verschillende items. Bv. kan u Ctrl ingedrukt houden en op de labels Geschiedenis en Europe klikken om boeken
over Europese geschiedenis te vinden. De Labelbrowser werkt door zoekexpressies te maken die automatisch toegevoegd
worden aan de Zoekbalk. Kĳken wat de Tag Browser creëert, is een goege manier om te leren hoe je simpele zoek
expressies te maken.
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Items in de Labelbrowser hebben gedeeltelĳk gekleurde pictogrammen. De hoeveelheid kleur hangt af van de gemiddelde
beoordeling van de boeken in deze categorie. Dus als de boeken van Isaac Asimov een gemiddelde van vier sterren hebben,
is het pictogram voor Isaac Asimov in de LabelBrowser voor 4/5de gekleurd. U kunt met uw muisaanwĳzer over het
pictogram gaan om de gemiddelde beoordeling te bekĳken.
De buiten-niveau items in de Labelbrowser, zoals Auteurs en Series, heten categorieën. U kan uw eigen categorieën cre-
eren,Gebruikerscategorieën genaamd, handig om items te organiseren. Bv. u kan deGebruikerscategorieën editor gebruiken
(klik op de Configureren knop linksonder in de Labelbrowser en kies Beheer auteurs, series, enz. → Gebruikerscategorie-
en) om een Gebruikerscategorie te creëren genaamd Favorite Authors, zet dan de items voor uw favorieten in de
categorie. Gebruikerscategorieën kunnen subcategorieën hebben. Bv. de Gebruikerscategorie Favorites.Authors is
een subcategorie van Favorites. U kan ook Favorites.Series hebben, In dat geval zullen er twe subcategorieën
zĳn in Favorites. Subcategorieën creëert u door rechtsklikken op een Gebruikerscategorie en kiezen van Subcategorie
toevoegen aan … en invoeren van de subcategorienaam of door gebruik van de Gebruikerscategorieën editor door invoeren
van namen zoals het Favorieten voorbeeld boven.
U kunt Gebruikerscategorieën doorzoeken op dezelfde manier als ingebouwde categorieën door erop te klikken.
Er zĳn vier zoekmogelĳkheden die de ronde maken door te klikken:

1. “alles dat overeenkomt met een item in de categorie” aangegeven door een enkel groen plus-teken.
2. “alles dat overeenkomt met een item in de categorie of de sub-categorieën” aangegeven door twee groene

plus-tekens.
3. “alles dat niet overeenkomt met een item in de categorie” aangegeven door een enkel rood min-teken.
4. “alles dat niet overeenkomt met een item in de categorie of de sub-categorieën” aangegeven door twee rode

min-tekens.
Het is ook mogelĳk om hiërarchieën op te zetten binnen sommige tekst categorieën zoals labels, series en aangepaste
kolommen. Deze hiërarchieën herkent u aan kleine driehoekjes, waardoor sub-items verborgen zĳn. Om hiërarchieën
van items in een categorie te gebruiken gaat u eerst naar Voorkeuren → Interface → Uitstraling & gevoel en voer de ca-
tegoriena(a)m(en) in in het “Categorieën met hiërarchische items” vak. Als dit eenmaal gebeurd is, zullen items in deze
categorie die punten bevatten getoond worden met de kleine driehoek. Bv. gaan we er van uit dat u een aangepaste kolom
aanmaakt genaamd “Genre” en aangeeft dat deze hiërarchische items bevat. Als dit gebeurt is, zullen items zoals Mys-
tery.Thriller en Mystery.Engels worden getoond als Mystery met ernaast de kleine driehoek. Klikken op de driehoek laat
Thriller en Engels zien als sub-items. Lees ook Subgroepen van boeken beheren bĳvoorbeeld “genre” (pagina 155) voor
meer informatie.
Hiërarchische items (items met kinderen) gebruiken dezelfde vier ‘klik-aan’ zoekopties als Gebruikerscategorieën. Items
zonder kinderen gebruiken twee van de zoekopties: “alles overeenkomend” en “alles niet overeenkomend”.
U kunt items slepen en plaatsen in de Labelbrowser op de Gebruikerscategorieën om ze toe te voegen aan die categorie.
Indien de bron een Gebruikerscategorie is, houdt de Shift ingedrukt tĳdens het slepen om het item te verplaatsen naar
de nieuwe categorie. U kunt ook boeken slepen en neerzetten van de boekenlĳst op items in de Labelbrowser; neerzetten
van een boek op een item zal dit automatisch toepassen voor de geplaatste boeken. Bv. een boek slepen op Isaac Asimov
zal het boek instellen als een boek van Isaac Asimov. Het neerzetten op het label Geschiedenis zal het label Geschiedenis
toevoegen aan de labels van het boek.
You can easily find any item in the Tag browser by clicking the search button at the lower-right corner. In addition, you
can right click on any item and choose one of several operations. Some examples are to hide it, rename it, or open a
“Manage x” dialog that allows you to manage items of that kind. For example, the Manage authors dialog allows you to
rename authors and control how their names are sorted.
U kunt instellen hoe items worden gesorteerd in de Labelbrowser met de knop Configureren onder links in de Labelbrow-
ser. U kunt kiezen om te sorteren op naam, gemiddelde beoorderling of populariteit (populariteit is het aantal boeken
met een item in uw bibliotheek; bĳvoorbeeld de populariteit van Isaac Asimov is het aantal boeken in uw bibliotheek
door Isaac Asimov).
You can use your own icons for categories and values in categories. To change the icon for a category, right-click on the
category (the outer-level item) and choose Change (category name) category icon. A dialog will open where you can pick
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an image to be used as the icon. To restore the icon to its default choose Restore (category name) default icon.
To choose icons for values in categories, right-click on a value then choose Manage icon for (value name). You will see a
list of choices:

• Choose an icon for this value but not its children. A dialog will open where you choose an icon for the value. Children
of that value will not inherit that icon.

• Choose an icon for this value and its children. A dialog will open where you choose an icon for the value. Any
children that don’t have their own specified icon will inherit this icon.

• Use the existing icon for this value but not its children. This option is offered if the value already has an icon that is
inherited by the value’s children. Selecting it will make the icon apply to the value but not its children.

• Use the existing icon for this value and its children. This option is offered if the value already has an icon that is not
inherited by the value’s children. Selecting it will make the icon apply to the value and its children.

• Use the default icon for this value. This option is offered if the item has an icon. It removes the icon from the value
and any children inheriting the icon. The default icon is what is specified below.

• Reset all value icons to the default icon. This option removes all item value icons for the category. It does not remove
a template if one exists. There is no undo.

• Use/edit a template to choose the default value icon. This option permits you to provide a calibre template that
returns the name of an icon file to be used as a default icon. The template can use two variables:

– category: the lookup name of the category, for example authors, series, #mycolumn.
– value: the value of the item within the category.
– count: the number of books with this value. If the value is part of a hierarchy then the count includes the

children.
– avg_rating: the average rating for books with this value. If the value is part of a hierarchy then the average

includes the children.
Book metadata such as title is not available. Template database functions such as book_count (pagina 188) and
book_values (pagina 188) will work, but the performance might not be acceptable. The following template func-
tions will work in the GUI but won’t work in the content server: connected_device_name (pagina 196), connec-
ted_device_uuid (pagina 196), current_virtual_library_name (pagina 196), is_marked (pagina 198), and virtu-
al_libraries (pagina 199).
In the GUI, Python templates have full access to the calibre database. In the content server, Python templates have
access to new API (see API documentation for the database interface4) but not the old API (LibraryDatabase).
For example, this template specifies that any value in the clicked-on category beginning with History will have an
icon named flower.png:

program:

if substr($value, 0, 7) == 'History' then 'flower.png' fi

If a template returns the empty string ('') then the category icon will be used. If the template returns a file name
that doesn’t exist then no icon is displayed.

• Use the category icon as the default. This option specifies that the icon used for the category should be used for any
value that doesn’t otherwise have an icon. Selecting this option removes any template icon specification.

The icon is chosen using the following hierarchy:
1. The icon specified for the value, if it exists.
2. The icon specified for a parent node found by walking up the tree, if one exists.

4 https://manual.calibre-ebook.com/db_api.html
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3. The icon from a template, if a template exists and it returns a non-empty string.
4. The default category icon, which always exists.

Icons are per-user, not per-library, stored in the calibre configuration folder. Icons for item values are stored in the
tb_icons subfolder. Icons used by templates are in the template_icons subfolder of tb_icons.

1.13 Omslagenrooster

U kunt calibre de boekomslagen laten tonen in een raster in plaats van een lĳst als u uw verzameling liever doorzoekt op
omslagen. Het Raster wordt ingeschakeld door te klikken op de knop Layout rechtsonder in het calibre hoofdscherm. U
kunt de grootte van de omslagen aanpassen en de achtergrond van het Raster via Vookeuren → Interface → Uitstraling &
Gevoel  → Omslagraster. U kunt ook ieder veld onder de omslagen laten zien zoals titel of auteur of beoordeling of een
aangepaste kolom die u zelf heeft gemaakt.
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1.14 Omslagbrowser

Naast het hierboven beschrevenRaster, kunt u calibre de omslagen ook laten tonen in een enkele rĳ. Dit wordt ingeschakeld
via de Layout knop rechtsonder in het hoofdscherm. In Voorkeuren → Interface → Uiterlĳk & Gedrag → Omslagbrowser
kunt u het aantal getoonde omslagen wĳzigen en zelfs de Omslagbrowser deze in een apart pop-upscherm laten zien.
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1.15 Adding notes for authors, series, etc.

You can add notes for an author/series/tag/publisher/etc. to your calibre library. To do so right click on the author name
in the Tag browser on the left or the Book details panel on the right and choose Create note or Edit note.
A simple popup window will allow you to enter your notes using basic formatting and supporting links and images. Once
a note for an author is created, it can be viewed easily from the Book details panel by clicking the little pencil icon next to
the author name.
You can search through all the notes in your library using the Browse notes tool by pressing Ctrl+Shift+N or adding it
to the toolbar via Preferences → Toolbars & menus.
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1.16 Snel-weergave
Soms wilt u een boek selecteren en snel een boekenlĳst krĳgen met dezelfde waarde in een categorie (auteurs, labels,
uitgevers, series, enz.) als het huidig geselecteerde boek maar zonder het huidige zicht op de bibliotheek te veranderen.
Dit kan met Snel Weergeven. Snel Weergeven opent ofwel een tweede venster of een paneel in de boekenlĳst met een
lĳst boeken die overeenkomen met die bepaalde waarde. Bv. neem aan dat u een lĳst wil zien met alle boeken met de
auteur(s) van het huidige boek. Klik in de auteur cel waarin u geïnteresseerd bent en druk op de ‘Q’ toets of klik op het
Snel Weergeven pictogram in het Layout onderdeel van het calibre venster. Een venster of paneel opent met al de auteurs
voor dat boek links en alle boeken van de geselecteerde auteur rechts.
Enkele voorbeelden van snelweergave gebruik: zie snel welke andere boeken:

• pas een (enkele) label(s) toe op het huidig geselecteerde boek,
• zitten in dezelfde reeks als het huidige boek
• hebben dezelfde waardes in een persoonlĳke kolom als het huidige boek
• zĳn geschreven bĳ één van de auteurs van het huidige boek
• deel waardes in een aangepaste kolom

Er zĳn twee keuzes voor waar de Snel Weergeven informatie verschĳnt:
1. Het kan “niet-gedokt” openen: bovenop het calibre venster en blĳft open tot u het expliciet sluit.
2. Het kan “gedokt” openen: als een paneel in het boekenlĳst onderdeel van het calibre hoofdvenster.

U kan het paneel naar believen van gedokt naar niet-gedokt veranderen met de “Gedokt/Niet-gedokt” knop.
Het Snel Weergeven scherm kan open blĳven en volgt de bewegingen in de boekenlĳst. Bv. als u in de calibre bibliotheek-
weergave klikt op een categoriekolom (labels, series, auteurs, enz.) van een boek zal de Snel Weergeven venster inhoud
veranderen om u in het linkerpaneel de waardes te tonen in die categorie voor het geselecteerde boek (bv. de labels voor
dat boek). Het eerste item in die lĳst wordt geselecteerd en Snel Weergeven toont u op het rechterpaneel alle boeken in
uw bibliotheek die ie waarde gebruiken. Klik op een andere waarde in het linkerpaneel om de boeken te zien met die
andere waarde.
Dubbelklik op een boek in het Snel Weergeven venster om dat boek te selecteren in de bibliotheek weergave. Dit past ook
de items aan getoond in het Snel Weergeven scherm (het linkerpaneel) om de items te tonen in het nieuw geselecteerde
boek.
Shift- of Ctrl- dubbelklik op een boek in het Snel Weergeven venster om de metadata bewerken dialoog te openen
in het calibre venster. Het bewerkte boek zal Snel Weergegeven worden als u de metadata bewerken dialoog sluit.
U kunt zien of een kolom snel weergegeven kan worden door met uw muisaanwĳzer over de kolomnaam te gaan en de
tooltip voor dit kolomhoofd te bekĳken. U kunt ook rechts te klikken op de kolomkop en bekĳken of de optie “Snelweer-
gave” wordt getoond in het menu; in dat geval is het kiezen van de optie Snelweergave hetzelfde als het indrukken van
‘Q’ van de huidge cel.
Opties (in Voorkeuren → Uitstraling & Gevoel → Snel Weergeven):

• Respecteer (of niet) de huidige Virtuele bibliotheek. Indien aangekruist toont Snel Weergeven enkel boeken in de
huidige Virtuele bibliotheek. Standaard: respecteer Virtuele bibliotheken

• Verander de inhoud van het Snel Weergeven venster als de kolom veranderd in de boekenlĳst met de pĳltjestoetsen.
Standaard: veranderingen met pĳltjestoetsen niet volgen

• Verander de Snel “Weergegeven” kolom bĳ dubbelklikken van een cel in het Snel Weergeven venster . Anders
wordt het boek veranderd maar de onderzochte kolom niet. Standaard: verander de kolom

• Verander de Snel “Weergegeven” kolom naar de huidige kolom bĳ indrukken van de return toets in het Snel Weer-
gevenpaneel. Anders wordt het boek gewĳzigd maar de onderzochte kolom niet. Standaard: verander de kolom.

• Kiezen welke kolommen getoond worden in het Snel Weergeven venster/paneel.
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1.17 Taken

Het Takenpaneel toont het huidige aantal lopende taken. Taken zĳn klussen die lopen in een apart proces. Ze bevatten het
converteren van e-boeken en communicatie met uw reader. U kunt op het Takenpaneel klikken om de lĳst van taken te
bekĳken. Als een taak voltooid is, kunt u een gedetailleerd log zien van deze taak door erop te dubbelklikken in de lĳst.
Dat is nuttig bĳ foutzoeken in taken die niet geheel gelukt zĳn.

1.18 Toetsenbord sneltoetsen
calibre has several keyboard shortcuts to save you time and mouse movement. These shortcuts are active in the book list
view (when you’re not editing the details of a particular book), and most of them affect the title you have selected. The
calibre E-book viewer has its own shortcuts (pagina 57) which can be customised in the viewer Preferences.

Notitie

Aandacht: De Calibre toetsenbord snelkoppeling heeft geen ‘modifier key’ nodig (Commando, Opties, Controle, Etc.),
met uitzondering wanneer het is gemeld. Je hoeft alleen de letter toets in te drukken, bĳv. E om aan te passen.

Tabel 1: Toetsenbord snelkoppelingen voor het Calibre programma
Toet-
sen-
bord
snel-
koppe-
ling

Actie

F2

(En-

ter

for

ma-

cOS)

Bewerk de metadata van het huidig geselecteerde veld in de boekenlĳst.

A Boeken toevoegen
Shift+A Formaten toevoegen aan de geselecteerde boeken
C Geselecteerde boeken converteren
D Naar apparaat sturen
Del Verwĳder geselecteerde boeken
E Bewerk metadata van geselecteerde boeken
G Boeken downloaden
I Toon boekgegevens
K Bewerk inhoudsopgave
M Geselecteerde records samenvoegen
Alt+M Geselecteerde records samenvoegen, originelen bewaren
O Bĳbehorende map openen
P Boeken bĳschaven
S Op schĳf opslaan
T Bewerk Boek

Vervolgt op volgende pagina
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Tabel 1 – Vervolgd van vorige pagina
Toet-
sen-
bord
snel-
koppe-
ling

Actie

V Tonen
Shift+V Laatst gelezen boek tonen
Alt+V/
Cmd+V
for

macOS

Specifiek formaat tonen

Alt+Shift+JSchakel taaklĳst
Alt+Shift+BSchakel Omslagbrowser
Alt+Shift+DSchakel Boekdetailpaneel
Alt+Shift+TSchakel Labelbrowser
Alt+Shift+GSchakel Omslagraster
Alt+A Toon boeken bĳ dezelfde auteur als het huidige boek
Alt+T Toon boeken met dezelfde labels als het huidige boek
Alt+P Toon boeken met dezelfde uitgever als het huidige boek
Alt+Shift+SToon boeken uit dezelfde reeks als het huidige boek
/,

Ctrl+F
Activeer de Zoekbalk

Shift+Ctrl+FOpen het Geavanceerde zoekvenster
Shift+Alt+FSchakel de Zoekbalk
Esc Huidige zoekterm wissen
Shift+EscSelecteer de boekenlĳst
Ctrl+EscDe Virtuele bibliotheek legen
Alt+Esc Verwĳder de extra restricties
Ctrl+* Maak een tĳdelĳke Virtuele bibliotheek gebaseerd op de huidige zoekopdracht
Ctrl+RechtsSelecteer de volgende Virtuele bibliotheek tab
Ctrl+LeftSelecteer de vorige Virtuele bibliotheek tab
N of F3 Zoek het volgende boek dat overeen komt met de huidige zoekopdracht (werkt alleen indien zoek accentu-

eren aan staat in de zoek voorkeuren)
Shift+N
of

Shift+F3

Zoek het vorige boek dat overeen komt met de huidige zoekopdracht (werkt alleen indien zoek accentueren
aan staat in de zoek voorkeuren)

Ctrl+D Metadata en omslagafbeeldingen downloaden
Ctrl+R Herstart Calibre
Ctrl+Shift+RHerstart in debug modus
Shift+Ctrl+EVoeg een leeg boek toe aan Calibre
Ctrl+M Wissel gemarkeerd/ongemarkeerde status op geselecteerde boeken
Ctrl+/
or
Ctrl+Alt+F

Open the popup to search the full text of all books in the library

Q Toon de Snelle weergave pop-up om boeken te tonen met gerelateerde reeksen/labels/enz.
Shift+Q Selecteer het geopende Snel weergave paneel
Shift+S Zoek in het Snel weergave paneel
F5 De huidige volgorde opnieuw toepassen
Ctrl+Q Calibre afsluiten
X Schakel auto scrollen van de boekenlĳst

Vervolgt op volgende pagina
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Tabel 1 – Vervolgd van vorige pagina
Toet-
sen-
bord
snel-
koppe-
ling

Actie

Ctrl+Alt+Shift+FRestrict the displayed books to only those books that are in a category currently displayed in the Tag browser
B Browse annotations (highlights and bookmarks) made in the calibre E-book viewer for all books in the

library
Ctrl+Shift+NBrowse notes associated with authors/series/tags/etc.
Alt+Shift+LToggle the layout between wide and narrow views
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Uw favoriete nieuws website toevoegen

calibre heeft een krachtig, flexibel en gemakkelĳk te gebruiken kader voor downloaden van nieuws van internet en con-
verteren naar een e-boek. Het volgende toont u aan de hand van voorbeelden, hoe u nieuws van verschillende websites
kunt krĳgen.
Om een   goed begrip te krĳgen van het gebruik van het raamwerk, volgt u de voorbeelden in de onderstaande volgorde:

• Compleet automatisch ophalen (pagina 33)
– De Calibre blog (pagina 34)
– bbc.co.uk (pagina 35)

• Het ophaalproces aanpassen (pagina 35)
– Gebruik van de print versie van bbc.co.uk (pagina 35)
– Artikel stĳlen vervangen (pagina 36)
– Splitsen en verdelen (pagina 37)
– Werkend voorbeeld (pagina 37)

• Tips voor ontwikkelen van nieuwe recepten (pagina 40)
• Verder lezen (pagina 41)
• API documentatie (pagina 41)

2.1 Compleet automatisch ophalen
Als uw nieuwsbron eenvoudig genoeg is, kan Calibre deze mogelĳk volledig automatisch ophalen, het enige wat u hoeft
te doen is de URL opgeven. Calibre verzamelt alle informatie die nodig is om een nieuwsbron te downloaden naar een
:term :recept. Om Calibre over een nieuwsbron te vertellen, moet je een :term :recept ervoor maken. Laten we enkele
voorbeelden bekĳken:
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2.1.1 De Calibre blog
De calibre blog is een blog met posts die veel nuttige calibre kenmerken beschrĳven op een simpele en toegankelĳke
manier voor nieuwe calibre gebruikers. Om deze blog te downloaden als e-boek, vertrouwen we op de RSS feed of the
blog:

http://blog.calibre-ebook.com/feeds/posts/default

Ik vond de RSS URL door te zoeken in “Abonneren op” onderaan de blogpagina en kiezen voor Posts → Atom. Om calibre
de feeds te laten downloaden en converteren naar een e-boek, moet u rechtsklikken op de Nieuws ophalen knop en dan het
Aangepaste nieuwsbron toevoegen menu item en dan de Nieuw Recept knop. Een dialoog zoals onder getoond verschĳnt.

Voer eerst Calibre Blog in in het Recept titel veld. Dit zal de titel van het e-boek zĳn dat wordt gecreëerd van het
artikel in de feeds boven.
De volgende twee velden (Oudste artikel en Max. aantal artikelen) geven u enige controle over hoeveel artikelen moeten
gedownload worden van elke feed, en ze zĳn zo klaar als een klontje.
Om de feeds aan het recept toe te voegen, voer de feedtitel en de feed URL in en klik op de Feed toevoegen knop. Als u
de feed hebt toegevoegd, klik gewoon op de Opslaan knop en u bent klaar! Sluit de dialoog.
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Om uw nieuw recept te testen, klik op de Nieuws ophalen knop en in hat Aangepaste nieuwsbronnen sub-menu klik op
calibre Blog. Na een paar minuten verschĳnt het nieuw gedownloade e-boek met blogposts in de hoofdbibliotheekweergave
(als uw reader aangesloten is, wordt het op de reader gezet i.p.v. in de bibliotheek). Selecteer het en raak de Tonen knop
om te lezen!
De reden dat dit zo goed werkt en met zo weinig inspanning is dat de blog volledige inhoud RSS feeds voorziet, m.a.w.
de artikel inhoud is ingebed in de feed zelf. Voor de meeste bronnen die nieuws voorzien op deze wĳze, met volledige
inhoud feeds, moet u niet meer inspanning doen om ze te converteren naar e-boeken. Nu een kĳkje naar een nieuwsbron
die geen volledige inhoud feeds levert. In zo’n feeds is het volledige artikel een webpagina en bevat de feed enkel een link
met een korte samenvatting.

2.1.2 bbc.co.uk
Laten we de volgende twee feeds van De BBC proberen:

1. Nieuws Front Pagina: https://newsrss.bbc.co.uk/rss/newsonline_world_edition/front_page/rss.xml
2. Wetenschap/Natuur: https://newsrss.bbc.co.uk/rss/newsonline_world_edition/science/nature/rss.xml

Volg de procedure beschreven in De Calibre blog (pagina 34) boven om een recept te creëren voor The BBC (met de
feeds boven). Kĳkend naar het gedownloade e-boek zien we dat calibre een lovenswaardige inspanning heeft gedaan om
enkel de inhoud waar u om geeft te halen uit elk artikel z’n webpagina. Het proces is echter niet perfect. Soms is er nog
ongewenste inhoud zoals menu’s en navigatie hulpjes of het verwĳderde inhoud waar het had moeten afblĳven, zoals
artikelkoppen. Voor het perfecte proces zullen we het moeten aanpassen zoals beschreven in het volgende onderdeel.

2.2 Het ophaalproces aanpassen
Als u het downloadproces wil perfectioneren of inhoud downloaden van een zeer complexe webstek, kan u gebruik maken
van al de kracht en soepelheid van het recept raamwerk. Om dat te doen, klik in de Aangepaste nieuwsbronnen dialoog
gewoon op de Schakel over naar Geavanceerde modus knop.
De gemakkelĳkste en dikwĳls productiefste aanpassing is de afdrukversie van de online artikelen gebruiken. De afdruk-
versie bevat gewoonlĳk veel minder rommel en vertaalt veel vlotter naar een e-boek. Laten we de afdrukversie van de
artikelen van De BBC proberen.

2.2.1 Gebruik van de print versie van bbc.co.uk
De eerste stap is kĳken naar het e-boek dat we downloadden van bbc.co.uk (pagina 35). Aan het einde van elk artikel
in het e-boek is een kleine blurb die toont waar het artikel werd gedownload. Kopieer en plak die URL in een browser.
Zoek op de webpagina van het artikel voor een link die wĳst naar de “Afdrukversie”. Klik erop om de afdrukversie van
het artikel te zien. Ziet er veel strakker uit! Vergelĳk nu de twee URL’s. Bĳ mĳ waren het:

Artikel URL
https://news.bbc.co.uk/2/hi/science/nature/7312016.stm

Print versie URL
https://newsvote.bbc.co.uk/mpapps/pagetools/print/news.bbc.co.uk/2/hi/science/nature/7312016.
stm

Het lĳkt erop dat om de afdrukversie te krĳgen, we elke artikel URL moeten laten voorafgaan door:
newsvote.bbc.co.uk/mpapps/pagetools/print/

In de Geavanceerde modus van de Aangepaste nieuwsbronnendialoog zou u iets moeten zien zoals (denk eraan om het
The BBC recept te selecteren voor naar geavanceerde modus over te schakelen):
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U ziet dat de velden van de Basis modus op een rechttoe rechtaan manier zĳn vertaald naar Python code. We moeten
instructies toevoegen aan dit recept om de afdrukversie van het artikel te gebruiken. Al wat nodig is, is toevoegen van
volgende twee regels:

def print_version(self, url):

return url.replace('https://', 'https://newsvote.bbc.co.uk/mpapps/pagetools/print/

↪→')

Dit is Python, dus inspringing is belangrĳk. Na toevoegen van de lĳnen zou het er moeten uitzien als:

Boven definieert def print_version(self, url) een methode die door calibre wordt aangeroepen voor elk artikel.
url is de URL van het originele artikel. Wat print_version doet, is die url nemen en vervangen door de nieuwe URL
die wĳst naar de afdrukversie van het artikel. Om te leren over Python5 see the tutorial6.
Klik nu op de Toevoegen/updaten recept knop en uw wĳzigingen worden opgeslagen. Download het e-boek opnieuw. U
zou nu een veel betere versie moeten hebben. Een van de problemen met de nieuwe versie is dat de lettertypes op de
webpagina van de afdrukversie te klein zĳn. Dit wordt ge-auto-fixxed bĳ converteren naar een e-boek maar zelfs daarna
is de lettertypegrootte van menu’s en navigatiebalk te groot vergeleken met de artikeltekst. Om dit te in orde te brengen,
doen we nog wat aanpassingen in het volgende onderdeel.

2.2.2 Artikel stijlen vervangen
In de vorige sectie zagen we dat de lettertypegrootte voor artikelen van de afdrukversie van The BBC te klein was. Op
de meeste webstekken, The BBC inbegrepen, is deze lettertypegrootte ingesteld door de CSS stĳlbladen. We kunnen dit
ophalen uitschakelen door toevoegen van de regel:

5 https://www.python.org
6 https://docs.python.org/tutorial/
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no_stylesheets = True

Het recept ziet er als volgt uit:

De nieuwe versie ziet er goed uit. Als u een perfectionist bent, dan zult u het volgende gedeelte willen lezen, deze gaat
over het aanpassen van de gedownloade content.

2.2.3 Splitsen en verdelen
calibre bevat zeer krachtige en flexibele mogelĳkheden om gedownloadede inhoud te manipuleren. Om enkele hiervan
te tonen, laten we nogmaals een kĳkje nemen bĳ onze oude vriend het The BBC (pagina 37) recept. Bĳ kĳken naar de
broncode (HTML) van een paar artikelen (afdrukversie), zien we dat ze een voettekst hebben zonder bruikbare informatie,
gevat in

<div class="footer">

...

</div>

Dit kan worden verwĳderd door toevoeging van:

remove_tags = [dict(name='div', attrs={'class':'footer'})]

naar het recept. Tenslotte, laten we wat CSS dat we eerder uitschakelden, vervangen met onze eigen CSS geschikt voor
converteren naar een e-boek:

extra_css = '.headline {font-size: x-large;} \n .fact { padding-top: 10pt }'

Met deze toevoegingen is ons recept “productiekwaliteit” geworden.
Deze recept verkent enkel het tipje van de ĳsberg als het over de kracht van calibre gaat. Om meer mogelĳkheden van
calibre te ontdekken, onderzoeken we een ingewikkelder voorbeeld uit het echte leven in de volgende sectie.

2.2.4 Werkend voorbeeld
Een redelĳk complex real life voorbeeld dat meer van de API van BasicNewsRecipe toont is het recept voor The New
York Times

import string, re

from calibre import strftime

from calibre.web.feeds.recipes import BasicNewsRecipe

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
from calibre.ebooks.BeautifulSoup import BeautifulSoup

class NYTimes(BasicNewsRecipe):

title = 'The New York Times'

__author__ = 'Kovid Goyal'

description = 'Daily news from the New York Times'

timefmt = ' [%a, %d %b, %Y]'

needs_subscription = True

remove_tags_before = dict(id='article')

remove_tags_after = dict(id='article')

remove_tags = [dict(attrs={'class':['articleTools', 'post-tools', 'side_tool',

↪→'nextArticleLink clearfix']}),

dict(id=['footer', 'toolsRight', 'articleInline', 'navigation',

↪→'archive', 'side_search', 'blog_sidebar', 'side_tool', 'side_index']),

dict(name=['script', 'noscript', 'style'])]

encoding = 'cp1252'

no_stylesheets = True

extra_css = 'h1 {font: sans-serif large;}\n.byline {font:monospace;}'

def get_browser(self):

br = BasicNewsRecipe.get_browser(self)

if self.username is not None and self.password is not None:

br.open('https://www.nytimes.com/auth/login')

br.select_form(name='login')

br['USERID'] = self.username

br['PASSWORD'] = self.password

br.submit()

return br

def parse_index(self):

soup = self.index_to_soup('https://www.nytimes.com/pages/todayspaper/index.

↪→html')

def feed_title(div):

return ''.join(div.findAll(text=True, recursive=False)).strip()

articles = {}

key = None

ans = []

for div in soup.findAll(True,

attrs={'class':['section-headline', 'story', 'story headline']}):

if ''.join(div['class']) == 'section-headline':

key = string.capwords(feed_title(div))

articles[key] = []

ans.append(key)

elif ''.join(div['class']) in ['story', 'story headline']:

a = div.find('a', href=True)

if not a:

continue

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
url = re.sub(r'\?.*', '', a['href'])

url += '?pagewanted=all'

title = self.tag_to_string(a, use_alt=True).strip()

description = ''

pubdate = strftime('%a, %d %b')

summary = div.find(True, attrs={'class':'summary'})

if summary:

description = self.tag_to_string(summary, use_alt=False)

feed = key if key is not None else 'Uncategorized'

if feed not in articles:

articles[feed] = []

if not 'podcasts' in url:

articles[feed].append(

dict(title=title, url=url, date=pubdate,

description=description,

content=''))

ans = self.sort_index_by(ans, {'The Front Page':-1, 'Dining In, Dining Out':1,

↪→ 'Obituaries':2})

ans = [(key, articles[key]) for key in ans if key in articles]

return ans

def preprocess_html(self, soup):

refresh = soup.find('meta', {'http-equiv':'refresh'})

if refresh is None:

return soup

content = refresh.get('content').partition('=')[2]

raw = self.browser.open('https://www.nytimes.com'+content).read()

return BeautifulSoup(raw.decode('cp1252', 'replace'))

We zien verscheidene nieuwe kenmerken in dit recept. Om te beginnen:

timefmt = ' [%a, %d %b, %Y]'

Dit stelt de getoonde tĳd op de voorpagina van het gecreëerde e-boek in op het formaat, Day, Day_Number Month,

Year. Kĳk op timefmt (pagina 51).
Dan zien we een groep richtlĳnen voor het opschonen van de gedownloade HTML:

remove_tags_before = dict(name='h1')

remove_tags_after = dict(id='footer')

remove_tags = ...

Deze verwĳderen alles voor de eerste <h1> tag en alle na de eerste tag wiens id is footer. Bekĳk remove_tags

(pagina 50), remove_tags_before (pagina 50), remove_tags_after (pagina 50).
De volgende interessante functie is:

needs_subscription = True

...

def get_browser(self):

...

needs_subscription = True zegt calibre dat dit recept een gebruikersnaam en wachtwoord nodig heeft voor content
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toegang. Dit laat calibre vragen naar een gebruikersnaam en wachtwoord telkens u dit recept probeert te gebruiken. De
code in calibre.web.feeds.news.BasicNewsRecipe.get_browser() (pagina 43) doet het inloggen op de NYT
website. Eens ingelogd zal calibre dezelfde ingelogde browser instance gebruiken om alle inhoud op te halen. Bekĳk
mechanize7 om de code in get_browser te begrĳpen.
Het volgende nieuwe kenmerk is de calibre.web.feeds.news.BasicNewsRecipe.parse_index() (pagina 44)
methode. Zĳn job is naar https://www.nytimes.com/pages/todayspaper/index.html te gaan en de lĳst met artikelen op
te halen die verschĳnt in todays krant. Hoewel complexer dan gewoon RSS te gebruiken, het recept creëert een e-boek
dat sterk lĳkt op de krant van de dag. parse_index maakt zwaar gebruik van BeautifulSoup8 om de webpagina van
de dagelĳkse krant te verwerken. U kan ook andere, modernere verwerkers gebruiken als BeautifulSoup u niet bevalt.
calibre komt met lxml9 en html5lib10, welke de aanbevolen verwerkers zĳn. Om ze te gebruiken, vervang de aanroep van
index_to_soup() door het volgende:

raw = self.index_to_soup(url, raw=True)

# For html5lib

import html5lib

root = html5lib.parse(raw, namespaceHTMLElements=False, treebuilder='lxml')

# For the lxml html 4 parser

from lxml import html

root = html.fromstring(raw)

Het laatste, nieuwe kenmerk is de calibre.web.feeds.news.BasicNewsRecipe.preprocess_html() (pagi-
na 45) methode. Ze kan gebruikt worden voor willekeurige transformaties op elke gedownloade HTML pagina. Hier
wordt ze gebruikt om de advertenties die de nytimes toont voor elk artikel te omzeilen.

2.3 Tips voor ontwikkelen van nieuwe recepten
De beste manier om nieuwe recepten te ontwikkelen is met de opdrachtregel. Creëer het recept in uw favoriete Python
editor en sla het op in een bestand, bv. myrecipe.recipe. De .recipe extensie is vereist. U kan inhoud downloaden met
dit recept met het commando:

ebook-convert myrecipe.recipe .epub --test -vv --debug-pipeline debug

Het commando e-boek-converteren downloadt alle webpagina’s en slaat ze op in het EPUB bestand
mijnrecept.epub. De -vv optie laat e-boek-converteren een hoop informatie uitspuwen over wat het doet. De
e-boek-converteren-recept-invoer --test optie laat het juist een paar artikels downloaden van maximaal
twee feeds. Bĳkomend plaatst e-boek-converteren de gedownloade HTML in de debug/input map, waar debug de
map is die u specificeerde in de e-boek-converteren --debug-pipeline optie.
Als de download compleet is, kan u de gedownloade HTML bekĳken door het bestand debug/input/index.html in
een browser te openen. Als u tevreden bent dat de download en voorbewerking correct gebeurt, kan e-boeken genereren
in verschillende formaten zoals onder getoond:

ebook-convert myrecipe.recipe myrecipe.epub

ebook-convert myrecipe.recipe myrecipe.mobi

...

Als tevreden bent met uw recept en u vindt dat er genoeg vraag is om het in te voegen in de set met ingebouwde recepten,
post dan uw recept in het calibre recipes forum11 om het te delen met andere gebruikers.

7 https://mechanize.readthedocs.io/en/latest/
8 https://www.crummy.com/software/BeautifulSoup/bs4/doc/
9 https://lxml.de/

10 https://github.com/html5lib/html5lib-python
11 https://www.mobileread.com/forums/forumdisplay.php?f=228
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Notitie

Op macOS bevinden de commandoregelprogramma’s zich in de calibre-bundel, bĳvoorbeeld, als u calibre hebt ge-
installeerd in /Applications bevinden de commandoregelprogramma’s zich in /Applications/calibre.app/
Contents/MacOS/.

Zie ook

ebook-convert (pagina 327)
De opdrachtregelinterface voor alle e-boekconversies.

2.4 Verder lezen
Om meer te leren over schrĳven van geavanceerde recepten met enkele van de mogelĳkheden beschikbaar in Basic-

NewsRecipe moet u volgende bronnen raadplegen:
API documentation (pagina 41)

Documentatie over de BasicNewsRecipe class en al zĳn belangrĳke methodes en velden.
BasicNewsRecipe12

De broncode van BasicNewsRecipe

Ingebouwde recepten13

De broncode voor de ingebouwde recepten die bĳ Calibre horen
Het calibre recepten forum14

Massa’s ervaren calibre recept schrĳven hier.

2.5 API documentatie
2.5.1 API documentatie voor recepten
De API voor het schrĳven van recepten is bepaald door de BasicNewsRecipe (pagina 41)
class calibre.web.feeds.news.BasicNewsRecipe(options, log, progress_reporter)

Basisklasse die logica bevat die nodig is in alle recepten. Door steeds meer functionaliteit in deze klasse te over-
schrĳven, kunt u steeds meer aangepaste/krachtige recepten maken. Voor een handleiding introductie tot het maken
van recepten, zie Uw favoriete nieuws website toevoegen (pagina 33).
classmethod adeify_images(soup)

Als je recept dat is geconverteerd naar EPUB problemen heeft met afbeeldingen bekeken in Adobe Digital
Editions, gebruik je deze methode vanuit postprocess_html() (pagina 45).

classmethod image_url_processor(baseurl, url)
Perform some processing on image urls (perhaps removing size restrictions for dynamically generated images,
etc.) and return the processed URL. Return None or an empty string to skip fetching the image.

classmethod print_version(url)
Neem een   ̀url` wĳzend naar de webpagina met artikelinhoud en retourneer de URL wĳzend naar de gedrukte
versie van het artikel. Doet standaard niets. Bĳvoorbeeld:

12 https://github.com/kovidgoyal/Calibre/blob/master/src/Calibre/web/feeds/news.py
13 https://github.com/kovidgoyal/calibre/tree/master/recipes
14 https://www.mobileread.com/forums/forumdisplay.php?f=228
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def print_version(self, url):

return url + '?&pagewanted=print'

classmethod tag_to_string(tag, use_alt=True, normalize_whitespace=True)
Gemaksmethode om een   ̀BeautifulSoup <https://www.crummy.com/software/BeautifulSoup/b43/doc>` _
Tag te nemen en de tekst er recursief uit te halen, inclusief eventuele CDATA-secties en alt tagattributen.
Geeft een mogelĳk lege Unicode string terug.
use_alt: Als` True` probeer het alt-attribuut te gebruiken voor labels die geen tekstuele inhoud hebben
tag: BeautifulSoup15 Tag

abort_article(msg=None)
Gebruik deze methode in een van de voorbewerk-methoden om de download voor het huidige artikel te be-
eindigen. Handig om artikelen over te slaan die ongepaste inhoud bevatten, zoals pure video-artikelen.

abort_recipe_processing(msg)
Zorgt ervoor dat het downloadsysteem voor recepten het downloaden van recepten afbreekt, en er een simpel
feedback-bericht aan de gebruiker wordt weergegeven.

add_toc_thumbnail(article, src)
Gebruik dit vanuit populate_article_metadata met het src attribuut van een <img>label uit het artikel dat
geschikt is om te gebruiken als de miniatuur die het artikel in de inhoudsopgave weergeeft. Of de miniatuur
daadwerkelĳk wordt gebruikt, is apparaatafhankelĳk (momenteel alleen in gebruik bĳ de Kindles). Merk op
dat de bedoelde afbeelding er een moet zĳn die succesvol is gedownload, anders wordt deze genegeerd.

canonicalize_internal_url(url, is_link=True)
Retourneer een set canonieke representaties van `` url``. De standaardimplementatie gebruikt alleen de host-
naam van de server en het pad van de URL, waarbĳ alle zoekparameters, fragmenten, enzovoort worden
genegeerd. De canonieke weergaven moeten uniek zĳn voor alle URL’s voor deze nieuwsbron. Als dat niet
het geval is, kunnen interne links onjuist worden opgelost.

Parameters
is_link – Is Waar als de URL afkomstig is van een interne link in een HTML-bestand. Onwaar
als de URL de URL is die werd gebruikt om een   artikel te downloaden.

cleanup()

Gebruikt nadat alle artikelen zĳn gedownload. Gebruik het om op te schonen, zoals het afmelden van abon-
nementssites, enz.

clone_browser(br)
Kloon de browser br. Gekloonde browsers worden gebruikt voor multi-threaded downloads, omdat mechani-
seren niet thread safe is. De standaard kloneringsroutines moeten de meeste browseraanpassingen vastleggen,
maar als u iets exotisch in uw recept doet, moet u deze methode in uw recept overschrĳven en handmatig klo-
nen.
Gekloonde browserinstances gebruiken standaard dezelfde, thread-safe CookieJar, tenzĳ u aangepaste coo-
kieverwerking hebt ingesteld.

default_cover(cover_file)

Maak een algemene omslag voor recepten die geen omslag hebben
download()

Download en verwerk alle artikelen uit de feeds in dit recept. Deze methode moet slechts één keer worden
aangeroepen voor een bepaalde receptinstantie. Meer dan één keer aanroepen zal leiden tot ongedefinieerd
gedrag. :return: Path to index.html
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extract_readable_article(html, url)
Haalt inhoud van hoofdartikel uit ‘html’, ruimt op en retourneert als een (article_html, extracted_title) tupel.
Gebaseerd op het oorspronkelĳke leesbaarheidsalgoritme van Arc90.

get_article_url(article)
Override in a subclass to customize extraction of the URL that points to the content for each article. Return
the article URL. It is called with article, an object representing a parsed article from a feed. See feedparser16.
By default it looks for the original link (for feeds syndicated via a service like FeedBurner or Pheedo) and if
found, returns that or else returns article.link17.

get_browser(*args, **kwargs)
Return a browser instance used to fetch documents from the web. By default it returns a mechanize18 browser
instance that supports cookies, ignores robots.txt, handles refreshes and has a random common user agent.
To customize the browser override this method in your sub-class as:

def get_browser(self, *a, **kw):

br = super().get_browser(*a, **kw)

# Add some headers

br.addheaders += [

('My-Header', 'one'),

('My-Header2', 'two'),

]

# Set some cookies

br.set_cookie('name', 'value')

br.set_cookie('name2', 'value2', domain='.mydomain.com')

# Make a POST request with some data

br.open('https://someurl.com', {'username': 'def', 'password': 'pwd'}).

↪→read()

# Do a login via a simple web form (only supported with mechanize␣

↪→browsers)

if self.username is not None and self.password is not None:

br.open('https://www.nytimes.com/auth/login')

br.select_form(name='login')

br['USERID'] = self.username

br['PASSWORD'] = self.password

br.submit()

return br

get_cover_url()

Retourneer een URL naar de omslagafbeelding voor deze editie of` Geen. Standaard retourneert het de waarde
van het lid self.cover_url dat normaal` Geen` is. Als u wilt dat uw recept een omslag voor het e-book download,
vervangt u deze methode in uw subklasse of stelt u de lid-variabele self.cover_url in voordat deze methode
wordt aangeroepen.

get_extra_css()

Retourneert standaard self.extra_css. Negeren als je de extra_css programmatisch wilt genereren.
get_feeds()

Retourneer een lĳst met RSS-feeds om op te halen voor dit profiel. Elk element van de lĳst moet een 2-
elementen-tupel van het formaat (titel, URL) zĳn. Als de titel Geen of een lege tekenreeks is, wordt de titel
uit de feed gebruikt. Deze methode is handig als uw recept een aantal bewerkingen moet uitvoeren om uit te
zoeken welke feeds moeten worden gedownload. Als dit het geval is, overschrĳft dit in uw subklasse.

get_masthead_title()

Overschrĳven in subklasse om iets anders dan de recept-titel te gebruiken
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get_masthead_url()

Retourneer een URL naar de masthead-afbeelding voor deze editie of` Geen. Standaard retourneert het de
waarde van het lid self.masthead_url dat normaal` Geen` is. Als u wilt dat uw recept een masthead voor het e-
book download, vervangt u deze methode in uw subklasse of stelt u de lid-variabele self.masthead_url in voor-
dat deze methode wordt aangeroepen. Masthead-afbeeldingen worden gebruikt in Kindle MOBI-bestanden.

get_obfuscated_article(url)
If you set articles_are_obfuscated this method is called with every article URL. It should return the path to a
file on the filesystem that contains the article HTML. That file is processed by the recursive HTML fetching
engine, so it can contain links to pages/images on the web. Alternately, you can return a dictionary of the form:
{‘data’: <HTML data>, ‘url’: <the resolved URL of the article>}. This avoids needing to create temporary
files. The url key in the dictionary is useful if the effective URL of the article is different from the URL
passed into this method, for example, because of redirects. It can be omitted if the URL is unchanged.
Deze methode is meestal nuttig voor sites die het moeilĳk maken om automatisch toegang te krĳgen tot
artikelinhoud.

get_url_specific_delay(url)
Return the delay in seconds before downloading this URL. If you want to programmatically determine the
delay for the specified URL, override this method in your subclass, returning self.delay by default for URLs
you do not want to affect.

Returns
A floating point number, the delay in seconds.

index_to_soup(url_or_raw, raw=False, as_tree=False, save_raw=None)
Gemaksmethode die een URL naar de indexpagina brengt en een BeautifulSoup <htt-
ps://www.crummy.com/software/BeautifulSoup/bs4/doc> _ terug geeft.
url_or_raw: ofwel een URL of de gedownloade indexpagina als een tekenreeks

is_link_wanted(url, tag)
Retourneer Waar als de link moet worden gevolgd of anders Onwaar. Hiermee wordt standaard NotImple-
mentedError gezet waardoor de downloader deze negeert.

Parameters
• url – De te volgen URL
• tag – Het label waarvan de URL is afgeleid

parse_feeds()

Maak een lĳst met artikelen uit de lĳst met feeds geretourneerd door BasicNewsRecipe.get_feeds()
(pagina 43). Retourneer een lĳst met Feed objecten.

parse_index()

Deze methode moet worden geïmplementeerd in recepten die een website verwerken in plaats van feeds om
een   lĳst met artikelen te genereren. Typische toepassingen zĳn voor nieuwsbronnen met een “Printeditie”
-webpagina met een overzicht van alle artikelen in de huidige gedrukte editie. Als deze functie is geïmple-
menteerd, wordt deze gebruikt in plaats van BasicNewsRecipe.parse_feeds() (pagina 44).
Het moet een lĳst retourneren. Elk element van de lĳst moet een 2-elementen tupel zĳn van de vorm ('feed

title', lijst van artikelen).
Elke lĳst met artikelen moet woordenboeken bevatten met de vorm:

{

'title' : article title,

'url' : URL of print version,

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
'date' : The publication date of the article as a string,

'description' : A summary of the article

'content' : The full article (can be an empty string). Obsolete

do not use, instead save the content to a temporary

file and pass a file:///path/to/temp/file.html as

the URL.

}

Als voorbeeld zie het recept voor het downloaden van The Atlantic. Daarnaast kunt u ‘author’ toevoegen voor
de auteur van het artikel.
Als u de verwerking om een   of andere reden wilt afbreken en Calibre aan de gebruiker een eenvoudig bericht
in plaats van een fout wilt laten tonen, roep dan meth: abort_recipe_processing aan.

populate_article_metadata(article, soup, first)
Wordt aangeroepen wanneer elke HTML-pagina die bĳ het artikel hoort wordt gedownload. Bedoeld om te
worden gebruikt om artikelmetadata te krĳgen zoals auteur / samenvatting / enz. van de bewerkte HTML
(soep).

Parameters
• article – Een object van klasse Calibre.web.feeds.Article. Als u de samenvatting

wĳzigt, vergeet dan niet om ook de text_summary te wĳzigen
• soup – Bewerkte HTML behorend bĳ dit artikel
• first – Waar als de bewerkte HTML de eerste pagina van het artikel is.

postprocess_book(oeb, opts, log)
Voer de benodigde nabewerking uit op het bewerkte gedownloade e-boek.

Parameters
• oeb – Een OEBBoek object
• opts – Omzet opties

postprocess_html(soup, first_fetch)
Deze methode wordt aangeroepen met de bron van elk gedownload HTML bestand, nadat het is bewerkt voor
koppelingen en afbeeldingen. Het kan worden gebruikt om willekeurig krachtige post-processing uit te voeren
op de HTML. Het moet soup teruggeven na bewerking.

Parameters
• soup – Een BeautifulSoup <https://www.crummy.com/software/BeautifulSoup/bs4/doc> _ in-

stantie die de gedownloade HTML bevat.
• first_fetch – Waar als dit de eerste pagina van een artikel is.

preprocess_html(soup)
Deze methode wordt aangeroepen met de bron van elk gedownload HTML bestand, voor dat het is bewerkt
voor koppelingen en afbeeldingen. Het wordt aangeroepen na het opschonen zoals gevraagd door remove_tags
enz. Het kan worden gebruikt om willekeurig krachtige post-processing uit te voeren op de HTML. Het moet
soup teruggeven na bewerking.
soup: Een BeautifulSoup <https://www.crummy.com/software/BeautifulSoup/bs4/doc> _ instantie die de ge-
downloade HTML bevat.
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preprocess_image(img_data, image_url)
Voer enige bewerking uit op gedownloade afbeeldingsgegevens. Dit wordt aangeroepen voor de onbewerkte
gegevens voordat enige formaat wĳziging is gedaan. Moet de verwerkte onbewerkte gegevens retourneren.
Retourneer None om de afbeelding over te slaan.

preprocess_raw_html(raw_html, url)
Deze methode wordt aangeroepen met de bron van elk gedownload HTML bestand, voordat het is bewerkt
in een object-boom. raw_html is een unicode-tekenreeks die de onbewerkte HTML vertegenwoordigt die is
gedownload van internet. url is de URL van waaruit de HTML is gedownload.
Merk op dat deze methode werkt * vóór * preprocess_regexps.
Deze methode moet de bewerkte raw_html retourneren als een unicode-object.

publication_date()

Use this method to set the date when this issue was published. Defaults to the moment of download. Must
return a datetime.datetime object.

skip_ad_pages(soup)
Deze methode wordt aangeroepen met de bron van elk gedownload HTML bestand, voordat een van de op-
schoonattributen zoals remove_tags, keep_only_tags worden toegepast. Merk op dat preprocess_regexps al
is toegepast. Het is bedoeld om het recept toe te staan   advertentiepagina’s over te slaan. Als de soep een
advertentiepagina vertegenwoordigt, retourneert u de HTML-code van de echte pagina. Anders retourneert
u Geen.
soup: Een BeautifulSoup <https://www.crummy.com/software/BeautifulSoup/bs4/doc> _ instantie die de ge-
downloade HTML bevat.

sort_index_by(index, weights)
Gemaksmethode om de titels in index te sorteren volgens` gewichten`. index wordt op zĳn plaats gesorteerd.
Retourneert index.
index: Een lĳst van titels.
gewichten: een woordenboek dat gewichten toewĳst aan titels. Als titels in de index niet in ‘gewichten’ voor-
komen, wordt aangenomen dat ze een gewicht van 0 hebben.

articles_are_obfuscated = False

Stel in op True en implementeer get_obfuscated_article() (pagina 44) om websites te beheren die
het moeilĳk maken om inhoud te schrapen.

auto_cleanup = False

Haal automatisch alle tekst uit de gedownloade artikelpagina’s. Gebruikt de algoritmen van het leesbaar-
heidsproject. Als u dit instelt op True, betekent dit dat u zich geen zorgen hoeft te maken over het handmatig
opschonen van de gedownloade HTML (hoewel handmatige opschoning altĳd beter is).

auto_cleanup_keep = None

Geef elementen op die het algoritme voor automatische opruiming nooit mag verwĳderen. De syntaxis is een
XPath-uitdrukking. Bĳvoorbeeld:

auto_cleanup_keep = '//div[@id="article-image"]' will keep all divs with

id="article-image"

auto_cleanup_keep = '//*[@class="important"]' will keep all elements

with class="important"

auto_cleanup_keep = '//div[@id="article-image"]|//span[@class="important"]'

will keep all divs with id="article-image" and spans

with class="important"
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browser_type = 'mechanize'

The simulated browser engine to use when downloading from servers. The default is to use the Python me-
chanize browser engine, which supports logging in. However, if you don’t need logging in, consider changing
this to either ‘webengine’ which uses an actual Chromium browser to do the network requests or ‘qt’ which
uses the Qt Networking backend. Both ‘webengine’ and ‘qt’ support HTTP/2, which mechanize does not and
are thus harder to fingerprint for bot protection services.

center_navbar = True

Indien Waar dan is de navigatiebalk gecentreerd, anders is deze links uitgelĳnd
compress_news_images = False

Set this to False to ignore all scaling and compression parameters and pass images through unmodified. If
True and the other compression parameters are left at their default values, images will be scaled to fit in the
screen dimensions set by the output profile and compressed to size at most (w * h)/16 where w x h are the
scaled image dimensions.

compress_news_images_auto_size = 16

De factor gebruikt bĳ automatisch comprimeren van JPEG afbeeldingen. Indien ingesteld op
Geen, is automatische compressie uitgeschakeld. Anders worden afbeeldingen verkleind naar
(w*h)/compress_news_images_auto_size bytes indien mogelĳk door verlaging kwaliteitsniveau, waar-
bĳ w x h de afbeeldingsdimensies in pixels zĳn. Minimale JPEG-kwaliteit is 5/100, deze beperking
wordt dus mogelĳk niet gehaald. Deze parameter kan genegeerd worden door de parameter com-
press_news_images_max_size die een vaste maximumgrootte voor afbeeldingen biedt. Merk op dat als u
scale_news_images_to_device inschakelt, de afbeelding eerst geschaald wordt en dan de kwaliteit verlaagd
totdat de grootte minder is dan (w * h)/factor, waarbĳ w en h nu de afmetingen van de geschaalde afbeelding
zĳn. Met andere woorden, deze compressie gebeurt na het schalen.

compress_news_images_max_size = None

Stel JPEG-kwaliteit in zodat afbeeldingen de gegeven grootte (in KBytes) niet overschrĳden. Indien ingesteld,
negeert deze parameter automatische compressie via compress_news_images_auto_size. De minimale JPEG-
kwaliteit is 5/100, deze beperking wordt dus mogelĳk niet gehaald.

conversion_options = {}

Receptspecifieke opties om de conversie van de gedownloade content naar een e-book te sturen. Deze zul-
len elke door gebruiker of plugin opgegeven waarden overschrĳven, dus alleen gebruiken als dit absoluut
noodzakelĳk is. Bĳvoorbeeld:

conversion_options = {

'base_font_size' : 16,

'linearize_tables' : True,

}

cover_margins = (0, 0, '#ffffff')

Standaard wordt de omslagafbeelding teruggegeven door get_cover_url() gebruikt als omslag voor het tĳd-
schrift. Dit negeren in uw recept zegt calibre de gedownloade omslag in een frame weer te geven waar breedte
en hoogte zĳn uitgedrukt als een percentage van de gedownloade omslag. cover_margins = (10, 15, ‘#ffffff’)
geeft de hoes een witte marge van 10px links en rechts, 15px boven en onder. Kleurnamen gedefinieerd
hier19. Merk op dat om welke reden dan ook wit niet altĳd werkt in Windows. Gebruik in plaats daarvan
#ffffff

delay = 0

The default delay between consecutive downloads in seconds. The argument may be a floating point number
to indicate a more precise time. See get_url_specific_delay() (pagina 44) to implement per URL
delays.
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description = ''

Een paar regels die de inhoud beschrĳven die door dit recept wordt gedownload. Dit wordt voornamelĳk
gebruikt in een GUI die een lĳst met recepten aanbiedt.

encoding = None

Geef een overschrĳf-codering op voor sites met een onjuiste karakterset-specificatie. De meest gebruikelĳke
is ‘latin1` opgeven en “cp1252” gebruiken. Als None, probeer de codering te detecteren. Als het een aan-
roepbare is, wordt deze aangeroepen met twee argumenten: het receptobject en de bron die moet worden
gedecodeerd. Het moet de gedecodeerde bron retourneren.

extra_css = None

Specificeer elke extra CSS die toegevoegd moet worden aan gedownloadde HTML. Het wordt ingevoegd in
<style> tags, net voor de sluit </head> tag daarbĳ alleCSS negerend behalve wat is aangegeven met gebruik van
het stĳl attribuut bĳ individuele HTML tags. Merk op dat als u programmatisch de extra_css wilt genereren,
negeer de get_extra_css() (pagina 43) methode. Bv.:

extra_css = '.heading { font: serif x-large }'

feeds = None

Lĳst met feeds om te downloaden. Kan zowel [url1, url2, ...] als [('title1', url1), ('tit-

le2', url2),...] zĳn
filter_regexps = []

List of regular expressions that determines which links to ignore. If empty it is ignored. Used only if
is_link_wanted is not implemented. For example:

filter_regexps = [r'ads\.doubleclick\.net']

verwĳdert alle URLs met ads.doubleclick.net erin.
Maar één van BasicNewsRecipe.match_regexps (pagina 49) of BasicNewsRecipe.

filter_regexps (pagina 48) mag gedefinieerd zĳn.
handle_gzip = True

Set to False if you do not want to use gzipped transfers with the mechanize browser. Note that some old
servers flake out with gzip.

ignore_duplicate_articles = None

Negeer dubbels van artikels die in meermaals aanwezig zĳn. Een dubbel artikel is een artikel dat dezelfde titel
en/of URL heeft. Om artikelen met dezelfde titel te negeren, stel dit in op:

ignore_duplicate_articles = {'title'}

Om in plaats daarvan URL’s te gebruiken, stel het in op:

ignore_duplicate_articles = {'url'}

Om te matchen op titel of URL, stel het in op:

ignore_duplicate_articles = {'title', 'url'}

keep_only_tags = []

Behoud enkel de gespecificeerde tags en hun kinderen. Voor het formaat om een tag te specificeren, zie
BasicNewsRecipe.remove_tags (pagina 50). Als deze lĳst niet leeg is, wordt de <body> tag geleegd en
hervuld met de tags die overeenkomen met de vermeldingen in deze lĳst. Bv.:
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keep_only_tags = [dict(id=['content', 'heading'])]

behoud enkel tags die een id attribuut hebben van “content” of “heading”.
language = 'und'

De taal van het nieuws. Moet een ISO-639 code zĳn, twee of drie karakters lang
masthead_url = None

By default, calibre will use a default image for the masthead (Kindle only). Override this in your recipe to
provide a URL to use as a masthead.

match_regexps = []

Lĳst met reguliere expressies die bepaalt welke links te volgen. Wordt genegeerd indien leeg. Enkel gebruikt
als is_link_wanted niet geïmplementeerd is. Bv.:

match_regexps = [r'page=[0-9]+']

komt overeen met alle URLs die page=some number becatten.
Maar één van BasicNewsRecipe.match_regexps (pagina 49) of BasicNewsRecipe.

filter_regexps (pagina 48) mag gedefinieerd zĳn.
max_articles_per_feed = 100

Maximaal aantal artikelen te downloaden van elke feed. Dit is vooral bruikbaar voor feeds die geen artikelda-
tum hebben. Voor de meeste feeds moet u BasicNewsRecipe.oldest_article (pagina 49) gebruiken

needs_subscription = False

If True the GUI will ask the user for a username and password to use while downloading. If set to “optional”
the use of a username and password becomes optional

no_stylesheets = False

Convenient flag to disable loading of stylesheets for websites that have overly complex stylesheets unsuitable
for conversion to e-book formats. If True stylesheets are not downloaded and processed

oldest_article = 7.0

Oldest article to download from this news source. In days.
preprocess_regexps = []

List of regexp substitution rules to run on the downloaded HTML. Each element of the list should be a two
element tuple. The first element of the tuple should be a compiled regular expression and the second a callable
that takes a single match object and returns a string to replace the match. For example:

preprocess_regexps = [

(re.compile(r'<!--Article ends here-->.*</body>', re.DOTALL|re.IGNORECASE),

lambda match: '</body>'),

]

will remove everything from <!–Article ends here–> to </body>.
publication_type = 'unknown'

Publication type Set to newspaper, magazine or blog. If set to None, no publication type metadata will be
written to the opf file.

recipe_disabled = None

Set to a non empty string to disable this recipe. The string will be used as the disabled message

2.5. API documentatie 49



calibre Gebruikershandleiding, Release 8.7.0

recipe_specific_options = None

Specify options specific to this recipe. These will be available for the user to customize in the Advanced tab
of the Fetch News dialog or at the ebook-convert command line. The options are specified as a dictionary
mapping option name to metadata about the option. For example:

recipe_specific_options = {

'edition_date': {

'short': 'The issue date to download',

'long': 'Specify a date in the format YYYY-mm-dd to download the␣

↪→issue corresponding to that date',

'default': 'current',

}

}

When the recipe is run, self.recipe_specific_options will be a dict mapping option name to the option value
specified by the user. When the option is unspecified by the user, it will have the value specified by ‘default’.
If no default is specified, the option will not be in the dict at all, when unspecified by the user.

recursions = 0

Number of levels of links to follow on article webpages
remove_attributes = []

List of attributes to remove from all tags. For example:

remove_attributes = ['style', 'font']

remove_empty_feeds = False

If True empty feeds are removed from the output. This option has no effect if parse_index is overridden in
the sub class. It is meant only for recipes that return a list of feeds using feeds or get_feeds() (pagina 43).
It is also used if you use the ignore_duplicate_articles option.

remove_javascript = True

Convenient flag to strip all JavaScript tags from the downloaded HTML
remove_tags = []

List of tags to be removed. Specified tags are removed from downloaded HTML. A tag is specified as a
dictionary of the form:

{

name : 'tag name', #e.g. 'div'

attrs : a dictionary, #e.g. {'class': 'advertisement'}

}

All keys are optional. For a full explanation of the search criteria, see Beautiful Soup20 A common example:

remove_tags = [dict(name='div', class_='advert')]

This will remove all <div class=”advert”> tags and all their children from the downloaded HTML.
remove_tags_after = None

Remove all tags that occur after the specified tag. For the format for specifying a tag see BasicNewsRecipe.
remove_tags (pagina 50). For example:

remove_tags_after = [dict(id='content')]

will remove all tags after the first element with id=”content”.
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remove_tags_before = None

Remove all tags that occur before the specified tag. For the format for specifying a tag see
BasicNewsRecipe.remove_tags (pagina 50). For example:

remove_tags_before = dict(id='content')

will remove all tags before the first element with id=”content”.
requires_version = (0, 6, 0)

Minimaal benodigde Calibre versie om dit recept te gebruiken
resolve_internal_links = False

If set to True then links in downloaded articles that point to other downloaded articles are changed to point
to the downloaded copy of the article rather than its original web URL. If you set this to True, you might also
need to implement canonicalize_internal_url() (pagina 42) to work with the URL scheme of your
particular website.

reverse_article_order = False

Volgorde van artikelen omdraaien in iedere feed
scale_news_images = None

Maximum dimensions (w,h) to scale images to. If scale_news_images_to_device is True this is set to the
device screen dimensions set by the output profile unless there is no profile set, in which case it is left at
whatever value it has been assigned (default None).

scale_news_images_to_device = True

Rescale images to fit in the device screen dimensions set by the output profile. Ignored if no output profile is
set.

simultaneous_downloads = 5

Number of simultaneous downloads. Set to 1 if the server is picky. Automatically reduced to 1 if
BasicNewsRecipe.delay (pagina 47) > 0

summary_length = 500

Maximum aantal tekens om te gebruiken in korte omschrĳving
template_css = '\n .article_date {\n color: gray; font-family: monospace;\n }\n\n

.article_description {\n text-indent: 0pt;\n }\n\n a.article {\n font-weight:

bold; text-align:left;\n }\n\n a.feed {\n font-weight: bold;\n }\n\n

.calibre_navbar {\n font-family:monospace;\n }\n '

The CSS that is used to style the templates, i.e., the navigation bars and the Tables of Contents. Rather than
overriding this variable, you should use extra_css in your recipe to customize look and feel.

timefmt = ' [%a, %d %b %Y]'

The format string for the date shown on the first page. By default: Day_Name, Day_Number Month_Name
Year

timeout = 120.0

Timeout voor ophalen van bestanden van de server in seconden
title = 'Onbekende nieuwsbron'

The title to use for the e-book
use_embedded_content = None

Normally we try to guess if a feed has full articles embedded in it based on the length of the embedded
content. If None, then the default guessing is used. If True then the we always assume the feeds has embedded
content and if False we always assume the feed does not have embedded content.
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De e-boek viewer

calibre bevat een ingebouwde e-boek viewer die alle belangrĳke e-boek formaten kan lezen. De e-boek viewer is zeer
aanpasbaar en heeft veel geavanceerde functies.

• Starten van de e-boek viewer (pagina 54)
• Door een e-book navigeren (pagina 54)
• Tekst highlighten (pagina 55)
• Lees hardop (pagina 55)
• In de tekst zoeken (pagina 55)
• Links volgen met enkel het toetsenbord (pagina 56)
• De look and feel van de leeservaring personalizeren (pagina 56)
• Opzoeken in woordenboek (pagina 56)
• Kopieer tekst en afbeeldingen (pagina 56)
• Inzoomen op afbeeldingen (pagina 57)
• Syncing with a paper edition of the current book (pagina 57)
• Toetsenbord sneltoetsen (pagina 57)
• Niet-opnieuw stroombare inhoud (pagina 59)
• Designing your book to work well with the calibre E-book viewer (pagina 60)
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3.1 Starten van de e-boek viewer
U kunt ieder boek bekĳken in uw calibre-bibliotheek door het boek te selecteren en de knop Bekĳken te drukken. Hiermee
wordt het boek geopend in de lezer. U kunt de lezer ook inschakelen vanaf het Start-menu in Windows. In macOS, kunt
U het vastzetten in het dock en het van daaruit starten. In Linux you kunt U de starter in het desktop menu gebruiken of
het commando command ebook-viewer gebruiker.

3.2 Door een e-book navigeren
U kunt in een boek ‘pagina’s omslaan’ door:

• Klikken in de linker- of rechtermarge of in de pagina met de muis
• Drukken op :kbd: spatiebalk, :kbd:` pagina omhoog`, :kbd: pagina omlaag of pĳltoetsen
• Op een touchscreen tikken op de tekst of naar links en rechts vegen

U heeft toegang tot de lezerbediening via:
• Rechtsklikken op de tekst
• Drukken op de :kbd: Esc of :kbd:` Menu` toetsen
• Op een aanraakscherm door op het bovenste 1/3 van het scherm te tikken

De viewer heeft twee modi, ‘gepagineerd” en “vloeiend”. In gepagineerde modus komt het boek in pagina’s, zoals een
papieren boek. In vloeiende modus loopt de tekst door zoals in een web browser. U kan ertussen schakelen met de viewer
Voorkeuren → Conversie onder Algemene opties → Pagina opmaak of door de Ctrl+M toets in te drukken.

3.2.1 Bladwijzers
Als u midden in een boek bent en de e-boek viewer sluit, zal deze onthouden waar u stopte met lezen en daar terugkeren
de volgende keer u het boek opent. U kan ook bladwĳzers instellen in het boek met de Bladwĳzers knop in de e-boek
viewer bediening of door Ctrl+B in te drukken. Bĳ EPUB boeken worden deze bladwĳzers opgeslagen in het EPUB
bestand zelf. U kan bladwĳzers opslaan en dan het bestand naar een vriend sturen. Als ze het bestand openen, zullen ze
uw bladwĳzers kunnen zien. U kan dit uitschakelen in de Diversen sectie van de viewer voorkeuren.

3.2.2 Inhoudsopgave
Als het boek dat u leest een inhoudsopgave heeft, kunt u die openen door op de knop: guilabel :`inhoudsopgave’ te
drukken. Dit geeft een lĳst met secties in het boek weer. U kan op eender welke klikken om naar dat gedeelte van het
boek te springen.

3.2.3 Navigeren op locatie
E-boeken hebben, in tegenstelling tot papieren boeken, geen concept van pagina’s. U kunt naar exacte locaties in e-boeken
verwĳzen met behulp van de Ga naar →  Locatie-functionaliteit in de lezerbediening.
U kunt deze locatiegegevens gebruiken om ondubbelzinnig naar delen van de boeken te verwĳzen bĳ bespreken met vrien-
den of ernaar verwĳzen in andere werken. U kunt deze locaties invoeren onder Ga naar →  Locatie in de lezerbediening.
Er is een URL die u kan kopiëren naar het plakbord en plakken in andere programma’s of documenten. Klikken op deze
URL opet het boek in de calibre e-boek viewer op de huidige locatie.
Als u op de links klikt in het e-boek die u naar andere delen in het boek brengen, zoals een eindnoot, dan kan u de knoppen
Terug and Voorwaarts links bovenaan in de lezerbediening. Deze knoppen gedragen zich zoals die in een web browser.
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3.2.4 Referentiemodus
calibre heeft ook een handige Reference mode. U kan het aanzetten door op de Reference mode knop in de lezerbediening
te klikken. Als u dit doet, krĳgt elke alinea een uniek nummer weergeven aan het begin, bestaand uit de sectie- en
alineanummers.
U kunt dit nummer gebruiken om ondubbelzinnig te refereren aan delen van de boeken wanneer u die bespreekt met
vrienden of in andere werken hieraan wilt refereren. U kunt deze nummers ingeven in het guilabel:Go to function om naar
een specifieke referentie locatie te gaan.

3.3 Tekst highlighten
Als u tekst selecteert in de viewer verschĳnt er een kleine pop-up naast de selectie. U kan op de highlight knop in die balk
klikken om een highlight te maken. U kan nota’s toevoegen en de kleur van de highlight veranderen. Bĳ een aanraak-
scherm, tik lang op een woord om te selecteren en de pop-up te tonen. In highlight modus kan u welke tekst geselecteerd is
met aanraak vriendelĳke selectiegrepen. Sleep de grepen naar de boven- of ondermarge om te scrollen tĳdens selecteren.
U kan ook Shift+klik of rechtse klik om de selectie uit te breiden, zeer bruikbaar bĳ multi-pagina selectie.
U kan de Highlights knop in de viewerbediening gebruiken om een apart paneel met een lĳst van alle highlights in het
boek te tonen, gesorteerd per hoofdstuk.
U kan alle highlights in uw hele calibre bekĳken doorbladeren door rechts te klikken op de Tonen knop en Doorblader
annotaties te kiezen.
Tenslotte, als u de calibre Content server’s in browser viewer gebruikt, kan u de viewer z’n annotaties laten synchroniseren
met de browser viewer via Voorkeuren → Diversen in de viewer voorkeuren en invoeren van de gebruikersnaam van de
Content server viewer om mee te synchroniseren. Gebruik de joker * om te synchroniseren met anonieme gebruikers.

3.4 Lees hardop
The viewer can read book text aloud. To use it you can simply click the Read aloud button in the viewer controls to start
reading book text aloud. The word or sentence being currently read is highlighted. Speech is synthesized from the text
using either the Piper21 neural text-to-speech engine or your operating system services for text-to-speech. You can change
the backend and the voice being used by clicking the gear icon in the bar that is displayed while Read aloud is active.
U kan ook gehighlighte delen luidop voorlezen door de Luidop lezen knop toe te voegen aan selectiebalk in de viewer
voorkeuren onder Selectiegedrag.

Notitie

Support for text-to-speech in browsers is very incomplete and bug-ridden so how well Read aloud will work in the
in-browser viewer is dependent on how well the underlying browser supports text-to-speech.

3.5 In de tekst zoeken
The viewer has very powerful search capabilities. Press the Ctrl+F key or access the viewer controls and click search. The
simplest form of searching is to just search for whatever text you enter in the text box. The different forms of searching
are chosen by the search mode box below the search input. Available modes are:

1. Contains - The simplest default mode. The text entered in the search box is searched for anywhere. All punctuation,
accents and spaces are ignored. For example, the search: Pena will match all of the following: penal, pen a,

pen.a and Peña. If you select the Case sensitive box then accents, spaces and punctuation are no longer ignored.
21 https://github.com/rhasspy/piper
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2. Whole words - Searches for whole words. So for example, the search pena will match the word Peña but not the
word Penal. As with Contains searches above, accents and punctuation are ignored unless the Case sensitive box
is checked.

3. Nearby words - Searches for whole words that are near each other. So for example, the search calibre cool

will match places where the words calibre and cool occur within sixty characters of each other. To change the
number of characters add the new number to the end of the list of words. For instance, calibre cool awesome

120 will match places where the three words occur within 120 characters of each other. Note that punctuation and
accents are not ignored for these searches.

4. Regex - Interprets the search text as a regular expression. To learn more about using regular expressions, see the
tutorial (pagina 216).

3.6 Links volgen met enkel het toetsenbord
De e-boekviewer heeft een Hintmodus die u toelaat op links in de tekst te klikken zonder muis.Druk de Alt+F toets in
en alle links in het huidige scherm worden gehighlight met een cĳfer of letter erover. Tik de letter op uw toetsenbord om
op de link te klikken. Drukken op de Esc toets voert de Hintmodus af zonder een link te selecteren.
Als er meer dan 35 links op het scherm zĳn, hebben sommige meerdere letters. Tik in dat geval de eerste en de tweede
of de eerste en tik Enter om te activeren. U kan ook Backspace gebruiken om een tikfout te herstellen.

3.7 De look and feel van de leeservaring personalizeren
U kunt lettergroottes in een wip wĳzigen door Lettergrootte in de lezerbediening te gebruiken of Ctrl ++ of Ctrl+- of
de toets Ctrl ingedrukt te houden en het muiswiel te gebruiken.
Kleuren kunnen worden gewĳzigd in de Colors sectie van de lezervoorkeuren.
U kunt het aantal pagina’s dat op het scherm wordt weergegeven alsmede de paginamarges wĳzigen in Paginalay-out in
de lezervoorkeuren.
U kunt aangepaste kopteksten en voetteksten weergeven, zoals de resterende tĳd om te lezen, de titel van het huidige
hoofdstuk, de boekpositie, enz. via het Kopteksten en voetteksten van de voorkeuren van de lezer.
Meer geavanceerde aanpassing kunnen worden bereikt met de instellingen :guilabel: Styles. Hier kunt u een achtergrond-
afbeelding specificeren om onder de tekst weer te geven en ook kunt u een stĳlblad instellen dat op elk boek wordt
toegepast. Hiermee kunt u dingen doen zoals alineastĳlen wĳzigen, tekstuitvulling enz. Voor voorbeelden van aangepas-
te stylesheets die door gebruikers van calibre worden gebruikt, zie `de forums <https://www.mobileread.com/forums/
showthread.php?t=51500 > `_.

3.8 Opzoeken in woordenboek
U kan de betekenis van woorden opzoeken door dubbelklikken of lang tikken op het woord dat u wilt opzoeken en dan
te klikken op de opzoek knop die eruit ziet als een bibliotheek.

3.9 Kopieer tekst en afbeeldingen
U kunt tekst en afbeeldingen selecteren door de inhoud met uw muis te slepen en vervolgens met de rechtermuisknop
te klikken en te selecteren Copy om naar het klembord te kopiëren. Het gekopieerde materiaal kan als platte tekst en
afbeeldingen in een andere applicatie worden geplakt.
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3.10 Inzoomen op afbeeldingen
U kunt inzoomen om een afbeelding op ware grootte in een apart venster weer te geven door erop te dubbelklikken of
lang te tikken. U kunt er ook op rechtsklikken en kiezen: guilabel :Bekĳk afbeelding.

3.11 Syncing with a paper edition of the current book
Some e-books, that have corresponding print editions, include metadata that marks the start of each paper page. For such
e-books, the viewer allows you to jump to a particular paper edition page via the Go to button in the viewer controls. You
can also optionally display the paper page corresponding to the current location in the book’s headers or footers via the
viewer settings, by adding Pages from paper edition to either the header or the footer.

3.12 Toetsenbord sneltoetsen
The viewer has extensive keyboard shortcuts, like the rest of calibre. They can be customised in the viewer Preferences.
The default shortcuts are listed below:

Tabel 1: Keyboard shortcuts for the calibre E-book viewer
Toet-
sen-
bord
snel-
koppe-
ling

Actie

Home,

Ctrl+ArrowUp,

Ctrl+ArrowLeft

Scroll to the start of the current file in a multi file book

Ctrl+HomeBlader naar het begin van het boek
Ctrl+EndBlader naar het einde van het boek
End,

Ctrl+ArrowDown,

Ctrl+ArrowRight

Scroll to the end of the current file in a multi file book

Ar-

rowUp

Blader terug, gelĳkmatig in vloeiende-stand en bĳ volledig scherm in pagina-stand

Ar-

row-

Down

Blader vooruit, gelĳkmatig in vloeiende-stand en bĳ volledig scherm in pagina-stand

Ar-

row-

Left

Langzaam naar links scrollen in vloeiende-stand en bĳ een pagina in pagina-stand

Ar-

row-

Right

Langzaam naar rechts scrollen in vloeiende-stand en bĳ een pagina in pagina-stand

PageUp,

Shift+Spacebar

Blader gelĳkmatig terug bĳ volledig scherm

Vervolgt op volgende pagina
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Tabel 1 – Vervolgd van vorige pagina
Toet-
sen-
bord
snel-
koppe-
ling

Actie

PageDown,

Spa-

cebar

Blader gelĳkmatig vooruit bĳ volledig scherm

Ctrl+PageUpScroll naar de vorige paragraaf
Ctrl+PageDownScroll naar de volgende paragraaf
Alt+ArrowLeftTerug
Alt+ArrowRightVolgende
Ctrl+T Toggle Table of Contents
Ctrl+S Lees hardop
Alt+P Change settings quickly by creating and switching to profiles
Alt+f Volg links met het toetsenbord
Ctrl+C Naar klembord kopiëren
Alt+C Kopieer huidige locatie naar klembord
Ctrl+Shift+CKopieer huidige locatie als calibre:// URL naar klembord
/,

Ctrl+f,
Cmd+f

Begin met zoeken

F3,

Enter

Volgende zoeken

Shift+F3,

Shift+Enter

Vorige zoeken

Ctrl+Plus,
Me-

ta+Plus

Lettertype vergroten

Ctrl+Minus,
Me-

ta+Minus

Lettertype verkleinen

Ctrl+0 Standaard font grootte herstellen
Ctrl+] Verhoog het aantal pagina’s per scherm
Ctrl+[ Verlaag het aantal pagina’s per scherm
Ctrl+Alt+CMaak het aantal pagina’s per scherm automatisch
F11,

Ctrl+Shift+F
Volledig scherm aan/uit

Ctrl+M Wissel tussen Pagina-stand en Vloeiende-stand voor tekst layout
Ctrl+W Schakel de schuifbalk in
Ctrl+X Wissel de Referentie-stand
Ctrl+B Toon/verberg bladwĳzers
Ctrl+Alt+BNieuwe bladwĳzer
Ctrl+N,

Ctrl+E

Toon de metadata van het boek

Ctrl+Alt+F5,

Ctrl+Alt+R

Boek herladen

Vervolgt op volgende pagina
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Tabel 1 – Vervolgd van vorige pagina
Toet-
sen-
bord
snel-
koppe-
ling

Actie

Ctrl+Shift+ArrowRightWĳzig de huidige selectie vooruit door een woord
Ctrl+Shift+ArrowLeftWĳzig de huidige selectie achteruit door een woord
Shift+ArrowRightWĳzig de huidige selectie vooruit met een letter
Shift+ArrowLeftWĳzig de huidige selectie achteruit met een letter
Shift+ArrowDownWĳzig de huidige selectie vooruit met een regel
Shift+HomeBreid huidige selectie uit tot het begin van de regel
Shift+EndBreid huidige selectie uit tot het einde van de regel
Ctrl+A Alles selecteren
Shift+ArrowUpWĳzig de huidige selectie achteruit met een regel
Ctrl+Shift+ArrowDownWĳzig de huidige selectie vooruit met een paragraaf
Ctrl+Shift+ArrowUpWĳzig de huidige selectie achteruit met een paragraaf
Esc,

Menu-

Key

Toon de e-boekviewer controls

Ctrl+Comma,

Ctrl+Esc,
Me-

ta+Esc,
Me-

ta+Comma

Toon de e-boekviewer voorkeuren

Ctrl+G,
;, :

Ga naar een geselecteerd boek of positie

Ctrl+SpacebarSchakel automatisch scrollen in
Alt+ArrowUpSneller automatisch bladeren
Alt+ArrowDownTrager automatisch bladeren
Ctrl+I Toon/verberg Controleur
Ctrl+L Toon/verberg de woorden pop-up venster
Ctrl+Q
(Cmd+Q
on ma-

cOS)

Afsluiten

Ctrl+P Afdrukken naar PDF
Ctrl+F11Wissel de werkbalk
Ctrl+H Schakel het deelvenster met markeringen
Ctrl+D Bewerk dit boek

3.13 Niet-opnieuw stroombare inhoud
Sommige boeken hebben zeer brede inhoud die niet kan afbreken aan paginagrenzen. Bv. tabellen of <pre> tags. In
dergelĳke gevallen schakelt u de viewer naar flow-modus door Ctrl+M te tikken om deze inhoud te lezen. Anderzĳds
kunt u ook volgende CSS toevoegen aan het :guilabel: Stĳlen gedeelte van de viewervoorkeuren om de viewer te dwingen
tekstregels op te splitsen in <pre> tags:
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code, pre { white-space: pre-wrap }

3.14 Designing your book to work well with the calibre E-book viewer
The calibre E-book viewer will set the is-calibre-viewer class on the root element. So you can write CSS rules that
apply only for it. Additionally, the viewer will set the following classes on the body element:
body.calibre-viewer-dark-colors

Instellen wanneer donker kleurenschema te gebruiken
body.calibre-viewer-light-colors

Instellen wanneer licht kleurenschema te gebruiken
body.calibre-viewer-paginated

Instellen wanneer in gepagineerde modus
body.calibre-viewer-scrolling

Instellen wanneer vloeiende (niet-gepagineerde) modus te gebruiken
body.calibre-footnote-container

Set when displaying a popup footnote
Finally, you can use the calibre color scheme colors via CSS variables22. The calibre E-book viewer defines the follo-
wing variables: --calibre-viewer-background-color, --calibre-viewer-foreground-color and optio-
nally --calibre-viewer-link-color in color themes that define a link color.

22 https://developer.mozilla.org/en-US/docs/Web/CSS/Using_CSS_custom_properties
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E-boek conversie

calibre heeft een conversiesysteem ontworpen voor gebruiksvriendelĳkheid. Normaal voegt u gewoon een boek toe aan
calibre, klikt op converteren en calibre zal hard proberen een uitvoer te genereren zo dicht mogelĳk bĳ de invoer. calibre
accepteert echter een groot aantal invoerformaten, niet allemaal even geschikt voor conversie naar e-boeken. In het geval
van zo’n invoerformaten, of als u gewoon meer controle over het conversiesysteem wilt, heeft calibre veel opties om het
conversieproces te verfĳnen. Merk op dat het conversiesysteem van calibre geen vervanging is voor een volledige e-boek
bewerker. Om e-boeken te bewerken raad ik aan ze eerst te converteren naar EPUB of AZW3 via calibre en dan de Boek
bewerken functie te gebruiken om ze in perfecte vorm te krĳgen. U kunt dan het bewerkte e-boek gebruiken als invoer
voor conversie naar andere formaten in calibre.
Dit document behandelt hoofdzakelĳk de conversie-instellingen zoals gevonden in het conversie dialoogvenster, onder
afgebeeld. Al deze instellingen zĳn ook beschikbaar via de opdrachtregel, zie ook ebook-convert (pagina 327). In calibre
kunt u hulp krĳgen bĳ elke individuele instelling door er met uw muis over te gaan waarna een tooltip verschĳnt met de
beschrĳving.
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Inhoud

• Inleiding (pagina 63)
• Uitstraling & gevoel (pagina 64)
• Pagina opmaak (pagina 67)
• Heuristische verwerking (pagina 67)
• Zoeken & vervangen (pagina 69)
• Structuurdetectie (pagina 69)
• Inhoudsopgave (pagina 70)
• Gebruik afbeeldingen als hoofdstuktitels tĳdens de conversie van HTML invoer-documenten (pagina 72)
• Gebruik tag attributen om de tekst te halen t.b.v. Inhoudsopgave (pagina 72)
• Hoe opties worden ingesteld/opgeslagen voor conversie (pagina 72)
• Formaat specifieke tips (pagina 73)
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4.1 Inleiding
Wat u als eerste moet weten over het systeem van conversie is dat het ontworpen is als een pĳplĳn. Schematisch ziet het
er als volgt uit:

Het invoerformaat wordt eerst geconverteerd naar XHTML door de gepaste Input plugin. Deze HTML wordt vervolgens
getransformeerd. In de laatste stap wordt de verwerkte XHTML geconverteerd naar het opgegeven uitvoerformaat door
de juiste Uitvoer plugin. De resultaten van de conversie kunnen sterk variëren, op basis van het invoerformaat. Sommige
formaten converteren beter dan andere. Een lĳst met de beste bronformaten voor conversie is beschikbaar: ref:hier <best-
source-formats>.
De transformaties uitgevoerd op de XHTML-uitvoer zĳn waar alles gebeurt. Er zĳn verschillende transformaties, bĳvoor-
beeld om boek metadata in te voegen als een pagina aan het begin van het boek, om hoofdstukkoppen te detecteren en
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automatisch een Inhoudsopgave te maken, om de lettergroottes proportioneel aan te passen, enz. Het is belangrĳk om te
onthouden dat alle transformaties op de XHTML-uitvoer van de Invoer plug-in werken, niet op het invoerbestand zelf.
Dus als u bĳvoorbeeld calibre vraagt om een RTF-bestand naar EPUB te converteren, wordt het eerst intern naar XHTML
geconverteerd, de verschillende transformaties worden op de XHTML toegepast en vervolgens maakt de Uitvoer plug-in
het EPUB-bestand, automatisch alle metadata, inhoudsopgave, enz genererend.

U kunt dit proces in actie zien door de debug optie te gebruiken. Geef het pad op naar een map voor

de uitvoer van de foutenopsporing. Tĳdens conversie zal calibre de XHTML gegenereerd door de diverse stadia van de
conversie pĳplĳn in verschillende sub-mappen plaatsen. De vier sub-mappen zĳn:

Tabel 1: Stappen in het conversieproces
Map Omschrĳving
invoer Dit bevat de HTML-uitvoer door de invoer plug-in. Gebruik dit om de invoer plug-in te debuggen.
door-
lopen

Het resultaat van voorbewerking en converteren naar XHTML van de uitvoer van de Invoer plug-in. Gebruik
voor foutopsporing in de structuurdetectie.

struc-
tuur

Na structuurdetectie maar voor CSS afvlakken en lettergrootte conversie. Gebruik voor foutopsporing in
lettergrootte conversie en CSS transformaties.

ver-
werkt

Net voor het e-boek wordt doorgegeven aan de uitvoer plug-in. Gebruik voor foutopsporing in de Uitvoer
plug-in.

Als u het invoerdocument wilt bewerken voor calibre het converteert, kan u dit best in de input submap doen, dan
inpakken als ZIP bestand en dit gebruiken als invoerformaat voor volgende conversies. Om dit te doen, gebruik de Meta
informatie bewerken dialoog om het ZIP bestand toe te voegen als formaat voor het boek en selecteer dan, linksboven in
het dialoogvenster, ZIP als invoerformaat.
Dit document behandelt hoofdzakelĳk de verschillende transformaties op de tussenliggende XHTML en hoe ze te con-
troleren. Op het einde zĳn er tips specifiek voor elk type invoer/uitvoer formaat.

4.2 Uitstraling & gevoel

Inhoud

• Lettertypen (pagina 65)
• Tekst (pagina 65)
• Opmaak (pagina 66)
• Stĳlen (pagina 66)
• Transformeer stĳlen (pagina 67)
• Transformeer HTML (pagina 67)

Deze groep opties controleert verschillende aspecten van het uitzicht van het geconverteerde e-boek.
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4.2.1 Lettertypen
Een van de fĳnste functies van de e-leeservaring is de mogelĳkheid om makkelĳk de lettergrootte in te stellen voor
individuele behoeftes en lichtomstandigheden. calibre heeft gesofisticeerde algoritmes om ervoor te zorgen dat het boeken
in een uniforme lettergrootte presenteert, ongeacht wat is gespecificeerd in het invoerdocument.
De basis lettergrootte van een document is de algemene lettergrootte in dat document, d.i. de grootte van de meeste tekst in
dat document. Als u een Basis lettergrootte specificeert, zal calibre automatisch de lettergrootte proportioneel aanpassen,
zodat de meest voorkomende grootte de gespecificeerde basis lettergrootte wordt en andere lettergroottes gepast geschaald
worden. Door een grotere basis lettergrootte te kiezen, kunt u de letters in het document groter maken en omgekeerd.
Wanneer u de basis lettergrootte instelt, moet u voor het beste resultaat ook de lettergrootte-sleutel instellen.
Normaal zal calibre automatisch een basis fontgrootte kiezen, gepast voor het uitvoerprofiel dat u gekozen hebt (zie Pagina
opmaak (pagina 67)). U kan dit echter hier negeren indien de standaard niet geschikt is voor u.
Met de optie Lettergrootte-sleutel controleert u hoe niet-basis lettergroottes worden geschaald. Het lettertype schaal algo-
ritme werkt met een lettergrootte sleutel, eenvoudig een komma gescheiden lĳst van lettergroottes. Deze sleutel vertelt
calibre hoeveel “stappen” groter of kleiner een bepaalde grootte moet zĳn vergeleken met de basisgrootte. Het idee is dat
er een begrensd aantal lettergroottes in een document mag voorkomen. Bv: een grootte voor de tekst, een paar groottes
voor verschillende titels en een paar voor super/subscripten en voetnoten. De lettergrootte-sleutel laat calibre de groottes
in het invoerdocument scheiden in separate “bakken” overeenkomend met verschillende logische lettergroottes.
Ter illustratie een voorbeeld. Stel dat het brondocument dat we converteren gemaakt is door iemand met uitstekend
gezichtsvermogen met een basis lettergrootte van 8pt. Dat betekent dat de meeste tekst in het document in 8pt is gezet,
met de titels een beetje groter (bv 10 of 12pt) en voetnoten iets kleiner op 6pt. Als we nu de volgende instellingen
gebruiken:

Base font size : 12pt

Font size key : 7, 8, 10, 12, 14, 16, 18, 20

Het uitvoerdocument krĳgt een basis lettergrootte van 12pt, titels 14 en 16pt en voetnoten 8pt. Aangenomen dat we de
grootste titels meer willen laten opvallen en de voetnoten ook. Om dit te bereiken zal de lettergrootte-sleutel gewĳzigd
moeten worden naar:

New font size key : 7, 9, 12, 14, 18, 20, 22

De grootste titels worden nu 18pt, terwĳl de voetnoten 9pt worden. U kunt met deze instellingen spelen en proberen uit
te vinden wat voor u de optimale waarden zĳn met behulp van de wizard die u kunt openen door op de kleine knop naast
de Lettergrootte-sleutel klikt.
Het schalen van lettergrootte in de conversie kunt u hier ook uitschakelen indien u de lettergroottes van het invoerdocument
wilt behouden.
Een verwante instelling is Lĳnhoogte. Lĳnhoogte bepaalt de verticale hoogte van lĳnen. Standaard (regelhoogte 0) is er
geen manipulatie van lĳnhoogten . Als u een niet-standaardwaarde opgeeft, worden regelhoogten ingesteld op alle plaatsen
zonder eigen lĳnhoogten. Dit is echter eerder een botte bĳl en moet spaarzaam worden gebruikt. Als u de lĳnhoogten
voor een deel van de invoer wilt aanpassen, is het beter om de Extra CSS (pagina 66) te gebruiken.
Hier kunt u calibre ook laten weten referenced lettertypen in het boek in te sluiten. Dit laat de lettertypen werken op
toestellen, zelfs als ze niet beschikbaar zĳn op het toestel.

4.2.2 Tekst
Tekst kan worden uitgevuld of niet. Uitgevulde tekst heeft extra spaties tussen woorden voor een nette rechtermarge.
Sommige mensen verkiezen aan uitgevulde tekst, anderen niet. Normaal gesproken bewaart calibre de uitvulling van het
originele document. Als u dit wilt negeren, gebruik de optie Text justification in dit gedeelte.
U kunt calibre ook laten Interpunctie verslimmen, dit vervangt gewone aanhalingstekens, streepjes en ellipsen door hun
typografisch correcte alternatieven. Merk op dat dit algoritme niet perfect is, dus het loont om de resultaten te beoordelen.
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Het omgekeerde, namelĳk: guilabel: Interpunctie verdommen is ook beschikbaar.
Tenslotte is er: guilabel: Invoer karakter encodering. Oudere documenten specificeren soms hun karaktercodering niet.
Bĳ conversie kunnen hierdoor niet-Engelse of speciale karakters, zoals slimme aanhalingstekens, beschadigd zĳn. calibre
probeert de karaktercodering van het brondocument te auto-detecteren, maar dat lukt niet altĳd. U kunt het dwingen een
bepaalde codering aan te nemen met deze instelling. cp1252 is een algemene codering voor documenten geproduceerd
met Windows software. U leest best ook Hoe converteer ik mĳn bestand met niet-Engelse karakters of smart quotes?
(pagina 132) voor meer informatie over coderingsproblemen.

4.2.3 Opmaak
Normaal worden alinea’s in XHTML gerenderd met een lege regel tussen alinea’s en zonder inspringen. In calibre kunt
u dit beïnvloeden met een paar opties. Verwĳder ruimte tussen alinea’s verwĳdert de lege regels tussen alinea’s. Het stelt
het tekst inspringen ook in op 1.5em (kan gewĳzigd worden) om een nieuwe alinea te markeren. Invoegen lege regel
doet het tegenovergestelde door precies één lege regel in te voegen tussen twee alinea’s. Beide opties zĳn veelomvattend,
verwĳderen van lege regels of juist het invoegen voor alle alinea’s (technisch <p> en <div> tags).U stelt gewoon de
optie in en deze zal worden uitgevoerd ongeacht hoe rommelig het invoerbestand is. Er is een uitzondering: wanneer het
invoerbestand harde regeleindes gebruikt voor alinea scheiding.
Als u de spatiëring tussen alle alinea’s wilt verwĳderen, behalve een select aantal, gebruik dan deze opties niet. Voeg in
plaats daarvan de volgende CSS-code toe aan Extra CSS 1:

p, div { margin: 0pt; border: 0pt; text-indent: 1.5em }

.spacious { margin-bottom: 1em; text-indent: 0pt; }

Vervolgens, in uw bron-document, markeer de alinea’s die afstand nodig hebben met class=”spacious”. Indien uw invoer-
document niet in HTML is, gebruik de optie Foutopsporing beschreven in de Inleiding om HTML te krĳgen (gebruik de
input submap).
Een andere handige optie is: guilabel: Lineariseer tabellen. Sommige slecht ontworpen documenten gebruiken tabellen om
de lay-out van tekst op de pagina te regelen. Bĳ het converteren bevatten deze documenten vaak tekst die van de pagina
afloopt en andere artefacten. Met deze optie wordt de inhoud uit de tabellen gehaald en lineair gepresenteerd. Merk op dat
deze optie alle tabellen lineariseert, dus gebruik het alleen als u zeker weet dat het invoerdocument geen tabellen gebruikt
voor legitieme doeleinden, zoals het presenteren van tabelinformatie.

4.2.4 Stijlen
De Extra CSS optie laat u willekeurige CSS specificeren, toe te passen op alle HTML bestanden in de invoer. Deze CSS
wordt met hoge prioriteit toegepast en negeert dus de meeste CSS in het invoerdocument. Gebruik deze instelling om
de presentatie/opmaak van uw document aan te passen. Wilt u bĳvoorbeeld dat alle alinea’s met class eindnotitie rechts
zĳn uitgelĳnd, voegt u gewoon toe:

.endnote { text-align: right }

of als u de insprong van alle paragrafen wilt aanpassen:

p { text-indent: 5mm; }

Extra CSS is een zeer krachtige optie, maar u moet wel enige kennis hebben over hoe CSS werkt om het potentieel
volledig te benutten. U kunt de optie Foutenopsporing pĳplĳn gebruiken zoals boven beschreven om te zien welke CSS
in opgenomen in het invoerdocument.
Een eenvoudigere optie is gebruik van: guilabel: Filter stĳlinformatie. Hiermee verwĳdert u alle CSS eigenschappen van
de opgegeven types uit het document. Bv: u kunt het gebruiken om alle kleuren of lettertypen te verwĳderen.
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4.2.5 Transformeer stijlen
Dit is de krachtigste styling gerelateerde functie. U kunt er regels mee definiëren die stĳlen veranderen op basis van
verschillende omstandigheden. Bv: u kunt het gebruiken om alle groene kleuren in blauw te veranderen, of om alle vet-
gedrukte stĳlen uit de tekst te verwĳderen of om alle koppen in een bepaalde kleur te kleuren, enz.

4.2.6 Transformeer HTML
Lĳkt op stĳlen transformeren maar laat u de HTML inhoud van het boek aanpassen. U kan een tag vervangen door een
andere, classes en andere attributen aan tags toevoegen gebaseerd op hun inhoud, enz.

4.3 Pagina opmaak
De Pagina instelling opties zĳn er om schermindeling zoals marges en schermafmeting te controleren. Er zĳn opties om
marges in te stellen die gebruikt worden door de Uitvoer plug-in indien het geselecteerde Uitvoerformaat marges onder-
steunt. Daarnaast moet u een Invoerprofiel kiezen en een Uitvoerprofiel. Beide profielsets zĳn in principe verantwoor-
delĳk voor interpretatie van de afmetingen in invoer/uitvoer documenten, schermafmetingen en standaard lettergrootte-
sleutels.
Als u weet dat het bestand dat u converteert, bedoeld is voor gebruik op een specifiek toestel/software platform, kies dan
het overeenkomend invoerprofiel, of neem gewoon het standaard profiel. Als uw weet dat de bestanden die u maakt voor
een bepaald toesteltype zĳn, kies het overeenkomende uitvoerprofiel, of neem een van de Generieke uitvoerprofielen. Als
u converteert naar MOBI of AZW3 zal u meestal één van de Kindle uitvoerprofielen kiezen. Anders is uw beste keuze
voor een moderne E-boek reader het Generiek e-inkt HD uitvoerprofiel.
Het Uitvoerprofiel controleert ook de schermafmeting. Dit zorgt er bĳvoorbeeld voor dat afbeeldingen auto-schalen om
op het scherm te passen in sommige uitvoerformaten. Kies dus een profiel van een toestel dat lĳkt op de schermafmeting
van uw apparaat.

4.4 Heuristische verwerking
Heuristische verwerking biedt een hoop functies om veelvoorkomende problemen in slecht opgemaakte invoerdocumenten
te proberen detecteren en corrigeren. Gebruik deze functies als uw invoerdocument slecht is geformatteerd. Deze functies
zĳn afhankelĳk van algemene patronen, houdt er rekening mee dat een optie soms tot slechtere resultaten kan leiden,
dus wees voorzichtig. Een aantal van deze opties verwĳdert bĳvoorbeeld alle niet-brekende spatie-entiteiten, of kan vals-
positieve overeenkomsten met betrekking tot de functie bevatten.
Activeer heuristische verwerking

Deze optie activeert calibre’s Heuristische verwerking stap in de conversiepĳplĳn. Dit moet ingeschakeld zĳn om
diverse sub-functies toe te passen.

Harde regeleinden verwĳderen
Deze optie activeren laat calibre proberen harde regeleinden te detecteren en corrigeren in het document via in-
terpunctie en regellengte. calibre zal eerst proberen of harde regeleinden voorkomen, als het erop lĳkt dat ze niet
bestaan, zal calibre niet proberen deze te verwĳderen. De regelterugloop factor kunt u verlagen om calibre te
‘dwingen’ de harde regeleinden te verwĳderen.

Regelterugloop factor
Deze optie controleert het algoritme dat calibre toepast om harde regeleinden te verwĳderen. Bĳvoorbeeld: Als de
waarde voor deze optie 0.4 is, betekent dit dat calibre harde regeleinden verwĳdert van regeleinden waarvan de
lengte minder dan 40% van alle regels in het document zĳn. Als uw document maar een paar regeleinden heeft die
gecorrigeerd moeten worden dan zou deze waarde gereduceerd moeten worden naar iets tussen 0.1 en 0.2.

Bepaal en markeer ongeformateerde hoofdstuktitels en sub-hoofdstuktitels
Indien uw document geen hoofdstuktitels en ondertitels heeft die anders zĳn geformatteerd dan de rest van de
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tekst kan calibre met deze optie proberen om deze te bepalen en ze omvatten met kop-labels. <h2> labels voor
hoofdstuktitels; <h3> labels voor alle gevonden titels.
Deze functie zal geen inhoudsopgave creëren, maar vaak kan dit helpen om standaard de hoofdstukken te her-
kennen en een inhoudsopgave op te bouwen. Stel de XPath bĳ onder Structuurdetectie als een inhoudsopgave
niet automatisch wordt gemaakt. Als er geen andere titels in het document zĳn, zal de instelling “//h:h2” onder
Structuurdetectie de makkelĳkste manier zĳn om een inhoudsopgave voor het document te maken.
De ingevoegde titels worden niet geformatteerd; om titels op te maken gebruik de optie Extra CSS onder de Uiterlĳk
en gedrag conversie-instellingen. Bĳvoorbeeld: Om titel-labels te centreren, gebruik onderstaande:

h2, h3 { text-align: center }

Hernummer sequenties van <h1> of <h2> labels
Sommige uitgevers formatteren hoofdstuktitels met meerdere <h1> of <h2> tags opeenvolgend. Met de standaard
conversie-instellingen zal calibre deze titels opsplitsen in twee titels. Deze optie zal de titel-labels hernummeren om
opsplitsing te voorkomen.

Verwĳder lege regels tussen alinea’s
Deze optie laat calibre lege regels binnen het document analyseren. Wanneer iedere alinea is gescheiden van de
volgende door een lege regel zal calibre alle lege alinea’s verwĳderen. Meerdere lege regels worden beschouwd
als scenario-onderbreking en als een enkele alinea behouden. Deze optie verschilt van de Verwĳder alinea-afstand
optie onder ‘Uitstraling & Gevoel’ doordat deze de HTML-inhoud daadwerkelĳk wĳzigt, terwĳl de andere optie de
opmaak van het document wĳzigt. Deze optie kan ook alinea’s verwĳderen die ingevoegd werden met behulp van
de Lege regel invoegen optie .

Zorg ervoor dat scene-onderbrekingen altĳd geformatteerd worden
Met deze optie probeert calibre om gewone scene-onderbrekingen markers te detecteren en ervoor te zorgen dat
deze centraal worden uitgelĳnd. ‘Zachte’ scene-onderbrekingen markers, d.i. scene-onderbrekingen bepaald door
extra lege ruimte worden opgemaakt zodat ze niet getoond worden in combinatie met pagina-einden.

Vervang scene-onderbrekingen
Als deze optie is geconfigureerd zal calibre de scene-onderbrekingen markers vervangen door vervangende tekst
gespecificeerd door de gebruiker. Merk op aub dat sommige sierkarakters mogelĳk niet worden ondersteund door
alle lezers.
Normaal vermĳdt u best het gebruik van HTML tags. calibre zal tags negeren en vooraf gedefinieerde mark-up
gebruiken. <hr /> tags, d.i. horizontale lĳn en <img> tags zĳn uitzonderingen. Horizontale lĳnen kunnen optioneel
worden gespecificeerd met stĳlen, voegt u uw eigen stĳl toe, voorzie zeker de ‘width’-instelling, anders wordt de
stĳl genegeerd. Afbeelding tags kunnen gebruikt worden, maar calibre heeft geen mogelĳkheid de afbeelding toe
te voegen tĳdens conversie, dit moet later gebeuren met de ‘Boek bewerken’ functie.

Voorbeeld afbeeldingstag (plaats de afbeelding in een map ‘Afbeeldingen’ in de EPUB na
conversie):

<img style=”width:10%” src=”../Images/scenebreak.png” />
Voorbeeld horizontale lĳn met opmaak:

<hr style=”width:20%;padding-top: 1px;border-top: 2px ridge black;border-bottom: 2px groove
black;”/>

Verwĳder overbodige koppeltekens
calibre analyseert alle inhoud met koppeltekens wanneer deze optie geactiveerd is. Het document zelf dient als
woordenboek in de analyse. Hiermee kan calibre nauwkeurig koppeltekens verwĳderen in elk woord in het docu-
ment in elke taal alsook verzonnen of rare wetenschappelĳke begrippen. Grootste nadeel is dat woorden die maar
één keer voorkomen niet worden gewĳzigd. Analyse gebeurt in twee stappen, de eerste analyseert de regeleinden.
Regeleinden worden alleen verwĳderd als het woord bestaat in het document met of zonder een koppelteken. De
tweede stap analyseert alle woorden met koppelteken, koppeltekens worden verwĳderd indien het woord ergens
anders bestaat zonder overeenstemming.
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Algemene woorden en patronen cursiveren
Wanneer geactiveerd zoekt calibre naar algemene woorden en patronen die cursieve schrĳfwĳze aangeven en ze
cursiveren. Voorbeelden zĳn algemene schrĳfwĳzen zoals ~word~ of uitspraken die algemeen cursief worden ge-
toond, bĳv. Latĳnse uitdrukkingen zoals ‘etc.’ of ‘et cetera’.

Vervang gegeven inspringing met CSS inspringing
Sommige documenten bepalen inspringende tekst met behulp van spaties. Wanneer deze optie is geactiveerd zal
calibre proberen deze te detecteren en vervangen door een 3% tekst insprong met behulp van CSS.

4.5 Zoeken & vervangen
Deze opties zĳn vooral nuttig voor conversie van PDF documenten of OCR conversies, hoewel ze ook helpen om vele
document-specifieke problemen op te lossen. Zo plaatsen sommige conversies kop- en voetteksten in de tekst. Deze
opties gebruiken reguliere expressies om deze of andere willekeurige teksten te proberen te detecteren en verwĳderen of
vervangen ze. Onthoud dat deze werken met de tussentĳdse XHTML gemaakt in de conversie pĳplĳn. Er is een wizard
om u te helpen de reguliere expressies aan te passen voor uw document. Klik op de toverstaf naast het expressievak en
klik op de ‘Test’ knop na het samenstellen uw zoekuitdrukking. Gevonden overeenkomsten worden gemarkeerd in Geel.
Het zoeken werkt met een Python reguliere expressie. Overeenkomende tekst wordt eenvoudig verwĳderd of vervangen
met behulp van het vervangingspatroon. Het vervangingspatroon is optioneel, indien leeg, wordt overeenkomende tekst
verwĳderd uit het document. U komt meer te weten over reguliere expressies en hun syntax op Alles over het gebruik van
reguliere expressies in calibre (pagina 216).

4.6 Structuurdetectie
Structuurdetectie houdt in dat calibre z’n best doet structurele elementen te detecteren in het invoerdocument wanneer
deze niet netjes zĳn gespecificeerd. Bĳvoorbeeld: hoofdstukken, pagina-einden, kop- en voetteksten enz. Zoals u begrĳpt,
varieert dit sterk van boek tot boek. Gelukkig heeft calibre zeer krachtige opties om dit te controleren. Met kracht komt
complexiteit, maar als u de tĳd neemt om de complexiteit te leren kennen, zult u vinden dat het dit waard is.

4.6.1 Hoofdstukken en pagina-eindes
calibre heeft twee sets opties voor hoofdstukdetectie en pagina-einden invoegen. Dit kan soms verwarrend zĳn omdat calibre
standaard pagina-einden invoegt voor gevonden hoofdstukken en tevens op de plekken gevonden door de optie pagina-
einden. De reden is dat vaak waar pagina-einden ingevoegd moeten worden geen markeringen zĳn voor hoofdstukken.
Tevens kunnen gevonden hoofdstukken optioneel ingevoegd worden in de automatisch gegenereerde Inhoudsopgaven.
calibre gebruikt XPath, een krachtige taal die de gebruiker markeringen voor hoofdstukken/pagina-einden laat bepalen.
XPath kan een uitdaging zĳn om te gebruiken maar gelukkig is er een XPath handleiding (pagina 159) in de Gebruikers-
handleiding. Onthoud dat Structuurdetectie werkt met het tussentĳdse XHTML bestand geproduceerd door de conversie-
pĳplĳn. Gebruik de foutopsporingsoptie beschreven in de Inleiding (pagina 63) om de passende instellingen voor uw boek
te bepalen. Er is ook een knop voor een XPath-wizard om help te krĳgen met het genereren van simpele XPath-expressies.
Standaard gebruikt calibre de volgende expressie voor hoofdstukdetectie:

//*[((name()='h1' or name()='h2') and re:test(., 'chapter|book|section|part\s+', 'i

↪→')) or @class = 'chapter']

Deze expressie is tamelĳk ingewikkeld, ze probeert een aantal algemene zaken gelĳktĳdig af te handelen. Dit betekent
dat calibre ervan uitgaat dat hoofdstukken beginnen met <h1> of <h2> tags die de woorden (hoofdstuk, boek, sectie of
deel) bevatten of het attribuut class=”chapter” hebben.
Een verwante optie is Hoofdstuk markeren waarmee u controleert wat calibre doet bĳ detectie van een hoofdstuk. Stan-
daard voegt het een pagina-einde in voor het hoofdstuk. U kunt een horizontale lĳn laten invoegen in plaats van of met
een pagina-einde. U kunt er ook voor kiezen om niets te doen.
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De standaard instelling om pagina-einden te detecteren is:

//*[name()='h1' or name()='h2']

wat betekent dat calibre standaard een pagina-einde invoegt vóór iedere <h1> en <h2>-tag.

Notitie

De standaard expressie kan anders zĳn afhankelĳk van het invoerformaat dat u wilt converteren.

4.6.2 Diversen
Er zĳn nog een paar opties in deze sectie.
Metadata invoegen als pagina aan het begin

Een van de grote voordelen van calibre is dat u zeer uitgebreide metadata kunt bĳhouden over al uw boeken, voor
bĳvoorbeeld een beoordeling, labels, commentaren etc. Deze optie voegt een enkele pagina in met alle metadata in
het geconverteerde boek direct na de omslagfoto. Zie dit als u eigen gepersonaliseerde boekomslag.

Verwĳder eerste afbeelding
Soms is de omslagfoto opgenomen in het bron-document in plaats van een afzonderlĳke omslagfoto. indien u
ook een omslagfoto pecificeert in Calibre zal het geconverteerde boek twee omslagfoto’s hebben. Deze optie zal
de eerste foto van het bron-document verwĳderen en zo ervoor zorgen dat het geconverteerde boek maar een
omslagfoto krĳgt en wel degene die u specificeert in Calibre.

4.7 Inhoudsopgave
Wanneer het invoer-document een Inhoudopgave heeft in de metadata zal calibre deze gebruiken. Maar een aantal oudere
formaten ondersteunen of een op metadata gebaseerde inhoudsopgave niet of individuele documenten hebben er geen.
In deze gevallen kunnen de opties helpen om een inhoudsopgave automatisch te genereren in het geconverteerde boek
gebaseerd op de inhoud van het invoer-document.

Notitie

Het kan een uitdaging zĳn om de opties precies goed te krĳgen. Indien u liever de inhoudsopgave handmatig wilt
maken/bewerken, converteer in EPUB of AZW3 formaten en vink het keuzevakje aan onder aan de sectie Inhouds-
opgave in de conversie-dialoog Handmatig verfĳnen van inhoudsopgave na conversie. Hiermee opent u de editor na
de conversie. Hiermee kunt u items maken in de Inhoudsopgave door eenvoudig te klikken op de plek in het boek
waarheen moet worden verwezen. U kunt tevens de editor zelf gebruiken zonder een conversie te doen. Ga naar Voor-
keuren → Werkbalken en voeg de inhoudsopgave-editor toe aan de hoofdwerkbalk. Darna selecteert u het boek dat u
wilt bewerken en klik op de editor-knop.

De eerste optie is Forceer gebruik auto gegenereerde Inhoudsopgave. Door deze optie aan te vinken dwingt u calibre de in
de metadata gevonden inhoudsopgave te overschrĳven met de automatisch gegenereerde.
De standaard werkwĳze van aanmaken van een automatisch gegenereerde Inhoudsopgave is dat Calibre eerst probeert
om hoofdstukken te detecteren en deze gaat toevoegen aan de inhoudopgave. U kunt meer te weten komen hoe u de
detectie van hoofdstukken kunt aanpassen in bovenstaande sectie Structuurdetectie (pagina 69). Indien u de gedetecteerde
hoofdstukken niet wilt toevoegen aan de gegenereerde inhoudsopgave, vink de keuze aan Gedetecteerde hoofdstukken niet
toevoegen.
Indien minder dan het Hoofdstuk drempel aantal hoofdstukken zĳn gedetecteerd, zal calibre alle hyperlinks in het invoer-
document aan de inhoudsopgave toevoegen. Dit functioneert vaak prima: veel invoerdocumenten hebben een gelinkte
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inhoudsopgave aan het begin. De Aantal links optie kan gebruikt worden om dit gedrag te controleren. Indien nu, worden
geen links toegevoegd. Indien groter dan nul wordt dat aantal links toegevoegd.
Calibre filtert automatisch duplicaten uit van de gegenereerde inhoudsopgave. Maar als er extra ongewenste items zĳn
kunt u deze uitfilteren met de optie Inhoudsopgave filteren. Dit is een reguliere expressie die de titel van items afstemt
met de gegenereerde inhoudsopgave. Zodra een overeenkomst gevonden wordt, zal het verwĳderd worden. Bĳvoorbeeld
om alle itels “Volgende” of “Vorige” te verwĳderen, gebruik:

Next|Previous

Met de optie Niveau 1,2,3 inhoudsopgave kunt u een gevanceerde gelaagde inhoudsopgave maken. Dat zĳn XPath-
expressies die overeenkomende labels in het tussentĳdse XHTML-bestand zoeken. Zie Inleiding (pagina 63) hoe u dit
XHTML-bestand kunt openen. Lees ook XPath handleiding (pagina 159) om te leren hoe XPath-expressies samengesteld
worden. Naast iedere optie is een knop die een wizard opent om te helpen met het maken van een basis XPath-expressie.
Het volgende eenvoudige voorbeeld laat zien hoe deze opties gebruikt kunnen worden.
Aangenomen u heeft een invoer-document dat resulteert in XHTML dat er als volgt uitziet:

<html xmlns="http://www.w3.org/1999/xhtml">

<head>

<title>Sample document</title>

</head>

<body>

<h1>Chapter 1</h1>

...

<h2>Section 1.1</h2>

...

<h2>Section 1.2</h2>

...

<h1>Chapter 2</h1>

...

<h2>Section 2.1</h2>

...

</body>

</html>

Hierna stellen we de opties als volgt in:

Level 1 TOC : //h:h1

Level 2 TOC : //h:h2

Dit zal resulteren in een automatisch gegenereerde twee traps inhoudsopgave die er als volgt uitziet:

Chapter 1

Section 1.1

Section 1.2

Chapter 2

Section 2.1

Waarschuwing

Niet alle uitvoer-formaten ondersteunen een gelaagde inhoudsopgave. Probeer het eerst met EPUB. Als dat werkt,
probeer het dan met het formaat van uw keuze.
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4.8 Gebruik afbeeldingen als hoofdstuktitels tijdens de conversie
van HTML invoer-documenten

Aangenomen dat u een afbeelding wilt gebruiken als hoofdstuktitel, maar u wilt toch dat calibre automatisch een Inhouds-
opgave genereert van de hoofdstuktitels. Gebruik de volgende HTML code om dit te bereiken:

<html>

<body>

<h2>Chapter 1</h2>

<p>chapter 1 text...</p>

<h2 title="Chapter 2"><img src="chapter2.jpg" /></h2>

<p>chapter 2 text...</p>

</body>

</html>

Stel de Niveau 1 Inhoudsopgave in als //h:h2. Voor hoofdstuk twee zal Calibre de titel ophalen van de waarde van het
attribuut title uit de <h2> tag omdat deze geen tekst heeft.

4.9 Gebruik tag attributen om de tekst te halen t.b.v. Inhoudsopgave
Indien u bĳzonder lange hoofdstuktitels heeft en kortere versies in de inhoudsopgave wilt hebben kunt u het “title”-attribuut
gebruiken om dat te bereiken; bĳvoorbeeld:

<html>

<body>

<h2 title="Chapter 1">Chapter 1: Some very long title</h2>

<p>chapter 1 text...</p>

<h2 title="Chapter 2">Chapter 2: Some other very long title</h2>

<p>chapter 2 text...</p>

</body>

</html>

Stel de Niveau 1 Inhoudsopgave in als //h:h2/@title. Calibre haalt nu de titel op van de waarde van het title-
attribuut van de <h2> labels in plaats van de tekst binnen de labels. N.B.: Het aanhangsel /@title in de XPath-expressie
kunt u in deze vorm gebruiken om Calibre te vertellen om de tekst te halen van ieder attribuut dat u wenst.

4.10 Hoe opties worden ingesteld/opgeslagen voor conversie
Er zĳn twee plaatsen waar de opties voor conversie kunnen worden ingesteld in Calibre. De eerste is in Voorkeuren-
>Conversie. Deze instellingen zĳn de standaards voor de conversie-opties. Wanneer u probeert om een nieuw boek te
converteren worden deze instellingen standaard gebruikt.
U kunt ook instellingen wĳzigen in een conversie-dialoog voor elke boek-conversie. Wanneer u een boek converteert zal
Calibre onthouden welke instellingen u heeft gebruikt voor dat boek; op deze manier zullen de opgeslagen instellingen
voor ieder individueel boek voorrang krĳgen boven de standaards in Voorkeuren als u dit boek opnieuw wilt converteren.
U kunt de individuele instellingen terugzetten naar de standaards met behulp van de knop Hertelen naar standaards in het
individuele boek in de conversie-dialoog. U kunt de opgeslagen instellingen verwĳderen voor meerdere boeken door alle
betreffende boeken te selecteren en dan te klikken op de knop Metadata bewerken om het dialoogvenster Bulk metadata
bewerken onderaan van het dialoogvenster is een optie om opgeslagen conversie-instellingen te verwĳderen.
Wanneer u meerdere boeken in bulk converteerd worden de instellingen genomen in de onderstaande volgorde (de laatste
overheerst):

• Van de standaards ingesteld in Voorkeuren->Conversie
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• Van de opgeslagen conversie-instellingen voor elk boek dat wordt geconverteerd (indien aanwezig). Dit kan worden
uitgeschakeld door de optie in de linkerbovenhoek van het dialoogvenster Bulkconversie.

• Van de instellingen in het Bulk-conversie-dialoogvenster
N.B.: De laatste instellingen voor elk boek in een Bulk conversie worden opgeslagen en opnieuw gebruikt als dat boek
opnieuw wordt geconverteerd. Aangezien de hoogste prioriteit in Bulkconversie wordt gegeven aan de instellingen in het
dialoogvenster Bulkconversie, zullen deze alle boekspecifieke instellingen overschrĳven. Daarom moet u alleen boeken in
bulk converteren die soortgelĳke instellingen nodig hebben. De uitzonderingen zĳn metadata en invoer-formaat specifieke
instellingen. Omdat het dialoogvenster voor Bulk Conversie geen instellingen heeft voor deze twee opties, worden deze
gehaald uit de boek-specifieke instellingen (indien aanwezig) of de standaards.

Notitie

U kunt de actuele instellingen zien die tĳdens conversie gebruikt worden door te klikken op te roterende pictogram in
de rechter benedenhoek en dat dubbelklikken op de individuele conversietaak. Dit opent het logboek van de conversie
en bevat de actuele instellingen bovenaan.

4.11 Formaat specifieke tips
Hier vindt u tips betreffende conversie van specifieke formaten. Opties voor specifieke formaten voor invoer of uitvoer
die beschikbaar zĳn in het converie-dialoogvenster onder hun eigen sectie, bĳvoorbeeld TXT invoer of EPUB uitvoer.

4.11.1 Microsoft Word documenten omzetten
calibre kan “.docx” bestanden gemaakt in Microsoft Word 2007 of later automatisch converteren. Voeg het bestand toe
aan Calibre en klik “converteren”.

Notitie

Er is een demo .docx-bestand23 dat de mogelĳkheden van de Calibre-conversie-engine demonstreert. Download het
gewoon en converteer het naar EPUB of AZW3 om te zien wat Calibre kan doen.

Calibre zal automatisch een Inhoudsopgave genereren gebaseerd op titels als u deze markeert met de stĳlen Titel 1,
Titel 2 etc. in Word. Open de uitvoer e-boek in de Calibre lezer en klik op de knop Inhoudsopgave om de gegenereerde
Inhoudsopgave te bekĳken.

Oudere .doc bestanden
Voor oudere .doc-bestanden kunt u in Microsoft Word ht document opslaan als HTML en het HTML-bestand converteren
met Calibre. Bĳ het opslaan als HTML moet u wel erop letten dat u de optie “Opslaan als webpagina, gefilterd” gebruikt
omdat dit zorgt voor een zuivere HTML-code dat zich goed laat converteren. N.B.: Word maakt werkelĳk rommelige
HTML en het converteren kan lange tĳd duren, wees geduldig. Als u beschikt over een nieuwere versie van Word kunt u
het ook meteen opslaan als docx.
Een ander alternatief is om het gratis LibreOffice te gebruiken. Open uw .doc-bestand in LibreOffice en sla het op als
.docx, dat direct in Calibre kan worden geconverteerd.

23 https://calibre-ebook.com/downloads/demos/demo.docx
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4.11.2 TXT documenten omzetten
TXT documenten hebben geen formattering zoals vetgedrukt, cursief e.d. of documentstructuur zoals alinea’s, titels,
secties e.d. maar er bestaan meerdere algemeen gebruikte conventies. Standaard probeert calibre automatische detectie
van de correcte formattering en opmaak gebaseerd op deze conventies.
TXT invoer ondersteunt een aantal opties om onderscheid te maken hoe alinea’s worden gedetecteerd.

Alinea stĳl: Auto
Analyseert het tekstbestand en probeert automatisch te bepalen hoe alinea’s zĳn gedefiniëerd.Deze
optie zal prima functioneren; indien u ontevreden bent met de resultaten probeer een van de handmatige
opties.

Alinea stĳl: Blok
Gaat ervan uit dat een of meer lege regels een alinea aangeven:

This is the first.

This is the

second paragraph.

Alinea stĳl: Enkele
Gaat ervan uit dat elke regel een alinea is:

This is the first.

This is the second.

This is the third.

Alinea stĳl: Print
Gaat ervan uit dat elke alinea begint met een inspringing (of een tab of 2+ spaties). Alinea eindigt
wanneer de volgende regel die begint met een inspringing is bereikt:

This is the

first.

This is the second.

This is the

third.

Alinea stĳl: Ongeformatteerd
Gaat ervan uit dat het document niet opgemaakt is maar wel harde regeleinden heeft. Leestekens en
gemiddelde regellengtes worden gebruikt om alinea’s te herstellen.

Alinea stĳl: Auto
Tracht het type van formatering opmaak te dectecteren. Als er geen opmaak is gebruikt, zal de format-
ting heuristisch toegepast worden

Activeer heuristische verwerking
Doorzoekt het document naar hoofdstuktitels, scene-onderbrekingen en cursief geschreven woorden en
zal de passende HTML-code toepassen tĳdens conversie.

Formattering: Markdown
Calibre ondersteunt ook de invoer van TXT door een transformatie-preprocessor bekend als Markdown.
Markdown voegt een basis-opmaak toe aan TXT-documenten zoals vetgedrukt, cursiev, sectie-titels,
tabellen, lĳsten, een Inhoudsopgave etc. Het markeren van hoofdstuktitels met een voorlopende # en
hoofdstuk XPath detectie-expressie in te stellen als “//h:h1” is de makkelĳkste manier om een nette
inhoudsopgave te laten genereren van een TXT-document. U kunt meer lezen over de markdown-syntax
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op daringfireball24.
Alinea stĳl: Ongeformatteerd

Past geen speciale opmaak toe op de tekst, het document wordt geconverteerd naar HTML zonder
andere wĳzigingen.

4.11.3 PDF-documenten omzetten
PDF-documenten zĳn van de slechtste formaten om van te converteren. Ze hebben een vast pagina en tekstplaatsingsfor-
maat . Heel moeilĳk dus om te bepalen waar een alinea eindigt en een andere begint. calibre zal proberen paragrafen te
ontwarren met een configureerbare Line un-wrapping factor. Deze schaal dient om de lengte te bepalen waarop een lĳn
wordt afgebroken. Geldige waarden zĳn een decimaal tussen 0 en 1. Standaard: 0,45, net onder de mediaanlĳnlengte.
Verlaag deze waarde om meer tekst toe te voegen aan het ontwarren. Verhoog voor minder. U kunt deze waarde aanpassen
in de conversie-instellingen onder PDF Input.
Ze hebben ook vaak kop- en voetteksten als onderdeel van het document dat bĳ de tekst wordt opgenomen. Gebruik het:
guilabel: Zoeken en vervangen paneel om kop- en voetteksten te verwĳderen om dit probleem te verhelpen. Als de kop-
en voetteksten niet uit de tekst worden verwĳderd, kan het uitpakken van de alinea weggooien. Lees: ref: regexptutorial
om te leren hoe u de opties voor het verwĳderen van kop- en voetteksten gebruikt.
Enkele beperkingen van PDF invoer zĳn:

• Ingewikkelde documenten met meerdere kolommen en afbeeldingen worden niet ondersteund.
• Extraheren van vector fotobestanden en tabellen vanuit het document is ook niet ondersteund.
• Sommige PDF’s gebruiken speciale hiërogliefen of symbolen om ll or ff or fi etc. weer te geven. Conversie van

deze kan functioneren of ook niet afhankelĳk van hoe deze intern worden weergegeven in het PDF.
• Links en Inhoudopgaves worden niet ondersteund
• PDF’s die ingesloten niet-Unicode-lettertypen gebruiken om niet-Engelse tekens weer te geven, zullen resulteren in

onleesbare uitvoer voor die tekens
• Sommige PDFs maken gebruik van foto’s met OCR tekst. In zulke gevallen zal Calibre de OCR tekst gebruiken,

wat heel anders kan zĳn van wat je ziet als je de PDF bekĳkt
• PDFs die gebruik maken van complexe tekst zoals recht naar links talen en wiskundige formules zullen niet juist

worden geconverteerd.
Om te herhalen PDF is echt, echt slecht formaat om te gebruiken als input. Als je absoluut PDF wilt gebruiken, dan kan
de output varieëren van uitstekend tot onbruikbaar, afhankelĳk van de input PDF.

4.11.4 Stripboek collecties
Een comic boek collectie is een .cbc-bestand. Een .cbc-bestand in een gezipt bestand dat andere CBZ/CBR bestanden
bevat. Daarnaast moet een .cbc-bestand een simepel tekstbestand bevatten genaamd comics.txt, in UTF-8 codering. Het
comics.txt bestand moet een lĳst bevatten van de comics-bestanden binnen het .cbc-bestand in de vorm van bestands-
naam:titel zoals hieronder:

one.cbz:Chapter One

two.cbz:Chapter Two

three.cbz:Chapter Three

Het .cbc bestand zal dan bevatten:

24 http://daringfireball.net/projects/markdown/syntax
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comics.txt

one.cbz

two.cbz

three.cbz

Calibre zal dit .cbc-bestand automatisch converteren in een e-boek met een Inhoudsopgave met links naar iedere ingave
in comics.txt.

4.11.5 EPUB geavanceerde opmaak demo
Verschillende geavanceerde opmaak voor EPUB-bestanden wordt gedemonstreerd in dit demobestand25. Het bestand is
gemaakt van met de hand gecodeerde HTML met Calibre en is bedoeld om te worden gebruikt als een sjabloon voor uw
eigen inspanningen om EPUB te maken.
De bron-HTML waaruit het is gemaakt, is beschikbaar: download_file:demo.zip <demos/demo.zip>. De instellingen die
worden gebruikt om de EPUB van het ZIP-bestand te maken, zĳn:

ebook-convert demo.zip .epub -vv --authors "Kovid Goyal" --language en --level1-toc '/

↪→/*[@class="title"]' --disable-font-rescaling --page-breaks-before / --no-default-

↪→epub-cover

N.B.: Omdat het bestand de mogelĳkheden van EPUB verkent zullen de meeste geavanceerde opmaak niet werken op
readers die minder kunnen dan de ingebouwde EPUB lezer van Calibre.

4.11.6 ODT documenten omzetten
Calibre kan direct ODT (OpenDocument Tekst) bestanden converteren. U moet stĳlen gebruiken om uw document op
te maken en zo min mogelĳke interne opmaak gebruiken. Wanneer u afbeeldingen in uw document invoegt moet u deze
verankeren aan een alinea. Afbeeldingen verankerd aan een pagina zullen aan het begin van de conversie eindigen.
Om automatische detectie van hoofdstukken te activeren, moet u deze markeren met de ingebouwde stĳlen genaamd Kop
1, Kop 2, …, Kop 6 (Kop 1’ is gelĳk aan de HTML tag <h1>, Kop 2 aan <h2> enz). Als u converteert in calibre kunt u
opgeven welke stĳl u gebruikte in het Detecteer hoofdstukken op vak . Voorbeeld:

• Als u Hoofdstukken markeert met stĳl Kop 2, moet u in het vak ‘Detecteer hoofdstukken op’ //h:h2 invullen
• Voor een geneste Inhoudsopgave met Secties gemarkeerd met Kop 2 en de Hoofdstukken gemarkeerd met Kop 3

moet u //h:h2|//h:h3 invullen. Op de Conversie - Inhoudsopgave pagina vult u in het vak Niveau 1 Inhouds-
opgave //h:h2 in en in het vak Niveau 2 Inhoudsopgave vult u //h:h3 in.

De bekende document-eigenschappen (Titel, sleutelwoorden, beschrĳving, maker) worden herkent en Calibre gebruikt de
eerste afbeelding (niet te klein en met de juiste aspect-ratio) als omslag-afbeelding.
Er is zelfs een geavanceerde eigenschappen conversie-modus, die geactiveerd wordt in de aangepaste eigen-
schap opf.metadata `` ('Ja of Nee') voor Ja te kiezen in uw ODT-document

(Bestand->Eigenschappen->Gebruikergedefinieerde eigenschappen). Wanneer deze eigenschap

door calibre wordt gedetecteerd worden de volgende aangepaste eigenschappen herkend

(``opf.authors overschrĳft de auteur van het document):

opf.titlesort

opf.authors

opf.authorsort

opf.publisher

opf.pubdate

(Vervolgt op volgende pagina)

25 https://calibre-ebook.com/downloads/demos/demo.epub
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(Vervolgd van vorige pagina)
opf.isbn

opf.language

opf.series

opf.seriesindex

Daarnaast kunt u de afbeelding specificeren de gebruikt wordt als omslag door deze te benoemen als opf.cover (rechts
klikken, Afbeelding->Opties->Naam) in het ODT. Wanneer geen afbeelding met deze naam wordt gevonden, zal de
‘slimme’ methode toegepast. Omdat de omslag-detectie kan resulteren in dubbele omslagen in bepaalde uitvoer-formaten,
zal het proces de alinea verwĳderen (maar alleen indien de inhoud de omslag is!) van het document. Maar dit functioneert
alleen met de benoemde afbeelding!
Om omslag-detectie uit te schakelen kunt u de gebruikersgedefineerde eigenschap opf.nocover (‘Ja of Nee’) instellen
op Ja in geavanceerde modus.

4.11.7 Naar PDF omzetten
De eerste, belangrĳkste instelling om te bepalen bĳ conversie naar PDF is het paginaformaat. Standaard gebruikt calibre
“U.S. letter”. U kunt dit wĳzigen naar een ander standaard formaat of een volledig aangepast in de PDF Output sectie van
de conversie dialoog. Als u een PDF genereert om op een specifiek toestel te gebruiken, kunt u de optie inschakelen om
het formaat te gebruiken van het :guilabel:’output profile`. Dus als uw uitvoerprofiel is ingesteld op Kindle, maakt calibre
een PDF met een formaat geschikt om te bekĳken op het kleine Kindle scherm.

Kop- en voetteksten
U kunt willekeurige kop- en voeterteksten insluiten op elke pagina van een PDF door kop- en voetertekst-sjablonen te
specificeren. Sjablonen zĳn knipsels van HTML-code die worden gerenderd op de plekken voor kop- en voetertekst.
Bĳvoorbeeld om pagina-nummers te centreren onder op elke pagina in groen gebruikt u het volgende voetersjabloon:

<footer><div style="margin: auto; color: green">_PAGENUM_</div></footer>

Calibre zal automatisch _PAGENUM_ vervangen door de huidige paginanummer. U kunt zelfs andere inhoud op even en
oneven pagina’s plaatsen, zo zal het volgende koptekst-sjabloon de titel zien op oneven pagina’s en de auteur op even
pagina’s:

<header style="justify-content: flex-end">

<div class="even-page">_AUTHOR_</div>

<div class="odd-page"><i>_TITLE_</i></div>

</header>

calibre zal automatisch: code: _TITLE_ en :code:` _AUTHOR_` vervangen door de titel en auteur van het document dat
wordt geconverteerd. Instelling: code: justify-content to: code:` flex-end` zorgt ervoor dat de tekst goed wordt uitgelĳnd.
U kunt ook tekst aan de linker en rechter rand weergeven en de lettergrootte wĳzigen, zoals aangetoond met deze koptekst
sjabloon:

<header style="justify-content: space-between; font-size: smaller">

<div>_TITLE_</div>

<div>_AUTHOR_</div>

</header>

Dit laat de titel links zien en de auteur rechts en in een lettergrootte die iets kleiner is dan de hoofdtekst.
U kunt ook de huidige sectie in sjablonen gebruiken, zoals hieronder te zien is:
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<header><div>_SECTION_</div></header>

_SECTION_ is replaced by whatever the name of the current section is. These names are taken from the metadata Table
of Contents in the document (the PDF Outline). If the document has no table of contents then it will be replaced by empty
text. If a single PDF page has multiple sections, the first section on the page will be used. Similarly, there is a variable
named _TOP_LEVEL_SECTION_ that can be used to get the name of the current top-level section.
U kunt JavaScript zelfs gebruiken in de kop- en voettekstsjablonen. De volgende sjabloon zorgt er bĳvoorbeeld voor dat
paginanummers beginnen met 4 in plaats van 1:

<footer>

<div></div>

<script>document.currentScript.parentNode.querySelector("div").innerHTML = "" + (_

↪→PAGENUM_ + 3)</script>

</footer>

Bovendien zĳn er nog enkele variabelen die u kunt gebruiken in de kopteksten en voetteksten, zoals hieronder beschreven:
• `` _TOTAL_PAGES_ ‘’ - totaal aantal pagina’s in het pdf-bestand, handig om bĳvoorbeeld een voortgangsteller te

implementeren.
• `` _TOP_LEVEL_SECTION_PAGES_ ‘’ - totaal aantal pagina’s in de huidige hoogste niveau sectie
• `` _TOP_LEVEL_SECTION_PAGENUM_ ‘’ - het paginanummer van de huidige pagina binnen de huidige hoogste

niveau sectie
• _WIDTH_PIXELS_ - the width of the header/footer area in pixels
• _HEIGHT_PIXELS_ - the height of the header/footer area in pixels

Notitie

Wanneer u kop- en voetteksten toevoegt, zorg er dan voor dat u de boven- en ondermarges van de pagina instelt op
waarden die groot genoeg zĳn, onder het gedeelte: guilabel: PDF Output van het conversie-dialoogvenster.

Afdrukbare inhoudsopgave
U kunt ook een afdrukbare Inhoudsopgave invoegen aan het einde van het PDF dat de paginanummers voor elke sectie laat
zien. Dit is zinvol als u het PDF op papier wilt afdrukken. Indien u het PDF op een electronisch apparaat wilt gebruiken,
dan biedt de PDF samenvatting deze functionaiteit en wordt standaard gegenereerd.
U kunt het uiterlĳk van de gegenereerde inhoudsopgave aanpassen door de instelling Extra CSS-conversie te gebruiken
onder het Uiterlĳk en Gevoel gedeelte van de conversiedialoog. De standaard gebruikte CSS wordt hieronder vermeld,
kopieer deze gewoon en breng de gewenste wĳzigingen aan.

.calibre-pdf-toc table { width: 100%% }

.calibre-pdf-toc table tr td:last-of-type { text-align: right }

.calibre-pdf-toc .level-0 {

font-size: larger;

}

.calibre-pdf-toc .level-1 td:first-of-type { padding-left: 1.4em }

.calibre-pdf-toc .level-2 td:first-of-type { padding-left: 2.8em }

78 Hoofdstuk 4. E-boek conversie



calibre Gebruikershandleiding, Release 8.7.0

Aangepaste paginamarges voor individuele HTML-bestanden
Als u een EPUB- of AZW3-bestand converteert met daarin meerdere afzonderlĳke HTML-bestanden en u de pagina-
marges voor een bepaald HTML-bestand wilt wĳzigen, kunt u het volgende stĳlblok aan het HTML-bestand toevoegen
met de calibre E-book editor:

<style>

@page {

margin-left: 10pt;

margin-right: 10pt;

margin-top: 10pt;

margin-bottom: 10pt;

}

</style>

Schakel vervolgens in het gedeelte PDF-uitvoer van het conversiedialoog de optie in: guilabel:Gebruik paginamarges van
het document dat wordt geconverteerd. Nu hebben alle pagina’s die uit dit HTML-bestand zĳn gegenereerd `` 10pt``-marges.
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calibre has an integrated e-book editor that can be used to edit books in the EPUB, KEPUB (Kobo) and AZW3 (Kindle)
formats. The editor shows you the HTML and CSS that is used internally inside the book files, with a live preview that
updates as you make changes. It also contains various automated tools to perform common cleanup and fixing tasks.
U kunt deze editor activeren door rechts te klikken op een boek in Calibre en kiezen voor Boek bewerken.
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5.1 Basis werkstroom

Notitie

A video tour of the calibre E-book editor is available here26.

When you first open a book with the Edit book tool, you will be presented with a list of files on the left. These are the
individual HTML files, stylesheets, images, etc. that make up the content of the book. Simply double click on a file to
start editing it. Note that if you want to do anything more sophisticated than making a few small tweaks, you will need to
know HTML Tutorial27 and CSS Tutorial28.
Wanneer u in de editor wĳzigingen aanbrengt in de HTML of CSS, worden de wĳzigingen in het voorbeeldvenster aan de
rechterkant in een voorbeeld van de wĳzigingen weergegeven. Als je tevreden bent met hoe de veranderingen die je hebt
gemaakt kĳken, klik dan op de Opslaan knop of gebruik :guilabel:` Bestand->Opslaan` om je wĳzigingen in het e-boek
op te slaan.
One useful feature is Checkpoints. Before you embark on some ambitious set of edits, you can create a checkpoint. The
checkpoint will preserve the current state of your book, then if in the future you decide you don’t like the changes you
have made to you can go back to the state when you created the checkpoint. To create a checkpoint, use Edit → Create
checkpoint. Checkpoints will also be automatically created for you whenever you run any automated tool like global search
and replace. The checkpointing functionality is in addition to the normal undo/redo mechanism when editing individual
files. Checkpoints are needed for when changes are spread over multiple files in the book.
Dat is in feite de manier om boeken te bewerken – Open een bestand, maak veranderen, bekĳk een voorbeeld en sla op.
De rest van deze handleiding zal de verschillende hulpmiddelen behandelen die het mogelĳk maken dat u specifieke taken

26 https://calibre-ebook.com/nl/demo#tutorials
27 https://www.w3schools.com/Html/default.asp
28 https://www.w3schools.com/css/default.asp
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zo goed mogelĳk uit kan voeren.
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5.2 De Verkenner
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De Verkenner toont een overzicht van de diverse bestanden binnen het boek dat u bewerkt. De bestanden staan op ge-
sorteerd op categorie, met tekst (HTML) bestanden bovenaan, gevolgd door stylesheet (CSS) bestanden, afbeeldingen
enz. Dubbelklikken op een bestand opent deze voor het bewerken. Het bewerken wordt ondersteund voor HTML, CSS
en afbeeldingen. De volgorde van tekstbestanden is dezelfde als tĳdens het lezen in het boek. Alle andere bestanden zĳn
alfabetisch gesorteerd.
Door met de muisaanwĳzer over een bestand te gaan toont de grootte en onderaan het scherm het gehele pad naar het
bestand in het boek. Bedenk wel dat bestanden binnen e-boeken gecomprimeerd zĳn. De grootte van het boek zelf is dus
niet de som van de grootte van de individuele bestanden.
Veel bestanden hebben een speciale betekenis in het boek. Deze hebben normaal een icoon naast hun namen om de
speciale betekenis aan te geven. Bv. in de afbeelding links ziet u dat de bestanden cover_image.jpg en titlepage.xhtml het
icoon van een omslag naast zich hebben om aangevend dat het boekomslagafbeelding en titelpagina zĳn. Het bestand
content.opf heeft een metadata icoon om aan te geven dat de boek metadata er aanwezig zĳn en het bestand toc.ncx heeft
een T icoon om aan te geven dat er een Inhoudsopgave is.
U kunt meerdere acties uitvoeren op bestanden door er met de rechter muisknop op te klikken.

5.2.1 Bestanden hernoemen
U kunt een bestand hernoemen door er rechts op te klikken en kiezen voor Hernoemen. Hernoemen van een bestand zal
automatisch alle links en referenties bĳwerken in het gehele boek. Dus alles wat u moet doen is een nieuwe naam in te
geven en Calibre doet de rest.
U kunt ook veel bestanden in groep hernoemen. Dit is bruikbaar als u wilt dat de bestanden een simpel naamschema volgen.
Bv.: U wilt alle HTML bestanden hernoemen naar Hoofdstuk-1.html, Hoofdstuk-2.html enz. Selecteer de bestanden die
u wilt hernoemen door de Shift or Ctrl toets ingedrukt te houden en op de bestanden te klikken. Dan rechtsklikken en
selecteer In groep hernoemen. Geef een voorvoegsel in en het begingetal voor de automatische nummering, klik OK en
het is klaar. De in groep hernoemen dialoog laat u ook bestanden hernoemen in de volgorde waarin ze verschĳnen in het
boek in plaats van waarin u ze selecteerde, bruikbaar, bĳvoorbeeld, om alle afbeeldingen te hernoemen in de volgorde
waarin ze verschĳnen.
Tenslotte kan u de bestandsextensie in groep veranderen voor alle geselecteerde bestanden. Selecteer meerdere bestanden,
zoals boven, rechtsklikken en kies Verander de extensie voor de geselecteerde bestanden.

5.2.2 Bestanden samenvoegen
Soms wilt u misschien twee HTML bestanden of twee CSS bestanden samenvoegen. Het kan soms bruikbaar zĳn om
alles in een enkel bestand te hebben. Pas op toch want veel inhoud in een enkel bestand zetten kan prestatieproblemen
geven bĳ lezen van het boek in een standaard reader.
Om meerdere bestanden samen te voegen, selecteer door de Ctrl toets ingedrukt te houden en erop te klikken (selec-
teer enkel bestanden van één type, alle HTML bestanden of alle CSS-bestanden enz.). dan rechts klikken en selecteer
samenvoegen. Dat is alles. calibre voegt de bestanden samen en let erop dat alle links en referenties wĳzigen naar de sa-
mengevoegde bestanden. N.B.: Samenvoegen van bestanden kan soms tekstopmaak wĳzigen omdat individuele bestanden
misschien verschillende stĳlbladen gebruikten.
U kan ook tekstbestanden selecteren en ze slepen en neerzetten op een ander tekstbestand om de geselecteerde met het
doel tekstbestand samen te voegen.

5.2.3 Volgorde van tekstbestand veranderen
You can re-arrange the order in which text (HTML) files are opened when reading the book by simply dragging and
dropping them in the File browser or clicking on the file to move and then pressing the Ctrl+Shift modifiers with the
Up, Down, Home or End keys. For the technically inclined, this is called re-ordering the book spine.
Note that you have to drop the items between other items, not on top of them, this can be a little fiddly until you get used
to it. Dropping on top of another file will cause the files to be merged.
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5.2.4 Kaft markeren
E-boeken hebben normaal een omslagafbeelding. Deze afbeelding wordt aangegeven in de Verkenner door een icoon van
een bruin boek naast de afbeeldingsnaam. Als u een andere afbeelding als omslag wilt, kunt u dit doen door rechtsklikken
op het bestand en kiezen Markeer als omslag.
Daarnast kennen EPUB-bestanden een titelpagina. Een titelpagina is een HTML-bestand die ageert als de titelpagi-
na/omslag van het boek. U kunt een HTML-bestand markeren als de titelpagina tĳdens het bewerken van EPUBs door
rechts te klikken. Indien er ook andere inhoud in staat zoals het eerste hoofdstuk dan gaat deze inhoud verloren als de
gebruiker ooit het EPUB-bestand converteert in Calibre naar een ander formaat. Dit gebeurt omdat Calibre ervan uitgaat
dat de gemarkeerde titelpagina alleen de omslag bevat en geen andere inhoud.

5.2.5 Bestanden verwijderen
U kunt bestanden verwĳderen door er rechts op te klikken of door ze te selecteren en de Del-toets in te drukken. Het
verwĳderen van een bestand verwĳdert alle referenties tot het bestand van het OPF-bestand zodat u dit klusje niet zelf
hoeft te doen. Hoewel referenties op andere locaties niet worden verwĳderd, kunt u het gereedschap Boek controleren
gebruiken om deze makkelĳk te vinden en verwĳderen/vervangen.

5.2.6 Bestanden exporteren
U kunt een bestand exporteren van een boek naar ergens anders op uw computer. Dit is nuttig als u aan een bestand wilt
werken met gespecialiseerde software. Om dit te doen rechtsklikt u op het bestand en selecteer Export.
Als u klaar bent met bewerken aan het geëxporteerde bestand unt u dit opnieuw importeren in het boek door weer rechts
te klikken op het bestand en selecteer Vervangen door bestand… waardoor u het bestand in het boek kunt vervangen door
het eerder geëxporteerde bestand.
U kan ook bestanden kopiëren tussen verschillende editor instanties. Selecteer de bestanden die u wilt kopiëren in Bestand
browser, klik rechts en kies, Kopieer geselecteerde bestanden naar een andere editor instantie. Dan, in de andere editor
instantie, klik rechts in de Bestand browser en kies Plak bestand van andere editor instantie.

5.2.7 Nieuwe afbeeldingn/lettertype/enz. toevoegen of nieuwe lege bestanden ma-
ken

U kunt een nieuwe afbeelding, lettertype, stĳlblad, enz. toevoegen van uw computer in een boek door te klikken op
Bestand → Nieuw bestand. Dit laat u ofwel een bestand importeren door te klikken op de Importeer bestand knop ofwel
een nieuw leeg HTML bestand of stĳlblad maken door een bestandsnaam in te vullen in het vakje voor het nieuwe bestand.
U kunt ook tegelĳkertĳd meerdere bestanden importeren in het boek met behulp van Bestand->Importeer bestanden in
boek.

5.2.8 Bestanden vervangen
U kunt makkelĳk bestaande bestanden in het boek vervangen door rechts te klikken op het bestand en selecteer vervangen.
Hiermee worden alle links en referenties automatisch bĳgewerkt, in het geval dat het vervangende bestand een andere naam
heeft dan het bestand dat wordt vervangen.

5.2.9 Het efficiënt linken van sylesheets aan HTML-bestanden
Voor uw comfort kunt u meerdere HTML bestanden selecteren in de Bestand browser, rechtsklikken en Stĳlbladen linken
kiezen om automatisch de <link> tags in te voegen voor die stĳlbladen in alle geselecteerde HTML bestanden.
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5.3 Zoeken & vervangen
Boek bewerken heeft een zeer krachtige zoek/vervang interface waarmee u tekst kunt zoeken/vervangen in het huidige
bestand, in alle bestanden en zelfs in een gemarkeerd deel van het huidige bestand. U kunt normaal zoeken of reguliere
expressies gebruiken. Over het gebruik van reguliere expressies om geavanceerd te zoeken, zie Alles over het gebruik van
reguliere expressies in calibre (pagina 216).

Start zoeken en vervangen met menu-item Zoeken → Zoek/vervang (u moet dan wel een HTML of CSS-bestand aan het
bewerken zĳn).
Type de tekst die u wilt vinden in het Zoek-vakje en de vervanger in het Vervang-vakje. U kunt de betreffende knoppen
klikken om de volgende match te vinden, de huidige match vervangen en alle matches vervangen.
Door de keuzelĳst onderaan het kader te gebruiken, kunt u zoeken in het huidig bestand, alle tekstbestanden, alle stylesheets
of alle bestanden. U kunt ook de zoekmethode kiezen, dus een normale (tekenreeks) zoekopdracht of met een reguliere
expressie.
U kunt alle matches tellen van een zoekopdracht met :guilabel:`Zoeken->Tellen `. De teller loopt over alles, bestan-
den/delen die u heeft geselecteerd in de keuzelĳst.
U kunt ook springen naar een bepaalde regel in de huidige geopende editor met Zoeken → Spring naar regel.

Notitie

Benut de maximale kracht van zoeken en vervangen met reguliere expressies. Zie Alles over het gebruik van reguliere
expressies in calibre (pagina 216).

5.3.1 Opgeslagen zoekopdrachten
U kunt regelmatig gebruikte zoek/vervang uitdrukkingen (ook functie modus expressies) opslaan en meermaals herbrui-
ken. Om een zoekopdracht op te slaan, rechtsklik in het Zoek vak en selecteer Huidige zoekopdracht opslaan.
De opgeslagen zoekopdrachten kunt u tonen via Zoeken → Opgeslagen zoekopdrachten. U ziet een lĳst met zoek/vervang
opdrachten die u kunt toepassen. U kunt zelfs meerdere opdrachten selecteren uit de lĳst door de Ctrl toets ingedrukt
te houden tĳden het klikken om meerdere zoek/vervang-opdrachten uit te voeren in één bewerking.

5.3.2 Functie modus
Functie modus laat u willekeurige, krachtige Python functies schrĳven die draaien op elke Zoek/vervang. U kan ongeveer
elke tekstmanipulatie doen die u wilt in functie modus. Voor meer informatie bekĳk Functie modus voor zoek & vervangen
in de editor (pagina 101).

5.3.3 Zoeken tussen HTML labels
Er is ook een speciale mogelĳkheid om naar tekst te zoeken tussen HTML-labels. Bĳvoorbeeld als in de HTML-code de
nadruk is op een <i>woord</i>. kunt u zoeken op op een woord en het wordt gevonden ondanks dat er een
<i> tag staat. Gebruik deze functie met het menu-item Zoeken → Zoeken HTML markup negeren.
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5.4 Geautomatiseerde functies
Boek bewerken heeft diverse gereedschappen om te helpen met algemene taken. Deze zĳn toegankelĳk in het Gereed-
schappen menu.

5.4.1 Inhoudsopgave bewerken
Er is een speciaal gereedschap om het bewerken van de Inhoudsopgave te versoepelen. Zet het in gang met Gereedschap-
pen → Inhoudsopgave → Inhoudsopgave bewerken.

Dit gereedschap laat de de huidige Inhoudsopgave (indien aanwezig) zien aan de linkerkant. Dubbelklik op een vermelding
om de tekst te wĳzigen. U kunt ook de volgorde van vermeldingen wĳzigen door deze te slepen en te plaatsen of de knoppen
aan de rechterkant te gebruiken.
Voor boeken die geen inhoudsopgave hebben levert het gereedschap diverse opties om een Inhoudsopgave automatisch
te laten genereren uit de tekst. U kunt de hierbĳ gebruik maken van de hoofdstukken in het document, van links, van
individuele bestanden enzovoort.
U kunt vermeldingen bewerken door erop te klikken en dan te klikken op de knop Wĳzig de locatie waarheen deze
vermelding verwĳst. Dit opent een klein weergave-venster van het boek, beweeg de muisaanwĳzer over het weergave-
venster en klik waar u wilt dat de vermelding naartoe verwĳst. Een dikke groene lĳn toont u de plaats. Klik Ok als u
tevreden bent met de plaats.
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5.4.2 Het boek controleren
Het gereedschap Boek controleren zoekt naar mogelĳke knelpunten in uw boek waardoor het op readers niet werkt als
bedoeld. Activeer dit met Gereedschappen → Boek controleren.

Alle gevonden problemen worden gerapporteerd in een mooie, gebruiksvriendelĳke lĳst. Op een vermelding klikken,
toont u enige hulp over die fout en biedt u de optie die te auto-herstellen indien mogelĳk. U kan ook dubbelklikken op de
fout om de locatie in een editor te openen zodat u het zelf kan herstellen.
Sommige van onderdelen van de controle zĳn:

• Slechtgevormde HTML. Alle HTML die niet als goedgevormde XML verwerkt wordt, wordt gerapporteerd. Her-
stellen zorgt ervoor dat uw markup in elke context werkt zoals bedoeld. calibre kan deze fouten ook auto-herstellen
maar dit heeft soms onverwachte effecten, omzichtig te gebruiken dus. Zoals altĳd wordt een checkpunt gemaakt
vóór auto-herstellen zodat u alles gemakkelĳk terug kan draaien. Auto-herstellen werkt door markup verwerking
door het zeer fout tolerante HTML5 algoritme, gevolgd door conversie naar doed gevormde XML.

• Verkeerde of onbekende CSS stĳlen. Alle ongeldige CSS of met eigenschappen niet gedefinieerd in de CSS 2.1
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standaard (plus enkele van CSS3) wordt gerapporteerd. CSS wordt gecontroleerd in alle stĳlbladen, inline stĳlat-
tributen en <style> tags in HTML bestanden.

• Onbekende linken. Linken die wĳzen naar bestanden in het boek die niet bestaan, worden gerapporteerd.
• Niet-gebruikte bestanden. Bestanden in het boek, niet gebruikt door andere bestanden of niet in de opbouw worden

gerapporteerd.
• Verscheidene doorsnee problemen in OPF bestanden zoals dubbele opbouw of manifest items, gebroken idrefs or

meta omslag tags, ontbrekende vereiste onderdelen en zo voort.
• Diverse controles op compatibiliteit betreffende bekende veelvoorkomende problemen die het boek slecht laten

werken op e-readers.

5.4.3 Cover toevoegen
You can easily add a cover to the book via Tools → Add cover. This allows you to either choose an existing image in the
book as the cover or import a new image into the book and make it the cover. When editing EPUB files, the HTML
wrapper for the cover is automatically generated. If an existing cover in the book is found, it is replaced. The tool also
automatically takes care of correctly marking the cover files as covers in the OPF.

5.4.4 Insluiten van gerefereerde lettertypes
Accessed via Tools → Embed reference fonts, this tool finds all fonts referenced in the book and if they are not already
embedded, searches your computer for them and embeds them into the book, if found. Please make sure that you have
the necessary copyrights for embedding commercially licensed fonts, before doing this.

5.4.5 Ingevoegde lettertypes uitdunnen
Accessed via Tools → Subset embedded fonts, this tool reduces all the fonts in the book to only contain glyphs for the text
actually present in the book. This commonly reduces the size of the font files by ~ 50%. However, be aware that once the
fonts are subset, if you add new text whose characters are not previously present in the subset font, the font will not work
for the new text. So do this only as the last step in your workflow.

5.4.6 Interpunctie verbeteren
Converteer platte tekst streepjes, weglatingstekens, aanhalingstekens, meerdere afbreekstreepjes, enz. om naar de typo-
grafisch juiste equivalenten. NB, het algoritme kan soms foute resultaten geven, met name als enkele aanhalingstekens in
het spel zĳn bĳ het begin van samentrekkingen. Toegankelĳk via Gereedschappen → Slimme interpunctie.

5.4.7 Transformeer CSS eigenschappen
Create rules to transform the styling of the book. For example, create a rule to convert all red text to green or to double
the font size of all text in the book or make text of a certain font family italic, etc.
De regels creëren is eenvoudig, de regels volgen een natuurlĳk taalformaat dat eruit ziet als:

• Als de eigenschap kleur rood is, verander het naar groen
• Als de eigenschap lettertype-grootte elke waarde is, vermenigvuldig de waarde met 2

Toegankelĳk via Gereedschappen → Transformeer stĳlen.

5.4.8 Ongebruikte CSS regels verwijderen
Remove all unused CSS rules from stylesheets and <style> tags. Some books created from production templates can have
a large number of extra CSS rules that don’t match any actual content. These extra rules can slow down readers that need
to process them all. Accessed via Tools → Remove unused CSS.
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5.4.9 Repareer HTML
This tool simply converts HTML that cannot be parsed as XML into well-formed XML. It is very common in e-books to
have non-well-formed XML, so this tool simply automates the process of fixing such HTML. The tool works by parsing
the HTML using the HTML5 algorithm (the algorithm used in all modern browsers) and then converting the result into
XML. Be aware that auto-fixing can sometimes have counter-intuitive results. If you prefer, you can use the Check Book
tool discussed above to find and manually correct problems in the HTML. Accessed via Tools → Fix HTML.

5.4.10 Alle bestanden leesbaarder maken
Dit gereedschap wordt gebruikt om alle HTML en CSS-bestanden automatisch te formatteren zo dat ze er “netjes uit-
zien”. De code springt automatisch in zodat alle regels er netjes bĳstaan, lege regels worden toegevoegd waar passend
enzovorts. Dit verfraaien reparereert automatisch ook defecte HTML/CSS. daarom kunt u beter eerst het Boek controle-
ren gereedschap gebruiken om alle problemen te corrigeren en pas daarna het verfraaien te doorlopen. Toegankelĳk met
Gereedschappen → Alle bestanden verfraaien.

Notitie

In HTML any text can have significant whitespace, via the CSS white-space directive. Therefore, beautification could
potentially change the rendering of the HTML. To avoid this as far as possible, the beautify algorithm only beautifies
block level tags that contain other block level tags. So, for example, text inside a <p> tag will not have its whitespace
changed. But a <body> tag that contains only other <p> and <div> tags will be beautified. This can sometimes mean
that a particular file will not be affected by beautify as it has no suitable block level tags. In such cases you can try
different beautification tools, that are less careful, for example: HTML Tidy29.

5.4.11 Een inline Inhoudsopgave invoegen
Normally in e-books, the Table of Contents is separate from the main text and is typically accessed via a special Table of
Contents button/menu in the e-book reading device. You can also have calibre automatically generate an inline Table of
Contents that becomes part of the text of the book. It is generated based on the currently defined Table of Contents.
If you use this tool multiple times, each invocation will cause the previously created inline Table of Contents to be replaced.
The tool can be accessed via Tools → Table of Contents → Insert inline Table of Contents.

5.4.12 Semantiek instellen
This tool is used to set semantics in EPUB files. Semantics are simply, links in the OPF file that identify certain locations
in the book as having special meaning. You can use them to identify the foreword, dedication, cover, table of contents,
etc. Simply choose the type of semantic information you want to specify and then select the location in the book the link
should point to. This tool can be accessed via Tools → Set semantics.

5.4.13 Stijl informatie filteren
This tool can be used to easily remove specified CSS style properties from the entire book. You can tell it what pro-
perties you want removed, for example, color, background-color, line-height and it will remove them from
everywhere they occur — stylesheets, <style> tags and inline style attributes. After removing the style information,
a summary of all the changes made is displayed so you can see exactly what was changed. The tool can be accessed via
Tools → Filter style information.

29 https://infohound.net/tidy/
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5.4.14 Boek ingewanden upgraden
This tool can be used to upgrade the book’s internals, if possible. For instance it will upgrade EPUB 2 books to EPUB 3
books. The tool can be accessed via Upgrade book internals.

5.5 Checkpoints
Checkpoints are a way to mark the current state of the book as “special”. You can then go on to do whatever changes you
want to the book and if you don’t like the results, return to the checkpointed state. Checkpoints are automatically created
every time you run any of the automated tools described in the previous section.
You can create a checkpoint via Edit → Create checkpoint. And go back to a previous checkpoint with Edit → Revert to …

The check pointing functionality is in addition to the normal Undo/redo mechanism when editing individual files. Check-
points are needed for when changes are spread over multiple files in the book or when you wish to be able to revert a
large group of related changes as a whole.
You can see a list of available checkpoints via View → Checkpoints. You can compare the current state of the book to a
specified checkpoint using the E-books vergelĳken (pagina 123) tool – by selecting the checkpoint of interest and clicking
the Compare button. The Revert to button restores the book to the selected checkpoint, undoing all changes since that
checkpoint was created.
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5.6 Het Live voorbeeld paneel
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The File preview gives you an overview of the various files inside The live preview panel shows you the changes you are
making live (with a second or two of delay). As you edit HTML or CSS files, the preview panel is updated automatically
to reflect your changes. As you move the cursor around in the editor, the preview panel will track its location, showing you
the corresponding location in the book. Clicking in the preview panel, will cause the cursor in the editor to be positioned
over the element you clicked. If you click a link pointing to another file in the book, that file will be opened in the edit
and the preview panel, automatically.
You can turn off the automatic syncing of position and live preview of changes – by buttons under the preview panel. The
live update of the preview panel only happens when you are not actively typing in the editor, so as not to be distracting or
slow you down, waiting for the preview to render.
The preview panel shows you how the text will look when viewed. However, the preview panel is not a substitute for
actually testing your book an actual reader device. It is both more, and less capable than an actual reader. It will tolerate
errors and sloppy markup much better than most reader devices. It will also not show you page margins, page breaks and
embedded fonts that use font name aliasing. Use the preview panel while you are working on the book, but once you are
done, review it in an actual reader device or software emulator.

Notitie

The preview panel does not support embedded fonts if the name of the font inside the font file does not match the
name in the CSS @font-face rule. You can use the Check Book tool to quickly find and fix any such problem fonts.

5.6.1 HTML bestanden splitsen
One, perhaps non-obvious, use of the preview panel is to split long HTML files. While viewing the file you want to split,

click the Split mode button under the preview panel . Then simply move your mouse to the place where you want
to split the file and click. A thick green line will show you exactly where the split will happen as you move your mouse.
Once you have found the location you want, simply click and the split will be performed.
Splitting the file will automatically update all links and references that pointed into the bottom half of the file and will
open the newly split file in an editor.
You can also split a single HTML file at multiple locations automatically, by right clicking inside the file in the editor and
choosing Split at multiple locations. This will allow you to easily split a large file at all heading tags or all tags having a
certain class and so on.
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5.7 Het realtime CSS paneel

The Live CSS panel shows you all the style rules that apply to the tag you are currently editing. The name of tag, along
with its line number in the editor are displayed, followed by a list of matching style rules.
It is a great way to quickly see which style rules apply to any tag. The view also has clickable links (in blue), which take
you directly to the location where the style was defined, in case you wish to make any changes to the style rules. Style
rules that apply directly to the tag, as well as rules that are inherited from parent tags are shown.
The panel also shows you what the finally calculated styles for the tag are. Properties in the list that are superseded by
higher priority rules are shown with a line through them.
You can enable the Live CSS panel via View → Live CSS.
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5.8 Diverse gereedschappen
Er zĳn nog meer gereedschappen bruikbaar voor het bewerken van uw boek

5.8.1 De Inhoudsopgave weergave
The Table of Contents view shows you the current table of contents in the book. Double clicking on any entry opens the
place that entry points to in an editor. You can right click to edit the Table of Contents, refresh the view or expand/collapse
all items. Access this view via View → Table of Contents.

5.8.2 Spellingscontrole van woorden in het boek
Je kunt de spellingscontrole laten lopen via Tools → Check spelling.

Words are shown with the number of times they occur in the book and the language the word belongs to. Language
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information is taken from the books metadata and from lang attributes in the HTML files. This allows the spell checker
to work well even with books that contain text in multiple languages. For example, in the following HTML extract, the
word color will be checked using American English and the word colour using British English:

<div lang="en_US">color <span lang="en_GB">colour</span></div>

Notitie

U kan dubbelklikken op een woord om het volgende voorkomen te accentueren in de editor. Nuttig als u het handmatig
wil bewerken of de context bekĳken.

To change a word, simply double click one of the suggested alternative spellings on the right, or type in your own corrected
spelling and click the Change selected word to button. This will replace all occurrences of the word in the book. You can
also right click on a word in the main word list to change the word conveniently from the right click menu.
You can have the spelling checker ignore a word for the current session by clicking the Ignore button. You can also
add a word to the user dictionary by clicking the Add to dictionary button. The spelling checker supports multiple user
dictionaries, so you can select the dictionary you want the word added to.
You can also have the spelling checker display all the words in your book, not just the incorrectly spelled ones. This is
useful to see what words are most common in your book and to run a simple search and replace on individual words.

Notitie

If you make any changes to the book by editing files while the spell check tool is open, you should click the Refresh
button in the Spell check tool. If you do not do this and continue to use the Spell check tool, you could lose the changes
you have made in the editor.

Notitie

To exclude an individual file from being spell checked when running the spell check tool, you can use the Exclude
files button or add the following comment just under the opening tag in the file:
<!-- calibre-no-spell-check -->

Nieuwe woordenboeken toevoegen
The spelling checker comes with builtin dictionaries for the English and Spanish languages. You can install your own
dictionaries via Preferences → Editor → Manage spelling dictionaries. The spell checker can use dictionaries from the
LibreOffice program (in the .oxt format). You can download these dictionaries from The LibreOffice Extensions repo-
sitory30.

5.8.3 Speciale tekens invoegen
You can insert characters that are difficult to type by using the Edit → Insert special character tool. This shows you all
Unicode characters, simply click on the character you want to type. If you hold Ctrl while clicking, the window will
close itself after inserting the selected character. This tool can be used to insert special characters into the main text or
into any other area of the user interface, such as the Search and replace tool.
Because there are a lot of characters, you can define your own Favorite characters, that will be shown first. Simply right
click on a character to mark it as favorite. You can also right click on a character in favorites to remove it from favorites.

30 https://extensions.libreoffice.org/?Tags%5B%5D=50
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Finally, you can re-arrange the order of characters in favorites by clicking the Re-arrange favorites button and then drag
and dropping the characters in favorites around.
You can also directly type in special characters using the keyboard. To do this, you type the Unicode code for the character
(in hexadecimal) and then press the Alt+X key which will convert the previously typed code into the corresponding
character. For example, to type ÿ you would type ff and then Alt+X. To type a non-breaking space you would use a0 and
then Alt+X, to type the horizontal ellipsis you would use 2026 and Alt+X and so on.
Finally, you can type in special characters by using HTML named entities. For example, typing &nbsp; will be replaced
by a non breaking space when you type the semi-colon. The replacement happens only when typing the semi-colon.

5.8.4 De code controle weergave
This view shows you the HTML coding and CSS that applies to the current element of interest. You open it by right
clicking a location in the preview panel and choosing Inspect. It allows you to see the HTML coding for that element
and more importantly, the CSS styles that apply to it. You can even dynamically edit the styles and see what effect your
changes have instantly. Note that editing the styles does not actually make changes to the book contents, it only allows for
quick experimentation. The ability to live edit inside the Inspector is under development.

5.8.5 Controle van externe links
You can use this tool to check all links in your book that point to external websites. The tool will try to visit every externally
linked website, and if the visit fails, it will report all broken links in a convenient format for you to fix.

5.8.6 Externe bronnen downloaden
You can use this tool to automatically download any images/stylesheets/etc. in the book that are not bundled with the
book (i.e. they have URLs pointing to a location on the internet). The tool will find all such resources and automatically
download them, add them to the book and replace all references to them to use the downloaded files.

5.8.7 Bestanden sorteren in mappen op type
Often when editing EPUB files that you get from somewhere, you will find that the files inside the EPUB are arranged
haphazardly, in different sub-folders. This tool allows you to automatically move all files into sub-folders based on their
types. Access it via Tools → Arrange into folders. Note that this tool only changes how the files are arranged inside the
EPUB, it does not change how they are displayed in the File browser.

5.8.8 Importeren van bestanden in andere e-book formaten als EPUB
The editor includes the ability to import files in some other e-book formats directly as a new EPUB, without going through
a full conversion. This is particularly useful to directly create EPUB files from your own hand-edited HTML files. You
can do this via File → Import an HTML or DOCX file as a new book.

Functie modus voor zoek & vervangen in de editor
De :guilabel: Zoek & vervangen tool in de editor ondersteunt een functiemodus. In deze modus kunt u reguliere expressies
combineren (zie :doc: regexp) met willekeurig krachtige Python-functies om allerlei geavanceerde tekstverwerking uit te
voeren.
In de standaard regexp modus voor zoeken en vervangen, geeft u zowel een reguliere expressie op om naar te zoeken als
een sjabloon, om alle gevonden overeenkomsten te vervangen. In functiemodus geeft u in plaats van een vast sjabloon
een willekeurige functie op in de Python programmeertaal31. Hiermee kunt u veel dingen doen die niet mogelĳk zĳn met
eenvoudige sjablonen.

31 https://docs.python.org
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Technieken voor het gebruik van de functie modus en de syntaxis worden beschreven aan de hand van voorbeelden, waarin
u wordt uitgelegd hoe u functies kunt maken om steeds complexere taken uit te voeren.

Automatisch het hoofdlettergebruik van titels in documenten corrigeren

Hier zullen we gebruik maken van een van de ingebouwde functies in de editor om automatisch het hoofdlettergebruik
van alle tekst binnen heading-tags naar elk woord met hoofdletters te veranderen:

Find expression: <([Hh][1-6])[^>]*>.+?</\1>

For the function, simply choose the Title-case text (ignore tags) builtin function. The will change titles that look like:
<h1>some titLE</h1> to <h1>Some Title</h1>. It will work even if there are other HTML tags inside the heading
tags.

Uw eerste aangepaste functie - koppeltekens slim maken

The real power of function mode comes from being able to create your own functions to process text in arbitrary ways.
The Smarten Punctuation tool in the editor leaves individual hyphens alone, so you can use the this function to replace
them with em-dashes.
To create a new function, simply click the Create/edit button to create a new function and copy the Python code from
below.

def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

return match.group().replace('--', '—').replace('-', '—')

Every Search & replace custom function must have a unique name and consist of a Python function named replace, that
accepts all the arguments shown above. For the moment, we won’t worry about all the different arguments to replace()
function. Just focus on the match argument. It represents a match when running a search and replace. Its full documen-
tation in available here32. match.group() simply returns all the matched text and all we do is replace hyphens in that
text with em-dashes, first replacing double hyphens and then single hyphens.
Gebruik deze functie met de zoek reguliere expressie:

>[^<>]+<

En het vervangt alle koppeltekens met em-streepjes maar enkel in echte tekst en niet in HTML tag definities.

De kracht van functie modus - een spellingswoordenboek gebruiken om fout koppeltekengebruik
te herstellen

E-boeken gecreëerd van scans van gedrukte boeken bevatten dikwĳls fout koppeltekengebruik – woorden gesplitst aan
het einde van een regel in d gedrukte tekst. We gaan een eenvoudige functie schrĳven om zulke woorden automatisch te
vinden en herstellen.

32 https://docs.python.org/library/re.html#match-objects
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import regex

from calibre import replace_entities

from calibre import prepare_string_for_xml

def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

def replace_word(wmatch):

# Try to remove the hyphen and replace the words if the resulting

# hyphen free word is recognized by the dictionary

without_hyphen = wmatch.group(1) + wmatch.group(2)

if dictionaries.recognized(without_hyphen):

return without_hyphen

return wmatch.group()

# Search for words split by a hyphen

text = replace_entities(match.group()[1:-1]) # Handle HTML entities like &amp;

corrected = regex.sub(r'(\w+)\s*-\s*(\w+)', replace_word, text, flags=regex.

↪→VERSION1 | regex.UNICODE)

return '>%s<' % prepare_string_for_xml(corrected) # Put back required entities

Gebruik deze functie met dezelfde zoek reguliere expressie als voorheen, namelĳk:

>[^<>]+<

And it will magically fix all mis-hyphenated words in the text of the book. The main trick is to use one of the useful extra
arguments to the replace function, dictionaries. This refers to the dictionaries the editor itself uses to spell check
text in the book. What this function does is look for words separated by a hyphen, remove the hyphen and check if the
dictionary recognizes the composite word, if it does, the original words are replaced by the hyphen free composite word.
Note that one limitation of this technique is it will only work for mono-lingual books, because, by default,
dictionaries.recognized() uses the main language of the book.

Automatische nummering secties

Now we will see something a little different. Suppose your HTML file has many sections, each with a heading in an
<h2> tag that looks like <h2>Some text</h2>. You can create a custom function that will automatically number these
headings with consecutive section numbers, so that they look like <h2>1. Some text</h2>.

def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

section_number = '%d. ' % number

return match.group(1) + section_number + match.group(2)

# Ensure that when running over multiple files, the files are processed

# in the order in which they appear in the book

replace.file_order = 'spine'

Gebruik het met de find expresse:

(?s)(<h2[^<>]*>)(.+?</h2>)

Plaats de cursor aan het begin van het bestand en klik op Alle vervangen.
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This function uses another of the useful extra arguments to replace(): the number argument. When doing a Replace
All number is automatically incremented for every successive match.
Een andere nieuwe functie is het gebruik van de replace.file_order – instelling die voor 'spine' betekent dat als
deze zoekopdracht draait op meerdere HTML files, de bestanden verwerkt worden in de volgorde waarin ze verschĳnen
in het book. Bekĳk Kies bestandsvolgorde bĳ uitvoeren meerdere HTML bestanden (pagina 107) voor details.

Maak automatische inhoudsopgave aan

Finally, lets try something a little more ambitious. Suppose your book has headings in h1 and h2 tags that look like <h1
id="someid">Some Text</h1>. We will auto-generate an HTML Table of Contents based on these headings. Create
the custom function below:

from calibre import replace_entities

from calibre.ebooks.oeb.polish.toc import TOC, toc_to_html

from calibre.gui2.tweak_book import current_container

from calibre.ebooks.oeb.base import xml2str

def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

if match is None:

# All matches found, output the resulting Table of Contents.

# The argument metadata is the metadata of the book being edited

if 'toc' in data:

toc = data['toc']

root = TOC()

for (file_name, tag_name, anchor, text) in toc:

parent = root.children[-1] if tag_name == 'h2' and root.children else␣

↪→root

parent.add(text, file_name, anchor)

toc = toc_to_html(root, current_container(), 'toc.html', 'Table of␣

↪→Contents for ' + metadata.title, metadata.language)

print(xml2str(toc))

else:

print('No headings to build ToC from found')

else:

# Add an entry corresponding to this match to the Table of Contents

if 'toc' not in data:

# The entries are stored in the data object, which will persist

# for all invocations of this function during a 'Replace All' operation

data['toc'] = []

tag_name, anchor, text = match.group(1), replace_entities(match.group(2)),␣

↪→replace_entities(match.group(3))

data['toc'].append((file_name, tag_name, anchor, text))

return match.group() # We don't want to make any actual changes, so return␣

↪→the original matched text

# Ensure that we are called once after the last match is found so we can

# output the ToC

replace.call_after_last_match = True

# Ensure that when running over multiple files, this function is called,

# the files are processed in the order in which they appear in the book

replace.file_order = 'spine'

En gebruik het met de find expressie:
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<(h[12]) [^<>]* id=['"]([^'"]+)['"][^<>]*>([^<>]+)

Run the search on All text files and at the end of the search, a window will popup with “Debug output from your function”
which will have the HTML Table of Contents, ready to be pasted into toc.html.
The function above is heavily commented, so it should be easy to follow. The key new feature is the use of another useful
extra argument to the replace() function, the data object. The data object is a Python dictionary that persists between
all successive invocations of replace() during a single Replace All operation.
Another new feature is the use of call_after_last_match – setting that to True on the replace() function means
that the editor will call replace() one extra time after all matches have been found. For this extra call, the match object
will be None.
This was just a demonstration to show you the power of function mode, if you really needed to generate a Table of
Contents from headings in your book, you would be better off using the dedicated Table of Contents tool in Tools → Table
of Contents.

De API voor de functie modus

All function mode functions must be Python functions named replace, with the following signature:

def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

return a_string

When a find/replace is run, for every match that is found, the replace() function will be called, it must return the
replacement string for that match. If no replacements are to be done, it should return match.group() which is the
original string. The various arguments to the replace() function are documented below.

The match argument

The match argument represents the currently found match. It is a Python Match object33. Its most useful method is
group() which can be used to get the matched text corresponding to individual capture groups in the search regular
expression.

The number argument

The number argument is the number of the current match. When you run Replace All, every successive match will cause
replace() to be called with an increasing number. The first match has number 1.

Het file_name argument

This is the filename of the file in which the current match was found. When searching inside marked text, the file_name
is empty. The file_name is in canonical form, a path relative to the root of the book, using / as the path separator.

Het metadata argument

This represents the metadata of the current book, such as title, authors, language, etc. It is an object of class calibre.
ebooks.metadata.book.base.Metadata (pagina 212). Useful attributes include, title, authors (a list of au-
thors) and language (the language code).

33 https://docs.python.org/library/re.html#match-objects
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Het dictionaries argument

This represents the collection of dictionaries used for spell checking the current book. Its most useful method is
dictionaries.recognized(word) which will return True if the passed in word is recognized by the dictionary
for the current book’s language.

Het data argument

This a simple Python dictionary. When you run Replace all, every successive match will cause replace() to be
called with the same dictionary as data. You can thus use it to store arbitrary data between invocations of replace()
during a Replace all operation.

Het functions argument

The functions argument gives you access to all other user defined functions. This is useful for code re-use. You can
define utility functions in one place and re-use them in all your other functions. For example, suppose you create a function
name My Function like this:

def utility():

# do something

def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

...

Dan, in een andere functie, hebt u toegang tot de utility() functie, zo:

def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

utility = functions['My Function']['utility']

...

You can also use the functions object to store persistent data, that can be re-used by other functions. For example, you
could have one function that when run with Replace All collects some data and another function that uses it when it is run
afterwards. Consider the following two functions:

# Function One

persistent_data = {}

def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

...

persistent_data['something'] = 'some data'

# Function Two

def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

persistent_data = functions['Function One']['persistent_data']

...

106 Hoofdstuk 5. E-boeken bewerken



calibre Gebruikershandleiding, Release 8.7.0

Foutzoeken in uw functies

You can debug the functions you create by using the standard print() function from Python. The output of print will
be displayed in a popup window after the Find/replace has completed. You saw an example of using print() to output
an entire table of contents above.

Kies bestandsvolgorde bij uitvoeren meerdere HTML bestanden

When you run a Replace all on multiple HTML files, the order in which the files are processes depends on what files you
have open for editing. You can force the search to process files in the order in which the appear by setting the file_order
attribute on your function, like this:

def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

...

replace.file_order = 'spine'

file_order accepts two values, spine and spine-reverse which cause the search to process multiple files in the
order they appear in the book, either forwards or backwards, respectively.

Having your function called an extra time after the last match is found

Sometimes, as in the auto generate table of contents example above, it is useful to have your function called an extra time
after the last match is found. You can do this by setting the call_after_last_match attribute on your function, like
this:

def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

...

replace.call_after_last_match = True

Appending the output from the function to marked text

When running search and replace on marked text, it is sometimes useful to append so text to the end of the marked text.
You can do that by setting the append_final_output_to_marked attribute on your function (note that you also need
to set call_after_last_match), like this:

def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

...

return 'some text to append'

replace.call_after_last_match = True

replace.append_final_output_to_marked = True

Suppressing the result dialog when performing searches on marked text

You can also suppress the result dialog (which can slow down the repeated application of a search/replace on many blocks
of text) by setting the suppress_result_dialog attribute on your function, like this:
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def replace(match, number, file_name, metadata, dictionaries, data, functions, *args,␣

↪→**kwargs):

...

replace.suppress_result_dialog = True

Meer voorbeelden

More useful examples, contributed by calibre users, can be found in the calibre E-book editor forum34.

Fragmenten
De calibre e-boek editor ondersteunt fragmenten. Een fragment is een stukje tekst dat ofwel dikwĳls herbruikt wordt ofwel
veel redundante tekst bevat. De editor laart u toe een fragment in te voegen met een paar toetsaanslagen. Bv veronderstel
dat u dikwĳls tags invoegt bĳ het bewerken van HTML bestanden, dan kan u simpelweg <a intikken en op Control+J

drukken. De editor zal het uitbreiden tot:

<a href="filename"></a>

Niet alleen dat, het woord bestandsnaam zal worden geselecteerd, met de cursor eroverheen, zodat u eenvoudig de echte
bestandsnaam kunt typen, met handige editorfunctie :ref: editor_auto_complete. En als u klaar bent met het typen van de
bestandsnaam, druk opnieuw op Control+J en de cursor springt naar de positie tussen de <a> tags, zodat u eenvoudig
de tekst voor de link kunt typen.
Het fragmentensysteem in de editor is zeer geavanceerd, er zĳn een paar ingebouwde fragmenten en u kunt uw eigen
fragmenten maken, aangepast aan uw bewerkingsstĳl.
De volgende bespreking van de ingebouwde fragmenten zou de kracht van het fragmentensysteem moeten illustreren.

Notitie

U kunt ook snippets gebruiken in de invoervelden in het :guilabel: Zoeken & vervangen paneel, echter, plaatshouders
(met Control+J om rond te springen) zullen niet werken.

De ingebouwde fragmenten

De ingebouwde fragmenten worden onder beschreven. Merk op dat u ze kunt negeren door uw eigen fragmenten te maken
met dezelfde triggertekst.

Opvultekst [Lorem] invoegen

Het eerste ingebouwde fragment, en het eenvoudigste, is om vultekst in een document in te voegen. De vultekst is afkomstig
uit De finibus bonorum et malorum35 een filosofisch werk van Cicero (vertaald naar Engels). Om het te gebruiken, typ
gewoon `` Lorem ‘’ in een HTML-bestand en druk op Control+J. Het wordt vervangen door een paar alinea’s vultekst.
De definitie van dit fragment is heel eenvoudig, de triggertekst is gedefinieerd als ``Lorem’’ en de sjabloon is gewoon
gedefinieerd als de letterlĳke tekst om in te voegen. U kunt het gemakkelĳk aanpassen om uw favoriete vultekst te
gebruiken.

34 https://www.mobileread.com/forums/showthread.php?t=237181
35 https://en.wikipedia.org/wiki/De_finibus_bonorum_et_malorum
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Een zelfsluitende HTML tag [<>] invoegen

Laten we nu een gemakkelĳke voorbeeld van het krachtige concept plaatshouders bekĳken. Stel dat u de zelfsluitende tag
<hr/> wil invoegen. Tik gewoon <> en druk op Control+J, de editor breid het fragment uit naar:

<|/>

Het | symbool stelt hier de huidige cursorpositie voor. U kan dan hr tikken en op Control+J drukken om de cursor
achter het einde van de tag te plaatsen. Dit fragment is gedefinieerd als:

Trigger: <>

Template: <$1/>$2

Plaatshouders zĳn gewoon het dollar ($) teken, gevolgd door een nummer. Als het fragment wordt uitgebreid door Con-
trol+J te drukken, komt de cursor bĳ de eerste plaatshouder (de plaatshouder met het laagste nummer). Als u nogmaals
Control+J drukt, springt de cursor naar de volgende (de plaatshouder met het eerstvolgende nummer).

Een HTML link tag [<a] invoegen

HTML link tags delen een gemene structuur. Ze hebben een href attribuut en wat tekst tussen de open- en sluittag. Een
fragment om het intikken efficiënter te maken leidt ons tot meer functies van plaatshouders. Om dit fragment te gebruiken,
tik gewoon <a en druk op Control+J. De editor breidt dit uit tot:

<a href="filename|"></a>

Niet alleen dat, het woord bestandsnaam zal worden geselecteerd, met de cursor eroverheen, zodat u eenvoudig de
echte bestandsnaam kunt typen, met de handige editorfunctie :ref: editor_auto_complete. En als u klaar bent met het
typen van de bestandsnaam, druk opnieuw op Control+J en de cursor springt naar de positie tussen de <a> tags, zodat
u eenvoudig de tekst voor de link kunt typen. Als u klaar bent met de tekst, druk weer op Control+J om voorbĳ de
sluittag te springen. Dit fragment heet:

Trigger: <a

Template: <a href="${1:filename}">${2*}</a>$3

Er zĳn hier enkele nieuwe functies. Eerst, de $1 plaatshouder werd complexer. Er is nu wat standaard tekst inbegrepen
(het woord bestandsnaam). Als een plaatshouder standaard tekst bevat, vervangt de plaatshouder de standaard tekst
als het fragment wordt uitgebreid. En als u naar een plaatshouder met standaard tekst springt met Control+J wordt de
tekst geselecteerd. Zo kan u standaard tekst gebruiken als geheugensteuntje om belangrĳke stukken van de sjabloon in te
vullen. U kan standaard tekst specificeren voor een plaatshouder met de syntax: ${<number>:default text}.
De andere nieuwe functie is dat de tweede plaatshouder achter een asterisk heeft (${2*}). Dit wil zeggen dat de plaats-
houder elke tekst die was geselecteerd voor het uitbreiden van de sjabloon vervangt. Om dit in actie te zien, selecteer wat
tekst in de editor, druk Control+J tik <a en druk terug op Control+J, de sjabloon wordt uitgebreid tot:

<a href="filename">whatever text you selected</a>

Een HTML afbeelding tag [<i] invoegen

Dit lĳkt veel op het HTML link invoegen, zoals boven gezien. Het laat u toe snel een <img src="filename"

alt="description" /> tag in te voegen en te springen tussen de src en alt attributen:

Trigger: <i

Template: <img src="${1:filename}" alt="${2*:description}" />$3
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Een willekeurige HTML tag [<<] invoegen

Dit laat u toe een willekeurige complete HTML tag in te voegen (of eerder ingevoerde tekst erin te zetten). Om te
gebruiken, tik << en druk Control+J. De editor breidt het uit tot:

<|></>

Tik de tag naam, bĳvoorbeeld: span en druk op Control+J, dit resulteert in:

<span>|</span>

Merk op dat de sluittag automatisch met span gevuld werd. Dit wordt bereikt met weer een andere functie van plaats-
houders, spiegelen. Spiegelen betekent gewoon dat als u een plaatshouder meer dan eens specificeert in een sjabloon, de
tweede en alle verdere posities automatisch gevuld worden met wat u in de eerste intikte als u op Control+J drukt. De
definitie voor dit fragment is

Trigger: <<

Template: <$1>${2*}</$1>$3

Zoals u ziet werd de eerste plaatshouder ($1) twee keer gespecificeerd, de tweede keer in de sluittag, wat gewoon kopieert
eerder wat u in de openingstag intikt.

Een willekeurige HTML tag invoegen met een class attribuut [<c]

Lĳkt sterk op het willekeurige tag invoegen voorbeeld boven, veronderstelt enkel dat u een class voor de tag wil specifi-
ceren:

Trigger: <c

Template: <$1 class="${2:classname}">${3*}</$1>$4

Dit laat u toe eerst de tagnaam in te tikken, druk Control+J, tik de class naam, druk Control+J, tik de inhoud van de
tag en druk een laatste keer Control+J om uit de tag te springen. De sluittag wordt automatisch ingevuld.

Uw eigen fragmenten maken

Fragmenten zĳn echt tof omdat u ze voor uzelf kan maken volgens uw bewerkstĳl. Om eigen fragmenten te maken, ga naar
Bewerken → Voorkeuren → Editor instellingen → Beheer fragmenten in de editor. U krĳgt een gemakkelĳk te gebruiken
pop-up dialoog om uw eigen fragmenten te creëren. Klik gewoon op de Add snippet en u ziet deze dialoog:
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Geef uw fragment eerst een naam, iets beschrĳvend om het later te helpen identificeren. Specificeer dan de trigger. De
trigger is gewoon de tekst die u in de editor in tikt vooraleer Control+J te drukken om het fragment uit te breiden.
Specificeer dan de fragment sjabloon. Begin best met een voorbeeld boven en pas het aan uw noden aan. Als laatste,
specificeer voor welke bestandstypes het fragment moet dienen. Zo kan u verschillende fragmenten hebben met dezelfde
trigger die anders werken in verschillende bestandstypes.
De volgende stap is uw nieuw fragment testen. Gebruik deTest ruimte onderaan. Tik de triggertekst in en druk Control+J
om het fragment uit te breiden en tussen plaatshouders te springen.

5.8.9 De rapporten functie
The editor includes a nice Reports tool (via Tools → Reports) that shows summaries of the files, images, links, words,
characters and styles used in the book. Every line in the report is hot-linked. Double clicking a line jumps to the place in
the book where that item is used or defined (as appropriate). For example, in the Links view, you can double click entries
the Source column to jump to where the link is defined and entries in the Target column to jump to where the link points.
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5.9 Speciale mogelijkheden in de code editor
De Calibre HTML editor is erg krachtig. Het heeft veel mogelĳkheden om het editeren van HTML (en CSS) gemakkelĳker
te maken

5.9.1 Syntaxis markering
De HTML editor heeft een erg gesofistikeerd syntax accentuatie. Mogelĳkheden zĳn:

• De tekst binnen vet, schuin en hoofdingen zĳn vet/schuin gemaakt
• As you move your cursor through the HTML, the matching HTML tags are highlighted, and you can jump to the

opening or closing tag with the keyboard shortcuts Ctrl+{ and Ctrl+}. Similarly, you can select the contents of
a tag with Ctrl+Alt+T or Ctrl+Shift+T.

• Foutieve HTML is gemarkeerd met rode onderstreping
• Spelling errors in the text inside HTML tags and attributes such as title are highlighted. The spell checking is

language aware, based on the value of the lang attribute of the current tag and the overall book language.
• CSS binnen de <style> labels is geaccentueerd.
• Speciale karakters die moeilĳk zĳn te onderscheiden van niet-brekende spaties, zoals de verschillendes soorten

hyphens, en zo verder zĳn geaccentueerd.
• Links naar andere bestanden in <a> tags, <img> en <link> tags hebben allemaal de bestandsnamen geaccentueerd.

Als de bestandsnaam waar ze naar wĳzen niet bestaat, is de bestandsnaam gemarkeerd met een rode lĳn eronder.

5.9.2 Contextgevoelige hulp
Je kan met de rechtermuisknop klikken op een HTML tag of CSS eigenschap om hulp te verkrĳgen over die tag of
eigenschap.
U kan ook de Ctrl toets ingedrukt houden en klikken op elke bestandsnaam in een link tag om dat bestand te openen in
de editor. Ctrl klikken op een class naam brengt u naar de eerste stĳlregel die overeenkomt met de tag en de class.
Rechtsklikken op een classnaam in een HTML bestand laat u de class hernoemen, elk voorkomen van de class veranderend
doorheen het boek en al z’n stĳlbladen.
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5.9.3 Auto-aanvullen
Wanneer je een e-book aan het bewerken bent, is de lastigste taak om links te maken naar andere bestanden in het boek,
of naar CSS stylesheets, of afbeeldingen. Je moet de goede bestandsnaam en het goede relatieve pad achterhalen. De
editior heeft een auto-complete functie om dat makkelĳker te maken.
As you type a filename, the editor automatically pops up suggestions. Simply use the Tab key to select the correct file
name. The editor even offers suggestions for links pointing to an anchor inside another HTML file. After you type the #
character, the editor will show you a list of all anchors in the target file, with a small snippet of text to help you choose
the right anchor.
Note that unlike most other completion systems, the editor’s completion system uses subsequence matching. This means
that you can type just two or three letters from anywhere in the filename to complete the filename. For example, say you
want the filename ../images/arrow1.png, you can simply type ia1 and press Tab to complete the filename. When
searching for matches, the completion system prioritizes letters that are at the start of a word, or immediately after a path
separator. Once you get used to this system, you will find it saves you a lot of time and effort.

5.9.4 Fragmenten
The calibre E-book editor supports snippets. A snippet is a piece of text that is either re-used often or contains a lot of
redundant text. The editor allows you to insert a snippet with only a few key strokes. The snippets are very powerful, with
many features, such as placeholders you can jump between, automatic mirroring of repeated text and so on. For more
information, see Fragmenten (pagina 108).
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De calibre Content server

De calibre: guilabel: inhoudsserver geeft u toegang tot uw calibre bibliotheken en leest boeken direct in een browser op
uw favoriete mobiele telefoon of tablet. Als gevolg hiervan hoeft u geen speciale apps voor het lezen/beheren van boeken
op uw telefoon te installeren. Gebruik gewoon de browser. De server downloadt en bewaart het boek dat u leest in een
off-line buffer, zodat u het kunt lezen, zelfs als er geen internetverbinding is.

Inhoud

• Toegang krĳgen tot de Content server vanaf andere toestellen (pagina 116)
– Toegang krĳgen tot de server vanaf apparaten in uw thuisnetwerk (pagina 116)
– Toegang krĳgen tot de server van overal op het internet (pagina 117)

• De server interface (pagina 117)
– De boekenlĳst (pagina 118)
– The book viewer (pagina 118)

• Browserondersteuning (pagina 118)
• Offline support inschakelen (pagina 118)
• Gebruikersaccounts enkel beheren vanop de commandoregel (pagina 118)
• Integratie van de Calibre Content-server in andere servers (pagina 119)

– Een volledig virtuele host gebruiken (pagina 119)
– Met een URL prefix (pagina 120)

• Een dienst creëren voor de calibre server op een modern Linux systeem (pagina 121)

Om de server te starten, klikt u op de: guilabel: verbinden/delen ` knop en kiest: guilabel: Start inhoudsserver`. Mogelĳk
ontvangt u een bericht van de firewall of het antivirusprogramma van uw computer met de vraag of het OK is om toegang
te verlenen tot `` calibre.exe``. Klik op de knop `` Toestaan`` of `` OK``. Open vervolgens een browser (bĳ voorkeur Chrome
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of Firefox) op uw computer en typ het volgende adres:
http://127.0.0.1:8080

This will open a page in the browser showing you your calibre libraries, click on any one and browse the books in it. Click
on a book, and it will show you all the metadata about the book, along with buttons to Read and Download the book.
Click the Read button to start reading the book.

Notitie

Het adres dat boven `` http: //127.0.0.1: 8080`` wordt gebruikt, werkt alleen op de computer die calibre draait. Om
toegang te krĳgen tot de server vanaf andere computers/telefoons/tablets/enz. u zult wat meer werk moeten doen,
zoals beschreven in de volgende sectie.

6.1 Toegang krijgen tot de Content server vanaf andere toestellen
Er zĳn twee typen van externe apparaat toegang die u normaal gesproken nodig heeft. De eerste, eenvoudigere soort
is vanuit uw thuisnetwerk. Als u calibre draait op een computer in uw thuisnetwerken en ook uw andere apparaten op
hetzelfde thuisnetwerk hebt aangesloten, moet u gemakkelĳk toegang hebben tot de server op die apparaten.

6.1.1 Toegang krijgen tot de server vanaf apparaten in uw thuisnetwerk
Na starten van de server in calibre zoals boven beschreven, klik terug op de Verbinden/delen knop. In plaats van de Start
Content server zou u een Stop Content server actie moeten zien. Rechts van deze actie staat een IP adres en een poort
nummer. Deze lĳken op een hoop getallen gescheiden door punten. Bĳvoorbeeld:

Stop Content server [192.168.1.5, port 8080]

Deze getallen zeggen u welk adres te gebruiken om te verbinden met de server in uw toestel. Volgens het voorbeeld boven
wordt het adres:

http://192.168.1.5:8080

Het eerste deel van het adres is altĳd http:// het volgende deel is het IP adres, de nummers voor de komma, en tenslotte
het poortnummer dat wordt toegevoegd aan het IP adres met een dubbel punt (:). Als u geluk hebt, is dit alles dat u nodig
hebt en kĳkt u nu naar de calibre bibliotheken op uw toestel. Indien niet, lees verder.

Problemen oplossen voor de thuisnetwerkverbinding
Als u niet met de server kan verbinden vanop uw toestel, probeer volgende stappen:

1. Controleer of de server draait door naar http://127.0.0.1:8080 te gaan in een browser op dezelfde computer
als de server.

2. Controleer of uw firewall en anti-virus verbindingen toelaten naar uw computer op poort 8080 en het calibre
programma. De gemakkelĳkste manier om firewall en anti-virus als bron van problemen te elimineren is ze tĳdelĳk
uit te schakelen en dan proberen te verbinden. U moet eerst de internet verbinding verbreken vóór de firewall uit
te schakelen om uw computer niet onbeschermd te laten.

3. Controleer of uw computer en toestel op hetzelfde netwerk zitten. Dit betekent dat ze beiden met dezelfde draadloze
router verbonden zĳn. Vooral, ze mogen geen mobiele telefoon of ISP geleverde WiFi verbinding gebruiken.

4. Als u een niet-standaard netwerkopstelling hebt, kan het zĳn dat het IP adres, getoond in het Verbinden/delen menu
fout is. In zulk geval moet u zelf uitzoeken wat het correcte te gebruiken IP adres is. Spĳtig genoeg is het onmogelĳk
u daarvoor een stappenplan te geven gezien het oneindige aantal mogelĳke configuraties.
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5. Als u een gebruikersnaam en wachtwoord hebt ingesteld, probeer eerst zonder om te zien of dat pro-
blemen oplevert. Sommige e-inkt toestellen hebben browsers die geen authenticatie kunnen afhandelen.
U kan dit soms omzeilen door gebruikersnaam en wachtwoord in te sluiten in de URL, bv.: http://

gebruikersnaam:wachtwoord@192.168.1.2:8080.
6. Als u vast zit kan u altĳd hulp vragen in de calibre gebruikersforums36.

6.1.2 Toegang krijgen tot de server van overal op het internet

Waarschuwing

Alvorens dit te doen, moet u gebruikersnaam/wachtwoord bescherming op de server aanzetten anders heeft iedereen
ter wereld toegang tot uw boeken. Ga naar Voorkeuren → Delen → Delen via (inter)net en schakel de optie Gebrui-
kersnaam en wachtwoord vereisen voor toegang tot de content server in.

Terwĳl de specifieke details om internet toegang in te stellen variëren afhankelĳk van de netwerkconfiguratie en het type
computer u gebruikt, is het basisschema als volgt.

1. Vind het externe IP adres van de computer waar u de server zal op draaien. Dit kan door de site What is my IP
address37 te bezoeken met een browser op de computer.

2. Als de computer achter een router zit, schakel port forwarding in om poort 8080 (of eender welke poort die u kiest
om de calibre Content server op te draaien) te forwarden.

3. Zorg ervoor dat de calibre server wordt doorgelaten door alle firewall/anti-virus programma’s op uw computer.
4. Nu zou u toegang moeten hebben tot de server via elk met internet verbonden toestel met het IP adres dat u vond

in de eerste stap. Bv. als het gevonden IP adres 123.123.123.123 was en de poort die u gebruikt voor de calibre
server 8080, het adres om te gebruiken op toestel wordt: http://123.123.123.123:8080.

5. Als optie kan u een dienst gebruiken als no-ip38 om een gemakkelĳk te herinneren adres in te stellen i.p.v. het adres
dat u vond in de eerste stap.

Notitie

Voor maximale veiligheid moet u ook HTTPS inschakelen op de Content server. U kan dit doen ofwel direct op de
server door het pad te voorzien naar het te gebruiken HTTPS certificaat in de geavanceerde configuratie opties voor
de server ofwel kan u een omgekeerde proxy instellen zoals onder beschreven, om een bestaande HTTPS setup te
gebruiken.

6.2 De server interface
De server interface is een vereenvoudigde versie van de calibre hoofdinterface, geoptimaliseerd voor gebruik met aan-
raakschermen. Het startscherm toont u boeken die u aan het lezen bent en geeft de mogelĳkheid een calibre bibliotheek
te kiezen om te doorbladeren. De server in calibre geeft u toegang tot al uw bibliotheken, niet maar een enkele zoals
vroeger.

36 https://www.mobileread.com/forums/forumdisplay.php?f=166
37 https://www.whatismyip.com/
38 https://www.noip.com/free
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6.2.1 De boekenlijst
De server boekenlĳst is een eenvoudig raster met boeken. Tik op een omslag om de detail metadata voor een boek te
zien. Als u een meer gedetailleerde lĳst verkiest, kan u het standaard beeld veranderen door op de drie verticale punten
rechtsboven te klikken.
Sorteren en doorzoeken van de boekenlĳst zou bekend moeten zĳn voor calibre gebruikers. Starten kan door klikken op
hun iconen rechtsboven. Ze werken beiden exact hetzelfde als in het calibre hoofdprogramma. De zoekpagina laat u zelfs
zoekqueries maken te klikken op auteurs/labels.enz., net zoals in de Labelbrowser in het hoofdprogramma.
Een geliefde functie in het hoofdprogramma, Virtuele bibliotheken is ook aanwezig in de server interface. Klik op de drie
verticale punten rechtsboven om een Virtuele bibliotheek te kiezen.

6.2.2 The book viewer
You can read any book in your calibre library by simply tapping on it and then tapping the Read button. The book viewer
is very simple to operate. You can both tap and swipe to turn pages. Swiping up/down skips between chapters. Tapping
the top quarter of the screen gets you the detailed controls and viewer preferences.
Als u de server laat draaien, kan u zelfs hetzelfde boek op verschillende toestellen openen en het herinnert uw laatste
leespositie. Indien niet kan u een synchronisatie afdwingen door tikken in het bovenste kwart en Sync kiezen.

6.3 Browserondersteuning
De nieuwe calibre server maakt veel gebruik van geavanceerde HTML 5 en CSS 3 functies. Daarom heeft het een up-to-
date browser nodig. Het is getest op Android Chrome en iOS Safari en op Chrome en Firefox op de desktop.
De server is oplettend om functionaliteit te gebruiken die al standaard is of op weg ernaar toe. Als hĳ dus momenteel niet
werkt met uw favoriete browser, zal hĳ dat waarschĳnlĳk wel doen zo gauw uw browser bĳgebeend is.
Als u een bĳzonder oude of beperkte browser gebruikt of u houdt niet van Javascript kan u de mobiele versie gebruiken
door simpelweg /mobile aan het server adres toe te voegen.

Notitie

Op iOS laat Apple slechts één browser engine toe, dus Firefox, Chrome en Safari zĳn allemaal hetzelfde onder de
motorkap. De nieuwe server interface vereist iOS 10.3.2 of nieuwer. Op Android is de server getest met Chrome
versie 58 en nieuwer.

6.4 Offline support inschakelen
Browser makers have been trying to force people to use SSL by disabling advanced features in their browsers for plain
HTTP connections. One such casualty is ApplicationCache, which was what was used in calibre for offline support. As
a result now-a-days sadly, offline mode works only as long as you keep the browser tab open. In addition, in Firefox on
Android, you will need to type about:config and create a preference called browser.tabs.useCache and set it to
true.

6.5 Gebruikersaccounts enkel beheren vanop de commandoregel
Het calibre programma heeft een leuke sectie in Voorkeuren dat u gebruikersaccounts laat beheren voor de server. Echter,
als u de server zelfstandig wilt draaien en het calibre hoofdprogramma niet op dezelfde computer/gebruikersaccount kunt
draaien, kunt u ook gebruikers beheren via de commandoregel.
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U kan gebruikersaccounts beheren met de --manage-users optie van het zelfstandige calibre-server programma.
Veronderstel dat u de gebruikersdatabase wilt opslaan in de map /srv/calibre , dan creëert u die door het draaien van:

calibre-server --userdb /srv/calibre/users.sqlite --manage-users

Volg gewoon de prompts om gebruikersaccounts te creëren, hun toelatingen in te stellen, enz. Als u klaar bent, kan u de
server draaien als volgt:

calibre-server --userdb /srv/calibre/users.sqlite --enable-auth

Het gebruikt de gebruikersaccounts die u creëerde in de vorige stap.

6.6 Integratie van de Calibre Content-server in andere servers
Hier laten we u zien hoe de calibre Content server te integreren in een andere server. Dit gebeurt meestal om gebruik te
maken van SSL of om de calibre bibliotheek te gebruiken als deel van een grotere site. De basistechniek is om de calibre
server te draaien en een omgekeerde proxy in te stellen van de hoofdserver.
Een omgekeerde proxy betekent dat uw gewone server binnenkomende verzoeken accepteert en die doorgeeft aan de
calibre server. Hĳ leest dan de antwoorden van de calibre server en stuurt die door naar de cliënt. Dit betekent dat u de
calibre server gewoon als altĳd kunt draaien zonder hem te moeten integreren met uw hoofdserver.

6.6.1 Een volledig virtuele host gebruiken
De eenvoudigste configuratie is om een volledig virtuele host aan de calibre server toe te wĳden. In dit geval, draai de
calibre server als:

calibre-server

Stel nu uw viruele host in op uw hoofdserver, bĳvoorbeeld voor nginx:

http {

client_max_body_size 64M; # needed to upload large books

}

server {

listen [::]:80;

server_name myserver.example.com;

location / {

proxy_pass http://127.0.0.1:8080;

}

}

Of voor Apache:

LoadModule proxy_module modules/mod_proxy.so

LoadModule proxy_http_module modules/mod_proxy_http.so

<VirtualHost *:80>

ServerName myserver.example.com

AllowEncodedSlashes On

ProxyPreserveHost On

ProxyPass "/" "http://localhost:8080/"

</VirtualHost>
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6.6.2 Met een URL prefix
Als u geen volledige virtuele host wil toewĳden aan calibre kan u hem een URL prefix laten gebruiken. Start de calibre
server als:

calibre-server --url-prefix /calibre --port 8080

De sleutel parameter hier is --url-prefix /calibre. Dit laat de Content server alle URL’s voorafgegaan door /
calibre bedienen. Om dit in actie te zien, bezoek http://localhost:8080/calibre in uw browser. U zou de
normale Content server website moeten zien maar hĳ draait nu onder /calibre.
Met nginx is de vereiste configuratie:

http {

client_max_body_size 64M; # needed to upload large books

}

proxy_set_header X-Forwarded-For $remote_addr;

location /calibre/ {

proxy_buffering off;

proxy_pass http://127.0.0.1:8080$request_uri;

}

location /calibre {

# we need a trailing slash for the Application Cache to work

rewrite /calibre /calibre/ permanent;

}

Voor Apache, activeer eerst de proxy modules in Apache door het volgende toe te voegen aan httpd.conf:

LoadModule proxy_module modules/mod_proxy.so

LoadModule proxy_http_module modules/mod_proxy_http.so

De exacte techniek om de proxy modules in te schakelen hangt af van uw Apache installatie. Als u de proxy modules hebt
ingeschakeld, voeg de volgende regels toe aan httpd.conf (of als u virtuele hosts gebruikt, aan het conf bestand voor
die virtuele host):

AllowEncodedSlashes On

RewriteEngine on

RewriteRule ^/calibre/(.*) http://127.0.0.1:8080/calibre/$1 [proxy]

RedirectMatch permanent ^/calibre$ /calibre/

Dat is alles, u hebt nu toegang tot de calibre Content server via de /calibre URL in uw hoofdserver. De boven-
staande regels geven alle verzoeken onder /calibre door aan de calibre server draaiend op poort 8080 en dankzĳ de
--url-prefix optie boven, handelt de calibre server ze transparant af.

Notitie

Bĳ gebruik van een reverse proxy moet u de calibre Content server vertellen om enkel naar localhost te luisteren via
--listen-on 127.0.0.1. Op deze manier luistert de server enkel voor verbindingen vanop dezelfde computer,
d.w.z. van de reverse proxy.

Notitie
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Als u SSL hebt ingesteld voor uw hoofdserver, moet u de calibre server zeggen basis authenticatie te gebruiken i.p.v.
digest authenticatie, dat is sneller. Geef hiertoe de --auth-mode=basic optie mee aan de calibre-server.

6.7 Een dienst creëren voor de calibre server op een modern Linux
systeem

U kan gemakkelĳk een dienst creëren om calibre te starten bĳ booten op een modern (systemd39) gebaseerd Linux
systeem. Creëer gewoon het bestand /etc/systemd/system/calibre-server.service met de inhoud onder ge-
toond:

[Unit]

Description=calibre Content server

After=network.target

[Service]

Type=simple

User=mylinuxuser

Group=mylinuxgroup

ExecStart=/opt/calibre/calibre-server "/path/to/calibre library folder"

[Install]

WantedBy=multi-user.target

Verander mylinuxuser en mylinuxgroup naar eender welke gebruiker en groep die u op de server wil. Dit zou dezelfde
gebruiker en groep moeten zĳn als de eigenaar van de bestanden in de calibre bibliotheekmap. Merk po dat het gewoonlĳk
geen goed idee is de server als root te draaien. Verander ook het pad naar de calibre bibliotheekmap volgens uw systeem.
U kan meerdere bibliotheken toevoegen indien nodig. Bekĳk de help voor het calibre-server commando.
Draai nu:

sudo systemctl start calibre-server

om de server te starten. Controleer z’n status met:

sudo systemctl status calibre-server

Om hem te laten starten bĳ het booten, draai:

sudo systemctl enable calibre-server

Notitie

De calibre server heeft geen draaiende X server nodig maar wel de X geïnstalleerde bibliotheken omdat sommige
componenten die hĳ nodig heeft eraan linken.

Notitie

De calibre server ondersteunt ook systemd socket activatie, u kan dat dus ook gebruiken indien nodig.

39 https://www.freedesktop.org/wiki/Software/systemd/
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E-books vergelĳken

calibre bevat een geïntegreerde tool voor het vergelĳken van e-boeken die kan worden gebruikt om te zien wat er in een
e-book is veranderd nadat het is bewerkt of geconverteerd. Het kan boeken vergelĳken in de formaten EPUB en AZW3.
Om het te gebruiken, opent u het e-book in de tool voor E-boeken bewerken (pagina 81) en klikt u op: guilabel:bestand-
>vergelĳk met ander boek of gebruikt u het: ref: book_details paneel. Als u een conversie uitvoert van EPUB naar
EPUB, wordt het oorspronkelĳke EPUB-bestand opgeslagen als ORIGINAL_EPUB. Klik met de rechtermuisknop op
het ORIGINAL_EPUB-item in het deelvenster Boek details en kies: guilabel:Vergelĳk met EPUB-indeling.
De vergelĳkende tool die wordt geopend, ziet eruit als de onderstaande schermafdruk. Het toont u de verschillen in tekst,
stĳlen en afbeeldingen in de gekozen boeken.
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7.1 De vergelijking weergave begrijpen
Zoals te zien is in de bovenstaande schermafdruk, toont de vergelĳkingsweergave de verschillen tussen de twee boeken
naast elkaar. Alleen de verschillen, met een paar regels context om hen heen, worden getoond. Hierdoor is het eenvoudig
om in één oogopslag te zien wat er is veranderd in een groot document zoals een boek.
Toegevoegde tekst met een groene, verwĳderde tekst met rode en de gewĳzigde tekst met blauwe achtergrond weergeven.
De regelnummers van alle gewĳzigde tekst worden aan de zĳkant weergegeven, zodat u gemakkelĳk naar een bepaalde
wĳziging in de editor kunt gaan. Wanneer u het vergelĳkingshulpmiddel vanuit de editor opent, kunt u ook dubbelklikken
op een regel in het rechterpaneel om automatisch naar die regel in de editor te gaan.
Een handige techniek bĳ het vergelĳken van boeken is om de vergelĳkingsfunctie te vertellen om de tekst- en stĳlbestanden
te verfraaien voordat de verschillen worden berekend. Dit kan vaak resulteren in schonere en gemakkelĳker te volgen
verschillen. Hiertoe klikt u op de knop: guilabel: Opties’ rechtsonder en kiest u: guilabel: ‘Verfraai bestanden voordat u ze
vergelĳkt’. Merk op dat verfraaien soms ongewenste effecten kan hebben, omdat het ongeldige markeringen kan veranderen
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om het geldig te maken. Je kunt ook het aantal regels van de context rond verschillen veranderen via de: guilabel: `Opties
knop.
U kunt zoeken naar tekst in de verschillen via de zoekbalk onderaan. U moet aangeven naar welk paneel u wilt zoeken,
de: guilabel: Links of de: guilabel:` Rechts`.

7.2 Lancering van de vergelijkingstool
Het vergelĳkingshulpmiddel is vooral handig wanneer u twee versies van hetzelfde boek hebt en wilt zien wat er anders
is. Daartoe zĳn er verschillende manieren om de tool te starten.

7.2.1 Twee e-book bestanden vergelijken
Open het eerste bestand in de: ref: edit tool. Klik nu op: guilabel: Bestand->Vergelĳk met een ander boek en kies het tweede
bestand (het moet in hetzelfde formaat zĳn als het eerste). De vergelĳkingsweergave wordt geopend met het bestand dat
aan de rechterkant wordt bewerkt en het tweede bestand aan de linkerkant.

7.2.2 Vergelijk de ORIGINAL_FMT met FMT
Wanneer u een conversie in Calibre van een FMT naar zichzelf uitvoert, wordt het oorspronkelĳke bestand opgeslagen als
ORIGINAL_FMT. U kunt zien wat er is gewĳzigd door de conversie door met de rechtermuisknop te klikken op het item
ORIGINAL_FMT in het venster: ref: book_details in het hoofdvenster en te selecteren: guilabel:` Vergelĳk met FMT`.
De vergelĳkingsweergave wordt geopend met ORIGINAL_FMT aan de linkerkant en FMT aan de rechterkant.

7.2.3 Vergelijk een checkpoint met de huidige staat van het boek gedurende het
bewerken

De: ref: edit tool heeft een zeer nuttige functie, genaamd: ref:` checkpoints`. Hiermee kunt u de huidige status van het boek
opslaan als een named * ĳkpunt *, waarnaar u kunt terugkeren als u de wĳzigingen die u hebt aangebracht sinds het maken
van het ĳkpunt niet leuk vindt. Ĳkpunten worden ook automatisch aangemaakt wanneer u verschillende geautomatiseerde
acties uitvoert in de editor. U kunt de lĳst met ĳkpunten bekĳken door naar: guilabel: View-> Checkpoints te gaan en
vervolgens de: guilabel:` vergelĳk`-knop gebruiken om het boek bĳ het geselecteerde ĳkpunt te vergelĳken met de huidige
staat. De vergelĳkingstool toont het controlepunt aan de linkerkant en de huidige status aan de rechterkant.
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Metadata van e-boeken aanpassen

Inhoud

• Metadata bewerken van één boek tegelĳk (pagina 127)
– Metadata aan het downloaden (pagina 128)
– Boekformaten beheren (pagina 128)
– Alles over de omslagen (pagina 128)

• Metadate van meerdere boeken tegelĳkertĳd bewerken (pagina 128)
– Zoek en vervangen (pagina 128)
– Metadata aan het bulk downloaden (pagina 129)

• Adding extra data files to a book (pagina 129)

E-boeken zĳn er in alle soorten en maten en vaker wel dan niet, zĳn hun metadata (dingen zoals titel/auteur/serie/uitgever)
onvolledig of onjuist. De eenvoudigste manier om metadata in calibre te wĳzigen, is door gewoon op een item te dubbel-
klikken en de juiste vervanging in te voeren. Voor meer geavanceerde, “power editing”, gebruik de metadata bewerken
tools onder besproken.

8.1 Metadata bewerken van één boek tegelijk
Klik op het boek dat u wilt bewerken en vervolgens op de :guilabel: Metadata bewerken’ knop of druk op de``E` toets.
Een dialoog opent waarin u alle aspecten van de metadata kunt bewerken. Het heeft verschillende functies om bewerken
sneller en efficiënter te maken. Een lĳst met veel gebruikte tips:

• U kan op de knop tussen titel en auteurs klikken om ze automatisch om te wisselen.
• U kunt op de knop naast auteurs sorteren klikken om calibre automatisch in te laten vullen met de sorteerwaarden

bĳ elke auteur opgeslagen. Gebruik de :guilabel: `Auteurs beheren’ dialoog om de sorteerwaarden van de auteurs
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te bekĳken/wĳzigen. Deze dialoog wordt geopend door klikken op/ingedrukt houden van de knop naast auteurs-
sortering.

• U kan op de knop naast tags klikken om de Tag editor te gebruiken om de tags van een boek te beheren.
• Gebruik het ISBN veld om een ISBN in te voeren (en veel andere ID types), het krĳgt een rode achtergrond als u

een ongeldig nummer invoert. Het kleurt groen bĳ geldige ISBNs.
• Het auteursorteerveld zal rood zĳn als de auteursorteerwaarde verschilt van wat calibre denkt dat het moet zĳn.

8.1.1 Metadata aan het downloaden
De leukste functie van de bewerk metadata dialoog is zĳn talent om automatisch vele metadata in te vullen door ze van
verschillende webstekken te halen. Momenteel gebruikt calibre Google Books en Amazon. Het kan Title, auteur, series,
tags, beoordeling, beschrĳving en ISBN voor u invullen.
Om de download te gebruiken, vul de titel en auteur velden in en klik op de Haal metadata knop. calibre geeft u een lĳst
met boeken die meest overeenkomen met de titel en auteur. Als u het ISBN veld invult, wordt dit bĳ voorkeur gebruikt
over titel en auteur. Geen overeenkomsten? Maak uw zoeken minder specifiek door slechts enkele sleutelwoorden uit de
titel te gebruiken en enkel de auteur’s achternaam.

8.1.2 Boekformaten beheren
In calibre kan een enkel boek gekoppeld zĳn aan verschillende formaten. Bv. u kwam in bezit van de Verzamelde Werken
van Shakespeare in EPUB formaat en converteerde dit naar MOBI om op uw Kindle te lezen. calibre beheert automatisch
verschillende formaten voor u. In de Beschikbare formaten sectie van de Bewerk metadata dialoog kan u deze formaten
beheren. U kan een nieuw formaat toevoegen, een bestaand formaat verwĳderen en calibre vragen de metadata en omslag
van het boek in te stellen uit een van de formaten.

8.1.3 Alles over de omslagen
U kan calibre vragen boekomslagen voor u te downloaden, indien het boek een ISBN heeft. Als alternatief kan u een
bestand op uw PC opgeven om als omslag te gebruiken. calibe kan zelfs een standaard omslag met basis metadata erop
voor u genereren. U kan afbeeldingen slepen en neerzetten op de omslag om hem te veranderen en ook rechtsklikken om
omslagafbeeldingen te knippen/plakken.
Bĳkomend is er een knop om automatisch de randen van de omslag bĳ te snĳden als uw afbeelding een lelĳke rand heeft.

8.2 Metadate van meerdere boeken tegelijkertijd bewerken
Selecteer eerst de boeken die u wil bewerken door Ctrl of Shift in te drukken en erop te klikken. Als u meer dan
één boek selecteert, laat klikken op de Metadata bewerken knop de Bulk metadata bewerken dialoog verschĳnen. Via
deze dialoog kan u snel auteur/uitgever/beoordeling/labels/series enz van een hoop boeken op dezelfde waarde instellen.
Dit is bĳzonder nuttig als u net een aantal boeken hebt geïmporteerd die metadata gemeen hebben. Deze dialoog is heel
krachtig, hĳ heeft bv. een Zoeken en vervangen tab die u kan gebruiken voor bulkoperaties op metadata en zelfs metadata
kopiëren van een kolom naar een andere.
De normale metadata bewerken dialoog heeft ook Volgende en Vorige knoppen die u kan gebruiken om de metadata te
bewerken van verschillenede boeken het een na het ander.

8.2.1 Zoek en vervangen
De Metadata bewerken voor veel boeken dialoog laat u willekeurig krachtige zoek- en vervangoperaties uitvoeren op de
geselecteerde boeken. Het gebruikt standaard een eenvoudige tekst zoek en vervang maar het ondersteunt ook reguliere
expressies. Voor meer over reguliere expressies, bekĳk Alles over het gebruik van reguliere expressies in calibre (pagi-
na 216).
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Zoals boven vermeld zĳn er twee zoek en vervang modi: karakterovereenkomst en reguliere expressies. Karakterovereen-
komst kĳkt in het Zoekveld dat u koos voor de karakters die u intikte in het zoek naar vak en vervangt deze karakters door
wat u intikte in het vervang door vak. Elke voorkomen van de zoekkarakters in het veld wordt vervangen. Bv. veronderstel
dat het te doorzoeken veld a bad cat bevat. Als u zoekt voor a om te vervangen door HELLO, zal het resultaat HELLO
bHELLOd cHELLOt zĳn.
Als het veld dat u doorzoekt een meervoudig veld is zoals labels, dan wordt elk label apart behandeld. Bv. als uw label
Horror, Scary bevat, zal de zoekexpressie r, met niets overeenkomen omdat de expressie eerst toegepast wordt op Horror
en dan op Scary.
Als u het zoeken hoofd/kleine letters wil laten negeren, ontkruis het Hoofdlettergevoelig vakje.
U kan calibre het hoofdlettergebruik van het resultaat laten veranderen (informatie na het vervangen) door een van de
functies uit het Pas functie toe na vervangen te kiezen. De beschikbare operaties zĳn:

• Kleine letters – verander alle karakters in het veld in kleine letters
• Hoofdletters – verander alle karakters in het veld in hoofdletters
• Title case – hoofdletter voor elk woord in het resultaat.

Het Uw test vak is voorzien om tekst in te voeren om te controleren of zoek/vervang doet wat u wilt. In de meeste gevallen
zĳn de boektestvakken voldoende maar het is mogelĳk dat er een geval is dat u wil controleren dat niet getoond wordt in
deze vakken. Voer dat geval in in Uw test.
Reguliere expressie modus verschilt wat van karaktermodus, buiten (natuurlĳk) het gebruik van reguliere expressies. Ten
eerste dat functies worden toegepast op de delen van de string overeenkomend met de zoekstring en niet het hele veld.
Verder zĳn functies van toepassing op de vervangstring, niet op het hele veld.
Het derde en belangrĳkste is dat de vervangingsstring kan refereren naar delen van de zoekstring door backreferenties
te gebruiken. Een backreferentie is \\n waar n een geheel getal is dat verwĳst naar de n’de groep tussen haakjes in de
zoekexpressie. Bv. met hetzelfde voorbeeld als boven, a bad cat, een zoekexpressie a (…) (…), en een vervangexpressie a
\2 \1, zal het resultaat a cat bad zĳn. Bekĳk a.u.b. de Alles over het gebruik van reguliere expressies in calibre (pagina 216)
voor meer informatie over backreferenties.
Een nuttig patroon: veronderstel dat u het hoofdlettergebruik wilt veranderen in een heel veld. De gemakkelĳkste manier
is de karaktermodus gebruiken maar laten we aannemen dat u reguliere expressie modus wilt gebruiken. De zoekexpressie
moet (^.*$) zĳn, de vervangexpressie \1, en de gewenste hoofdlettervervangfunctie moet geselecteerd worden.
Tenslotte, in reguliere expressie modus kan u waardes van een veld naar een ander kopiëren. Maak gewoon het bron-
en doelveld verschillend. De kopie kan het doelveld vervangen of voor-/achteraan bĳ het veld toevoegen . Het ‘gebruik
komma’ aankruisvakje zegt calibre wel of niet een komma toe te voegen tussen de tekst en het doelveld in voor-/achteraan
toevoegen modus. Als het doel meervoudig is, (bv. labels) kan u dit vakje niet ontkruisen.
Zoeken en vervangen wordt gedaan nadat alle andere metadataveranderingen in de andere tabs toegepast zĳn. Dit kan tot
enige verwarring leiden omdat de testvakken de informatie tonen voor de andere veranderingen maar de operatie wordt
uitgevoerd na de andere veranderingen. Als u twĳfelt over way gaat gebeuren, meng zoeken/vervangen niet met andere
veranderingen.

8.2.2 Metadata aan het bulk downloaden
Als u metadata voor meerdere boeken ineens wilt downloaden, rechtsklik op de Metadata bewerken knop en selecteer
Metadata downloaden. U kan kiezen tussen enkel metadata downloaden, enkel omslagen, of beiden.

8.3 Adding extra data files to a book
calibre can store any number of extra data files associated to a book. These can be alternate covers, supplementary
material, etc. They cannot be viewed directly or used as conversion sources. Nor are they indexed by the Full text search
engine in calibre. To view/add/delete them select the book and right click the Edit metadata button and choose Manage

8.3. Adding extra data files to a book 129



calibre Gebruikershandleiding, Release 8.7.0

data files. This will pop-up a window where you can perform operations on these files. Alternately, you can right click
the Add books button and choose Add data files to selected book records to more quickly add data files.
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Veel gestelde vragen

Inhoud

• E-book formaat conversie (pagina 131)
• Toestel integratie (pagina 134)
• Library management (pagina 141)
• Diversen (pagina 145)

9.1 E-book formaat conversie

Inhoud

• Welke conversie formaten worden ondersteund door Calibre? (pagina 132)
• Wat zĳn de beste bronformaten voor omzetting? (pagina 132)
• Ik heb een PDF geconverteerd, maar het bestand heeft verschillende soorten problemen? (pagina 132)
• Hoe converteer ik mĳn bestand met niet-Engelse karakters of smart quotes? (pagina 132)
• Hoe zit het met inhoudsopgaven in MOBI bestanden? (pagina 132)
• Hoe zet ik een set HTML-bestanden om in een specifieke volgorde? (pagina 133)
• De EPUB die ik maakte met Calibre is ongeldig? (pagina 134)
• Hoe maak ik gebruik van enkele van de geavanceerde features van de conversietools? (pagina 134)
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9.1.1 Welke conversie formaten worden ondersteund door Calibre?
Calibre ondersteunt de conversie van vele invoerformaten naar vele uitvoerformaten. Conversie is mogelĳk van elk in-
voerformaat in de volgende lĳst, naar elk uitvoerformaat.
Input Formats: AZW, AZW3, AZW4, CBZ, CBR, CB7, CBC, CHM, DJVU, DOCX, EPUB, FB2, FBZ, HTML, HT-
MLZ, KEPUB, LIT, LRF, MOBI, ODT, PDF, PRC, PDB, PML, RB, RTF, SNB, TCR, TXT, TXTZ
Output Formats: AZW3, EPUB, DOCX, FB2, HTMLZ, KEPUB, OEB, LIT, LRF, MOBI, PDB, PMLZ, RB, PDF, RTF,
SNB, TCR, TXT, TXTZ, ZIP

Notitie

PRC is een generiek formaat, Calibre ondersteunt PRC-bestanden met TextRead en MOBIBook-headers. PDB is ook
een generiek formaat. Calibre ondersteunt eReader, Plucker (alleen invoer), PML en zTxt PDB-bestanden. DJVU-
ondersteuning is alleen voor het converteren van DJVU-bestanden die ingesloten tekst bevatten. Deze worden meestal
gegenereerd door OCR-software. MOBI-boeken kunnen van twee typen Mobi6 en KF8 zĳn. Calibre ondersteunt
beide volledig. MOBI-bestanden hebben vaak de bestandsextensies .azw of .azw3. DOCX-bestanden van Microsoft
Word 2007 en nieuwer worden ondersteund.

9.1.2 Wat zijn de beste bronformaten voor omzetting?
In order of decreasing preference: LIT, MOBI, AZW, EPUB, KEPUB, AZW3, FB2, FBZ, DOCX, HTML, PRC, ODT,
RTF, PDB, TXT, PDF

9.1.3 Ik heb een PDF geconverteerd, maar het bestand heeft verschillende soorten
problemen?

PDF is een vreselĳk formaat om te converteren. Voor een lĳst voor de mogelĳke problemen die kunnen optreden bĳ het
converteren van een PDF, zie: PDF-documenten omzetten (pagina 75)

9.1.4 Hoe converteer ik mijn bestand met niet-Engelse karakters of smart quotes?
Er zĳn twee aspecten aan dit probleem:

1. Knowing the encoding of the source file: calibre tries to guess what character encoding your source files use,
but often, this is impossible, so you need to tell it what encoding to use. This can be done in the GUI via the
Input character encoding field in the Look & feel → Text section of the conversion dialog. The command-line
tools have an ebook-convert-txt-input --input-encoding option.

2. When adding HTML files to calibre, you may need to tell calibre what encoding the files are in. To do this
go to Preferences → Advanced → Plugins → File type and customize the HTML to ZIP plugin, telling it what
encoding your HTML files are in. Now when you add HTML files to calibre they will be correctly processed.
HTML files from different sources often have different encodings, so you may have to change this setting
repeatedly. A common encoding for many files from the web is cp1252 and I would suggest you try that
first. Note that when converting HTML files, leave the input encoding setting mentioned above blank. This
is because the HTML to ZIP plugin automatically converts the HTML files to a standard encoding (UTF-8).

9.1.5 Hoe zit het met inhoudsopgaven in MOBI bestanden?
Het eerste wat je je moet realiseren is, dat de meeste e-books twee inhoudsopgaves hebben. De eerste is de traditionele
inhoudsopgave, zoals bekend in gedrukte boeken. Deze inhoudsopgave is deel van de hoofd document ‘flow’ en kan naar
wens gestĳld worden. Dit is de eigenlĳke inhoudsopgave.
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Dan is er de metadata Inhoudsopgave. Zo’n Inhoudsopgave is geen deel van de boektekst en is normaal toegankelĳk via
een speciale knop op een reader. Bv. in de calibre e-boekviewer gebruikt u de Inhoudsopgave Tonen knop om het te zien.
Het kan niet gestĳld worden door de ontwerper van het boek. Hoe het eruit ziet hangt af van het viewer programma.
In the MOBI format, the situation is a little confused. This is because the MOBI format, alone amongst mainstream e-book
formats, does not have decent support for a metadata ToC. A MOBI book simulates the presence of a metadata ToC by
putting an extra content ToC at the end of the book. When you click Go to Table of Contents on your Kindle, it is to this
extra content ToC that the Kindle takes you.
Now it might well seem to you that the MOBI book has two identical ToCs. Remember that one is semantically a content
ToC and the other is a metadata ToC, even though both might have exactly the same entries and look the same. One can
be accessed directly from the Kindle’s menus, the other cannot.
When converting to MOBI, calibre detects the metadata ToC in the input document and generates an end-of-file ToC in
the output MOBI file. You can turn this off by an option in the MOBI Output settings. You can also tell calibre whether
to put it at the start or the end of the book via an option in the MOBI Output settings. Remember this ToC is semantically
a metadata ToC, in any format other than MOBI it cannot not be part of the text. The fact that it is part of the text in
MOBI is an accident caused by the limitations of MOBI. If you want a ToC at a particular location in your document text,
create one by hand. So we strongly recommend that you leave the default as it is, i.e. with the metadata ToC at the end
of the book. Also note that if you disable the generation of the end-of-file ToC the resulting MOBI file may not function
correctly on a Kindle, since the Kindle’s use the metadata ToC for many things, including the Page Flip feature.
If you have a hand edited ToC in the input document, you can use the ToC detection options in calibre to automatically
generate the metadata ToC from it. See the conversion section of the User Manual for more details on how to use these
options.
Finally, I encourage you to ditch the content ToC and only have a metadata ToC in your e-books. Metadata ToCs will give
the people reading your e-books a much superior navigation experience (except on the Kindle, where they are essentially
the same as a content ToC).

Notitie

The newer AZW3 format has proper support for a metadata ToC. However, the Kindle firmware tends to malfunction
if you disable the generation of the end-of-file inline ToC. So it is recommended that you leave the generated ToC
alone. If you create an AZW3 file with a metadata ToC and no end-of-file generated ToC, some features on the Kindle
will not work, such as the Page Flip feature.

9.1.6 Hoe zet ik een set HTML-bestanden om in een specifieke volgorde?
Als u een set HTML-bestanden in een specifieke volgorde wilt omzetten, dient u een inhoudsopgavebestand aan te maken,
d.w.z. nog een HTML-bestand, dat links naar alle andere bestanden bevat, geplaatst in de gewenste volgorde. Zo’n bestand
ziet er als volgt uit:

<html>

<body>

<h1>Table of Contents</h1>

<p style="text-indent:0pt">

<a href="file1.html">First File</a><br/>

<a href="file2.html">Second File</a><br/>

.

.

.

</p>

</body>

</html>
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Voeg dan dit HTML bestand toe aan de GUI en gebruik de Converteren knop om uw e-boek te creëren. U kan de optie
in het Inhoudsopgave onderdeel in de conversie dialoog gebruiken voor beheer van hoe de Inhoudsopgave gegenereerd
wordt.

Notitie

By default, when adding HTML files, calibre follows links in the files in depth first order. This means that if file
A.html links to B.html and C.html and D.html, but B.html also links to D.html, then the files will be in the order
A.html, B.html, D.html, C.html. If instead you want the order to be A.html, B.html, C.html, D.html then you must
tell calibre to add your files in breadth first order. Do this by going to Preferences → Advanced → Plugins → File type
and customizing the HTML to ZIP plugin.

9.1.7 De EPUB die ik maakte met Calibre is ongeldig?
Calibre garandeert niet dat een door Calibre gemaakte EPUB geldig is. De enige garantie die Calibre geeft is dat het
een geldige EPUB uitvoert als u geldige XHTML 1.1 + CSS 2.1 aanlevert. Calibre doet zĳn best om ervoor te zorgen
dat de door Calibre gemaakte EPUB’s daadwerkelĳk op een breed scala aan apparaten functioneren zoals bedoeld. Deze
doelstelling is onverenigbaar met het maken van geldige EPUB’s en is voor de overgrote meerderheid van de gebruikers
van veel groter belang. Als u een tool nodig heeft die altĳd geldige EPUB’s maakt, is Calibre niet geschikt voor u. Dit
houdt in dat als u een door Calibre gemaakte EPUB naar een online winkel wilt verzenden die de validiteit van EPUB’s
controleert, u zelf dient te controleren of de EPUB geldig is. Calibre doet dit namens u niet, m.a.w. u dient bĳ Calibre
geldige XHTML + CSS als de invoerdocumenten aan te leveren.

9.1.8 Hoe maak ik gebruik van enkele van de geavanceerde features van de con-
versietools?

You can get help on any individual feature of the converters by mousing over it in the GUI or running ebook-convert
dummy.html .epub -h at a terminal. A good place to start is to look at the following demo file that demonstrates some
of the advanced features html-demo.zip40.

9.2 Toestel integratie

Inhoud

• Welke apparaten worden door Calibre ondersteund? (pagina 135)
• Hoe kan ik helpen om mĳn apparaat te laten ondersteunen door Calibre? (pagina 135)
• Mĳn apparaat wordt niet herkend door Calibre? (pagina 135)
• Mĳn apparaat is niet-standaard of ongebruikelĳk. Hoe kan ik verbinding ermee maken? (pagina 136)
• Hoe gebruik ik Calibre op mĳn iPad/iPhone/iPod touch? (pagina 136)
• How do I use calibre with my Android phone/tablet or Kindle Fire? (pagina 137)
• Heb ik toegang tot mĳn calibre boeken via de browser op mĳn Kindle of ander leestoestel? (pagina 138)
• Ik kan geen e-mails verzenden vanuit Calibre? (pagina 138)
• My device is getting mounted read-only in Linux, so calibre cannot connect to it? (pagina 139)
• Why does calibre not support collections on the Kindle or shelves on the Nook? (pagina 139)

40 https://calibre-ebook.com/downloads/html-demo.zip
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• Ik krĳg steeds een foutmelding wanneer ik Calibre gebruik met de Kobo Touch/Glo/etc.? (pagina 139)
• Covers for books I send to my e-ink Kindle show up momentarily and then are replaced by a generic cover?

(pagina 140)
• Covers for books sent to my Kindle ColorSoft and newer do not show up in the book list? (pagina 140)
• De omslagen voor mĳn MOBI bestanden worden niet meer getoond in Kindle voor PC/Kindle voor Android/iPad

enz. (pagina 140)
• Ik heb boeken overgezet op mĳn Kindle, gebruik makend van Calibre. Waarom worden deze niet getoond? (pa-

gina 141)

9.2.1 Welke apparaten worden door Calibre ondersteund?
calibre can directly connect to all the major (and most of the minor) e-book reading devices, smartphones, tablets, etc.
In addition, using the Connect to folder function you can use it with any e-book reader that exports itself as a USB disk.
Finally, you can connect wirelessly to any device that has a web browser using the calibre Content server.

9.2.2 Hoe kan ik helpen om mijn apparaat te laten ondersteunen door Calibre?
If your device appears as a USB disk to the operating system, adding support for it to calibre is very easy. We just need
some information from you:

• Complete lĳst van e-boek formaten die uw toestel ondersteunt
• Is er een speciale map op het toestel om alle e-boekbestanden te plaatsen? En detecteert het toestel bestanden

geplaatst in submappen?
• We also need information about your device that calibre will collect automatically. First, if your device supports

SD cards, insert them. Then connect your device to the computer. In calibre go to Preferences → Miscellaneous
and click the “Debug device detection” button. This will create some debug output. Copy it to a file and repeat the
process, this time with your device disconnected from your computer.

• Stuur beide uitvoeren naar ons met de andere informatie en we schrĳven een stuurprogramma voor uw toestel.
Once you send us the output for a particular operating system, support for the device in that operating system will appear
in the next release of calibre. To send us the output, open a bug report and attach the output to it. See how to report bugs41.

9.2.3 Mijn apparaat wordt niet herkend door Calibre?
Volg deze stappen om het probleem te vinden:

• Zorg ervoor dat u slechts één apparaat tegelĳk met uw computer heeft verbonden. U kunt niet tegelĳkertĳd met
een ander door Calibre ondersteund apparaat, zoals een iPhone/iPad, enz. verbonden zĳn.

• If you are connecting an Apple iDevice (iPad, iPod Touch, iPhone), Apple no longer allows third party software
to connect to their devices using a USB cable. Instead use a wireless connection, via the calibre Content server.

• If you are connecting a 2024 Kindle or newer or an Android device, and are on macOS or Linux, read the note
under Een USB kabel gebruiken (pagina 137).

• On macOS if you get permission errors when connecting a device to calibre, you can fix that by looking under
System Preferences > Security and Privacy > Privacy > Files and Folders.

41 https://calibre-ebook.com/nl/bugs
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• Make sure you are running the latest version of calibre (currently 8.7.0). The latest version can always be downlo-
aded from the calibre website42. You can tell what version of calibre you are currently running by looking at the
bottom line of the main calibre window.

• Zorg ervoor dat uw besturingssysteem het toestel ziet, d.w.z. het toestel hoort zichtbaar te zĳn in Windows Ver-
kenner (in Windows) of Finder (in macOS).

• Ga in calibre naar Voorkeuren → Delen → Genegeerde toestellen en controleer of uw toestel niet genegeerd wordt
• Als alle bovenstaande stappen mislukken, ga naar Voorkeuren → Geavanceerd → Diversen en klik op Foutzoeken

toesteldetectie met uw toestel aangesloten en post de uitvoer als een ticket op de calibre bug tracker43.

9.2.4 Mijn apparaat is niet-standaard of ongebruikelijk. Hoe kan ik verbinding er-
mee maken?

In addition to the Connect to folder function found under the Connect/share button, calibre provides a User defined

device plugin that can be used to connect to any USB device that shows up as a disk drive in your operating system. Note:
on Windows, the device must have a drive letter for calibre to use it. See the device plugin Preferences -> Plugins

-> Device plugins -> User defined and Preferences -> Miscellaneous -> Get information to

setup the user defined device for more information. Note that if you are using the user defined plugin for a
device normally detected by a builtin calibre plugin, you must disable the builtin plugin first, so that your user defined
plugin is used instead.

9.2.5 Hoe gebruik ik Calibre op mijn iPad/iPhone/iPod touch?
Een gemakkelĳke manier om uw calibre collectie te doorbladeren vanop uw Apple toestel is via gebruik van De calibre
Content server (pagina 115), wat uw verzameling beschikbaar maakt via het net. Voer eerst volgende stappen uit in calibre

• Stel het Voorkeur Uitvoer Formaat in calibre in op EPUB (Het uitvoerformaat kan ingesteld worden in Voorkeu-
ren → Interface → Gedrag)

• Stel het uitvoerprofiel in op iPad (dit werkt ook voor iPhone/iPads) in Voorkeuren → Conversie → Algemene op-
ties → Pagina opmaak

• Converteer de boeken die u wilt lezen op uw iDevice naar EPUB formaat door ze te selecteren en te klikken op de
Converteren knop.

• Zet de Content server aan door te klikken op de Verbinden/delen knop en laat calibre draaien. U kan calibre ook
zeggen om de Content server automatisch te starten via Voorkeuren → Delen → Delen over (inter)net.

De Content server laat u toe boeken direct in Safari lezen. Bĳkomend zĳn er veel apps voor uw iDevice die met de calibre
Content server kunnen verbinden. Voorbeelden: Marvin, Mapleread en iBooks zelf.

De Content server gebruiken.
Start de Safari browser en tik het IP adres en de poort van de computer die de calibre server draaien in, zoals dit:

http://192.168.1.2:8080/

Vervang 192.168.1.2 door het lokale IP adres van de computer die calibre draait. Bekĳk De calibre Content server
(pagina 115) voor details over het draaien van de server en het correcte IP adres vinden om te gebruiken
U zal een lĳst met boeken zien in Safari, tik op een boek en u krĳgt de optie ofwel het te downloaden ofwel het te lezen
in de browser. Als u kiest voor downloaden, vraagt Safari of u het wilt openen met iBooks.

42 https://calibre-ebook.com/nl/download
43 https://bugs.launchpad.net/calibre
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Many reading apps support browsing the calibre library directly via its OPDS support. In such apps you can go to the
online catalog screen and add the IP address of the calibre server to browse and download books from your calibre library
within the app.

9.2.6 How do I use calibre with my Android phone/tablet or Kindle Fire?
There are two ways that you can connect your Android device to calibre. Using a USB cable – or wirelessly, over the air.
The first step to using an Android device is installing an e-book reading application on it. There are many free and paid
e-book reading applications for Android: Some examples (in no particular order): FBReader44, Moon+45, Mantano46,
Aldiko47, Kindle48.

Een USB kabel gebruiken
Simply plug your device into the computer with a USB cable. calibre should automatically detect the device and then you
can transfer books to it by clicking the Send to device button. Note that on macOS and Linux only a single program can
connect to an Android device at a time, so make sure the device is not opened in the OS File manager, or the Android
File Transfer utility, etc.

Notitie

With newer Android devices, you might have to jump through a few hoops to get the connection working, as Google
really does not want you to be independent of its cloud. First, unlock the screen before plugging in the USB cable.
When you plugin in the USB cable you will get a popup notification. Make sure it says some thing like “Transferring
Media files” or “MTP (Media Transfer mode)”. If it does not, tap the notification, and change the mode to Media
Transfer (MTP). You may need to restart calibre at this point in order for your device to be recognized. Finally, you
might get a popup on the device every time calibre or the operating system actually tries to connect to it, asking for
permission, tap OK.

Notitie

With the Kindle Fire 8 or newer there is an icon that shows up when the USB cable is plugged in, showing that the
device is charging. Tap that and switch the device to data transfer mode, and then start calibre, it should then be
detected.

Door de lucht
calibre has a builtin web server, the calibre Content server (pagina 115). It makes your calibre collection available over
the net. You can browse it on your device using a simple browser or a dedicated application. First perform the following
steps in calibre:

• Set the Preferred Output Format in calibre to EPUB for normal Android devices or MOBI for Kindles (The output
format can be set under Preferences → Interface → Behavior)

• Converteer de boeken die u wilt lezen op uw toestel naar EPUB/MOBI formaat door ze te selecteren en te klikken
op de Converteren knop.

• Zet de Content server aan in calibre’s voorkeuren en laat calibre draaien.
Op je Android toestel, open de browser en surf naar

44 https://play.google.com/store/apps/details?id=org.geometerplus.zlibrary.ui.android&hl=en
45 https://play.google.com/store/apps/details?id=com.flyersoft.moonreader&hl=en
46 https://play.google.com/store/apps/details?id=com.mantano.reader.android.lite&hl=en
47 https://play.google.com/store/apps/details?id=com.aldiko.android&hl=en
48 https://play.google.com/store/apps/details?id=com.amazon.kindle&feature=related_apps
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http://192.168.1.2:8080/
Vervang 192.168.1.2 door het lokale IP adres van de computer die calibre draait. Bekĳk De calibre Content server
(pagina 115) voor details over het draaien van de server en het correcte IP adres vinden om te gebruiken
U kan nu uw boekencollectie doorbladeren en boeken downloaden van calibre naar uw toestel om te openen met eender
welke e-boek leessoftware dat u hebt op uw Android toestel.
Many reading apps support browsing the calibre library directly via its OPDS support. In such apps you can go to the
online catalog screen and add the IP address of the calibre server to browse and download books from your calibre library
within the app.

9.2.7 Heb ik toegang tot mijn calibre boeken via de browser opmijn Kindle of ander
leestoestel?

calibre heeft een Content server die de boeken in calibre exporteert als webpagina. Bekĳk De calibre Content server
(pagina 115) voor details.
Some devices, like the Kindle (1/2/DX), do not allow you to access port 8080 (the default port on which the content server
runs). In that case, change the port in the calibre Preferences to 80. (On some operating systems, you may not be able to
run the server on a port number less than 1024 because of security settings. In this case the simplest solution is to adjust
your router to forward requests on port 80 to port 8080).
Also some devices do not have browsers advanced enough to run the app-like interface used by the Content server. For
such devices, you can simply add /mobile to the server URL to get a simplified, non-JavaScript interface.

9.2.8 Ik kan geen e-mails verzenden vanuit Calibre?
Because of the large amount of spam in email, sending email can be tricky, as different mail servers use different strategies
to block email. The most common problem is if you are sending email directly (without a mail relay) in calibre. Many
servers (for example, Amazon) block email that does not come from a well known relay. The most robust way to setup
email sending in calibre is to do the following:

• Creëer een gratis GMX account op GMX49.
• Go to Preferences → Sharing → Sharing books by email in calibre and click the Use GMX button and fill in the

information asked for.
• Log into your GMX account on the website and enable SMTP sending (Settings->POP3 & IMAP->Send and receive

emails via external program)
• calibre will then be able to use GMX to send the mail.
• If you are sending to your Kindle, remember to update the email preferences on your Amazon Kindle page to allow

email sent from your GMX email address. Also note that Amazon does not allow email delivery of AZW3 and new
style (KF8) MOBI files. Finally, Amazon recently started sending confirmation emails that you have to click on
back to your GMX account before the book is actually delivered.

Even after doing this, you may have problems. One common source of problems is that some poorly designed antivirus
programs block calibre from opening a connection to send email. Try adding an exclusion for calibre in your antivirus
program.

Notitie

Microsoft/GMX can disable your account if you use it to send large amounts of email. So, when using these services to
send mail calibre automatically restricts itself to sending one book every five minutes. If you don’t mind risking your
account being blocked you can reduce this wait interval by going to Preferences → Advanced → Tweaks in calibre.

49 https://www.gmx.com
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Notitie

Google recently deliberately broke their email sending protocol (SMTP) support in an attempt to force everyone to use
their web interface so they can show you more ads. They are trying to claim that SMTP is insecure, that is incorrect
and simply an excuse. Use some other email provider instead.

Notitie

If you are concerned about giving calibre access to your email account, simply create a new free email account with
GMX or Outlook and use it only for calibre.

9.2.9 My device is getting mounted read-only in Linux, so calibre cannot connect
to it?

Linux kernels mount devices read-only when their filesystems have errors. You can repair the filesystem with:

sudo fsck.vfat -y /dev/sdc

Replace /dev/sdc with the path to the device node of your device. You can find the device node of your device, which
will always be under /dev by examining the output of:

mount

9.2.10 Why does calibre not support collections on the Kindle or shelves on the
Nook?

Neither the Kindle nor the Nook provide any way to manipulate collections over a USB connection. If you really care
about using collections, I would urge you to sell your Kindle/Nook and get a Kobo. Only Kobo seems to understand that
life is too short to be entering collections one by one on an e-ink screen 2/7
Note that in the case of the Kindle, there is a way to manipulate collections via USB, but it requires that the Kindle be
rebooted every time it is disconnected from the computer, for the changes to the collections to be recognized. As such,
it is unlikely that any calibre developers will ever feel motivated enough to support it. There is however, a calibre plugin
that allows you to create collections on your Kindle from the calibre metadata. It is available from here50.

Notitie

Amazon have removed the ability to manipulate collections completely in their newer models, like the Kindle Touch
and Kindle Fire, making even the above plugin useless, unless you root your Kindle and install custom firmware.

9.2.11 Ik krijg steeds een foutmelding wanneer ik Calibre gebruik met de Kobo
Touch/Glo/etc.?

The Kobo has very buggy firmware. Connecting to it has been known to fail at random. Certain combinations of mother-
board, USB ports/cables/hubs can exacerbate this tendency to fail. If you are getting an error when connecting to your
touch with calibre try the following, each of which has solved the problem for some calibre users.

• Koppel de Kobo direct aan je computer, niet via een USB hub.
• Probeer een andere USB kabel en een andere USB poort op je computer.

50 https://www.mobileread.com/forums/showthread.php?t=244202
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• Meld je af op de Kobo en meld je opnieuw aan, dit zorgt ervoor dat de gegevensbank opnieuw opgebouwd wordt
en de gegevensbank corruptie fouten verholpen.

• Probeer de laatste firmware te upgraden op je Kobo Touch.
• Probeer je Kobo te resetten (soms lost dit het probleem op voor een tĳdje, maar dan duikt dit probleem weer op

en moet je weer opnieuw resetten)
• Probeer één of twee boeken te zetten op de Kobo per keer en hou je collectie klein op de Kobo.

9.2.12 Covers for books I send to my e-ink Kindle show up momentarily and then
are replaced by a generic cover?

This happens because of an Amazon bug. They try to download a cover for the book from their servers and when that
fails, they replace the existing cover that calibre created with a generic cover. For details see this forum thread51. As of
version 4.17, calibre has a workaround, where if you connect the Kindle to calibre after the covers have been destroyed
by Amazon, calibre will restore them automatically. So in order to see the covers on your Kindle, you have to:

1) Send the book to the Kindle with calibre
2) Disconnect the Kindle and wait for Amazon to destroy the cover
3) Reconnect the Kindle to calibre

Note that this workaround only works for books sent with calibre 4.17 or later. Alternately, simply keep your Kindle in
airplane mode, you don’t really want Amazon knowing every book you read anyway. I encourage you to contact Amazon
customer support and complain loudly about this bug. Maybe Amazon will listen.

Notitie

If the workaround is not working for you make sure you Kindle firmware is at least version 5.12.5, released in April
2020.

9.2.13 Covers for books sent to my Kindle ColorSoft and newer do not show up in
the book list?

Amazon deliberately broke this functionality in their ColorSoft and newer devices in order to discourage you from reading
non Amazon books on their devices. See this forum thread52 for details. The only known workaround is to send the
books as “Personal documents” to the Kindle which will fix the covers not showing up but break other features such as
Whispersync and the books will show up under “Personal documents” not “Books” on the device. To enable this in calibre
go to Preferences → Output options → MOBI output and enable the check box that says Enable sharing of book content.
This will cause all future books sent to the Kindle by calibre to be marked as personal documents.

9.2.14 De omslagen voormijnMOBI bestandenworden nietmeer getoond inKindle
voor PC/Kindle voor Android/iPad enz.

Dit wordt veroorzaakt door een bug in de Amazon software. U kan hier rond werken door naar Voorkeu-
ren → Conversie → Uitvoer Opties → MOBI uitvoer te gaan en de optie Delen van boekinhoud inschakelen in te stellen.
Als u een vroeger geconverteerd boek weer converteert, moet u deze optie ook inschakelen in de conversie dialoog voor
dat individueel boek (omdat per boek conversie instellingen worden opgeslagen en voorrang hebben).
Note that doing this will mean that the generated MOBI will show up under personal documents instead of Books on
the Kindle Fire and Amazon whispersync will not work, but the covers will. It’s your choice which functionality is more
important to you. I encourage you to contact Amazon and ask them to fix this bug.

51 https://www.mobileread.com/forums/showthread.php?t=329945
52 https://www.mobileread.com/forums/showthread.php?t=364350
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The bug in Amazon’s software is that when you put a MOBI file on a Kindle, unless the file is marked as a Personal
document, Amazon assumes you bought the book from it and tries to download the cover thumbnail for it from its servers.
When the download fails, it refuses to fallback to the cover defined in the MOBI file. This is likely deliberate on Amazon’s
part to try to force authors to sell only through them. In other words, the Kindle only displays covers for books marked as
Personal Documents or books bought directly from Amazon.
If you send a MOBI file to an e-ink Kindle with calibre using a USB connection, calibre works around this Amazon bug by
uploading a cover thumbnail itself. However, that workaround is only possible when using a USB connection and sending
with calibre. Note that if you send using email, Amazon will automatically mark the MOBI file as a Personal Document
and the cover will work, but the book will show up in Personal Documents.

9.2.15 Ik heb boeken overgezet op mijn Kindle, gebruik makend van Calibre. Waar-
om worden deze niet getoond?

Books sent to the Kindle only show up on the Kindle after they have been indexed by the Kindle. This can take some
time. If the book still does not show up after some time, then it is likely that the Kindle indexer crashed. Sometimes a
particular book can cause the indexer to crash. Unfortunately, Amazon has not provided any way to deduce which book
is causing a crash on the Kindle. Your only recourse is to either reset the Kindle, or delete all files from its memory using
Windows Explorer (or whatever file manager you use) and then send the books to it again, one by one, until you discover
the problem book. Once you have found the problem book, delete it off the Kindle and do a MOBI to MOBI or MOBI
to AZW3 conversion in calibre and then send it back. This will most likely take care of the problem.

9.3 Library management

Inhoud

• Waar worden mĳn boekbestanden opgeslagen? (pagina 141)
• Hoe gaat Calibre om met auteursnamen en sorteren? (pagina 142)
• Why doesn’t calibre let me store books in my own folder structure? (pagina 143)
• Waarom heeft Calibre geen kolom voor foo? (pagina 144)
• Kan ik ook een kolom krĳgen die formaten of ISBN toont? (pagina 144)
• Hoe kan ik de Calibre gegevens van de ene computer naar de andere overzetten? (pagina 144)
• De boekenlĳst in Calibre is leeg! (pagina 145)
• Waarom krĳg ik foutmeldingen met met Calibre bibliotheek op een netwerk map/NAS? (pagina 145)

9.3.1 Waar worden mijn boekbestanden opgeslagen?
When you first run calibre, it will ask you for a folder in which to store your books. Whenever you add a book to calibre,
it will copy the book into that folder. Books in the folder are nicely arranged into sub-folders by Author and Title. Note
that the contents of this folder are automatically managed by calibre, do not add any files/folders manually to this folder,
as they may be automatically deleted. If you want to add a file associated to a particular book, use the top right area of
Edit metadata dialog to do so. Then, calibre will automatically put that file into the correct folder and move it around
when the title/author changes.
Metadata about the books is stored in the file metadata.db at the top level of the library folder. This file is a sqlite
database. When backing up your library make sure you copy the entire folder and all its sub-folders.
The library folder and all its contents make up what is called a calibre library. You can have multiple such libraries. To
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manage the libraries, click the calibre icon on the toolbar. You can create new libraries, remove/rename existing ones and
switch between libraries easily.
You can copy or move books between different libraries (once you have more than one library setup) by right clicking on
a book and selecting the Copy to library action.

9.3.2 Hoe gaat Calibre om met auteursnamen en sorteren?
Author names are complex, especially across cultures, see this note53 for some of the complexities. calibre has a very
flexible strategy for managing author names. The first thing to understand is that books and authors are separate entities
in calibre. A book can have more than one author, and an author can have more than one book. You can manage the
authors of a book by the edit metadata dialog. You can manage individual authors by right clicking on the author in the
Tag browser on the left of the main calibre window and selecting Manage authors. Using this dialog you can change the
name of an author and also how that name is sorted. This will automatically change the name of the author in all the books
of that author. When a book has multiple authors, separate their names using the & character.
Now coming to author name sorting:

• When a new author is added to calibre (this happens whenever a book by a new author is added), calibre automa-
tically computes a sort string for both the book and the author.

• Authors in the Tag browser are sorted by the sort value for the authors. Remember that this is different from the
Author sort field for a book.

• By default, this sort algorithm assumes that the author name is in First name Last name format and generates
a Last name, First name sort value.

• You can change this algorithm by going to Preferences → Advanced → Tweaks and setting the au-
thor_sort_copy_method tweak.

• You can force calibre to recalculate the author sort values for every author by right clicking on any author and
selecting Manage authors, then pushing the Recalculate all author sort values button. Do this after you have set the
author_sort_copy_method tweak to what you want.

• You can force calibre to recalculate the author sort values for all books by using the bulk metadata edit dialog (select
all books and click edit metadata, check the Automatically set author sort checkbox, then press OK).

• When recalculating the author sort values for books, calibre uses the author sort values for each individual author.
Therefore, ensure that the individual author sort values are correct before recalculating the books’ author sort values.

• You can control whether the Tag browser display authors using their names or their sort values by setting the
categories_use_field_for_author_name tweak in Preferences → Advanced → Tweaks

Note that you can set an individual author’s sort value to whatever you want using Manage authors. This is useful when
dealing with names that calibre will not get right, such as complex multi-part names like Miguel de Cervantes Saavedra
or when dealing with Asian names like Sun Tzu.
With all this flexibility, it is possible to have calibre manage your author names however you like. For example, one
common request is to have calibre display author names LN, FN. To do this, and if the note below does not apply to you,
then:

• Set the author_sort_copy_method tweak to copy as described above.
• Herstart calibre. Verander geen metadata vooraleer de volgende stappen te ondernemen.
• Change all author names to LN, FN using the Manage authors dialog.
• After you have changed all the authors, press the Recalculate all author sort values button.
• Press OK, at which point calibre will change the authors in all your books. This can take a while.

53 https://www.w3.org/International/questions/qa-personal-names.en.php?changelang=en
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Notitie

When changing from FN LN to LN, FN, it is often the case that the values in author_sort are already in LN,
FN format. If this is your case, then do the following:

• Set the author_sort_copy_method tweak to copy as described above.
• Herstart calibre. Verander geen metadata vooraleer de volgende stappen te ondernemen.
• Open the Manage authors dialog. Press the copy all author sort values to author button.
• Check through the authors to be sure you are happy. You can still press Cancel to abandon the changes.

Once you press OK, there is no undo.
• Press OK, at which point calibre will change the authors in all your books. This can take a while.

9.3.3 Why doesn’t calibre let me store books in my own folder structure?
The whole point of calibre’s library management features is that they provide a search and sort based interface for locating
books that is much more efficient than any possible folder scheme you could come up with for your collection. Indeed, once
you become comfortable using calibre’s interface to find, sort and browse your collection, you won’t ever feel the need to
hunt through the files on your disk to find a book again. By managing books in its own folder structure of Author -> Title
-> Book files, calibre is able to achieve a high level of reliability and standardization. To illustrate why a search/tagging
based interface is superior to folders, consider the following. Suppose your book collection is nicely sorted into folders
with the following scheme:

Genre -> Author -> Series -> ReadStatus

Now this makes it very easy to find for example all science fiction books by Isaac Asimov in the Foundation series. But
suppose you want to find all unread science fiction books. There’s no easy way to do this with this folder scheme, you
would instead need a folder scheme that looks like:

ReadStatus -> Genre -> Author -> Series

In calibre, you would instead use tags to mark genre and read status and then just use a simple search query like
tag:scifi and not tag:read. calibre even has a nice graphical interface, so you don’t need to learn its search
language instead you can just click on tags to include or exclude them from the search.
To those of you that claim that you need access to the filesystem, so that you can have access to your books over the
network, calibre has an excellent Content server that gives you access to your calibre library over the net.
If you are worried that someday calibre will cease to be developed, leaving all your books marooned in its folder structure,
explore the powerful Save to disk feature in calibre that lets you export all your files into a folder structure of arbitrary
complexity based on their metadata.
Finally, the reason there are numbers at the end of every title folder, is for robustness. That number is the id number of
the book record in the calibre database. The presence of the number allows you to have multiple records with the same
title and author names. It is also part of what allows calibre to magically regenerate the database with all metadata if the
database file gets corrupted. Given that calibre’s mission is to get you to stop storing metadata in filenames and stop using
the filesystem to find things, the increased robustness afforded by the id numbers is well worth the uglier folder names.
Als je nog steeds niet overtuigd bent, vrees ik ervoor dat Calibre niets is voor je. Om duidelĳk te zĳn, dit zal niet
veranderen. Gelieve ons niet te contacteren, in een poging om onze gedachten te veranderen.
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9.3.4 Waarom heeft Calibre geen kolom voor foo?
calibre is designed to have columns for the most frequently and widely used fields. In addition, you can add any columns
you like. Columns can be added via Preferences → Interface → Add your own columns. Watch the tutorial UI Power tips54

to learn how to create your own columns, or read this blog post55.
You can also create “virtual columns” that contain combinations of the metadata from other columns. In the add column
dialog use the Quick create links to easily create columns to show the book ISBN or formats. You can use the powerful
calibre template language to do much more with columns. For more details, see De calibre sjabloontaal (pagina 162).

9.3.5 Kan ik ook een kolom krijgen die formaten of ISBN toont?
Ja, het is mogelĳk. Volg bovenstaande instructies om een maat gemaakte kolom toe te voegen.

9.3.6 Hoe kan ik de Calibre gegevens van de ene computer naar de andere over-
zetten?

You can export all calibre data (books, settings and plugins) and then import it on another computer. First let’s see how
to export the data:

• Right click the calibre icon in the main calibre toolbar and select Export/import all calibre data. Note that if there is
currently a device connected, this menu option will not be available – so, disconnect any connected devices. Then
click the button labelled Export all your calibre data. You will see a list of all your calibre libraries. Click OK and
choose an empty folder somewhere on your computer. The exported data will be saved in this folder. Simply copy
this folder to your new computer and follow the instructions below to import the data.

• Install calibre on your new computer and run through the Welcome wizard, it does not matter what you do there, as
you will be importing your old settings in the next step. You will now have an empty calibre, with just the Getting
Started guide in your library. Once again, right click the calibre button and choose Export/import all calibre data.
Then click the button labelled Import previously exported data. Select the folder with the exported data that you
copied over earlier. You will now have a list of libraries you can import. Go through the list one by one, and select
the new location for each library (a location is just an empty folder somewhere on your computer). Click OK. After
the import completes, calibre will restart, with all your old libraries, settings and calibre plugins.

Notitie

De import/export functionaliteit is enkel beschikbaar vanaf Calibre versie 2.47. Als je een oudere versie hebt van
Calibre, of als problemen tegenkomt met import/export, kun je de Calibre bibliotheek map manueel overschrĳven,
zoals beschreven in volgend paragraaf.
Simply copy the calibre library folder from the old to the new computer. You can find out what the library folder is
by clicking the calibre icon in the toolbar. Choose the Switch/create calibre library action and you will see the path to
the current calibre library.
Now on the new computer, start calibre for the first time. It will run the Welcome wizard asking you for the location of
the calibre library. Point it to the previously copied folder. If the computer you are transferring to already has a calibre
installation, then the Welcome wizard won’t run. In that case, right-click the calibre icon in the toolbar and point it to
the newly copied folder. You will now have two calibre libraries on your computer and you can switch between them
by clicking the calibre icon on the toolbar. Transferring your library in this manner preserves all your metadata, tags,
custom columns, etc.

54 https://calibre-ebook.com/nl/demo#tutorials
55 https://blog.calibre-ebook.com/calibre-custom-columns/
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9.3.7 De boekenlijst in Calibre is leeg!
In order to understand why that happened, you have to understand what a calibre library is. At the most basic level, a
calibre library is just a folder. Whenever you add a book to calibre, that book’s files are copied into this folder (arranged
into sub folders by author and title). Inside the calibre library folder, at the top level, you will see a file called metadata.db.
This file is where calibre stores the metadata like title/author/rating/tags etc. for every book in your calibre library. The
list of books that calibre displays is created by reading the contents of this metadata.db file.
Er kunnen twee redenen zĳn waarom Calibre een lege lĳst toont van boeken:

• Your calibre library folder changed its location. This can happen if it was on an external disk and the drive letter
for that disk changed. Or if you accidentally moved the folder. In this case, calibre cannot find its library and so
starts up with an empty library instead. To remedy this, do a right-click on the calibre icon in the calibre toolbar
and select Switch/create library. Click the little blue icon to select the new location of your calibre library and click
OK. If you don’t know the new location search your computer for the file metadata.db.

• Je metadata.db bestand was verwĳderd/corrupt. In dit geval, kan calibre de metadata.db herstellen van de backups.
Rechtermuisklik op het calibre icoon in de calibre toolbar en kies voor Bibliotheek onderhoud -> herstel database.
calibre zal automatisch de metadata.db herstellen.

9.3.8 Waarom krijg ik foutmeldingen met met Calibre bibliotheek op een netwerk
map/NAS?

Zet niet je Calibre bibliotheek op een netwerk map.
A filesystem is a complex beast. Most network filesystems lack various filesystem features that calibre uses. Some don’t
support file locking, some don’t support hardlinking, some are just flaky. Additionally, calibre is a single user application,
if you accidentally run two copies of calibre on the same networked library, bad things will happen. Finally, different OSes
impose different limitations on filesystems, so if you share your networked drive across OSes, once again, bad things will
happen.
Consider using the calibre Content server to make your books available on other computers. Run calibre on a single
computer and access it via the Content server or a Remote Desktop solution.
If you must share the actual library, use a file syncing tool like DropBox or rsync instead of a networked drive. If you are
using a file-syncing tool it is essential that you make sure that both calibre and the file syncing tool do not try to access
the calibre library at the same time. In other words, do not run the file syncing tool and calibre at the same time.
Even with these tools there is danger of data corruption/loss, so only do this if you are willing to live with that risk. In
particular, be aware that Google Drive is incompatible with calibre, if you put your calibre library in Google Drive, you
will suffer data loss. See this thread56 for details.

9.4 Diversen

Inhoud

• Amazon is stopping email delivery of MOBI files? (pagina 146)
• Ik wil dat Calibre nieuws download van mĳn favoriete nieuws website. (pagina 147)
• Vanwaar de naam Calibre? (pagina 147)
• Why does calibre show only some of my fonts on macOS? (pagina 147)
• Calibre start niet in Windows? (pagina 147)

56 https://www.mobileread.com/forums/showthread.php?t=205581
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• Crashed of reageert niet Calibre regelmatig? (pagina 148)
• The calibre E-book viewer and Edit book tools do not work on Windows? (pagina 148)
• Using the viewer or doing any conversions results in a permission denied error on Windows (pagina 149)
• calibre is not starting/crashing on macOS? (pagina 149)
• I get only a black or white screen when running the calibre E-book viewer? (pagina 149)
• I heb het installatie bestand gedownload, waarom werkt het niet? (pagina 149)
• Mĳn antivirus programma beweert dat Calibre een virus/trojaan paars is? (pagina 150)
• Hoe maak ik een backup van Calibre? (pagina 150)
• Hoe kan ik gekochte EPUB boeken gebruiken met Calibre? (of wat ik doen met .ascm bestanden)? (pagina 150)
• Ik krĳg een “Toegang geweigerd” fout? (pagina 151)
• Hoe kan ik de metadata van de metagegevens lezen op mĳn lezer? (pagina 151)
• Hoe kan ik Calibre instellen om mĳn HTTP proxy te gebruiken? (pagina 151)
• Ik wil nieuwe functionaliteit toevoegen aan Calibre. Wat kan ik doen? (pagina 151)
• Waarom heeft Calibre geen automatische updates? (pagina 152)
• Hoe zit het met de licentie van Calibre? (pagina 152)
• Hoe start ik Calibre van mĳn USB stick? (pagina 152)
• How do I run parts of calibre like news download and the Content server on my own Linux server? (pagina 152)

9.4.1 Amazon is stopping email delivery of MOBI files?
Amazon have announced57 that they will stop accepting MOBI files emailed to @kindle.com email addresses. You can
instruct calibre to send EPUB instead of MOBI by going to Preferences → Sharing books by email and then removing
MOBI from the list of formats to send to your @kindle.com email address and adding EPUB instead.
Note however, that Amazon’s EPUB intake is very flawed, they will reject a number of EPUB files that work everywhere
else. In such cases you can try the following trick:

1. Convert the EPUB file to MOBI
2. Then convert the MOBI file back to EPUB and send the resulting EPUB file

This will remove all advanced formatting, embedded fonts, etc., but greatly increase the chances of Amazon accepting
the EPUB.

Notitie

If you were previously using email delivery of periodicals downloaded by calibre, you will be better off sending those
by USB cable or downloading them from the calibre Content server via the Kindle’s built-in browser. However, if
you want to continue using email delivery you can try changing the output format in Preferences->Behavior to EPUB,
then calibre will download the news in EPUB format. Whether Amazon will accept the EPUB or not is a whole other
question.

57 https://blog.the-ebook-reader.com/2022/05/03/amazon-dropping-mobi-support-on-send-to-kindle-apps/
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9.4.2 Ik wil dat Calibre nieuws download van mijn favoriete nieuws website.
If you are reasonably proficient with computers, you can teach calibre to download news from any website of your
choosing. To learn how to do this see Uw favoriete nieuws website toevoegen (pagina 33).
Otherwise, you can request a particular news site by posting in the calibre Recipes forum58.

9.4.3 Vanwaar de naam Calibre?
Maak een keuze:

• Converter And LIBRary for E-books
• A high calibre product
• A tribute to the SONY Librie which was the first e-ink based e-book reader
• Mĳn vrouw heeft hiervoor gekozen ;-)

Calibre is niet uitgesproken als cal-i-ber niet ca-li-bre. Als je het afvraagt, Calibre is de Britse/gemenebest spelling voor
Calibre. Als een Indiaan, dat is de natuurlĳke spelling voor mĳ.

9.4.4 Why does calibre show only some of my fonts on macOS?
calibre embeds fonts in e-book files it creates. E-book files support embedding only TrueType and OpenType (.ttf and
.otf) fonts. Most fonts on macOS systems are in .dfont format, thus they cannot be embedded. calibre shows only TrueType
and OpenType fonts found on your system. You can obtain many such fonts on the web. Simply download the .ttf/.otf
files and add them to the Library/Fonts folder in your home folder.

9.4.5 Calibre start niet in Windows?
Er kunnen meerdere redenen hiervoor zĳn:

• If you get no errors but the calibre window does not appear, it has probably just appeared off screen. You can gather
all windows onto the current screen using one of the techniques described here59.

• Some software has been known to interfere with calibre, try rebooting in Safe mode and see if it works. A known
culprit is the Sunshine60 screen sharing software.

• Als je een foutmelding krĳgt dat Calibre een bestand niet kan openen omdat het in gebruik is door een ander
programma, probeer het volgende:

– deïnstalleer Calibre
– Herstart uw computer
– Herinstalleer Calibre. Maar start Calibre niet vanaf de installatie wizard.
– Probeer je anti virus programma tĳdelĳk uit te schakelen. (om veilig te zĳn, zorg je ervoor dat je niet ver-

bonden bent met het internet)
– Kĳk in de map waar je calibre bibliotheek staat. Verwĳder metadata.db.
– Start Calibre
– Vanaf nu zou Calibre normaal moeten opstarten.

• If you get an error about a Python function terminating unexpectedly after upgrading calibre, first uninstall calibre,
then delete the folders (if they exists) C:\Program Files\Calibre and C:\Program Files\Calibre2.
Now re-install and you should be fine.

58 https://www.mobileread.com/forums/forumdisplay.php?f=228
59 https://www.wikihow.com/Bring-an-Off-Screen-Window-Back-on-Windows
60 https://github.com/LizardByte/Sunshine

9.4. Diversen 147

https://www.mobileread.com/forums/forumdisplay.php?f=228
https://www.wikihow.com/Bring-an-Off-Screen-Window-Back-on-Windows
https://github.com/LizardByte/Sunshine


calibre Gebruikershandleiding, Release 8.7.0

• If you get an error in the Welcome wizard on an initial run of calibre, try choosing a folder like C:\library as the
calibre library (calibre sometimes has trouble with library locations if the path contains non-English characters, or
only numbers, etc.)

• Try running it as administrator (Right click on the icon and select Run as administrator)
If it still won’t launch, start a command prompt (press the Windows key and R; then type cmd.exe in the Run dialog that
appears). At the command prompt type the following command and press Enter:

calibre-debug -g

Post any output you see in a help message on the Forum61.

9.4.6 Crashed of reageert niet Calibre regelmatig?
Er zĳn verschillende mogelĳkheden dat ik weet van heb, dat dit kan veroorzaken:

• Je hebt recentelĳk een externe monitor of TV aan je computer gekoppeld. Als dit het geval is, wanneer calibre
een nieuw venster opent, zoals “metadata bewerken” & “boeken omzetten”, wordt het niet getoont op het andere
scherm, daarom denk je dat er niets gebeurd. Ontkoppel je tweede monitor en herstart calibre.

• The following programs have been reported to cause crashes in calibre: If you are running any of these, close
them before starting calibre, or uninstall them: RoboForm, Logitech SetPoint Settings, Constant Guard Protection by
Xfinity, Spybot, Killer Network Manager, Nahimic UI Interface, Acronis True Image.

• Je gebruikt een Wacom USB muis/tablet. Er is een incomptabiliteit tussen de Wacom stuurprogramma’s en de
grafische omgeving die Calibre gebruikt. Probeer een muis die niet van Wacom is.

• Op sommige 64 bit versies van Windows zĳn er veiligheid software/instellingen die voorkomen dat de 64 bit versie
van calibre normaal opstart. Als je de 64 bit versie van calibre gebruikt, probeer dan de 32 bit versie.

• If the crash happens when you are trying to copy text from the calibre E-book viewer, it is most likely caused by
some clipboard monitoring/managing application you have running. Turn it off and you should be fine.

• If the crashes happen specifically when you are using a file dialog, like clicking on the Add books button or the
Save to Disk button, then you have some software that has installed broken Shell extensions on your computer.
Known culprits include: SpiderOak, odrive sync and Dell Backup and Recovery and NetDrive. If you have one of
these, uninstall them and you will be fine. You can also use the NirSoft Shell Extension Viewer62 to see what shell
extensions are installed on your system and disable them individually, if you don’t want to uninstall the full program.
Remember to use “Restart Explorer” or reboot your computer after disabling the shell extensions.

If none of the above apply to you, then there is some other program on your computer that is interfering with calibre.
First reboot your computer in safe mode, to have as few running programs as possible, and see if the crashes still happen.
If they do not, then you know it is some program causing the problem. The most likely such culprit is a program that
modifies other programs’ behavior, such as an antivirus, a device driver, something like RoboForm (an automatic form
filling app) or an assistive technology like Voice Control or a Screen Reader.
Om uit te zoeken welk programma dat de schuldige is, elimineer één per één om te kĳken dewelke de oorzaak is. Om
een programma te stoppen: start Calibre op, controleer of er geen crash is. Als er nog steeds een crash is, probeer dan
een ander programma te stoppen en probeer opnieuw.

9.4.7 The calibre E-book viewer and Edit book tools do not work on Windows?
These two programs use hardware acceleration as they embed a version of the Chrome browser to render HTML. If they
do not work it will be because of incompatibility with your system’s GPU (graphics) drivers. Try updating these first,

61 https://www.mobileread.com/forums/forumdisplay.php?f=166
62 https://www.nirsoft.net/utils/shexview.html
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and reboot. If that does not fix it, you can set the QTWEBENGINE_CHROMIUM_FLAGS environment variable to the value
--disable-gpu to turn off hardware acceleration. See this page63 for details.

9.4.8 Using the viewer or doing any conversions results in a permission denied
error on Windows

Something on your computer is preventing calibre from accessing its own temporary files. Most likely the permissions on
your Temp folder are incorrect. Go to the folder file:C:\Users\USERNAME\AppData\Local in Windows Explorer and
then right click on the file:Temp folder, select Properties and go to the Security tab. Make sure that your user account has
full control for this folder.
Some users have reported that running the following command in an Administrator Command Prompt fixed their permis-
sions. To get an Administrator Command Prompt search for cmd.exe in the start menu, then right click on the command
prompt entry and select Run as administrator. At the command prompt type the following command and press Enter:

icacls "%appdata%\..\Local\Temp" /reset /T

Als alternatief, kun je Calibre uitvoeren als Administrator, maar sommige fuctionaliteit kan mogelĳk niet werken zoals
copiëren en plakken.
Eindelĳk, sommige gebruikers hebben gemeld dat het uitschakelen van UAC het probleem verhelpt.

9.4.9 calibre is not starting/crashing on macOS?
One common cause of failures on macOS is the use of accessibility technologies that are incompatible with the graphics
toolkit calibre uses. Try turning off VoiceOver if you have it on. Also go to System Preferences->System->Universal
Access and turn off the setting for enabling access for assistive devices in all the tabs. Another cause can be some third
party apps that modify system behavior, such as Smart Scroll and Default Folder X.
Je kan de debug output achterhalen waarom Calibre niet kan starten door het Console.app te laten lopen. De debug output
zal daar staan. Als de debug output een regel bevat als:

Qt: internal: -108: Error ATSUMeasureTextImage text/qfontengine_mac.mm

then the problem is probably a corrupted font cache. You can clear the cache by following these instructions64. If that
doesn’t solve it, look for a corrupted font file on your system, in ~/Library/Fonts or the like. An easy way to check for
corrupted fonts in macOS is to start the “Font Book” application, select all fonts and then in the File menu, choose
“Validate fonts”.

9.4.10 I get only a black or white screen when running the calibre E-book viewer?
This will be because of an incompatibility between Qt WebEngine, which the viewer uses to render and the GPU drivers
on your system. First try upgrading the GPU drivers. If that does not help, you can try turning off hardware acceleration
in Qt WebEngine by setting the environment variable QTWEBENGINE_CHROMIUM_FLAGS to the value --disable-gpu.
See Omgevingsvariabelen (pagina 289) for how to change environment variables.

9.4.11 I heb het installatie bestand gedownload, waarom werkt het niet?
Downloading from the Internet can sometimes result in a corrupted download. If the calibre installer you downloaded is
not opening, try downloading it again. If re-downloading it does not work, download it from an alternate location65. If the
installer still doesn’t work, then something on your computer is preventing it from running.

• Probeer tĳdelĳk je anti virus programma uit te schakelen. (Microsoft Security Essentials, of Kaspersky of Norton
of McAfee of wat dan ook). Dit is wellicht de reden waarom het update proces blĳft hangen.

63 https://doc.qt.io/qt-6/qtwebengine-debugging.html
64 https://typefaceapp.com/help/troubleshooting/macos-font-cache
65 https://github.com/kovidgoyal/calibre/releases/latest

9.4. Diversen 149

https://doc.qt.io/qt-6/qtwebengine-debugging.html
https://typefaceapp.com/help/troubleshooting/macos-font-cache
https://github.com/kovidgoyal/calibre/releases/latest


calibre Gebruikershandleiding, Release 8.7.0

• Similarly, if the installer is failing/rolling back and you have Microsoft PowerToys running, quit it.
• If you have installed to a non-standard location, try running the installer as Administrator
• Try rebooting your computer and running a registry cleaner like Wise registry cleaner66.
• Probeer een schone installatie. Dat betekent, verwĳder het bestand: file:C:\Program Files\Calibre2 (of waar je de

vorige keer Calibre hebt geïnstalleerd). Daarna, voer de installatie opnieuw uit. Opnieuw installeren verwĳderd niet
je boeken of instellingen.

• Try downloading the installer with an alternate browser. For example if you are using Microsoft Edge, try using
Firefox or Chrome instead.

• If you get an error about a missing DLL on Windows, then most likely, the permissions on your temporary folder
are incorrect. Go to the folder C:\Users\USERNAME\AppData\Local in Windows Explorer and then right click
on the Temp folder and select Properties and go to the Security tab. Make sure that your user account has full control
for this folder.

If you still cannot get the installer to work and you are on Windows, you can use the calibre portable install67, which does
not need an installer (it is just a ZIP file).

9.4.12 Mijn antivirus programma beweert dat Calibre een virus/trojaan paars is?
The first thing to check is that you are downloading calibre from the official website68. Make sure you are clicking the
download links on the left, not the advertisements on the right. calibre is a very popular program and unscrupulous people
try to setup websites offering it for download to fool the unwary.
If you have the official download and your antivirus program is still claiming calibre is a virus, then, your antivirus
program is wrong. Antivirus programs use heuristics, patterns of code that “look suspicious” to detect viruses. It’s rather
like racial profiling. calibre is a completely open source product. You can actually browse the source code yourself (or
hire someone to do it for you) to verify that it is not a virus. Please report the false identification to whatever company you
buy your antivirus software from. If the antivirus program is preventing you from downloading/installing calibre, disable
it temporarily, install calibre and then re-enable it.

9.4.13 Hoe maak ik een backup van Calibre?
The most important thing to backup is the calibre library folder, that contains all your books and metadata. This is the
folder you chose for your calibre library when you ran calibre for the first time. You can get the path to the library folder
by clicking the calibre icon on the main toolbar. You must backup this complete folder with all its files and sub-folders.
You can switch calibre to using a backed up library folder by simply clicking the calibre icon on the toolbar and choosing
your backup library folder. A backed up library folder backs up your custom columns and saved searches as well as all
your books and metadata.
If you want to backup the calibre configuration/plugins, you have to backup the config folder. You can find this config
folder via Preferences → Miscellaneous. Note that restoring configuration folders is not officially supported, but should
work in most cases. Just copy the contents of the backup folder into the current configuration folder to restore.

9.4.14 Hoe kan ik gekochte EPUB boeken gebruiken met Calibre? (of wat ik doen
met .ascm bestanden)?

Most purchased EPUB books have DRM (pagina 375). This prevents calibre from opening them. You can still use calibre
to store and transfer them to your e-book reader. First, you must authorize your reader on a Windows machine with
Adobe Digital Editions. Once this is done, EPUB books transferred with calibre will work fine on your reader. When
you purchase an epub book from a website, you will get an “.acsm” file. This file should be opened with Adobe Digital

66 https://www.wisecleaner.com
67 https://calibre-ebook.com/nl/download_portable
68 https://calibre-ebook.com/nl/download

150 Hoofdstuk 9. Veel gestelde vragen

https://www.wisecleaner.com
https://calibre-ebook.com/nl/download_portable
https://calibre-ebook.com/nl/download


calibre Gebruikershandleiding, Release 8.7.0

Editions, which will then download the actual “.epub” e-book. The e-book file will be stored in the folder “My Digital
Editions”, from where you can add it to calibre.

9.4.15 Ik krijg een “Toegang geweigerd” fout?
A permissie foutmelding kan gebeuren vanwege diverse redenen, geen enkel heeft te maken met Calibre.

• Je kan permissie fouten krĳgen als je een SD kaart gebruikt met schrĳfbeveiliging.
• On macOS if you get permission errors when connecting a device to calibre, you can fix that by looking under

System Preferences > Security and Privacy > Privacy > Files and Folders.
• If you, or some program you used changed the file permissions of the files in question to read only.
• If there is a filesystem error on the device which caused your operating system to mount the filesystem in read only

mode or mark a particular file as read only pending recovery.
• If the files have their owner set to a user other than you.
• Als je bestand open is in een ander programma.
• If the file resides on a device, you may have reached the limit of a maximum of 256 files in the root of the device.

In this case you need to reformat the device/sd card referred to in the error message with a FAT32 filesystem, or
delete some files from the SD card/device memory.

You will need to fix the underlying cause of the permissions error before resuming to use calibre. Read the error message
carefully, see what file it points to and fix the permissions on that file or its containing folders.

9.4.16 Hoe kan ik de metadata van de metagegevens lezen op mijn lezer?
Most readers do not support this. You should complain to the manufacturer about it and hopefully if enough people
complain, things will change. In the meantime, you can insert the metadata, including comments into a “Jacket page” at
the start of the e-book, by using the option to “Insert metadata as page at start of book” during conversion. The option
is found in the Structure detection section of the conversion settings. Note that for this to have effect you have to convert
the book. If your book is already in a format that does not need conversion, you can convert from that format to the same
format.
Another alternative is to create a catalog in e-book form containing a listing of all the books in your calibre library, with
their metadata. Click-and-hold the Convert button to access the catalog creation tool. And before you ask, no you cannot
have the catalog “link directly to” books on your reader.

9.4.17 Hoe kan ik Calibre instellen om mijn HTTP proxy te gebruiken?
By default, calibre uses whatever proxy settings are set in your OS. Sometimes these are incorrect, for example, on
Windows if you don’t use Microsoft Edge then the proxy settings may not be up to date. You can tell calibre to use a
particular proxy server by setting the http_proxy and https_proxy environment variables. The format of the variable
is: http://username:password@servername you should ask your network administrator to give you the correct
value for this variable. Note that calibre only supports HTTP proxies not SOCKS proxies. You can see the current proxies
used by calibre in Preferences->Miscellaneous.

9.4.18 Ik wil nieuwe functionaliteit toevoegen aan Calibre. Wat kan ik doen?
U heeft twee keuzes:

1. Create a patch by hacking on calibre and send it to me for review and inclusion. See Development69.
69 https://calibre-ebook.com/nl/get-involved
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2. Open a bug requesting the feature70. Remember that while you may think your feature request is extremely
important/essential, calibre developers might not agree. Fortunately, calibre is open source, which means you
always have the option of implementing your feature yourself, or hiring someone to do it for you. Furthermore,
calibre has a comprehensive plugin architecture, so you might be able to develop your feature as a plugin, see
Uw eigen plugins schrĳven om de functionaliteit van calibre uit te breiden (pagina 226).

9.4.19 Waarom heeft Calibre geen automatische updates?
Om vele redenen:

• Er is geen noodzaak om iedere week te updaten. Als je tevreden bent hoe Calibre werkt, kun je de automatische
waarschuwing afzetten. Controleer of je wenst up te daten, één keer per jaar of zo. Er is een check box om de
waarschuwing af te zetten, als je klikt op de waarschuwing zelf.

• calibre downloads currently use about 150TB of bandwidth a month71. Implementing automatic updates would
greatly increase that and end up costing thousands of dollars a month, which someone has to pay.

• Als ik een dialoog implementeer dat de updates download en het uitvoert, in plaats van manueel van de website
te downloaden, zou de meest hardnekkige Calibre updater, tenminste vĳf muisklikken per week besparen. Er zĳn
belangrĳker prioriteiten te doen met de ontwikkeling van Calibre.

• Als je echt, maar dan ook echt haat om iedere week een nieuwe versie van Calibre te downloaden, maar steeds de
aller laatste versie wenst te gebruiken, raad ik je aan om de bron code te downloaden, hetgaan dat updates trivaal
maakt. Instructies zĳn hier beschikbaar: available here (pagina 345).

• There are third party automatic updaters for calibre made by calibre users in the calibre forum72.
• Additionally, some third-party updaters such as Norton or Avast may update software behind the user’s back. If

you find calibre has updated unexpectedly, check for the presence of one.

9.4.20 Hoe zit het met de licentie van Calibre?
calibre is licensed under the GNU General Public License v3 (an open source license). This means that you are free to
redistribute calibre as long as you make the source code available. So if you want to put calibre on a CD with your product,
you must also put the calibre source code on the CD. The source code is available for download73. You are free to use
the results of conversions from calibre however you want. You cannot use either code or libraries from calibre in your
software without making your software open source. For details, see The GNU GPL v374.

9.4.21 Hoe start ik Calibre van mijn USB stick?
A portable version of calibre is available here75.

9.4.22 How do I run parts of calibre like news download and the Content server on
my own Linux server?

First, you must install calibre onto your Linux server. If your server is using a modern Linux distribution, you should have
no problems installing calibre onto it.

70 https://calibre-ebook.com/nl/bugs
71 https://calibre-ebook.com/dynamic/downloads
72 https://www.mobileread.com/forums/forumdisplay.php?f=238
73 https://download.calibre-ebook.com
74 https://www.gnu.org/licenses/gpl.html
75 https://calibre-ebook.com/nl/download_portable
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Notitie

calibre needs GLIBC >= 2.31 and libstdc++ >= 6.0.28. If you have an older server, you will either need to compile
these from source, or use calibre 3.48 which requires GLIBC >= 2.17 or 2.85.1 which requires GLIBC >= 2.13 or
calibre 1.48 which requires only GLIBC >= 2.10. In addition, although the calibre command line utilities do not need
a running X server, some of them do require the X server libraries to be installed on your system. This is because
of Qt, which is used for various image processing tasks, and links against these libraries. If you get an ImportEr-
ror about some Qt modules, you are likely missing some X libraries. Typical candidates are: libxcb-cursor0,
libxcb-xinerama0, libegl1, libopengl0.

U kunt de Calibre server draaien met het commando:

/opt/calibre/calibre-server /path/to/the/library/you/want/to/share

You can download news and convert it into an e-book with the command:

/opt/calibre/ebook-convert "Title of news source.recipe" outputfile.epub

If you want to generate MOBI, use outputfile.mobi instead and use --output-profile kindle.
U kunt de gedownload nieuws e-mailen met het commando:

/opt/calibre/calibre-smtp

Ik laat het uitvogelen van de exacte commando’s als een opgave voor de lezer.
Ten slotte kunt u al het gedownloade nieuws aan de Calibre bibliotheek toevoegen met:

/opt/calibre/calibredb add --with-library /path/to/library outfile.epub

Remember to read the Opdrachtpromt (pagina 305) section of the calibre User Manual to learn more about these, and
other commands.
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Lesboeken

Hier vindt u lessen om te starten met het gebruik van de meer geavanceerde functies van calibre, zoals XPath en sjablonen.

10.1 Subgroepen beheren van boeken, bijvoorbeeld “genre”
Sommige mensen willen de boeken in hun bibliotheek indelen in subgroepen vergelĳkbaar met submappen. De meest
genoemde reden is om genre-hiërachieën te maken, maar er zĳn meer. Een gebruiker zocht een manier om tekstboeken
in de delen op onderwerp en cursusnummer. Iemand anders wilde geschenken op onderwerp bĳhouden en ontvanger.
Deze handleiding zal het voorbeeld genre gebruiken in deze uitleg.
Voor u verdergaat, merk op dat we het niet hebben over mappen op de harde schĳf. Subgroepen zĳn geen bestandsmappen.
Boeken worden nergens naartoe gekopieerd. calibres bibliotheek bestandsstructuur wordt niet beïnvloed. In plaats daarvan
presenteren we een manier om subgroepen van boeken te organiseren en tonen binnen een calibre bibliotheek.

• Configuratie (pagina 156)
• Zoeken (pagina 158)
• Restricties (pagina 159)
• Handige sjabloonfuncties (pagina 159)

Subgroepen zoals bĳv. genres moeten voldoen aan alle onderstaande voorwaarden:
• Een subgroep (bĳv. een genre) moet boeken bevatten (verwĳzen naar boeken), niet boekcategorieën. Dit onder-

scheidt subgroepen van calibre gebruiker-categorieën.
• Een boek kan in meerdere subgroepen (genres) voorkomen. Dit onderscheidt subgroepen van fysieke bestands-

mappen.
• Subgroepen (genres) moeten een hiërarchie vormen; subgroepen kunnen subgroepen bevatten.

Labels geven u de eerste twee. Als u een boek met het genre labelt, kunt u met de Labelbrowser (of zoekactie) boeken met
dat genre vinden, dit geeft u de eerste. Veel boeken kunnen dezelfde label(s) hebben, dit geeft u de tweede. Het probleem
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is dat labels niet aan de derde vereiste voldoen. Ze bieden geen hiërarchie.
Isgtree| Calibres hiërarchie functie levert u de derde, het vermogen om de genres te zien in een ‘boomstructuur’ en de
capaciteit om makkelĳk te zoeken naar boeken in genre of sub-genre. Bĳvoorbeeld: Aangenomen dat uw genre als volgt
is gestructureerd:

Genre

. History

.. Japanese

.. Military

.. Roman

. Mysteries

.. English

.. Vampire

. Science Fiction

.. Alternate History

.. Military

.. Space Opera

. Thrillers

.. Crime

.. Horror

etc.

Door de hiërarchiefunctie te gebruiken, kunt u deze genres in de Tag-browser in boom-vorm zien, zoals weergegeven in de
schermafbeelding. In dit voorbeeld is het buitenste niveau (Genre) een aangepaste kolom die de genres bevat. Genres met
subgenres verschĳnen met een kleine driehoek ernaast. Klikken op die driehoek opent het item en worden de subgenres
weergegeven, zoals u kunt zien bĳ History en Science Fiction.
Klikken op een genre kan zoeken naar alle boeken met dat genre of sub-genres. Bĳvoorbeeld, klikken op Science Fic-
tion kan resulteren in alle drie sub-genres, Alternatieve Geschiedenis, Militair en Ruimtevaart. Klikken op Alternatieve
Geschiedenis geeft boeken in dat genre, Militair en Ruimtevaart buiten beschouwing latend. Uiteraard kan een boek
meerdere genres hebben. Als een boek in Ruimtevaart en Militair is ingedeeld, ziet u dit boek als u op een van beide
genres klikt. Zoeken wordt hieronder gedetailleerd besproken.
Tevens kunt u op de afbeelding zien dat het genre Militarisme tweemal voorkomt, eenmaal onder History en eenmaal
onder Science Fiction. Omdat de genres in een hiërarchie staan, zĳn dit twee separate genres. Een boek kan dus voorkomen
in het ene, het andere of (twĳfelachtig in dit geval) in beide. Bĳvoorbeeld kunnen de boeken van Winston Churcill “De
Tweede Wereldoorlog” voorkomen in “History.Militarisme”. David Webers Honor Harrington boeken kunnen in “Sciende
Fiction.Miltarisme” en ook in “Science Fiction.Ruimtevaart”.
Als een genre eenmaal bestaat, d.w.z. dat minstens één boek het heeft, kunt u dit makkelĳk toewĳzen aan andere boeken
door deze te slepen vanuit de bibliotheek naar het genre dat u wilt toewĳzen aan de boeken. U kunt genres ook toewĳzen
in de metadata-editors; meer informatie onderstaand.

10.1.1 Configuratie
Ondertussen wilt u vermoedelĳk weten “Hoe is dit ingericht?” Er zĳn drie stappen: 1) een aangepaste kolom aanmaken,
2) vertel calibre dat de nieuwe kolom hiërarchisch behandeld moet worden en 3) genres toevoegen.
You create the custom column in the usual way, using Preferences -> Add your own columns. This example uses “#genre”
as the lookup name and “Genre” as the column heading. It is important that the column type is set to Comma-separated
text, like tags, shown in the Tag browser.
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Then after restarting calibre, you must tell calibre that the column is to be treated as a hierarchy. Go to Preferences  → 
Look & feel  →  Tag browser  →  Hierarchy and searching and choose the new Genre column as having hierarchical items.
Nu staan er nog geen genres in de kolom. Blĳft een laatste stap: Hoe wĳzen we een genre toe aan een boek. Een genre
bestaat niet in calibre totdat het verschĳnt bĳ tenminste één boek. Om te leren hoe een genre aan een boek toe te wĳzen,
moeten we eerst wat dieper ingaan over hoe een genre eruit ziet in de metadata van een boek.
Een hiërarchie maakt u door uitdrukkingen of woorden gescheiden door punten in te voeren. Voortgaand in het vorbeeld
genre kunnen deze zĳn “History.Militarisme”, “Mysteries.Vampire”, “Science Fiction.Ruimtevaart”, etc. Om aldus een
nieuw genre te maken, kiest u een boek waarvoor u een genre wilt toewĳzen, bewerk de metadata en voer het nieuwe
genre in de kolom in die u heeft gemaakt. In ons voorbeeld wilt u misschien het genre “Comics” met een sub-genre
“Superheroes” voor een boek toewĳzen; hiervoor wilt u ‘metadata bewerken’ voor dat (comic) boek, kies de Aangepaste
metadat tab en vul dan “Comics.Superheroes” in zoals onderstaand te zien (negeer de andere aangepaste kolommen):

Nadat u het bovenstaande hebt gedaan, ziet u in de Tag-browser:
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Vanaf nu kunt u dit nieuwe genre toewĳzen aan een boek (vermoedelĳk een comic) door het boek te slepen op het genre
of het toevoegen met behulp van metadata bewerken precies zoals hierboven beschreven.

Notitie

Hiërarchische weergave werkt alleen als de Tag browser is ingesteld om items op naam te sorteren. Dit is de standaard
en controleren kan door te klikken op de knop Instellen onder aan de Tag browser.

10.1.2 Zoeken

De eenvoudigste manier om naar genres te zoeken, is met behulp van de Tag-browser, door op het genre te klikken dat
u wilt zien. Als u op een genre met kinderen klikt, worden boeken met dat genre en alle kindergenres weergegeven. Dit
kan echter een vraag oproepen. Het feit dat een genre kinderen heeft, betekent niet dat het geen genre op zichzelf is. Een
boek kan bĳvoorbeeld het genre “Geschiedenis” hebben, maar niet “Geschiedenis.Militair”. Hoe zoek je naar boeken met
alleen “Geschiedenis”?
Het zoekmechanisme van de Tag-browser weet of een item kinderen heeft. Als dit het geval is, klikt u op het item door
5 zoekopdrachten in plaats van de normale drie. De eerste is de normale groene plus, die je alleen boeken met dat genre
laat zien (bĳvoorbeeld Geschiedenis). De tweede is een dubbele plus (hierboven weergegeven), die je boeken toont met
dat genre en alle subgenres (bĳv. Geschiedenis en Geschiedenis.Militair). De derde is de normale rode min, die je boeken
toont zonder dat exacte genre. De vierde is een dubbele min, die je boeken toont zonder dat genre of sub-genres. De vĳfde
is terug naar het begin, geen teken, wat betekent dat er geen zoeken is.
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10.1.3 Restricties
Als u een genre zoekt en er dan een opgeslagen zoekopdracht voor maakt, kunt u het vak ‘beperken tot’ gebruiken om een
virtuele bibliotheek met dit genre boeken te maken. Handig als u andere zoekopdrachten in het genre wilt doen of metadata
voor boeken in het genre wilt beheren/bĳwerken. Dit voorbeeld volgend, kunt u een Opgeslagen zoekopdracht maken met
de naam ‘Geschiedenis.Japans’ door eerst op het genre Japans in de Tag-browser te klikken om een zoekopdracht in het
zoekvak te krĳgen, Geschiedenis.Japans in het opgeslagen zoekvak in te voeren en vervolgens op de knop ‘zoekopdracht
opslaan’ (het groene vak met het witte plusteken aan de rechterkant) te drukken.

Na creatie van de opgeslagen zoekopdracht, kunt u deze als beperking gebruiken.

10.1.4 Handige sjabloonfuncties
Misschien wilt u de genre-informatie in een sjabloon gebruiken, bĳvoorbeeld met opslaan op schĳf of ver-
zenden naar apparaat. De vraag kan dan zĳn: “Hoe krĳg ik de naam of namen van het buitenste genre?” Een
kaliber-sjabloonfunctie, subitems, is beschikbaar om dit gemakkelĳker te maken.
Stel bĳvoorbeeld dat u het buitenste genre-niveau wilt toevoegen aan de opslaan-op-schĳf-sjabloon om genre-
mappen te maken, zoals in “Geschiedenis/De Opstekende Storm - Churchill, Winston”. Om dit te doen, moet
u het eerste niveau van de hiërarchie nemen en aan de voorkant toevoegen samen met een schuine streep om
aan te geven dat het een map moet maken. De onderstaande sjabloon realiseert dit:

{#genre:subitems(0,1)||/}{title} - {authors}

Zie De sjabloontaal (pagina 162) voor meer informatie over sjablonen en de functie subitems().

10.2 XPath handleiding
In deze zelfstudie krĳgt u een voorzichtige inleiding tot XPath <https://en.wikipedia.org/wiki/XPath> _, een querytaal
die kan worden gebruikt om willekeurige delen van `HTML <https://en.wikipedia.org/wiki/HTML>`_documenten in
Calibre. XPath is een veel gebruikte standaard, en googelen levert een hoop informatie op. Deze zelfstudie richt zich echter

10.2. XPath handleiding 159

https://en.wikipedia.org/wiki/HTML


calibre Gebruikershandleiding, Release 8.7.0

op het gebruik van XPath voor aan e-boeken gerelateerde taken, zoals het vinden van hoofdstukken in een ongestructureerd
HTML-document.

Inhoud

• Selecteren op naam van label (pagina 160)
• Selecteren op eigenschap (pagina 161)
• Selecteren op label inhoud (pagina 161)
• Voorbeeld e-boek (pagina 161)
• XPath ingebouwde functies (pagina 161)

10.2.1 Selecteren op naam van label
De eenvoudigste vorm van selectie is om labels op naam te selecteren. Bĳvoorbeeld, stel dat u wilt alle <h2>-labels in een
document wilt selecteren. De XPath query voor dit is:

//h:h2 (Selects all <h2> tags)

Het voorvoegsel // betekent zoeken op elk niveau van het document. Stel nu dat u wilt zoeken naar <span> -labels die
zich binnen de ``<a>``labels bevinden. Dat kan worden bereikt met:

//h:a/h:span (Selects <span> tags inside <a> tags)

Als u naar labels wilt zoeken in een bepaald gebied van het document, verander dan de prefix:

/h:body/h:div/h:p (Selects <p> tags that are children of <div> tags that are

children of the <body> tag)

Dit komt overeen met <p>een zeer kort e-book om het gebruik van XPath.</p> in de voorbeeld_ebook
aan te tonen, maar niet een van de andere <p>-labels. Het h: voorvoegsel in de bovenstaande voorbeelden is nodig om
overeen te komen met XHTML-labels. Dit komt omdat intern, Calibre alle inhoud als XHTML vertegenwoordigt. In
XHTML-labels hebben een naamruimte, en h: is de naamruimte prefix voor HTML-labels.
Stel nu dat u zowel de tags ``<h1> ‘’ als ``<h2> ‘’ wilt selecteren. Om dat te doen, hebben we een XPath-constructie nodig
genaamd * predicaat *. Een :dfn: predicaat is gewoon een test die wordt gebruikt om tags te selecteren. Tests kunnen
willekeurig krachtig zĳn en naarmate deze zelfstudie vordert, zult u krachtigere voorbeelden zien. Een predicaat wordt
gemaakt door de testuitdrukking tussen vierkante haken te plaatsen:

//*[name()='h1' or name()='h2']

Er zĳn verschillende nieuwe functies in deze XPath-expressie. De eerste is het gebruik van het jokerteken `` * ``. Het
betekent * komt overeen met elke tag *. Kĳk nu naar de testuitdrukking `` name ()=’h1’ of name ()=’h2’ ‘’. : term: name()
is een voorbeeld van een * ingebouwde functie *. Het evalueert eenvoudigweg de naam van de tag. Dus door het te
gebruiken, kunnen we tags selecteren waarvan de namen h1 of` h2` zĳn. Merk op dat de functie name () naamruimten
negeert, zodat het voorvoegsel `` h: `` niet nodig is. XPath heeft verschillende handige ingebouwde functies. Een paar meer
zullen in deze zelfstudie worden geïntroduceerd.

160 Hoofdstuk 10. Lesboeken



calibre Gebruikershandleiding, Release 8.7.0

10.2.2 Selecteren op eigenschap
Om tags te selecteren op basis van hun attributen, is het gebruik van predicaten vereist:

//*[@style] (Select all tags that have a style attribute)

//*[@class="chapter"] (Select all tags that have class="chapter")

//h:h1[@class="bookTitle"] (Select all h1 tags that have class="bookTitle")

Hier verwĳst de operator ``@’’ naar de kenmerken van de tag. U kunt enkele van de in ‘XPath ingebouwde functies’ _
gebruiken om meer geavanceerdere vergelĳkingen uit te voeren op kenmerkwaarden.

10.2.3 Selecteren op label inhoud
Met XPath kunt u zelfs tags selecteren op basis van de tekst die ze bevatten. De beste manier om dit te doen is om de
kracht van * reguliere expressies * te gebruiken via de ingebouwde functie re:test():

//h:h2[re:test(., 'chapter|section', 'i')] (Selects <h2> tags that contain the words␣

↪→chapter or

section)

Hier verwĳst de operator . naar de inhoud van de tag, net zoals de operator ``@’’ verwĳst naar de kenmerken.

10.2.4 Voorbeeld e-boek
<html>

<head>

<title>A very short e-book</title>

<meta name="charset" value="utf-8" />

</head>

<body>

<h1 class="bookTitle">A very short e-book</h1>

<p style="text-align:right">Written by Kovid Goyal</p>

<div class="introduction">

<p>A very short e-book to demonstrate the use of XPath.</p>

</div>

<h2 class="chapter">Chapter One</h2>

<p>This is a truly fascinating chapter.</p>

<h2 class="chapter">Chapter Two</h2>

<p>A worthy continuation of a fine tradition.</p>

</body>

</html>

10.2.5 XPath ingebouwde functies
naam()

De naam van het huidige label.
bevat()

contains(s1, s2) returns true if s1 contains s2.
re:test()

re:test (src, patroon, vlaggen) geeft waar terug als de string src overeenkomt met de reguliere expressie
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patroon. Een bĳzonder handige vlag is i, het maakt vergelĳken hoofdletter ongevoelig. Een goede inleiding over
de syntaxis voor reguliere expressies is te vinden op regexp syntax <https://docs.python.org/library/re.html> _

10.3 De calibre sjabloontaal
De calibre sjabloontaal is een calibre-eigen taal gebruikt doorheen calibre voor taken zoals specificeren van bestandspaden,
opmaken van waarden en berekenen van de waarde voor gebruiker-gespecificeerde kolommen. Voorbeelden:

• Specificeer de mappenstructuur en bestandsnamen bĳ opslaan van bestanden van de calibre bibliotheek naar de
schĳf of e-boekreader.

• Definieer regels voor toevoegen van iconen en kleuren aan calibre’s boekenlĳst.
• Definieer virtuele kolommen die data bevatten van andere kolommen.
• Geavanceerd bibliotheek zoeken.
• Geavanceerd metadata zoeken en vervangen.

De taal is gebouwd rond het concept van een sjabloon die specificeert welke metadata te gebruiken, berekeningen op die
metadata en hoe het opgemaakt moet worden.

10.3.1 Basis sjablonen
Een basissjabloon bestaat uit één of meer template expressions. Een template expression bestaat uit tekst en
namen tussen accolades ({}) die wordt vervangen door de overeenkomende metadata van het boek in verwerking. Bv. de
standaard sjabloon in calibre gebruikt voor boeken naar toestel opslaan heeft vier template expressions:

{author_sort}/{title}/{title} - {authors}

Voor het boek “The Foundation” door “Isaac Asimov” wordt dit:

Asimov, Isaac/The Foundation/The Foundation - Isaac Asimov

De schuine strepen zĳn geen template expressions omdat ze tussen {} staan. Zulke tekst blĳft waar ie is. Bv., als
de sjabloon is:

{author_sort} Some Important Text {title}/{title} - {authors}

dan voor “The Foundation” produceert de sjabloon:

Asimov, Isaac Some Important Text The Foundation/The Foundation - Isaac Asimov

Een template expression heeft toegang tot alle metadata in calibre, inbegrepen aangepaste kolommen (kolommen
die u zelf creëerde), door de kolom z’n lookup name te gebruiken. Om een kolom z’n lookup name te vinden (soms velden
genaamd), zweef met uw muis over de kolom header in calibre’s boekenlĳst. Lookup names voor aangepaste kolommen
beginnen altĳd met #. Voor reeks type kolommen is er een bĳkomend veld genaamd #lookup name_index wat de
serie index is voor dat boek in de serie. Bv., als u een aangepaste serie hebt genaamd #myseries dan zal er ook een
kolom zĳn genaamd #myseries_index. De standaard serie kolom index heet series_index.
Naast de kolom gebaseerde velden, kunt u gebruik maken van:

• {formats} - Een lĳst van formaten beschikbaar in de calibre bibliotheek voor een boek
• {identifiers:select(isbn)} - De ISBN van het boek

Als de metadata voor het veld voor een bepaald boek niet gedefinieerd is wordt het veld in de sjabloon vervangen door de
lege string (''). Bv. overweeg volgende sjabloon:
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{author_sort}/{series}/{title} {series_index}

Als Asimov’s boek “Second Foundation” in de serie “Foundation” is dan geeft de sjabloon:

Asimov, Isaac/Foundation/Second Foundation 3

Als er voor een boek geen serie is ingevoerd geeft de sjabloon:

Asimov, Isaac/Second Foundation

De sjabloonverwerker verwĳdert automatisch meerdere schuine strepen en voorloop en volg spaties.

10.3.2 Geavanceerde opmaak
Bovenop metadatasubstitutie kunnen sjablonen voorwaardelĳk extra tekst opnemen en de opmaak van gesubstitueerde
gegevens controleren.
Voorwaardelĳk tekst opnemen
Soms wilt u dat tekst enkel in de uitvoer verschĳnt als een veld niet leeg is. Een veel voorkomend geval is series en
series_index waar u ofwel niets wil of de twee waarden gescheiden door een streepje. calibre doet dit via een speciale
template expression syntaxis.
Bv. met het Foundation voorbeeld van boven, veronderstel dat u wilt dat de sjabloon Foundation - 3 - Second Foundation
geeft. Deze sjabloon geeft die uitvoer:

{series} - {series_index} - {title}

Alhoewel, als een boek geen deel van een serie is, geeft de sjabloon - - de titel, wat waarschĳnlĳk niet is wat u wilt.
Gewoonlĳk willen de mensen als resultaat de titel zonder extra streepjes. Dit kan met de volgende sjabloon syntaxis:

{field:|prefix_text|suffix_text}

Deze template expression zegt dat als field de waarde XXXX heeft, het resultaat prefix_textXXXXXsuffix_text zal
zĳn. Als field leeg is (heeft geen waarde) dan zal het resultaat de lege string zĳn (niets) omdat voor- en achtervoegsel
genegeerd worden. Het voor- en achtervoegsel kunnen lege plekken hebben.
Gebruik geen subsjablonen (`{ … }`) of functies (zie onder) in het voor- of achtervoegsel.
Met deze syntaxis kunnen we het geen-serie probleem boven oplossen met de sjabloon:

{series}{series_index:| - | - }{title}

De streepjes komen er enkel bĳ als het boek een serie index heeft, die het enkel heeft als het deel van een serie is. Verder
weer met het Foundation voorbeeld, de sjabloon geeft Foundation - 1 - Second Foundation.
Aantekeningen:

• U moet een dubbel punt zetten na de lookup name als u een voor- of achtervoegsel gebruikt.
• U moet ofwel beide ofwel geen | karakters gebruiken. Eén gebruiken, zoals in {field:| - }, is niet toegelaten.
• Het is oké om geen tekst te voorzien voor voor- of achtervoegsel, zoals in {series:|| - }. De sjabloon {tit-
le:||} is hetzelfde als {title}.

Opmaak
Veronderstel dat u series_index opgemaakt wilt als drie cĳfers met voorloopnullen. Dit doet de truc:

{series_index:0>3s} - Drie cĳfers met voorloopnullen
Voor volgnullen, gebruik:
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{series_index:0<3s} - Drie cĳfers met volgnullen
Als u reeksindexen gebruikt met fractionele waarden, bv. 1,1, hebt u de komma’s misschien graag uitgelĳnd. Bv. u hebt
misschien graag dat indexen 1 en 2,5 eruit zien als 01,00 en 02,50 zodat ze correct sorteren op een toestel dat lexicaal
sorteert. Om dit te doen, gebruik:

{series_index:0>5.2f} - Vĳf karakters bestaande uit twee cĳfers met voorloopnullen, een komma en
twee cĳfers na de komma.

Als u enkel de twee eerste letters van de data wil, gebruik:
{author_sort:.2} - Enkel de eerste twee letters van de auteursorteernaam

Veel van de calibre sjabloontaalvormgeving komt van Python. Voor meer details over de syntaxis van deze geavanceerde
vormgevingsoperaties zie de Python documentatie76.

10.3.3 Sjablonen gebruiken om aangepaste kolommen te definiëren
Sjablonen kunnen gebruikt worden om informatie weer te geven niet in calibre’s metadata of metadata afwĳkend van
calibre’s gewone formaat. Bv. u wilt misschien het ISBN tonen, een veld dat calibre niet weergeeft. Dit kan door een
aangepaste kolom te creëren van het type Kolom gemaakt van andere kolommen (hierna samengestelde kolommen) en een
sjabloon te voorzien om de weer te geven tekst te genereren. De kolom geeft het resultaat weer van het evalueren van de
sjabloon. Bv. om het ISBN weer te geven, creëer de kolom en voer {identifiers:select(isbn)} in in het sjabloon
vak. Om een kolom weer te geven met de waardes van twee series aangepaste kolommen, gescheiden door een komma,
gebruik {#series1:||,}{#series2}.
Samengestelde kolommen kunnen elke sjabloonoptie gebruiken, inclusief opmaak.
Nota: U kan data getoond in een samengestelde kolom niet bewerken. U moet de bronkolommen bewerken. Als u een sa-
mengestelde kolom bewerkt, bv. door erop dubbel te klikken, zal calibre de bewerksjabloon openen, niet de onderliggende
data.

10.3.4 Templates and plugboards
Plugboards are used for changing the metadata written into books during send-to-device and save-to-disk operations. A
plugboard permits you to specify a template to provide the data to write into the book’s metadata. You can use plugboards
to modify the following fields: authors, author_sort, language, publisher, tags, title, title_sort. This feature helps people
who want to use different metadata in books on devices to solve sorting or display issues.
When you create a plugboard, you specify the format and device for which the plugboard is to be used. A special device
is provided, save_to_disk, that is used when saving formats (as opposed to sending them to a device). Once you have
chosen the format and device, you choose the metadata fields to change, providing templates to supply the new values.
These templates are connected to their destination fields, hence the name plugboards. You can of course use composite
columns in these templates.
Plugboards are quite flexible and can be written in Single Function Mode, Template Program Mode, General Program
Mode, or Python Template mode.
When a plugboard might apply (Content server, save to disk, or send to device), calibre searches the defined plugboards
to choose the correct one for the given format and device. For example, to find the appropriate plugboard for an EPUB
book being sent to an ANDROID device, calibre searches the plugboards using the following search order:

• een adapter met een exacte overeenkomst op formaat en toestel, bv. EPUB en ANDROID

• a plugboard with an exact match on format and the special any device choice, e.g., EPUB and any device

• een adapter met de speciale any format keuze en een exacte overeenkomst op toestel, bv. any format en
ANDROID

• a plugboard with any format and any device

76 https://docs.python.org/3/library/string.html#formatstrings
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De labels en auteurs velden hebben een speciale behandeling omdat beide velden meer dan één item kunnen vasthouden.
Een boek kan vele labels en meerdere auteurs hebben. Als u opgeeft dat één van deze twee velden gewĳzigd gaat worden,
wordt de template resultaat onderzocht om te zien of meer dan één item is. Voor labels wordt het resultaat gescheiden waar
Calibre een komma vindt. Bĳvoorbeeld, als de template de waarde `` Thriller, Horror`` produceert, dan zal het resultaat
twee labels zĳn, Thriller en Horror. Er is geen manier om een komma in het midden van een tag te zetten.
The same thing happens for authors, but using a different character for the cut, a & (ampersand) instead of a comma. For
example, if the template produces the value Blogs, Joe&Posts, Susan, then the book will end up with two authors,
Blogs, Joe and Posts, Susan. If the template produces the value Blogs, Joe;Posts, Susan, then the book
will have one author with a rather strange name.
Plugboards affect the metadata written into the book when it is saved to disk or written to the device. Plugboards do not
affect the metadata used by save to disk and send to device to create the file names. Instead, file names are
constructed using the templates entered on the appropriate preferences window.

10.3.5 Functies gebruiken in sjablonen - Eén Functie Modus
Veronderstel dat u de waarde van een veld in hoofdletters wil tonen wanneer dat veld normaal elk woord met beginhoofd-
letter toont. Dit kan met sjabloonfuncties. Bv., om de titel in hoofdletters te tonen, gebruik de uppercase functie, zoals
in {title:uppercase()}. Om met beginhoofdletters te tonen, gebruik {title:titlecase()}.
Functies gaan in het formaat deel van de sjabloon, na de : en voor de eerste | of de sluit } als geen voor- of achtervoegsel
is gebruikt. Als u zowel een formaat als een functie referentie hebt, komt de functie na een tweede :. Functies geven de
waarde terug van de kolom gespecificeerd in de sjabloon, gepast gewĳzigd.
De syntaxis voor gebruik van functies is een van:

{lookup_name:function(arguments)}

{lookup_name:format:function(arguments)}

{lookup_name:function(arguments)|prefix|suffix}

{lookup_name:format:function(arguments)|prefix|suffix}

Functienamen moeten altĳd gevolgd worden door open/sluithaakjes. Sommige functies hebben extra waarden (argumen-
ten) nodig en deze staan tussen de haakjes. Argumenten worden gescheiden door komma’s. Letterlĳke komma’s (als
tekst, niet als argumenten scheiders) moeten vooraf gegaan worden door een achteroverhellend streepje (\). Het laatste
(of enige) argument kan geen tekstueel sluithaakje bevatten.
Functies worden geëvalueerd voor formaat specificaties en het voor-/achtervoegsel. Kĳk verder beneden voor een voor-
beeld van gebruik van zowel een formaat als een functie.
Belangrĳk: Als u programmeerervaring hebt, hou er a.u.b. rekening mee dat de syntaxis in Eén Functie Modus niet is wat
u verwacht. Strings hebben geen aanhalingstekens en spaties zĳn belangrĳk. Alle argumenten worden gezien als contanten;
er zĳn geen expressies.
Gebruik geen subsjablonen (`{ … }`) als functie argumenten. In plaats daarvan, gebruik Sjabloon Programma Modus
(pagina 173) en Algemene Programma Modus (pagina 168).
Notes on calling functions in Single Function Mode:

• When functions are used in Single Function Mode, the first parameter, value, is automatically replaced by the
content of the field specified in the template. For example, when the template {title:capitalize()} is pro-
cessed, the content of the title field is passed as the parameter value to the capitalize function.

• In the function documentation, the notation [something]* means that something can be repeated zero or more
times. The notation [something]+ means that the something is repeated one or more times (must exist at least
one time).

• Some functions use regular expressions. In the template language regular expression matching is case-insensitive.
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Functions are documented in Sjabloon functie referenties (pagina 182). The documentation tells you what arguments the
functions require and what the functions do. For example, here is the documentation of the ifempty (pagina 207) function.

• ifempty(value, text_if_empty) – if the value is not empty then return that value, otherwise return
text_if_empty.

You see that the function requires two arguments, value and text_if_empty. However, because we are using Single
Function Mode, we omit the value argument, passing only text_if_empty. For example, this template:

{tags:ifempty(No tags on this book)}

shows the tags for a book, if any. If it has no tags then it show No tags on this book.
The following functions are usable in Single Function Mode because their first parameter is value.

• capitalize (pagina 187)(value) – returns the value with the first letter in upper case and the rest lower case.
• ceiling (pagina 186)(value) – returns the smallest integer greater than or equal to value.
• cmp (pagina 206)(value, y, lt, eq, gt) – compares value and y after converting both to numbers.
• contains (pagina 207)(value, pattern, text_if_match, text_if_not_match) – checks if the value is

matched by the regular expression pattern

• date_arithmetic (pagina 191)(value, calc_spec, fmt) – Calculate a new date from value using calc_spec.
• encode_for_url (pagina 209)(value, use_plus) – returns the value encoded for use in a URL as specified by
use_plus. The value is first URL-encoded. Next, if use_plus is 0 then spaces are replaced by '+' (plus) signs.
If it is 1 then spaces are replaced by %20.

• floor (pagina 186)(value) – returns the largest integer less than or equal to value.
• format_date (pagina 192)(value, format_string) – format the value, which must be a date string, using

the format_string, returning a string.
• format_duration (pagina 193)(value, template, [largest_unit]) – format the value, a number of se-

conds, into a string showing weeks, days, hours, minutes, and seconds. If the value is a float then it is rounded to
the nearest integer.

• format_number (pagina 194)(value, template) – interprets the value as a number and formats that number
using a Python formatting template such as {0:5.2f} or {0:,d} or ${0:5,.2f}.

• fractional_part (pagina 186)(value) – returns the part of the value after the decimal point.
• human_readable (pagina 194)(value) – expects the value to be a number and returns a string representing that

number in KB, MB, GB, etc.
• ifempty (pagina 207)(value, text_if_empty) – if the value is not empty then return that value, otherwise

return text_if_empty.
• language_strings (pagina 198)(value, localize) – return the language names for the language codes (see here

for names and codes77) passed in value.
• list_contains (pagina 200)(value, separator, [ pattern, found_val, ]* not_found_val) – interpret

the value as a list of items separated by separator, checking the pattern against each item in the list.
• list_count (pagina 201)(value, separator) – interprets the value as a list of items separated by separator

and returns the number of items in the list.
• list_count_matching (pagina 201)(value, pattern, separator) – interprets value as a list of items sepa-

rated by separator, returning the number of items in the list that match the regular expression pattern.
77 https://www.loc.gov/standards/iso639-2/php/code_list.php
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• list_item (pagina 200)(value, index, separator) – interpret the value as a list of items separated by
separator, returning the ‘index’th item.

• list_sort (pagina 203)(value, direction, separator) – return value sorted using a case-insensitive lexical
sort.

• lookup (pagina 199)(value, [ pattern, key, ]* else_key) – The patterns will be checked against the
value in order

• lowercase (pagina 187)(value) – returns the value in lower case.
• mod (pagina 186)(value, y) – returns the floor of the remainder of value / y.
• rating_to_stars (pagina 194)(value, use_half_stars) – Returns the value as string of star (★) characters.
• re (pagina 207)(value, pattern, replacement) – return the value after applying the regular expression.
• re_group (pagina 208)(value, pattern [, template_for_group]*) – return a string made by applying

the regular expression pattern to value and replacing each matched instance
• round (pagina 186)(value) – returns the nearest integer to value.
• select (pagina 200)(value, key) – interpret the value as a comma-separated list of items with each item having

the form id:id_value (the calibre identifier format).
• shorten (pagina 208)(value, left_chars, middle_text, right_chars) – Return a shortened version

of the value
• str_in_list (pagina 200)(value, separator, [ string, found_val, ]+ not_found_val) – interpret

the value as a list of items separated by separator then compare string against each value in the list.
• subitems (pagina 204)(value, start_index, end_index) – This function breaks apart lists of tag-like hier-

archical items such as genres.
• sublist (pagina 204)(value, start_index, end_index, separator) – interpret the value as a list of

items separated by separator, returning a new list made from the items from start_index to end_index.
• substr (pagina 208)(value, start, end) – returns the start’th through the end’th characters of value
• swap_around_articles (pagina 209)(value, separator) – returns the value with articles moved to the end,

separated by a semicolon.
• swap_around_comma (pagina 209)(value) – given a value of the form B, A, return A B.
• switch (pagina 199)(value, [patternN, valueN,]+ else_value) – for each patternN, valueN pair,

checks if the value matches the regular expression patternN

• test (pagina 209)(value, text_if_not_empty, text_if_empty) – return text_if_not_empty if the
value is not empty, otherwise return text_if_empty.

• titlecase (pagina 187)(value) – returns the value in title case.
• transliterate (pagina 209)(value) – Return a string in a latin alphabet formed by approximating the sound of the

words in value.
• uppercase (pagina 188)(value) – returns the value in upper case.

Functies en opmaak gebruiken in dezelfde sjabloon
Veronderstel, u hebt een aangepaste kolom met gehele getallen #myint die u wilt weergeven met voorloopnullen, zoals
in 003. Een manier om dit te doen is met het formaat 003. Hoewel, standaard, als een getal (geheel of decimaal) gelĳk is
aan nul wordt de waarde getoond als de lege string dus nul waardes geven de lege string, niet 000. Als u 000 waardes wilt
zien, gebruikt u zowel de formaat string als de ifempty functie om de lege waarde terug op nul te zetten. De sjabloon
wordt:
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{#myint:0>3s:ifempty(0)}

Merk op dat u zowel het voor- als het achtervoegsel kan gebruiken. Als u wil dat het getal verschĳnt als [003] of [000],
gebruik dan de sjabloon:

{#myint:0>3s:ifempty(0)|[|]}

10.3.6 Algemene Programma Modus
Algemene Programma Modus (APM) vervangt sjabloonexpressies door een programma geschreven in de sjabloontaal. De
syntaxis van de taal is gedefinieerd door de volgende grammatica:

program ::= 'program:' expression_list

expression_list ::= top_expression [ ';' top_expression ]*

top_expression ::= or_expression

or_expression ::= and_expression [ '||' and_expression ]*

and_expression ::= not_expression [ '&&' not_expression ]*

not_expression ::= [ '!' not_expression ]* | concatenate_expr

concatenate_expr::= compare_expr [ '&' compare_expr ]*

compare_expr ::= add_sub_expr [ compare_op add_sub_expr ]

compare_op ::= '==' | '!=' | '>=' | '>' | '<=' | '<' |

'in' | 'inlist' | 'inlist_field' |

'==#' | '!=#' | '>=#' | '>#' | '<=#' | '<#'

add_sub_expr ::= times_div_expr [ add_sub_op times_div_expr ]*

add_sub_op ::= '+' | '-'

times_div_expr ::= unary_op_expr [ times_div_op unary_op_expr ]*

times_div_op ::= '*' | '/'

unary_op_expr ::= [ add_sub_op unary_op_expr ]* | expression

expression ::= identifier | constant | function | assignment | field_reference |

if_expr | for_expr | break_expr | continue_expr |

'(' expression_list ')' | function_def

field_reference ::= '$' [ '$' ] [ '#' ] identifier

identifier ::= id_start [ id_rest ]*

id_start ::= letter | underscore

id_rest ::= id_start | digit

constant ::= " string " | ' string ' | number

function ::= identifier '(' expression_list [ ',' expression_list ]* ')'

function_def ::= 'def' identifier '(' top_expression [ ',' top_expression ]* ')' ':

↪→'

expression_list 'fed'

assignment ::= identifier '=' top_expression

if_expr ::= 'if' condition 'then' expression_list

[ elif_expr ] [ 'else' expression_list ] 'fi'

condition ::= top_expression

elif_expr ::= 'elif' condition 'then' expression_list elif_expr | ''

for_expr ::= for_list | for_range

for_list ::= 'for' identifier 'in' list_expr

[ 'separator' separator_expr ] ':' expression_list 'rof'

for_range ::= 'for' identifier 'in' range_expr ':' expression_list 'rof'

range_expr ::= 'range' '(' [ start_expr ',' ] stop_expr

[ ',' step_expr [ ',' limit_expr ] ] ')'

list_expr ::= top_expression

break_expr ::= 'break'
(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
continue_expr ::= 'continue'

separator_expr ::= top_expression

start_expr ::= top_expression

stop_expr ::= top_expression

step_expr ::= top_expression

limit_expr ::= top_expression

Aantekeningen:
• een top_expression heeft altĳd een waarde. De waarde van een expression_list is de waarde van de laatste
top_expression in de lĳst. Bv. de waarde van de expressielĳst 1;2;'foobar';3 is 3.

• In een logische context is elke niet-lege waarde True
• In een logische context is de lege waarde False
• Strings en getallen kunnen door elkaar gebruikt worden. Bv. 10 en '10' zĳn identiek.
• Comments are lines starting with a ‘#’ character, possibly preceded by blanks or tabs.

Operator voorrang
De operator voorrang (volgorde van evalueren) van hoogste (eerst geëvalueerd) naar laagste (laatst geëvalueerd) is:

• Functie aanroep, constanten, uitdrukkingen tussen haakjes, instructie-expressies, opdracht-expressies, veldreferen-
ties.

• Unary plus (+) en min (-). Deze operatoren evalueren van rechts naar links.
Deze en alle andere rekenkundige operatoren geven integers terug als het resultaat van de expressie een fractioneel
deel gelĳk aan nul is. Bv. als een expressie 3.0 terug geeft, wordt dit veranderd in 3.

• Vermenigvuldigen (*) en delen (/). Deze operatoren zĳn associatief en evalueren van links naar rechts. Gebruik
haakjes als u de volgorde van evaluatie wilt veranderen.

• Optellen (+) en aftrekken (-). Deze operatoren zĳn associatief en evalueren van links naar rechts.
• Numerieke en string vergelĳkingen. Deze operatoren geven '1' terug als de vergelĳking door gaat, anders de lege

string (''). Vergelĳkingen zĳn niet associatief: a < b < c is een syntaxis fout.
• String concatenation (&). The & operator returns a string formed by concatenating the left-hand and right-hand

expressions. Example: 'aaa' & 'bbb' returns 'aaabbb'. The operator is associative and evaluates left to right.
• Unary logisch niet (!). Deze operator geeft '1' terug als de expressie Vals is (evalueert naar de lege string), anders
''.

• Logisch en (&&). Deze operator geeft ‘1’ terug als zowel de linker- als de rechter-kant expressies Waar zĳn, of de
lege string '' als een van beide Vals is. Het is associatief, evalueert van links naar rechts en doet aan kort-sluiten78.

• Logische of (||). Deze operator geeft '1' terug als ofwel de linker- ofwel de rechterkant expressie Waar is, of ''
als beide Vals zĳn. Hĳ is associatief, evalueert van links naar rechts en doet aan kort-sluiten79. Het is een inclusieve
of, geeft '1' terug als zowel de linker- en rechterkant expressies Waar zĳn.

Veldreferenties
A field_reference evaluates to the value of the metadata field named by lookup name that follows the $ or $$.
Using $ is equivalent to using the field (pagina 196) function. Using $$ is equivalent to using the raw_field (pagina 198)
function. Examples:

78 https://chortle.ccsu.edu/java5/Notes/chap40/ch40_2.html
79 https://chortle.ccsu.edu/java5/Notes/chap40/ch40_2.html
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* $authors ==> field('authors')

* $#genre ==> field('#genre')

* $$pubdate ==> raw_field('pubdate')

* $$#my_int ==> raw_field('#my_int')

If expressies
If expressies evalueren eerst de condition. Als de condition Waar is (een niet-lege waarde) wordt de expres-

sion_list in de then clausule geëvalueerd. Als ze Onwaar is wordt, indien aanwezig, de expression_list in de
elif of else clausule geëvalueerd. De elif en else delen zĳn optioneel. De woorden if, then, elif, else, en fi

zĳn gereserveerd; U kan ze niet gebruiken als identificator namen. U kan nieuwe regels en spaties zetten overal waar
het zin heeft. De condition is een top_expression geen expression_list; puntkomma’s zĳn niet toegelaten. De
expression_lists zĳn puntkomma gescheiden reeksen met top_expressions. Een if expressie geeft het resultaat
terug van de laatste top_expression in de geëvalueerde expression_list, of de lege string als geen expressie lĳst
werd geëvalueerd.
Voorbeelden:

* program: if field('series') then 'yes' else 'no' fi

* program:

if field('series') then

a = 'yes';

b = 'no'

else

a = 'no';

b = 'yes'

fi;

strcat(a, '-', b)

Genest if voorbeeld:

program:

if field('series') then

if check_yes_no(field('#mybool'), '', '', '1') then

'yes'

else

'no'

fi

else

'no series'

fi

Zoals boven gezegd, een if geeft een waarde. Dat betekent dat al de volgenden equivalent zĳn:

* program: if field('series') then 'foo' else 'bar' fi

* program: if field('series') then a = 'foo' else a = 'bar' fi; a

* program: a = if field('series') then 'foo' else 'bar' fi; a

For example, this program returns the value of the series column if the book has a series, otherwise the value of the
title column:

program: field(if field('series') then 'series' else 'title' fi)

For expressies
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The for expression iterates over a list of values, processing them one at a time. The list_expression must evaluate
either to a metadata field lookup name e.g., tags or #genre, or to a list of values. The range (pagina 203) generates a
list of numbers. If the result is a valid lookup name then the field’s value is fetched and the separator specified for that
field type is used. If the result isn’t a valid lookup name then it is assumed to be a list of values. The list is assumed to be
separated by commas unless the optional keyword separator is supplied, in which case the list values must be separated
by the result of evaluating the separator_expr. A separator cannot be used if the list is generated by range(). Each
value in the list is assigned to the specified variable then the expression_list is evaluated. You can use break to
jump out of the loop, and continue to jump to the beginning of the loop for the next iteration.
Voorbeeld: Deze sjabloon verwĳdert de eerste hiërarchische naam voor elke waarde in Genre (#genre), een lĳst opbou-
wend met de nieuwe namen:

program:

new_tags = '';

for i in '#genre':

j = re(i, '^.*?\.(.*)$', '\1');

new_tags = list_union(new_tags, j, ',')

rof;

new_tags

Als het originele Genre History.Military, Science Fiction.Alternate History, ReadMe is dan geeft de sjabloon Military,
Alternate History, ReadMe terug. U kan deze sjabloon gebruiken in calibre’s Metadata bewerken in bulk  →  Zoeken &
vervangen met Zoeken naar ingesteld op template om het eerste niveau van de hiërarchie te verwĳderen en de resulte-
rende waarde aan Genre toe te wĳzen.
Merk op: de laatste regel in de sjabloon, new_tags, is niet strikt nodig in dit geval omdat for de waarde van de laatste
top_expression terug geeft in de expressie lĳst. De waarde van een opdracht is de waarde van zĳn expressie, dus de waarde
van het for bericht is wat was toegewezen aan new_tags.
Function definition
If you have repeated code in a template then you can put that code into a local function. The def keyword starts the
definition. It is followed by the function name, the argument list, then the code in the function. The function definition
ends with the fed keyword.
Arguments are positional. When a function is called the supplied arguments are matched left to right against the defined
parameters, with the value of the argument assigned to the parameter. It is an error to provide more arguments than defined
parameters. Parameters can have default values, such as a = 25. If an argument is not supplied for that parameter then
the default value is used, otherwise the parameter is set to the empty string.
The return statement can be used in a local function.
A function must be defined before it can be used.
Example: This template computes an approximate duration in years, months, and days from a number of days. The
function to_plural() formats the computed values. Note that the example also uses the & operator:

program:

days = 2112;

years = floor(days/360);

months = floor(mod(days, 360)/30);

days = days - ((years*360) + (months * 30));

def to_plural(v, str):

if v == 0 then return '' fi;

return v & ' ' & (if v == 1 then str else str & 's' fi) & ' '

fed;

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)

to_plural(years, 'year') & to_plural(months, 'month') & to_plural(days,'day')

Relationele operatoren
Relational operators return '1' if the comparison is true, otherwise the empty string ('').
Er zĳn twee soorten relationele operatoren: string vergelĳkingen en numerieke vergelĳkingen.
String comparisons do case-insensitive string comparison using lexical order. The supported string comparison operators
are ==, !=, <, <=, >, >=, in, inlist, and inlist_field. For the in, inlist, and inlist_field operators, the
result of the left hand expression is interpreted as a regular expression pattern. They are true if the value of left-hand
regular expression matches the value of the right hand expression. The regular expressions are case-insensitive.
The inlist operator is true if the left hand regular expression matches any one of the items in the right hand list where
the items in the list are separated by commas. The inlist_field operator is true if the left hand regular expression
matches any of the items in the field (column) named by the right hand expression, using the separator defined for the
field. NB: the inlist_field operator requires the right hand expression to evaluate to a field name, while the inlist
operator requires the right hand expression to evaluate to a string containing a comma-separated list. Because of this
difference, inlist_field is substantially faster than inlist because no string conversions or list constructions are
done.
De numerieke vergelĳkingsoperatoren zĳn ==#, !=#, <#, <=#, >#, >=#. De links en rechts expressies moeten evalueren
naar numerieke waarden met twee uitzonderingen: zowel de string waarde “None” (niet gedefinieerd veld) en de lege
string evalueren naar de waarde nul.
Voorbeelden:

• program: field('series') == 'foo' returns '1' if the book’s series is foo, otherwise ''.
• program: 'f.o' in field('series') geeft '1' terug als het boek z’n serie overeenkomt met de reguliere

expressie f.o (bv., foo, Off Onyx, enz.), anders ''.
• program: 'science' inlist $#genre returns '1' if any of the values retrieved from the book’s genres

match the regular expression science, e.g., Science, History of Science, Science Fiction etc., otherwise ''.
• program: '^science$' inlist $#genre returns '1' if any of the book’s genres exactly match the regular

expression ^science$, e.g., Science, otherwise ''. The genres History of Science and Science Fiction don’t match.
• program: 'asimov' inlist $authors returns '1' if any author matches the regular expression asimov,

e.g., Asimov, Isaac or Isaac Asimov, otherwise ''.
• program: 'asimov' inlist_field 'authors' returns '1' if any author matches the regular expression
asimov, e.g., Asimov, Isaac or Isaac Asimov, otherwise ''.

• program: 'asimov$' inlist_field 'authors' returns '1' if any author matches the regular expression
asimov$, e.g., Isaac Asimov, otherwise ''. It doesn’t match Asimov, Isaac because of the $ anchor in the regular
expression.

• program: if field('series') != 'foo' then 'bar' else 'mumble' fi returns 'bar' if the
book’s series is not foo. Otherwise it returns 'mumble'.

• program: if field('series') == 'foo' || field('series') == '1632' then 'yes' else

'no' fi returns 'yes' if series is either foo or 1632, otherwise 'no'.
• program: if '^(foo|1632)$' in field('series') then 'yes' else 'no' fi returns 'yes' if

series is either foo or 1632, otherwise 'no'.
• program: if 11 > 2 then 'yes' else 'no' fi geeft 'no' omdat de > operator een lexicale vergelĳking

doet.
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• program: if 11 ># 2 then 'yes' else 'no' fi geeft 'yes' terug omdat de ># operator een numerieke
vergelĳking doet.

Functions in General Program Mode
See Sjabloon functie referenties (pagina 182) for the list of functions built into the template language.
Aantekeningen:

• As opposed to Single Function Mode (pagina 165), in General Program Mode you must specify the first parameter
value.

• All parameters are expression_lists (see the grammar above).

10.3.7 Meer complexe programma’s in sjabloonexpressies - Sjabloon Programma
Modus

Sjabloon ProgrammaModus (SPM) is een mengeling van Algemene ProgrammaModus (pagina 168) en Eén Functie Modus
(pagina 165). TPM verschilt van Eén Functie Modus in dat het toelaat sjabloon expressies te schrĳven die verwĳzen naar
andere metadata velden, geneste functies gebruikt, variabelen wĳzigt, en rekenkunde doet. Het verschilt van Algemene
Programma Modus in dat de sjabloon gevat wordt tussen { en } karakters en niet begint met het woord program:. Het
programma deel van de sjabloon is een Algemene Programma Modus expressie lĳst.
Example: assume you want a template to show the series for a book if it has one, otherwise show the value of a custom
field #genre. You cannot do this in the Single Function Mode (pagina 165) because you cannot make reference to another
metadata field within a template expression. In TPM you can, as the following expression demonstrates:

{series:'ifempty($, $#genre)'}

Het voorbeeld toont meerdere dingen:
• TPM is used if the expression begins with :' and ends with '}. Anything else is assumed to be in Single Function

Mode (pagina 165).
If the template contains a prefix and suffix, the expression ends with '| where the | is the delimiter for the prefix.
Example:

{series:'ifempty($, $#genre)'|prefix | suffix}

• Functions must be given all their arguments. For example, the standard built-in functions must be given the initial
parameter value.

• The variable $ is usable as the value argument and stands for the value of the field named in the template, series
in this case.

• spaties worden genegeerd en kunnen eender waar in de expressie gebruikt worden
• constante strings zĳn omringd door overeenkomende aanhalingstekens, ofwel ' ofwel ".

In TPM, using { and } characters in string literals can lead to errors or unexpected results because they confuse the
template processor. It tries to treat them as template expression boundaries, not characters. In some but not all cases you
can replace a { with [[ and a } with ]]. Advice: if your program contains { and } characters then you should use General
Program Mode.

10.3.8 Python Template Mode
Python Template Mode (PTM) lets you write templates using native Python and the calibre API80. The database API
will be of most use; further discussion is beyond the scope of this manual. PTM templates are faster and can do more
complicated operations but you must know how to write code in Python using the calibre API.

80 https://manual.calibre-ebook.com/develop.html#api-documentation-for-various-parts-of-calibre
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A PTM template begins with:

python:

def evaluate(book, context):

# book is a calibre metadata object

# context is an instance of calibre.utils.formatter.PythonTemplateContext,

# which currently contains the following attributes:

# db: a calibre legacy database object.

# globals: the template global variable dictionary.

# arguments: is a list of arguments if the template is called by a GPM template,␣

↪→otherwise None.

# funcs: used to call Built-in/User functions and Stored GPM/Python templates.

# Example: context.funcs.list_re_group()

# your Python code goes here

return 'a string'

You can add the above text to your template using the context menu, usually accessed with a right click. The comments
are not significant and can be removed. You must use python indenting.
The context object supports str(context) that returns a string of the context’s contents, and context.attributes

that returns a list of the attribute names in the context.
The context.funcs attribute allows calling Built-in and User template functions, and Stored GPM/Python templates,
so that you can execute them directly in your code. The functions are retrieved using their names. If the name conflicts
with a Python keyword, add an underscore to the end of the name. Examples:

context.funcs.list_re_group()

context.funcs.assert_()

Here is an example of a PTM template that produces a list of all the authors for a series. The list is stored in a Column built
from other columns, behaves like tags. It shows in Book details and has the on separate lines checked (in Preferences → Look
& feel → Book details). That option requires the list to be comma-separated. To satisfy that requirement the template
converts commas in author names to semicolons then builds a comma-separated list of authors. The authors are then
sorted, which is why the template uses author_sort.

python:

def evaluate(book, context):

if book.series is None:

return ''

db = context.db.new_api

ans = set()

# Get the list of books in the series

ids = db.search(f'series:"={book.series}"', '')

if ids:

# Get all the author_sort values for the books in the series

author_sorts = (v for v in db.all_field_for('author_sort', ids).values())

# Add the names to the result set, removing duplicates

for aus in author_sorts:

ans.update(v.strip() for v in aus.split('&'))

# Make a sorted comma-separated string from the result set

return ', '.join(v.replace(',', ';') for v in sorted(ans))

The output in Book details looks like this:
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10.3.9 Templates and URLs
You can use templates to construct URLs. Two cases are described here:

• Custom column Book details search URLs
• The calibre URL scheme

Custom column book details search URLs
When you create a custom column you can provide a URL to be used in Book details using a template. For example, if
you have a custom column for Translators you can define a URL to take you to a site for translators. Book details search
URLs can be provided for Text, Enumerated, Series, and Column built from other column column types.
When an item with a search template is clicked in Book details the template is evaluated. It is provided the normal book
metadata. It is also provided three additional fields:

• item_value: the value of the clicked item.
• item_value_quoted: the value of clicked item, URL-encoded. Special characters are escaped to make them

valid in URLs and spaces are replaced by '+' (plus) signs.
• item_value_no_plus: the value of clicked item, URL-encoded. Special characters are escaped to make them

valid in URLs and spaces are replaced by the %20, not plus.
There are several ways to construct the URL. The following use Wikipedia as an example.
The simplest is a basic template:

https://en.wikipedia.org/w/index.php?search={item_value_encoded}

In some cases you might want to do more processing. There are four template functions you can use, depending on the
complexity of the processing.
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• make_url (pagina 209)(path, [query_name, query_value]+) – this function is the easiest way to construct
a query URL. It uses a path, the web site and page you want to query, and query_name, query_value pairs
from which the query is built. In general, the query_value must be URL-encoded. With this function it is always
encoded and spaces are always replaced with '+' signs.

• make_url_extended (pagina 210)(...) – this function is similar to make_url() (pagina 209) but gives you more
control over the URL components. The components of a URL are
scheme:://authority/path?query string.
See Uniform Resource Locator81 on Wikipedia for more detail.
The function has two variants:

make_url_extended(scheme, authority, path, [query_name, query_value]+)

and

make_url_extended(scheme, authority, path, query_string)

• query_string (pagina 211)([query_name, query_value, how_to_encode]+)– returns a URL query string
constructed from the query_name, query_value, how_to_encode triads. A query string is a series of items
where each item looks like query_name=query_value where query_value is URL-encoded as instructed.
The query items are separated by '&' (ampersand) characters.

• encode_for_url (pagina 209)(value, use_plus) – returns the value encoded for use in a URL as specified by
use_plus. The value is first URL-encoded. Next, if use_plus is 0 then spaces are replaced by '+' (plus) signs.
If it is 1 then spaces are replaced by %20.

For example, assume you have a custom column Translators (#translators) where the names are Last name, First
name. You might need to convert the name to First name Last name when creating the URL. You can use the make_url
(pagina 209) function to do this:

program: make_url('https://en.wikipedia.org/w/index.php', 'search', swap_around_comma(

↪→$item_value))

If we assume that the translator’s name is Boy-Żeleński, Tadeusz then the above template produces the link:

https://en.wikipedia.org/w/index.php?search=Tadeusz+Boy-%C5%BBele%C5%84ski

Note that the person’s first name is now first, the space is now a plus, and that the non-English characters in the last name
are URL-encoded.
The functions make_url_extended (pagina 210), query_string (pagina 211), and encode_for_url (pagina 209) might be
useful depending upon any additional processing complexity.
The calibre URL scheme
Calibre supports several different URLs to navigate your calibre libraries. This section shows how to use templates to
construct some of the URLs. See Het calibre:// URL schema (pagina 253) for details on the URLs available.

• Switch to a specific library. The syntax of this URL is:

calibre://switch-library/Library_Name

Library_Name must be replaced with the name of the calibre library you wish to open. The library name is shown
in the title bar of the window. It is a simple name, not the file path to the library. You must spell it as shown in the
title bar, including letter case. The character _ (underscore) stands for the current library. If the name contains any
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spaces or special characters then it must be hex encoded using the to_hex (pagina 211) function, as in the following
example:

program: strcat('calibre://switch-library/_hex_-', to_hex(current_library_name()))

The template generates the URL:

calibre://switch-library/_hex_-4c6962726172792e746573745f736d616c6c

You can replace the current_library_name() function with the actual name of the library, as in:

program: strcat('calibre://switch-library/_hex_-', to_hex('Library.test_small'))

• Links to show books. These links select a book in the calibre library. The syntax for this URL is:

calibre://show-book/Library_Name/book_id

The book id is the numeric calibre id for the book, available to templates as $id. As above, the library name
might need to be hex encoded. Here is an example:

program: strcat('calibre://show-book/_hex_-', to_hex(current_library_name()), '/',

↪→ $id)

It produces the URL:

calibre://show-book/_hex_-4c6962726172792e746573745f736d616c6c/1353

• Searching for books. These links search for books in the specified calibre library. The syntax for this URL is:

calibre://search/Library_Name?q=query

calibre://search/Library_Name?eq=hex_encoded_query

where query is any valid calibre search expression. You must hex encode any query containing spaces or speci-
al characters, which generally means all of them. For example, the calibre search expression for searching for a
hierarchical tag beginning with ‘AA’ is tags:"=.AA". This template constructs a search URL for that expression:

program: strcat('calibre://search/_hex_-', to_hex(current_library_name()), '?eq=',

↪→ to_hex('tags:"=.AA"'))

The resulting URL is:

calibre://search/_hex_-4c6962726172792e746573745f736d616c6c?

↪→eq=746167733a223d2e414122

Here is an example of the same URL built using the :ref:ff_make_url_extended function instead of strcat
(pagina 208):

program: make_url_extended('calibre', '', 'search/_hex_-' & to_hex(current_

↪→library_name()),

'eq', to_hex('tags:"=.AA"'))

• Open a book details window on a book in some library. The syntax for this URL is:

calibre://book-details/Library_Name/book_id

An example template is:
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program: strcat('calibre://book-details/_hex_-', to_hex(current_library_name()),

↪→'/', $id)

which produces the URL:

calibre://book-details/_hex_-4c6962726172792e746573745f736d616c6c/1353

• Open the notes associated with an author/series/etc. The syntax of the URL is:

calibre://book-details/Library_Name/Field_Name/id_Item_Id

calibre://book-details/Library_Name/Field_Name/hex_Hex_Encoded_Item_Name

Field_Name is the lookup name of the field. If the field is a custom column then replace the # character with
an underscore (_). Item_Id is the internal numeric ID of the value in the field. There isn’t a template function
that returns the Item_Id, so templates will normally use the second form, Hex_Encoded_Item_Name. Here is a
sample template that opens the note for the person Boy-Żeleński, Tadeusz in the field #authtest:

program: strcat('calibre://show-note/_hex_-', to_hex(current_library_name()),

'/_authtest/hex_', to_hex('Boy-Żeleński, Tadeusz'))

which produces the URL:

calibre://show-note/_hex_-4c6962726172792e746573745f736d616c6c/_authtest/hex_

↪→426f792dc5bb656c65c584736b692c205461646575737a

10.3.10 Opgeslagen sjablonen
Both General Program Mode (pagina 168) and Python Template Mode (pagina 173) support saving templates and
calling those templates from another template, much like calling stored functions. You save templates using Preferen-
ces → Advanced → Template functions. More information is provided in that dialog. You call a template the same way
you call a function, passing positional arguments if desired. An argument can be any expression. Examples of calling a
template, assuming the stored template is named foo:

• foo() – roep de sjabloon aan zonder argumenten door te geven.
• foo(a, b) roep de sjabloon aan met doorgeven van de waardes van de twee variabelen a en b.
• foo(if field('series') then field('series_index') else 0 fi) – als het boek een series

heeft, passeer de series_index, anders de waarde 0.
In GPM you retrieve the arguments passed in the call to the stored template using the arguments function. It both declares
and initializes local variables, effectively parameters. The variables are positional; they get the value of the parameter given
in the call in the same position. If the corresponding parameter is not provided in the call then arguments assigns that
variable the provided default value. If there is no default value then the variable is set to the empty string. For example,
the following arguments function declares 2 variables, key, alternate:

arguments(key, alternate='series')

Voorbeelden, er weer vanuit gaand dat de opgeslagen sjabloon foo heet:
• foo('#myseries') – argument key krĳgt de waarde 'myseries' toegewezen en het argument alternate

krĳgt de standaard waarde 'series' toegewezen.
• foo('series', '#genre') de variabele key krĳgt de waarde 'series' toegewezen en de variabele alter-
nate de waarde '#genre'.

• foo() – de variabele key krĳgt de lege string toegewezen en de variabele alternate de waarde 'series'.
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In PTM the arguments are passed in the arguments parameter, which is a list of strings. There isn’t any way to specify
default values. You must check the length of the arguments list to be sure that the number of arguments is what you
expect.
An easy way to test stored templates is using the Template tester dialog. For ease of access give it a keyboard shortcut
in Preferences → Advanced → Keyboard shortcuts → Template tester. Giving the Stored templates dialog a shortcut
will help switching more rapidly between the tester and editing the stored template’s source code.

10.3.11 Bijkomende informatie voor sjablonen voorzien
A developer can choose to pass additional information to the template processor, such as application-specific book met-
adata or information about what the processor is being asked to do. A template can access this information and use it
during the evaluation.
Ontwikkelaar: hoe bĳkomende informatie doorgeven
The additional information is a Python dictionary containing pairs variable_name: variable_value where the
values must be strings. The template can access the dictionary, creating template local variables named variable_name
containing the value variable_value. The user cannot change the name so it is best to use names that won’t collide
with other template local variables, for example by prefixing the name with an underscore.
This dictionary is passed to the template processor (the formatter) using the named parameter glo-

bal_vars=your_dict. The full method signature is:

def safe_format(self, fmt, kwargs, error_value, book,

column_name=None, template_cache=None,

strip_results=True, template_functions=None,

global_vars={})

Sjabloon schrĳver: hoe toegang krĳgen tot de bĳkomende informatie
You access the additional information (the globals dictionary) in a template using the template function:

globals(id[=expression] [, id[=expression]]*)

where id is any legal variable name. This function checks whether the additional information provided by the developer
contains the name. If it does then the function assigns the provided value to a template local variable with that name. If
the name is not in the additional information and if an expression is provided, the expression is evaluated and the
result is assigned to the local variable. If neither a value nor an expression is provided, the function assigns the empty
string ('') to the local variable.
A template can set a value in the globals dictionary using the template function:

set_globals(id[=expression] [, id[=expression]]*)

This function sets the globals dictionary key:value pair id:value where value is the value of the template local
variable id. If that local variable doesn’t exist then value is set to the result of evaluating expression.

10.3.12 Notes on the difference between modes
The three program modes, Single Function Mode (pagina 165) (SFM), Template Program Mode (pagina 173) (TPM),
and General Program Mode (pagina 168) (GPM), work differently. SFM is intended to be ‘simple’ so it hides a lot of
programming language bits.
Verschillen:

• In SFM the value of the column is always passed as an ‘invisible’ first argument to a function included in the
template.
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• SFM doesn’t support the difference between variables and strings; all values are strings.
• The following SFM template returns either the series name or the string “no series”:

{series:ifempty(no series)}

De soortgelĳke sjabloon in SPM is:

{series:'ifempty($, 'no series')'}

De soortgelĳke sjabloon in APM is:

program: ifempty(field('series'), 'no series')

The first argument to ifempty is the value of the field series. The second argument is the string no series.
In SFM the first argument, the value of the field, is automatically passed (the invisible argument).

• Several template functions, for example booksize() and current_library_name(), take no arguments. Be-
cause of the ‘invisible argument’ you cannot use these functions in SFM.

• Nested functions, where a function calls another function to compute an argument, cannot be used in SFM. For
example this template, intended to return the first 5 characters of the series value uppercased, won’t work in SFM:

{series:uppercase(substr(0,5))}

• TPM and GPM support nested functions. The above template in TPM would be:

{series:'uppercase(substr($, 0,5))'}

In GPM it would be:

program: uppercase(substr(field('series'), 0,5))

• As noted in the above Template ProgramMode (pagina 173) section, using { and } characters in TPM string literals
can lead to errors or unexpected results because they confuse the template processor. It tries to treat them as template
boundaries, not characters. In some but not all cases you can replace a { with [[ and a } with ]]. Generally, if your
program contains { and } characters then you should use General Program Mode.

10.3.13 User-defined Python template functions
You can add your own Python functions to the template processor. Such functions can be used in any of the three template
programming modes. The functions are added by going to Preferences  →  Advanced  →  Template functions. Instructions
are shown in that dialog. Note that you can use Python Templates for a similar purpose. As calling user-defined functions
is faster than calling a Python template, user-defined functions might be more efficient depending on the complexity of
what the function or template does.

10.3.14 Special notes for using templates in different contexts
In the GUI (Columns made from other columns and Template searches):

• GPM templates work as before.
• Python templates have full access to the calibre database.

In icon rules:
• icon rule templates have no book data so field-based functions such as format_date_field (pagina 193),

list_count_field (pagina 201), and check_yes_no (pagina 207) won’t work.
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In the Content server:
• Templates have access to the new API but not the old API (LibraryDatabase).
• Because of the above, the following formatter functions are not guaranteed to work in GPM templates (composite

columns, icon rules, etc) and should be avoided if you use the content server:
– connected_device_name (pagina 196)
– connected_device_uuid (pagina 196)
– current_virtual_library_name (pagina 196)
– is_marked (pagina 198)
– virtual_libraries (pagina 199)

10.3.15 Extra opmerkingen voor opslaan/versturen van sjablonen
Special processing is applied when a template is used in a Save to disk or Send to device template. The values of the fields
are cleaned, replacing characters that are special to file systems with underscores, including slashes. This means that field
text cannot be used to create folders. However, slashes are not changed in prefix or suffix strings, so slashes in these strings
will cause folders to be created. Because of this, you can create variable-depth folder structure.
For example, assume we want the folder structure series/series_index - title, with the caveat that if series does not exist,
then the title should be in the top folder. The template to do this is:

{series:||/}{series_index:|| - }{title}

The slash and the hyphen appear only if series is not empty.
The lookup function lets us do even fancier processing. For example, assume that if a book has a series, then we want
the folder structure series/series index - title.fmt. If the book does not have a series then we want the folder structure
genre/author_sort/title.fmt. If the book has no genre then we want to use ‘Unknown’. We want two completely different
paths, depending on the value of series.
Om dit te bereiken:

1. Create a composite field (give it lookup name #aa) containing {series}/{series_index} - {title}. If the
series is not empty, then this template will produce series/series_index - title.

2. Create a composite field (give it lookup name #bb) containing {#genre:ifempty(Unknown)}/

{author_sort}/{title}. This template produces genre/author_sort/title, where an empty genre is replaced
with Unknown.

3. Set the save template to {series:lookup(.,#aa,#bb)}. This template chooses composite field #aa if series
is not empty and composite field #bb if series is empty. We therefore have two completely different save paths,
depending on whether or not series is empty.

10.3.16 Tips
• Use the Template Tester to test templates. Add the tester to the context menu for books in the library and/or give

it a keyboard shortcut.
• Templates can use other templates by referencing composite columns built with the desired template. Alternatively,

you can use Stored Templates.
• In a plugboard, you can set a field to empty (or whatever is equivalent to empty) by using the special template {}.

This template will always evaluate to an empty string.
• The technique described above to show numbers even if they have a zero value works with the standard field

series_index.
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10.3.17 Sjabloon functie referenties
Reference for all built-in template language functions
Here, we document all the built-in functions available in the calibre template language. Every function is implemented as
a class in python and you can click the source links to see the source code, in case the documentation is insufficient. The
functions are arranged in logical groups by type.

• Arithmetic (pagina 186)
– add (pagina 186)
– ceiling (pagina 186)
– divide (pagina 186)
– floor (pagina 186)
– fractional_part (pagina 186)
– mod (pagina 186)
– multiply (pagina 186)
– round (pagina 186)
– subtract (pagina 187)

• Boolean (pagina 187)
– and (pagina 187)
– not (pagina 187)
– or (pagina 187)

• Case changes (pagina 187)
– capitalize (pagina 187)
– lowercase (pagina 187)
– titlecase (pagina 187)
– uppercase (pagina 188)

• Database functions (pagina 188)
– book_count (pagina 188)
– book_values (pagina 188)
– extra_file_modtime (pagina 189)
– extra_file_names (pagina 189)
– extra_file_size (pagina 189)
– get_link (pagina 189)
– get_note (pagina 190)
– has_extra_files (pagina 190)
– has_note (pagina 190)

• Date functions (pagina 191)
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– date_arithmetic (pagina 191)
– days_between (pagina 191)
– today (pagina 191)

• Formatting values (pagina 191)
– finish_formatting (pagina 191)
– format_date (pagina 192)
– format_date_field (pagina 193)
– format_duration (pagina 193)
– format_number (pagina 194)
– human_readable (pagina 194)
– rating_to_stars (pagina 194)

• Get values from metadata (pagina 195)
– annotation_count (pagina 195)
– approximate_formats (pagina 195)
– author_links (pagina 195)
– author_sorts (pagina 195)
– booksize (pagina 195)
– connected_device_name (pagina 196)
– connected_device_uuid (pagina 196)
– current_library_name (pagina 196)
– current_library_path (pagina 196)
– current_virtual_library_name (pagina 196)
– field (pagina 196)
– formats_modtimes (pagina 196)
– formats_path_segments (pagina 197)
– formats_paths (pagina 197)
– formats_sizes (pagina 197)
– has_cover (pagina 198)
– is_marked (pagina 198)
– language_codes (pagina 198)
– language_strings (pagina 198)
– ondevice (pagina 198)
– raw_field (pagina 198)
– raw_list (pagina 198)
– series_sort (pagina 199)
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– user_categories (pagina 199)
– virtual_libraries (pagina 199)

• Iterate over values (pagina 199)
– first_non_empty (pagina 199)
– lookup (pagina 199)
– switch (pagina 199)
– switch_if (pagina 199)

• List lookup (pagina 200)
– identifier_in_list (pagina 200)
– list_contains (pagina 200)
– list_item (pagina 200)
– select (pagina 200)
– str_in_list (pagina 200)

• List manipulation (pagina 201)
– list_count (pagina 201)
– list_count_field (pagina 201)
– list_count_matching (pagina 201)
– list_difference (pagina 201)
– list_equals (pagina 201)
– list_intersection (pagina 201)
– list_join (pagina 202)
– list_re (pagina 202)
– list_re_group (pagina 202)
– list_remove_duplicates (pagina 202)
– list_sort (pagina 203)
– list_split (pagina 203)
– list_union (pagina 203)
– range (pagina 203)
– subitems (pagina 204)
– sublist (pagina 204)

• Overige (pagina 204)
– arguments (pagina 204)
– assign (pagina 205)
– globals (pagina 205)
– is_dark_mode (pagina 205)
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– print (pagina 205)
– set_globals (pagina 205)

• Recursion (pagina 205)
– eval (pagina 205)
– template (pagina 206)

• Relational (pagina 206)
– cmp (pagina 206)
– first_matching_cmp (pagina 206)
– strcmp (pagina 206)
– strcmpcase (pagina 206)

• String manipulation (pagina 207)
– character (pagina 207)
– check_yes_no (pagina 207)
– contains (pagina 207)
– field_exists (pagina 207)
– ifempty (pagina 207)
– re (pagina 207)
– re_group (pagina 208)
– shorten (pagina 208)
– strcat (pagina 208)
– strcat_max (pagina 208)
– strlen (pagina 208)
– substr (pagina 208)
– swap_around_articles (pagina 209)
– swap_around_comma (pagina 209)
– test (pagina 209)
– transliterate (pagina 209)

• URL functions (pagina 209)
– encode_for_url (pagina 209)
– make_url (pagina 209)
– make_url_extended (pagina 210)
– query_string (pagina 211)
– to_hex (pagina 211)
– urls_from_identifiers (pagina 211)

• API of the Metadata objects (pagina 212)
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Arithmetic

add

class calibre.utils.formatter_functions.BuiltinAdd

add(x [, y]*) – returns the sum of its arguments. Throws an exception if an argument is not a number. In most cases
you can use the + operator instead of this function.

ceiling

class calibre.utils.formatter_functions.BuiltinCeiling

ceiling(value) – returns the smallest integer greater than or equal to value. Throws an exception if value is not a
number.

divide

class calibre.utils.formatter_functions.BuiltinDivide

divide(x, y) – returns x / y. Throws an exception if either x or y are not numbers. This function can usually be
replaced by the / operator.

floor

class calibre.utils.formatter_functions.BuiltinFloor

floor(value) – returns the largest integer less than or equal to value. Throws an exception if value is not a number.

fractional_part

class calibre.utils.formatter_functions.BuiltinFractionalPart

fractional_part(value) – returns the part of the value after the decimal point. For example,
fractional_part(3.14) returns 0.14. Throws an exception if value is not a number.

mod

class calibre.utils.formatter_functions.BuiltinMod

mod(value, y) – returns the floor of the remainder of value / y. Throws an exception if either value or y is not
a number.

multiply

class calibre.utils.formatter_functions.BuiltinMultiply

multiply(x [, y]*) – returns the product of its arguments. Throws an exception if any argument is not a number.
This function can usually be replaced by the * operator.

round

class calibre.utils.formatter_functions.BuiltinRound

round(value) – returns the nearest integer to value. Throws an exception if value is not a number.
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subtract

class calibre.utils.formatter_functions.BuiltinSubtract

subtract(x, y) – returns x - y. Throws an exception if either x or y are not numbers. This function can usually be
replaced by the - operator.

Boolean

and

class calibre.utils.formatter_functions.BuiltinAnd

and(value [, value]*) – returns the string '1' if all values are not empty, otherwise returns the empty string.
You can have as many values as you want. In most cases you can use the && operator instead of this function. One
reason not to replace and() with && is when short-circuiting can change the results because of side effects. For example,
and(a='',b=5) will always do both assignments, where the && operator won’t do the second.

not

class calibre.utils.formatter_functions.BuiltinNot

not(value) – returns the string '1' if the value is empty, otherwise returns the empty string. This function can usually
be replaced with the unary not (!) operator.

or

class calibre.utils.formatter_functions.BuiltinOr

or(value [, value]*) – returns the string '1' if any value is not empty, otherwise returns the empty string. You
can have as many values as you want. This function can usually be replaced by the || operator. A reason it cannot be
replaced is if short-circuiting will change the results because of side effects.

Case changes

capitalize

class calibre.utils.formatter_functions.BuiltinCapitalize

capitalize(value) – returns the value with the first letter in upper case and the rest lower case.

lowercase

class calibre.utils.formatter_functions.BuiltinLowercase

lowercase(value) – returns the value in lower case.

titlecase

class calibre.utils.formatter_functions.BuiltinTitlecase

titlecase(value) – returns the value in title case.
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uppercase

class calibre.utils.formatter_functions.BuiltinUppercase

uppercase(value) – returns the value in upper case.

Database functions

book_count

class calibre.utils.formatter_functions.BuiltinBookCount

book_count(query, use_vl) – returns the count of books found by searching for query. If use_vl is 0 (zero)
then virtual libraries are ignored. This function and its companion book_values() are particularly useful in template
searches, supporting searches that combine information from many books such as looking for series with only one book. It
cannot be used in composite columns unless the tweak allow_template_database_functions_in_composites

is set to True. It can be used only in the GUI.
For example this template search uses this function and its companion to find all series with only one book:

• Define a stored template (using Preferences → Advanced → Template functions) named series_only_one_book
(the name is arbitrary). The template is:

program:

vals = globals(vals='');

if !vals then

all_series = book_values('series', 'series:true', ',', 0);

for series in all_series:

if book_count('series:="' & series & '"', 0) == 1 then

vals = list_join(',', vals, ',', series, ',')

fi

rof;

set_globals(vals)

fi;

str_in_list(vals, ',', $series, 1, '')

The first time the template runs (the first book checked) it stores the results of the database lookups in a global
template variable named vals. These results are used to check subsequent books without redoing the lookups.

• Use the stored template in a template search:

template:"program: series_only_one_book()#@#:n:1"

Using a stored template instead of putting the template into the search eliminates problems caused by the
requirement to escape quotes in search expressions.

This function can be used only in the GUI and the content server.

book_values

class calibre.utils.formatter_functions.BuiltinBookValues

book_values(column, query, sep, use_vl) – returns a list of the unique values contained in the column column
(a lookup name), separated by sep, in the books found by searching for query. If use_vl is 0 (zero) then virtual libraries
are ignored. This function and its companion book_count() are particularly useful in template searches, supporting
searches that combine information from many books such as looking for series with only one book. It cannot be used
in composite columns unless the tweak allow_template_database_functions_in_composites is set to True.
This function can be used only in the GUI and the content server.
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extra_file_modtime

class calibre.utils.formatter_functions.BuiltinExtraFileModtime

extra_file_modtime(file_name, format_string) – returns the modification time of the extra file file_name
in the book’s data/ folder if it exists, otherwise -1. The modtime is formatted according to format_string (see
format_date() (pagina 192) for details). If format_string is the empty string, returns the modtime as the floating point
number of seconds since the epoch. See also the functions has_extra_files() (pagina 190), extra_file_names() (pagina 189)
and extra_file_size() (pagina 189). The epoch is OS dependent. This function can be used only in the GUI and the content
server.

extra_file_names

class calibre.utils.formatter_functions.BuiltinExtraFileNames

extra_file_names(sep [, pattern]) – returns a sep-separated list of extra files in the book’s data/ folder. If
the optional parameter pattern, a regular expression, is supplied then the list is filtered to files that match pattern. The
pattern match is case insensitive. See also the functions has_extra_files() (pagina 190), extra_file_modtime() (pagina 189)
and extra_file_size() (pagina 189). This function can be used only in the GUI and the content server.

extra_file_size

class calibre.utils.formatter_functions.BuiltinExtraFileSize

extra_file_size(file_name) – returns the size in bytes of the extra file file_name in the book’s data/ folder
if it exists, otherwise -1. See also the functions has_extra_files() (pagina 190), extra_file_names() (pagina 189) and
extra_file_modtime() (pagina 189). This function can be used only in the GUI and the content server.

get_link

class calibre.utils.formatter_functions.BuiltinGetLink

get_link(field_name, field_value) – fetch the link for field field_name with value field_value. If there
is no attached link, return the empty string. Examples:

• The following returns the link attached to the tag Fiction:

get_link('tags', 'Fiction')

• This template makes a list of the links for all the tags associated with a book in the form value:link, ...:

program:

ans = '';

for t in $tags:

l = get_link('tags', t);

if l then

ans = list_join(', ', ans, ',', t & ':' & get_link('tags', t), ',')

fi

rof;

ans

This function works only in the GUI and the content server.
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get_note

class calibre.utils.formatter_functions.BuiltinGetNote

get_note(field_name, field_value, plain_text) – fetch the note for field field_name with value
field_value. If plain_text is empty, return the note’s HTML including images. If plain_text is 1 (or '1'),
return the note’s plain text. If the note doesn’t exist, return the empty string in both cases. Example:

• Return the HTML of the note attached to the tag Fiction:

program:

get_note('tags', 'Fiction', '')

• Return the plain text of the note attached to the author Isaac Asimov:

program:

get_note('authors', 'Isaac Asimov', 1)

This function works only in the GUI and the content server.

has_extra_files

class calibre.utils.formatter_functions.BuiltinHasExtraFiles

has_extra_files([pattern]) – returns the count of extra files, otherwise ‘’ (the empty string). If the optional
parameter pattern (a regular expression) is supplied then the list is filtered to files that match pattern before the files
are counted. The pattern match is case insensitive. See also the functions extra_file_names() (pagina 189), extra_file_size()
(pagina 189) and extra_file_modtime() (pagina 189). This function can be used only in the GUI and the content server.

has_note

class calibre.utils.formatter_functions.BuiltinHasNote

has_note(field_name, field_value). Check if a field has a note. This function has two variants:
• if field_value is not '' (the empty string) return '1' if the value field_value in the field field_name has

a note, otherwise ''.
Example: has_note('tags', 'Fiction') returns '1' if the tag fiction has an attached note, otherwise
''.

• If field_value is '' then return a list of values in field_name that have a note. If no item in the field has a
note, return ''. This variant is useful for showing column icons if any value in the field has a note, rather than a
specific value.
Example: has_note('authors', '') returns a list of authors that have notes, or '' if no author has a note.

You can test if all the values in field_name have a note by comparing the list length of this function’s return value
against the list length of the values in field_name. Example:

list_count(has_note('authors', ''), '&') ==# list_count_field('authors')

This function works only in the GUI and the content server.
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Date functions

date_arithmetic

class calibre.utils.formatter_functions.BuiltinDateArithmetic

date_arithmetic(value, calc_spec, fmt) – Calculate a new date from value using calc_spec. Return the
new date formatted according to optional fmt: if not supplied then the result will be in ISO format. The calc_spec is
a string formed by concatenating pairs of vW (valueWhat) where v is a possibly-negative number and W is one of the
following letters:

• s: add v seconds to date

• m: add v minutes to date

• h: add v hours to date

• d: add v days to date

• w: add v weeks to date

• y: add v years to date, where a year is 365 days.
Example: '1s3d-1m' will add 1 second, add 3 days, and subtract 1 minute from date.

days_between

class calibre.utils.formatter_functions.BuiltinDaysBetween

days_between(date1, date2) – return the number of days between date1 and date2. The number is positive if
date1 is greater than date2, otherwise negative. If either date1 or date2 are not dates, the function returns the empty
string.

today

class calibre.utils.formatter_functions.BuiltinToday

today() – return a date+time string for today (now). This value is designed for use in format_date or days_between,
but can be manipulated like any other string. The date is in ISO82 date/time format.

Formatting values

finish_formatting

class calibre.utils.formatter_functions.BuiltinFinishFormatting

finish_formatting(value, format, prefix, suffix) – apply the format, prefix, and suffix to the
value in the same way as done in a template like {series_index:05.2f| - |- }. This function is provided to
ease conversion of complex single-function- or template-program-mode templates to GPM Templates. For example, the
following program produces the same output as the above template:

program: finish_formatting(field("series_index"), "05.2f", " - ", " - ")

Another example: for the template:

{series:re(([^\s])[^\s]+(\s|$),\1)}{series_index:0>2s| - | - }{title}

use:
82 https://en.wikipedia.org/wiki/ISO_8601
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program:

strcat(

re(field('series'), '([^\s])[^\s]+(\s|$)', '\1'),

finish_formatting(field('series_index'), '0>2s', ' - ', ' - '),

field('title')

)

format_date

class calibre.utils.formatter_functions.BuiltinFormatDate

format_date(value, format_string) – format the value, which must be a date string, using the for-

mat_string, returning a string. It is best if the date is in ISO format as using other date formats often causes errors
because the actual date value cannot be unambiguously determined. Note that the format_date_field() function is
both faster and more reliable.
The formatting codes are:

• d : the day as number without a leading zero (1 to 31)
• dd : the day as number with a leading zero (01 to 31)
• ddd : the abbreviated localized day name (e.g. “Mon” to “Sun”)
• dddd : the long localized day name (e.g. “Monday” to “Sunday”)
• M : the month as number without a leading zero (1 to 12)
• MM : the month as number with a leading zero (01 to 12)
• MMM : the abbreviated localized month name (e.g. “Jan” to “Dec”)
• MMMM : the long localized month name (e.g. “January” to “December”)
• yy : the year as two digit number (00 to 99)
• yyyy : the year as four digit number.
• h : the hours without a leading 0 (0 to 11 or 0 to 23, depending on am/pm)
• hh : the hours with a leading 0 (00 to 11 or 00 to 23, depending on am/pm)
• m : the minutes without a leading 0 (0 to 59)
• mm : the minutes with a leading 0 (00 to 59)
• s : the seconds without a leading 0 (0 to 59)
• ss : the seconds with a leading 0 (00 to 59)
• ap : use a 12-hour clock instead of a 24-hour clock, with ‘ap’ replaced by the lowercase localized string for am or

pm
• AP : use a 12-hour clock instead of a 24-hour clock, with ‘AP’ replaced by the uppercase localized string for AM

or PM
• aP : use a 12-hour clock instead of a 24-hour clock, with ‘aP’ replaced by the localized string for AM or PM
• Ap : use a 12-hour clock instead of a 24-hour clock, with ‘Ap’ replaced by the localized string for AM or PM
• iso : the date with time and timezone. Must be the only format present
• to_number : convert the date & time into a floating point number (a timestamp)
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• from_number : convert a floating point number (a timestamp) into an ISO-formatted date. If you want a different
date format then add the desired formatting string after from_number and a colon (:). Example:

format_date(val, 'from_number:MMM dd yyyy')

You might get unexpected results if the date you are formatting contains localized month names, which can happen if you
changed the date format to contain MMMM. Using format_date_field() avoids this problem.

format_date_field

class calibre.utils.formatter_functions.BuiltinFormatDateField

format_date_field(field_name, format_string) – format the value in the field field_name, which must be
the lookup name of a date field, either standard or custom. See format_date() (pagina 192) for the formatting codes. This
function is much faster than format_date() and should be used when you are formatting the value in a field (column). It is
also more reliable because it works directly on the underlying date. It can’t be used for computed dates or dates in string
variables. Examples:

format_date_field('pubdate', 'yyyy.MM.dd')

format_date_field('#date_read', 'MMM dd, yyyy')

format_duration

class calibre.utils.formatter_functions.BuiltinFormatDuration

format_duration(value, template, [largest_unit]) – format the value, a number of seconds, into a string
showing weeks, days, hours, minutes, and seconds. If the value is a float then it is rounded to the nearest integer. You
choose how to format the value using a template consisting of value selectors surrounded by [ and ] characters. The
selectors are:

• [w]: weeks
• [d]: days
• [h]: hours
• [m]: minutes
• [s]: seconds

You can put arbitrary text between selectors.
The following examples use a duration of 2 days (172,800 seconds) 1 hour (3,600 seconds) and 20 seconds, which totals
to 176,420 seconds.

• format_duration(176420, '[d][h][m][s]') will return the value 2d 1h 0m 20s.
• format_duration(176420, '[h][m][s]') will return the value 49h 0m 20s.
• format_duration(176420, 'Your reading time is [d][h][m][s]') returns the value Your reading

time is 49h 0m 20s.
• format_duration(176420, '[w][d][h][m][s]') will return the value 2d 1h 0m 20s. Note that the zero

weeks value is not returned.
If you want to see zero values for items such as weeks in the above example, use an uppercase selector. For example, the
following uses 'W' to show zero weeks:
format_duration(176420, '[W][d][h][m][s]') returns 0w 2d 1h 0m 20s.
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By default the text following a value is the selector followed by a space. You can change that to whatever text you want.
The format for a selector with your text is the selector followed by a colon followed by text segments separated by '|'

characters. You must include any space characters you want in the output.
You can provide from one to three text segments.

• If you provide one segment, as in [w: weeks ] then that segment is used for all values.
• If you provide two segments, as in [w: weeks | week ] then the first segment is used for 0 and more than 1.

The second segment is used for 1.
• If you provide three segments, as in [w: weeks | week | weeks ] then the first segment is used for 0, the

second segment is used for 1, and the third segment is used for more than 1.
The second form is equivalent to the third form in many languages.
For example, the selector:

• [w: weeks | week | weeks ] produces '0 weeks ', '1 week ', or '2 weeks '.
• [w: weeks | week ] produces '0 weeks ', '1 week ', or '2 weeks '.
• [w: weeks ] produces 0 weeks ', 1 weeks ', or 2 weeks '.

The optional largest_unit parameter specifies the largest of weeks, days, hours, minutes, and seconds that will be
produced by the template. It must be one of the value selectors. This can be useful to truncate a value.
format_duration(176420, '[h][m][s]', 'd') will return the value 1h 0m 20s instead of 49h 0m 20s.

format_number

class calibre.utils.formatter_functions.BuiltinFormatNumber

format_number(value, template) – interprets the value as a number and formats that number using a Python
formatting template such as {0:5.2f} or {0:,d} or ${0:5,.2f}. The formatting template must begin with {0: and
end with } as in the above examples. Exception: you can leave off the leading “{0:” and trailing “}” if the format template
contains only a format. See the Template Language83 and the Python84 documentation for more examples. Returns the
empty string if formatting fails.

human_readable

class calibre.utils.formatter_functions.BuiltinHumanReadable

human_readable(value) – expects the value to be a number and returns a string representing that number in KB,
MB, GB, etc.

rating_to_stars

class calibre.utils.formatter_functions.BuiltinRatingToStars

rating_to_stars(value, use_half_stars) – Returns the value as string of star (★) characters. The value must
be a number between 0 and 5. Set use_half_stars to 1 if you want half star characters for fractional numbers available
with custom ratings columns.

83 https://manual.calibre-ebook.com/template_lang.html
84 https://docs.python.org/3/library/string.html#formatstrings
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Get values from metadata

annotation_count

class calibre.utils.formatter_functions.BuiltinAnnotationCount

annotation_count() – return the total number of annotations of all types attached to the current book. This function
works only in the GUI and the content server.

approximate_formats

class calibre.utils.formatter_functions.BuiltinApproximateFormats

approximate_formats() – return a comma-separated list of formats associated with the book. Because the list comes
from calibre’s database instead of the file system, there is no guarantee that the list is correct, although it probably is. Note
that resulting format names are always uppercase, as in EPUB. The approximate_formats() function is much faster
than the formats_... functions.
This function works only in the GUI. If you want to use these values in save-to-disk or send-to-device templates then
you must make a custom “Column built from other columns”, use the function in that column’s template, and use that
column’s value in your save/send templates.

author_links

class calibre.utils.formatter_functions.BuiltinAuthorLinks

author_links(val_separator, pair_separator) – returns a string containing a list of authors and those authors’
link values in the form: author1 val_separator author1_link pair_separator author2 val_separator

author2_link etc.
An author is separated from its link value by the val_separator string with no added spaces. Assuming the
val_separator is a colon, author:link value pairs are separated by the pair_separator string argument with
no added spaces. It is up to you to choose separators that do not occur in author names or links. An author is included
even if the author link is empty.

author_sorts

class calibre.utils.formatter_functions.BuiltinAuthorSorts

author_sorts(val_separator) – returns a string containing a list of author’s sort values for the authors of the book.
The sort is the one in the author metadata information, which can be different from the author_sort in books. The returned
list has the form author sort 1 val_separator author sort 2 etc. with no added spaces. The author sort values
in this list are in the same order as the authors of the book. If you want spaces around val_separator then include
them in the val_separator string.

booksize

class calibre.utils.formatter_functions.BuiltinBooksize

booksize() – returns the value of the calibre size field. Returns ‘’ if the book has no formats.
This function works only in the GUI. If you want to use this value in save-to-disk or send-to-device templates then you
must make a custom “Column built from other columns”, use the function in that column’s template, and use that column’s
value in your save/send templates
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connected_device_name

class calibre.utils.formatter_functions.BuiltinConnectedDeviceName

connected_device_name(storage_location_key) – if a device is connected then return the device name, other-
wise return the empty string. Each storage location on a device has its own device name. The storage_location_key
names are 'main', 'carda' and 'cardb'. This function works only in the GUI.

connected_device_uuid

class calibre.utils.formatter_functions.BuiltinConnectedDeviceUUID

connected_device_uuid(storage_location_key) – if a device is connected then return the device uuid (uni-
que id), otherwise return the empty string. Each storage location on a device has a different uuid. The stora-

ge_location_key location names are 'main', 'carda' and 'cardb'. This function works only in the GUI.

current_library_name

class calibre.utils.formatter_functions.BuiltinCurrentLibraryName

current_library_name() – return the last name on the path to the current calibre library.

current_library_path

class calibre.utils.formatter_functions.BuiltinCurrentLibraryPath

current_library_path() – return the full path to the current calibre library.

current_virtual_library_name

class calibre.utils.formatter_functions.BuiltinCurrentVirtualLibraryName

current_virtual_library_name() – return the name of the current virtual library if there is one, otherwise the
empty string. Library name case is preserved. Example:

program: current_virtual_library_name()

This function works only in the GUI.

field

class calibre.utils.formatter_functions.BuiltinField

field(lookup_name) – returns the value of the metadata field with lookup name lookup_name. The $ prefix can be
used instead of the function, as in $tags.

formats_modtimes

class calibre.utils.formatter_functions.BuiltinFormatsModtimes

formats_modtimes(date_format_string) – return a comma-separated list of colon-separated items FMT:DATE
representing modification times for the formats of a book. The date_format_string parameter specifies how the date
is to be formatted. See the format_date() (pagina 192) function for details. You can use the select() (pagina 200) function
to get the modification time for a specific format. Note that format names are always uppercase, as in EPUB.
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formats_path_segments

class calibre.utils.formatter_functions.BuiltinFormatsPathSegments

formats_path_segments(with_author, with_title, with_format, with_ext, sep) – return parts of
the path to a book format in the calibre library separated by sep. The parameter sep should usually be a slash ('/'). One
use is to be sure that paths generated in Save to disk and Send to device templates are shortened consistently. Another is
to be sure the paths on the device match the paths in the calibre library.
A book path consists of 3 segments: the author, the title including the calibre database id in parentheses, and the format
(author - title). Calibre can shorten any of the three because of file name length limitations. You choose which segments
to include by passing 1 for that segment. If you don’t want a segment then pass 0 or the empty string for that segment.
For example, the following returns just the format name without the extension:

formats_path_segments(0, 0, 1, 0, '/')

Because there is only one segment the separator is ignored.
If there are multiple formats (multiple extensions) then one of the extensions will be picked at random. If you care about
which extension is used then get the path without the extension then add the desired extension to it.
Examples: Assume there is a book in the calibre library with an epub format by Joe Blogs with title ‘Help’. It would have
the path

Joe Blogs/Help - (calibre_id)/Help - Joe Blogs.epub

The following shows what is returned for various parameters:
• formats_path_segments(0, 0, 1, 0, '/') returns Help - Joe Blogs

• formats_path_segments(0, 0, 1, 1, '/') returns Help - Joe Blogs.epub

• formats_path_segments(1, 0, 1, 1, '/') returns Joe Blogs/Help - Joe Blogs.epub

• formats_path_segments(1, 0, 1, 0, '/') returns Joe Blogs/Help - Joe Blogs

• formats_path_segments(0, 1, 0, 0, '/') returns Help - (calibre_id)

formats_paths

class calibre.utils.formatter_functions.BuiltinFormatsPaths

formats_paths([separator]) – return a separator-separated list of colon-separated items FMT:PATH giving the
full path to the formats of a book. The separator argument is optional. If not supplied then the separator is ', '

(comma space). If the separator is a comma then you can use the select() function to get the path for a specific format.
Note that format names are always uppercase, as in EPUB.

formats_sizes

class calibre.utils.formatter_functions.BuiltinFormatsSizes

formats_sizes() – return a comma-separated list of colon-separated FMT:SIZE items giving the sizes of the formats
of a book in bytes. You can use the select() function to get the size for a specific format. Note that format names are
always uppercase, as in EPUB.
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has_cover

class calibre.utils.formatter_functions.BuiltinHasCover

has_cover() – return 'Yes' if the book has a cover, otherwise the empty string.

is_marked

class calibre.utils.formatter_functions.BuiltinIsMarked

is_marked() – check whether the book is marked in calibre. If it is then return the value of the mark, either 'true'
(lower case) or a comma-separated list of named marks. Returns '' (the empty string) if the book is not marked. This
function works only in the GUI.

language_codes

class calibre.utils.formatter_functions.BuiltinLanguageCodes

language_codes(lang_strings) – return the language codes85 for the language names passed in lang_strings.
The strings must be in the language of the current locale. lang_strings is a comma-separated list.

language_strings

class calibre.utils.formatter_functions.BuiltinLanguageStrings

language_strings(value, localize) – return the language names for the language codes (see here for names and
codes86) passed in value. Example: {languages:language_strings()}. If localize is zero, return the strings
in English. If localize is not zero, return the strings in the language of the current locale. lang_codes is a comma-
separated list.

ondevice

class calibre.utils.formatter_functions.BuiltinOndevice

ondevice() – return the string 'Yes' if ondevice is set, otherwise return the empty string. This function works only in
the GUI. If you want to use this value in save-to-disk or send-to-device templates then you must make a custom “Column
built from other columns”, use the function in that column’s template, and use that column’s value in your save/send
templates.

raw_field

class calibre.utils.formatter_functions.BuiltinRawField

raw_field(lookup_name [, optional_default]) – returns the metadata field named by lookup_namewithout
applying any formatting. It evaluates and returns the optional second argument optional_default if the field’s value
is undefined (None). The $$ prefix can be used instead of the function, as in $$pubdate.

raw_list

class calibre.utils.formatter_functions.BuiltinRawList

raw_list(lookup_name, separator) – returns the metadata list named by lookup_name without applying any
formatting or sorting, with the items separated by separator.

85 https://www.loc.gov/standards/iso639-2/php/code_list.php
86 https://www.loc.gov/standards/iso639-2/php/code_list.php
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series_sort

class calibre.utils.formatter_functions.BuiltinSeriesSort

series_sort() – returns the series sort value.

user_categories

class calibre.utils.formatter_functions.BuiltinUserCategories

user_categories() – return a comma-separated list of the user categories that contain this book. This function works
only in the GUI. If you want to use these values in save-to-disk or send-to-device templates then you must make a custom
Column built from other columns, use the function in that column’s template, and use that column’s value in your save/send
templates

virtual_libraries

class calibre.utils.formatter_functions.BuiltinVirtualLibraries

virtual_libraries() – return a comma-separated list of Virtual libraries that contain this book. This function works
only in the GUI. If you want to use these values in save-to-disk or send-to-device templates then you must make a custom
“Column built from other columns”, use the function in that column’s template, and use that column’s value in your
save/send templates.

Iterate over values

first_non_empty

class calibre.utils.formatter_functions.BuiltinFirstNonEmpty

first_non_empty(value [, value]*) – returns the first value that is not empty. If all values are empty, then the
empty string is returned. You can have as many values as you want.

lookup

class calibre.utils.formatter_functions.BuiltinLookup

lookup(value, [ pattern, key, ]* else_key) – The patterns will be checked against the value in order. If a
pattern matches then the value of the field named by key is returned. If no pattern matches then the value of the field
named by else_key is returned. See also the switch() (pagina 199) function.

switch

class calibre.utils.formatter_functions.BuiltinSwitch

switch(value, [patternN, valueN,]+ else_value) – for each patternN, valueN pair, checks if the
value matches the regular expression patternN and if so returns the associated valueN. If no patternN matches,
then else_value is returned. You can have as many patternN, valueN pairs as you wish. The first match is returned.

switch_if

class calibre.utils.formatter_functions.BuiltinSwitchIf

switch_if([test_expression, value_expression,]+ else_expression) – for each test_expression,
value_expression pair, checks if test_expression is True (non-empty) and if so returns the result of va-

lue_expression. If no test_expression is True then the result of else_expression is returned. You can have
as many test_expression, value_expression pairs as you want.
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List lookup

identifier_in_list

class calibre.utils.formatter_functions.BuiltinIdentifierInList

identifier_in_list(val, id_name [, found_val, not_found_val]) – treat val as a list of identifiers
separated by commas. An identifier has the format id_name:value. The id_name parameter is the id_name text to
search for, either id_name or id_name:regexp. The first case matches if there is any identifier matching that id_name.
The second case matches if id_name matches an identifier and the regexp matches the identifier’s value. If found_val
and not_found_val are provided then if there is a match then return found_val, otherwise return not_found_val.
If found_val and not_found_val are not provided then if there is a match then return the identifier:value pair,
otherwise the empty string ('').

list_contains

class calibre.utils.formatter_functions.BuiltinInList

list_contains(value, separator, [ pattern, found_val, ]* not_found_val) – interpret the value
as a list of items separated by separator, checking the pattern against each item in the list. If the patternmatches an
item then return found_val, otherwise return not_found_val. The pair pattern and found_value can be repeated
as many times as desired, permitting returning different values depending on the item’s value. The patterns are checked
in order, and the first match is returned.
Aliases: in_list(), list_contains()

list_item

class calibre.utils.formatter_functions.BuiltinListitem

list_item(value, index, separator) – interpret the value as a list of items separated by separator, returning
the ‘index’th item. The first item is number zero. The last item has the index -1 as in list_item(-1,separator). If
the item is not in the list, then the empty string is returned. The separator has the same meaning as in the count function,
usually comma but is ampersand for author-like lists.

select

class calibre.utils.formatter_functions.BuiltinSelect

select(value, key) – interpret the value as a comma-separated list of items with each item having the form
id:id_value (the calibre identifier format). The function finds the first pair with the id equal to key and returns
the corresponding id_value. If no id matches then the function returns the empty string.

str_in_list

class calibre.utils.formatter_functions.BuiltinStrInList

str_in_list(value, separator, [ string, found_val, ]+ not_found_val) – interpret the value as a
list of items separated by separator then compare string against each value in the list. The string is not a regular
expression. If string is equal to any item (ignoring case) then return the corresponding found_val. If string contains
separators then it is also treated as a list and each subvalue is checked. The string and found_value pairs can be
repeated as many times as desired, permitting returning different values depending on string’s value. If none of the strings
match then not_found_value is returned. The strings are checked in order. The first match is returned.
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List manipulation

list_count

class calibre.utils.formatter_functions.BuiltinCount

list_count(value, separator) – interprets the value as a list of items separated by separator and returns the
number of items in the list. Most lists use a comma as the separator, but authors uses an ampersand (&).
Examples: {tags:list_count(,)}, {authors:list_count(&)}.
Aliases: count(), list_count()

list_count_field

class calibre.utils.formatter_functions.BuiltinFieldListCount

list_count_field(lookup_name)– returns the count of items in the field with the lookup name lookup_name.
The field must be multi-valued such as authors or tags, otherwise the function raises an error. This function is much
faster than list_count() because it operates directly on calibre data without converting it to a string first. Example:
list_count_field('tags').

list_count_matching

class calibre.utils.formatter_functions.BuiltinListCountMatching

list_count_matching(value, pattern, separator) – interprets value as a list of items separated by sepa-
rator, returning the number of items in the list that match the regular expression pattern.
Aliases: list_count_matching(), count_matching()

list_difference

class calibre.utils.formatter_functions.BuiltinListDifference

list_difference(list1, list2, separator) – return a list made by removing from list1 any item found
in list2 using a case-insensitive comparison. The items in list1 and list2 are separated by separator, as are the
items in the returned list.

list_equals

class calibre.utils.formatter_functions.BuiltinListEquals

list_equals(list1, sep1, list2, sep2, yes_val, no_val) – return yes_val if list1 and list2 contain
the same items, otherwise return no_val. The items are determined by splitting each list using the appropriate separator
character (sep1 or sep2). The order of items in the lists is not relevant. The comparison is case-insensitive.

list_intersection

class calibre.utils.formatter_functions.BuiltinListIntersection

list_intersection(list1, list2, separator) – return a list made by removing from list1 any item not
found in list2, using a case-insensitive comparison. The items in list1 and list2 are separated by separator, as
are the items in the returned list.
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list_join

class calibre.utils.formatter_functions.BuiltinListJoin

list_join(with_separator, list1, separator1 [, list2, separator2]*) – return a list made by
joining the items in the source lists (list1 etc) using with_separator between the items in the result list. Items in
each source list[123...] are separated by the associated separator[123...]. A list can contain zero values. It can
be a field like publisher that is single-valued, effectively a one-item list. Duplicates are removed using a case-insensitive
comparison. Items are returned in the order they appear in the source lists. If items on lists differ only in letter case then
the last is used. All separators can be more than one character.
Example:

program:

list_join('#@#', $authors, '&', $tags, ',')

You can use list_join on the results of previous calls to list_join as follows:

program:

a = list_join('#@#', $authors, '&', $tags, ',');

b = list_join('#@#', a, '#@#', $#genre, ',', $#people, '&', 'some value', ',')

You can use expressions to generate a list. For example, assume you want items for authors and #genre, but with the
genre changed to the word “Genre: “ followed by the first letter of the genre, i.e. the genre “Fiction” becomes “Genre: F”.
The following will do that:

program:

list_join('#@#', $authors, '&', list_re($#genre, ',', '^(.).*$', 'Genre: \1'), ',

↪→')

list_re

class calibre.utils.formatter_functions.BuiltinListRe

list_re(src_list, separator, include_re, opt_replace) – Construct a list by first separating src_list
into items using the separator character. For each item in the list, check if it matches include_re. If it does then add
it to the list to be returned. If opt_replace is not the empty string then apply the replacement before adding the item
to the returned list.

list_re_group

class calibre.utils.formatter_functions.BuiltinListReGroup

list_re_group(src_list, separator, include_re, search_re [,template_for_group]*) – Like
list_re except replacements are not optional. It uses re_group(item, search_re, template ...) when doing the
replacements.

list_remove_duplicates

class calibre.utils.formatter_functions.BuiltinListRemoveDuplicates

list_remove_duplicates(list, separator) – return a list made by removing duplicate items in list. If items
differ only in case then the last is returned. The items in list are separated by separator, as are the items in the
returned list.
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list_sort

class calibre.utils.formatter_functions.BuiltinListSort

list_sort(value, direction, separator) – return value sorted using a case-insensitive lexical sort. If di-
rection is zero (number or character), value is sorted ascending, otherwise descending. The list items are separated
by separator, as are the items in the returned list.

list_split

class calibre.utils.formatter_functions.BuiltinListSplit

list_split(list_val, sep, id_prefix) – splits list_val into separate values using sep, then assigns the
values to local variables named id_prefix_N where N is the position of the value in the list. The first item has position
0 (zero). The function returns the last element in the list.
Example:

list_split('one:two:foo', ':', 'var')

is equivalent to:

var_0 = 'one'

var_1 = 'two'

var_2 = 'foo'

list_union

class calibre.utils.formatter_functions.BuiltinListUnion

list_union(list1, list2, separator) – return a list made by merging the items in list1 and list2, removing
duplicate items using a case-insensitive comparison. If items differ in case, the one in list1 is used. The items in list1
and list2 are separated by separator, as are the items in the returned list. Aliases: merge_lists(), list_union()

range

class calibre.utils.formatter_functions.BuiltinRange

range(start, stop, step, limit) – returns a list of numbers generated by looping over the range specified by the
parameters start, stop, and step, with a maximum length of limit. The first value produced is ‘start’. Subsequent
values next_v = current_v + step. The loop continues while next_v < stop assuming step is positive, otherwise
while next_v > stop. An empty list is produced if start fails the test: start >= stop if step is positive. The limit
sets the maximum length of the list and has a default of 1000. The parameters start, step, and limit are optional.
Calling range() with one argument specifies stop. Two arguments specify start and stop. Three arguments specify
start, stop, and step. Four arguments specify start, stop, step and limit.
Examples:

range(5) -> '0, 1, 2, 3, 4'

range(0, 5) -> '0, 1, 2, 3, 4'

range(-1, 5) -> '-1, 0, 1, 2, 3, 4'

range(1, 5) -> '1, 2, 3, 4'

range(1, 5, 2) -> '1, 3'

range(1, 5, 2, 5) -> '1, 3'

range(1, 5, 2, 1) -> error(limit exceeded)
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subitems

class calibre.utils.formatter_functions.BuiltinSubitems

subitems(value, start_index, end_index) – This function breaks apart lists of tag-like hierarchical items such
as genres. It interprets the value as a comma- separated list of tag-like items, where each item is a period-separated list.
It returns a new list made by extracting from each item the components from start_index to end_index, then merging
the results back together. Duplicates are removed. The first subitem in a period-separated list has an index of zero. If an
index is negative then it counts from the end of the list. As a special case, an end_index of zero is assumed to be the
length of the list.
Examples:

• Assuming a #genre column containing “A.B.C”:
– {#genre:subitems(0,1)} returns “A”
– {#genre:subitems(0,2)} returns “A.B”
– {#genre:subitems(1,0)} returns “B.C”

• Assuming a #genre column containing “A.B.C, D.E”:
– {#genre:subitems(0,1)} returns “A, D”
– {#genre:subitems(0,2)} returns “A.B, D.E”

sublist

class calibre.utils.formatter_functions.BuiltinSublist

sublist(value, start_index, end_index, separator) – interpret the value as a list of items separated
by separator, returning a new list made from the items from start_index to end_index. The first item is number
zero. If an index is negative, then it counts from the end of the list. As a special case, an end_index of zero is assumed to
be the length of the list.
Examples assuming that the tags column (which is comma-separated) contains “A, B, C”:

• {tags:sublist(0,1,\,)} returns “A”
• {tags:sublist(-1,0,\,)} returns “C”
• {tags:sublist(0,-1,\,)} returns “A, B”

Overige

arguments

class calibre.utils.formatter_functions.BuiltinArguments

arguments(id[=expression] [, id[=expression]]*) – Used in a stored template to retrieve the arguments
passed in the call. It both declares and initializes local variables with the supplied names, the id``s, making them

effectively parameters. The variables are positional; they get the value of the argument

given in the call in the same position. If the corresponding argument is not provided in

the call then ``arguments() assigns that variable the provided default value. If there is no default value then the
variable is set to the empty string.
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assign

class calibre.utils.formatter_functions.BuiltinAssign

assign(id, value) – assigns value to id, then returns value. id must be an identifier, not an expression. In most
cases you can use the = operator instead of this function.

globals

class calibre.utils.formatter_functions.BuiltinGlobals

globals(id[=expression] [, id[=expression]]*) – Retrieves “global variables” that can be passed into the
formatter. The name id is the name of the global variable. It both declares and initializes local variables with the names
of the global variables passed in (the id parameters. If the corresponding variable is not provided in the globals then it
assigns that variable the provided default value. If there is no default value then the variable is set to the empty string.)

is_dark_mode

class calibre.utils.formatter_functions.BuiltinIsDarkMode

is_dark_mode() – returns '1' if calibre is running in dark mode, '' (the empty string) otherwise. This function can
be used in advanced color and icon rules to choose different colors/icons according to the mode. Example:

if is_dark_mode() then 'dark.png' else 'light.png' fi

print

class calibre.utils.formatter_functions.BuiltinPrint

print(a [, b]*) – prints the arguments to standard output. Unless you start calibre from the command line
(calibre-debug -g), the output will go into a black hole. The print function always returns its first argument.

set_globals

class calibre.utils.formatter_functions.BuiltinSetGlobals

set_globals(id[=expression] [, id[=expression]]*) – Sets globalvariables that can be passed into the
formatter. The globals are given the name of the id passed in. The value of the id is used unless an expression is
provided.

Recursion

eval

class calibre.utils.formatter_functions.BuiltinEval

eval(string) – evaluates the string as a program, passing the local variables. This permits using the template pro-
cessor to construct complex results from local variables. In Template Program Mode87, because the { and } characters
are interpreted before the template is evaluated you must use [[ for the { character and ]] for the } character. They
are converted automatically. Note also that prefixes and suffixes (the |prefix|suffix syntax) cannot be used in the
argument to this function when using Template Program Mode.

87 https://manual.calibre-ebook.com/template_lang.html#more-complex-programs-in-template-expressions-template-program-mode
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template

class calibre.utils.formatter_functions.BuiltinTemplate

template(x) – evaluates x as a template. The evaluation is done in its own context, meaning that variables are not shared
between the caller and the template evaluation. If not using General Program Mode, because the { and } characters are
special, you must use [[ for the { character and ]] for the } character; they are converted automatically. For example,
template(\'[[title_sort]]\') will evaluate the template {title_sort} and return its value. Note also that
prefixes and suffixes (the |prefix|suffix syntax) cannot be used in the argument to this function when using template
program mode.

Relational

cmp

class calibre.utils.formatter_functions.BuiltinCmp

cmp(value, y, lt, eq, gt) – compares value and y after converting both to numbers. Returns lt if value <#

y, eq if value ==# y, otherwise gt. This function can usually be replaced with one of the numeric compare operators
(==#, <#, >#, etc).

first_matching_cmp

class calibre.utils.formatter_functions.BuiltinFirstMatchingCmp

first_matching_cmp(val, [ cmp, result, ]* else_result) – compares val < cmp in sequence, returning
the associated result for the first comparison that succeeds. Returns else_result if no comparison succeeds.
Example:

i = 10;

first_matching_cmp(i,5,"small",10,"middle",15,"large","giant")

returns "large". The same example with a first value of 16 returns "giant".

strcmp

class calibre.utils.formatter_functions.BuiltinStrcmp

strcmp(x, y, lt, eq, gt) – does a case-insensitive lexical comparison of x and y. Returns lt if x < y, eq if x
== y, otherwise gt. This function can often be replaced by one of the lexical comparison operators (==, >, <, etc.)

strcmpcase

class calibre.utils.formatter_functions.BuiltinStrcmpcase

strcmpcase(x, y, lt, eq, gt) – does a case-sensitive lexical comparison of x and y. Returns lt if x < y, eq if
x == y, otherwise gt.
Note: This is NOT the default behavior used by calibre, for example, in the lexical comparison operators (==, >, <, etc.).
This function could cause unexpected results, preferably use strcmp() whenever possible.
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String manipulation

character

class calibre.utils.formatter_functions.BuiltinCharacter

character(character_name) – returns the character named by character_name. For example, charac-

ter('newline') returns a newline character ('\n'). The supported character names are newline, return, tab,
and backslash. This function is used to put these characters into the output of templates.

check_yes_no

class calibre.utils.formatter_functions.BuiltinCheckYesNo

check_yes_no(field_name, is_undefined, is_false, is_true) – checks if the value of the yes/no field
named by the lookup name field_name is one of the values specified by the parameters, returning 'Yes' if a match
is found otherwise returning the empty string. Set the parameter is_undefined, is_false, or is_true to 1 (the
number) to check that condition, otherwise set it to 0.
Example: check_yes_no("#bool", 1, 0, 1) returns 'Yes' if the yes/no field #bool is either True or undefined
(neither True nor False).
More than one of is_undefined, is_false, or is_true can be set to 1.

contains

class calibre.utils.formatter_functions.BuiltinContains

contains(value, pattern, text_if_match, text_if_not_match) – checks if the value is matched
by the regular expression pattern. Returns text_if_match if the pattern matches the value, otherwise returns
text_if_not_match.

field_exists

class calibre.utils.formatter_functions.BuiltinFieldExists

field_exists(lookup_name) – checks if a field (column) with the lookup name lookup_name exists, returning
'1' if so and the empty string if not.

ifempty

class calibre.utils.formatter_functions.BuiltinIfempty

ifempty(value, text_if_empty) – if the value is not empty then return that value, otherwise return
text_if_empty.

re

class calibre.utils.formatter_functions.BuiltinRe

re(value, pattern, replacement) – return the value after applying the regular expression. All instances of
pattern in the value are replaced with replacement. The template language uses case insensitive Python regular
expressions88.

88 https://docs.python.org/3/library/re.html
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re_group

class calibre.utils.formatter_functions.BuiltinReGroup

re_group(value, pattern [, template_for_group]*) – return a string made by applying the regular expres-
sion pattern to value and replacing each matched instance with the value returned by the corresponding template. In
Template Program Mode89, like for the template and the eval functions, you use [[ for { and ]] for }.
The following example looks for a series with more than one word and uppercases the first word:

program: re_group(field('series'), "(\S* )(.*)", "{$:uppercase()}", "{$}")'}

shorten

class calibre.utils.formatter_functions.BuiltinShorten

shorten(value, left_chars, middle_text, right_chars) – Return a shortened version of the value,
consisting of left_chars characters from the beginning of the value, followed by middle_text, followed by
right_chars characters from the end of the value. left_chars and right_chars must be non-negative integers.
Example: assume you want to display the title with a length of at most 15 characters in length. One template that does this
is {title:shorten(9,-,5)}. For a book with the title Ancient English Laws inthe Times of Ivanhoe the result will be
Ancient E-anhoe: the first 9 characters of the title, a -, then the last 5 characters. If the value’s length is less than left

chars + right chars + the length of middle text then the value will be returned unchanged. For example, the title
TheDome would not be changed.

strcat

class calibre.utils.formatter_functions.BuiltinStrcat

strcat(a [, b]*) – returns a string formed by concatenating all the arguments. Can take any number of arguments.
In most cases you can use the & operator instead of this function.

strcat_max

class calibre.utils.formatter_functions.BuiltinStrcatMax

strcat_max(max, string1 [, prefix2, string2]*) – Returns a string formed by concatenating the arguments.
The returned value is initialized to string1. Strings made from prefix, string pairs are added to the end of the
value as long as the resulting string length is less than max. Prefixes can be empty. Returns string1 even if string1 is
longer than max. You can pass as many prefix, string pairs as you wish.

strlen

class calibre.utils.formatter_functions.BuiltinStrlen

strlen(value) – Returns the length of the string value.

substr

class calibre.utils.formatter_functions.BuiltinSubstr

substr(value, start, end) – returns the start’th through the end’th characters of value. The first character
in value is the zero’th character. If end is negative then it indicates that many characters counting from the right.
If end is zero, then it indicates the last character. For example, substr('12345', 1, 0) returns '2345', and
substr('12345', 1, -1) returns '234'.

89 https://manual.calibre-ebook.com/template_lang.html#more-complex-programs-in-template-expressions-template-program-mode
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swap_around_articles

class calibre.utils.formatter_functions.BuiltinSwapAroundArticles

swap_around_articles(value, separator) – returns the value with articles moved to the end, separated by a
semicolon. The value can be a list, in which case each item in the list is processed. If the value is a list then you must
provide the separator. If no separator is provided or the separator is the empty string then the value is treated as
being a single value, not a list. The articles are those used by calibre to generate the title_sort.

swap_around_comma

class calibre.utils.formatter_functions.BuiltinSwapAroundComma

swap_around_comma(value) – given a value of the form B, A, return A B. This is most useful for converting names
in LN, FN format to FN LN. If there is no comma in the value then the function returns the value unchanged.

test

class calibre.utils.formatter_functions.BuiltinTest

test(value, text_if_not_empty, text_if_empty) – return text_if_not_empty if the value is not empty,
otherwise return text_if_empty.

transliterate

class calibre.utils.formatter_functions.BuiltinTransliterate

transliterate(value) – Return a string in a latin alphabet formed by approximating the sound of the words in
value. For example, if value is Фёдор Миха́йлович Достоевский this function returns Fiodor Mikhailovich

Dostoievskii.

URL functions

encode_for_url

class calibre.utils.formatter_functions.BuiltinEncodeForURL

encode_for_url(value, use_plus) – returns the value encoded for use in a URL as specified by use_plus.
The value is first URL-encoded. Next, if use_plus is 0 then spaces are replaced by '+' (plus) signs. If it is 1 then spaces
are replaced by %20.
If you do not want the value to be encoding but to have spaces replaced then use the re() (pagina 207) function, as in
re($series, ' ', '%20')

See also the functions make_url() (pagina 209), make_url_extended() (pagina 210) and query_string() (pagina 211).

make_url

class calibre.utils.formatter_functions.BuiltinMakeUrl

make_url(path, [query_name, query_value]+) – this function is the easiest way to construct a query URL. It
uses a path, the web site and page you want to query, and query_name, query_value pairs from which the query is
built. In general, the query_value must be URL-encoded. With this function it is always encoded and spaces are always
replaced with '+' signs.
At least one query_name, query_value pair must be provided.
Example: constructing a Wikipedia search URL for the author Niccolò Machiavelli:
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make_url('https://en.wikipedia.org/w/index.php', 'search', 'Niccolò Machiavelli')

returns

https://en.wikipedia.org/w/index.php?search=Niccol%C3%B2+Machiavelli

If you are writing a custom column book details URL template then use $item_name or field('item_name') to
obtain the value of the field that was clicked on. Example: if Niccolò Machiavelli was clicked then you can construct the
URL using:

make_url('https://en.wikipedia.org/w/index.php', 'search', $item_name)

See also the functions make_url_extended() (pagina 210), query_string() (pagina 211) and encode_for_url() (pagina 209).

make_url_extended

class calibre.utils.formatter_functions.BuiltinMakeUrlExtended

make_url_extended(...) – this function is similar to make_url() (pagina 209) but gives you more control over the
URL components. The components of a URL are
scheme:://authority/path?query string.
See Uniform Resource Locator90 on Wikipedia for more detail.
The function has two variants:

make_url_extended(scheme, authority, path, [query_name, query_value]+)

and

make_url_extended(scheme, authority, path, query_string)

This function returns a URL constructed from the scheme, authority, path, and either the query_string or a
query string constructed from the query argument pairs. The authority can be empty, which is the case for calibre
scheme URLs. You must supply either a query_string or at least one query_name, query_value pair. If you
supply query_string and it is empty then the resulting URL will not have a query string section.
Example 1: constructing a Wikipedia search URL for the author Niccolò Machiavelli:

make_url_extended('https', 'en.wikipedia.org', '/w/index.php', 'search', 'Niccolò␣

↪→Machiavelli')

returns

https://en.wikipedia.org/w/index.php?search=Niccol%C3%B2+Machiavelli

See the query_string() (pagina 211) function for an example using make_url_extended() with a query_string.
If you are writing a custom column book details URL template then use $item_name or field('item_name') to
obtain the value of the field that was clicked on. Example: if Niccolò Machiavelli was clicked on then you can construct
the URL using :

make_url_extended('https', 'en.wikipedia.org', '/w/index.php', 'search', $item_name')

See also the functions make_url() (pagina 209), query_string() (pagina 211) and encode_for_url() (pagina 209).
90 https://en.wikipedia.org/wiki/URL
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query_string

class calibre.utils.formatter_functions.BuiltinQueryString

query_string([query_name, query_value, how_to_encode]+)– returns a URL query string constructed
from the query_name, query_value, how_to_encode triads. A query string is a series of items where each
item looks like query_name=query_value where query_value is URL-encoded as instructed. The query items are
separated by '&' (ampersand) characters.
If how_to_encode is 0 then query_value is encoded and spaces are replaced with '+' (plus) signs. If
how_to_encode is 1 then query_value is encoded with spaces replaced by %20. If how_to_encode is 2 then
query_value is returned unchanged; no encoding is done and spaces are not replaced. If you want query_value
not to be encoded but spaces to be replaced then use the re() (pagina 207) function, as in re($series, ' ', '%20')

You use this function if you need specific control over how the parts of the query string are constructed. You could then
use the resultingquery string in make_url_extended() (pagina 210), as in

make_url_extended(

'https', 'your_host', 'your_path',

query_string('encoded', 'Hendrik Bäßler', 0, 'unencoded', 'Hendrik Bäßler', 2))

giving you

https://your_host/your_path?encoded=Hendrik+B%C3%A4%C3%9Fler&unencoded=Hendrik Bäßler

You must have at least one query_name, query_value, how_to_encode triad, but can have as many as you wish.
The returned value is a URL query string with all the specified items, for example: name1=val1[&nameN=valN]*.
Note that the '?' path / query string separator is not included in the returned result.
If you are writing a custom column book details URL template then use $item_name or field('item_name') to
obtain the unencoded value of the field that was clicked. You also have item_value_quoted where the value is already
encoded with plus signs replacing spaces, and item_value_no_plus where the value is already encoded with %20

replacing spaces.
See also the functions make_url() (pagina 209), make_url_extended() (pagina 210) and encode_for_url() (pagina 209).

to_hex

class calibre.utils.formatter_functions.BuiltinToHex

to_hex(val) – returns the string val encoded into hex. This is useful when constructing calibre URLs.

urls_from_identifiers

class calibre.utils.formatter_functions.BuiltinUrlsFromIdentifiers

urls_from_identifiers(identifiers, sort_results) – given a comma-separated list of identifiers,
where an identifier is a colon-separated pair of values (id_name:id_value), returns a comma-separated list of
HTML URLs generated from the identifiers. The list not sorted if sort_results is 0 (character or number), otherwise
it is sorted alphabetically by the identifier name. The URLs are generated in the same way as the built-in identifiers
column when shown in Book Details.
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API of the Metadata objects

The python implementation of the template functions is passed in a Metadata object. Knowing it’s API is useful if you
want to define your own template functions.
class calibre.ebooks.metadata.book.base.Metadata(title, authors=('Onbekend',), other=None,

template_cache=None, formatter=None)

A class representing all the metadata for a book. The various standard metadata fields are available as attributes of
this object. You can also stick arbitrary attributes onto this object.
Metadata from custom columns should be accessed via the get() method, passing in the lookup name for the column,
for example: “#mytags”.
Use the is_null() (pagina 212) method to test if a field is null.
This object also has functions to format fields into strings.
The list of standard metadata fields grows with time is in STANDARD_METADATA_FIELDS (pagina 213).
Please keep the method based API of this class to a minimum. Every method becomes a reserved field name.
is_null(field)

Return True if the value of field is null in this object. ‘null’ means it is unknown or evaluates to False. So a
title of _(‘Unknown’) is null or a language of ‘und’ is null.
Be careful with numeric fields since this will return True for zero as well as None.
Also returns True if the field does not exist.

deepcopy(class_generator=<function Metadata.<lambda>>)
Do not use this method unless you know what you are doing, if you want to create a simple clone of this
object, use deepcopy_metadata() instead. Class_generator must be a function that returns an instance of
Metadata or a subclass of it.

get_identifiers()

Return a copy of the identifiers dictionary. The dict is small, and the penalty for using a reference where a
copy is needed is large. Also, we don’t want any manipulations of the returned dict to show up in the book.

set_identifiers(identifiers)
Set all identifiers. Note that if you previously set ISBN, calling this method will delete it.

set_identifier(typ, val)
If val is empty, deletes identifier of type typ

standard_field_keys()

return a list of all possible keys, even if this book doesn’t have them
custom_field_keys()

return a list of the custom fields in this book
all_field_keys()

All field keys known by this instance, even if their value is None
metadata_for_field(key)

return metadata describing a standard or custom field.
all_non_none_fields()

Return a dictionary containing all non-None metadata fields, including the custom ones.
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get_standard_metadata(field, make_copy)
return field metadata from the field if it is there. Otherwise return None. field is the key name, not the label.
Return a copy if requested, just in case the user wants to change values in the dict.

get_all_standard_metadata(make_copy)
return a dict containing all the standard field metadata associated with the book.

get_all_user_metadata(make_copy)
return a dict containing all the custom field metadata associated with the book.

get_user_metadata(field, make_copy)
return field metadata from the object if it is there. Otherwise return None. field is the key name, not the label.
Return a copy if requested, just in case the user wants to change values in the dict.

set_all_user_metadata(metadata)
store custom field metadata into the object. Field is the key name not the label

set_user_metadata(field, metadata)
store custom field metadata for one column into the object. Field is the key name not the label

remove_stale_user_metadata(other_mi)
Remove user metadata keys (custom column keys) if they don’t exist in ‘other_mi’, which must be a metadata
object

template_to_attribute(other, ops)
Takes a list [(src,dest), (src,dest)], evaluates the template in the context of other, then copies the result to
self[dest]. This is on a best-efforts basis. Some assignments can make no sense.

smart_update(other, replace_metadata=False)
Merge the information in other into self. In case of conflicts, the information in other takes precedence, unless
the information in other is NULL.

format_field(key, series_with_index=True)
Returns the tuple (display_name, formatted_value)

to_html()

A HTML representation of this object.
calibre.ebooks.metadata.book.base.STANDARD_METADATA_FIELDS

The set of standard metadata fields.

'''

All fields must have a NULL value represented as None for simple types,

an empty list/dictionary for complex types and (None, None) for cover_data

'''

SOCIAL_METADATA_FIELDS = frozenset((

'tags', # Ordered list

'rating', # A floating point number between 0 and 10

'comments', # A simple HTML enabled string

'series', # A simple string

'series_index', # A floating point number

# Of the form { scheme1:value1, scheme2:value2}

# For example: {'isbn':'123456789', 'doi':'xxxx', ... }

'identifiers',

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
))

'''

The list of names that convert to identifiers when in get and set.

'''

TOP_LEVEL_IDENTIFIERS = frozenset((

'isbn',

))

PUBLICATION_METADATA_FIELDS = frozenset((

'title', # title must never be None. Should be _('Unknown')

# Pseudo field that can be set, but if not set is auto generated

# from title and languages

'title_sort',

'authors', # Ordered list. Must never be None, can be [_('Unknown')]

'author_sort_map', # Map of sort strings for each author

# Pseudo field that can be set, but if not set is auto generated

# from authors and languages

'author_sort',

'book_producer',

'timestamp', # Dates and times must be timezone aware

'pubdate',

'last_modified',

'rights',

# So far only known publication type is periodical:calibre

# If None, means book

'publication_type',

'uuid', # A UUID usually of type 4

'languages', # ordered list of languages in this publication

'publisher', # Simple string, no special semantics

# Absolute path to image file encoded in filesystem_encoding

'cover',

# Of the form (format, data) where format is, e.g. 'jpeg', 'png', 'gif'...

'cover_data',

# Either thumbnail data, or an object with the attribute

# image_path which is the path to an image file, encoded

# in filesystem_encoding

'thumbnail',

))

BOOK_STRUCTURE_FIELDS = frozenset((

# These are used by code, Null values are None.

'toc', 'spine', 'guide', 'manifest',

))

USER_METADATA_FIELDS = frozenset((

# A dict of dicts similar to field_metadata. Each field description dict

# also contains a value field with the key #value#.

'user_metadata',

))

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
DEVICE_METADATA_FIELDS = frozenset((

'device_collections', # Ordered list of strings

'lpath', # Unicode, / separated

'size', # In bytes

'mime', # Mimetype of the book file being represented

))

CALIBRE_METADATA_FIELDS = frozenset((

'application_id', # An application id, currently set to the db_id.

'db_id', # the calibre primary key of the item.

'formats', # list of formats (extensions) for this book

# a dict of user category names, where the value is a list of item names

# from the book that are in that category

'user_categories',

# a dict of items to associated hyperlink

'link_maps',

))

ALL_METADATA_FIELDS = SOCIAL_METADATA_FIELDS.union(

PUBLICATION_METADATA_FIELDS).union(

BOOK_STRUCTURE_FIELDS).union(

USER_METADATA_FIELDS).union(

DEVICE_METADATA_FIELDS).union(

CALIBRE_METADATA_FIELDS)

# All fields except custom fields

STANDARD_METADATA_FIELDS = SOCIAL_METADATA_FIELDS.union(

PUBLICATION_METADATA_FIELDS).union(

BOOK_STRUCTURE_FIELDS).union(

DEVICE_METADATA_FIELDS).union(

CALIBRE_METADATA_FIELDS)

# Metadata fields that smart update must do special processing to copy.

SC_FIELDS_NOT_COPIED = frozenset(('title', 'title_sort', 'authors',

'author_sort', 'author_sort_map',

'cover_data', 'tags', 'languages',

'identifiers'))

# Metadata fields that smart update should copy only if the source is not None

SC_FIELDS_COPY_NOT_NULL = frozenset(('device_collections', 'lpath', 'size', 'comments

↪→', 'thumbnail'))

# Metadata fields that smart update should copy without special handling

SC_COPYABLE_FIELDS = SOCIAL_METADATA_FIELDS.union(

PUBLICATION_METADATA_FIELDS).union(

BOOK_STRUCTURE_FIELDS).union(

DEVICE_METADATA_FIELDS).union(

CALIBRE_METADATA_FIELDS) - \

SC_FIELDS_NOT_COPIED.union(

SC_FIELDS_COPY_NOT_NULL)

SERIALIZABLE_FIELDS = SOCIAL_METADATA_FIELDS.union(

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
USER_METADATA_FIELDS).union(

PUBLICATION_METADATA_FIELDS).union(

CALIBRE_METADATA_FIELDS).union(

DEVICE_METADATA_FIELDS) - \

frozenset(('device_collections', 'formats',

'cover_data'))

# these are rebuilt when needed

10.4 Alles over het gebruik van reguliere expressies in calibre
Reguliere expressies zĳn functies die op veel plaatsen van calibre worden gebruikt om geavanceerde manipulatie van e-
book inhoud en metadata uit te voeren. Deze handleiding is een voorzichtige inleiding om u op weg te helpen met het
gebruik van reguliere uitdrukkingen in calibre.

Inhoud

• Allereerst een waarschuwing en bemoediging (pagina 216)
• Waar in calibre kan je reguliere expressies gebruiken? (pagina 217)
• Wat is een reguliere expressie eigenlĳk? (pagina 217)
• Iets meer uitleg graag? (pagina 217)
• Dat klinkt niet heel moeilĳk. Ga door. (pagina 217)
• Prachtig! Nu begint het ergens op te lĳken! (pagina 218)
• Nou, deze speciale karakters zĳn erg netjes en zo maar wat als ik een overeenkomst met een punt of vraagteken

wil? (pagina 218)
• Wat zĳn dan de meest nuttige sets? (pagina 218)
• Maar als ik een paar verschillende strings had die ik wilde laten overeenkomen worden dingen ingewikkeld?

(pagina 219)
• U miste… (pagina 219)
• In het begin zei u dat er een manier was om een reguliere expressie hoofdletterongevoelig te maken? (pagina 220)
• Ik denk dat ik deze reguliere expressies begin te begrĳpen nu … hoe gebruik ik ze in calibre? (pagina 220)

– Omzettingen (pagina 220)
– Boeken toevoegen (pagina 221)
– Massabewerking van metadata (pagina 221)

• Snelle referentie (pagina 221)
• Credits (pagina 226)

10.4.1 Allereerst een waarschuwing en bemoediging
Dit gaat onvermĳdelĳk enigszins technisch worden, - reguliere expressies zĳn immers een technisch hulpmiddel voor het
doen van technische zaken. Ik zal wat jargon en concepten moeten gebruiken die ingewikkeld of ingewikkeld lĳken. Ik
ga proberen die concepten zo duidelĳk mogelĳk uit te leggen, maar kan echt niet zonder ze helemaal te gebruiken. Dat
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gezegd zĳnde, wees niet ontmoedigd door enig jargon, omdat ik heb geprobeerd om alles nieuw uit te leggen. En terwĳl
reguliere expressies zelf misschien een mysterieuze, zwarte magie lĳken (of, om prozaïscher te zĳn, een willekeurige reeks
mumbo-jumbo letters en tekens), beloof ik dat ze niet zo gecompliceerd zĳn. Zelfs degenen die reguliere uitdrukkingen
echt goed begrĳpen, hebben moeite met het lezen van de meer gecompliceerde uitdrukkingen, maar het schrĳven ervan
is niet zo moeilĳk - je construeert de uitdrukking stap voor stap. Dus, neem een stap en volg me naar het konĳnenhol.

10.4.2 Waar in calibre kan je reguliere expressies gebruiken?
Er zĳn een paar plaatsen waar calibre reguliere expressies gebruikt. Daar is de :guilabel :Zoeken & vervangen in conversie-
opties, detectie van metadata uit bestandsnamen in de importinstellingen en Zoeken & vervangen bĳ het bewerken van
de metadata van boeken in bulk. De calibre boek editor kan ook reguliere expressies gebruiken in zĳn Zoek en vervang
functie. Tenslotte kan u reguliere expressies gebruiken bĳ doorzoeken van de calibre boekenlĳst en bĳ zoeken in de calibre
e-boekviewer.

10.4.3 Wat is een reguliere expressie eigenlijk?
Een reguliere expressie is een manier om een string set te beschrĳven. Een enkele reguliere expressie kan overeenkomen
met een aantal verschillende strings. Dit maakt reguliere expressie zo krachtig – het is een beknopte manier om een
mogelĳk groot aantal variaties te beschrĳven.

Notitie

Ik gebruik string hier op de manier dat het gebruikt wordt in programmeertalen: een reeks van één of meerdere
karakters, inbegrepen letters, cĳfers, interpunctie en zogenaamde witruimte (regeleindes, tabs, enz.). Merk a.u.b.
op dat in het algemeen hoofd- en kleine letters niet als identiek beschouwd worden, “a” is dus iets anders als “A”
en zo verder. In calibre zĳn reguliere expressies hoofdletterongevoelig in de Zoekbalk maar niet in de conversie-
opties. Er is een manier om elke reguliere expressie hoofdletterongevoelig te maken maar dat bespreken we later. Het
wordt gecompliceerd omdat reguliere expressies variaties toelaten in de strings waar ze mee overeen komen, dus een
expressie kan met verschillende strings overeen komen, reden dat ze gebruikt worden. Meer daarover later.

10.4.4 Iets meer uitleg graag?
Wel, daarom zĳn we hier. Ten eerste, dit is het belangrĳkste concept in reguliere expressies: Een string is zelf een reguliere
expressie die met zichzelf overeenkomt. Dat wil zeggen, als ik met de string "Hello, World!" wou overeenkomen met
een reguliere expressie, de te gebruiken reguliere expressie zou Hello, World! zĳn. Ja, het is echt zo simpel. U zal
nochtans opmerken dat dit enkel overeenkomt met de exacte string "Hello, World!", niet met bv. "Hello, wOrld!"

of "hello, world!" of elke andere variatie.

10.4.5 Dat klinkt niet heel moeilijk. Ga door.
Nu komt het echt leuke gedeelte. Herinnert u zich dat ik zei dat reguliere expressies met meerdere strings kunnen over-
eenkomen? Nu wordt het een beetje ingewikkelder. Neem, als een iets meer praktische oefening, dat het e-boek dat u
wou converteren een gemene voettekst had om de pagina’s te tellen, zoals “Pagina 5 van 423”. Duidelĳk dat het pagina
nummer zal stĳgen van 1 tot 423, dus u zou met 423 verschillende strings moeten overeenkomen, klopt? Fout, eigenlĳk:
reguliere expressies laten u karaktersets definiëren die overeenkomen: Om een set te definiëren, zet u alle karakters die
u in de set wilt tussen vierkante haken. Dus, bv., de set [abc] komt overeen met ofwel karakter “a”, “b” of “c”. Sets
komen altĳd maar overeen met een van de karakters in de set. Ze “begrĳpen” karakterbereiken, dat wil zeggen, als u met
alle kleine letters wil overeenkomen, gebruikt u de set [a-z], voor hoofd- en kleine letters gebruikt u [a-zA-Z] en zo
voort. Bent u mee? Dus, duidelĳk, gebruik makend van de expressie Page [0-9] of 423 komt u overeen met de eerste
9 pagina’s, daarbĳ de vereiste expressies tot drie reducerend: De tweede expressie Page [0-9][0-9] of 423 komt
overeen met alle tweecĳferige paginanummers en ik ben er zeker van dat u kan raden hoe de derde expressie eruit zou
zien. Ja, vooruit, schrĳf het op.
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10.4.6 Prachtig! Nu begint het ergens op te lijken!
Ik hoopte al dat u dat zou zeggen. Maar hou u vast, het wordt nog beter! We zagen net dat met sets we konden zoeken
naar één of meerdere karakters ineens. Maar men kan zelfs een karakter of set herhalen en zo het aantal expressies nodig
voor het paginanummer voorbeeld boven verminderen tot één. Ja, ÉÉN! Spannend? Absoluut! Zo werkt het: Bepaalde
zogenaamde speciale karakters, “+”, “?” en “*”, herhalen het voorafgaande element. (Element betekent ofwel een enkel
karakter, ofwel een karakterset, ofwel een escape sequentie ofwel een groep (we leren later meer over die twee laatste)-
kortom, elke eenheid in een reguliere expressie). Deze karakters heten wildcards of quantifiers. Nauwkeuriger, “?” komt
overeen met 0 of 1 van het voorafgaande element, “*” komt overeen met 0 of meer van het voorafgaande element en “+”
komt overeen met 1 of meer van het voorafgaande element. Een paar voorbeelden: De expressie a? komt overeen met
ofwel “” (de lege string, niet echt bruikbaar in dit geval) ofwel “a”, de expressie a* komt overeen met “”, “a”, “aa” of elk
aantal a’s op een rĳ, en, tenslotte, de expressie a+ komt overeen met “a”, “aa” of elk aantal a’s op een rĳ (Merk op: het
komt niet overeen met de lege string!). Zelfde geval met sets: De expressie [0-9]+ komt overeen met elk bestaand geheel
getal! Ik weet wat u denkt en u hebt gelĳk: Als u dat in het geval boven met overeenkomende pagina nummers gebruikt,
zou dat niet die enkele expressie zĳn die met alle paginanummers overeen komt? Ja, de expressie Page [0-9]+ of 423

komt overeen met elk paginanummer in dat boek!

Notitie

Iets over die quantifiers: Ze proberen gewoonlĳk met zoveel mogelĳk tekst overeen te komen, voorzichtig gebruiken
dus. Dit wordt “gulzig gedrag” genoemd - Ik ben er zeker van dat u dat snapt. Het wordt problematisch als u, bv.
probeert met een tag overeen te komen. Beschouw bv. de string "<p class="calibre2">Title here</p>" en
dat u met de openingstag wilt overeenkomen (het deel tussen het eerste paar punthaakjes, meer over tags later). Men
zou denken dat de expressie <p.*> dat doet maar eigenlĳk komt dat overeen met de hele string! (Het karakter “.” is
nog een speciaal karakter dat met alles overeenkomt behalve een nieuwe ĳn, dus de expressie .* komt overeen met elke
regel die u zich kan inbeelden). I.p.d.v. gebruik <p.*?> wat de quantifier "*" niet-gulzig maakt. Die expressie komt
enkel overeen met de openingstag, zoals bedoeld. Er is nog een manier om dit te bereiken: De expressie <p[^>]*>
komt met dezelfde tag overeen - u ziet waarom na het volgende onderdeel. Merk gewoon op dat er dikwĳls meerdere
manieren zĳn om een reguliere expressie te schrĳven.

10.4.7 Nou, deze speciale karakters zijn erg netjes en zo maar wat als ik een over-
eenkomst met een punt of vraagteken wil?

U kan natuurlĳk dit doen: Zet gewoon een backslash voor elk speciaal karakter en het wordt geïnterpreteerd als letterlĳk
dat karakter, zonder speciale betekenis. Dit paar backslashes gevolgd door een enkel karakter wordt een escape sequentie
genoemd en een backslash voor een speciaal karakter zetten heet dat karakter escapen. Een escape sequentie wordt ge-
interpreteerd als een enkel element. Er zĳn natuurlĳk escape sequenties die meer doen dan speciale karakters escapen,
"\t" bv. betekent een tabulator. We zien later enkele escape sequenties. Oh, enne, wat betreft die speciale karakters:
Beschouw elk karakter dat we bespreken in deze introductie als hebbende een zekere functie die speciaal kan zĳn en dus
een nood om te escapen als u het letterlĳke karakter wilt hebben.

10.4.8 Wat zijn dan de meest nuttige sets?
Ik wist dat u het zou vragen. Enkele nuttige sets zĳn [0-9] komt overeen met een enkel getal, [a-z] met een enkele
kleine letter, [A-Z] met een enkele hoofdletter, [a-zA-Z] met een enkele letter en [a-zA-Z0-9] komt overeen met
een enkele letter of cĳfer.
\d

is gelĳkwaardig aan [0-9]

\w

is gelĳkwaardig aan [a-zA-Z0-9_]

\s

is gelĳkwaardig aan elke spatie

218 Hoofdstuk 10. Lesboeken



calibre Gebruikershandleiding, Release 8.7.0

Notitie

“Witruimte” is een term voor alles dat niet afgedrukt wordt. Deze karakters zĳn onder andere spatie, tab, regelinvoer-
teken (LF), paginainvoerteken (FF), regeleinde (CR), niet-afbrekende spaties, enz.

Notitie

De hoofdletter- en kleinelettersets kunnen overeenkomen met zowel hoofdletters als kleine letters als de instelling om
zoekopdrachten hoofdletterongevoelig te maken is ingeschakeld. Dergelĳke instellingen zĳn bĳvoorbeeld te vinden in
Voorkeuren->Zoeken in Calibre zelf en op het zoekpaneel in de calibre E-book viewer evenals de calibre Edit book
tool.

Al laatste woord over sets, u kan een set ook definiëren als elk karakter behalve die in de set. U doet dat door het
karakter "^" als allereerste karakter in de set te zetten. Dus, [^a] komt overeen met elk karakter behalve “a”. Dat heet
de set aanvullen. Die verkorte escapereeksen die we eerder zagen kunnen ook aangevuld worden: "\D" betekent elk
niet-numeriek karakter, equivalent dus met [^0-9]. De andere verkortingen kunnen aangevuld worden door, u raadde
het, gebruik van de respectieve hoofdletter i.p.v. de kleine letter. Dus, terug naar het voorbeeld <p[^>]*> van de vorige
sectie, u ziet nu dat de gebruikte karakterset probeert overeen te komen met elk karakter behalve een sluitend vierkant
haakje.

10.4.9 Maar als ik een paar verschillende strings had die ik wilde laten overeenko-
men worden dingen ingewikkeld?

Vrees niet, ‘t leven is nog altĳd eenvoudig en goed. Overweeg dit voorbeeld: In het boek dat converteert staat “Titel” op
elke oneven pagina en “Auteur” op elke even pagina. Ziet er goed uit in druk, niet? Maar in e-boeken is het vervelend.
U kan hele expressies groeperen tussen aanhalingstekens en het karakter "|" laat overeenkomen met ofwel de expressie
rechts ofwel de expressie links. Combineer deze en u bent klaar. Te snel voor u? Oké, om te beginnen groeperen we
de expressies voor even en oneven pagina’s en krĳgen (Title)(Author) als de twee benodigde expressies. Nu maken
we het simpeler met gebruik van het pĳp symbool ("|" wordt het pĳp of sluissymbool genoemd): Als u de expressie
(Title|Author) gebruikt krĳgt u ofwel een overeenkomst voor “Titel” (op de oneven pagina’s) ofwel “Auteur” (op de
even pagina’s). Wel, was dat niet gemakkelĳk?
U kan natuurlĳk het pĳp symbool ook zonder groeperende haakjes gebruiken. Weet u nog dat ik zei dat quantifiers het
element voor zich herhalen? Wel, het pĳp symbool werkt enigszins anders: De expressie “Titel|Auteur” komt ook overeen
met ofwel de string “Titel” ofwel de string “Auteur”, net zoals het voorbeeld boven met groeperen. Het pĳp symbool
selecteert tussen de volledige expressie ervoor en erna. Dus als u met de strings “Calibre” en “calibre” wou overeenkomen
en enkel wou selecteren tussen de hoofd- en kleine letter “c”, moet u de expressie (c|C)alibre gebruiken, waar de
groepering ervoor zorgt dat enkel de “c” wordt geselecteerd. Als u c|Calibre zou gebruiken, zou u een overeenkomst
krĳgen op de string “c” of op de string “Calibre”, wat niet is wat we wilden. Samengevat: Bĳ twĳfel, gebruik groeperen
met het pĳp symbool.

10.4.10 U miste…
…wacht nog even, er is nog één, heel tof ding dat u kan doen met groepen. Als u een groep hebt die vroeger overeenkwam,
kan u verder in de expressie verwĳzingen naar die groep gebruiken: Groepen worden genummerd vanaf 1, en u verwĳst
ernaar door het getal van de groep waarnaar u wilt verwĳzen te escapen, dus naar de vĳfde groep wordt verwezen met
\5. Dus, als u zocht naar ([^ ]+) \1 in de string “Test Test”, komt dat overeen met de hele string!
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10.4.11 In het begin zei u dat er een manier was om een reguliere expressie hoofd-
letterongevoelig te maken?

Inderdaad, bedankt voor uw aandacht en om me eraan te herinneren. U kan calibre zeggen hoe u bepaalde dingen gedaan
wilt hebben met vlaggen. U voegt vlaggen in in uw expressie via de speciale constructie (?vlaggen hier) waar u,
natuurlĳk, “vlaggen hier” vervangt door de specifieke vlag die u wilt. Om hoofdlettergebruik te negeren is de vlag i dus
u voegt (?i) in in uw expressie. Dus, (?i)test komt overeen met “Test”, “tEst”, “TEst” en elke hoofd/kleine letter
variatie ie u kunt bedenken.
Een andere nuttige vlag laat het punt overeenkomen met eender welk karakter, inbegrepen de newline, de vlag s. Als u
meerdere vlaggen wil gebruiken in een expressie, zet ze gewoon in dezelfde verklaring: (?is) negeert hoofdlettergebruik
en laat het punt met alles overeenkomen. Het maakt niet uit welke vlag u eerst zet, (?si) is gelĳk aan het bovenstaande.

10.4.12 Ik denk dat ik deze reguliere expressies begin te begrijpen nu … hoe ge-
bruik ik ze in calibre?

Omzettingen
Laten we beginnen met de conversie instellingen, wat echt handig is. In het Zoeken & vervangen deel kan u een regexp
(afkorting voor reguliere expressie) ingeven die de string beschrĳft die vervangen wordt tĳdens de conversie. Het handige
deel is de wizard. Klik op de toverstaf en u krĳgt een voorbeeld van wat calibre “ziet” tĳdens de conversie. Scrol naar de
string die u wilt verwĳderen, selecteer en kopieer hem, plak helm in het regexp veld boven in het venster. Als er variabele
delen zĳn, zoals pagina nummers of zo, gebruik daarvoor sets en quantifiers en terwĳl u bezig bent, denk eraan speciale
karakters te escapen, als er zĳn. Klik op de Test knop en calibre accentueert de delen die het zou vervangen als u de regexp
zou gebruiken. Wanneer u tevreden bent, klik op OK en converteer. Weer voorzichtig als uw conversie bron tags heeft
zoals deze:

Maybe, but the cops feel like you do, Anita. What's one more dead vampire?

New laws don't change that. </p>

<p class="calibre4"> <b class="calibre2">Generated by ABC Amber LIT Conv

<a href="http://www.processtext.com/abclit.html" class="calibre3">erter,

http://www.processtext.com/abclit.html</a></b></p>

<p class="calibre4"> It had only been two years since Addison v. Clark.

The court case gave us a revised version of what life was

(schaamteloos geripped uit deze thread91). U moet enkele tags verwĳderen ook. In dit voorbeeld raad ik aan te beginnen
met de tag <b class="calibre2">, nu moet u eindigen met de overeenkomende sluittag (openingstags zĳn <tag>,
sluittags zĳn </tag>), welke gewoon de volgende </b> in dit geval. (Gebruik een goede HTML manual of vraag in
het forum als u hierover twĳfelt). De openingstag kan beschreven worden met <b.*?>, de sluittag met </b>, dus we
kunnen alles tussen deze tags verwĳderen met <b.*?>.*?</b>. Maar deze expressie gebruiken is een slecht idee want ze
verwĳdert alles omsloten door <b> tags (die, by the way, de omsloten tekst vet weergeeft), en waarschĳnlĳk verwĳderen we
delen va het boek op deze manier. In plaats daarvan, geef ook het begin van de omsloten string mee, de reguliere expressie
wordt dan <b.*?>\s*Generated\s+by\s+ABC\s+Amber\s+LIT.*?</b> De \s met quantifiers is inbegrepen hier
in plaats van expliciet gebruik van de spaties zoals in de string om eventuele variaties van de string op te vangen. Denk
eraan te controleren wat calibre gaat verwĳderen zodat u zeker bent dat u geen delen verwĳdert die u wilt behouden als u
een nieuwe expressie test. Als u maar één voorkomen test, kan u ergens anders in de tekst een mismatch over het hoofd
zien. Merk ook op dat als per ongeluk meer of minder tags verwĳdert dan u eigenlĳk wou dat calibre de beschadigde code
probeert te herstellen na het verwĳderen.

91 https://www.mobileread.com/forums/showthread.php?t=75594"
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Boeken toevoegen
Iets anders waar u reguliere expressies voor kan gebruiken is metadata uit bestandsnamen halen. U vindt deze functie
in “Boeken toevoegen” in de instellingen. Er is hier een speciale functie: U kan veldnamen gebruiken voor metadata
velden, bv. (?P<title>) geeft aan dat calibre dit deel van de string gebruikt als boektitel. De toegelaten veldnamen zĳn
opgelĳst in de vensters, samen met een ander leuk testveld. Bv. Stel u wilt een hoop bestanden importeren genaamd zoals
Classical Texts: The Divine Comedy by Dante Alighieri.mobi. (Dit is natuurlĳk al in uw bibliotheek,
we houden allemaal van klassieke Italiaanse poëzie) of Science Fiction epics: The Foundation Trilogy

by Isaac Asimov.epub. Dit is duidelĳk een naamgevingsschema waar calibre geen nuttige data kan uithalen - z’n
standaard expressie om metadata te extraheren is (?P2.+) - (?P3[^_]+). Een reguliere expressie die hier werkt zou
[a-zA-Z]+: (?P4.+) by (?P5.+) zĳn. Merk a.u.b. op dat, in de groep voor het metadata veld, u expressies moet
gebruiken die beschrĳven waar het veld met overeenkomt. En merk ook op dat bĳ gebruik van het door calibre voorziene
testveld, u de extensie moet toevoegen aan uw testbestandsnaam of u krĳgt helemaal geen overeenkomsten, ook niet met
een werkende expressie.

Massabewerking van metadata
Het laatste deel is reguliere expressie Zoeken en vervangen in metadatavelden. U kunt hier toegang toe krĳgen door meer-
dere boeken in de bibliotheek te selecteren en metadata bulksgewĳs te bewerken. Wees erg voorzichtig bĳ het gebruik van
deze laatste functie, want het kan Very Bad Things met je bibliotheek doen! Controleer nogmaals of uw uitdrukkingen
doen wat u wilt met behulp van de testvelden en markeer alleen de boeken die u echt wilt wĳzigen! In de zoekmodus
voor reguliere expressies kunt u in één veld zoeken, de tekst door iets vervangen en zelfs het resultaat in een ander veld
schrĳven. Een praktisch voorbeeld: stel dat uw bibliotheek de boeken van de Dune-serie van Frank Herbert bevatte, ge-
noemd naar de mode Dune 1 - Dune, Dune 2 - Dune Messiah enzovoort. Nu wil je Dune in het serieveld krĳgen.
U kunt dat doen door te zoeken naar (.*?) \d+ - .* in het titelveld en dit te vervangen door \1 in het reeksveld.
Zie wat ik daar heb gedaan? Dat is een verwĳzing naar de eerste groep waarmee u het serieveld vervangt. Nu je de serie
helemaal klaar hebt, hoef je alleen maar nog een keer te zoeken naar .*? - in het titelveld en vervang het door "" (een
lege string), nogmaals in het titelveld, en je metadata zĳn allemaal netjes en opgeruimd. Is dat niet geweldig? Trouwens,
in plaats van het hele veld te vervangen, kun je ook toevoegen of toevoegen aan het veld, dus als je wilde dat de boektitel
wordt voorafgegaan door serie-informatie, dan zou je dat ook kunnen doen. Zoals je inmiddels ongetwĳfeld hebt opge-
merkt, is er een selectievakje met het label Hoofdlettergevoelig, dus je hoeft hier geen vlaggen te gebruiken om gedrag te
selecteren.
Wel, tot zover de zeer korte inleiding tot reguliere expressies. Hopelĳk heb ik u genoeg laten zien om u tenminste te laten
beginnen en het mogelĳk te maken om zelfstandig verder te leren - een goed vertrekpunt is de Python documentatie voor
reguliere expressies92.
Toch een laatste verwittiging: Reguliere expressies zĳn krachtig maar ook foutgevoelig. calibre voorziet echt super test-
mogelĳkheden om te zien of uw expressies doen wat u verwacht van hen. Gebruik ze. Probeer uzelf niet in de voet te
schieten. (Dzjee, wat een prachtige uitdrukking…). Doet u het toch ondanks de waarschuwing (of in een ander lichaams-
deel), probeer ervan te leren.

10.4.13 Snelle referentie
Quick reference voor regexp syntax
Deze checklist vat de meest gebruikte/moeilĳk te onthouden delen van de regexp engine, beschikbaar in de meeste delen
van calibre, samen.

Inhoud

• Karakter klassen (pagina 222)

92 https://docs.python.org/library/re.html
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• Steno tekenklassen (pagina 223)
• De quantifiers (pagina 223)
• Hebzucht (pagina 223)
• Afwisseling (pagina 223)
• Uitsluiting (pagina 223)
• Ankers (pagina 224)
• Groepen (pagina 224)
• Lookarounds (pagina 224)
• Recursie (pagina 225)
• Speciale karakters (pagina 225)
• Meta-karakters (pagina 225)
• Modes (pagina 226)

Karakter klassen

Tekenklassen zĳn handig om verschillende groepen karakters samen te stellen, kort en bondig.
Voorbeelden:

Vertegen-
woordi-
ging

Klasse

[a-z] Kleine letters. Bevat geen tekens met accentmarkering en ligaturen
[a-z0-9] Kleine letters van a tot z of cĳfers van 0 tot 9
[A-Za-z-] Hoofdletters of kleine letters, of een streepje. Om het streepje in een klasse op te nemen, moet u het aan

het begin of aan het einde plaatsen om het niet te verwarren met het koppelteken dat een reeks tekens
specificeert

[^0-9] Elk teken behalve een cĳfer. Het caret (^) aan het begin van de klasse sluit de karakters van de klasse
uit (gecomplementeerde klasse)

[[a-z]--[aeiouy]]De medeklinkers in kleine letters. Een klas kan in een klas worden opgenomen. De karakters -- sluiten
uit wat hen volgt

[\w--[\

d_]]

Alle letters (inclusief tekens met buitenlandse accenten). Afgekorte klassen kunnen binnen een klas
worden gebruikt

Voorbeeld:

<[^<>]+> to select an HTML tag
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Steno tekenklassen

Vertegen-
woordiging

Klasse

\d Een cĳfer (hetzelfde als [0-9])
\D Elk niet-numeriek karakter (hetzelfde als [^0-9])
\w Een alfanumeriek karakter ([a-zA-Z0-9]) inbegrepen karakters met accent en ligatuur
\W Elk “niet-woord”karakter
\s Spatie, harde spatie, tab, nieuweregelteken
\S Elk “niet blanco ruimte” karakter
. Elk karakter uitgezonderd nieuwe regel. Gebruik het “dot all” aankruisvakje of de (?s) regexp

modifier om het nieuwe regel karakter mee te tellen.

De quantifiers

Quantifier Aantal keren dat de uitdrukking voorkomt voor de quantifier
? 0 of 1 keer voorkomen van de uitdrukking. Hetzelfde als {0,1}
+ 1 of meer keer voorkomen van de uitdrukking. Hetzelfde als {1,}
* 0, 1 of meer keer voorkomen van de uitdrukking. Hetzelfde als {0,}
{n} Exact n keer voorkomen van de uitdrukking
{min,max} Aantal keer voorkomen tussen de minimum en maximum waarden inbegrepen
{min,} Aantal keren voorkomen tussen de minimum waarde inbegrepen en oneindig
{,max} Aantal keren voorkomen tussen 0 en de maximum waarde inbegrepen

Hebzucht

Standaard, met quantifiers, is de regular expression engine hebzuchtig: hĳ breidt de selectie zo ver mogelĳk uit. Dit geeft
dikwĳls verassingen, in het begin. ? volgt een quantifier om hem lui te maken. Vermĳd twee ervan in dezelfde uitdrukking,
het resultaat kan onvoorspelbaar zĳn.
Let op met het nesten van quantifiers, bv het patroon (a*)*, omdat het de verwerkingstĳd exponentieel verhoogt.

Afwisseling

Het | karakter in een regular expression is een logische OR. Het betekent dat ofwel de voorgaande ofwel de navolgende
uitdrukking kan overeenkomen.

Uitsluiting

Methode 1
pattern_to_exclude(*SKIP)(*FAIL)|pattern_to_select

Voorbeeld:
"Blabla"(*SKIP)(*FAIL)|Blabla

selecteert Blabla, in de strings Blabla of “Blabla of Blabla”, maar niet in “Blabla”.
Methode 2
pattern_to_exclude\K|(pattern_to_select)

"Blabla"\K|(Blabla)

selecteert Blabla, in de strings Blabla of “Blabla of Blabla”, maar niet in “Blabla”.
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Ankers

Een anker is een manier om een logische locatie in een string te matchen, eerder dan een karakter. De nuttigste ankers
voor tekstverwerking zĳn:

\b

Geeft een woordgrens aan, bv een overgang van een spatie naar een niet blanco ruimte karakter. U kan
bv \bsurd gebruiken om overeen te komen met the surd maar niet absurd.

^

Komt overeen met het begin van een regel (in multi-regel modus, wat standaard is)
$

Komt overeen met het einde van een regel (in multi-regel modus, wat standaard is)
\K

Reset de start positie van de selectie naar z’n positie in het patroon. Sommige regex engines (maar niet
calibre) laten geen lookbehind of variabele lengte toe, zeker met quantifiers. Als u \K kan gebruiken
bĳ deze engines, laat het u ook toe om van deze beperking vanaf te raken door het equivalent van een
positieve lookbehind van variabele lengte te schrĳven.

Groepen

(expression)

Vang groep, die de selectie bewaart en later terug opgeroepen kan worden in de search or replace
patronen met \n, waar n het volgnummer is van de vang groep (beginnend bĳ 1 in leesvolgorde)

(?:expression)

Groep die de selectie niet vangt
(?>expression)

Atomic Group: Zo gauw aan de uitdrukking voldaan is, geeft de regexp engine door, en als de rest van
het patroon faalt, zal hĳ niet terug gaan om andere combinaties met de uitdrukking te proberen. Atomic
groepen vangen niet.

(?|expression)

Branch reset groep: de branches van de alternaties inbegrepen in de uitdrukking delen dezelfde groep
nummers

(?<name>expression)

Groep “naam” genoemd. De selectie kan later terug opgeroepen worden in het zoek patroon door (?
P=name) en in de vervang door \g<name>. Twee verschillende groepen kunnen dezelfde naam ge-
bruiken.

Lookarounds

Lookaround Meaning
?= Positieve lookahead (na de selectie te plaatsen)
?! Negatieve lookahead (na de selectie te plaatsen)
?<= Positieve lookbehind (voor de selectie te plaatsen)
?<! Negatieve lookbehind (voor de selectie te plaatsen)

Lookaheads en lookbehinds verbruiken geen karakters, ze hebben zero lengte en vangen niet. Het zĳn atomic groepen:
zo gauw aan de stelling voldaan is, geeft de regexp engine door, en als de rest van het patroon faalt, zal hĳ niet terug gaan
in de lookaround om andere combinaties te proberen.
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Bĳ het zoeken naar meerdere overeenkomsten in een string, kan een lookbehind, bĳ de startpositie van elke poging, de
karakters inspecteren voor de huidige positie. Dus, in de string 123, het patroon (?<=\d)\d (een cĳfer voorafgegaan
door een cĳfer) zou, in theorie, 2 en 3 moeten kiezen. Anderzĳds, \d\K\d kan enkel 2 kiezen omdat de startpositie na de
eerste selectie onmiddellĳk voor 3 is en er niet genoeg cĳfers zĳn voor een tweede overeenkomst. Gelĳkaardig, \d(\d)
vangt enkel 2. In calibre’s regexp engine praktĳk gedraagt de positieve lookbehind zich op dezelfde manier en kiest enkel
2, in tegenstelling tot de theorie.
Groepen kunnen in lookarounds geplaatst worden, maar vangen is zelden bruikbaar. Niettegenstaande, als het bruikbaar
is, is het nodig om zeer zorgvuldig te zĳn in het gebruik van een quantifier in een lookbehind: de hebzucht die komt met de
afwezigheid van backtracking kan een verrassende vangst geven. Hierom, gebruik eerder \K dan een positieve lookbehind
als je een quantifier hebt (of erger, meerdere) in een vang groep van de positieve lookbehind.
Voorbeeld van een negatieve lookahead:
(?![^<>{}]*[>}])

Voorkomt het selecteren binnenin een tag of stĳl in een bestand indien aan het einde van het patroon geplaatst.
Wanneer mogelĳk, is het altĳd beter om de lookarounds the ‘ankeren”, om het aantal stappen om het resultaat te verkrĳgen,
te verkleinen.

Recursie

Vertegenwoordiging Meaning
(?R) Recursie van het gehele patroon
(?1) Recursie van het enige patroon van de genummerde vang groep, hier groep 1

Recursie is zichzelf roepen. Dit is nuttig voor gebalanceerde queries, zoals quoted strings, die binnenin quoted strings
kunnen bevatten. Dus, als tĳdens het verwerken van een string tussen dubbele aanhalingstekens, we het begin van een
andere string tussen dubbele aanhalingstekens tegen komen, weten we wat te doen en we roepen onszelf. Dan hebben we
een patroon zoals:

start-pattern(?>atomic sub-pattern|(?R))*end-pattern

Om een string te selecteren tussen dubbele aanhalingstekens zonder te stoppen voor een string daar binnenin:

“((?>[^“”]+|(?R))*[^“”]+)”

Deze template kan ook gebruikt worden om tag paren te wĳzigen die ergens binnenin staan, zoals <div> tags.

Speciale karakters

Vertegenwoordiging Character
\t tabulation
\n line break
\x20 (zachte) spatie
\xa0 harde spatie

Meta-karakters

Meta-karakters zĳn diegene die een speciale betekenis hebben voor de regexp engine. Van deze moeten er 12 voorafgegaan
worden door een escape karakter, de backslash (\), om hun speciale betekenis te verliezen en terug een gewoon karakter
te worden:
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^ . [ ] $ ( ) * + ? | \

Zeven andere meta-karakters moeten niet door een backslash vooraf gegaan worden (maar het kan zonder gevolgen):

{ } ! < > = :

Speciale karakters verliezen hun status als ze in een class gebruikt worden (tussen haakjes []). Het sluitende haakje en
het streepje hebben een speciale betekenis in een class. Buiten de class is het streepje gewoon een streepje, het sluitend
haakje blĳft een meta-karakter.
De slash (/) en het hekje (of kardinaalteken) (#) zĳn geen meta-karakters, zĳ moeten niet voorafgegaan worden door een
escape karakter.
In sommige tools, zoals regex101.com in de Python engine, hebben dubbele aanhalingstekens de speciale status van
scheidingsteken, en moeten voorafgegaan worden door een escape teken, of de opties moeten aangepast worden. Dit is
niet het geval in de calibre editor.

Modes

(?s)

Zorgt ervoor dat het punt (.) ook met nieuwe lĳn karakters overeenkomt
(?m)

Laat de ^ en $ ankers overeenkomen met het begin en einde van regels ipv het begin en einde van de
hele string.

10.4.14 Credits
Dank voor hulp met tips, correcties en dergelĳke:

• ldolse
• kovidgoyal
• chaley
• dwanthny
• kacir
• Starson17
• Orpheu

Voor meer over reguliere expressies, bekĳk The Python User Manual93. De actuele reguliere expressie bibliotheek ge-
bruikt door calibre is: regex94 welke verscheidene nuttige verbeteringen ondersteunt bovenop de Python standaard bibli-
otheek.

10.5 Uw eigen plugins schrijven om de functionaliteit van calibre uit
te breiden

calibre heeft een zeer modulair ontwerp. Bĳna alle functionaliteit in calibre komt als plug-ins. Plug-ins voor conversie,
downloaden van nieuws (recepten genaamd), verschillende componenten van de gebruikersinterface, verbinding maken
met verschillende toestellen, bestanden verwerken bĳ toevoegen aan calibre enz. U vidnt een volledige lĳst van ingebouwde
plug-ins in calibre op: guilabel: `Voorkeuren-> Geavanceerd-> Plug-ins ‘te gaan.

93 https://docs.python.org/library/re.html
94 https://bitbucket.org/mrabarnett/mrab-regex/src/hg/
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Hier laten we zien hoe u uw eigen plugins kunt maken om nieuwe functies toe te voegen aan calibre.

Inhoud

• Opbouw van een calibre plugin (pagina 227)
• Een Gebruikersinterface plugin (pagina 228)

– __init__.py (pagina 229)
– ui.py (pagina 231)
– main.py (pagina 232)
– Ophalen bronnen uit het plug-in ZIP bestand (pagina 235)
– Gebruikers-configuratie van uw plugin inschakelen (pagina 235)

• Boek plug-ins bewerken (pagina 237)
– main.py (pagina 237)

• Vertalingen toevoegen aan uw plugin (pagina 240)
• De plug-in API (pagina 241)
• Plug-ins foutopsporing (pagina 241)
• Meer voorbeelden van plugins (pagina 241)
• Uw plugins delen met anderen (pagina 242)

Notitie

Dit is enkel van toepassing op calibre releases >= 0.8.60

10.5.1 Opbouw van een calibre plugin
Een calibre plug-in is heel eenvoudig, gewoon een ZIP-bestand dat wat Python code bevat en andere bronnen zoals
afbeelding die de plug-in nodig heeft. Genoeg, laten we een eenvoudig voorbeeld bekĳken.
Stel, u heeft calibre geïnstalleerd om diverse e-documenten zelf te publiceren in EPUB en MOBI-formaten. U wilt dat
alle bestanden gegenereerd door calibre als uitgever “Hello world” hebben, hier volgt hoe dit te doen. Maak een bestand
genaamd __init__.py (dit is een speciale naam en moet altĳd gebruikt worden voor het hoofdbestand van uw plugin)
en geef de volgende Python code in:

from calibre.customize import FileTypePlugin

class HelloWorld(FileTypePlugin):

name = 'Hello World Plugin' # Name of the plugin

description = 'Set the publisher to Hello World for all new conversions'

supported_platforms = ['windows', 'osx', 'linux'] # Platforms this plugin will␣

↪→run on

author = 'Acme Inc.' # The author of this plugin

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
version = (1, 0, 0) # The version number of this plugin

file_types = {'epub', 'mobi'} # The file types that this plugin will be␣

↪→applied to

on_postprocess = True # Run this plugin after conversion is complete

minimum_calibre_version = (0, 7, 53)

def run(self, path_to_ebook):

from calibre.ebooks.metadata.meta import get_metadata, set_metadata

with open(path_to_ebook, 'r+b') as file:

ext = os.path.splitext(path_to_ebook)[-1][1:].lower()

mi = get_metadata(file, ext)

mi.publisher = 'Hello World'

set_metadata(file, mi, ext)

return path_to_ebook

Dat is alles. Om deze code als plug-in aan calibre toe te voegen, voer het volgende uit in de map waar u __init__.py::
creëerde

calibre-customize -b .

Notitie

Op macOS bevinden de commandoregelprogramma’s zich in de calibre-bundel, bĳvoorbeeld, als u calibre hebt ge-
installeerd in /Applications bevinden de commandoregelprogramma’s zich in /Applications/calibre.app/
Contents/MacOS/.

U kan de Hello World plugin downloaden van helloworld_plugin.zip95.
Elke keer u calibre gebruikt om een boek te converteren, wordt de plugin’s run()methode geroepen en het geconverteerde
boek heeft als uitgever “Hello World”. Dit is een banale plugin, op naar een ingewikkelder voorbeeld dat daadwerkelĳk
een component toevoegt aan de gebruikersinterface.

10.5.2 Een Gebruikersinterface plugin
Deze plug-in zal bestaan uit een paar bestanden (om de code schoon te houden). Het toont u hoe bronnen (afbeeldingen
of databestanden) op te halen uit de plug-in’s ZIP , gebruikers toe te staan uw plug-in in te stellen, elementen in de
gebruikersinterface voor calibre te maken en de database voor boeken te raadplegen en doorzoeken.
U kan deze plugin downloaden van interface_demo_plugin.zip96

Het eerste ding om op te merken is dat dit ZIP bestand veel meer bestanden bevat, onder uitgelegd, let extra op
plugin-import-name-interface_demo.txt.

plugin-import-name-interface_demo.txt
Een leeg tekstbestand om de multi-file plugin magie in te schakelen. Dit bestand moet aanwezig zĳn
in alle plug-ins die meer dan één .py bestand gebruiken. Het moet leeg zĳn en de bestandsnaam moet
volgende vorm hebben: `` plugin-import-name-**een_naam **.txt``. Met dit bestand kunt u code im-
porteren uit de .py bestanden in het ZIP-bestand , met behulp van een statement als:

from calibre_plugins.some_name.some_module import some_object

95 https://calibre-ebook.com/downloads/helloworld_plugin.zip
96 https://calibre-ebook.com/downloads/interface_demo_plugin.zip
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De prefix calibre_plugins moet altĳd aanwezig zĳn. some_name komt van de naam van het lege
tekst bestand. some_module verwĳst naar some_module.py in het ZIP bestand. Merk op dat deze
import even machtig is als gewone Python imports. U kan packages en subpackages van .py modules
creëren in het ZIP bestand, net zoals u normaal zou doen (door __init__.py te definiëren in elke submap)
en alles zou “moeten werken”.
De naam die u gebruikt voor some_name gaat in een algemene naamruimte, gedeeld door alle plug-ins,
dus maak deze zo uniek mogelĳk. Maar vergeet niet dat het een geldig Python-id moet zĳn (alleen
alfabetten, cĳfers en het onderliggend streepje).

__init__.py
Zoals hiervoor, het bestand dat de plugin’s klasse definieert

main.py
Dit bestand bevat de daadwerkelĳke code die iets nuttigs doet

ui.py
Dit bestand definieert de interface van de plugin

images/icon.png
Het icoon voor deze plugin

about.txt
Een tekstbestand met informatie over de plugin

vertalingen
Een map die .mo-bestanden bevat met vertalingen van de gebruikersinterface van uw plug-in in ver-
schillende talen. Zie onder voor details.

Laten we naar de code kĳken.

__init__.py
Eerst de verplichte __init__.py om de plug-in’s metadata te definiëren:

from calibre.customize import InterfaceActionBase

class InterfacePluginDemo(InterfaceActionBase):

'''

This class is a simple wrapper that provides information about the actual

plugin class. The actual interface plugin class is called InterfacePlugin

and is defined in the ui.py file, as specified in the actual_plugin field

below.

The reason for having two classes is that it allows the command line

calibre utilities to run without needing to load the GUI libraries.

'''

name = 'Interface Plugin Demo'

description = 'An advanced plugin demo'

supported_platforms = ['windows', 'osx', 'linux']

author = 'Kovid Goyal'

version = (1, 0, 0)

minimum_calibre_version = (0, 7, 53)

#: This field defines the GUI plugin class that contains all the code

#: that actually does something. Its format is module_path:class_name

#: The specified class must be defined in the specified module.
(Vervolgt op volgende pagina)
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actual_plugin = 'calibre_plugins.interface_demo.ui:InterfacePlugin'

def is_customizable(self):

'''

This method must return True to enable customization via

Preferences->Plugins

'''

return True

def config_widget(self):

'''

Implement this method and :meth:`save_settings` in your plugin to

use a custom configuration dialog.

This method, if implemented, must return a QWidget. The widget can have

an optional method validate() that takes no arguments and is called

immediately after the user clicks OK. Changes are applied if and only

if the method returns True.

If for some reason you cannot perform the configuration at this time,

return a tuple of two strings (message, details), these will be

displayed as a warning dialog to the user and the process will be

aborted.

The base class implementation of this method raises NotImplementedError

so by default no user configuration is possible.

'''

# It is important to put this import statement here rather than at the

# top of the module as importing the config class will also cause the

# GUI libraries to be loaded, which we do not want when using calibre

# from the command line

from calibre_plugins.interface_demo.config import ConfigWidget

return ConfigWidget()

def save_settings(self, config_widget):

'''

Save the settings specified by the user with config_widget.

:param config_widget: The widget returned by :meth:`config_widget`.

'''

config_widget.save_settings()

# Apply the changes

ac = self.actual_plugin_

if ac is not None:

ac.apply_settings()

De enige noemenswaardige eigenschap is het veld: attr:actual_plugin. Omdat calibre zowel opdrachtregel als GUI inter-
faces heeft, mogen GUI plug-ins zoals deze geen enkele GUI-bibliotheek laden in __init__.py . Het veld actual_plugin
doet dit voor u, door calibre te zeggen dat de daadwerkelĳke plugin in een ander bestand in uw ZIP archief te vinden is,
dat alleen in een GUI context wordt geladen.
Vergeet niet dat om dit te laten werken, u een plugin-import-name-een_naam.txt bestand nodig hebt in uw ZIP plug-in,

230 Hoofdstuk 10. Lesboeken



calibre Gebruikershandleiding, Release 8.7.0

zoals boven besproken.
Er zĳn meerdere methoden om gebruikersconfiguratie van de plug-in mogelĳk te maken. Deze worden onder besproken.

ui.py
Laten we nu ui.py bekĳken dat de eigenlĳke GUI plug-in definieert. De broncode is voorzien van commentaar en zou
zichzelf moeten verklaren:

from calibre.gui2.actions import InterfaceAction

from calibre_plugins.interface_demo.main import DemoDialog

class InterfacePlugin(InterfaceAction):

name = 'Interface Plugin Demo'

# Declare the main action associated with this plugin

# The keyboard shortcut can be None if you don't want to use a keyboard

# shortcut. Remember that currently calibre has no central management for

# keyboard shortcuts, so try to use an unusual/unused shortcut.

action_spec = ('Interface Plugin Demo', None,

'Run the Interface Plugin Demo', 'Ctrl+Shift+F1')

def genesis(self):

# This method is called once per plugin, do initial setup here

# Set the icon for this interface action

# The get_icons function is a builtin function defined for all your

# plugin code. It loads icons from the plugin zip file. It returns

# QIcon objects, if you want the actual data, use the analogous

# get_resources builtin function.

#

# Note that if you are loading more than one icon, for performance, you

# should pass a list of names to get_icons. In this case, get_icons

# will return a dictionary mapping names to QIcons. Names that

# are not found in the zip file will result in null QIcons.

icon = get_icons('images/icon.png', 'Interface Demo Plugin')

# The qaction is automatically created from the action_spec defined

# above

self.qaction.setIcon(icon)

self.qaction.triggered.connect(self.show_dialog)

def show_dialog(self):

# The base plugin object defined in __init__.py

base_plugin_object = self.interface_action_base_plugin

# Show the config dialog

# The config dialog can also be shown from within

# Preferences->Plugins, which is why the do_user_config

# method is defined on the base plugin class

do_user_config = base_plugin_object.do_user_config

# self.gui is the main calibre GUI. It acts as the gateway to access

(Vervolgt op volgende pagina)
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# all the elements of the calibre user interface, it should also be the

# parent of the dialog

d = DemoDialog(self.gui, self.qaction.icon(), do_user_config)

d.show()

def apply_settings(self):

from calibre_plugins.interface_demo.config import prefs

# In an actual non trivial plugin, you would probably need to

# do something based on the settings in prefs

prefs

main.py
De eigenlĳke logica om de Interface Plugin Demo dialoog te implementeren.

from calibre_plugins.interface_demo.config import prefs

class DemoDialog(QDialog):

def __init__(self, gui, icon, do_user_config):

QDialog.__init__(self, gui)

self.gui = gui

self.do_user_config = do_user_config

# The current database shown in the GUI

# db is an instance of the class LibraryDatabase from db/legacy.py

# This class has many, many methods that allow you to do a lot of

# things. For most purposes you should use db.new_api, which has

# a much nicer interface from db/cache.py

self.db = gui.current_db

self.l = QVBoxLayout()

self.setLayout(self.l)

self.label = QLabel(prefs['hello_world_msg'])

self.l.addWidget(self.label)

self.setWindowTitle('Interface Plugin Demo')

self.setWindowIcon(icon)

self.about_button = QPushButton('About', self)

self.about_button.clicked.connect(self.about)

self.l.addWidget(self.about_button)

self.marked_button = QPushButton(

'Show books with only one format in the calibre GUI', self)

self.marked_button.clicked.connect(self.marked)

self.l.addWidget(self.marked_button)

self.view_button = QPushButton(

(Vervolgt op volgende pagina)
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'View the most recently added book', self)

self.view_button.clicked.connect(self.view)

self.l.addWidget(self.view_button)

self.update_metadata_button = QPushButton(

"Update metadata in a book's files", self)

self.update_metadata_button.clicked.connect(self.update_metadata)

self.l.addWidget(self.update_metadata_button)

self.conf_button = QPushButton(

'Configure this plugin', self)

self.conf_button.clicked.connect(self.config)

self.l.addWidget(self.conf_button)

self.resize(self.sizeHint())

def about(self):

# Get the about text from a file inside the plugin zip file

# The get_resources function is a builtin function defined for all your

# plugin code. It loads files from the plugin zip file. It returns

# the bytes from the specified file.

#

# Note that if you are loading more than one file, for performance, you

# should pass a list of names to get_resources. In this case,

# get_resources will return a dictionary mapping names to bytes. Names that

# are not found in the zip file will not be in the returned dictionary.

text = get_resources('about.txt')

QMessageBox.about(self, 'About the Interface Plugin Demo',

text.decode('utf-8'))

def marked(self):

''' Show books with only one format '''

db = self.db.new_api

matched_ids = {book_id for book_id in db.all_book_ids() if len(db.

↪→formats(book_id)) == 1}

# Mark the records with the matching ids

# new_api does not know anything about marked books, so we use the full

# db object

self.db.set_marked_ids(matched_ids)

# Tell the GUI to search for all marked records

self.gui.search.setEditText('marked:true')

self.gui.search.do_search()

def view(self):

''' View the most recently added book '''

most_recent = most_recent_id = None

db = self.db.new_api

for book_id, timestamp in db.all_field_for('timestamp', db.all_book_ids()).

↪→items():

if most_recent is None or timestamp > most_recent:

most_recent = timestamp

(Vervolgt op volgende pagina)
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most_recent_id = book_id

if most_recent_id is not None:

# Get a reference to the View plugin

view_plugin = self.gui.iactions['View']

# Ask the view plugin to launch the viewer for row_number

view_plugin._view_calibre_books([most_recent_id])

def update_metadata(self):

'''

Set the metadata in the files in the selected book's record to

match the current metadata in the database.

'''

from calibre.ebooks.metadata.meta import set_metadata

from calibre.gui2 import error_dialog, info_dialog

# Get currently selected books

rows = self.gui.library_view.selectionModel().selectedRows()

if not rows or len(rows) == 0:

return error_dialog(self.gui, 'Cannot update metadata',

'No books selected', show=True)

# Map the rows to book ids

ids = list(map(self.gui.library_view.model().id, rows))

db = self.db.new_api

for book_id in ids:

# Get the current metadata for this book from the db

mi = db.get_metadata(book_id, get_cover=True, cover_as_data=True)

fmts = db.formats(book_id)

if not fmts:

continue

for fmt in fmts:

fmt = fmt.lower()

# Get a python file object for the format. This will be either

# an in memory file or a temporary on disk file

ffile = db.format(book_id, fmt, as_file=True)

ffile.seek(0)

# Set metadata in the format

set_metadata(ffile, mi, fmt)

ffile.seek(0)

# Now replace the file in the calibre library with the updated

# file. We don't use add_format_with_hooks as the hooks were

# already run when the file was first added to calibre.

db.add_format(book_id, fmt, ffile, run_hooks=False)

info_dialog(self, 'Updated files',

f'Updated the metadata in the files of {len(ids)} book(s)',

show=True)

def config(self):

self.do_user_config(parent=self)

# Apply the changes

self.label.setText(prefs['hello_world_msg'])
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Ophalen bronnen uit het plug-in ZIP bestand
calibres plug-in laadsysteem definieert een aantal ingebouwde functies waarmee u gemakkelĳk bestanden kunt ophalen
uit het plug-in ZIP bestand.

get_resources(name_or_list_of_names)
This function should be called with a list of paths to files inside the ZIP file. For example to access the
file icon.png in the folder images in the ZIP file, you would use: images/icon.png. Always use a
forward slash as the path separator, even on Windows. When you pass in a single name, the function
will return the raw bytes of that file or None if the name was not found in the ZIP file. If you pass in
more than one name then it returns a dictionary mapping the names to bytes. If a name is not found, it
will not be present in the returned dictionary.

get_icons(name_or_list_of_names, plugin_name=’’)
Een wrapper voor get_resources() die QIcon objecten creëert van de rauwe bytes vanuit get_resources.
Werd een naam niet gevonden in het ZIP bestand, zal de overeenkomende QIcon null zĳn. Om icoon
theme-ing te ondersteunen, geef de mensvriendelĳke naam van uw plug-in in als plugin_name. Als
de gebruiker een icoonthema gebruikt met iconen voor uw plug-in, worden deze bĳ voorkeur geladen .

Gebruikers-configuratie van uw plugin inschakelen
Om gebruikers uw plug-in te laten configureren, moet u drie methoden in uw basis plug-inklasse definiëren, **
is_customizable **, ** config_widget ** en ** save_settings ** zoals onder weergegeven:

def is_customizable(self):

'''

This method must return True to enable customization via

Preferences->Plugins

'''

return True

def config_widget(self):

'''

Implement this method and :meth:`save_settings` in your plugin to

use a custom configuration dialog.

This method, if implemented, must return a QWidget. The widget can have

an optional method validate() that takes no arguments and is called

immediately after the user clicks OK. Changes are applied if and only

if the method returns True.

If for some reason you cannot perform the configuration at this time,

return a tuple of two strings (message, details), these will be

displayed as a warning dialog to the user and the process will be

aborted.

The base class implementation of this method raises NotImplementedError

so by default no user configuration is possible.

'''

# It is important to put this import statement here rather than at the

# top of the module as importing the config class will also cause the

# GUI libraries to be loaded, which we do not want when using calibre

# from the command line

from calibre_plugins.interface_demo.config import ConfigWidget

return ConfigWidget()
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def save_settings(self, config_widget):

'''

Save the settings specified by the user with config_widget.

:param config_widget: The widget returned by :meth:`config_widget`.

'''

config_widget.save_settings()

# Apply the changes

ac = self.actual_plugin_

if ac is not None:

ac.apply_settings()

calibre heeft vele manieren om configuratiegegevens te bewaren (een erfenis van lange geschiedenis). De aanbevolen
manier is het gebruik van de JSONConfig klasse, die de informatie bewaart in een .json bestand.
De code om configuratiegegevens te beheren in de demoplug-in is in config.py:

from calibre.utils.config import JSONConfig

# This is where all preferences for this plugin will be stored

# Remember that this name (i.e. plugins/interface_demo) is also

# in a global namespace, so make it as unique as possible.

# You should always prefix your config file name with plugins/,

# so as to ensure you don't accidentally clobber a calibre config file

prefs = JSONConfig('plugins/interface_demo')

# Set defaults

prefs.defaults['hello_world_msg'] = 'Hello, World!'

class ConfigWidget(QWidget):

def __init__(self):

QWidget.__init__(self)

self.l = QHBoxLayout()

self.setLayout(self.l)

self.label = QLabel('Hello world &message:')

self.l.addWidget(self.label)

self.msg = QLineEdit(self)

self.msg.setText(prefs['hello_world_msg'])

self.l.addWidget(self.msg)

self.label.setBuddy(self.msg)

def save_settings(self):

prefs['hello_world_msg'] = self.msg.text()

Het prefs object is nu beschikbaar in de plug-incode met een simpele:

from calibre_plugins.interface_demo.config import prefs
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U kunt het gebruik van prefs-object zien in main.py:

def config(self):

self.do_user_config(parent=self)

# Apply the changes

self.label.setText(prefs['hello_world_msg'])

10.5.3 Boek plug-ins bewerken
Laten we wat hoger schakelen en een plug-in creëren om tools toe te voegen aan de calibre boekeditor. De plug-in is hier
beschikbaar: editor_demo_plugin.zip97.
De eerste stap, zoals voor alle plug-ins, is het maken van het lege import name .txt bestand zoals above (pagina 228)
beschreven. We noemen het bestand plugin-import-name-editor_plugin_demo.txt.
Nu maken we het verplichte bestand __init__.py waarin de metadata over de plug-in staan – zĳn naam, maker, versie
enz.

class DemoPlugin(EditBookToolPlugin):

name = 'Edit Book plugin demo'

version = (1, 0, 0)

author = 'Kovid Goyal'

supported_platforms = ['windows', 'osx', 'linux']

description = 'A demonstration of the plugin interface for the ebook editor'

minimum_calibre_version = (1, 46, 0)

Een enkel editorplug-in kan meerdere tools leveren, iedere tool correspondeert met een knop in de werkbalk en trefwoord
in het Plug-ins menu in de editor. Deze kunnen sub-menu’s hebben indien de tool meerdere acties heeft.
De tools moeten allemaal gedefinieerd zĳn in het bestand main.py in uw plugin. Iedere tool is een class, die erft van
de calibre.gui2.tweak_book.plugin.Tool (pagina 371) class. Laten we een kĳkje nemen in main.py van de
demoplug-in, de broncode is voorzien van commentaar en zou zichzelf moeten verklaren. Lees de API-documenten van
de calibre.gui2.tweak_book.plugin.Tool (pagina 371) class voor meer details.

main.py
Hier zien we de definitie van een enkele tool dat alle lettergroottes in het boek vermenigvuldigt met een getal ingesteld
door de gebruiker. Deze tool demonstreert meerdere belangrĳke concepten die u nodig heeft om uw eigen plug-in te
ontwikkelen. Lees daarom de (goed van commentaar voorziene) broncode grondig.

from css_parser.css import CSSRule

from qt.core import QAction, QInputDialog

from calibre import force_unicode

from calibre.ebooks.oeb.polish.container import OEB_DOCS, OEB_STYLES, serialize

from calibre.gui2 import error_dialog

# The base class that all tools must inherit from

from calibre.gui2.tweak_book.plugin import Tool

(Vervolgt op volgende pagina)
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class DemoTool(Tool):

#: Set this to a unique name it will be used as a key

name = 'demo-tool'

#: If True the user can choose to place this tool in the plugins toolbar

allowed_in_toolbar = True

#: If True the user can choose to place this tool in the plugins menu

allowed_in_menu = True

def create_action(self, for_toolbar=True):

# Create an action, this will be added to the plugins toolbar and

# the plugins menu

ac = QAction(get_icons('images/icon.png'), 'Magnify fonts', self.gui) #␣

↪→noqa: F821

if not for_toolbar:

# Register a keyboard shortcut for this toolbar action. We only

# register it for the action created for the menu, not the toolbar,

# to avoid a double trigger

self.register_shortcut(ac, 'magnify-fonts-tool', default_keys=(

↪→'Ctrl+Shift+Alt+D',))

ac.triggered.connect(self.ask_user)

return ac

def ask_user(self):

# Ask the user for a factor by which to multiply all font sizes

factor, ok = QInputDialog.getDouble(

self.gui, 'Enter a magnification factor', 'Allow font sizes in the book␣

↪→will be multiplied by the specified factor',

value=2, min=0.1, max=4

)

if ok:

# Ensure any in progress editing the user is doing is present in the␣

↪→container

self.boss.commit_all_editors_to_container()

try:

self.magnify_fonts(factor)

except Exception:

# Something bad happened report the error to the user

import traceback

error_dialog(self.gui, _('Failed to magnify fonts'), _(

'Failed to magnify fonts, click "Show details" for more info'),

det_msg=traceback.format_exc(), show=True)

# Revert to the saved restore point

self.boss.revert_requested(self.boss.global_undo.previous_container)

else:

# Show the user what changes we have made, allowing her to

# revert them if necessary

self.boss.show_current_diff()

# Update the editor UI to take into account all the changes we

(Vervolgt op volgende pagina)
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# have made

self.boss.apply_container_update_to_gui()

def magnify_fonts(self, factor):

# Magnify all font sizes defined in the book by the specified factor

# First we create a restore point so that the user can undo all changes

# we make.

self.boss.add_savepoint('Before: Magnify fonts')

container = self.current_container # The book being edited as a container␣

↪→object

# Iterate over all style declarations in the book, this means css

# stylesheets, <style> tags and style="" attributes

for name, media_type in container.mime_map.items():

if media_type in OEB_STYLES:

# A stylesheet. Parsed stylesheets are css_parser CSSStylesheet

# objects.

self.magnify_stylesheet(container.parsed(name), factor)

container.dirty(name) # Tell the container that we have changed the␣

↪→stylesheet

elif media_type in OEB_DOCS:

# A HTML file. Parsed HTML files are lxml elements

for style_tag in container.parsed(name).xpath('//*[local-name="style"]

↪→'):

if style_tag.text and style_tag.get('type', None) in {None, 'text/

↪→css'}:

# We have an inline CSS <style> tag, parse it into a

# stylesheet object

sheet = container.parse_css(style_tag.text)

self.magnify_stylesheet(sheet, factor)

style_tag.text = serialize(sheet, 'text/css', pretty_

↪→print=True)

container.dirty(name) # Tell the container that we have␣

↪→changed the stylesheet

for elem in container.parsed(name).xpath('//*[@style]'):

# Process inline style attributes

block = container.parse_css(elem.get('style'), is_

↪→declaration=True)

self.magnify_declaration(block, factor)

elem.set('style', force_unicode(block.getCssText(separator=' '),

↪→'utf-8'))

def magnify_stylesheet(self, sheet, factor):

# Magnify all fonts in the specified stylesheet by the specified

# factor.

for rule in sheet.cssRules.rulesOfType(CSSRule.STYLE_RULE):

self.magnify_declaration(rule.style, factor)

def magnify_declaration(self, style, factor):

# Magnify all fonts in the specified style declaration by the specified

(Vervolgt op volgende pagina)
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# factor

val = style.getPropertyValue('font-size')

if not val:

return

# see if the font-size contains a number

num = re.search(r'[0-9.]+', val)

if num is not None:

num = num.group()

val = val.replace(num, f'{float(num)*factor:f}')

style.setProperty('font-size', val)

# We should also be dealing with the font shorthand property and

# font sizes specified as non numbers, but those are left as exercises

# for the reader

Laten we main.py bekĳken. We zien dat een enkele tool wordt gedefinieerd, Magnify fonts. Hĳ vraagt de gebruiker een
getal en vermenigvuldigt alle lettergroottes in het boek met dit getal.
Het eerste belangrĳke ding is de naam van de tool die een redelĳk unieke tekenreeks moet zĳn, deze wordt gebruikt als
sleutel voor dit gereedschap.
Het volgende belangrĳke punt is calibre.gui2.tweak_book.plugin.Tool.create_action() (pagina 372).
Deze methode maakt de QAction objecten die op de plug-inwerkbalk en het plug-inmenu verschĳnen. Optioneel wordt
ook een sneltoets toegewezen die de gebruiker kan aanpassen. Het getriggerde signaal van de QAction is verbonden met
de ask_user() methode die de gebruiker vraagt naar de lettergrootte vergrotingsfactor en vervolgens de vergrotingscode
uitvoert.
De vergrotingscode is goed becommentarieerd en vrĳ eenvoudig. De belangrĳkste dingen om op te merken zĳn dat u
een verwĳzing naar het editorvenster krĳgt als self.gui en de editor Boss als self.boss. De Boss is het object dat
de gebruikersinterface van de editor bestuurt. Het heeft veel nuttige methoden, die zĳn gedocumenteerd in de klasse
calibre.gui2.tweak_book.boss.Boss (pagina 372).
Tenslotte is er ``self.current_container’’, een verwĳzing naar het boek dat wordt bewerkt als calibre.ebooks.oeb.
polish.container.Container (pagina 364) object. Dit stelt het boek voor als een verzameling van z’n samenstel-
lende HTML/CSS/afbeeldingsbestanden en heeft handige methoden om veel nuttige dingen te doen. Het containerobject
en verschillende handige hulpprogramma’s die kunnen worden herbruikt in uw plug-incode zĳn gedocumenteerd in :ref:
polish_api.

10.5.4 Vertalingen toevoegen aan uw plugin
U kunt de teksten in het gebruikersinterface in uw plugin laten vertalen in elke taal die is ingesteld voor de calibre gebrui-
kersinterface.
De eerste stap is door uw plug-in’s broncodes te gaan en alle voor gebruikers zichtbare teksten te markeren als vertaalbaar
door ze te omgeven met _(). Bĳvoorbeeld:

action_spec = (_('My plugin'), None, _('My plugin is cool'), None)

Gebruik dan een programma om .po bestanden te genereren uit uw plug-in’s broncode . Er moet één .po-bestand zĳn
voor elke taal waarin u wilt vertalen. Bĳvoorbeeld: nl.po voor Nederlands, fr.po voor Frans enzovoort. U kunt hiervoor
het `Poedit <https://poedit.net/>`_program gebruiken.
Stuur deze .po-bestanden naar uw vertalers. Zodra u ze terug krĳgt, compileer ze in .mo-bestanden. U kunt opnieuw
Poedit daarvoor gebruiken, of doe gewoon:

calibre-debug -c "from calibre.translations.msgfmt import main; main()" filename.po
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Plaats de .mo-bestanden in de vertalingen-map in uw plug-in.
De laatste stap is om gewoon de functie load_translations() te roepen bovenaan uw plugin’s .py bestanden. Voor prestatie
redenen deze functie alleen aanroepen in die .py-bestanden die echt vertaalbare teksten bevatten. Dus in een normale
Gebruikersinterfaceplug-in roept u deze functie aan bovenin ui.py maar niet in __init__.py.
U kunt de vertalingen van uw plug-ins testen door de taal van de gebruikersinterface in calibre te wĳzigen onder Voor-
keuren → Interface → Uitstraling & gevoel of door calibre uit te voeren met de CALIBRE_OVERRIDE_LANG omgevings-
variabele ingesteld. Voorbeeld:

CALIBRE_OVERRIDE_LANG=de

Vervang de met de taalcode van de taal die u wilt testen.
For translations with plurals, use the ngettext() function instead of _(). For example:

ngettext('Delete a book', 'Delete {} books', num_books).format(num_books)

10.5.5 De plug-in API
Zoals u misschien heeft opgemerkt is een plug-in in calibre een class. Er zĳn verschillende classes voor verschillende
types plug-ins. Details van iedere class, inclusief de basis class van alle plugins zĳn te vinden in API documentatie voor
plugins (pagina 258).
Uw plugin zal bĳna zeker code gebruiken van calibre. Om te leren hoe u diverse stukjes functionaliteit vindt in de calibre
code basis, lees de sectie over calibre’s Code opmaak (pagina 346).

10.5.6 Plug-ins foutopsporing
De eerste, belangrĳkste stap is calibre draaien in foutenopsporingsmodus. U kunt dit doen in de opdrachtregel met:

calibre-debug -g

Of vanuit calibre door met de rechts te klikken op de Preferences knop of gebruik te maken van de Ctrl+Shift+R
sneltoets .
Wanneer u werkt met de opdrachtregel verschĳnt de foutoplossing op de console, wanneer u werkt in calibre zal dit naar
een .txt-bestand worden geschreven.
U kunt overal printinstructies invoegen in uw plug-incode, deze worden uitgevoerd in de foutopsporingsmodus. Vergeet
niet, dit is Python, uzou echt niets meer nodig moeten hebben dan print commando’s om te debuggen ;) Ik heb heel calibre
ontwikkeld met alleen deze foutopsporingstechniek.
U kunt snel wĳzigingen aan uw plugin testen met behulp van de volgende opdrachtregel:

calibre-debug -s; calibre-customize -b /path/to/your/plugin/folder; calibre

Dit sluit een lopende calibre af, wacht totdat het programma geheel afgesloten is, dan uw plugin updaten in calibre en
calibre herstarten.

10.5.7 Meer voorbeelden van plugins
U kan een lĳst met gesofisticeerde calibre plug-ins vinden hier98.

98 https://www.mobileread.com/forums/showthread.php?t=118764
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10.5.8 Uw plugins delen met anderen
Als u de plugins die u gemaakt hebt wilt delen met andere gebruikers van calibre, post ze onder een nieuw onderwerp in
calibre plugins forum99.

10.6 Wiskunde typesetten in e-boeken
De calibre e-boek viewer kan wiskunde tonen ingebed in e-boeken (EPUB en HTML bestanden). U kan de wiskunde direct
typesetten met TeX or MathML or AsciiMath.De calibre e-boek viewer gebruikt de uitstekende MathJax100 bibliotheek
om dit te doen. Dit is een korte tutorial over het creëren van e-boeken met wiskunde erin die goed werken met de calibre
e-boek viewer.

10.6.1 Een simpel HTML bestand met wiskunde
U kan wiskunde inline schrĳven in een eenvoudig HTML bestand en de calibre e-boek viewer zal het in correct gezette
wiskunde weergeven. In het voorbeeld onder gebruiken we TeX-notatie voor wiskunde. U zal zien dat u normale TeX
opdrachten kan gebruiken, met het kleine voorbehoud dat en-teken en, minder dan en groter dan tekens moeten worden
geschreven als &amp; &lt; en &gt; respectievelĳk.
De eerste stap is calibre te vertellen dat dit wiskunde zal bevatten. U doet dit door het volgende stukje code aan de <head>
sectie van het HTML bestand toe te voegen:

<script type="text/x-mathjax-config"></script>

Super, nu kunt u wiskunde typen net zoals u in een .tex file zou doen. Bĳvoorbeeld, hier zĳn Lorentz’s vergelĳkingen:

<h2>The Lorenz Equations</h2>

<p>

\begin{align}

\dot{x} &amp; = \sigma(y-x) \\

\dot{y} &amp; = \rho x - y - xz \\

\dot{z} &amp; = -\beta z + xy

\end{align}

</p>

Dit stukje code ziet eruit als de volgende schermafdruk in de calibre e-boek viewer.

Fig. 1: The Lorenz Equations

Het volledige HTML bestand, met meer vergelĳkingen en in-line wiskunde is onder weergegeven. U kan dit HTML
bestand in calibre naar EPUB converteren om een e-boek te maken dat u gemakkelĳk naar andere mensen kan verspreiden.

99 https://www.mobileread.com/forums/forumdisplay.php?f=237
100 https://www.mathjax.org
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<!DOCTYPE html>

<html>

<!-- Copyright (c) 2012 Design Science, Inc. -->

<head>

<title>Math Test Page</title>

<meta http-equiv="content-type" content="text/html; charset=UTF-8" />

<!-- This script tag is needed to make calibre's ebook-viewer recpgnize that this␣

↪→file needs math typesetting -->

<script type="text/x-mathjax-config">

// This line adds numbers to all equations automatically, unless explicitly␣

↪→suppressed.

MathJax.tex = {tags: 'all'};

</script>

<style>

h1 {text-align:center}

h2 {

font-weight: bold;

background-color: #DDDDDD;

padding: .2em .5em;

margin-top: 1.5em;

border-top: 3px solid #666666;

border-bottom: 2px solid #999999;

}

</style>

</head>

<body>

<h1>Sample Equations</h1>

<h2>The Lorenz Equations</h2>

<p>

\begin{align}

\dot{x} &amp; = \sigma(y-x) \label{lorenz}\\

\dot{y} &amp; = \rho x - y - xz \\

\dot{z} &amp; = -\beta z + xy

\end{align}

</p>

<h2>The Cauchy-Schwarz Inequality</h2>

<p>\[

\left( \sum_{k=1}^n a_k b_k \right)^{\!\!2} \leq

\left( \sum_{k=1}^n a_k^2 \right) \left( \sum_{k=1}^n b_k^2 \right)

\]</p>

<h2>A Cross Product Formula</h2>

<p>\[

\mathbf{V}_1 \times \mathbf{V}_2 =

\begin{vmatrix}
(Vervolgt op volgende pagina)
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\mathbf{i} &amp; \mathbf{j} &amp; \mathbf{k} \\

\frac{\partial X}{\partial u} &amp; \frac{\partial Y}{\partial u} &amp; 0 \\

\frac{\partial X}{\partial v} &amp; \frac{\partial Y}{\partial v} &amp; 0 \\

\end{vmatrix}

\]</p>

<h2>The probability of getting \(k\) heads when flipping \(n\) coins is:</h2>

<p>\[P(E) = {n \choose k} p^k (1-p)^{ n-k} \]</p>

<h2>An Identity of Ramanujan</h2>

<p>\[

\frac{1}{(\sqrt{\phi \sqrt{5}}-\phi) e^{\frac25 \pi}} =

1+\frac{e^{-2\pi}} {1+\frac{e^{-4\pi}} {1+\frac{e^{-6\pi}}

{1+\frac{e^{-8\pi}} {1+\ldots} } } }

\]</p>

<h2>A Rogers-Ramanujan Identity</h2>

<p>\[

1 + \frac{q^2}{(1-q)}+\frac{q^6}{(1-q)(1-q^2)}+\cdots =

\prod_{j=0}^{\infty}\frac{1}{(1-q^{5j+2})(1-q^{5j+3})},

\quad\quad \text{for $|q|&lt;1$}.

\]</p>

<h2>Maxwell's Equations</h2>

<p>

\begin{align}

\nabla \times \vec{\mathbf{B}} -\, \frac1c\, \frac{\partial\vec{\mathbf{E}}}{\

↪→partial t} &amp; = \frac{4\pi}{c}\vec{\mathbf{j}} \\

\nabla \cdot \vec{\mathbf{E}} &amp; = 4 \pi \rho \\

\nabla \times \vec{\mathbf{E}}\, +\, \frac1c\, \frac{\partial\vec{\mathbf{B}}}{\

↪→partial t} &amp; = \vec{\mathbf{0}} \\

\nabla \cdot \vec{\mathbf{B}} &amp; = 0

\end{align}

</p>

<h2>Inline Mathematics</h2>

<p>While display equations look good for a page of samples, the

ability to mix math and text in a paragraph is also important. This

expression \(\sqrt{3x-1}+(1+x)^2\) is an example of an inline equation. As

you see, equations can be used this way as well, without unduly

disturbing the spacing between lines.</p>

<h2>References to equations</h2>

<p>Here is a reference to the Lorenz Equations (\ref{lorenz}). Clicking on the␣

↪→equation number will take you back to the equation.</p>

(Vervolgt op volgende pagina)
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</body>

</html>

Notitie

The calibre E-book viewer supports MathML as well as TeX, but you must include the <script type="text/

x-mathjax-config"></script> line in your HTML file otherwise the MathML will not render.

10.6.2 Meer informatie
Daar de calibre e-boek viewer de MathJax bibliotheek gebruikt om wiskunde weer te geven, is de beste plaats om hulp
en meer te vinden over wiskunde in e-boeken de MathJax webstek <https://www.mathjax.org>`_.

10.7 Creëren van AZW3 • EPUB • MOBI-catalogi
calibre’s Maak catalogus functie laat u een catalogus van uw bibliotheek in verschillende formaten creëren. Deze docu-
mentatie beschrĳft de opties bĳ het genereren van een catalogus in AZW3 , EPUB en MOBI formaten.

• Selecteer boeken voor de catalogus (pagina 245)
• Inbegrepen afdelingen (pagina 246)
• Voorvoegsels (pagina 247)
• Uitgesloten boeken (pagina 247)
• Uitgesloten genres (pagina 248)
• Overige opties (pagina 248)
• Aangepaste catalogus omslagen (pagina 249)
• Extra hulpbronnen (pagina 249)

10.7.1 Selecteer boeken voor de catalogus
Als u heel uw bibliotheek gecatalogeerd wilt, verwĳder alle zoek- of filtercriteria in het hoofdvenster. Met één boek
geselecteerd, zullen alle boeken in uw bibliotheek kandidaat zĳn voor opname in de gegenereerde catalogus . Individuele
boeken kunt u uitsluiten door verschillende criteria; zie: ref:` Uitgesloten_genres` hieronder voor meer informatie.
Als u slechts een deel van uw bibliotheek wil catalogeren, hebt u twee opties:

• Maak een selectie van de boeken die u wilt catalogeren. Met meer dan één boek geselecteerd in calibres hoofdven-
ster, worden alleen de geselecteerde boeken gecatalogeerd .

• Gebruik het Zoekveld of Tag Browser om de weergegeven boeken te filteren. Alleen de weergegeven boeken worden
gecatalogeerd.

Om catalogus generatie te starten, selecteer menu-item Omzetten boeken > Creër catalogus van de boeken in uw calibre
bibliotheek. U kunt ook een Maak catalogus knop aan een werkbalk toevoegen in Voorkeuren> Interface > Werkbalken &
menu’s voor vlottere toegang tot de catalogus genereren dialoog.
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In Catalog options , selecteer AZW3, EPUB en MOBI als Cataloog formaat. In het Cataloog titel vul de naam in die u
wenst voor de gegenereerde catalogus . Als een catalogus van dezelfde naam en formaat bestaat, wordt deze vervangen
door de nieuw gegenereerde catalogus.

Activeren van Stuur catalogus automatisch naar apparaat zal de gegenereerde catalogus downloaden naar een verbonden
toestel na voltooiing.

10.7.2 Inbegrepen afdelingen

Aangevinkte onderdelen worden toegevoegd in de genereerde catalogus:
• Auteurs - alle boeken, gesorteerd op auteur, getoond in een lĳst. Losse boeken worden getoond boven boekenreek-

sen.
• Titels - alle boeken, gesorteerd op titel, getoond in een lĳst formaat.
• Reeksen - alle boeken uit een reeks, gesorteerd op reeks, getoond in een lĳst.
• Genres - individuele genres getoond in een lĳst, gesorteerd op Auteur en Reeks.
• Nieuw toegevoegd - alle boeken, gesorteerd in omgekeerde tĳdsvolgorde. Lĳst bevat boeken toegevoegd in de af-

gelopen 30 dagen, dan een maand-voor-maand overzicht van toegevoegde boeken.
• Beschrĳvingen - gedetailleerde beschrĳving van elk boek inclusief omslag-miniatuur en commentaren. Gesorteerd

op auteur met losse boeken boven de boeken in reeksen.
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10.7.3 Voorvoegsels

Met voorvoegsel-regels kunt u een voorvoegsel toevoegen aan boekenlĳsten als aan bepaalde criteria is voldaan. Bv u wilt
gelezen boeken markeren met een vinkje of boeken op uw wensenlĳst met een X.
Het aankruisvakje in de eerste kolom activeert de regel. Naam is een regelnaam die u geeft. Veld is ofwel Tags of een aan-
gepaste kolom uit uw bibliotheek. Waarde is de overeenkomende inhoud van Veld. Als een voorvoegsel-regel is vervuld,
wordt het boek gemarkeerd met het geselecteerde Voorvoegsel.
Drie voorvoegsel-regels zĳn in het bovenstaande voorbeeld gespecificeerd:

1. Boek gelezen geeft aan dat een boek met willekeurige datum in een aangepaste kolom genaamd Laatst gelezen een
vinkje als voorvoegsel krĳgt.

2. Wenslĳst item geeft aan dat elk boek met een Wensenlĳst tag een X krĳgt als voorvoegsel.
3. Bibliotheek boeken geeft aan dat elk boek met een waarde Waar (of Ja) in een aangepaste kolom Beschikbaar in

Bibliotheek dubbele pĳltjes als voorvoegsel krĳgt .
De eerste overeenkomende regel levert het voorvoegsel. Uitgeschakelde of incomplete regels worden genegeerd.

10.7.4 Uitgesloten boeken

Uitsluiting-regels bepalen welke boeken niet gecatalogiseerd worden.
Het vakje in de eerste kolom schakelt de regel in. Naam is een regelnaam die u opgeeft. Veld is ofwel Tags of een
aangepaste kolom in uw bibliotheek. Waarde komt overeen met de inhoud van Veld. Wanneer aan een uitsluiting-regel is
voldaan, wordt het boek uitgesloten van de gegenereerde catalogus.
Twee uitsluiting-regels zĳn in het bovenstaande voorbeeld gespecificeerd:

1. De Catalogi regel geeft aan dat elk boek met een Catalogus tag zal worden uitgesloten van de gegenereerde catalogus.
2. De Gearchiveerd boeken regel geeft aan dat alle boeken met een waarde van Gearchiveerd in de aangepaste kolom

Status worden uitgesloten van de gegenereerde catalogus.
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Alle regels worden geëvalueerd voor elk boek. Uitgeschakelde of onvolledige regels worden genegeerd.

10.7.5 Uitgesloten genres

Wanneer de catalogus is gegenereerd worden labels in uw gegevensbank gebruikt als genres. Bĳvoorbeeld gebruikt u de
labels “Fictie”en “Nonfictie”. Deze labels worden genres in de gegenereerde catalogus met boeken opgevoerd onder hun
betreffende genre gebaseerd op hun toegewezen labels. Een boek wordt opgevoerd in iedere genre-sectie waarvoor het
een betreffende tag heeft.
U kunt bepaalde tags ook gebruiken voor andere doeleinden zoals een + om een gelezen boek aan te geven of een vierkante
haakjes tag zoals [Amazon Freebie] voor de bron. Met de Uitgesloten genres regex kunt u tags opgeven die u niet wilt
als genres in de gegenereerde catalogus. Het standaard regex uitsluiting patroon \[.+\]\+ sluit alle tags uit in de form
[tag] evenals +, standaard tag voor gelezen boeken, van het gebruik als genres in de gegenereerde catalogus.
U kunt ook een exacte tag-naam gebruiken in een regex. Bĳvoorbeeld [Amazon Freebie] of [Project Guten-

berg]. Indien u meerdere extacte labels voor uitsluiting wilt opgeven zet u een verticale streep ertussen: [Amazon
Freebie]|[Project Gutenberg].
Regex-resultaten toont welke labels worden uitgesloten wanneer de catalogus is gemaakt, gebaseerd op de labels in uw
database en de regex-patronen die u invoert. De resultaten worden bĳgewerkt als u de regex wĳzigt.

10.7.6 Overige opties

Catalogus cover bepaalt of er een nieuwe cover wordt gegenereerd of een bestaande gebruikt. Het is mogelĳk een aange-
paste cover voor uw catalogus te creëren - kĳk op aangepaste_catalogus_covers voor meer informatie. Als u een gecre-
eerde cover terug wilt gebruiken, selecteer Gebruik bestaande cover. Selecteer anders Genereer nieuwe cover.
Extra Beschrĳving notitie specificeert het invoegen van aangepaste kolom inhoud in de pagina Beschrĳving, naast de
miniatuur cover. Bv. u wilt de datum tonen wanneer u een boek voor het laatst gelezen hebt met een Laatst gelezen
aangepaste kolom. Voor geavanceerd gebruik van de Beschrĳving notitie functie, lees dit bericht in het calibre forum101.
Miniatuur breedte specificeert de voorkeursbreedte voor omslag-miniaturen in de pagina Beschrĳving. Miniaturen worden
gecached om de snelheid te verbeteren. Bĳ experimenteren met verschillende breedtes, probeer een catalogus met maar
een paar boeken totdat u de gewenste breedte heeft, genereer dan uw volledige catalogus. Het eerste genereren van een
catalogus met een nieuwe miniatuurbreedte zal trager zĳn maar de volgende uitvoeringen van de catalogus hebben voordeel
van de miniaturencache.

101 http://www.mobileread.com/forums/showpost.php?p=1335767&postcount=395
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Samenvoegen met commentaar specificeert een aangepaste kolom wiens inhoud niet-destructief samengevoegd wordt met
de commentaar metadata tĳdens catalogusgeneratie. Bv. u hebt een aangepaste kolom Auteur bio die u wilt toevoegen
aan de commentaar metadata. U kan kiezen om de inhoud van de aangepaste kolom voor of na de commentaar sectie te
plaatsen, en optioneel de toegevoegde inhoud afscheiden met een horizontale streep. Mogelĳke kolomtypes zĳn tekst,
commentaar en samengesteld.

10.7.7 Aangepaste catalogus omslagen

Met de Generate Cover plugin102 geïnstalleerd, kun je aa,gepaste
covers toevoegen aan je catalogus. Om de plugin te installeren, ga naar Preferences > Advanced > Plugins > Get new
plugins.

10.7.8 Extra hulpbronnen
Voor meer informatie over calibres catalogus functionaliteit, bezoek het MobileRead forum sticky Creating Catalogs -
Start here103, waar u informatie kunt vinden hoe een catalogus template aan te passen aan uw wensen, en hoe u een bug
report op te stellen.
Voor vragen of om calibres Catalogus eigenschap te bespreken met anderen, bezoek het MobileRead forum Library
Management104.

10.8 Virtuele bibliotheken
Een virtuele bibliotheek is een manier om in calibre een bepaald deel van uw bibliotheek te openen. Bĳvoorbeeld: U wilt
alleen werken met boeken van een bepaalde auteur of boeken met een bepaalde tag. Het gebruik van virtuele bibliotheken
is de voorkeurwĳze om uw grote boekenverzameling op te splitsen in kleinere verzamelingen. Deze manier is beter dan het
opdelen van uw bibliotheek in kleine bibliotheken omdat, als u uw gehele collectie wilt doorzoeken, u eenvoudig teruggaat
naar de gehele bibliotheek. Er bestaat geen mogelĳkheid om meerdere afzonderlĳke bibliotheken tegelĳk te doorzoeken.
Een Virtuele bibliotheek verschilt van een gewone zoekopdracht. Een zoekopdracht beperkt alleen de lĳst met boeken
getoond in de boekenlĳst. Een Virtuele bibliotheek doet dat en beperkt ook de vermeldingen in de :guilabel: Tagbrowser

102 https://www.mobileread.com/forums/showthread.php?t=124219
103 https://www.mobileread.com/forums/showthread.php?t=118556
104 https://www.mobileread.com/forums/forumdisplay.php?f=236
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links. De Tag-browser toont alleen labels, auteurs, series, uitgevers, enz. afkomstig van de boeken in de Virtuele biblio-
theek. Een Virtuele bibliotheek gedraagt zich dus alsof de bibliotheek alleen de beperkte verzameling boeken bevat.

10.8.1 Virtuele bibliotheken maken

Voor gebruik van een Virtuele bibliotheek, klik op de :guilabel :Virtuele bibliotheek
knop links van de zoekbalk en selecteer de :guilabel:` Creëer Virtuele Bibliotheek` optie. Laten we als eerste voorbeeld
een virtuele bibliotheek maken die alleen boeken van een bepaalde auteur laat zien. Klik op de :guilabel :Auteurs link
zoals in de afbeelding onder, kies de auteur die u wilt gebruiken en klik op OK.

De dialoog Virtuele bibliotheek maken is voor u ingevuld. Klik op OK en u ziet dat een nieuwe Virtuele bibliotheek is
gemaakt, en ernaar toe omgeschakeld, enkel de boeken van de geselecteerde auteur weergevend. Wat calibre betreft, is
het alsof uw bibliotheek alleen boeken van de geselecteerde auteur bevat.
U kan altĳd terugschakelen naar de volledige bibliotheek door nogmaals op Virtuele bibliotheek te klikken en <None> te
selecteren.
Virtuele bibliotheken zĳn gebaseerd op zoekopdrachten. U kunt elke zoekopdracht gebruiken als basis voor een virtuele
bibliotheek. De virtuele bibliotheek bevat alleen de boeken die daarmee overeenkomen. Tik eerst de zoekopdracht die u
wilt gebruiken in de zoekbalk of bouw ze op met de: guilabel: Tagbrowser. Als u tevreden bent met de resultaten, klik op
de knop Virtuele bibliotheek, kies: guilabel: Bibliotheek maken en voer er een naam voor in. De virtuele bibliotheek wordt
dan gemaakt op basis van de zoekopdracht die u net hebt ingevoerd. Zoekopdrachten zĳn zeer krachtig, voor voorbeelden
van dingen die u ermee kunt doen, zie: ref: search_interface.

Voorbeelden van handige Virtuele bibliotheken
• Boeken toegevoegd aan calibre in de laatste dag:

date:>1daysago
• Boeken toegevoegd aan Calibre in de laatste maand:

date:>30daysago
• Boeken met een waardering van 5 sterren:

rating:5
• Boeken met een waardering van minimaal 4 sterren:

rating:>=4
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• Boeken zonder waardering:
rating:false

• Tĳdschriften gedownload door de Fetch Nieuws functie in calibre:
labels:=News and author:=Calibre

• Boeken zonder labels:
labels:false

• Boeken zonder omslag:
cover:false

10.8.2 Werken met virtuele bibliotheken
U kan een eerder aangemaakte Virtuele bibliotheek bewerken of verwĳderen door op het :guilabel: ‘Virtuele bibliotheek’
te klikken en de geschikte actie te kiezen.
U kunt calibre instellen om altĳd een bepaalde virtuele bibliotheek te gebruiken als de huidige bibliotheek geopend is, ga
naar Voorkeuren → Interface → Gedrag.
U kan de huidige zoekopdracht snel als een tĳdelĳke Virtuele bibliotheek gebruiken, klik op de Virtuele Bibliotheek knop
en kies de *huidige zoekopdracht.
U kan alle beschikbare virtuele bibliotheken als tabs boven het boekenoverzicht tonen. Dit is vooral handig als u veel
tussen virtuele bibliotheken wilt wisselen. Klik op de knop Virtuele bibliotheek en selecteer Toon virtuele bibliotheken als
tabs. U kan de tabs verplaatsen door slepen en neerzetten en die sluiten die u niet wilt zien. Gesloten tabs herstelt u door
rechts te klikken op de tabbalk.

10.8.3 Virtuele bibliotheken gebruiken in zoekopdrachten
U kan boeken zoeken in een virtuele bibliotheek met het voorvoegsel vl:. Bĳvoorbeeld: `` vl:Gelezen`` vindt alle boeken
in de Gelezen virtuele bibliotheek. De zoekopdracht `` vl:Gelezen en vl:”Science Fiction” vindt alle boeken in zowel de
virtuele bibliotheek Gelezen als Science Fiction.
De waarde na ``vl:’’ moet de naam van een virtuele bibliotheek zĳn. Bevat de naam van de virtuele bibliotheek spaties,
omring deze dan met aanhalingstekens.
Nut voor een Virtuele bibliotheek is in de Content server. In Voorkeuren → Delen → Delen via (inter)net → Vraag gebrui-
kersnaam en wachtwoord kan u calibre bibliotheken zichtbaar voor een gebruiker beperken. Voor elke zichtbare biblio-
theek kan u een zoekexpressie specificeren om verder te beperken welke boeken zichtbaar zĳn. Gebruik vl:"Virtuele
bibliotheek naam" om de boeken te beperken tot deze in een Virtuele bibliotheek.

10.8.4 Gebruik van extra restricties
U kunt boeken getoond in een Virtuele Bibliotheek verder beperken met Extra beperkingen. Een extra beperking is een
opgeslagen zoekopdracht die u eerder heeft gemaakt die op de huidige Virtuele Bibliotheek wordt toegepast om verder
boeken te beperken getoond in de Virtuele bibliotheek. Bv: U heeft een Virtuele Bibliotheek voor boeken getagd als
Historische Fictie en een opgeslagen zoekopdracht voor ongelezen boeken. Klik op de knop Virtuele Bibliotheek en kies de
optie Extra beperkingen om alleen ongelezen Historische Fictie boeken te tonen. Meer over opgeslagen zoekopdrachten
op Zoekopdrachten opslaan (pagina 17).
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Het calibre:// URL schema

calibre registreert zichzelf als het programma voor calibre:// URLs. U kan deze dus gebruiken voor acties als boeken
openen, zoeken naar boeken, enz van andere programma’s/documenten of via de opdrachtregel. Bĳvoorbeeld, het volgende
uitvoeren via de opdrachtregel:

calibre calibre://switch-library/Some_Library

Opent calibre met de bibliotheek Some Library. Bibliotheek namen zĳn de mapnaam van de bibliotheekmap met spaties
vervangen door onderliggende streepjes. De speciale waarde _ betekent huidige bibliotheek. De verschillende URL types
zĳn hieronder gedocumenteerd.
U kan deze links zelfs in HTML bestanden of Word documenten zetten en het besturingssysteem zal automatisch calibre
starten om de gespecificeerde actie uit te voeren.

• Wissen naar een specifieke bibliotheek (pagina 253)
• Toon een specifiek boek in calibre (pagina 254)
• Open een specifiek boek in de e-boek viewer op een specifieke plaats (pagina 254)
• Naar boeken zoeken (pagina 254)
• Open a book details window on a book in some library (pagina 255)
• Open the notes associated with an author/series/etc. (pagina 255)
• Hex codering van URL parameters (pagina 255)

11.1 Wissen naar een specifieke bibliotheek
De URL syntax is

calibre://switch-library/Library_Name
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Bibliotheeknamen zĳn de mapnaam van de bibliotheek, spaties vervangen door onderliggende streepjes. Speciale waarde
_ betekent huidige bibliotheek. U kan ook hex codering (pagina 255) voor de bibliotheeknamen gebruiken, nuttig als de
bibliotheek namen speciale karakters bevatten die anders URL codering nodig hebben. Hex gecodeerde bibliotheeknamen
lĳken op:

_hex_-AD23F4BC

Waar het deel na de _hex_- prefix is de bibliotheeknaam in UTF-8 en elke byte voorgesteld wordt door 2 hexadecimale
karakters.

11.2 Toon een specifiek boek in calibre
De URL syntax is

calibre://show-book/Library_Name/book_id

Dit toont het boek met book_id (een nummer) in calibre. De boeken ids zĳn zichtbaar in de calibre interface door over
de Klik om te openen link in het Boek details paneel te hoveren, het is het nummer tussen haakjes aan het einde van het
pad naar de boekmap.
U kan een link naar het nu getoonde boek in calibre kopiëren door rechts te klikken op het Boek details paneel en Kopieer
link naar boek te kiezen.
If a search is active and the book is not matched by the search then the search is cleared.
If a Virtual library is selected, calibre will use it when showing the book. If the book isn’t found in that virtual library
then the virtual library is cleared.
If you want to switch to a particular Virtual library when showing the book, use:

calibre://show-book/Library_Name/book_id?virtual_library=Library%20Name

or

calibre://show-book/Library_Name/book_id?encoded_virtual_library=hex_encoded_virtual_

↪→library_name

replacing spaces in the Virtual library name by %20. If the book isn’t found in that virtual library then the virtual library
is ignored.

11.3 Open een specifiek boek in de e-boek viewer op een specifieke
plaats

De URL syntax is

calibre://view-book/Library_Name/book_id/book_format?open_at=location

Hier is book_format het formaat van het boek, bv. EPUB or MOBI en de locatie is een optionele locatie in het boek.
De gemakkelĳkste manier om deze links te krĳgen is door het boek te openen in de viewer, selecteer dan in de viewer
controls Ga naar → Locatie en daar vindt u zo’n link die u naar ergens kan kopiëren/plakken.

11.4 Naar boeken zoeken
De URL syntax is
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calibre://search/Library_Name?q=query

calibre://search/Library_Name?eq=hex_encoded_query

Zoeken is hier elke geldige search expression (pagina 12). Als de zoekuitdrukking ingewikkeld is, codeer als hex string
(pagina 255) en gebruik eq in de plaats. De zoekopdracht leeg laten zal de huidige zoekopdracht wissen.
Als een Virtuele bibliotheek is geselecteerd,zal calibre ze standaard leegmaken voor het zoeken zodat alle boeken zeker
gevonden worden. Als u de Virtuele bibliotheek wil behouden, gebruik:

calibre://search/Library_Name?q=query&virtual_library=_

Als u naar een bepaalde Virtuele bibliotheek wil schakelen, gebruik:

calibre://search/Library_Name?virtual_library=Library%20Name

or

calibre://search/Library_Name?encoded_virtual_library=hex_encoded_virtual_library_name

vervang spaties in naam Virtuele bibliotheek door “%20”.
Als u in calibre zoekt en een link wil genereren daarvoor, kan u dat doen door rechts te klikken op de zoekbalk en Kopieer
zoekopdracht als URL te kiezen.

11.5 Open a book details window on a book in some library
De URL syntax is

calibre://book-details/Library_Name/book_id

This opens a book details window on the specified book from the specified library without changing the current library
or the selected book.

11.6 Open the notes associated with an author/series/etc.
De URL syntax is

calibre://book-details/Library_Name/Field_Name/id_Item_Id

This opens a window showing the notes of the specified item. The easiest way to create such URLs is to show the notes
you want in calibre and click the Copy URL button to copy the URL to the clipboard and paste it wherever you need.
Here Field_Name is the name of the columns such as authors or tags. For user created columns, replace the leading
# in the field name with an underscore, so #mytags becomes _mytags.
In addition to specifying items by id using Item_Id you can also specify them by name using either val_Item_Name
or hex_Hex_Encoded_Item_Name. For example:

calibre://book-details/Library_Name/authors/val_John%20Doe

11.7 Hex codering van URL parameters
Hex codering van URL parameters gebeurt door eerst de parameter als UTF-8 bytes te coderen en dan elke byte te
vervangen door twee hex karakters die de byte voorstellen. Bv. de string abc zĳn de bytes 0x61 0x62 en 0x63 in
UTF-8, dus de gecodeerde versie is de string: 616263.
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calibre aanpassen

calibre heeft een zeer modulair ontwerp. Veel stukken kunnen aangepast worden. Hier leert u:
• hoe omgevingsvariabelen te gebruiken en tweaks om calibre’s gedrag aan te passen.
• hoe uw eigen statische bronnen specificeren zoals iconen en sjablonen om de standaard te negeren
• hoe plug-ins gebruiken om bĳkomende functionaliteit toe te voegen aan calibre.
• hoe icoonthema’s en plug-ins delen met andere calibre gebruikers.
• kĳk hoe u “recepten” kan creëren om nieuwe online inhoudsbronnen aan calibre toe te voegen in de Sectie nieuws.

Notitie

Merk op dat alhoewel icoonthema’s en plug-ins geïndexeerd zĳn en downloadbaar via calibre’s ingebouwde updater,
ze geen deel van calibre zĳn en hun officiële plaats voor ondersteuning en broncode zĳn de Mobileread forums105 in
hun ondersteuningsdraadjes.

• Omgevingsvariabelen (pagina 289)
• Truckjes (pagina 290)
• Iconen, sjablonen, enz. overschrĳven (pagina 302)
• Maak uw eigen icon thema voor Calibre (pagina 303)
• calibre personaliseren met plugins (pagina 303)

105 https://www.mobileread.com/forums/forumdisplay.php?f=166
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12.1 API documentatie voor plugins
Definieert verschillende abstracte basis verdelingen die kunnen worden onderverdeeld om sterke plugins te creëren. De
handige verdelingen zĳn:

• Plugin (pagina 258)
• BestandsTypePlugin (pagina 260)
• Metadata plugins (pagina 262)
• Catalogus plugins (pagina 263)
• Metadata download plugins (pagina 264)
• Omzet plugins (pagina 267)
• Device drivers (pagina 270)
• User interface actions (pagina 283)
• Preferences plugins (pagina 287)

12.1.1 Plugin
class calibre.customize.Plugin(plugin_path)

Een Calibre plugin. Nuttige onderdelen bevatten:
• self.installation_type: Stores how the plugin was installed.
• self.plugin_path: slaat pad op naar het ZIP-bestand dat bevat

deze plugin of None als het een ingebouwde plugin betreft
• self.site_customization: slaat een aanpassingsreeks op die is ingevoerd

door de gebruiker.
Methoden die moeten worden opgeheven in subklassen:

• iinitialiseren()

• customization_help() (pagina 260)
Nuttige methodes:

• temporary_file() (pagina 260)
• __enter__()

• load_resources() (pagina 259)
supported_platforms = []

Lĳst van platformen waar deze plugin op werkt. Bĳvoorbeeld: ['windows', 'osx', 'linux']

name = 'Trivial Plugin'

De naam van de plug-in. Deze mag geen Trivial Plugin heten.
version = (1, 0, 0)

De versie van deze plugin in 3’en (hoofd, sub, herziening)
description = 'Doet helemaal niets'

Een korte tekst die beschrĳft wat de plugin doet
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author = 'Onbekend'

De maker van deze plugin
priority = 1

When more than one plugin exists for a filetype, the plugins are run in order of decreasing priority. Plugins
with higher priority will be run first. The highest possible priority is sys.maxsize. Default priority is 1.

minimum_calibre_version = (0, 4, 118)

The earliest version of calibre this plugin requires
installation_type = None

The way this plugin is installed
can_be_disabled = True

If False, the user will not be able to disable this plugin. Use with care.
type = 'Basis'

The type of this plugin. Used for categorizing plugins in the GUI
initialize()

Called once when calibre plugins are initialized. Plugins are re-initialized every time a new plugin is added.
Also note that if the plugin is run in a worker process, such as for adding books, then the plugin will be
initialized for every new worker process.
Perform any plugin specific initialization here, such as extracting resources from the plugin ZIP file. The path
to the ZIP file is available as self.plugin_path.
Note that self.site_customization is not available at this point.

config_widget()

Implement this method and save_settings() (pagina 259) in your plugin to use a custom configuration
dialog, rather then relying on the simple string based default customization.
This method, if implemented, must return a QWidget. The widget can have an optional method validate()
that takes no arguments and is called immediately after the user clicks OK. Changes are applied if and only
if the method returns True.
If for some reason you cannot perform the configuration at this time, return a tuple of two strings (message,
details), these will be displayed as a warning dialog to the user and the process will be aborted.

save_settings(config_widget)
Save the settings specified by the user with config_widget.

Parameters
config_widget – The widget returned by config_widget() (pagina 259).

do_user_config(parent=None)
This method shows a configuration dialog for this plugin. It returns True if the user clicks OK, False otherwise.
The changes are automatically applied.

load_resources(names)
If this plugin comes in a ZIP file (user added plugin), this method will allow you to load resources from the
ZIP file.
Bĳvoorbeeld om een afbeelding te laden:

pixmap = QPixmap()

pixmap.loadFromData(self.load_resources(['images/icon.png'])['images/icon.png

↪→'])

icon = QIcon(pixmap)
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Parameters
names – List of paths to resources in the ZIP file using / as separator

Returns
A dictionary of the form {name: file_contents}. Any names that were not found in the
ZIP file will not be present in the dictionary.

customization_help(gui=False)
Return a string giving help on how to customize this plugin. By default raise a NotImplementedError,
which indicates that the plugin does not require customization.
If you re-implement this method in your subclass, the user will be asked to enter a string as customization for
this plugin. The customization string will be available as self.site_customization.
Site customization could be anything, for example, the path to a needed binary on the user’s computer.

Parameters
gui – Indien waar, geef HTML hulp terug, anders platte tekst hulp.

temporary_file(suffix)
Return a file-like object that is a temporary file on the file system. This file will remain available even after
being closed and will only be removed on interpreter shutdown. Use the name member of the returned object
to access the full path to the created temporary file.

Parameters
suffix – Het achtervoegsel dat het tĳdelĳke bestand zal krĳgen.

cli_main(args)
This method is the main entry point for your plugins command line interface. It is called when the user does:
calibre-debug -r “Plugin Name”. Any arguments passed are present in the args variable.

12.1.2 BestandsTypePlugin
class calibre.customize.FileTypePlugin(plugin_path)

Basisklassen: Plugin (pagina 258)
A plugin that is associated with a particular set of file types.
file_types = {}

Set of file types for which this plugin should be run. Use ‘*’ for all file types. For example: {'lit', 'mobi',

'prc'}

on_import = False

If True, this plugin is run when books are added to the database
on_postimport = False

If True, this plugin is run after books are added to the database. In this case the postimport and postadd
methods of the plugin are called.

on_postconvert = False

If True, this plugin is run after a book is converted. In this case the postconvert method of the plugin is called.
on_postdelete = False

If True, this plugin is run after a book file is deleted from the database. In this case the postdelete method of
the plugin is called.

on_preprocess = False

If True, this plugin is run just before a conversion
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on_postprocess = False

If True, this plugin is run after conversion on the final file produced by the conversion output plugin.
type = 'Bestandstype'

The type of this plugin. Used for categorizing plugins in the GUI
run(path_to_ebook)

Run the plugin. Must be implemented in subclasses. It should perform whatever modifications are required
on the e-book and return the absolute path to the modified e-book. If no modifications are needed, it should
return the path to the original e-book. If an error is encountered it should raise an Exception. The default
implementation simply return the path to the original e-book. Note that the path to the original file (before
any file type plugins are run, is available as self.original_path_to_file).
The modified e-book file should be created with the temporary_file() method.

Parameters
path_to_ebook – Absolute path to the e-book.

Returns
Absolute path to the modified e-book.

postimport(book_id, book_format, db)
Called post import, i.e., after the book file has been added to the database. Note that this is different from
postadd() (pagina 261) which is called when the book record is created for the first time. This method is
called whenever a new file is added to a book record. It is useful for modifying the book record based on the
contents of the newly added file.

Parameters
• book_id – Gegevensbank id van het toegevoegde boek.
• book_format – Het bestandsformaat van het toegevoegde boek.
• db – Bibliotheek gegevensbank

postconvert(book_id, book_format, db)
Called post conversion, i.e., after the conversion output book file has been added to the database. Note that
it is run after a conversion only, not after a book is added. It is useful for modifying the book record based
on the contents of the newly added file.

Parameters
• book_id – Gegevensbank id van het toegevoegde boek.
• book_format – Het bestandsformaat van het toegevoegde boek.
• db – Bibliotheek gegevensbank

postdelete(book_id, book_format, db)
Called post deletion, i.e., after the book file has been deleted from the database. Note that it is not run when
a book record is deleted, only when one or more formats from the book are deleted. It is useful for modifying
the book record based on the format of the deleted file.

Parameters
• book_id – Gegevensbank id van het toegevoegde boek.
• book_format – Het bestandsformaat van het toegevoegde boek.
• db – Bibliotheek gegevensbank
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postadd(book_id, fmt_map, db)
Called post add, i.e. after a book has been added to the db. Note that this is different from postimport()

(pagina 261), which is called after a single book file has been added to a book. postadd() is called only when
an entire book record with possibly more than one book file has been created for the first time. This is useful
if you wish to modify the book record in the database when the book is first added to calibre.

Parameters
• book_id – Gegevensbank id van het toegevoegde boek.
• fmt_map – Map of file format to path from which the file format was added. Note that this

might or might not point to an actual existing file, as sometimes files are added as streams.
In which case it might be a dummy value or a non-existent path.

• db – Bibliotheek gegevensbank

12.1.3 Metadata plugins
class calibre.customize.MetadataReaderPlugin(*args, **kwargs)

Basisklassen: Plugin (pagina 258)
A plugin that implements reading metadata from a set of file types.
file_types = {}

Set of file types for which this plugin should be run. For example: set(['lit', 'mobi', 'prc'])

supported_platforms = ['windows', 'osx', 'linux']

Lĳst van platformen waar deze plugin op werkt. Bĳvoorbeeld: ['windows', 'osx', 'linux']

version = (8, 7, 0)

De versie van deze plugin in 3’en (hoofd, sub, herziening)
author = 'Kovid Goyal'

De maker van deze plugin
type = 'Metagegevens-lezer'

The type of this plugin. Used for categorizing plugins in the GUI
get_metadata(stream, type)

Return metadata for the file represented by stream (a file like object that supports reading). Raise an exception
when there is an error with the input data.

Parameters
type – The type of file. Guaranteed to be one of the entries in file_types (pagina 262).

Returns
A calibre.ebooks.metadata.book.Metadata object

class calibre.customize.MetadataWriterPlugin(*args, **kwargs)

Basisklassen: Plugin (pagina 258)
A plugin that implements reading metadata from a set of file types.
file_types = {}

Set of file types for which this plugin should be run. For example: set(['lit', 'mobi', 'prc'])

supported_platforms = ['windows', 'osx', 'linux']

Lĳst van platformen waar deze plugin op werkt. Bĳvoorbeeld: ['windows', 'osx', 'linux']
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version = (8, 7, 0)

De versie van deze plugin in 3’en (hoofd, sub, herziening)
author = 'Kovid Goyal'

De maker van deze plugin
type = 'Metagegevens-schrijver'

The type of this plugin. Used for categorizing plugins in the GUI
set_metadata(stream, mi, type)

Set metadata for the file represented by stream (a file like object that supports reading). Raise an exception
when there is an error with the input data.

Parameters
• type – The type of file. Guaranteed to be one of the entries in file_types (pagina 262).
• mi – A calibre.ebooks.metadata.book.Metadata object

12.1.4 Catalogus plugins
class calibre.customize.CatalogPlugin(plugin_path)

Basisklassen: Plugin (pagina 258)
Een plugin welke een catalogus generator implementeert.
file_types = {}

Output file type for which this plugin should be run. For example: ‘epub’ or ‘xml’
type = 'Catalogusgenerator'

The type of this plugin. Used for categorizing plugins in the GUI
cli_options = []

CLI parser options specific to this plugin, declared as namedtuple Option:
from collections import namedtuple Option = namedtuple(‘Option’, ‘option, default, dest, help’) cli_options
= [Option(’–catalog-title’, default = ‘My Catalog’, dest = ‘catalog_title’, help = (_(‘Title of generated catalog.
nDefault:’) + “ ‘” + ‘%default’ + “’”))] cli_options parsed in calibre.db.cli.cmd_catalog:option_parser()

initialize()

If plugin is not a built-in, copy the plugin’s .ui and .py files from the ZIP file to $TMPDIR. Tab will be
dynamically generated and added to the Catalog Options dialog in calibre.gui2.dialogs.catalog.py:Catalog

run(path_to_output, opts, db, ids, notification=None)
Run the plugin. Must be implemented in subclasses. It should generate the catalog in the format specified in
file_types, returning the absolute path to the generated catalog file. If an error is encountered it should raise
an Exception.
The generated catalog file should be created with the temporary_file() method.

Parameters
• path_to_output – Absolute path to the generated catalog file.
• opts – A dictionary of keyword arguments
• db – Een LibraryDatabase2 object
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12.1.5 Metadata download plugins
class calibre.ebooks.metadata.sources.base.Source(*args, **kwargs)

Basisklassen: Plugin (pagina 258)
type = 'Externe metagegevensbron'

The type of this plugin. Used for categorizing plugins in the GUI
author = 'Kovid Goyal'

De maker van deze plugin
supported_platforms = ['windows', 'osx', 'linux']

Lĳst van platformen waar deze plugin op werkt. Bĳvoorbeeld: ['windows', 'osx', 'linux']

capabilities = frozenset({})

Set of capabilities supported by this plugin. Useful capabilities are: ‘identify’, ‘cover’
touched_fields = frozenset({})

List of metadata fields that can potentially be download by this plugin during the identify phase
has_html_comments = False

Set this to True if your plugin returns HTML formatted comments
supports_gzip_transfer_encoding = False

Setting this to True means that the browser object will indicate that it supports gzip transfer encoding. This
can speedup downloads but make sure that the source actually supports gzip transfer encoding correctly first

ignore_ssl_errors = False

Set this to True to ignore HTTPS certificate errors when connecting to this source.
cached_cover_url_is_reliable = True

Cached cover URLs can sometimes be unreliable (i.e. the download could fail or the returned image could
be bogus). If that is often the case with this source, set to False

options = ()

A list of Option objects. They will be used to automatically construct the configuration widget for this plugin
config_help_message = None

A string that is displayed at the top of the config widget for this plugin
can_get_multiple_covers = False

If True this source can return multiple covers for a given query
auto_trim_covers = False

If set to True covers downloaded by this plugin are automatically trimmed.
prefer_results_with_isbn = True

If set to True, and this source returns multiple results for a query, some of which have ISBNs and some of
which do not, the results without ISBNs will be ignored

is_configured()

Return False if your plugin needs to be configured before it can be used. For example, it might need a
username/password/API key.

customization_help()

Return a string giving help on how to customize this plugin. By default raise a NotImplementedError,
which indicates that the plugin does not require customization.
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If you re-implement this method in your subclass, the user will be asked to enter a string as customization for
this plugin. The customization string will be available as self.site_customization.
Site customization could be anything, for example, the path to a needed binary on the user’s computer.

Parameters
gui – Indien waar, geef HTML hulp terug, anders platte tekst hulp.

config_widget()

Implement this method and save_settings() (pagina 265) in your plugin to use a custom configuration
dialog, rather then relying on the simple string based default customization.
This method, if implemented, must return a QWidget. The widget can have an optional method validate()
that takes no arguments and is called immediately after the user clicks OK. Changes are applied if and only
if the method returns True.
If for some reason you cannot perform the configuration at this time, return a tuple of two strings (message,
details), these will be displayed as a warning dialog to the user and the process will be aborted.

save_settings(config_widget)
Save the settings specified by the user with config_widget.

Parameters
config_widget – The widget returned by config_widget() (pagina 265).

get_author_tokens(authors, only_first_author=True)
Take a list of authors and return a list of tokens useful for an AND search query. This function tries to return
tokens in first name middle names last name order, by assuming that if a comma is in the author name, the
name is in lastname, other names form.

get_title_tokens(title, strip_joiners=True, strip_subtitle=False)
Take a title and return a list of tokens useful for an AND search query. Excludes connectives(optionally) and
punctuation.

split_jobs(jobs, num)
Split a list of jobs into at most num groups, as evenly as possible

test_fields(mi)
Return the first field from self.touched_fields that is null on the mi object

clean_downloaded_metadata(mi)
Call this method in your plugin’s identify method to normalize metadata before putting the Metadata object
into result_queue. You can of course, use a custom algorithm suited to your metadata source.

get_book_url(identifiers)
Return a 3-tuple or None. The 3-tuple is of the form: (identifier_type, identifier_value, URL). The URL
is the URL for the book identified by identifiers at this source. identifier_type, identifier_value specify the
identifier corresponding to the URL. This URL must be browsable to by a human using a browser. It is meant
to provide a clickable link for the user to easily visit the books page at this source. If no URL is found, return
None. This method must be quick, and consistent, so only implement it if it is possible to construct the URL
from a known scheme given identifiers.

get_book_url_name(idtype, idval, url)
Return a human readable name from the return value of get_book_url().

get_book_urls(identifiers)

Override this method if you would like to return multiple URLs for this book. Return a list of 3-tuples. By
default this method simply calls get_book_url() (pagina 265).
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get_cached_cover_url(identifiers)
Return cached cover URL for the book identified by the identifiers dictionary or None if no such URL exists.
Note that this method must only return validated URLs, i.e. not URLS that could result in a generic cover
image or a not found error.

id_from_url(url)

Parse a URL and return a tuple of the form: (identifier_type, identifier_value). If the URL does not match
the pattern for the metadata source, return None.

identify_results_keygen(title=None, authors=None, identifiers={})
Return a function that is used to generate a key that can sort Metadata objects by their relevance given a search
query (title, authors, identifiers).
These keys are used to sort the results of a call to identify() (pagina 266).
For details on the default algorithm see InternalMetadataCompareKeyGen (pagina 267). Re-implement
this function in your plugin if the default algorithm is not suitable.

identify(log, result_queue, abort, title=None, authors=None, identifiers={}, timeout=30)
Identify a book by its Title/Author/ISBN/etc.
If identifiers(s) are specified and no match is found and this metadata source does not store all related iden-
tifiers (for example, all ISBNs of a book), this method should retry with just the title and author (assuming
they were specified).
If this metadata source also provides covers, the URL to the cover should be cached so that a subsequent call
to the get covers API with the same ISBN/special identifier does not need to get the cover URL again. Use
the caching API for this.
Every Metadata object put into result_queue by this method must have a source_relevance attribute that is
an integer indicating the order in which the results were returned by the metadata source for this query. This
integer will be used by compare_identify_results(). If the order is unimportant, set it to zero for every
result.
Make sure that any cover/ISBN mapping information is cached before the Metadata object is put into re-
sult_queue.

Parameters
• log – A log object, use it to output debugging information/errors
• result_queue – A result Queue, results should be put into it. Each result is a Metadata

object
• abort – If abort.is_set() returns True, abort further processing and return as soon as possible
• title – De titel van het boek, mag Geen zĳn.
• authors – A list of authors of the book, can be None
• identifiers – A dictionary of other identifiers, most commonly {‘isbn’:’1234…’}
• timeout – Timeout in seconds, no network request should hang for longer than timeout.

Returns
None if no errors occurred, otherwise a unicode representation of the error suitable for showing
to the user

download_cover(log, result_queue, abort, title=None, authors=None, identifiers={}, timeout=30,
get_best_cover=False)

Download a cover and put it into result_queue. The parameters all have the same meaning as for identify()
(pagina 266). Put (self, cover_data) into result_queue.
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This method should use cached cover URLs for efficiency whenever possible. When cached data is not present,
most plugins simply call identify and use its results.
If the parameter get_best_cover is True and this plugin can get multiple covers, it should only get the “best”
one.

class calibre.ebooks.metadata.sources.base.InternalMetadataCompareKeyGen(mi, source_plugin,
title, authors,
identifiers)

Generate a sort key for comparison of the relevance of Metadata objects, given a search query. This is used only
to compare results from the same metadata source, not across different sources.
The sort key ensures that an ascending order sort is a sort by order of decreasing relevance.
Het algoritme is:

• Prefer results that have at least one identifier the same as for the query
• Prefer results with a cached cover URL
• Prefer results with all available fields filled in
• Prefer results with the same language as the current user interface language
• Prefer results that are an exact title match to the query
• Prefer results with longer comments (greater than 10% longer)
• Use the relevance of the result as reported by the metadata source’s search

engine

12.1.6 Omzet plugins
class calibre.customize.conversion.InputFormatPlugin(*args)

Basisklassen: Plugin (pagina 258)
InputFormatPlugins are responsible for converting a document into HTML+OPF+CSS+etc. The results of the
conversion must be encoded in UTF-8. The main action happens in convert() (pagina 268).
type = 'Invoer converteren'

The type of this plugin. Used for categorizing plugins in the GUI
can_be_disabled = False

If False, the user will not be able to disable this plugin. Use with care.
supported_platforms = ['windows', 'osx', 'linux']

Lĳst van platformen waar deze plugin op werkt. Bĳvoorbeeld: ['windows', 'osx', 'linux']

file_types = {}

Set of file types for which this plugin should be run For example: set(['azw', 'mobi', 'prc'])

is_image_collection = False

If True, this input plugin generates a collection of images, one per HTML file. This can be set dynamically,
in the convert method if the input files can be both image collections and non-image collections. If you set
this to True, you must implement the get_images() method that returns a list of images.

core_usage = 1

Number of CPU cores used by this plugin. A value of -1 means that it uses all available cores
for_viewer = False

If set to True, the input plugin will perform special processing to make its output suitable for viewing
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output_encoding = 'utf-8'

The encoding that this input plugin creates files in. A value of None means that the encoding is undefined
and must be detected individually

common_options = {<calibre.customize.conversion.OptionRecommendation object>}

Options shared by all Input format plugins. Do not override in sub-classes. Use options (pagina 268) instead.
Every option must be an instance of OptionRecommendation.

options = {}

Options to customize the behavior of this plugin. Every option must be an instance of OptionRecommen-
dation.

recommendations = {}

A set of 3-tuples of the form (option_name, recommended_value, recommendation_level)
get_images()

Return a list of absolute paths to the images, if this input plugin represents an image collection. The list of
images is in the same order as the spine and the TOC.

convert(stream, options, file_ext, log, accelerators)
This method must be implemented in sub-classes. It must return the path to the created OPF file or an
OEBBook instance. All output should be contained in the current folder. If this plugin creates files outside the
current folder they must be deleted/marked for deletion before this method returns.

Parameters
• stream – A file like object that contains the input file.
• options – Options to customize the conversion process. Guaranteed to have attributes cor-

responding to all the options declared by this plugin. In addition, it will have a verbose attri-
bute that takes integral values from zero upwards. Higher numbers mean be more verbose.
Another useful attribute is input_profile that is an instance of calibre.customize.
profiles.InputProfile.

• file_ext – The extension (without the .) of the input file. It is guaranteed to be one of the
file_types supported by this plugin.

• log – A calibre.utils.logging.Log object. All output should use this object.
• accelerators – A dictionary of various information that the input plugin can get easily

that would speed up the subsequent stages of the conversion.
postprocess_book(oeb, opts, log)

Called to allow the input plugin to perform postprocessing after the book has been parsed.
specialize(oeb, opts, log, output_fmt)

Called to allow the input plugin to specialize the parsed book for a particular output format. Called after
postprocess_book and before any transforms are performed on the parsed book.

gui_configuration_widget(parent, get_option_by_name, get_option_help, db, book_id=None)
Called to create the widget used for configuring this plugin in the calibre GUI. The widget must be an instance
of the PluginWidget class. See the builtin input plugins for examples.

class calibre.customize.conversion.OutputFormatPlugin(*args)
Basisklassen: Plugin (pagina 258)
OutputFormatPlugins are responsible for converting an OEB document (OPF+HTML) into an output e-book.
The OEB document can be assumed to be encoded in UTF-8. The main action happens in convert() (pagina 269).
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type = 'Converteer uitvoer'

The type of this plugin. Used for categorizing plugins in the GUI
can_be_disabled = False

If False, the user will not be able to disable this plugin. Use with care.
supported_platforms = ['windows', 'osx', 'linux']

Lĳst van platformen waar deze plugin op werkt. Bĳvoorbeeld: ['windows', 'osx', 'linux']

file_type = None

The file type (extension without leading period) that this plugin outputs
common_options = {<calibre.customize.conversion.OptionRecommendation object>}

Options shared by all Input format plugins. Do not override in sub-classes. Use options (pagina 269) instead.
Every option must be an instance of OptionRecommendation.

options = {}

Options to customize the behavior of this plugin. Every option must be an instance of OptionRecommen-
dation.

recommendations = {}

A set of 3-tuples of the form (option_name, recommended_value, recommendation_level)
property description

str(object=’’) -> str str(bytes_or_buffer[, encoding[, errors]]) -> str
Create a new string object from the given object. If encoding or errors is specified, then the object must
expose a data buffer that will be decoded using the given encoding and error handler. Otherwise, returns the
result of object.__str__() (if defined) or repr(object). encoding defaults to ‘utf-8’. errors defaults to ‘strict’.

convert(oeb_book, output, input_plugin, opts, log)
Render the contents of oeb_book (which is an instance of calibre.ebooks.oeb.OEBBook) to the file
specified by output.

Parameters
• output – Either a file like object or a string. If it is a string it is the path to a folder that may

or may not exist. The output plugin should write its output into that folder. If it is a file like
object, the output plugin should write its output into the file.

• input_plugin – The input plugin that was used at the beginning of the conversion pipeline.
• opts – Conversion options. Guaranteed to have attributes corresponding to the OptionRe-

commendations of this plugin.
• log – The logger. Print debug/info messages etc. using this.

specialize_options(log, opts, input_fmt)
Can be used to change the values of conversion options, as used by the conversion pipeline.

specialize_css_for_output(log, opts, item, stylizer)
Can be used to make changes to the CSS during the CSS flattening process.

Parameters
• item – The item (HTML file) being processed
• stylizer – A Stylizer object containing the flattened styles for item. You can get the style

for any element by stylizer.style(element).
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gui_configuration_widget(parent, get_option_by_name, get_option_help, db, book_id=None)
Called to create the widget used for configuring this plugin in the calibre GUI. The widget must be an instance
of the PluginWidget class. See the builtin output plugins for examples.

12.1.7 Device drivers
The base class for all device drivers is DevicePlugin (pagina 270). However, if your device exposes itself as a USBMS
drive to the operating system, you should use the USBMS class instead as it implements all the logic needed to support
these kinds of devices.
class calibre.devices.interface.DevicePlugin(plugin_path)

Basisklassen: Plugin (pagina 258)
Defines the interface that should be implemented by backends that communicate with an e-book reader.
type = 'Toestel interface'

The type of this plugin. Used for categorizing plugins in the GUI
FORMATS = ['lrf', 'rtf', 'pdf', 'txt']

Geordende lĳst met ondersteunde formaten
VENDOR_ID = 0

VENDOR_ID can be either an integer, a list of integers or a dictionary If it is a dictionary, it must be a
dictionary of dictionaries, of the form:

{

integer_vendor_id : { product_id : [list of BCDs], ... },

...

}

PRODUCT_ID = 0

Een integer of een lĳst met integers
BCD = None

BCD can be either None to not distinguish between devices based on BCD, or it can be a list of the BCD
numbers of all devices supported by this driver.

THUMBNAIL_HEIGHT = 68

Hoogte van voorbeeldweergave op het bestand
THUMBNAIL_COMPRESSION_QUALITY = 75

Compression quality for thumbnails. Set this closer to 100 to have better quality thumbnails with fewer com-
pression artifacts. Of course, the thumbnails get larger as well.

WANTS_UPDATED_THUMBNAILS = False

Set this to True if the device supports updating cover thumbnails during sync_booklists. Setting it to true will
ask device.py to refresh the cover thumbnails during book matching

CAN_SET_METADATA = ['title', 'authors', 'collections']

Whether the metadata on books can be set via the GUI.
CAN_DO_DEVICE_DB_PLUGBOARD = False

Whether the device can handle device_db metadata plugboards
path_sep = '/'

Path separator for paths to books on device
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icon = 'reader.png'

Icoon voor dit apparaat
UserAnnotation

alias of Annotation
OPEN_FEEDBACK_MESSAGE = None

GUI displays this as a message if not None in the status bar. Useful if opening can take a long time
VIRTUAL_BOOK_EXTENSIONS = frozenset({})

Set of extensions that are “virtual books” on the device and therefore cannot be viewed/saved/added to library.
For example: frozenset(['kobo'])

VIRTUAL_BOOK_EXTENSION_MESSAGE = None

Message to display to user for virtual book extensions.
NUKE_COMMENTS = None

Whether to nuke comments in the copy of the book sent to the device. If not None this should be short string
that the comments will be replaced by.

MANAGES_DEVICE_PRESENCE = False

If True indicates that this driver completely manages device detection, ejecting and so forth. If you set this
to True, you must implement the detect_managed_devices and debug_managed_device_detection methods.
A driver with this set to true is responsible for detection of devices, managing a blacklist of devices, a list
of ejected devices and so forth. calibre will periodically call the detect_managed_devices() method and if it
returns a detected device, calibre will call open(). open() will be called every time a device is returned even if
previous calls to open() failed, therefore the driver must maintain its own blacklist of failed devices. Similarly,
when ejecting, calibre will call eject() and then assuming the next call to detect_managed_devices() returns
None, it will call post_yank_cleanup().

SLOW_DRIVEINFO = False

If set the True, calibre will call the get_driveinfo() (pagina 273) method after the books lists have been
loaded to get the driveinfo.

ASK_TO_ALLOW_CONNECT = False

If set to True, calibre will ask the user if they want to manage the device with calibre, the first time it
is detected. If you set this to True you must implement get_device_uid() (pagina 276) and igno-

re_connected_device() (pagina 276) and get_user_blacklisted_devices() (pagina 276) and
set_user_blacklisted_devices() (pagina 276)

user_feedback_after_callback = None

Set this to a dictionary of the form {‘title’:title, ‘msg’:msg, ‘det_msg’:detailed_msg} to have calibre popup a
message to the user after some callbacks are run (currently only upload_books). Be careful to not spam the
user with too many messages. This variable is checked after every callback, so only set it when you really need
to.

classmethod get_open_popup_message()

GUI displays this as a non-modal popup. Should be an instance of OpenPopupMessage
classmethod model_metadata()→ tuple[ModelMetadata, ...]

Metadata about all the actual device models this driver supports
is_usb_connected(devices_on_system, debug=False, only_presence=False)

Return True, device_info if a device handled by this plugin is currently connected.
Parameters

devices_on_system – Lĳst met momenteel aangesloten apparaten
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detect_managed_devices(devices_on_system, force_refresh=False)
Called only if MANAGES_DEVICE_PRESENCE is True.
Scan for devices that this driver can handle. Should return a device object if a device is found. This object will
be passed to the open() method as the connected_device. If no device is found, return None. The returned
object can be anything, calibre does not use it, it is only passed to open().
This method is called periodically by the GUI, so make sure it is not too resource intensive. Use a cache to
avoid repeatedly scanning the system.

Parameters
• devices_on_system – Set van USB apparaten gevonden op het systeem
• force_refresh – If True and the driver uses a cache to prevent repeated scanning, the

cache must be flushed.
debug_managed_device_detection(devices_on_system, output)

Called only if MANAGES_DEVICE_PRESENCE is True.
Should write information about the devices detected on the system to output, which is a file like object.
Should return True if a device was detected and successfully opened, otherwise False.

reset(key='-1', log_packets=False, report_progress=None, detected_device=None)

Parameters
• key – De sleutel om het apparaat te ontgrendelen
• log_packets – If true the packet stream to/from the device is logged
• report_progress – Function that is called with a % progress (number between 0 and 100)

for various tasks. If it is called with -1 that means that the task does not have any progress
information

• detected_device – Device information from the device scanner
can_handle_windows(usbdevice, debug=False)

Optional method to perform further checks on a device to see if this driver is capable of handling it. If it is
not it should return False. This method is only called after the vendor, product ids and the bcd have matched,
so it can do some relatively time intensive checks. The default implementation returns True. This method is
called only on Windows. See also can_handle() (pagina 272).
Note that for devices based on USBMS this method by default delegates to can_handle() (pagina 272). So
you only need to override can_handle() (pagina 272) in your subclass of USBMS.

Parameters
usbdevice – A usbdevice as returned by calibre.devices.winusb.

scan_usb_devices()

can_handle(device_info, debug=False)
Unix version of can_handle_windows() (pagina 272).

Parameters
device_info – Is a tuple of (vid, pid, bcd, manufacturer, product, serial number)

open(connected_device, library_uuid)
Perform any device specific initialization. Called after the device is detected but before any other functions
that communicate with the device. For example: For devices that present themselves as USB Mass storage
devices, this method would be responsible for mounting the device or if the device has been automounted,
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for finding out where it has been mounted. The method calibre.devices.usbms.device.Device.

open() (pagina 280) has an implementation of this function that should serve as a good example for USB
Mass storage devices.
This method can raise an OpenFeedback exception to display a message to the user.

Parameters
• connected_device – The device that we are trying to open. It is a tuple of (vendor id,

product id, bcd, manufacturer name, product name, device serial number). However, some
devices have no serial number and on Windows only the first three fields are present, the rest
are None.

• library_uuid – The UUID of the current calibre library. Can be None if there is no library
(for example when used from the command line).

eject()

Un-mount / eject the device from the OS. This does not check if there are pending GUI jobs that need to
communicate with the device.
NOTE: That this method may not be called on the same thread as the rest of the device methods.

post_yank_cleanup()

Called if the user yanks the device without ejecting it first.
set_progress_reporter(report_progress)

Set a function to report progress information.
Parameters

report_progress – Function that is called with a % progress (number between 0 and 100)
for various tasks. If it is called with -1 that means that the task does not have any progress
information

get_device_information(end_session=True)
Ask device for device information. See L{DeviceInfoQuery}.

Returns
(device name, device version, software version on device, MIME type) The tuple can optionally
have a fifth element, which is a drive information dictionary. See usbms.driver for an example.

get_driveinfo()

Return the driveinfo dictionary. Usually called from get_device_information(), but if loading the driveinfo is
slow for this driver, then it should set SLOW_DRIVEINFO. In this case, this method will be called by calibre
after the book lists have been loaded. Note that it is not called on the device thread, so the driver should cache
the drive info in the books() method and this function should return the cached data.

card_prefix(end_session=True)

Return a 2 element list of the prefix to paths on the cards. If no card is present None is set for the card’s
prefix. E.G. (‘/place’, ‘/place2’) (None, ‘place2’) (‘place’, None) (None, None)

total_space(end_session=True)

Get total space available on the mountpoints:
1. Hoofdgeheugen
2. Geheugenkaart A
3. Geheugenkaart B
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Returns
A 3 element list with total space in bytes of (1, 2, 3). If a particular device doesn’t have any of
these locations it should return 0.

free_space(end_session=True)

Get free space available on the mountpoints:
1. Hoofdgeheugen
2. Geheugenkaart A
3. Geheugenkaart B

Returns
A 3 element list with free space in bytes of (1, 2, 3). If a particular device doesn’t have any of
these locations it should return -1.

books(oncard=None, end_session=True)
Return a list of e-books on the device.

Parameters
oncard – If ‘carda’ or ‘cardb’ return a list of e-books on the specific storage card, otherwise
return list of e-books in main memory of device. If a card is specified and no books are on the
card return empty list.

Returns
Een boekenlĳst.

upload_books(files, names, on_card=None, end_session=True, metadata=None)
Upload a list of books to the device. If a file already exists on the device, it should be replaced. This method
should raise a FreeSpaceError if there is not enough free space on the device. The text of the FreeSpa-
ceError must contain the word “card” if on_card is not None otherwise it must contain the word “memory”.

Parameters
• files – Een lĳst met paden
• names – A list of file names that the books should have once uploaded to the device.

len(names) == len(files)
• metadata – If not None, it is a list of Metadata objects. The idea is to use the metadata to

determine where on the device to put the book. len(metadata) == len(files). Apart from the
regular cover (path to cover), there may also be a thumbnail attribute, which should be used
in preference. The thumbnail attribute is of the form (width, height, cover_data as jpeg).

Returns
A list of 3-element tuples. The list is meant to be passed to add_books_to_metadata()

(pagina 274).
classmethod add_books_to_metadata(locations, metadata, booklists)

Add locations to the booklists. This function must not communicate with the device.
Parameters

• locations – Result of a call to L{upload_books}
• metadata – List of Metadata objects, same as for upload_books() (pagina 274).
• booklists – A tuple containing the result of calls to (books(oncard=None)(),
books(oncard='carda')(), :meth`books(oncard=’cardb’)`).
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delete_books(paths, end_session=True)
Delete books at paths on device.

classmethod remove_books_from_metadata(paths, booklists)
Remove books from the metadata list. This function must not communicate with the device.

Parameters
• paths – paden naar boeken op het apparaat.
• booklists – A tuple containing the result of calls to (books(oncard=None)(),
books(oncard='carda')(), :meth`books(oncard=’cardb’)`).

sync_booklists(booklists, end_session=True)
Metadata bĳwerken op het apparaat.

Parameters
booklists – A tuple containing the result of calls to (books(oncard=None)(),
books(oncard='carda')(), :meth`books(oncard=’cardb’)`).

get_file(path, outfile, end_session=True)
Read the file at path on the device and write it to outfile.

Parameters
outfile – file object like sys.stdout or the result of an open() (pagina 272) call.

classmethod config_widget()

Should return a QWidget. The QWidget contains the settings for the device interface
classmethod save_settings(settings_widget)

Should save settings to disk. Takes the widget created in config_widget() (pagina 275) and saves all
settings to disk.

classmethod settings()

Should return an opts object. The opts object should have at least one attribute format_map which is an ordered
list of formats for the device.

set_plugboards(plugboards, pb_func)
provide the driver the current set of plugboards and a function to select a specific plugboard. This method is
called immediately before add_books and sync_booklists.
pb_func is a callable with the following signature::

def pb_func(device_name, format, plugboards)
You give it the current device name (either the class name or DEVICE_PLUGBOARD_NAME), the for-
mat you are interested in (a ‘real’ format or ‘device_db’), and the plugboards (you were given those by
set_plugboards, the same place you got this method).

Returns
None or a single plugboard instance.

set_driveinfo_name(location_code, name)
Set the device name in the driveinfo file to ‘name’. This setting will persist until the file is re-created or the
name is changed again.
Non-disk devices should implement this method based on the location codes returned by the
get_device_information() method.
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prepare_addable_books(paths)
Given a list of paths, returns another list of paths. These paths point to addable versions of the books.
If there is an error preparing a book, then instead of a path, the position in the returned list for that book
should be a three tuple: (original_path, the exception instance, traceback)

startup()

Called when calibre is starting the device. Do any initialization required. Note that multiple instances of the
class can be instantiated, and thus __init__ can be called multiple times, but only one instance will have this
method called. This method is called on the device thread, not the GUI thread.

shutdown()

Called when calibre is shutting down, either for good or in preparation to restart. Do any cleanup required.
This method is called on the device thread, not the GUI thread.

get_device_uid()

Must return a unique id for the currently connected device (this is called immediately after a successful call
to open()). You must implement this method if you set ASK_TO_ALLOW_CONNECT = True

ignore_connected_device(uid)

Should ignore the device identified by uid (the result of a call to get_device_uid()) in the future. You must
implement this method if you set ASK_TO_ALLOW_CONNECT = True. Note that this function is called
immediately after open(), so if open() caches some state, the driver should reset that state.

get_user_blacklisted_devices()

Return map of device uid to friendly name for all devices that the user has asked to be ignored.
set_user_blacklisted_devices(devices)

Set the list of device uids that should be ignored by this driver.
specialize_global_preferences(device_prefs)

Implement this method if your device wants to override a particular preference. You must ensure that all call
sites that want a preference that can be overridden use device_prefs[‘something’] instead of prefs[‘something’].
Your method should call device_prefs.set_overrides(pref=val, pref=val, …). Currently used for: metadata
management (prefs[‘manage_device_metadata’])

set_library_info(library_name, library_uuid, field_metadata)
Implement this method if you want information about the current calibre library. This method is called at
startup and when the calibre library changes while connected.

is_dynamically_controllable()

Called by the device manager when starting plugins. If this method returns a string, then a) it supports the
device manager’s dynamic control interface, and b) that name is to be used when talking to the plugin.
This method can be called on the GUI thread. A driver that implements this method must be thread safe.

start_plugin()

This method is called to start the plugin. The plugin should begin to accept device connections however it
does that. If the plugin is already accepting connections, then do nothing.
This method can be called on the GUI thread. A driver that implements this method must be thread safe.

stop_plugin()

This method is called to stop the plugin. The plugin should no longer accept connections, and should clea-
nup behind itself. It is likely that this method should call shutdown. If the plugin is already not accepting
connections, then do nothing.
This method can be called on the GUI thread. A driver that implements this method must be thread safe.

276 Hoofdstuk 12. calibre aanpassen



calibre Gebruikershandleiding, Release 8.7.0

get_option(opt_string, default=None)
Return the value of the option indicated by opt_string. This method can be called when the plugin is not
started. Return None if the option does not exist.
This method can be called on the GUI thread. A driver that implements this method must be thread safe.

set_option(opt_string, opt_value)
Set the value of the option indicated by opt_string. This method can be called when the plugin is not started.
This method can be called on the GUI thread. A driver that implements this method must be thread safe.

is_running()

Return True if the plugin is started, otherwise false
This method can be called on the GUI thread. A driver that implements this method must be thread safe.

synchronize_with_db(db, book_id, book_metadata, first_call)
Called during book matching when a book on the device is matched with a book in calibre’s db. The method
is responsible for synchronizing data from the device to calibre’s db (if needed).
The method must return a two-value tuple. The first value is a set of calibre book ids changed if calibre’s
database was changed or None if the database was not changed. If the first value is an empty set then the
metadata for the book on the device is updated with calibre’s metadata and given back to the device, but no
GUI refresh of that book is done. This is useful when the calibre data is correct but must be sent to the device.
The second value is itself a 2-value tuple. The first value in the tuple specifies whether a book format should
be sent to the device. The intent is to permit verifying that the book on the device is the same as the book in
calibre. This value must be None if no book is to be sent, otherwise return the base file name on the device (a
string like foobar.epub). Be sure to include the extension in the name. The device subsystem will construct a
send_books job for all books with not- None returned values. Note: other than to later retrieve the extension,
the name is ignored in cases where the device uses a template to generate the file name, which most do. The
second value in the returned tuple indicated whether the format is future-dated. Return True if it is, otherwise
return False. calibre will display a dialog to the user listing all future dated books.
Extremely important: this method is called on the GUI thread. It must be threadsafe with respect to the device
manager’s thread.
book_id: the calibre id for the book in the database. book_metadata: the Metadata object for the book coming
from the device. first_call: True if this is the first call during a sync, False otherwise

class calibre.devices.interface.BookList(oncard, prefix, settings)
Basisklassen: list
A list of books. Each Book object must have the fields

1. titel
2. auteurs
3. grootte (bestandsgrootte van het boek)
4. datetime (a UTC time tuple)
5. pad (pad op het apparaat naar het boek)
6. thumbnail (can be None) thumbnail is either a str/bytes object with the image data or it should have an attribute

image_path that stores an absolute (platform native) path to the image
7. tags (a list of strings, can be empty).

supports_collections()

Return True if the device supports collections for this book list.
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add_book(book, replace_metadata)
Add the book to the booklist. Intent is to maintain any device-internal metadata. Return True if booklists
must be sync’ed

remove_book(book)
Remove a book from the booklist. Correct any device metadata at the same time

get_collections(collection_attributes)
Return a dictionary of collections created from collection_attributes. Each entry in the dictionary is of the
form collection name:[list of books]
The list of books is sorted by book title, except for collections created from series, in which case series_index
is used.

Parameters
collection_attributes – A list of attributes of the Book object

USB Mass Storage based devices
The base class for such devices is calibre.devices.usbms.driver.USBMS (pagina 281). This class in turn inherits
some of its functionality from its bases, documented below. A typical basic USBMS based driver looks like this:

from calibre.devices.usbms.driver import USBMS

class PDNOVEL(USBMS):

name = 'Pandigital Novel device interface'

gui_name = 'PD Novel'

description = _('Communicate with the Pandigital Novel')

author = 'Kovid Goyal'

supported_platforms = ['windows', 'linux', 'osx']

FORMATS = ['epub', 'pdf']

VENDOR_ID = [0x18d1]

PRODUCT_ID = [0xb004]

BCD = [0x224]

THUMBNAIL_HEIGHT = 144

EBOOK_DIR_MAIN = 'eBooks'

SUPPORTS_SUB_DIRS = False

def upload_cover(self, path, filename, metadata):

coverdata = getattr(metadata, 'thumbnail', None)

if coverdata and coverdata[2]:

with open('%s.jpg' % os.path.join(path, filename), 'wb') as coverfile:

coverfile.write(coverdata[2])

class calibre.devices.usbms.device.Device(plugin_path)

Basisklassen: DeviceConfig, DevicePlugin (pagina 270)
This class provides logic common to all drivers for devices that export themselves as USB Mass Storage devices.
Provides implementations for mounting/ejecting of USBMS devices on all platforms.
VENDOR_ID = 0

VENDOR_ID can be either an integer, a list of integers or a dictionary If it is a dictionary, it must be a
dictionary of dictionaries, of the form:
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{

integer_vendor_id : { product_id : [list of BCDs], ... },

...

}

PRODUCT_ID = 0

Een integer of een lĳst met integers
BCD = None

BCD can be either None to not distinguish between devices based on BCD, or it can be a list of the BCD
numbers of all devices supported by this driver.

WINDOWS_MAIN_MEM = None

String identifying the main memory of the device in the Windows PnP id strings This can be None, string,
list of strings or compiled regex

WINDOWS_CARD_A_MEM = None

String identifying the first card of the device in the Windows PnP id strings This can be None, string, list of
strings or compiled regex

WINDOWS_CARD_B_MEM = None

String identifying the second card of the device in the Windows PnP id strings This can be None, string, list
of strings or compiled regex

OSX_MAIN_MEM_VOL_PAT = None

Used by the new driver detection to disambiguate main memory from storage cards. Should be a regular
expression that matches the main memory mount point assigned by macOS

MAX_PATH_LEN = 250

The maximum length of paths created on the device
NEWS_IN_FOLDER = True

Plaats nieuws in een eigen map
classmethod model_metadata()→ tuple[ModelMetadata, ...]

Metadata about all the actual device models this driver supports
reset(key='-1', log_packets=False, report_progress=None, detected_device=None)

Parameters
• key – De sleutel om het apparaat te ontgrendelen
• log_packets – If true the packet stream to/from the device is logged
• report_progress – Function that is called with a % progress (number between 0 and 100)

for various tasks. If it is called with -1 that means that the task does not have any progress
information

• detected_device – Device information from the device scanner
set_progress_reporter(report_progress)

Set a function to report progress information.
Parameters

report_progress – Function that is called with a % progress (number between 0 and 100)
for various tasks. If it is called with -1 that means that the task does not have any progress
information
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card_prefix(end_session=True)
Return a 2 element list of the prefix to paths on the cards. If no card is present None is set for the card’s
prefix. E.G. (‘/place’, ‘/place2’) (None, ‘place2’) (‘place’, None) (None, None)

total_space(end_session=True)

Get total space available on the mountpoints:
1. Hoofdgeheugen
2. Geheugenkaart A
3. Geheugenkaart B

Returns
A 3 element list with total space in bytes of (1, 2, 3). If a particular device doesn’t have any of
these locations it should return 0.

free_space(end_session=True)

Get free space available on the mountpoints:
1. Hoofdgeheugen
2. Geheugenkaart A
3. Geheugenkaart B

Returns
A 3 element list with free space in bytes of (1, 2, 3). If a particular device doesn’t have any of
these locations it should return -1.

windows_sort_drives(drives)
Called to disambiguate main memory and storage card for devices that do not distinguish between them on
the basis of WINDOWS_CARD_NAME. For example: The EB600

can_handle_windows(usbdevice, debug=False)
Optional method to perform further checks on a device to see if this driver is capable of handling it. If it is
not it should return False. This method is only called after the vendor, product ids and the bcd have matched,
so it can do some relatively time intensive checks. The default implementation returns True. This method is
called only on Windows. See also can_handle().
Note that for devices based on USBMS this method by default delegates to can_handle(). So you only
need to override can_handle() in your subclass of USBMS.

Parameters
usbdevice – A usbdevice as returned by calibre.devices.winusb.

scan_usb_devices()

open(connected_device, library_uuid)
Perform any device specific initialization. Called after the device is detected but before any other functions
that communicate with the device. For example: For devices that present themselves as USB Mass storage
devices, this method would be responsible for mounting the device or if the device has been automounted,
for finding out where it has been mounted. The method calibre.devices.usbms.device.Device.

open() (pagina 280) has an implementation of this function that should serve as a good example for USB
Mass storage devices.
This method can raise an OpenFeedback exception to display a message to the user.

Parameters
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• connected_device – The device that we are trying to open. It is a tuple of (vendor id,
product id, bcd, manufacturer name, product name, device serial number). However, some
devices have no serial number and on Windows only the first three fields are present, the rest
are None.

• library_uuid – The UUID of the current calibre library. Can be None if there is no library
(for example when used from the command line).

eject()

Un-mount / eject the device from the OS. This does not check if there are pending GUI jobs that need to
communicate with the device.
NOTE: That this method may not be called on the same thread as the rest of the device methods.

post_yank_cleanup()

Called if the user yanks the device without ejecting it first.
sanitize_callback(path)

Callback to allow individual device drivers to override the path sanitization used by crea-

te_upload_path().
filename_callback(default, mi)

Callback to allow drivers to change the default file name set by create_upload_path().
sanitize_path_components(components)

Perform any device specific sanitization on the path components for files to be uploaded to the device
get_annotations(path_map)

Resolve path_map to annotation_map of files found on the device
add_annotation_to_library(db, db_id, annotation)

Add an annotation to the calibre library
class calibre.devices.usbms.cli.CLI

class calibre.devices.usbms.driver.USBMS(plugin_path)
Basisklassen: CLI (pagina 281), Device (pagina 278)
The base class for all USBMS devices. Implements the logic for sending/getting/updating metadata/caching meta-
data/etc.
description = 'Communiceer met een e-boek reader.'

Een korte tekst die beschrĳft wat de plugin doet
author = 'John Schember'

De maker van deze plugin
supported_platforms = ['windows', 'osx', 'linux']

Lĳst van platformen waar deze plugin op werkt. Bĳvoorbeeld: ['windows', 'osx', 'linux']

booklist_class

alias of BookList
book_class

alias of Book
FORMATS = []

Geordende lĳst met ondersteunde formaten
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CAN_SET_METADATA = []

Whether the metadata on books can be set via the GUI.
get_device_information(end_session=True)

Ask device for device information. See L{DeviceInfoQuery}.
Returns

(device name, device version, software version on device, MIME type) The tuple can optionally
have a fifth element, which is a drive information dictionary. See usbms.driver for an example.

set_driveinfo_name(location_code, name)
Set the device name in the driveinfo file to ‘name’. This setting will persist until the file is re-created or the
name is changed again.
Non-disk devices should implement this method based on the location codes returned by the
get_device_information() method.

books(oncard=None, end_session=True)
Return a list of e-books on the device.

Parameters
oncard – If ‘carda’ or ‘cardb’ return a list of e-books on the specific storage card, otherwise
return list of e-books in main memory of device. If a card is specified and no books are on the
card return empty list.

Returns
Een boekenlĳst.

upload_books(files, names, on_card=None, end_session=True, metadata=None)
Upload a list of books to the device. If a file already exists on the device, it should be replaced. This method
should raise a FreeSpaceError if there is not enough free space on the device. The text of the FreeSpa-
ceError must contain the word “card” if on_card is not None otherwise it must contain the word “memory”.

Parameters
• files – Een lĳst met paden
• names – A list of file names that the books should have once uploaded to the device.

len(names) == len(files)
• metadata – If not None, it is a list of Metadata objects. The idea is to use the metadata to

determine where on the device to put the book. len(metadata) == len(files). Apart from the
regular cover (path to cover), there may also be a thumbnail attribute, which should be used
in preference. The thumbnail attribute is of the form (width, height, cover_data as jpeg).

Returns
A list of 3-element tuples. The list is meant to be passed to add_books_to_metadata()

(pagina 282).
upload_cover(path, filename, metadata, filepath)

Upload book cover to the device. Default implementation does nothing.
Parameters

• path – The full path to the folder where the associated book is located.
• filename – De naam van het boek bestand zonder de extensie.
• metadata – metadata belonging to the book. Use metadata.thumbnail for cover
• filepath – The full path to the e-book file
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add_books_to_metadata(locations, metadata, booklists)
Add locations to the booklists. This function must not communicate with the device.

Parameters
• locations – Result of a call to L{upload_books}
• metadata – List of Metadata objects, same as for upload_books() (pagina 282).
• booklists – A tuple containing the result of calls to (books(oncard=None)(),
books(oncard='carda')(), :meth`books(oncard=’cardb’)`).

delete_books(paths, end_session=True)
Delete books at paths on device.

remove_books_from_metadata(paths, booklists)
Remove books from the metadata list. This function must not communicate with the device.

Parameters
• paths – paden naar boeken op het apparaat.
• booklists – A tuple containing the result of calls to (books(oncard=None)(),
books(oncard='carda')(), :meth`books(oncard=’cardb’)`).

sync_booklists(booklists, end_session=True)
Metadata bĳwerken op het apparaat.

Parameters
booklists – A tuple containing the result of calls to (books(oncard=None)(),
books(oncard='carda')(), :meth`books(oncard=’cardb’)`).

classmethod normalize_path(path)
Return path with platform native path separators

12.1.8 User interface actions
If you are adding your own plugin in a ZIP file, you should subclass both InterfaceActionBase and InterfaceAction.
The load_actual_plugin() method of your InterfaceActionBase subclass must return an instantiated object of your
InterfaceBase subclass.
class calibre.gui2.actions.InterfaceAction(parent, site_customization)

Basisklassen: QObject
A plugin representing an “action” that can be taken in the graphical user interface. All the items in the toolbar and
context menus are implemented by these plugins.
Note that this class is the base class for these plugins, however, to integrate the plugin with calibre’s plugin system,
you have to make a wrapper class that references the actual plugin. See the calibre.customize.builtins

module for examples.
Als twee InterfaceAction (pagina 283) objecten dezelfde naam hebben, krĳgt de gene met de hoogste prioriteit
voorrang.
Sub-classes should implement the genesis() (pagina 286), library_changed() (pagina 286), locati-
on_selected() (pagina 286), shutting_down() (pagina 286), initialization_complete() (pagi-
na 286) and tag_browser_context_action() (pagina 286) methods.
Once initialized, this plugin has access to the main calibre GUI via the gui member. You can access other plugins
by name, for example:

12.1. API documentatie voor plugins 283



calibre Gebruikershandleiding, Release 8.7.0

self.gui.iactions['Save To Disk']

To access the actual plugin, use the interface_action_base_plugin attribute, this attribute only beco-
mes available after the plugin has been initialized. Useful if you want to use methods from the plugin class like
do_user_config().
The QAction specified by action_spec (pagina 284) is automatically create and made available as self.

qaction.
name = 'Implement me'

The plugin name. If two plugins with the same name are present, the one with higher priority takes precedence.
priority = 1

The plugin priority. If two plugins with the same name are present, the one with higher priority takes prece-
dence.

popup_type = 1

The menu popup type for when this plugin is added to a toolbar
auto_repeat = False

Of deze actie moet worden herhaald als de snelkoppeling-toets wordt ingedrukt.
action_spec = ('text', 'icon', None, None)

Of the form: (text, icon_path, tooltip, keyboard shortcut). icon, tooltip and keyboard shortcut can be None.
keyboard shortcut must be either a string, None or tuple of shortcuts. If None, a keyboard shortcut correspon-
ding to the action is not registered. If you pass an empty tuple, then the shortcut is registered with no default
key binding.

action_shortcut_name = None

If not None, used for the name displayed to the user when customizing the keyboard shortcuts for the above
action spec instead of action_spec[0]

action_add_menu = False

Indien waar, wordt automatisch een menu gemaakt en toegevoegd aan self.qaction
action_menu_clone_qaction = False

If True, a clone of self.qaction is added to the menu of self.qaction If you want the text of this action to be
different from that of self.qaction, set this variable to the new text

dont_add_to = frozenset({})

Set of locations to which this action must not be added. See all_locations for a list of possible locations
dont_remove_from = frozenset({})

Set of locations from which this action must not be removed. See all_locations for a list of possible
locations

action_type = 'global'

Type of action ‘current’ means acts on the current view ‘global’ means an action that does not act on the current
view, but rather on calibre as a whole

accepts_drops = False

If True, then this InterfaceAction will have the opportunity to interact with drag and drop events. See the
methods, accept_enter_event() (pagina 284), :meth`:accept_drag_move_event`, drop_event() (pa-
gina 285) for details.
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accept_enter_event(event, mime_data)
This method should return True iff this interface action is capable of handling the drag event. Do not call
accept/ignore on the event, that will be taken care of by the calibre UI.

accept_drag_move_event(event, mime_data)
This method should return True iff this interface action is capable of handling the drag event. Do not call
accept/ignore on the event, that will be taken care of by the calibre UI.

drop_event(event, mime_data)

This method should perform some useful action and return True iff this interface action is capable of handling
the drop event. Do not call accept/ignore on the event, that will be taken care of by the calibre UI. You should
not perform blocking/long operations in this function. Instead emit a signal or use QTimer.singleShot and
return quickly. See the builtin actions for examples.

create_menu_action(menu, unique_name, text, icon=None, shortcut=None, description=None,
triggered=None, shortcut_name=None, persist_shortcut=False)

Convenience method to easily add actions to a QMenu. Returns the created QAction. This action has one
extra attribute calibre_shortcut_unique_name which if not None refers to the unique name under which this
action is registered with the keyboard manager.

Parameters
• menu – The QMenu de nieuw gemaakte actie zal worden toegevoegd aan
• unique_name – A unique name for this action, this must be globally unique, so make it as

descriptive as possible. If in doubt, add an UUID to it.
• text – De tekst van de actie.
• icon – Either a QIcon or a file name. The file name is passed to the QIcon.ic() builtin, so

you do not need to pass the full path to the images folder.
• shortcut – A string, a list of strings, None or False. If False, no keyboard shortcut is regis-

tered for this action. If None, a keyboard shortcut with no default keybinding is registered.
String and list of strings register a shortcut with default keybinding as specified.

• description – Een beschrĳving voor deze actie. Gebruikt om tooltips in te stellen.
• triggered – A callable which is connected to the triggered signal of the created action.
• shortcut_name – The text displayed to the user when customizing the keyboard shortcuts

for this action. By default it is set to the value of text.
• persist_shortcut – Shortcuts for actions that don’t always appear, or are libra-

ry dependent, may disappear when other keyboard shortcuts are edited unless `per-

sist_shortcut` is set True.
load_resources(names)

If this plugin comes in a ZIP file (user added plugin), this method will allow you to load resources from the
ZIP file.
Bĳvoorbeeld om een afbeelding te laden:

pixmap = QPixmap()

pixmap.loadFromData(tuple(self.load_resources(['images/icon.png']).

↪→values())[0])

icon = QIcon(pixmap)

Parameters
names – List of paths to resources in the ZIP file using / as separator
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Returns
A dictionary of the form {name : file_contents}. Any names that were not found in the
ZIP file will not be present in the dictionary.

genesis()

Setup this plugin. Only called once during initialization. self.gui is available. The action specified by acti-
on_spec (pagina 284) is available as self.qaction.

location_selected(loc)

Called whenever the book list being displayed in calibre changes. Currently values for loc are: library,
main, card and cardb.
This method should enable/disable this action and its sub actions as appropriate for the location.

library_about_to_change(olddb, db)
Aangeroepen elke keer wanneer de huidige bibliotheek wĳzigt.

Parameters
• olddb – The LibraryDatabase corresponding to the previous library.
• db – The LibraryDatabase corresponding to the new library.

library_changed(db)
Aangeroepen elke keer wanneer de huidige bibliotheek wĳzigt.

Parameters
db – The LibraryDatabase corresponding to the current library.

gui_layout_complete()

Called once per action when the layout of the main GUI is completed. If your action needs to make changes
to the layout, they should be done here, rather than in initialization_complete() (pagina 286).

initialization_complete()

Called once per action when the initialization of the main GUI is completed.
tag_browser_context_action(index)

Called when displaying the context menu in the Tag browser. index is the QModelIndex that points to the Tag
browser item that was right clicked. Test it for validity with index.valid() and get the underlying TagTreeItem
object with index.data(Qt.ItemDataRole.UserRole). Any action objects yielded by this method will be added
to the context menu.

shutting_down()

Called once per plugin when the main GUI is in the process of shutting down. Release any used resources,
but try not to block the shutdown for long periods of time.

class calibre.customize.InterfaceActionBase(*args, **kwargs)

Basisklassen: Plugin (pagina 258)
supported_platforms = ['windows', 'osx', 'linux']

Lĳst van platformen waar deze plugin op werkt. Bĳvoorbeeld: ['windows', 'osx', 'linux']

author = 'Kovid Goyal'

De maker van deze plugin
type = 'Gebruikersinterface actie'

The type of this plugin. Used for categorizing plugins in the GUI
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can_be_disabled = False

If False, the user will not be able to disable this plugin. Use with care.
load_actual_plugin(gui)

This method must return the actual interface action plugin object.

12.1.9 Preferences plugins
class calibre.customize.PreferencesPlugin(plugin_path)

Basisklassen: Plugin (pagina 258)
A plugin representing a widget displayed in the Preferences dialog.
This plugin has only one important method create_widget() (pagina 287). The various fields of the plugin
control how it is categorized in the UI.
supported_platforms = ['windows', 'osx', 'linux']

Lĳst van platformen waar deze plugin op werkt. Bĳvoorbeeld: ['windows', 'osx', 'linux']

author = 'Kovid Goyal'

De maker van deze plugin
type = 'Voorkeuren'

The type of this plugin. Used for categorizing plugins in the GUI
can_be_disabled = False

If False, the user will not be able to disable this plugin. Use with care.
config_widget = None

Import path to module that contains a class named ConfigWidget which implements the ConfigWidgetInter-
face. Used by create_widget() (pagina 287).

category_order = 100

Where in the list of categories the category (pagina 287) of this plugin should be.
name_order = 100

Where in the list of names in a category, the gui_name (pagina 287) of this plugin should be
category = None

The category this plugin should be in
gui_category = None

The category name displayed to the user for this plugin
gui_name = None

The name displayed to the user for this plugin
icon = None

The icon for this plugin, should be an absolute path
description = None

The description used for tooltips and the like
create_widget(parent=None)

Create and return the actual Qt widget used for setting this group of preferences. The widget must implement
the calibre.gui2.preferences.ConfigWidgetInterface (pagina 287).
The default implementation uses config_widget (pagina 287) to instantiate the widget.

12.1. API documentatie voor plugins 287



calibre Gebruikershandleiding, Release 8.7.0

class calibre.gui2.preferences.ConfigWidgetInterface

This class defines the interface that all widgets displayed in the Preferences dialog must implement. See Config-
WidgetBase (pagina 288) for a base class that implements this interface and defines various convenience methods
as well.
changed_signal = None

This signal must be emitted whenever the user changes a value in this widget
supports_restoring_to_defaults = True

Set to True iff the restore_to_defaults() method is implemented.
restore_defaults_desc = 'Standaardinstellingen terugzetten. U moet op ‘Toepassen’

klikken om de standaardinstellingen daadwerkelijk terug te zetten.'

The tooltip for the “Restore defaults” button
restart_critical = False

If True the Preferences dialog will not allow the user to set any more preferences. Only has effect if commit()
(pagina 288) returns True.

genesis(gui)
Called once before the widget is displayed, should perform any necessary setup.

Parameters
gui – The main calibre graphical user interface

initialize()

Should set all config values to their initial values (the values stored in the config files). A “return” statement
is optional. Return False if the dialog is not to be shown.

restore_defaults()

Should set all config values to their defaults.
commit()

Save any changed settings. Return True if the changes require a restart, False otherwise. Raise an Abort-

Commit exception to indicate that an error occurred. You are responsible for giving the user feedback about
what the error is and how to correct it.

refresh_gui(gui)
Called once after this widget is committed. Responsible for causing the gui to reread any changed settings.
Note that by default the GUI re-initializes various elements anyway, so most widgets won’t need to use this
method.

initial_tab_changed()

Called if the initially displayed tab is changed before the widget is shown, but after it is initialized.
class calibre.gui2.preferences.ConfigWidgetBase(parent=None)

Base class that contains code to easily add standard config widgets like checkboxes, combo boxes, text fields and
so on. See the register() (pagina 289) method.
This class automatically handles change notification, resetting to default, translation between gui objects and config
objects, etc. for registered settings.
If your config widget inherits from this class but includes setting that are not registered, you should override the
ConfigWidgetInterface (pagina 287) methods and call the base class methods inside the overrides.
changed_signal

This signal must be emitted whenever the user changes a value in this widget
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supports_restoring_to_defaults = True

Set to True iff the restore_to_defaults() method is implemented.
restart_critical = False

If True the Preferences dialog will not allow the user to set any more preferences. Only has effect if commit()
(pagina 289) returns True.

register(name, config_obj, gui_name=None, choices=None, restart_required=False,
empty_string_is_None=True, setting=<class 'calibre.gui2.preferences.Setting'>)

Een instelling registreren.
Parameters

• name – De instelling naam
• config_obj – The config object that reads/writes the setting
• gui_name – The name of the GUI object that presents an interface to change the setting.

By default it is assumed to be 'opt_' + name.
• choices – If this setting is a multiple choice (combobox) based setting, the list of choices.

The list is a list of two element tuples of the form: [(gui name, value), ...]

• setting – The class responsible for managing this setting. The default class handles almost
all cases, so this param is rarely used.

initialize()

Should set all config values to their initial values (the values stored in the config files). A “return” statement
is optional. Return False if the dialog is not to be shown.

commit(*args)
Save any changed settings. Return True if the changes require a restart, False otherwise. Raise an Abort-

Commit exception to indicate that an error occurred. You are responsible for giving the user feedback about
what the error is and how to correct it.

restore_defaults(*args)
Should set all config values to their defaults.

12.2 Omgevingsvariabelen
• CALIBRE_CONFIG_DIRECTORY - stelt de map in waar configuratiebestanden worden bewaard/gelezen.
• CALIBRE_TEMP_DIR - stelt de tĳdelĳke map in gebruikt door calibre
• CALIBRE_CACHE_DIRECTORY - stelt de map in waar calibre persistent data cachet tussen sessies
• CALIBRE_OVERRIDE_DATABASE_PATH - laat u een volledig pad opgeven naar metadata.db. Met deze variabele

kunt u metadata.db op een andere locatie hebben dan in de bibliotheekmap. Handig als uw bibliotheekmap op een
netwerkschĳf staat waar bestandsvergrendeling niet is ondersteund.

• CALIBRE_DEVELOP_FROM - draaide in een calibre development omgeving. Kĳk op Opzetten van Calibre in een
development omgeving (pagina 345).

• CALIBRE_OVERRIDE_LANG - dwong de taal af gebruikt door de interface (ISO 639 taal code)
• CALIBRE_TEST_TRANSLATION - testte een vertaal .po bestand (zou het pad naar het .po bestand moeten zĳn)
• CALIBRE_NO_NATIVE_FILEDIALOGS - laat calibre geen native bestandsdialogen gebruiken voor selecteren be-

standen/mappen.
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• CALIBRE_NO_NATIVE_MENUBAR - laat calibre geen native (global) menu in Ubuntu Unity en gelĳkaardige Linux
desktop omgevingen creëren. Het menu staat in plaats daarvan in het venster, traditioneel.

• CALIBRE_USE_SYSTEM_THEME - standaard, bĳ Linux, gebruikt calibre z’n eigen, ingebouwde Qt stĳl. Dit is om
crashen en hangen, veroorzaakt door incompatibiliteiten tussen de versie van Qt calibre die van het systeem. Het
nadeel is dat calibre mogelĳk niet de systeem look en feel volgt. Als u deze omgevingsvariabele op Linux zet, zal
hĳ calibre het systeem thema laten gebruiken – opgelet voor crashes en hangen.

• CALIBRE_SHOW_DEPRECATION_WARNINGS - laat calibre depreciatie verwittigingen sturen naar stdout. Nuttig
voor calibre ontwikkelaars.

• CALIBRE_NO_DEFAULT_PROGRAMS - voorkomt dat calibre automatisch de bestandstypes die het aankan regi-
streert in Windows.

• CALIBRE_USE_SYSTEM_CERTIFICATES - make calibre use the system certificate store for SSL certificate veri-
fication instead of its own certificate store on Windows and macOS.

• CALIBRE_NO_ICONS_IN_MENUS - Disable icons in menus
• QT_QPA_PLATFORM - On Linux set this to wayland to force calibre to use Wayland and xcb to force use of X11.
• SYSFS_PATH - Gebruik dit als sysfs niet in /sys staat maar ergens anders
• http_proxy, https_proxy - bĳ Linux gebruikt om een HTTP(S) proxy te specificeren

Zie Hoe omgevings-variabelen in Windows in te stellen <https://www.computerhope.com/issues/ch000549.htm> _. Als u
macOS gebruikt, kunt u omgevingsvariabelen instellen door de ~/Library/Preferences/calibre/macos-env.

txt te maken en de omgevingsvariabelen één per regel erin te plaatsen, bĳvoorbeeld:

CALIBRE_DEVELOP_FROM=$HOME/calibre-src/src

CALIBRE_NO_NATIVE_FILEDIALOGS=1

CALIBRE_CONFIG_DIRECTORY=~/.config/calibre

12.3 Truckjes
Truckjes zĳn kleine wĳzigingen die u kunt aanbrengen om diverse aspecten te beheren in calibres gedrag. U kunt deze
wĳzigen in Voorkeuren->Geavanceerd->Truckjes. De standaard waardes voor aanpassingen staan hieronder

#!/usr/bin/env python

# vim:fileencoding=UTF-8:ts=4:sw=4:sta:et:sts=4:ai

# License: GPLv3 Copyright: 2010, Kovid Goyal <kovid at kovidgoyal.net>

# Contains various tweaks that affect calibre behavior. Only edit this file if

# you know what you are doing. If you delete this file, it will be recreated from

# defaults.

#: Auto increment series index

# The algorithm used to assign a book added to an existing series a series number.

# New series numbers assigned using this tweak are always integer values, except

# if a constant non-integer is specified.

# Possible values are:

# next - First available integer larger than the largest existing number

# first_free - First available integer larger than 0

# next_free - First available integer larger than the smallest existing number

# last_free - First available integer smaller than the largest existing number.␣

↪→Return largest existing + 1 if no free number is found

(Vervolgt op volgende pagina)
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# const - Assign the number 1 always

# no_change - Do not change the series index

# a number - Assign that number always. The number is not in quotes. Note that 0.0␣

↪→can be used here.

# Examples:

# series_index_auto_increment = 'next'

# series_index_auto_increment = 'next_free'

# series_index_auto_increment = 16.5

#

# Set the use_series_auto_increment_tweak_when_importing tweak to True to

# use the above values when importing/adding books. If this tweak is set to

# False (the default) then the series number will be set to 1 if it is not

# explicitly set during the import. If set to True, then the

# series index will be set according to the series_index_auto_increment setting.

# Note that the use_series_auto_increment_tweak_when_importing tweak is used

# only when a value is not provided during import. If the importing regular

# expression produces a value for series_index, or if you are reading metadata

# from books and the import plugin produces a value, then that value will

# be used irrespective of the setting of the tweak.

series_index_auto_increment = 'next'

use_series_auto_increment_tweak_when_importing = False

#: Add separator after completing an author name

# Set this if the completion separator should be appended to the end of the

# completed text to automatically begin a new completion operation for authors.

# It can be either True or False

authors_completer_append_separator = False

#: Author sort name algorithm

# The algorithm used to copy author to author_sort.

# Possible values are:

# invert: use "fn ln" -> "ln, fn"

# copy : copy author to author_sort without modification

# comma : use 'copy' if there is a ',' in the name, otherwise use 'invert'

# nocomma : "fn ln" -> "ln fn" (without the comma)

# When this tweak is changed, the author_sort values stored with each author

# must be recomputed by right-clicking on an author in the left-hand tags

# panel, selecting 'Manage authors', and pressing

# 'Recalculate all author sort values'.

#

# The author_name_suffixes are words that are ignored when they occur at the

# end of an author name. The case of the suffix is ignored and trailing

# periods are automatically handled.

#

# The same is true for author_name_prefixes.

#

# The author_name_copywords are a set of words which, if they occur in an

# author name, cause the automatically generated author sort string to be

# identical to the author's name. This means that the sort for a string like

# "Acme Inc." will be "Acme Inc." instead of "Inc., Acme".

#

# If author_use_surname_prefixes is enabled, any of the words in

(Vervolgt op volgende pagina)
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# author_surname_prefixes will be treated as a prefix to the surname, if they

# occur before the surname. So for example, "John von Neumann" would be sorted

# as "von Neumann, John" and not "Neumann, John von".

author_sort_copy_method = 'comma'

author_name_suffixes = ('Jr', 'Sr', 'Inc', 'Ph.D', 'Phd',

'MD', 'M.D', 'I', 'II', 'III', 'IV',

'Junior', 'Senior')

author_name_prefixes = ('Mr', 'Mrs', 'Ms', 'Dr', 'Prof')

author_name_copywords = (

'Agency', 'Corporation', 'Company', 'Co.', 'Council',

'Committee', 'Inc.', 'Institute', 'National', 'Society', 'Club', 'Team',

'Software', 'Games', 'Entertainment', 'Media', 'Studios',

)

author_use_surname_prefixes = False

author_surname_prefixes = ('da', 'de', 'di', 'la', 'le', 'van', 'von')

#: Splitting multiple author names

# By default, calibre splits a string containing multiple author names on

# ampersands and the words "and" and "with". You can customize the splitting

# by changing the regular expression below. Strings are split on whatever the

# specified regular expression matches, in addition to ampersands.

# Default: r'(?i),?\s+(and|with)\s+'

authors_split_regex = r'(?i),?\s+(and|with)\s+'

#: Use author_sort and/or series_sort for names in Tag browser

# Set which author or series field is used to display as the item name in the

# Tag browser (the list of authors, series, publishers etc on the left hand

# side). The choices for author are 'author' and 'author_sort'. The choices for

# series are 'series' and 'series_sort'. This tweak affects only what is

# displayed under the category in the Tag browser and Content server. Please

# note that if you set this to …_sort, it is possible to see duplicate names in

# the list because although it is guaranteed that author and series names are

# unique, there is no such guarantee for their sort values. Showing duplicates

# won't break anything but it could lead to some confusion. The tooltip for an

# item will show the item's name no matter how you set this tweak.

# Examples:

# categories_use_field_for_author_name = 'author'

# categories_use_field_for_author_name = 'author_sort'

# categories_use_field_for_series_name = 'series'

# categories_use_field_for_series_name = 'series_sort'

categories_use_field_for_author_name = 'author'

categories_use_field_for_series_name = 'series'

#: Control partitioning of Tag browser

# When partitioning the Tag browser, the format of the subcategory label is

# controlled by a template: categories_collapsed_name_template if sorting by

# name, categories_collapsed_rating_template if sorting by average rating, and

# categories_collapsed_popularity_template if sorting by popularity. There are

# two variables available to the template: first and last. The variable 'first'

# is the initial item in the subcategory, and the variable 'last' is the final

# item in the subcategory. Both variables are 'objects'; they each have multiple

# values that are obtained by using a suffix. For example, first.name for an

(Vervolgt op volgende pagina)
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# author category will be the name of the author. The sub-values available are:

# name: the printable name of the item

# count: the number of books that references this item

# avg_rating: the average rating of all the books referencing this item

# sort: the sort value. For authors, this is the author_sort for that author

# category: the category (e.g., authors, series) that the item is in.

# Note that the "r'" in front of the { is necessary if there are backslashes

# (\ characters) in the template. It doesn't hurt anything to leave it there

# even if there aren't any backslashes.

categories_collapsed_name_template = r'{first.sort:shorten(4,,0)} - {last.

↪→sort:shorten(4,,0)}'

categories_collapsed_rating_template = r'{first.avg_rating:4.2f:ifempty(0)} - {last.

↪→avg_rating:4.2f:ifempty(0)}'

categories_collapsed_popularity_template = r'{first.count:d} - {last.count:d}'

#: Specify columns to sort the booklist by on startup

# Provide a set of columns to be sorted on when calibre starts.

# The argument is None if saved sort history is to be used

# otherwise it is a list of column,order pairs. Column is the

# lookup/search name, found using the tooltip for the column

# Order is 0 for ascending, 1 for descending.

# For example, set it to [('authors',0),('title',0)] to sort by

# title within authors.

sort_columns_at_startup = None

#: Control how dates are displayed

# Format to be used for publication date and the timestamp (date).

# A string controlling how the publication date is displayed in the GUI

# d the day as number without a leading zero (1 to 31)

# dd the day as number with a leading zero (01 to 31)

# ddd the abbreviated localized day name (e.g. 'Mon' to 'Sun')

# dddd the long localized day name (e.g. 'Monday' to 'Sunday')

# M the month as number without a leading zero (1-12)

# MM the month as number with a leading zero (01-12)

# MMM the abbreviated localized month name (e.g. 'Jan' to 'Dec')

# MMMM the long localized month name (e.g. 'January' to 'December')

# yy the year as two digit number (00-99)

# yyyy the year as four digit number

# h the hours without a leading 0 (0 to 11 or 0 to 23, depending on am/pm)

# hh the hours with a leading 0 (00 to 11 or 00 to 23, depending on am/pm)

# m the minutes without a leading 0 (0 to 59)

# mm the minutes with a leading 0 (00 to 59)

# s the seconds without a leading 0 (0 to 59)

# ss the seconds with a leading 0 (00 to 59)

# ap use a 12-hour clock instead of a 24-hour clock, with "ap" replaced by the␣

↪→lowercase localized string for am or pm

# AP use a 12-hour clock instead of a 24-hour clock, with "AP" replaced by the␣

↪→uppercase localized string for AM or PM

# aP use a 12-hour clock instead of a 24-hour clock, with "aP" replaced by the␣

↪→localized string for am or pm

# Ap use a 12-hour clock instead of a 24-hour clock, with "Ap" replaced by the␣

↪→localized string for AM or PM

(Vervolgt op volgende pagina)
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# iso the date with time and timezone. Must be the only format present

# For example, given the date of 9 Jan 2010, the following formats show

# MMM yyyy ==> Jan 2010 yyyy ==> 2010 dd MMM yyyy ==> 09 Jan 2010

# MM/yyyy ==> 01/2010 d/M/yy ==> 9/1/10 yy ==> 10

#

# publication default if not set: MMM yyyy

# timestamp default if not set: dd MMM yyyy

# last_modified_display_format if not set: dd MMM yyyy

gui_pubdate_display_format = 'MMM yyyy'

gui_timestamp_display_format = 'dd MMM yyyy'

gui_last_modified_display_format = 'dd MMM yyyy'

#: Control sorting of titles and series in the library display

# Control title and series sorting in the library view. If set to

# 'library_order', the title sort field will be used instead of the title.

# Unless you have manually edited the title sort field, leading articles such as

# The and A will be ignored. If set to 'strictly_alphabetic', the titles will be

# sorted as-is (sort by title instead of title sort). For example, with

# library_order, The Client will sort under 'C'. With strictly_alphabetic, the

# book will sort under 'T'.

# This flag affects calibre's library display. It has no effect on devices. In

# addition, titles for books added before changing the flag will retain their

# order until the title is edited. Editing a title and hitting Enter

# without changing anything is sufficient to change the sort. Or you can use

# the 'Update title sort' action in the Bulk metadata edit dialog to update

# it for many books at once.

title_series_sorting = 'library_order'

#: Control formatting of title and series when used in templates

# Control how title and series names are formatted when saving to disk/sending

# to device. The behavior depends on the field being processed. If processing

# title, then if this tweak is set to 'library_order', the title will be

# replaced with title_sort. If it is set to 'strictly_alphabetic', then the

# title will not be changed. If processing series, then if set to

# 'library_order', articles such as 'The' and 'An' will be moved to the end. If

# set to 'strictly_alphabetic', the series will be sent without change.

# For example, if the tweak is set to library_order, "The Lord of the Rings"

# will become "Lord of the Rings, The". If the tweak is set to

# strictly_alphabetic, it would remain "The Lord of the Rings". Note that the

# formatter function raw_field will return the base value for title and

# series regardless of the setting of this tweak.

save_template_title_series_sorting = 'library_order'

#: Set the list of words considered to be "articles" for sort strings

# Set the list of words that are to be considered 'articles' when computing the

# title sort strings. The articles differ by language. By default, calibre uses

# a combination of articles from English and whatever language the calibre user

# interface is set to. In addition, in some contexts where the book language is

# available, the language of the book is used. You can change the list of

# articles for a given language or add a new language by editing

# per_language_title_sort_articles. To tell calibre to use a language other

# than the user interface language, set, default_language_for_title_sort. For

(Vervolgt op volgende pagina)

294 Hoofdstuk 12. calibre aanpassen



calibre Gebruikershandleiding, Release 8.7.0

(Vervolgd van vorige pagina)
# example, to use German, set it to 'deu'. A value of None means the user

# interface language is used. The setting title_sort_articles is ignored

# (present only for legacy reasons).

per_language_title_sort_articles = {

# English

'eng': (r'A\s+', r'The\s+', r'An\s+'),

# Esperanto

'epo': (r'La\s+', r"L'", 'L´'),

# Spanish

'spa': (r'El\s+', r'La\s+', r'Lo\s+', r'Los\s+', r'Las\s+', r'Un\s+',

r'Una\s+', r'Unos\s+', r'Unas\s+'),

# French

'fra': (r'Le\s+', r'La\s+', r"L'", r'L´', r'L’', r'Les\s+', r'Un\s+', r'Une\s+

↪→',

r'Des\s+', r'De\s+La\s+', r'De\s+', r"D'", r'D´', r'D’'),

# Polish

'pol': (),

# Italian

'ita': (r'Lo\s+', r'Il\s+', r"L'", r'L´', r'La\s+', r'Gli\s+',

r'I\s+', r'Le\s+', r'Uno\s+', r'Un\s+', r'Una\s+', "rUn'",

r'Un´', r'Dei\s+', r'Degli\s+', r'Delle\s+', r'Del\s+',

r'Della\s+', r'Dello\s+', r"Dell'", r'Dell´'),

# Portuguese

'por': (r'A\s+', r'O\s+', r'Os\s+', r'As\s+', r'Um\s+', r'Uns\s+',

r'Uma\s+', r'Umas\s+'),

# Romanian

'ron': (r'Un\s+', r'O\s+', r'Nişte\s+'),

# German

'deu': (r'Der\s+', r'Die\s+', r'Das\s+', r'Den\s+', r'Ein\s+',

r'Eine\s+', r'Einen\s+', r'Dem\s+', r'Des\s+', r'Einem\s+',

r'Eines\s+'),

# Dutch

'nld': (r'De\s+', r'Het\s+', r'Een\s+', r"'n\s+", r"'s\s+", r'Ene\s+',

r'Ener\s+', r'Enes\s+', r'Den\s+', r'Der\s+', r'Des\s+',

r"'t\s+"),

# Swedish

'swe': (r'En\s+', r'Ett\s+', r'Det\s+', r'Den\s+', r'De\s+'),

# Turkish

'tur': (r'Bir\s+',),

# Afrikaans

'afr': (r"'n\s+", r'Die\s+'),

# Greek

'ell': (r'O\s+', r'I\s+', r'To\s+', r'Ta\s+', r'Tus\s+', r'Tis\s+',

r"'Enas\s+", r"'Mia\s+", r"'Ena\s+", r"'Enan\s+"),

# Hungarian

'hun': (r'A\s+', r'Az\s+', r'Egy\s+'),

}

default_language_for_title_sort = None

title_sort_articles = r'^(A|The|An)\s+'

#: Specify a folder calibre should connect to at startup

# Specify a folder that calibre should connect to at startup using
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# connect_to_folder. This must be a full path to the folder. If the folder does

# not exist when calibre starts, it is ignored.

# Example for Windows:

# auto_connect_to_folder = 'C:/Users/someone/Desktop/testlib'

# Example for other operating systems:

# auto_connect_to_folder = '/home/dropbox/My Dropbox/someone/library'

auto_connect_to_folder = ''

#: Specify renaming rules for SONY collections

# Specify renaming rules for SONY collections. This tweak is only applicable if

# metadata management is set to automatic. Collections on SONYs are named

# depending upon whether the field is standard or custom. A collection derived

# from a standard field is named for the value in that field.

#

# For example, if the standard 'series' column contains the value 'Darkover', then the

# collection name is 'Darkover'. A collection derived from a custom field will

# have the name of the field added to the value. For example, if a custom series

# column named 'My Series' contains the name 'Darkover', then the collection

# will by default be named 'Darkover (My Series)'. For purposes of this

# documentation, 'Darkover' is called the value and 'My Series' is called the

# category. If two books have fields that generate the same collection name,

# then both books will be in that collection.

#

# This set of tweaks lets you specify for a standard or custom field how

# the collections are to be named. You can use it to add a description to a

# standard field, for example 'Foo (Tag)' instead of the 'Foo'. You can also use

# it to force multiple fields to end up in the same collection.

#

# For example, you could force the values in 'series', '#my_series_1', and

# '#my_series_2' to appear in collections named 'some_value (Series)', thereby

# merging all of the fields into one set of collections.

#

# There are two related tweaks. The first determines the category name to use

# for a metadata field. The second is a template, used to determines how the

# value and category are combined to create the collection name.

# The syntax of the first tweak, sony_collection_renaming_rules, is:

# {'field_lookup_name':'category_name_to_use', 'lookup_name':'name', ...}

#

# The second tweak, sony_collection_name_template, is a template. It uses the

# same template language as plugboards and save templates. This tweak controls

# how the value and category are combined together to make the collection name.

# The only two fields available are {category} and {value}. The {value} field is

# never empty. The {category} field can be empty. The default is to put the

# value first, then the category enclosed in parentheses, it isn't empty:

# '{value} {category:|(|)}'

#

# Examples: The first three examples assume that the second tweak

# has not been changed.

#

# 1) I want three series columns to be merged into one set of collections. The

# column lookup names are 'series', '#series_1' and '#series_2'. I want nothing

# in the parenthesis. The value to use in the tweak value would be:
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# sony_collection_renaming_rules={'series':'', '#series_1':'', '#series_2':''}

#

# 2) I want the word '(Series)' to appear on collections made from series, and

# the word '(Tag)' to appear on collections made from tags. Use:

# sony_collection_renaming_rules={'series':'Series', 'tags':'Tag'}

#

# 3) I want 'series' and '#myseries' to be merged, and for the collection name

# to have '(Series)' appended. The renaming rule is:

# sony_collection_renaming_rules={'series':'Series', '#myseries':'Series'}

#

# 4) Same as example 2, but instead of having the category name in parentheses

# and appended to the value, I want it prepended and separated by a colon, such

# as in Series: Darkover. I must change the template used to format the category name

#

# The resulting two tweaks are:

# sony_collection_renaming_rules={'series':'Series', 'tags':'Tag'}

# sony_collection_name_template='{category:||: }{value}'

sony_collection_renaming_rules = {}

sony_collection_name_template = '{value}{category:| (|)}'

#: Specify how SONY collections are sorted

# Specify how SONY collections are sorted. This tweak is only applicable if

# metadata management is set to automatic. You can indicate which metadata is to

# be used to sort on a collection-by-collection basis. The format of the tweak

# is a list of metadata fields from which collections are made, followed by the

# name of the metadata field containing the sort value.

# Example: The following indicates that collections built from pubdate and tags

# are to be sorted by the value in the custom column '#mydate', that collections

# built from 'series' are to be sorted by 'series_index', and that all other

# collections are to be sorted by title. If a collection metadata field is not

# named, then if it is a series- based collection it is sorted by series order,

# otherwise it is sorted by title order.

# [(['pubdate', 'tags'],'#mydate'), (['series'],'series_index'), (['*'], 'title')]

# Note that the bracketing and parentheses are required. The syntax is

# [ ( [list of fields], sort field ) , ( [ list of fields ] , sort field ) ]

# Default: empty (no rules), so no collection attributes are named.

sony_collection_sorting_rules = []

#: Control how tags are applied when copying books to another library

# Set this to True to ensure that tags in 'Tags to add when adding

# a book' are added when copying books to another library

add_new_book_tags_when_importing_books = False

#: Set the maximum number of sort 'levels'

# Set the maximum number of sort 'levels' that calibre will use to resort the

# library after certain operations such as searches or device insertion. Each

# sort level adds a performance penalty. If the database is large (thousands of

# books) the penalty might be noticeable. If you are not concerned about multi-

# level sorts, and if you are seeing a slowdown, reduce the value of this tweak.

maximum_resort_levels = 5

#: Choose whether dates are sorted using visible fields
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# Date values contain both a date and a time. When sorted, all the fields are

# used, regardless of what is displayed. Set this tweak to True to use only

# the fields that are being displayed.

sort_dates_using_visible_fields = False

#: Fuzz value for trimming covers

# The value used for the fuzz distance when trimming a cover.

# Colors within this distance are considered equal.

# The distance is in absolute intensity units.

cover_trim_fuzz_value = 10

#: Control behavior of the book list

# You can control the behavior of double clicks and pressing Enter on the books

# list. Choices: open_viewer, do_nothing, show_book_details,

# show_locked_book_details, edit_cell, edit_metadata. Selecting anything other

# than open_viewer, show_book_details, or show_locked_book_details has the side

# effect of disabling editing a field using a single click.

# Default: open_viewer.

# Example: doubleclick_on_library_view = 'do_nothing'

# You can also control whether the book list scrolls per item or

# per pixel. Default is per item.

doubleclick_on_library_view = 'open_viewer'

enter_key_behavior = 'do_nothing'

horizontal_scrolling_per_column = False

vertical_scrolling_per_row = False

#: Language to use when sorting

# Setting this tweak will force sorting to use the

# collating order for the specified language. This might be useful if you run

# calibre in English but want sorting to work in the language where you live.

# Set the tweak to the desired ISO 639-1 language code, in lower case.

# You can find the list of supported locales at

# https://en.wikipedia.org/wiki/List_of_ISO_639-1_codes

# Default: locale_for_sorting = '' -- use the language calibre displays in

# Example: locale_for_sorting = 'fr' -- sort using French rules.

# Example: locale_for_sorting = 'nb' -- sort using Norwegian rules.

locale_for_sorting = ''

#: The number of seconds to wait before sending emails

# The number of seconds to wait before sending emails when using a

# public email server like GMX/Hotmail/Gmail. Default is: 5 minutes

# Setting it to lower may cause the server's SPAM controls to kick in,

# making email sending fail. Changes will take effect only after a restart of

# calibre. You can also change the list of hosts that calibre considers

# to be public relays here. Any relay host ending with one of the suffixes

# in the list below will be considered a public email server.

public_smtp_relay_delay = 301

public_smtp_relay_host_suffixes = ['gmail.com', 'live.com', 'gmx.com', 'outlook.com']

#: The maximum width and height for covers saved in the calibre library

# All covers in the calibre library will be resized, preserving aspect ratio,

# to fit within this size. This is to prevent slowdowns caused by extremely
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# large covers

maximum_cover_size = (1650, 2200)

#: Where to send downloaded news

# When automatically sending downloaded news to a connected device, calibre

# will by default send it to the main memory. By changing this tweak, you can

# control where it is sent. Valid values are "main", "carda", "cardb". Note

# that if there isn't enough free space available on the location you choose,

# the files will be sent to the location with the most free space.

send_news_to_device_location = 'main'

#: Unified toolbar on macOS

# If you enable this option and restart calibre, the toolbar will be 'unified'

# with the titlebar as is normal for macOS applications. However, doing this has

# various bugs, for instance the minimum width of the toolbar becomes twice

# what it should be and it causes other random bugs on some systems, so turn it

# on at your own risk!

unified_title_toolbar_on_osx = False

#: Save original file when converting/polishing from same format to same format

# When calibre does a conversion from the same format to the same format, for

# example, from EPUB to EPUB, the original file is saved, so that in case the

# conversion is poor, you can tweak the settings and run it again. By setting

# this to False you can prevent calibre from saving the original file.

# Similarly, by setting save_original_format_when_polishing to False you can

# prevent calibre from saving the original file when polishing.

save_original_format = True

save_original_format_when_polishing = True

#: Number of recently viewed books to show

# Right-clicking the "View" button shows a list of recently viewed books. Control

# how many should be shown, here.

gui_view_history_size = 15

#: Change the font size of the Book details panel in the interface

# Change the font size at which book details are rendered in the side panel and

# comments are rendered in the metadata edit dialog. Set it to a positive or

# negative number to increase or decrease the font size.

change_book_details_font_size_by = 0

#: What format to default to when using the "Unpack book" feature

# The "Unpack book" feature of calibre allows direct editing of a book format.

# If multiple formats are available, calibre will offer you a choice

# of formats, defaulting to your preferred output format if it is available.

# Set this tweak to a specific value of 'EPUB' or 'AZW3' to always default

# to that format rather than your output format preference.

# Set to a value of 'remember' to use whichever format you chose last time you

# used the "Unpack book" feature.

# Examples:

# default_tweak_format = None (Use output format)

# default_tweak_format = 'EPUB'

# default_tweak_format = 'remember'
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default_tweak_format = None

#: Do not preselect a completion when editing authors/tags/series/etc.

# This means that you can make changes and press Enter and your changes will

# not be overwritten by a matching completion. However, if you wish to use the

# completions you will now have to press Tab to select one before pressing

# Enter. Which technique you prefer will depend on the state of metadata in

# your library and your personal editing style.

#

# If preselect_first_completion is False and you want Tab to accept what you

# typed instead of the first completion then set tab_accepts_uncompleted_text

# to True. If you do this then to select from the completions you must press

# the Down or Up arrow keys. The tweak tab_accepts_uncompleted_text is ignored

# if preselect_first_completion is True

preselect_first_completion = False

tab_accepts_uncompleted_text = False

#: Completion mode when editing authors/tags/series/etc.

# By default, when completing items, calibre will show you all the candidates

# that start with the text you have already typed. You can instead have it show

# all candidates that contain the text you have already typed. To do this, set

# completion_mode to 'contains'. For example, if you type asi it will match both

# Asimov and Quasimodo, whereas the default behavior would match only Asimov.

completion_mode = 'prefix'

#: Sort the list of libraries alphabetically

# The list of libraries in the Copy to library and Quick switch menus are

# normally sorted by most used. However, if there are more than a certain

# number of such libraries, the sorting becomes alphabetic. You can set that

# number here. The default is ten libraries.

many_libraries = 10

#: Choose available output formats for conversion

# Restrict the list of available output formats in the conversion dialogs.

# For example, if you only want to convert to EPUB and AZW3, change this to

# restrict_output_formats = ['EPUB', 'AZW3']. The default value of None causes

# all available output formats to be present.

restrict_output_formats = None

#: Set the thumbnail image quality used by the Content server

# The quality of a thumbnail is largely controlled by the compression quality

# used when creating it. Set this to a larger number to improve the quality.

# Note that the thumbnails get much larger with larger compression quality

# numbers.

# The value can be between 50 and 99

content_server_thumbnail_compression_quality = 75

#: Image file types to treat as e-books when dropping onto the "Book details" panel

# Normally, if you drop any image file in a format known to calibre onto the

# "Book details" panel, it will be used to set the cover. If you want to store

# some image types as e-books instead, you can set this tweak.

# Examples:
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# cover_drop_exclude = {'tiff', 'webp'}

cover_drop_exclude = ()

#: Exclude fields when copy/pasting metadata

# You can ask calibre to not paste some metadata fields when using the

# Edit metadata->Copy metadata/Paste metadata actions. For example,

# exclude_fields_on_paste = ['cover', 'timestamp', '#mycolumn']

# to prevent pasting of the cover, Date and custom column, mycolumn.

# You can also add a shortcut in Preferences->Shortcuts->Edit metadata

# to paste metadata ignoring this tweak.

exclude_fields_on_paste = []

#: Skip internet connected check

# Skip checking whether the internet is available before downloading news.

# Useful if for some reason your operating systems network checking

# facilities are not reliable (for example NetworkManager on Linux).

skip_network_check = False

#: Tab stop width in the template editor

# Sets the width of the tab stop in the template editor in "average characters".

# For example, a value of 1 results in a space with the width of one average␣

↪→character.

template_editor_tab_stop_width = 4

#: Value for undefined numbers when sorting

# Sets the value to use for undefined numbers when sorting.

# For example, the value -10 sorts undefined numbers as if they were set to -10.

# Use 'maximum' for the largest possible number. Use 'minimum' for the smallest

# possible number. Quotes are optional if entering a number.

# Examples:

# value_for_undefined_numbers_when_sorting = -100

# value_for_undefined_numbers_when_sorting = '2'

# value_for_undefined_numbers_when_sorting = -0.01

# value_for_undefined_numbers_when_sorting = 'minimum'

# value_for_undefined_numbers_when_sorting = 'maximum'

value_for_undefined_numbers_when_sorting = 0

#: Allow template database functions in composite columns

# If True then the template database functions book_values() and book_count()

# can be used in composite custom columns. Note: setting this tweak to True and

# using these functions in composites can be very slow.

# Default: False

allow_template_database_functions_in_composites = False

#: Change the programs that are run when opening files/URLs

# By default, calibre passes URLs to the operating system to open using

# whatever default programs are configured there. Here you can override

# that by specifying the program to use, per URL type. For local files,

# the type is "file" and for web links it is "http*". For example:

# openers_by_scheme = { "http*": "firefox %u" } will make calibre run Firefox

# for https://whatever URLs. %u is replaced by the URL to be opened. The scheme
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# takes a glob pattern allowing a single entry to match multiple URL types.

openers_by_scheme = {}

#: Set the first day of the week for calendar popups

# It must be one of the values Default, Sunday, Monday, Tuesday, Wednesday,

# Thursday, Friday, or Saturday, all in English, spelled exactly as shown.

calendar_start_day_of_week = 'Default'

#: East Asian language to use for transliteration

# Setting this tweak will make calibre use the specified language as the "base"

# language when transliterating East Asian languages to English. This might be

# useful if you run calibre in English but want text transliterated to

# Japanese instead of Chinese. The valid values are:

# 'ja' for Japanese

# 'kr' for Korean

# 'vn' for Vietnamese

# 'zh' for Chinese

# Any other value will use the language set in calibre preferences as the base

# language. A base language other than those in the above list causes transliteration

# with a base language of Chinese.

# Example: east_asian_base_language = 'ja'

east_asian_base_language = ''

12.4 Iconen, sjablonen, enz. overschrijven

Notitie

calibre has direct support for icon themes, there are several icon themes available for calibre, that you can use by going
to Preferences → Interface → Look & Feel → Change icon theme. It is preferable to use icon themes over overriding
individual icons.

calibre staat u toe de statische bronnen, zoals pictogrammen, JavaScript en sjablonen voor het metadata inlegvel, catalogi,
enz. te vervangen door aangepaste versies die u leuk vindt. Alle statische bronnen worden opgeslagen in de bronnen sub-
map van de calibre installatielocatie. In Windows is dit meestal C:\Program Files\Calibre2app\resources. In
macOS, /Applications/calibre.app/Contents/Resources/resources/. In Linux , als u het binaire instal-
latieprogramma van de calibre-website gebruikt, is dit /opt/calibre/resources. Deze paden kunnen veranderen,
afhankelĳk van waar u kiest om calibre te installeren.
De bestanden in deze resourcesmap niet veranderen want uw veranderingen worden overschreven bĳ de volgende calibre
update. In plaats daarvan, ga naar Voorkeuren → Geavanceerd → Allerlei en klik Open calibre configuratie map. Creëer
in deze configuratiemap een submap genaamd bronnen en plaats er de bestanden die u wilt negeren. Plaats de bestan-
den in geschikte submappen, plaats afbeeldingen bĳvoorbeeld in resources/images, etc. calibre zal automatisch uw
aangepast bestand verkiezen boven het ingebouwde bĳ de volgende start.
Bĳvoorbeeld, als u het icoon voor de Boeken verwĳderen actie wilt veranderen, zou u eerst in de ingebouwde bron-
nenmap kĳken en zien dat het relevant bestand resources/images/remove_books.png is. Aangenomen dat u
een alternatief icoon heeft in PNG formaat, genaamd my_remove_books.png, zou u het opslaan in de configura-
tiemap als resources/images/remove_books.png. Alle iconen gebruikt door de calibre gebruikersinterface staan
in resources/images en zĳn submappen.
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12.5 Maak uw eigen icon thema voor Calibre
If you have created a beautiful set of icons and wish to share them with other calibre users via calibre’s builtin icon
theme support, you can easily package up your icons into a theme. To do so, go to Preferences → Miscellaneous → Create
icon theme, select the folder where you have put your icons. Then fill up the theme metadata and click OK. This will
result in a ZIP file containing the theme icons. You can upload that to the calibre forum at Mobileread106 and then I
will make your theme available via calibre’s builtin icon theme system. By default, the icon theme you just created will
also be installed as the current theme in calibre. If you are testing your theme, remember to remove the images from the
resources/images folder so that the icons from the theme are used.
As of calibre 6, you can have custom icons for light and dark mode. Simply create two versions of the icon and name the
files with the suffix -for-dark-theme and -for-light-theme. For example, modified-for-dark-theme.png
and modified-for-light-theme.png. Then calibre will automatically use the appropriate icon based on the current
theme.

12.6 calibre personaliseren met plugins
calibre is zeer modulair ontworpen. Bĳna alle functionaliteit in calibre komt in de vorm van plug-ins. Er zĳn plug-ins voor
conversie, downloaden van nieuws (recepten genoemd), voor verschillende componenten van de gebruikersinterface, om
te verbinden met verschillende toestellen, om bestanden te verwerken bĳ toevoegen aan calibre enz. U vindt een volledige
lĳst van alle ingebouwde plug-ins in calibre op :guilabel: `Voorkeuren-> Geavanceerd-> Plug-ins ‘.
U kunt uw eigen plugins schrĳven om het gedrag van calibre aan te passen en uit te breiden. De opbouw van plugins is heel
simpel, lees hierover de handleiding Uw eigen plugins schrĳven om de functionaliteit van calibre uit te breiden (pagina 226).
Als u een plug-in geschreven heeft kan u die uploaden naar het calibre plug-in forum op Mobileread107 en hĳ zal beschik-
baar zĳn via calibre’s ingebouwde plug-in updater.

106 https://www.mobileread.com/forums/forumdisplay.php?f=166
107 https://www.mobileread.com/forums/forumdisplay.php?f=237
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Opdrachtpromt

Notitie

On macOS, the command line tools are inside the calibre bundle, for example, if you installed calibre in
/Applications the command line tools are in /Applications/calibre.app/Contents/MacOS/. So,
for example, to run ebook-convert you would use: /Applications/calibre.app/Contents/MacOS/

ebook-convert.

13.1 Gedocumenteerde commando’s
13.1.1 calibre

calibre [options] [path_to_ebook or calibre url ...]

Start calibre’s Grafische Gebruiker Interface en voeg optioneel het e-boek toe aan path_to_ebook naar de database. U
kan ook calibre URLs specificeren om verscheidene taken uit te voeren, buiten boeken toevoegen. Bĳvoorbeeld:
calibre://view-book/test_library/1842/epub
Opent het boek met id 1842 in het EPUB formaat uit de bibliotheek “test_library” in de calibre e-boek viewer. Bibli-
otheeknamen zĳn de mapnamen van de bibliotheken met spaties vervangen door onderliggende streepjes. Een volledige
beschrĳving van de verschillende URL gebaseerde acties staat in de Gebruikershandleiding.
Als u aan calibre parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
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[Opties]
--detach

Loskoppelen van de controleterminal, indien aanwezig (alleen Linux)
--help, -h

toon dit helpbericht en stop
--ignore-plugins

Aangepaste plug-ins negeren. Nuttig als u een plug-in geïnstalleerd hebt waardoor calibre niet kan starten
--no-update-check

Niet op nieuwe versies controleren
--shutdown-running-calibre, -s

Sluit, indien aanwezig, een actieve calibre-instantie af. Bedenk dat eventuele draaiende taken zonder melding wor-
den afgebroken. Gebruik deze optie voorzichtig.

--start-in-tray

Geminimaliseerd naar het systeemvak starten.
--verbose, -v

Genegeerd: gebuik dit niet. Alleen aanwezig voor compatibiliteitsredenen
--version

toon programmaversie en stop
--with-library

Gebruik de bibliotheek op de opgegeven locatie.

13.1.2 calibre-customize

calibre-customize opties

Pas calibre aan door externe plug-ins te laden.
Als u aan calibre-customize parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten.
Bv.: “/some path/with spaces”

[Opties]
--add-plugin, -a

Voeg een plug-in toe door het pad op te geven naar z'n ZIPbestand.
--build-plugin, -b

Voor plug-in ontwikkelaars: Pad naar de map waar u de plug-in ontwikkelt. Dit commando zal de plug-in automa-
tisch zippen en updaten in calibre.

--customize-plugin

Plug-in aanpassen. Geef de naam van de plug-in en de aanpassingsreeks op, gescheiden door een komma. De
aanpassingsreeks is dezelfde als die u zou invoeren bĳ het aanpassen van de plug-in in de hoofd calibre GUI

--disable-plugin

Deactiveer de genoemde plug-in
--enable-plugin

Activeer de genoemde plug-in
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--help, -h

toon dit helpbericht en stop
--list-plugins, -l

Toon alle geïnstalleerde plug-ins
--remove-plugin, -r

Verwĳder een aangepaste plug-in op naam. Heeft geen effect op standaard plug-ins
--version

toon programmaversie en stop

13.1.3 calibre-debug

calibre-debug [opties]

Verscheidene commandoregel interfaces nuttig voor foutzoeken in calibre. Zonder opties start dit commando een ge-
integreerde Python vertaler. U kan ook de hoofd calibre GUI gebruiken, het calibre leesvenster en de calibre bewerker in
de foutzoekmodus.
Het bevat ook interfaces voor verschillende stukjes van calibre die geen specifieke commandoregel gereedschappen heb-
ben, zoals font subsets, de e-boek diff tool en zo voort.
U kan ook calibre-debug gebruiken om zelfstandige scripts te draaien. Gebruik het daarvoor zo:

calibre-debug -e myscript.py -- --option1 --option2 file1 file2 …
Alles na de -- wordt doorgegeven aan het script. U kan ook calibre foutzoeken gebruiken als een shebang in scripts, zo:

#!/usr/bin/env -S calibre-debug -e -- –
Als u aan calibre-debug parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.:
“/some path/with spaces”

[Opties]
--add-simple-plugin

Voeg een eenvoudige plug-in toe (b.v. een plug-in die één .py bestand bevat) door het pad aan te geven naar het
py-bestand die de code voor de plug-in bevat.

--command, -c

Python code uitvoeren.
--debug-device-driver, -d

Fouten in toesteldetectie zoeken
--default-programs

calibre (af)melden als Windows standaard programma. --default-programs (pagina 307) = (regis-

ter|unregister)

--diff

Draait de calibre diff tool. Bĳvoorbeeld: calibre-debug --diff (pagina 307) bestand1 bestand2
--edit-book

Start het calibre "Bewerk Boek" tool in debug modus.
--exec-file, -e

Python code in het bestand uitvoeren.
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--explode-book, -x

Explodeer het boek in de gespecificeerde map. Gebruik: -x file.epub output_dir Exporteert het boek als een ver-
zameling HTML bestanden en metadata die u kan bewerken met standaard HTML gereedschappen. Werkt met
EPUB, AZW3, HTMLZ en DOCX bestanden.

--export-all-calibre-data

Exporteer alle Calibre-gegevens (boeken/instellingen/plug-ins). Normaal gesproken wordt u gevraagd naar
de exportmap en de bibliotheken die u wilt exporteren. U kunt ze ook opgeven als opdrachtre-
gel argumenten om de vragen over te slaan. Gebruik absolute paden voor de exportmap en biblio-
theken. Het speciale trefwoord "all" kan worden gebruikt om alle bibliotheken te exporteren. Voor-
beelden: calibre-debug --export-all-calibre-data (pagina 308) # voor interactief gebruik calibre-
debug --export-all-calibre-data (pagina 308) /path/to/empty/export/folder /path/to/library/folder1
/path/to/library2 calibre-debug --export-all-calibre-data (pagina 308) /export/folder all # exporteer alle
bekende bibliotheken

--gui, -g

Start de GUI met de probleemoplosser ingeschakeld. De output wordt afgedrukt naar stdou en stderr.
--gui-debug

Voer de GUI uit met de debug console, log naar het gespecificeerd pad. Enkel intern gebruik, gebruik de -g optie
om de GUI in debug modus uit te voeren

--help, -h

toon dit helpbericht en stop
--implode-book, -i

Implodeer een eerder geëxplodeerd boek. Gebruik: -i output_dir file.epub Importeert het boek vanuit bestanden in
output_dir die gecreëerd werden bĳ een vorige aanroep van --explode-book (pagina 307). Zorg ervoor hetzelfde
bestandstype op te geven als bĳ het exploderen.

--import-calibre-data

Importeer eerder geëxporteerde calibre gegevens
--inspect-mobi, -m

Inspecteer MOBI-bestand(en) in opgegeven pad(en)
--kepubify

Convert the specified EPUB file to KEPUB without doing a full conversion. This is what the Kobo driver does
when sending files to the device.

--paths

Output van de paden de nodig zĳn voor de installatie van de calibre omgeving
--run-plugin, -r

plug-inplug-inVoer een plugin uit welke via opdracht-prompt kan starten. Bĳvoorbeeld: calibre-debug -r "Plug-in
naam" -- bestand1 --option1 Alles na de -- zal worden meegegeven aan de plugin als argumenten.

--run-test, -t

Voer de genoemde test(s) uit. Gebruik de speciale waarde "alle" om alle tests uit te voeren. Als de testnaam begint
met een punt, wordt aangenomen dat het een modulenaam is. Als de testnaam begint met @, wordt aangenomen
dat het een categorienaam is.

--run-without-debug

Niet uitvoeren met de DEBUG flag set
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--shutdown-running-calibre, -s

Sluit, indien aanwezig, een actieve calibre-instantie af. Bedenk dat eventuele draaiende taken zonder melding wor-
den afgebroken. Gebruik deze optie voorzichtig.

--subset-font, -f

Wissel het gespecifieerde lettertype. Gebruik -- na deze optie om optie door te geven naar lettertype wisselpro-
gramma.

--test-build

Test binaire modules in build
--un-kepubify

Convert the specified KEPUB file to EPUB without doing a full conversion. This is what the Kobo driver does
when importing files from the device.

--version

toon programmaversie en stop
--viewer, -w

E-boek leesvenster in debug modus uitvoeren

13.1.4 calibre-server

calibre-server [options] [path to library folder...]

Start de calibre Content server. De calibre Content server toont uw calibre bibliotheken via het internet. U kan het pad
naar de bibliotheek mappen specificeren als argumenten bĳ calibre-server. Als u geen pad specificeert, worden alle
bibliotheken die het calibre hoofdprogramma kent, gebruikt.
Als u aan calibre-server parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.:
“/some path/with spaces”

[Opties]
--access-log

Pad naar toegangslogbestand. Dit houdt informatie bĳ over clients die verbinding maken met de server en aanvragen
indienen. Standaard worden geen toegangslogbestanden bĳgehouden.

--ajax-timeout

Tĳd (in seconden) om te wachten op een antwoord van de server bĳ zoekopdrachten.
--auth-mode

Kies het type authenticatie dat gebruikt is. Stel de HTTP authenticatie modus in gebruikt door de server. Op "basis"
als u de server achter een proxy zet, laat het anders op "auto" wat "basis" gebruikt als SSL is ingesteld, anders
gebruikt het "digest".

--auto-reload

Herstart automatisch wanneer de bron code veranderd. Handig voor ontwikkeling. U zou ook een kleine waarde
moeten geven aan de afsluit timeout.

--ban-after

Aantal mislukte inlogpogingen voor bannen. Het aantal mislukte inlogpogingen waarna een IP adres wordt geband
--ban-for

Ban IP adressen met meerdere mislukte inlogpogingen. Bant tĳdelĳk IP adressen die meerdere mislukte inlogpo-
gingen hebben voor het gespecificeerde aantal minuten. Nuttig om pogingen tot wachtwoord raden te voorkomen.
Indien ingesteld op 0 wordt er niet geband.

13.1. Gedocumenteerde commando’s 309



calibre Gebruikershandleiding, Release 8.7.0

--book-list-mode

De standaard boekenlĳst modus kiezen. Stel de standaard boekenlĳst modus in voor nieuwe gebruikers. Individuele
gebruikers kunnen de standaard negeren in hun instellingen. De standaard is een omslagraster.

--compress-min-size

Minimale grootte waarbĳ antwoorden data compressie gebruiken (in bytes).
--custom-list-template

Pad naar een JSON bestand met een sjabloon voor de aangepaste boekenlĳst modus. De gemakkelĳkste manier om
zo'n sjabloonbestand te creëren is via Voorkeuren->Delen->Delen via (inter)net->Boek lĳst sjabloon in calibre,
creëer de sjabloon en exporteer ze.

--daemonize

Draai het proces in de achtergrond als een daemon (enkel Linux)
--displayed-fields

Getoonde gebruiker gedefinieerde velden beperken. Komma gescheiden lĳst met door de gebruiker gedefinieerde
metadatavelden die door de Content server in de /opds en /mobile weergaven worden getoond. Als u deze optie
selecteert, worden velden die niet in deze lĳst zĳn opgenomen niet weergegeven. Bv.: my_rating,my_tags

--enable-allow-socket-preallocation, --disable-allow-socket-preallocation

Socket voor-toewĳzing, bv. bĳ systemd socket activatie. Deze optie is standaard ingeschakeld.
--enable-auth, --disable-auth

Wachtwoord gebaseerde authenticatie voor toegang tot de server. Normaal heeft de server geen beperkingen en
geeft iedereen toegang. Met deze optie kan u toegang beperken tot vooraf gedefinieerde gebruikers. Deze optie is
standaard uitgeschakeld.

--enable-fallback-to-detected-interface, --disable-fallback-to-detected-interface

Terug vallen op automatisch gedetecteerde interface. Als de server voor een bepaalde reden niet in staat is om te
"bind"en met de interface gespecificeerd in listen_on, probeert hĳ een interface te detecteren die met de buiten-
wereld verbindt en bind daarmee. Deze optie is standaard ingeschakeld.

--enable-local-write, --disable-local-write

Laat niet-geauthentiseerde lokale verbindingen veranderingen maken. Normaal, als u authenticatie niet aanzet,
werkt de server in alleen-lezen modus zodat anonieme gebruikers geen veranderingen kunnen aanbrengen in uw
calibre bibliotheken. Deze optie laat iedereen die verbindt vanop dezelfde computer als waarop de server draait
veranderingen maken. Nuttig als u de server wilt draaien zonder authenticatie maar toch calibredb wilt gebruiken
om uw bibliotheken te wĳzigen. Merk op dat deze optie aanzetten betekent dat elk programma op de computer uw
calibre bibliotheken kan wĳzigen. Deze optie is standaard uitgeschakeld.

--enable-log-not-found, --disable-log-not-found

HTTP 404 (Niet Gevonden) verzoeken loggen. Normaal logt de server alle HTTP verzoeken voor bronnen die hĳ
niet vond. Dit kan een hoop log spam genereren als uw server het doel wordt van bots. Gebruik deze optie om het
af te zetten. Deze optie is standaard ingeschakeld.

--enable-use-bonjour, --disable-use-bonjour

Adverteer OPDS feeds via BonJour. Adverteer de OPDS feeds via de BonJour dienst, zodat OPDS gebaseerde
reading apps de server kunnen detecteren en automatisch verbinden. Deze optie is standaard ingeschakeld.

--enable-use-sendfile, --disable-use-sendfile

Zero copy file transfers for increased performance. This will use zero-copy in-kernel transfers when sending files
over the network, increasing performance. However, it can cause corrupted file transfers on some broken filesys-
tems. If you experience corrupted file transfers, turn it off. Deze optie is standaard ingeschakeld.

--help, -h

toon dit helpbericht en stop
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--ignored-fields

Genegeerde door de gebruiker gedefinieerde metadata velden. Door komma's gescheiden lĳst van door de ge-
bruiker gedefinieerde metadata gegevensvelden die niet door de inhoudsserver in de weergaven /OPDS en /mobiel
worden weergegeven. Bĳvoorbeeld: my_rating,my_tags

--listen-on

De interface waarop te luisteren voor verbindingen. The default is to listen on all available IPv6 and IPv4 interfaces.
You can change this to, for example, "127.0.0.1" to only listen for IPv4 connections from the local machine, or to
"0.0.0.0" to listen to all incoming IPv4 connections.

--log

Pad naar logbestand voor serverlog. Dit logbestand bevat servergegevens en fouten, maar geen toegangslogs. Het
wordt standaard naar stdout geschreven.

--manage-users

Beheer de database met gebruikers die met deze server mogen verbinden. U kan het in automatische modus ge-
bruiken door toevoeging van een –. Bekĳk calibre-server --manage-users (pagina 311) -- help voor details.
Bekĳk ook de --userdb (pagina 312) optie.

--max-header-line-size

Max. grootte van enkele HTTP header (in KB).
--max-job-time

Maximale tĳd voor werkprocessen. Maximale tĳd dat werker processen mogen draaien (in minuten). Stel in op nul
voor geen limiet.

--max-jobs

Maximale aantal werkprocessen. Werker processen worden gelanceerd indien nodig en gebruikt voor grote taken
zoals voorbereiden van een boek om te tonen, boeken toevoegen, converteren, enz. Normaal is het maximale aantal
gebaseerd op het aantal CPU kernen. U kan het controleren met deze instelling.

--max-log-size

Max. logfile grootte (in MB). Maximum grootte van log bestanden gegenereerd door de server. Als de log groter
wordt, wordt het automatisch geroteerd. Zet op nul om log rotatie uit te schakelen.

--max-opds-items

Maximale aantal boeken in OPDS feeds. Maximum aantal boeken dat de server terug geeft in een enkele OPDS
verkrĳgingsfeed.

--max-opds-ungrouped-items

Maximaal aantal niet-gegroepeerde items in OPDS-feeds. Groepeer items in categorieën zoals auteur/labels per
beginletter wanneer er meer items dan dit aantal zĳn. Stel op nul in om uit te schakelen.

--max-request-body-size

Toegestane max. bestandsgrootte om naar server te uploaden (in MB).
--num-per-page

Aantal boeken te tonen op een enkele pagina. Aantal boeken te tonen op een enkele pagina in de browser.
--pidfile

Schrĳf het PID van het proces naar het opgegeven bestand
--port

De poort waarop geluisterd word naar verbindingen.
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--search-the-net-urls

Pad naar JSON bestand met URLs voor de "Doorzoek het internet" functie. De gemakkelĳkste manier om zo'n
bestand te creëren is via Voorkeuren->Delen->Delen via (inter)net->Doorzoek het internet in calibre, creëer de
URLs en exporteer ze.

--shutdown-timeout

Totaaltĳd in seconden om te wachten om netjes af te sluiten.
--ssl-certfile

Pad naar bestand SSL certificaat.
--ssl-keyfile

Pad naar bestand SSL persoonlĳke sleutel.
--timeout

Tĳd (in seconden) totdat een inactieve verbinding wordt gesloten.
--trusted-ips

Laat niet-geauthentiseerde verbindingen van specifieke IP adressen veranderingen maken. Normaal, als u authen-
ticatie niet aanzet, werkt de server in alleen-lezen modus zodat anonieme gebruikers geen veranderingen kunnen
aanbrengen in uw calibre bibliotheken. Deze optie laat iedereen die verbindt vanop specifieke IP adressen veran-
deringen maken. Moet een komma gescheiden lĳst zĳn van adressen of netwerk specificaties. Nuttig als u de server
wilt draaien zonder authenticatie maar toch calibredb wilt gebruiken om uw bibliotheken te wĳzigen. Merk op dat
deze optie aanzetten betekent dat iedereen die verbindt vanop de gespecificeerde adressen uw calibre bibliotheken
kan wĳzigen.

--url-prefix

Een prefix om voor alle URL's te zetten. Nuttig als u deze server achter een omgekeerde proxy wil draaien. Bv.
gebruik /calibre als het URL voorvoegsel.

--userdb

Pad naar de gebruikersdatabase voor authenticatie. De database is een SQLite bestand. Gebruik --manage-users
(pagina 311) om het te creëren. U kan meer lezen over gebruikersbeheer op: https://manual.calibre-ebook.com/nl/
server.html#managing-user-accounts-from-the-command-line-only

--version

toon programmaversie en stop
--worker-count

Aantal werker threads gebruikt om verzoeken te verwerken.

13.1.5 calibre-smtp

calibre-smtp [opties] [van naar tekst]

Verzend een email met het SMTP protocol. calibre-smtp heeft 2 manieren van werken, in de schrĳf modus kan u een
van / to en text specifieren en deze zullen dan gebruikt worden voor het opstellen en verzenden van een email boodschap.
In de filter modus, zal calibre-smtp een complete email inlezen uit STDIN en het dan verzenden
tekst is de tekst in het email bericht Als tekst niet is gespecifieerd, dan zal een complete email uitgelezen worden vanuit
STDIN van is het email adres van de verzender en to die van de ontvanger Wanneer een complete email is uitgeleden vanuit
STDIN, worden van en naar enkel gebruikt bĳ het SMTP onderhandeling, de bericht headers worden niet aangepast.
Als u aan calibre-smtp parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.:
“/some path/with spaces”
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[Opties]
--fork, -f

Fork en verzend berichten in de achtergrond. Indien u deze optie gebruikt zou u ook de --outbox (pagina 313)
moeten gebruiken om verzend problemen op te vangen.

--help, -h

toon dit helpbericht en stop
--localhost, -l

Computernaam van deze pc. Gebruikt bĳ verbinden met SMTP server.
--outbox, -o

Pad naar mail-map om mislukte e-mails in op te slaan.
--timeout, -t

Time-out voor verbinding
--verbose, -v

Wees woordrĳker
--version

toon programmaversie en stop

COMPOSE MAIL

Opties om een e-mail op te stellen. Genegeerd als tekst niet is opgegeven
--attachment, -a

Bestand om toe te voegen aan email
--subject, -s

Onderwerp van de email

SMTP RELAY

Opties om een SMTP relay server te gebruiken om mail te verzenden. calibre zal proberen om rechtstreeks een email te
versturen, tenzĳ –relay wordt meegegeven.
--cafile

Path to a file of concatenated CA certificates in PEM format, used to verify the server certificate when using TLS.
By default, the system CA certificates are used.

--dont-verify-server-certificate

Do not verify the server certificate when connecting using TLS. This used to be the default behavior in calibre
versions before 3.27. If you are using a relay with a self-signed or otherwise invalid certificate, you can use this
option to restore the pre 3.27 behavior

--encryption-method, -e

Encryptie methode gebruiken bĳ verbinden van relay. Keuzes zĳn TLS, SSL en NONE. Standaard is TLS. WAAR-
SCHUWING: NONE kiezen is zeer onveilig

--password, -p

Wachtwoord voor relay
--port

Poort om te connecteren naar een relay server. Standaard wordt 465 gebruikt indien encryptie actief is, en 25 anders.
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--relay, -r

Een SMTP relay server gebruiken om email te verzenden.
--username, -u

Gebruikersnaam voor relay

13.1.6 calibredb

%prof commando [opties] [parameters]

calibrebd is de command line interface naar de calibre database. Het heeft verschillende sub-commando’s, hieronder
gedocumenteerd.
calibrebd kan gebruikt worden om ofwel een calibre database te manipuleren gespecificeerd bĳ pad of een calibre
Content server draaiend ofwel op de lokale machine of over het internet. U kan een calibre Content server starten ofwel met
het calibre-server programma ofwel klik in het calibre hoofdprogramma op Connect/share  → Start Content Server.
Aangezien calibredb veranderingen kan aanbrengen in uw calibre bibliotheken, moet u eerst authenticatie instellen op
de server. Er zĳn twee manieren om dat te doen:

• Als u enkel wil verbinden met een server die draait op dezelfde computer,
kan u gewoon de --enable-local-write optie gebruiken van de Content server, om elk pro-
gramma, inbegrepen calibre, dat draait op de lokale computer om dingen te veranderen in uw
calibre data. Als u de server vanuit het calibre hoofdprogramma draait, is deze optie in Preferen-
ces → Sharing over het internet → Geavanceerd.

• Als u toegang over het internet wil inschakelen, dan moet u gebruikersaccounts instellen op de server
en de opties --username (pagina 315) en --password gebruiken (pagina 315) op calibredb

om het toegang te verlenen. U kan gebruikerauthenticatie instellen voor calibre-server met de
--enable-auth optie en gebruik makend van --manage-users om de gebruikersaccounts te cre-
eren. Als u de server draait vanuit het calibre hoofdprogramma, gebruik Voorkeuren → Delen over het
net → Vraag gebruikersnaam/wachtwoord.

Om te verbinden met een draaiende Content server, geef de URL van de server door aan de --with-library (pagi-
na 315) optie, bekĳk de documentatie van die optie voor details en voorbeelden.

• ALGEMENE OPTIES (pagina 315)
• list (pagina 316)
• add (pagina 317)

– TOEVOEGEN VANUIT MAPPEN (pagina 317)
• remove (pagina 318)
• add_format (pagina 318)
• remove_format (pagina 318)
• show_metadata (pagina 319)
• set_metadata (pagina 319)
• export (pagina 319)
• catalog (pagina 320)

– EPUB OPTIES (pagina 321)
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• saved_searches (pagina 322)
• add_custom_column (pagina 323)
• custom_columns (pagina 323)
• remove_custom_column (pagina 323)
• set_custom (pagina 324)
• restore_database (pagina 324)
• check_library (pagina 324)
• list_categories (pagina 325)
• backup_metadata (pagina 325)
• clone (pagina 325)
• embed_metadata (pagina 326)
• search (pagina 326)
• fts_index (pagina 326)
• fts_search (pagina 327)

ALGEMENE OPTIES
--help, -h

toon dit helpbericht en stop
--library-path, --with-library

Pad naar calibre bibliotheek. Standaard wordt het pad gebruikt opgeslagen in de instellingen. U kan ook met een
calibre Content server verbinden om te wĳzigen in bibliotheken op afstand. Om dit te doen, gebruik een URL van de
vorm: http://hostname:port/#library_id bv, http://localhost:8080/#mylibrary. library_id is de id van de bibliotheek
waarmee u wilt verbinden op de Content server. U kan de speciale library_id gebruiken van - om een lĳst te
krĳgen van beschikbare ids op de server. Voor details over het toegang krĳgen via een Content server, zie https:
//manual.calibre-ebook.com/nl/generated/nl/calibredb.html.

--password

Wachtwoord om te verbinden met een calibre Content server. Gebruik speciale waarde: <stdin> om het wachtwoord
van de standaardinvoer te lezen. Om het wachtwoord van een bestand te lezen, gebruik: <f:/path/to/file> (d.w.z. <f:
gevolgd door volledig pad naar bestand en een trailing>). De punthaken in het bovenstaande zĳn vereist, onthoud
om ze te escapen of gebruik aanhalingstekens voor uw shell.

--timeout

De time-out, in seconden, bĳ verbinden met een calibre bibliotheek over het netwerk. De standaard is twee minuten.
--username

Gebruikersnaam voor verbinden met een calibre Content server
--version

toon programmaversie en stop
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list

calibredb list [opties]

Toon de beschikbare boeken in de calibre-database.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--ascending

Sorteer resultaten in oplopende volgorde
--fields, -f

Velden te tonen bĳ het maken van boekenlĳsten in de database. Moet een lĳst met komma-gescheiden waarden zĳn.
Beschikbare velden: author_sort, authors, comments, cover, formats, identifiers, isbn, languages, last_modified,
pubdate, publisher, rating, series, series_index, size, tags, template, timestamp, title, uuid Standaard: title,authors.
Het speciale veld "alle" kan dienen om alle velden te selecteren. Naast de ingebouwde velden boven zĳn ook
aangepaste velden beschikbaar als *field_name, bĳvoorbeeld, voor een aangepast veld #rating, gebruik de naam:
*rating

--for-machine

Genereer uitvoer in JSON formaat, dit is veel beter voor machine verificatie. Zorgt ervoor dat de lengte van lĳnen
en de afscheidings opties genegeerd zullen worden.

--limit

Het maximum aantal resultaten om weer te geven. Standaard: allen
--line-width, -w

De maximale breedte van een enkele regel in de uitvoer. Standaard is dit hetzelfde als de schermgrootte.
--prefix

De prefix voor mappaden. Standaard is het absolute pad naar de bibliotheekmap.
--search, -s

Filter de resultaten op de zoekoperatie. Voor het indeling van de zoekopdracht kunt u de zoek-gerelateerde docu-
mentatie in de gebruikershandleiding raadplegen. Standaard word er niet gefilterd.

--separator

De string gebruikt om velden van elkaar te scheiden. Standaard is dit een spatie.
--sort-by

Het veld waarop de resultaten moeten worden gesorteerd. U kunt meerdere velden specificeren door ze te scheiden
met komma's. Beschikbare velden: author_sort, authors, comments, cover, formats, identifiers, isbn, languages,
last_modified, pubdate, publisher, rating, series, series_index, size, tags, template, timestamp, title, uuid Standaard:
id

--template

De sjabloon die moet worden uitgevoerd als "template" in de veldenlĳst staat. Houd er rekening mee dat sjablonen
worden genegeerd tĳdens het verbinden met een Calibre-server. Standaard: Geen

--template_file, -t

Pad naar een bestand met het sjabloon dat moet worden uitgevoerd als "template" in de veld-lĳst staat. Standaard:
Geen

--template_heading

Kop voor de sjabloonkolom. Standaard: stan%daard. Deze optie wordt genegeerd als de optie --for-machine

(pagina 316) is ingesteld
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add

calibredb toevoegen [opties] bestand1 bestand2 bestand3 ...

Voeg de gespecificeerde bestanden als boeken toe aan de database. U kan ook mappen specificeren, kĳk bĳ map gere-
lateerde opties beneden.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--authors, -a

Stel de auteur in voor toegevoegde boek(en)
--automerge, -m

Als boeken met vergelĳkbare titels en auteurs worden gevonden, voegt u de binnenkomende formaten (bestanden)
automatisch samen met bestaande boekrecords. De waarde "negeren" betekent dat dubbele formaten worden ver-
wĳderd. De waarde "overschrĳven" betekent dat dubbele formaten in de bibliotheek worden overschreven door de
nieuw toegevoegde bestanden. De waarde "new_record" betekent dat dubbele formaten in een nieuw boekrecord
worden geplaatst.

--cover, -c

Pad naar de omslag voor het toegevoegde boek
--duplicates, -d

Voeg boeken toe aan de database, zelfs als ze al bestaan. Er wordt vergeleken op basis van boektitels en auteurs.
Merk op dat de optie --automerge (pagina 317) voorrang heeft.

--empty, -e

Voeg een leeg boek toe (een boek dat van geen enkel formaat gebruikt maakt)
--identifier, -I

Stel de identificatren voor dit boek in, bĳvoorbeeld: -I asin:XXX -I isbn:YYY
--isbn, -i

Stel het ISBN-nummer in voor toegevoegde boek(en)
--languages, -l

Een door komma's gescheiden lĳst van talen (het beste is om ISO639 taal codes te gebruiken, alhoewel sommige
taal-namen ook herkend worden)

--series, -s

Stel de series in van toegevoegde boek(en)
--series-index, -S

Stel het nummer in de serie in voor toegevoegde boek(en)
--tags, -T

Stel labels in voor toegevoegde boek(en)
--title, -t

Stel de titel in voor toegevoegde boek(en)

TOEVOEGEN VANUIT MAPPEN

Opties voor beheer van boeken toevoegen vanuit mappen. Standaard enkel bestanden met extensies van gekende e-boek
bestandtypes.
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--add

Een bestandsnaam (glob) patroon, bestanden die overeenkomen met dit patroon zullen worden toegevoegd bĳ het
scannen van mappen voor bestanden, zelfs als ze geen bekend e-boek bestandstype hebben. Kan meerdere keren
worden opgegeven voor meerdere patronen.

--ignore

Een bestandsnaam (glob) patroon, bestanden die overeenkomen met dit patroon, worden genegeerd bĳ het scannen
van mappen. Kan meerdere keren worden opgegeven voor meerdere patronen. Bĳvoorbeeld: *.pdf zal alle pdf-
bestanden negeren

--one-book-per-directory, -1

Neem aan dat elke map een enkel logisch boek heeft and dat alle bestanden erin verschillende e-boek formaten zĳn
van dat boek

--recurse, -r

Verwerk mappen recursief

remove

calibredb verwijder ID's

Verwĳder de boek indentificatoren van de database. ID’s is een komma-gescheiden lĳst van ID nummers (u kan ID
nummers verkrĳgen door het zoek commando te gebruiken). Bĳvoorbeeld: 23,34,57-85 (bĳ opgave van een serie, wordt
het laatste nummer niet opgenomen).
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--permanent

Gebruik de Prullenbak niet

add_format

calibredb add_format [opties] id ebook_file

Voeg het e-boek in ebook_file toe aan de beschikbare formaten voor het logische boek geïdentificeerd door id. U kunt id
krĳgen door de zoekopdracht te gebruiken. Als het formaat al bestaat, wordt het vervangen, tenzĳ de optie Niet vervangen
is opgegeven.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--as-extra-data-file

Voeg het bestand toe als een extra gegevensbestand aan het boek, niet als e-boekindeling
--dont-replace

Vervang het formaat niet als het al bestaat

remove_format

calibredb remove_format [opties] id fmt

Verwĳder het formaat fmt van het logische boek geïdentificeerd door id. U kunt het id met het zoek-commando vinden.
fmt is een bestandsextensie zoals LRF, TXT of EPUB. Als het logische boek niet in dit formaat bestaat zal er niets
gebeuren.
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Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”

show_metadata

calibredb show_metadata [opties] id

Toon de metadata die in de calibre database zĳn opgeslagen voor het boek dat bĳ id hoort. id is een id nummer verkregen
met het zoek-commando.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--as-opf

Metadata in OPF-formaat (XML) afdrukken

set_metadata

calibredb set_metadata [options] book_id [/path/to/metadata.opf]

Stel de metadata in die zĳn opgeslagen in de Calibre-database voor het boek geïdentificeerd door book_id uit het OPF-
bestand metadata.opf. book_id is een boek-id-nummer van de zoekopdracht. U kunt snel een idee krĳgen van het OPF-
formaat door de –as-opf schakelt over naar de opdracht show_metadata. U kunt ook de metagegevens van individuele
velden met de optie –field. Als u de optie –field gebruikt, is er het is niet nodig om een OPF-bestand op te geven.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--field, -f

Het veld om te zetten. Formaat is veld_naam:waarde, bĳvoorbeeld: --field (pagina 319) labels:label1,label2.
Gebruik --list-fields (pagina 319) om een lĳst van alle veld namen te krĳgen. U kunt deze optie meer-
malen gebruiken om meerdere velden te zetten. Opgelet: Voor talen moet u de ISO639 taal codes gebruiken
(b.v. en voor Engels, fr voor Frans enzovoort). Voor identificatoren, de syntaxis is --field (pagina 319) identi-
fiers:isbn:XXXX,doi:YYYYY. Voor booleaans (ja/nee) velden gebruik waar en niet waar of ja en nee.

--list-fields, -l

Toon de metadata veldnamen die kunnen worden gebruikt met de --field (pagina 319) optie

export

calibredb export [opties] ids

Exporteer de boeken die zĳn opgegeven door ids (een door komma’s gescheiden lĳst) naar het bestandssysteem. De
exportbewerking slaat alle formaten van het boek, de omslag en metagegevens op (in een OPF-bestand). Alle extra
gegevensbestanden die aan het boek zĳn geassocieerd, worden ook opgeslagen. U kunt id-nummers ophalen via de zoek-
opdracht.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--all

Exporteer alle boeken in de database, negeer de lĳst met id's.
--dont-asciiize

Laat calibre alle niet-Latĳnse karakters converteren naar Latĳnse voor de bestandsnamen. Nuttig bĳ opslaan naar
een verouderd bestandssysteem zonder volledige ondersteuning voor Unicode bestandsnamen. Als u dit opgeeft zal
het gedrag uitgeschakeld worden.
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--dont-save-cover

Normaal slaat calibre de omslag op in een apart bestand samen met de overige boekbestanden van het bĳbehorende
boek. Als u dit opgeeft zal het gedrag uitgeschakeld worden.

--dont-save-extra-files

Save any data files associated with the book when saving the book Als u dit opgeeft zal het gedrag uitgeschakeld
worden.

--dont-update-metadata

Normaal zal calibre de metadata in opgeslagen bestanden bĳwerken met informatie in de calibre bibliotheek. Maakt
opslaan op schĳf langzamer. Als u dit opgeeft zal het gedrag uitgeschakeld worden.

--dont-write-opf

Normaal gesproken, zal calibre de metadata in een apart OPF-bestand opslaan, samen met de daadwerkelĳke e-
boekbestanden. Als u dit opgeeft zal het gedrag uitgeschakeld worden.

--formats

Kommagescheiden lĳst van opslagformaten voor elk boek. Standaard worden alle formaten bewaard.
--progress

Rapporteer voortgang
--replace-whitespace

Vervang witruimte door lage streepjes (_).
--single-dir

Exporteer alle boeken naar één enkele map
--template

De sjabloon waarmee de bestandsnaam en mapstructuur van de opgeslagen bestanden wordt gecontroleerd. Stan-
daard is dit "{author_sort}/{title}/{title} - {authors}’" dat boeken per auteur in een submap plaatst met bestands-
namen met de naam van de auteur en de titel. Beschikbare opties zĳn: {author_sort, authors, id, isbn, languages,
last_modified, pubdate, publisher, rating, series, series_index, tags, timestamp, title}

--timefmt

Het formaat om gegevens weer te geven. %d - dag, %b - maand, %m - maandnummer, %Y - jaar. Standaard is:
%b, %Y

--to-dir

Exporteer boeken naar de gespecificeerde map. Standaard is .
--to-lowercase

Paden naar kleine letters omzetten.

catalog

calibredb catalog /path/to/destination.(csv|epub|mobi|xml...) [options]

Exporteer een catalogus in een formaat gespecificeerd door pad / naar / bestemmingsextensie. Opties bepalen hoe ver-
meldingen worden weergegeven in de gegenereerde catalogusuitvoer. Merk op dat verschillende catalogusformaten ver-
schillende sets opties ondersteunen. Naar bekĳk de verschillende opties, specificeer de naam van het outputbestand en
dan de –help optie.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
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--ids, -i

Kommagescheiden lĳst met database-ID's om te catalogiseren. Indien gebruikt, zal --search (pagina 321) ge-
negeerd worden. Standaard: all

--search, -s

Filter de resultaten met de zoekopdracht. Voor het formaat van de zoekopdracht, zie de zoekfunctionaliteit in de
gebruikershandleiding. Standaard: geen filter

--verbose, -v

Laat gedetailleerde uitvoerinformatie zien. Nuttig bĳ het opsporen van problemen

EPUB OPTIES

--catalog-title

Titel van gegenereerde catalogus gebruikt als titel in metadata. Standaard: 'My Books' Van toepassing op: AZW3,
EPUB, MOBI uitvoerformaten

--cross-reference-authors

Creëert kruis-referenties in Auteursonderdeel voor boeken met meerdere auteurs. Standaard: 'False' Van toepas-
sing op: AZW3, EPUB, MOBI uitvoerformaten.

--debug-pipeline

Sla de uitvoer van verschillende stadia in de omzettingspĳplĳn op in de gespecificeerde map. Nuttig wanneer u
onzeker bent in welk stadium van het omzettingsproces een fout optreedt. Standaard: 'None' Van toepassing op:
AZW3, EPUB, MOBI uitvoerformaten

--exclude-genre

Regex die beschrĳft welke labels uit te sluiten als genre's. Standaard: '[.+]|^+$' sluit labels in haken uit, b.v.
'[Project Gutenberg]', en '+', de standaard voor gelezen boeken. Van toepassing op: AZW3, EPUB, MOBI
uitvoerformaten

--exclusion-rules

Specificeert de regels gebruikt om boeken uit te sluiten van de aangemaakt catalogus. Het model voor een uit-
sluitregel is ofwel ('<rule name>','Tags','<comma-separated list of tags>') of ('<rule name>','<custom co-
lumn>','<pattern>'). Bĳvoorbeeld: (('Gearchiveerde boeken','#status','Gearchiveerd'),) zal een boek uitslui-
ten met de waarde 'Gearchiveerd' in de aangepaste kolom 'status'. Wanneer meerder kolommen zĳn gedefini-
eerd, worden alle regels toegepast. Standaard: "(('Catalogs','Tags','Catalog'),)" Geldt voor AZW3, EPUB,
MOBI uitvoerformaten

--generate-authors

Voeg 'Auteurs' onderdeel toe aan catalogus. Standaard: 'False' Van toepassing op: AZW3, EPUB, MOBI uit-
voerformaten

--generate-descriptions

Voeg 'Beschrĳvingen' onderdeel toe aan catalogus. Standaard: 'False' Van toepassing op: AZW3, EPUB, MOBI
uitvoerformaten

--generate-genres

Voeg 'Genres' onderdeel toe aan catalogus. Standaard: 'False' Van toepassing op: AZW3, EPUB, MOBI uit-
voerformaten

--generate-recently-added

Voeg 'Onlangs toegevoegd' onderdeel toe aan catalogus. Standaard: 'False' Van toepassing op: AZW3, EPUB,
MOBI uitvoerformaten
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--generate-series

Voeg 'Series' onderdeel toe aan catalogus. Standaard: 'False' Van toepassing op: AZW3, EPUB, MOBI uitvoer-
formaten

--generate-titles

Voeg 'Titels' onderdeel toe aan catalogus. Standaard: 'False' Van toepassing op: AZW3, EPUB, MOBI uitvoer-
formaten

--genre-source-field

Bronveld voor Genres onderdeel. Standaard: 'Labels' Van toepassing op: AZW3, EPUB, MOBI uitvoerformaten
--header-note-source-field

Aangepast veld met in de Beschrĳving koptekst in te voegen notitie tekst. Standaard: '' Van toepassing op: AZW3,
EPUB, MOBI uitvoerformaten

--merge-comments-rule

#<custom field>:[voor|na]:[Waar|Onwaar] specificerend: <custom field> Aangepast veld met nota's samen te voe-
gen met commentaar [voor|na] Plaatsing van nota's ten opzichte van commentaar [Waar|Onwaar] - Een horizontale
regel wordt ingevoegd tussen nota's en commentaar Standaard: '::' Geldt voor: AZW3, EPUB, MOBI outvoer-
formaten

--output-profile

Specificeert het uitvoerprofiel. In sommige gevallen is een uitvoerprofiel vereist om de catalogus te optimaliseren
voor het toestel. Bĳvoorbeeld 'kindle' of 'kindle_dx' creëert een gestructureerde Inhoudsopgave met Onderdelen
en Artikelen Standaard: 'None' Geldt voor AZW3, EPUB, MOBI uitvoerformaten

--prefix-rules

Specificeert de regels gebruikt voor het insluiten van voorvoegsels die gelezen boeken aanduiden, wenslĳst items en
andere gebruiker gespecificeerde voorvoegsels. Het model voor een voorvoegsel regel is ('<rule name>','<source
field>','<pattern>','<prefix>'). Wanneer meerdere regels gedefinieerd zĳn, wordt de eerste regel gebruikt. Stan-
daard: "(('Read books','tags','+','✓'),('Wishlist item','tags','Wishlist','×'))"Geldt voor AZW3, EPUB,
MOBI uitvoerformaten

--preset

Gebruik een benoemde voorinstelling gemaakt met de GUI catalogus bouwer. Een voorinstelling specificeert alle
instellingen om een catalogus te maken. Standaard: 'None' Van toepassing op AZW3, EPUB, MOBI uitvoerfor-
maten

--thumb-width

Formaat tip (in inches) voor boekomslagen in catalogus. Bereik: 1.0 - 2.0 Standaard: '1.0' Van toepassing op:
AZW3, EPUB, MOBI uitvoerformaten

--use-existing-cover

Vervang bestaande omslag bĳ genereren van de catalogus. Standaard: 'False' Van toepassing op: AZW3, EPUB,
MOBI uitvoerformaten

saved_searches

calibredb saved_searches [options] (list|add|remove)

Beheer de opgeslagen zoekopdrachten in deze database. Als u een zoekopdracht met dezelfde naam wil opslaan, dan zal
de oude vervangen worden.
Syntax om toe te voegen:
calibredb saved_searches add search_name search_expression
Syntax om te verwĳderen:
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calibredb saved_searches remove search_name
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”

add_custom_column

calibredb add_custom_column [opties] label naam gegevenstype

Creëer een zelf gedefinieerde kolom. label is de machine vriendelĳke naam van de kolom. Dit label
mag geen spaties of dubbele punten bevatten, naam is de mens vriendelĳke naam van de kolom.

gegevenstype is één van: bool, comments, composite, datetime, enumeration, float, int, rating, series, text
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--display

Een woordenboek van opties voor het aanpassen van hoe de gegevens in deze kolom worden geïnterpreteerd.
Dit is een JSON string. Voor kolommen met opsommingen gebruik --display (pagina 323)"{\ "enum_values\
":[\ "val1\ ", \ "val2\ "]}" Er bestaan vele opties voor de weergave variabele. De opties per kolomtype zĳn:
samenstelling: composite_template, composite_sort, make_category,contains_html, use_decorations datum/tĳd:
date_format opsomming: enum_values, enum_colors, use_decorations int, float: number_format tekst: is_names,
use_decorations De beste manier om geldige combinaties te vinden is door het maken van een aangepaste kolom
van het juiste type in de GUI en daarna in de back-up OPF zoeken naar een boek (verzeker u ervan dat er een
nieuw OPF is aangemaakt nadat de kolom is toegevoegd). U zult de JSON zien voor de "weergave" van de nieuwe
kolom in de OPF.

--is-multiple

Deze kolom slaat label like data op (i.e. waarden gescheiden door komma's). Enkel van toepassing als data tekst
is.

custom_columns

calibredb custom_columns [options]

Lĳst van beschikbare aangepaste kolommen. Geeft kolommen en ID’s weer.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--details, -d

Toon details voor iedere kolom.

remove_custom_column

calibredb remove_custom_column [options] label

Verwĳder de door het label geïdentificeerde aangepaste kolom. U kan de beschikbare kolommen bekĳken door het cus-
tom_columns commando te gebruiken.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--force, -f

Niet om bevestiging vragen
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set_custom

calibredb set_custom [options] column id value

Stel de waarde van de aangepaste kolom in voor het boek, die geïdentificeerd is op ID. U kunt een lĳst van ids krĳgen met
behulp van het zoek commando. U kunt een lĳst met aangepaste kolomnamen krĳgen met behulp van het custom_columns
commando.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--append, -a

Als de kolom meerde waardes bevat, voeg dan de opgegeven waarden aan de bestaande toe, in plaats van ze te
vervangen.

restore_database

calibredb restore_database [options]

Herstel deze database van de metadata bewaard in OPF bestanden in elke map van de calibre bibliotheek. Nuttig als uw
metadata.db bestand gecorrumpeerd is.
WAARSCHUWING/ Dit commando regenereert uw database volledig. U zal alle zoekacties, gebruikerscategorieën,
adapters, opgeslagen per-boek conversies en aangepaste recepten verliezen. Herstelde metadata zullen maar zo accuraat
zĳn als wat is gevonden in de OPF bestanden.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--really-do-it, -r

Het herstel echt uitvoeren. Het commando zal niet uitgevoerd worden tenzĳ deze optie ingesteld is.

check_library

calibredb check_library [opties]

Voer controles uit op het bestandssysteem van de bibliotheek. Rapporten zĳn invalid_titles, extra_titles, invalid_authors,
extra_authors, missing_formats, extra_formats, extra_files, missing_covers, extra_covers, failed_folders
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--csv, -c

Uitvoer naar CSV
--ignore_extensions, -e

Kommagescheiden lĳst van te negeren extensies. Standaard: all
--ignore_names, -n

Kommagescheiden lĳst van te negeren namen. Standaard: all
--report, -r

Kommagescheiden lĳst van rapporten. Standaard: all
--vacuum-fts-db

Leeg de volledige tekstzoek database. Dit kan erg traag en geheugenintensief zĳn, afhankelĳk van de grootte van
de database
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list_categories

calibredb list_categories [opties]

Maak een rapport van de categorie-informatie in de database. De informatie is het equivalent van wat wordt weergegeven
in de Labelbrowser.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--categories, -r

Kommagescheiden lĳst van categorie-opzoeknamen. Standaard: alle
--csv, -c

Uitvoer naar CSV
--dialect

Het type CSV bestand te maken. Keuzes excel, excel-tab, unix
--item_count, -i

Toon alleen het aantal items in een categorie in plaats van de aantallen per item in de categorie
--width, -w

De maximale breedte van een enkele regel in de uitvoer. Standaard is dit hetzelfde als de schermgrootte.

backup_metadata

calibredb backup_metadata [opties]

Maak een back-up van de metadata uit de database in individuele OPF bestanden
in elke boek map. Dit gebeurt normaal automatisch maar u kan dit commando

uitvoeren om een vernieuwing van de OPF af te dwingen met de –all optie.
NB: Dit is normaal niet nodig omdat er van de OPF bestanden automatisch een back-up wordt gemaakt elke keer metadata
is veranderd.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--all

Normaal werkt dit commando enkel op boeken met verouderde OPF bestanden. Deze optie zorgt dat het op alle
boeken werkt.

clone

calibredb kloon pad/naar/nieuw/bibliotheek

Maak een kloon van de huidige bibliotheek. Hierdoor wordt een nieuwe, lege bibliotheek gemaakt met dezelfde aangepaste
kolommen, Virtuele bibliotheken en andere instellingen als de huidige bibliotheek.
De gekloonde bibliotheek bevat geen boeken. Als u een volledig duplicaat wilt maken, inclusief alle boeken, gebruik dan
gewoon uw bestandssysteemtools om de bibliotheekmap te kopiëren.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
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embed_metadata

calibredb ingevoegde_metadata [opties] boek_id

Update de metadata in het eigenlĳke boek file opgeslagen in calibre bibliotheek vanuit de metadata in de calibre data-
base. Normaal worden metadata enkel geüpdatet wanneer files uit calibre worden geëxporteerd, dit commando is nuttig
indien u wilt dat de bestanden worden geüpdatet ter plaatse. Opgelet dat verschillende formaten verschillende hoeveel-
heden metadata ondersteunen. U kan de speciale waarde “all” gebruiken in plaats van boek_id om de metadata van alle
boeken aan te passen. U kan ook verschillende boek id’s meegeven gescheiden door spaties en id reeksen gescheiden door
koppeltekens. Bĳvoorbeeld: calibredb ingevoegde_metadata 1 2 10-15 23
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--only-formats, -f

Update alleen de metadata in specifieke bestands types. Gebruik dit meerdere keren om verschillende formaten
aan te passen. Standaard worden alle formaten aangepast.

search

calibredb search [opties] zoekexpressie

Doorzoek de bibliotheek voor de specifieke zoekterm, geeft een komma gescheiden lĳst van boek IDs terug overeenko-
mend met de zoekuitdrukking. Het uitvoerformaat is nuttig om andere commando’s uit te voeren die een lĳst van IDs
aanvaarden als invoer
De zoekexpressie kan eerder wat zĳn uit calibre’s krachtige zoek querytaal bĳvoorbeeld: %p rog search author:asimov
‘title:”i robot”’
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--limit, -l

Het maximum aantal weer te geven resultaten. Standaard is alle resultaten.

fts_index

calibredb fts_index [options] enable/disable/status/reindex

Controleer het Volledige tekst doorzoeken indexeren proces.
enable

Schakelt FTS indexeren in voor deze bibliotheek
disable

Schakelt FTS indexeren uit voor deze bibliotheek
status

Toont de huidige indexeringsstatus
reindex

Kan gebruikt worden om bepaalde boeken te re-indexeren of de hele bibliotheek. Om bepaalde boeken te re-
indexeren specificeer de boek IDs als extra argumenten na de reindex opdracht. Als geen boek IDs gespecificeerd
werden, wordt de hele bibliotheek geherindexeerd.

Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
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--indexing-speed

Indexeersnelheid. Gebruik snel voor snel indexeren met alle kracht van uw pc en traag voor minder intensief in-
dexeren. Merk op dat de snelheid terug op traag wordt gezet na elk gebruik.

--wait-for-completion

Wacht tot alle boeken geïndexeerd zĳn, indexeringsvoortgang wordt regelmatig getoond

fts_search

calibredb fts_search [options] zoekexpressie

Doe een volledige tekstopzoeking op de gehele bibliotheek of een onderdeel ervan.
Als u aan calibredb parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”
--do-not-match-on-related-words

Match alleen op exacte woorden, niet op verwante woorden. Correctie komt dus niet overeen met corrigeren.
--include-snippets

Voeg fragmenten toe van de tekst rond elke overeenkomst. Merk op dat dit het zoeken veel langzamer maakt.
--indexing-threshold

Hoeveel procent van de bibliotheek moet worden geïndexeerd voordat zoeken is toegestaan. Standaard ingesteld op
90

--match-end-marker

De markering die wordt gebruikt om het einde van een overeenkomend woord in een fragment aan te geven
--match-start-marker

De markering die wordt gebruikt om het begin van een overeenkomend woord in een fragment aan te geven
--output-format

De indeling waarin de zoekresultaten moeten worden uitgevoerd. Ofwel 'tekst' voor platte tekst of 'json' voor
JSON-uitvoer.

--restrict-to

Beperk de doorzochte boeken, ofwel met een zoekexpressie ofwel met IDs. Bĳvoorbeeld: IDs: 1,2,3 om te beperken
op ID of search:tag:foo om te beperken tot boeken met label foo.

13.1.7 ebook-convert

ebook-convert input_file output_file [opties]

Converteer een e-boek van het ene naar het andere formaat.
input_file is de invoer en output_file is de uitvoer. Beiden moeten gespecificeerd worden als de eerste twee argumenten
bĳ het commando.
Het e-boek uitvoerformaat wordt geraden van de extensie van output_file. output_file kan ook van het speciale .EXT
formaat zĳn, waar EXT de uitvoerbestandextensie is. In dit geval wordt de naam van het invoerbestand die van het uit-
voerbestand. Merk op dat de bestandsnaam niet mag beginnen met een koppelteken. Als, tot slot, output_file geen extensie
heeft, wordt het gezien als een map en wordt een “open e-boek” (OEB) bestaande uit HTML bestanden geschreven in die
map. Deze bestanden zĳn dezelfde die normaal gezien naar de uitvoer plug-in zouden zĳn gepasseerd.
Na specificatie van het invoer- en uitvoerbestand kan u de conversie aanpassen door een aantal opties te kiezen. De
beschikbare opties hangen af van het type invoer- en uitvoerbestanden. Voor hulp specificeer het invoer- en uitvoerbestand
en gebruik dan de -h optie.
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Voor de volledige documentatie van het conversiesysteem zie E-boek conversie (pagina 61)
Als u aan ebook-convert parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.:
“/some path/with spaces”
De opties en standaard waarden voor de opties veranderen met de de input en output waarden. U moet dus altĳd controleren
bĳ:
ebook-convert myfile.input_format myfile.output_format -h
Hier onder staan de opties die gleden voor alle conversies, gevolgd door de opties die specifiek zĳn voor elk input en
output formaat.

• INVOEROPTIES (pagina 329)
• UITVOEROPTIES (pagina 329)
• LOOK AND FEEL (pagina 330)
• HEURISTISCHE VERWERKING (pagina 332)
• ZOEK EN VERVANG (pagina 333)
• STRUCTUUR DETECTIE (pagina 334)
• INHOUDSOPGAVE (pagina 334)
• METAGEGEVENS (pagina 335)
• FOUTOPSPORING (pagina 336)

--help, -h

toon dit helpbericht en stop
--input-profile

Specificeer het invoerprofiel. Het invoerprofiel geeft het conversiesysteem informatie over hoe de informatie in
het invoerdocument geïnterpreteerd moet worden. Bĳvoorbeeld resolutie-afhankelĳke lengtes (lengte in pixels).
Mogelĳkheden zĳn: cybookg3, cybook_opus, default, hanlinv3, hanlinv5, illiad, irexdr1000, irexdr800, kindle,
msreader, mobipocket, nook, sony, sony300, sony900

--list-recipes

Namen van ingebouwde recepten weergeven. U kunt de volgende opdracht gebruiken om met behulp van een recept
een e-boek te maken: eboek-converteer "Receptnaam.recipe" uitvoer.epub

--output-profile

Specificeer het uitvoerprofiel. Het uitvoerprofiel bepaalt hoe het conversiesysteem het aangemaakte document
optimaliseert voor het aangegeven apparaat. In sommige gevallen kan een uitvoerprofiel worden gebruikt voor
een bepaald apparaat, maar dat is zelden nodig. Keuzes zĳn:cybookg3, cybook_opus, default, generic_eink, ge-
neric_eink_large, generic_eink_hd, hanlinv3, hanlinv5, illiad, ipad, ipad3, irexdr1000, irexdr800, jetbook5, kind-
le, kindle_dx, kindle_fire, kindle_oasis, kindle_pw, kindle_pw3, kindle_scribe, kindle_voyage, kobo, msreader,
mobipocket, nook, nook_color, nook_hd_plus, pocketbook_inkpad3, pocketbook_lux, pocketbook_hd, pocket-
book_900, pocketbook_pro_912, galaxy, sony, sony300, sony900, sony-landscape, sonyt3, tablet

--version

toon programmaversie en stop
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INVOEROPTIES
Opties om de bewerking van invoerbestand mobi aan te passen
--input-encoding

Specificeer de tekencodering van het invoerbestand. Als deze optie ingesteld is, zal de codering die het document
zelf bevat genegeerd worden. Vooral nuttig voor documenten die geen codering ingesteld hebben, of die een foutieve
tekencodering aangeven.

UITVOEROPTIES
Opties om de bewerking van uitvoerbestand epub aan te passen
--dont-split-on-page-breaks

Schakel splitsen bĳ pagina-eindes uit. Normaal worden de invoerbestanden automatisch bĳ elk pagina-einde opge-
splitst in twee bestanden. Hierdoor krĳg je een uitvoer e-boek dat sneller en met minder middelen kan verwerkt
worden. Splitsen is echter traag, en als uw bronbestand een groot aantal pagina-eindes bevat, moet u splitsen op
pagina-eindes uitschakelen.

--epub-flatten

Deze optie is alleen nodig als u de EPUB op een FBReaderJ wilt gebruiken. Het verwĳdert alle deelmappen binnen
de EPUB, en zet alle bestanden op het hoogste niveau.

--epub-inline-toc

Voeg een in-line Inhoudsopgave in, die in het boek komt als deel van de inhoud.
--epub-max-image-size

De maximale afbeeldingsgrootte (breedte x hoogte). Een waarde van none betekent dat u de schermgrootte uit het
uitvoerprofiel gebruikt. Een waarde van profile betekent dat er geen maximale grootte is opgegeven. Een waarde
van 100x200 zorgt er bĳvoorbeeld voor dat het formaat van alle afbeeldingen wordt aangepast, zodat hun breedte
niet meer is dan 100 pixels en hun hoogte niet meer dan 200 pixels. Houd er rekening mee dat dit alleen de grootte
van de daadwerkelĳke afbeeldingsbestanden zelf beïnvloedt. Elke afbeelding kan in een ander formaat worden
weergegeven, afhankelĳk van de stĳl die erop wordt toegepast in het document.  

--epub-toc-at-end

Zet de ingevoegde in-line Inhoudsopgave aan het eind van het boek in plaats van aan het begin.
--epub-version

De versie van het EPUB-bestand dat moet worden gegenereerd. EPUB 2 is het meest compatibel, gebruik alleen
EPUB 3 als u weet dat u het echt nodig hebt.

--extract-to

Extract the contents of the generated book to the specified folder. The contents of the folder are first deleted, so
be careful.

--flow-size

Splits alle HTML-bestanden die groter zĳn dan deze grootte (in kB). Dit is nodig omdat de meeste EPUB-lezers
geen grote bestanden kunnen hanteren. De standaard van 260KB is de grootte vereist voor Adobe Digital Editions.
Ingesteld op 0 schakelt de opsplitsing uit.

--no-default-epub-cover

Als het invoerbestand geen omslag bevat en er niet expliciet een is opgegeven zal een standaardomslag worden
aangemaakt met daarop de titel, auteurs, enz. Deze optie schakelt dit uit.

--no-svg-cover

Gebruik geen SVG voor de omslag van het boek. Gebruik deze optie als uw EPUB gebruikt gaat worden op een
toestel dat SVG niet ondersteunt, zoals de iPhone of de JetBook Lite. Zonder deze optie zullen deze toestellen de
omslag van het boek als een lege pagina laten zien.
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--preserve-cover-aspect-ratio

Bĳ gebruik van een SVG-omslag zal deze optie ervoor zorgen dat de omslag het hele scherm vult, maar toch de
breedte/hoogteverhouding zal behouden. Dit betekent dat er sprake kan zĳn van omslagen met witte randen aan de
zĳkanten of de boven- en onderkant van het beeld, maar de afbeelding zal nooit vervormd worden. Zonder deze
optie kan de afbeelding enigszins vervormd worden, maar zullen er geen witte randen zĳn.

--pretty-print

Indien opgegeven, zal de uitvoerplug-in proberen om uitvoer te genereren die zo leesbaar mogelĳk is. Het kan zĳn
dat dit op sommige uitvoerplug-ins geen enkel effect heeft.

--toc-title

Titel voor elke gegenereerde inline inhoudsopgave.

LOOK AND FEEL
Opties om uiterlĳk van de uitvoer aan te passen
--asciiize

Zet unicode karakters om naar ASCII tekens. Voorzichtig gebruiken want dit zal unicode karakters vervangen door
ASCII. Bĳvoorbeeld: "Pelé" wordt vervangen door "Pele". Merk ook op dat als er meerdere weergaven van een
teken zĳn (zoals bĳ gedeelde tekens uit Chinees en Japans), de weergave gekozen wordt op basis van de huidige
taalinstellingen voor calibre.

--base-font-size

De basistekstgrootte in pt's. Alle lettergroottes in het geproduceerde boek worden opnieuw geschaald op basis van
deze grootte. Door een groter formaat te kiezen, kunt u de lettertypen in de uitvoer groter maken en omgekeerd. Als
de waarde nul is, wordt de basislettergrootte standaard gekozen op basis van het uitvoerprofiel dat u hebt gekozen.

--change-justification

Wĳzig tekst uitvulling. De waarde ‘links uitlĳnen’ verandert alle uitgelĳnde tekst in de bron naar links uitgelĳnde
tekst (m.a.w. niet uitgevuld). De waarde ‘tekst uitvullen’ verandert alle niet uitgevulde tekst naar uitgevuld. De
waarde ‘origineel’ (de standaardwaarde) verandert de uitvulling in het bronbestand niet. Merk op dat maar een
beperkt aantal uitvoerformaten uitvullen ondersteunen.

--disable-font-rescaling

Geen herschaling van lettergrootte.
--embed-all-fonts

Alle lettertypes invoegen waaraan in het input-document wordt gerefereerd maar nog niet ingevoegd. Dit zal uw
systeem doorzoeken naar de lettertypes, en indien gevonden, zullen ze ingevoegd worden. Invoegen zal alleen werken
als het formaat waarnaar u converteert ingebouwde fonts ondersteunt, zoals EPUB, AZW3, DOCX of PDF. Let
aub op dat u de nodige licentie bezit om de in dit document gebruikte lettertypes in te voegen.

--embed-font-family

Het gespecificeerde lettertype inbedden in het boek. Dit specificeert het "basis" lettertype voor het boek. Als het
invoer document eigen lettertypes specificeert, kunnen deze het basis lettertype negeren. U kunt de filter stĳlin-
formatie optie gebruiken om lettertypes uit het invoer document te verwĳderen. Merk op: inbedden van lettertypes
werkt alleen met bepaalde uitvoer indelingen, voornamelĳk EPUB, AZW3 en DOCX.

--expand-css

Standaard gebruikt calibre het verkorte formaat voor verschillende CSS-eigenschappen zoals marges, padding, rand,
enz. Deze optie zorgt ervoor dat het in plaats daarvan het volledige formaat gebruikt. Merk op dat CSS altĳd wordt
uitgebreid bĳ genereren van EPUB bestanden met als uitvoerprofiel een van de Nook profielen daar de Nook geen
verkorte CSS kan verwerken.
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--extra-css

Het pad naar een CSS stĳlblad of rauwe CSS. Deze CSS wordt toegevoegd aan de stĳlregels van het bronbestand,
zodat het deze regels kan negeren.

--filter-css

Een door komma's gescheiden lĳst van CSS-eigenschappen die zullen worden verwĳderd uit alle CSS-stĳlregels.
Dit is handig als de aanwezigheid van enkele stĳl informatie voorkomt dat het wordt overschreven op uw toestel.
Bĳvoorbeeld: font-family, kleur, margin-left, margin-right

--font-size-mapping

Omzetten van CSS-lettertypenamen naar lettergroottes in pts. Een voorbeeld van instelling is
12,12,14,16,18,20,22,24. Dit zĳn de omzettingen voor de groottes xx-small tot xx-large, met de laatste
grootte voor enorme letters. Het algoritme voor lettertypeherschaling gebruikt deze lettergroottes om de letters
intelligent aan te passen. Standaard worden de instellingen van het gekozen uitvoerprofiel gebruikt.

--insert-blank-line

Voeg een lege regel toe tussen alinea's. Dit werkt niet als het bronbestand geen alinea's gebruikt (<p>- of <div>-
labels).

--insert-blank-line-size

Stel de hoogte van de ingevoegde blanco regels in (in em). De hoogte van de regels tussen paragrafen is het dubbele
van wat u hier insteld.

--keep-ligatures

Preserve ligatures present in the input document. A ligature is a combined character of a pair of characters like ff,
fi, fl et cetera. Most readers do not have support for ligatures in their default fonts, so they are unlikely to render
correctly. By default, calibre will turn a ligature into the corresponding pair of normal characters. Note that ligatures
here mean only unicode ligatures not ligatures created via CSS or font styles. This option will preserve them instead.

--line-height

De lĳnhoogte in pts. Regelt de vrĳe ruimte tussen opeenvolgende tekstregels. Geldt alleen voor elementen die hun
eigen lĳnhoogte niet bepalen. Meestal is het opgeven van de minimale lĳnhoogte nuttiger. Standaard wordt de
lĳnhoogte niet aangepast.

--linearize-tables

Sommige slecht ontworpen documenten gebruiken tabellen om de opmaak van tekst op de pagina te beïnvloeden.
Wanneer deze documenten geconverteerd worden hebben ze vaak vreemde fouten, zoals tekst die langer is dan de
pagina. Deze optie zal de inhoud uit de tabellen halen en deze achter elkaar weergeven.

--margin-bottom

Zet de ondermarge in punten. Standaard is 5.0. Bĳ een negatieve waarde wordt er geen marge ingesteld (de marge-
instelling in het originele document blĳft behouden). Opmerking: pagina-georiënteerde indelingen zoals PDF en
DOCX hebben hun eigen marge-instellingen die voorrang hebben.

--margin-left

Zet de linkermarge in punten. Standaard is 5.0. Bĳ een negatieve waarde wordt er geen marge ingesteld (de marge-
instelling in het originele document blĳft behouden). Opmerking: pagina-georiënteerde indelingen zoals PDF en
DOCX hebben hun eigen marge-instellingen die voorrang hebben.

--margin-right

Zet de rechtermarge in punten. Standaard is 5.0. Bĳ een negatieve waarde wordt er geen marge ingesteld (de marge-
instelling in het originele document blĳft behouden). Opmerking: pagina-georiënteerde indelingen zoals PDF en
DOCX hebben hun eigen marge-instellingen die voorrang hebben.
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--margin-top

Zet de bovenmarge in punten. Standaard is 5.0. Bĳ een negatieve waarde wordt er geen marge ingesteld (de marge-
instelling in het originele document blĳft behouden). Opmerking: pagina-georiënteerde indelingen zoals PDF en
DOCX hebben hun eigen marge-instellingen die voorrang hebben.

--minimum-line-height

De minimale hoogte van een regel, als percentage van de berekende lettergrootte van het element. calibre zorgt
ervoor dat ieder element een regelhoogte heeft van op zĳn minst deze instelling, onafhankelĳk van wat het inge-
voerde document specificeert. Zet op nul om te negeren. De standaardwaarde is 120%. Gebruik deze instelling
liever dan de rechtstreekse regelhoogte-instelling, tenzĳ u weet wat u doet. Om bĳvoorbeeld dubbele regelafstand
te verkrĳgen zet u deze instelling op 240.

--remove-paragraph-spacing

Verwĳder witregels tussen alinea's. Stelt ook inspringen met 1.5em in voor alinea's. Witregels verwĳderen werkt
niet als het invoerbestand geen alinea's gebruikt (<p>- of <div>-labels).

--remove-paragraph-spacing-indent-size

Als calibre lege regels tussen paragrafen verwĳderd, zal automatisch een paragraaf insprong worden toegevoegd
om de paragraaf makkelĳk te kunnen onderscheiden. Deze optie stelt de breedte van die insprong (in em) in. Als
y deze waarde negatief instelt, zal de insprong-waarde gebruikt worden die is opgegeven in het bestand. Oftewel,
calibre zal de insprong niet aanpassen.

--smarten-punctuation

Zet gewone aanhalingstekens, streepjes en beletseltekens om in hun typografisch juiste equivalenten. Voor details:
https://daringfireball.net/projects/smartypants.

--subset-embedded-fonts

Uitdunnen van alle ingebedde lettertypes. Elk ingebed lettertype is beperkt tot de tekens gebruikt in dit document.
Dit beperkt de omvang van de lettertype bestanden. Bruikbaar wanneer u een zeer uitgebreid lettertype wilt insluiten
met veel ongebruikte tekens.

--transform-css-rules

Pad naar een bestand met regels om de CSS-stĳlen in dit boek te transformeren. De eenvoudigste manier om een
dergelĳk bestand te maken is om de wizard te gebruiken voor het maken van regels in de GUI van calibre. Open het
in de "Uitstraling & gevoel-> Transformeer stĳlen" onderdeel van het conversie dialoogvenster. Nadat u de regels
hebt gemaakt, kunt u de knop "Exporteren" gebruiken om ze in een bestand op te slaan.

--transform-html-rules

Pad naar een bestand met regels om de HTML in dit boek te transformeren. De eenvoudigste manier om een zo'n
bestand te maken is de calibre GUI wizard te gebruiken voor het maken van regels. Open het in de "Uitstraling
& gevoel-> Transformeer HTML" onderdeel van de conversiedialoog. Na maken van de regels, kunt u de knop
"Exporteren" gebruiken om ze in een bestand op te slaan.

--unsmarten-punctuation

Vervang mooie aanhalingstekens, punten en afbrekingstekens met de 'platte tekst' equivalenten.

HEURISTISCHE VERWERKING
Bewerk de tekst van het document en de struktuur, gebruikmakend van algemene patronen. Standaard uitgeschakeld.
Gebruik –enable-heuristics om in te schakelen. Individuele taken kunnen worden uitgeschakeld met de –disable-* opties.

--disable-dehyphenate

Analyseer de afgebroken woorden. Het document zelf dient als woordenboek om te bepalen of het afbreekteken
als liggend streepje moet worden behouden.

332 Hoofdstuk 13. Opdrachtpromt

https://daringfireball.net/projects/smartypants


calibre Gebruikershandleiding, Release 8.7.0

--disable-delete-blank-paragraphs

Verwĳder lege alinea's als ze elke tweede alinea voorkomen
--disable-fix-indents

Maak van indentatie aangeduid door niet-afbrekende spaties CSS-indentatie.
--disable-format-scene-breaks

Links uitgelĳnde breekpuntmarkeringen worden gecentreerd. Vervang opeenvolgende lege regels door horizontale
lĳnen.

--disable-italicize-common-cases

Zoek naar veelgebruikte woorden en patronen die duiden op cursief en maak deze cursief.
--disable-markup-chapter-headings

Detecteer onopgemaakte hoofdstuk (sub)koppen en verander deze in h2 en h3 tags. Deze instelling creëert geen
Inhoudsopgave maar kan samen met structuurdetectie gebruikt worden om er een te maken.

--disable-renumber-headings

Zoek naar opeenvolgende <h1>- of <h2>-labels. Deze worden hernummerd om te voorkomen dat hoofdstuktitels
opgedeeld worden.

--disable-unwrap-lines

Verwĳder harde regeleinden op basis van interpunctie en andere opmaak hints.
--enable-heuristics

Heuristische verwerking inschakelen. Zonder deze optie wordt geen enkele heuristische verwerking uitgevoerd.
--html-unwrap-factor

Schaal om te bepalen vanaf welke lengte harde regeleinden moeten worden verwĳderd. Geldige waarde is een
decimaal getal tussen 0 en 1. De standaardwaarde is 0.4, iets minder dan de mediaan van de regellengte. Als maar
bĳ weinig regels de harde regeleinden hoeven worden verwĳderd, kunt u beter een lagere waarde kiezen

--replace-scene-breaks

Vervang breekpunten door de aangegeven tekst. Standaard wordt de tekst uit het invoerbestand gebruikt.

ZOEK EN VERVANG
Wĳzig de tekst en structuur van het document m.b.v. gebruiker-gedefinieerde patronen.
--search-replace

Pad naar een bestand dat zoek en vervang reguliere expressies bevat. Het bestand moet afwisselende regels bevatten
van reguliere expressies gevolgd door vervangingspatronen (die een lege regel kan zĳn). De reguliere expressie moet
in de Python regex schrĳfwĳze zĳn en het bestand moet in de UTF-8 codering zĳn.

--sr1-replace

Vervanging voor vervangen van tekst gevonden met sr1-zoeken.
--sr1-search

Zoekpatroon (regexp) dat vervangen moet worden door sr1.
--sr2-replace

Vervanging voor vervangen van tekst gevonden met sr2-zoeken.
--sr2-search

Zoekpatroon (regexp) dat vervangen moet worden door sr2.
--sr3-replace

Vervanging voor vervangen van tekst gevonden met sr3-zoeken.
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--sr3-search

Zoekpatroon (regexp) dat vervangen moet worden door sr3.

STRUCTUUR DETECTIE
Stel de auto-detectie van de documentstructuur in.
--add-alt-text-to-img

When an <img> tag has no alt attribute, check the associated image file for metadata that specifies alternate text,
and use it to fill in the alt attribute. The alt attribute improves accessibility by providing text descriptions for users
who cannot see or fully interpret visual content.

--chapter

Een XPath-expressie om hoofdstuktitels te detecteren. De standaard is om <h1> of <h2> labels die de woorden
"chapter", "book", "section", "prologue", "epilogue" or "part" bevatten als hoofdstuktitels te overwegen, even-
als labels met class = "chapter". De gebruikte uitdrukking moet resulteren in een lĳst met elementen. Gebruik de
uitdrukking "/" om hoofdstukdetectie uit te schakelen. Raadpleeg de XPath zelfstudie in de calibre Gebruikers-
handleiding voor meer hulp bĳ het gebruik van deze functie.

--chapter-mark

Specificeer hoe gedetecteerde hoofdstukken moeten worden gemarkeerd. Een waarde "pagebreak" zal een nieuwe
pagina beginnen voor nieuwe hoofdstukken. Een waarde "rule" zal een streep toevoegen voor hoofdstukken. Een
waarde "none" zal hoofdstukmarkering uitschakelen, en een waarde "both" zal zowel nieuwe pagina's als strepen
gebruiken om hoofdstukken te markeren.

--disable-remove-fake-margins

In sommige documenten worden voor elke alinea apart linker- en rechtermarges opgegeven. calibre tracht deze te
verwĳderen, maar soms worden daardoor marges verwĳderd die niet weg mogen. In dat geval kan margeverwĳde-
ring uitgeschakeld worden.

--insert-metadata

Voeg de boek-metadata in aan het begin van het boek. Dit is nuttig als uw e-boeklezer de directie manier van
tonen/zoeken van metadata niet ondersteunt.

--page-breaks-before

Een XPath uitdrukking. Pagina splitsing wordt toegevoegd voor de aangegeven elementen. Om uit te schakelen
gebruikt u de uitdrukking: /

--prefer-metadata-cover

Gebruik de in het bronbestand gedetecteerde omslag en niet de opgegeven omslag.
--remove-first-image

Verwĳder de eerste afbeelding van het oorspronkelĳke e-boek. Nuttig als het brondocument een omslagafbeelding
heeft die niet wordt herkend als omslag. In dat geval als u een omslag heeft ingesteld in calibre zal het e-boek twee
omslagfoto's laten zien als u deze optie niet instelt.

--start-reading-at

Een XPath-expressie om de locatie in het document te detecteren waar te beginnen met lezen. Sommige e-boek
leesprogramma's (vooral de Kindle) gebruiken deze locatie als de positie om het boek te openen. Raadpleeg de
XPath-zelfstudie in de calibre gebruikershandleiding voor meer hulp bĳ het gebruik van deze functie.

INHOUDSOPGAVE
Configureer het automatisch aanmaken van de Inhoudsopgave. Standaard zal, indien aanwezig, de Inhoudsopgave van het
invoerbestand gebruikt worden, in plaats van de automatisch aangemaakte Inhoudsopgave.
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--duplicate-links-in-toc

Laat dubbele invoer toe bĳ creëren van een Inhoudsopgave vanuit links in het invoerdocument, d.w.z. laat meer
dan één invoer toe met dezelfde tekst indien ze verwĳzen naar een verschillende locatie.

--level1-toc

XPath expressie die alle aan de Inhoudsopgave op niveau een toe te voegen tags specificeert. Deze optie gaat boven
andere vormen van auto-detectie. Bekĳk de XPath handleiding in de calibre handleiding voor voorbeelden .

--level2-toc

XPath expressie die alle aan de Inhoudsopgave op niveau twee toe te voegen tags specificeert.. Elke vermelding komt
onder de vorige niveau een vermelding. Bekĳk de XPath handleiding in de calibre handleiding voor voorbeelden .

--level3-toc

XPath expressie die alle aan de Inhoudsopgave op niveau drie toe te voegen tags specificeert.. Elke vermelding komt
onder de vorige niveau twee vermelding. Bekĳk de XPath handleiding in de calibre handleiding voor voorbeelden .

--max-toc-links

Maximaal aantal links dat aan de Inhoudsopgave toegevoegd mag worden. Gebruik 0 om uit te schakelen. Stan-
daard is: 50. Links worden alleen aan de inhoudsopgave toegevoegd als minder dan dit aantal hoofdstukken werd
gedetecteerd.

--no-chapters-in-toc

Voeg geen automatisch gedetecteerde hoofdstukken aan de Inhoudsopgave toe.
--toc-filter

Verwĳder vermeldingen uit de Inhoudsopgave wiens titels overeenkomen met de opgegeven reguliere expressie.
Overeenkomende vermeldingen en kinderen worden verwĳderd.

--toc-threshold

Als het aantal gedetecteerde hoofdstukken kleiner is dan dit getal worden links aan de Inhoudsopgave toegevoegd.
Standaard: 6

--use-auto-toc

Indien aanwezig, wordt normaal de Inhoudsopgave van het bronbestand gebruikt i.p.v. een automatisch gegene-
reerde. Met deze optie zal altĳd de automatisch gegenereerde versie gebruikt worden.

METAGEGEVENS
Opties om metagegevens voor de uitvoer in te stellen
--author-sort

De string die gebruikt wordt bĳ het sorteren op auteur.
--authors

Geef de auteurs op. Meerdere auteurs moeten met een ampersand (&) van elkaar gescheiden worden.
--book-producer

Geef de producent op.
--comments

Stel de e-boek omschrĳving in.
--cover

Stel de omslag in met het opgegeven bestand of URL
--isbn

Geef het ISBN van het boek op.
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--language

De taal instellen.
--pubdate

Stel de publicatiedatum in (veronderstellend de locale tĳdzone, behalve als de tĳdzone expliciet is gespecificeerd)
--publisher

Stel de e-boek uitgever in.
--rating

Waardering geven. Moet een getal tussen de 1 en 5 zĳn.
--read-metadata-from-opf, --from-opf, -m

Lees metadata uit het opgegeven OPF bestand. Metadata die hieruit worden gelezen negeren metadata in het bron-
bestand.

--series

Stel de serie in waartoe dit e-boek behoort.
--series-index

Geef de index van dit boek in de serie op.
--tags

Geef de labels voor het boek op. Dit moet een door komma's gescheiden lĳst zĳn.
--timestamp

Maak tĳdstempel voor boek (wordt nergens meer gebruikt)
--title

Geef de titel op.
--title-sort

De versie van de titel die wordt gebruikt bĳ het sorteren.

FOUTOPSPORING
Opties om te helpen bĳ het vinden van fouten bĳ de conversie
--debug-pipeline, -d

Sla de uitvoer van verschillende stadia van de conversielĳn op in de opgegeven map. Nuttig als u niet zeker weet
tĳdens welke stap in het conversieproces een fout optreedt.

--verbose, -v

Niveau van detail informatie uitvoer. Specifieer meerdere malen voor meer details. Indien het twee maal wordt
meegegeven zal er een volledig detail gegeven worden, eenmaal medium details, en geen enkele keer de minimale
details.

13.1.8 ebook-edit

ebook-edit [opts] [path_to_ebook] [name_of_file_inside_book ...]

Lanceert het calibre boek Bewerken gereedschap. Optioneel kan u ook de namen van bestanden in het boek specificeren
die automatisch geopend worden voor bewerken.
Als u aan ebook-edit parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”

336 Hoofdstuk 13. Opdrachtpromt



calibre Gebruikershandleiding, Release 8.7.0

[Opties]
--detach

Loskoppelen van de controleterminal, indien aanwezig (alleen Linux)
--help, -h

toon dit helpbericht en stop
--select-text

De tekst om te selecteren in het boek wanneer het geopend is voor bewerking
--version

toon programmaversie en stop

13.1.9 ebook-meta

ebook-meta ebook_file [opties]

Lezen/schrĳven metadata van/naar e-boekbestanden.
Ondersteunende formaten om metadata te lezen: azw, azw1, azw3, azw4, cb7, cbc, cbr, cbz, chm, docx, epub, fb2, fbz,
html, htmlz, imp, kepub, lit, lrf, lrx, mobi, odt, oebzip, opf, pdb, pdf, pml, pmlz, pobi, prc, rar, rb, rtf, snb, tpz, txt, txtz,
updb, zip
Ondersteunende formaten om metadata te schrĳven: azw, azw1, azw3, azw4, docx, epub, fb2, fbz, htmlz, kepub, lrf,
mobi, odt, pdb, pdf, prc, rtf, tpz, txtz
Verscheidene bestandtypes ondersteunen verscheidene soorten metadata. Indien u probeert sommige metadata in een
niet-ondersteunde bestandstype op te slaan worden die metadata gewoon genegeerd.
Als u aan ebook-meta parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”

[Opties]
--author-sort

Tekst die wordt gebruikt bĳ het sorteren op auteur. Als deze leeg is, en de auteur(s) zĳn opgegeven, dan zal deze
automatisch aan de hand van de auteur(s) aangemaakt worden.

--authors, -a

Geef de auteurs op. Meerdere auteurs moeten door het &-teken gescheiden worden. Auteursnamen moeten in de
volgorde Voornaam Achternaam zĳn.

--book-producer, -k

Geef de producent op.
--category

Geef de boekcategorie op.
--comments, -c

Stel de e-boek omschrĳving in.
--cover

Gebruik het opgegeven bestand voor de omslag.
--date, -d

Geef de publicatiedatum op.
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--disallow-rendered-cover

For formats like EPUB that use a "default cover" of the first page rendered, disallow such default covers
--from-opf

Lees metadata uit het opgegeven OPF bestand en gebruik deze om metadata in het e-boek in te stellen. Metadata
die op de opdrachtregel opgegeven worden negeren metadata uit het OPF bestand

--get-cover

Haal de omslag van het e-boek en sla dit op als het gespecificeerde bestand.
--help, -h

toon dit helpbericht en stop
--identifier

Stel de ID's voor het boek in, kan meerdere keren worden opgegeven. Bĳvoorbeeld: --identificeer uri
https://acme.com --identificeer isbn: 12345 Als u een ID wilt verwĳderen, geeft u geen waarde op.
--Identificeer isbn: Houd er rekening mee dat voor EPUB-bestanden een ID die is gemarkeerd als de pakket-
id niet kan worden verwĳderd.

--index, -i

Geef de index van dit boek in de serie op.
--isbn

Geef het ISBN van het boek op.
--language, -l

De taal instellen.
--lrf-bookid

Stel het BoekID in, in LRF-bestanden
--publisher, -p

Stel de e-boek uitgever in.
--rating, -r

Waardering geven. Moet een getal tussen de 1 en 5 zĳn.
--series, -s

Stel de serie in waartoe dit e-boek behoort.
--tags

Geef de labels voor het boek op. Dit moet een door komma's gescheiden lĳst zĳn.
--title, -t

Geef de titel op.
--title-sort

De versie van de titel die wordt gebruikt bĳ het sorteren. Als deze leeg is en de titel is opgegeven, dan zal deze
automatisch aan de hand van de titel aangemaakt worden.

--to-opf

Geef de naam van een OPF-bestand op. De metadata zullen in het OPF-bestand worden opgeslagen.
--version

toon programmaversie en stop
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13.1.10 ebook-polish

ebook-polish [opties] invoer_bestand [uitvoer_bestand]

Boeken oppoetsen gaat over alles wat de indruk van perfectie aan je zorgvuldig samengestelde E-boeken geeft.
Oppoetsen tracht zo min mogelĳk de interne code van u E-boek te veranderen. Anders dan bĳ converteren vereenvoudigt
het geen CSS, hernoemt het geen bestanden, verandert niet de lettertype grootte, aanpassen van marges, enz. Elke actie
veroorzaakt slechts de minimaal benodigde veranderingen om het beoogde effect te bereiken.
Je dient dit als laatste stap in u E-boek creatieproces te gebruiken.
Merk op dat oppoetsen alleen werkt bĳ bestanden in het AZW3 of EPUB of KEPUB formaat.
Als u aan ebook-polish parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.:
“/some path/with spaces”

[Opties]
--add-soft-hyphens, -H

Voeg zachte koppeltekens toe aan alle woorden in het boek. Hiermee kan het boek worden weergegeven beter
wanneer de tekst gerechtvaardigd is, in lezers die geen woordafbreking ondersteunen

--compress-images, -i

Comprimeer de afbeeldingen in het boek, zonder de kwaliteit aan te tasten..
--cover, -c

Pad naar omslag afbeelding. Wĳzigt de omslag gespecificeerd in het E-boek. Als geen omslag beschikbaar is, of
de omslag is niet goed herkend, dan wordt een nieuwe omslag toegevoegd.

--download-external-resources, -d

Download external resources such as images, stylesheets, etc. that point to URLs instead of files in the book.
All such resources will be downloaded and added to the book so that the book no longer references any external
resources.

--embed-fonts, -e

Alle lettertypes insluiten waaraan gerefereerd wordt in het document en die nog niet zĳn ingesloten in. Hierbĳ wordt
uw computer doorzocht op lettertypes en indien gevonden zullen zĳ worden ingesloten in het document. Verzeker
u ervan dat u over de juist licentie beschikt voor het insluiten van de in dit document gebruikte lettertypes.

--help, -h

toon dit helpbericht en stop
--jacket, -j

Voegt een "Boekomslag" pagina in aan het begin van het boek, die alle metadata van het boek bevat, zoals titel,
labels, auteurs, series, commentaren enz. Elke vorig gebruikte boekomslag zal worden vervangen.

--opf, -o

Pad naar een OPF bestand. De metadata in het boek is bĳgewerkt vanuit het OPF bestand.
--remove-jacket

Verwĳder een eerder ingevoegde overzichtspagina.
--remove-soft-hyphens

Verwĳder zachte koppeltekens uit alle tekst in het boek
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--remove-unused-css, -u

Verwĳder alle ongebruikte CSS regels van stĳlbladen en <stĳl> tags. Boeken gemaakt op basis van productiesja-
blonen kunnen een groot aantal extra CSS-regels hebben die niet slaan op enige feitelĳke inhoud. Deze extra regels
kunnen e-readers vertragen die ze allemaal moeten verwerken.

--smarten-punctuation, -p

Zet platte tekst streepjes, weglatingstekens, aanhalingstekens, meerdere afbreekstreepjes, enz. om naar de typogra-
fisch juiste equivalenten. NB, het algoritme kan soms foute resultaten geven, met name als enkele aanhalingstekens
worden gebruikt bĳ de start van samenstelling.

--subset-fonts, -f

Uitdunnen van lettertypen betekend het reduceren van ingesloten lettertypes zodat ze enkel de tekens bevatten welke
worden gebruikt in het boek. Dit zorgt voor een grote reductie van de lettertype bestanden (een halvering van de
lettertypebestanden is normaal). Bĳvoorbeeld, als het boek een specifiek lettertype gebruikt voor koppen, dan zal
uitdunnen het lettertype reduceren tot enkel de tekens weergegeven in de koppen van het boek. Of als het boek
vette en scheve versies van het lettertype heeft ingevoegd, maar vet en scheef niet of weinig wordt gebruikt, dan
kunnen deze worden gereduceerd tot een paar tekens of zelfs helemaal worden verwĳderd Het enige nadeel van
uitdunnen van een lettertype is dat u, wanneer u op een later moment besluit tekst toe te voegen aan uw boek, de
nieuwe tekst mogelĳk tekens bevat die u heeft verwĳderd uit het lettertype.

--upgrade-book, -U

Upgrade de interne structuren van het boek, indien mogelĳk. Bĳvoorbeeld: upgrade EPUB 2-boeken naar EPUB
3-boeken.

--verbose

Geef uitgebreidere uitvoer, nuttig bĳ foutopsporing.
--version

toon programmaversie en stop

13.1.11 ebook-viewer

ebook-viewer [opties] bestand

Bekĳk een e-boek.
Als u aan ebook-viewer parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.:
“/some path/with spaces”

[Opties]
--continue

Laatst geopend boek verder lezen
--detach

Loskoppelen van de controleterminal, indien aanwezig (alleen Linux)
--force-reload

Dwing herladen van alle geopende boeken af
--full-screen, --fullscreen, -f

Indien gespecificeerd, zal het e-boekleesvenster proberen in volledig scherm te openen bĳ opstarten.
--help, -h

toon dit helpbericht en stop

340 Hoofdstuk 13. Opdrachtpromt



calibre Gebruikershandleiding, Release 8.7.0

--new-instance

Open a new viewer window even when the option to use only a single viewer window is set
--open-at

The position at which to open the specified book. The position is a location or position you can get by using the
Go to->Location action in the viewer controls. Alternately, you can use the form toc:something and it will open at
the location of the first Table of Contents entry that contains the string "something". The form toc-href:something
will match the href (internal link destination) of toc nodes. The matching is exact. If you want to match a substring,
use the form toc-href-contains:something. The form ref:something will use Reference mode references. The form
search:something will search for something after opening the book. The form regex:something will search for the
regular expression something after opening the book.

--raise-window

Indien gespecificeerd, zal het e-boekleesvenster proberen naar voren te komen bĳ opstarten.
--version

toon programmaversie en stop

13.1.12 fetch-ebook-metadata

fetch-ebook-metadata [options]

Haal metadata over het boek van online bronnen. Er moet minstens een titel, auteur of ISBN meegegeven worden.
Als u aan fetch-ebook-metadata parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten.
Bv.: “/some path/with spaces”

[Opties]
--allowed-plugin, -p

Geef de naam van een metadata download plug-in om te gebruiken. Standaard worden alle metadata -plug-ins
gebruikt. Kan meerdere keren worden opgegeven voor meerdere plug-ins. Alle plug-in-namen: Google, Google
Images, Amazon.com, Edelweiss, Open Library, Big Book Search

--authors, -a

Boek Auteur(s)
--cover, -c

Geef een bestandsnaam. De omslag "indien beschikbaar" wordt opgeslagen. Zonder deze optie wordt geen omslag
gedownload.

--help, -h

toon dit helpbericht en stop
--identifier, -I

Identificatoren zoals ASIN/Goodreads id enz. Kunnen meermaals gespecificeerd worden voor meerdere Identifi-
catoren. Bv.: --identifier (pagina 341) asin:B0082BAJA0

--isbn, -i

Boek ISBN
--opf, -o

De metadata uitvoeren in OPF indeling in plaats van door mensen leesbare tekst.
--timeout, -d

Timeout in seconden. Standaard is dit 30
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--title, -t

Boek titel
--verbose, -v

Print de log naar de console (stderr)
--version

toon programmaversie en stop

13.1.13 lrf2lrs

lrf2lrs boek.lrf

Een LRF-bestand naar LRS (XML UTF-8-codering) converteren
Als u aan lrf2lrs parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”

[Opties]
--dont-output-resources

Ingebedde afbeeldingen en lettertypes niet bewaren op schĳf
--help, -h

toon dit helpbericht en stop
--output, -o

Uitvoer-LRS-bestand
--verbose

Wees woordrĳker
--version

toon programmaversie en stop

13.1.14 lrfviewer

lrfviewer [opties] boek.lrf

Lees het LRF e-boek boek.lrf
Als u aan lrfviewer parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”

[Opties]
--disable-hyphenation

Zet woordafbreken uit. Zou weergeven opmerkelĳk moeten versnellen.
--help, -h

toon dit helpbericht en stop
--profile

Profileer de LRF weergave
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--verbose

Laat meer informatie zien over de weergaveproces
--version

toon programmaversie en stop
--visual-debug

Zet de visuele hulp aan voor foutzoeken in de weergave engine
--white-background

Als standaard is de achtergrond een gebroken wit sinds dit gemakkelĳker is om te lezen voor de ogen. Gebruik deze
optie om de achtergrond puur wit te maken.

13.1.15 lrs2lrf

lrs2lrf [opties] bestand.lrs

Compileer een LRS-bestand naar LRF-formaat.
Als u aan lrs2lrf parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”

[Opties]
--help, -h

toon dit helpbericht en stop
--lrs

LRS naar LRS converteren, handig om fouten op te sporen.
--output, -o

Pad naar uitvoerbestand
--verbose

Verwerking met veel uitleg
--version

toon programmaversie en stop

13.1.16 web2disk

web2disk URL

Waar URL is bĳvoorbeeld http://google.com
Als u aan web2disk parameters met spaties mee wilt geven, moet u deze met aanhalingstekens omsluiten. Bv.: “/some
path/with spaces”

[Opties]
--base-dir, -d

Basismap waar de URL wordt opgeslagen. Standaard is dit .
--delay

Minimuminterval in seconden tussen aaneensluitende downloads. Standaard is dit 0 s
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--dont-download-stylesheets

Geen CSS-stylesheets downloaden.
--encoding

De tekencodering voor de websites die u probeert te downloaden. Standaard zal er worden geprobeerd om de
codering te raden.

--filter-regexp

Alle links die overeenkomen met deze reguliere expressie worden genegeerd. U kunt deze optie vaker toepassen.
Als een regexp een match oplevert, wordt de link genegeerd. Standaard wordt links niet genegeerd. Als filter regexp
en match regexp allebei zĳn gespecifieerd, wordt filter regexp als eerste toegepast.

--help, -h

toon dit helpbericht en stop
--match-regexp

Alleen links die overeenkomen met deze regexp zullen gevolgd worden. Deze optie kan meerdere keren worden
opgegeven, in welk geval de link zal worden gevolgd als deze overeenkomt met ten minste één regexp. Standaard
zullen alle links gevolgd worden.

--max-files, -n

Het maximaal aantal te downloaden bestanden. Dit is alleen van toepassing op bestanden in <a href>-labels. Stan-
daard is dit 9223372036854775807

--max-recursions, -r

Maximaal aantal niveaus voor recursie, d.w.z. diepte van te volgen koppelingen. Standaard 1
--timeout, -t

Time-out in seconden om te wachten op een antwoord van de server. Standaard: 10.0 s
--verbose

Laat gedetailleerde uitvoerinformatie zien. Nuttig bĳ het opsporen van problemen
--version

toon programmaversie en stop

13.2 Ongedocumenteerde commando’s
• ebook-device
• markdown-calibre

U kan het gebruik van ongedocumenteerde commandos zien door ze uit te voeren zonder extra opties in een terminal.
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Opzetten van Calibre in een development omgeving

calibre is volledig open source, onder de GNU GPL v3 licentie <https://www.gnu.org/licenses/gpl.html> _. Dit betekent dat
u vrĳ bent om het programma naar hartenlust te downloaden en aan te passen. In dit gedeelte leert u hoe u een calibre
ontwikkelingsomgeving kunt opzetten voor het besturingssysteem van uw keuze. calibre wordt voornamelĳk geschreven in
Python <https://www.python.org> _ met wat C/C++ code voor snelheid en systeeminterface. Merk op dat calibre minstens
Python 3.8 nodig heeft.

Inhoud

• Ontwerp filosofie (pagina 346)
– Code opmaak (pagina 346)

• De code verkrĳgen (pagina 347)
– Uw aanpassingen insturen voor productie (pagina 347)

• Windows ontwikkel omgeving (pagina 348)
• macOS ontwikkelomgeving (pagina 349)
• Linux ontwikkel omgeving (pagina 350)
• Afzonderlĳke “normale” en “ontwikkel” calibre installaties op dezelfde computer hebben (pagina 350)
• Debug tips (pagina 351)

– Gebruik van print statements (pagina 351)
– Een interactieve Python vertaler gebruiken (pagina 351)
– De Python foutzoeker als een externe foutzoeker gebruiken (pagina 351)
– De foutzoeker gebruiken in uw favoriete Python IDE (pagina 352)
– Willekeurige scripts uitvoeren in de calibre Python omgeving (pagina 352)

• Calibre gebruiken in uw projecten (pagina 353)
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– Binaire installatie van Calibre (pagina 353)
– Broncode installatie op Linux (pagina 353)

• API installatie voor diverse onderdelen van Calibre (pagina 353)

14.1 Ontwerp filosofie
Calibre heeft zĳn wortels in de Unix-wereld, wat betekent dat het design bĳzonder modulair is. De modules werken samen
met elkaar via precies gedefinieerde interfaces. Hierdoor wordt het toevoegen van nieuwe features en het oplossen van
bugs in Calibre erg eenvoudig, wat resulteert in een snel ontwikkelingstempo. Vanwege deze wortels heeft Calibre een
uitgebreide command line interface voor al zĳn functies, welke gedocumenteerd zĳn in Opdrachtpromt (pagina 305).
Het modulaire ontwerp van Calibre wordt uitgedrukt via `` Plugins``. Er is een: ref :handleiding <customize> over het schrĳ-
ven van Calibre plug-ins. Als u bĳvoorbeeld ondersteuning toevoegt voor een nieuw Calibre apparaat, heeft dit meestal
betrekking op het schrĳven van minder dan 100 regels code in de vorm van een plug-in voor apparaatstuurprogramma’s.
U kunt bladeren door de ingebouwde stuurprogramma’s108. Op dezelfde manier houdt het toevoegen van ondersteuning
voor nieuwe conversie-indelingen het schrĳven van invoeg- / uitvoerformatenplug-ins in. Een ander voorbeeld van het
modulaire ontwerp is de: ref: receptuursysteem <news> voor het ophalen van nieuws. Zie de Index van plug-ins <htt-
ps://www.mobileread.com/forums/showthread.php?p=1362767#post1362767> _ voor meer voorbeelden van plug-ins die
zĳn ontworpen om functies aan Calibre toe te voegen.

14.1.1 Code opmaak
Alle de Calibre python code staat in het Calibre pakket. Dit pakket bevat de volgende hoofddeel pakketten

• apparaten - Alle apparaatstuurprogramma’s. Bekĳk enkele van de ingebouwde stuurprogramma’s om een   idee te
krĳgen hoe ze werken.

– Voor details, bekĳk: devices.interface wat de interface definieert ondersteund door toestel stuurpro-
gramma’s en devices.usbms wat een generiek stuurprogramma definieert die met een USBMS toestel
verbindt. Alle USBMS gebaseerde stuurprogramma’s erven ervan.

• e-boeken - Alle e-boek conversie/metadata code. Een goed beginpunt is calibre.ebooks.conversion.cli,
de module die het ebook-convert commando drĳft. Het conversieproces wordt gecontroleerd via conversion.
plumber. De formaat onafhankelĳke code zit allemaal in ebooks.oeb en de formaat afhankelĳke code in
ebooks.format_name.
– Metadata lezen, schrĳven en downloaden staat allemaal in `` ebooks.metagegevans``
– Conversie gebeurt in een pĳplĳn, voor de structuur van de pĳplĳn, bekĳk Inleiding (pagina 63). De pĳplĳn

bestaat uit een invoerplug-in, verschillende transforms en een uitvoerplug-in. De code die de pĳplĳn opbouwt
en aandrĳft zit in plumber.py. De pĳplĳn werkt op een voorstelling van een e-boek als een ontzipte EPUB,
met manifest, spine, ToC, gids, HTML inhoud, enz. De class die deze voorstelling beheert is OEBBook in
ebooks.oeb.base. De verschillende transformaties toegepast op het boek tĳdens conversie wonen in oeb/
transforms/*.py. En de in- en uitvoerplug-in wonen in oeb/transforms/*.py.

– E-boek bewerken gebeurt met een ander container object, gedocumenteerd in API documentatie voor e-book
bewerking functies (pagina 364).

• db - De database achterkant. Bekĳk API documentatie voor de gegevensbank interface (pagina 353) voor de interface
naar de calibre bibliotheek.

• Content server: srv is de calibre Content server.
108 https://github.com/kovidgoyal/Calibre/tree/master/src/Calibre/devices
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• gui2 - De Grafische Gebruiker Interface. GUI initialisatie gebeurt in gui2.main en gui2.ui. De e-boek-viewer
zit in gui2.viewer. De e-book editor in gui2.tweak_book.

Als u de ingangspunten voor alle calibre executables wilt lokaliseren, bekĳk de entry_points structuur in linux.py109.
Als u hulp nodig hebt om de code te begrĳpen, post iets in het ontwikkelforum110 en u zal heel waarschĳnlĳk hulp krĳgen
van een van de vele calibre ontwikkelaars.

14.2 De code verkrijgen
U kan de calibre broncode op twee manieren krĳgen, via een versiecontrolesysteem of download direct een tarball111.
calibre gebruikt Git112, een gedistribueerd versiecontrolesysteem. Git is beschikbaar op alle platformen die calibre on-
dersteunt. Na installeren van Git kan u de calibre source code krĳgen met het commando:

git clone https://github.com/kovidgoyal/calibre.git

Op Windows heb je de volledige padnaam nodig, dat zal ongeveer zo zĳn: bestand: C:\Program Files\Git\git.exe.
Calibre is een zeer groot project met een zeer lange versiebeheergeschiedenis, dus het bovenstaande kan een tĳd duren
(10 minuten tot een uur, afhankelĳk van je internetsnelheid).
Als u de code sneller wilt krĳgen, de broncode van de laatste uitgave is altĳd beschikbaar als een archive113.
Om een   vertakking bĳ te werken naar de nieuwste code, gebruik de volgende opdracht:

git pull --no-edit

U kan ook de code doorbladeren op GitHub114.

14.2.1 Uw aanpassingen insturen voor productie
Als u enkel een paar kleine veranderingen wilt maken, maak uw veranderingen en creëer een “merge directive” die u dan
aan een ticket in de calibre bug tracker115 kan koppelen. Om dit te doen, maak uw veranderingen , draai dan:

git commit -am "Comment describing your changes"

git format-patch origin/master --stdout > my-changes

Dit creëert een my-changes bestand in de huidige map, koppel dit gewoon aan een ticket op de calibre bug tracker116.
Merk op dat dit alle commits die gemaakt hebt meeneemt. Als u slechts enkele commits wil sturen, moet u de origin/
master boven veranderen. Om enkel de laatste commit te sturen, gebruik:

git format-patch HEAD~1 --stdout > my-changes

Als u de laatste n commentaren wilt verzenden, vervangt u 1 door n, bĳvoorbeeld voor de laatste 3 commentaren:

git format-patch HEAD~3 --stdout > my-changes

109 https://github.com/kovidgoyal/calibre/blob/master/src/calibre/linux.py
110 https://www.mobileread.com/forums/forumdisplay.php?f=240
111 https://calibre-ebook.com/dist/src
112 https://www.git-scm.com/
113 https://calibre-ebook.com/dist/src
114 https://github.com/kovidgoyal/calibre
115 https://bugs.launchpad.net/calibre
116 https://bugs.launchpad.net/calibre
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Zorg dat u geen samenvoegingen opneemt bĳ het gebruik van HEAD~n.
Als u veel ontwikkelwerk aan calibre wil doen, kan u best een GitHub117 account creëren. Onder vindt u een basisgids om
uw eigen fork van calibre op te zetten die u toelaat pull requests in te dienen voor opname in calibre’s hoofdrepository:

• Stel git in op uw machine zoals beschreven in dit artikel: Setup Git118

• Stel ssh-sleutels in voor authenticatie naar GitHub, zoals hier beschreven: SSH-sleutels genereren
<https://help.github.com/articles/generating-ssh-keys> _

• Ga naar https://github.com/kovidgoyal/Calibre en klik op de Fork button.
• In een terminalvenster doe:

git clone git@github.com:<username>/calibre.git

git remote add upstream https://github.com/kovidgoyal/calibre.git

Vervang <username> boven door uw GitHub gebruikersnaam. Dat zorgt ervoor dat uw fork lokaal wordt uitge-
checkt.

• U kunt wĳzigingen aanbrengen en deze toewĳzen wanneer u maar wilt. Wanneer je klaar bent om je werk samen
te voegen, doe dan een:

git push

en ga naar https://github.com/<username>/Calibre en klik op Pull Request button om een pull request
te generen die samengevoegd kan worden.

• U kunt uw lokale exemplaar op elk gewenst moment bĳwerken met code van de hoofdrepo door te doen:

git pull upstream

U houdt best een oogje op het calibre ontwikkelforum119. Vooraleer grote veranderingen te maken, bespreek ze best in
het forum of contacteer Kovid direct (de broncode krioelt van z’n e-mailadres).

14.3 Windows ontwikkel omgeving

Notitie

U moet ook de calibre broncode apart ophalen zoals beschreven boven.

Installeer calibre normaal met de Windows installer <https://calibre-ebook.com/download_windows>`__. Open dan een
Commandoprompt en ga naar de voordien bekeken calibre codemap. Bĳvoorbeeld:

cd C:\Users\kovid\work\calibre

calibre is de map die de src bevat en bronnensubmappen.
De volgende stap is de omgevingsvariabele CALIBRE_DEVELOP_FROM instellen op het absolute pad van de src map. Dus,
volgens het voorbeeld boven zou het C:\Users\kovid\work\calibre\src zĳn. Hier is een korte gids <https://docs.
python.org/using/windows.html#excursus-setting-environment-variables>`_ over instellen van omgevingsvariabelen in
Windows.

117 https://github.com
118 https://help.github.com/articles/set-up-git
119 https://www.mobileread.com/forums/forumdisplay.php?f=240
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Nadat u de omgevingsvariabele hebt ingesteld, opent u een nieuwe opdrachtprompt en controleert u of deze correct is
ingesteld met de opdracht:

echo %CALIBRE_DEVELOP_FROM%

Deze omgevingsvariabele instellen betekent dat calibre nu alle Python code vanuit de gespecificeerde locatie laadt.
Das alles! U bent nu klaar om de calibre code te beginnen hacken. Bv. open het bestand src\calibre\__init__.py

in uw favoriete editor en voeg volgende regel toe:

print("Hello, world!")

in de buurt van de bovenkant van het bestand. Voer nu de opdracht: opdracht uit: calibredb. De allereerste regel van de
uitvoer zou moeten zĳn `` Hallo, wereld! ``.
U kan ook een calibre ontwikkelomgeving opzetten in het gratis Microsoft Visual Studio, als u wilt, met volgende in-
structies hier120.

14.4 macOS ontwikkelomgeving

Notitie

U moet ook de calibre broncode apart ophalen zoals beschreven boven.

Installeer calibre normaal met de provided .dmg121. Open dan een Terminal en ga naar de voordien bekeken calibre
codemap, bĳvoorbeeld:

cd /Users/kovid/work/calibre

calibre is de map die de src bevat en bronnensubmappen. de calibre opdrachtregelgereedschappen vindt u in de calibre
appbundel, in /Applications/calibre.app/Contents/MacOS, u voegt deze map best toe aan uw PATH omge-
vingsvariabele als u de opdrachtregelgereedschappen vlot wilt gebruiken.
De volgende stap is het maken van een bash-script dat de omgevingsvariabele CALIBRE_DEVELOP_FROM instelt op het
absolute pad van de src map bĳ het uitvoeren van calibre in foutzoekmodus.
Maak een platte-tekst bestand:

#!/bin/sh

export CALIBRE_DEVELOP_FROM="/Users/kovid/work/calibre/src"

calibre-debug -g

Sla dit bestand op als /usr/local/bin/calibre-develop, stel dan de rechten in zodat het kan worden uitgevoerd:

chmod +x /usr/local/bin/calibre-develop

Als u dit heeft gedaan, voer uit:

calibre-develop

U zou wat diagnostische informatie in het Terminal-venster moeten zien als Calibre opstart, en u zou een asterisk na het
versienummer in het GUI-venster moeten zien, om aan te geven dat u vanuit de bron loopt.

120 https://www.mobileread.com/forums/showthread.php?t=251201
121 https://calibre-ebook.com/download_osx
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14.5 Linux ontwikkel omgeving

Notitie

U moet ook de calibre broncode apart ophalen zoals beschreven boven.

calibre is voornamelĳk in Linux ontwikkeld. U hebt twee keuzes bĳ instellen van de ontwikkelomgeving. U kan de
calibre binary als gewoonlĳk installeren en dat als runtime omgeving gebruiken voor uw ontwikkeling. Deze werkwĳze
is gelĳkaardig aan die in Windows en macOS. Als alternatief kan u calibre van de bron installeren. Instructies om een
ontwikkelomgeving op te zetten vanuit de bron staan in het INSTALL bestand in de bestandsboom. Hier gaat het over
gebruik van de binary als een runtime, wat de aanbevolen methode is.
Installeer calibre met de binary installer122. Open dan een Terminal en ga naar de voordien bekeken calibre codemap,
bĳvoorbeeld:

cd /home/kovid/work/calibre

calibre is de map die de src bevat en bronnensubmappen.
De volgende stap is om de omgevingsvariabele `` CALIBRE_DEVELOP_FROM`` in te stellen op het absolute pad van
de src-map. Dus, in navolging van het bovenstaande voorbeeld, zou het /home/kovid/work/Calibre/src zĳn. Het
instellen van omgevingsvariabelen is afhankelĳk van je Linux-distributie en welke shell je gebruikt.

Notitie

It is recommended to use the binary installer provided from upstream. Should you insist on using a package provided
by your distribution, use the CALIBRE_PYTHON_PATH and CALIBRE_RESOURCES_PATH variables instead. You can
get these by running calibre-debug --paths. But note that distribution calibre packages are often terminally
broken and are completely unsupported.

Nadat u de omgevingsvariabele hebt ingesteld, opent u een nieuwe terminal en controleert u of deze correct is ingesteld
met de opdracht:

echo $CALIBRE_DEVELOP_FROM

Deze omgevingsvariabele instellen betekent dat calibre nu alle Python code vanuit de gespecificeerde locatie laadt.
Das alles! U bent nu klaar om de calibre code te beginnen hacken. Bv. open het bestand src\calibre\__init__.py

in uw favoriete editor en voeg volgende regel toe:

print("Hello, world!")

in de buurt van de bovenkant van het bestand. Voer nu de opdracht: opdracht uit: calibredb. De allereerste regel van de
uitvoer zou moeten zĳn `` Hallo, wereld! ``.

14.6 Afzonderlijke “normale” en “ontwikkel” calibre installaties op
dezelfde computer hebben

De calibre bronboom is heel stabiel en breekt zelden maar als u de behoefte voelt om vanuit de bron te draaien op een
aparte testbibliotheek en de uitgegeven calibre versie met uw dagdagelĳkse bibliotheek, kan u dat gemakkelĳk met .bat

122 https://calibre-ebook.com/download_linux
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bestanden of shellscripts om calibre te starten. Het voorbeeld onder toont hoe dit te doen in Windows met .bat bestanden
(de instructies voor andere platformen zĳn hetzelfde, gebruik gewoon een shellscript i.p.v. een .bat bestand).
De releaseversie van calibre lanceren met uw alledaagse bibliotheek
Calibre-normal.bat:

calibre.exe "--with-library=C:\path\to\everyday\library folder"

Calibre-dev.bat:

set CALIBRE_DEVELOP_FROM=C:\path\to\calibre\checkout\src

calibre.exe "--with-library=C:\path\to\test\library folder"

14.7 Debug tips
Python is een dynamisch getypeerde taal met uitstekend onderdak voor introspectie. Kovid schreef de kern calibre code
zonder ook maar één keer een foutzoeker te gebruiken. Er zĳn veel strategieën voor foutzoeken in calibre code:

14.7.1 Gebruik van print statements
Dit is de favoriete manier van Kovid om te debuggen. Voeg eenvoudig afdrukinstructies in op interessante plaatsen en
voer uw programma uit in de terminal. U kunt de GUI bĳvoorbeeld vanuit de terminal starten als:

calibre-debug -g

U kan de e-boekviewer ook starten als:

calibre-debug -w /path/to/file/to/be/viewed

The e-book editor can be started as:

calibre-debug --edit-book /path/to/be/edited

14.7.2 Een interactieve Python vertaler gebruiken
U kan de volgende twee regels code invoegen om op dat punt een interactieve Python sessie te starten:

from calibre import ipython

ipython(locals())

Bĳ het uitvoeren van de opdrachtregel start hiermee een interactieve Python vertaler met toegang tot alle lokaal gede-
finieerde variabelen (variabelen in de lokale scope). De interactieve prompt heeft zelfs Tab voltooiing voor objectei-
genschappen en u kunt de verschillende Python faciliteiten gebruiken voor introspectie, zoals dir(), type(), repr(),
enz.

14.7.3 De Python foutzoeker als een externe foutzoeker gebruiken
U kan de ingebouwde Python foutzoeker gebruiken (pdb) als een externe foutzoeker vanop de opdrachtregel. Om te
beginnen, start de externe foutzoeker op de plaats in de code waar u in geïnteresseerd bent, zoals dit:

from calibre.rpdb import set_trace

set_trace()
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Voer vervolgens Calibre uit, hetzĳ als normaal, of met behulp van een van de Calibre-debug-opdrachten die in de vorige
sectie zĳn beschreven. Zodra het bovenstaande punt in de code is bereikt, zal Calibre bevriezen, wachtend totdat de
foutopsporing verbinding maakt.
Open nu een terminal of opdrachtprompt en gebruik de volgende opdracht om de foutopsporingssessie te starten:

calibre-debug -c "from calibre.rpdb import cli; cli()"

U kan lezen hoe de Python foutzoeker te gebruiken in de Python stdlib docs voor de pdb module123.

Notitie

Standaard probeert de debugger op afstand verbinding te maken op poort 4444. Je kunt dit wĳzigen door
de parameter port naar zowel de set_trace() als de cli() -functies hierboven door te geven, zoals deze:
set_trace(port=1234)``en``cli(port = 1234).

Notitie

De Python foutzoeker kan niet met meerdere draadjes overweg, u moet set_trace dus voor elk draadje roepen, elke
keer met een ander poortnummer.

14.7.4 De foutzoeker gebruiken in uw favoriete Python IDE
Het is mogelĳk om de ingebouwde foutzoeker van uw favoriete Python IDE te gebruiken, als hĳ extern foutzoeken on-
dersteunt. De eerste stap is toevoegen van de calibre scr checkout aan PYTHONPATH in uw IDE. M.a.w. de map die u
instelde als CALIBRE_DEVELOP_FROM boven moet ook in PYTHONPATH van uw IDE staan.
Plaats dan de IDE’s externe foutzoekmodule in de src submap van de calibre broncode checkout. Voeg de nodige code
toe om de externe foutzoeker te starten op het punt van interesse, bv. in de hoofdfunctie. Draai calibre dan als gewoonlĳk.
Uw IDE zou nu moeten kunnen verbinden met de externe foutzoeker die in calibre draait.

14.7.5 Willekeurige scripts uitvoeren in de calibre Python omgeving
Het calibre-debug commando voorziet enkele handige schakelaars om uw eigen code uit te voeren, met toegang tot
de calibre modules:

calibre-debug -c "some Python code"

is geweldig om een klein code knipseltje te testen op de commandoregel. Werkt op dezelfde manier als de -c schakelaar
naar de Python vertaler:

calibre-debug myscript.py

kan worden gebruikt om je eigen Python-script uit te voeren. Het werkt op dezelfde manier als het doorgeven van het
script aan de Python-interpreter, behalve dat de Calibre omgeving volledig is geïnitialiseerd, zodat u alle Calibre code in
uw script kunt gebruiken. om opdrachtregelargumenten te gebruiken met uw script, gebruik de vorm:

calibre-debug myscript.py -- --option1 arg1

De `` –`` zorgt ervoor dat alle volgende argumenten aan je script worden doorgegeven.
123 https://docs.python.org/library/pdb.html#debugger-commands
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14.8 Calibre gebruiken in uw projecten
Het is mogelĳk calibre functies/code direct te gebruiken in uw Python project. Er zĳn twee manieren om dit te doen:

14.8.1 Binaire installatie van Calibre
Als u een binaire installatie van calibre hebt, kan u de Python vertaler, gebundeld met calibre, zo gebruiken:

calibre-debug /path/to/your/python/script.py -- arguments to your script

14.8.2 Broncode installatie op Linux
Bĳkomend aan de techniek boven, als u een broninstallatie doet in Linux kan u calibre ook direct importeren, op deze
manier:

import init_calibre

import calibre

print(calibre.__version__)

Het is essentieel dat u de init_calibre module importeert voor enige andere calibre modules/packages want het stelt de
vertaler in om de calibre code te draaien.

14.9 API installatie voor diverse onderdelen van Calibre
14.9.1 API documentatie voor de gegevensbank interface
Deze API is thread safe (meervoudige reader, single writer vergrendelingsschema). U kunt een API intreden door

from calibre.library import db

db = db('Path to calibre library folder').new_api

Als u zich bevindt in een plugin dat deel uitmaakt van de hoofd caliber gebruikersinterface kunt u ook toegang krĳgen tot
dit zoals onderstaand;;

db = self.gui.current_db.new_api

class calibre.db.cache.Cache(backend, library_database_instance=None)
Een geheugencache van het bestand metadata .db van een calibre bibliotheek. Deze class dient ook als een thread-
safe API om toegang te krĳgen tot de database. Het geheugencache wordt onderhouden in normale vorm voor
maximale prestatie.
SQLITE wordt gebruikt om te lezen en schrĳven van metadata .db op een robuuste manier. De logica van alle
tabellen lezen/sorteren/zoeken/cachen wordt herimplementeerd. Dit was noodzakelĳk voor maximale prestatie en
flexibiliteit.
class EventType(*values)

book_created = 4

When a new book record is created in the database, with the book id as the only argument
book_edited = 8

When a book format is edited, with arguments: (book_id, fmt)
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books_removed = 5

When books are removed from the database with the list of book ids as the only argument
format_added = 2

When a format is added to a book, with arguments: (book_id, format)
formats_removed = 3

When formats are removed from a book, with arguments: (mapping of book id to set of formats removed
from the book)

indexing_progress_changed = 9

When the indexing progress changes
items_removed = 7

When items such as tags or authors are removed from some books. Arguments: (field_name, affected
book ids, ids of removed items)

items_renamed = 6

When items such as tags or authors are renamed in some or all books. Arguments: (field_name, affected
book ids, map of old item id to new item id)

links_changed = 11

When the links associated with items(s) are changed, with arguments: (field_name, item_ids)
metadata_changed = 1

When some metadata is changed for some books, with arguments: (name of changed field, set of affected
book ids)

notes_changed = 10

When the notes associated with item(s) are changed, with arguments: (field_name, item_ids)
add_books(books, add_duplicates=True, apply_import_tags=True, preserve_uuid=False, run_hooks=True,

dbapi=None)

Voeg de gespecificeerde boeken toe aan de bibliotheek. Boeken moeten een iterabel zĳn van 2-tupels, elk
2-tupel van de vorm: code: (mi, format_map) waarbĳ mi een Metadata -object is en format_map een woorden-
boek is van de vorm: code: {fmt: path_or_stream} `, bĳvoorbeeld: :code: {‘EPUB’: ‘/pad/naar/bestand.epub’}
`.
Retourneert een paar lĳsten: id's, duplicaten. ids bevat de boek-id’s voor alle nieuw gemaakte boeken
in de gegevensbank. duplicaten bevat de: code: (mi, format_map) voor alle boeken die al bestaan in de
gegevensbank volgens de eenvoudige duplicaat detectie heuristiek gebruikt door has_book() (pagina 359).

add_custom_book_data(name, val_map, delete_first=False)
Toevoegen van gegevens voor naam waar val_map is een map van book-ids naar waardes. Indien delete_first
is True of WAAR, dan wordt alle eerder opgeslagen gegevens voor naam verwĳderd.

add_extra_files(book_id, map_of_relpath_to_stream_or_path, replace=True, auto_rename=False)

Add extra data files
add_format(book_id, fmt, stream_or_path, replace=True, run_hooks=True, dbapi=None)

Voeg een formaat toe aan het gespecificeerde boek. Koppel True terug als het formaat succesvol is toegevoegd.
Parameters

• replace – Als “True” een bestaand formaat vervangt, anders als het formaat al bestaat,
“False” terugkoppelen.

• run_hooks – Indien TRUE lopen de bestandstype-plugins in het formaat vóór en ná het
toevoegen.
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• dbapi – Enkel intern gebruik
add_listener(event_callback_function, check_already_added=False)

Registreer een callback functie die aangeroepen wordt nadat bepaalde acties op de database uit-
gevoerd werden. De functie moet drie argumenten hebben: (EventType (pagina 353), library_id,
event_type_specific_data)

add_notes_resource(path_or_stream_or_data, name: str, mtime: float = None)→ int
Add the specified resource so it can be referenced by notes and return its content hash

all_annotation_types()

Return a tuple of all annotation types in the database.
all_annotation_users()

Return a tuple of all (user_type, user name) that have annotations.
all_annotations(restrict_to_user=None, limit=None, annotation_type=None, ignore_removed=False,

restrict_to_book_ids=None)

Return a tuple of all annotations matching the specified criteria. ignore_removed controls whether remo-
ved (deleted) annotations are also returned. Removed annotations are just a skeleton used for merging of
annotations.

all_annotations_for_book(book_id)
Return a tuple containing all annotations for the specified book_id as a dict with keys: format, user_type, user,
annotation. Here, annotation is the annotation data.

all_book_ids(type=<class 'frozenset'>)
Bevroren voor alle beken de boek id’s.

all_field_for(field, book_ids, default_value=None)
Zelfde als field_for, behalve dat het werkt voor meerdere boeken tegelĳkertĳd

all_field_ids(name)
Bevroren set met ID’s voor alle waarden in het veld naam.

all_field_names(field)
Bevroren set van alle veld namen (alleen gebruikt worden voor VEEL-EEN en VEEL-VEEL velden)

annotation_count_for_book(book_id)
Return the number of annotations for the specified book available in the database.

annotations_map_for_book(book_id, fmt, user_type='local', user='viewer')
Return a map of annotation type -> annotation data for the specified book_id, format, user and user_type.

author_data(author_ids=None)

Geeft auteurgegevens terug als woordenboek met toetsen: naam, sortering, link
Indien geen auteurs met de gespecificeerds id’s worden gevonden, geeft dit een leeg woordenboek terug. Indien
author_ids is None worden gegevens van alle auteurs getoond.

author_sort_from_authors(authors, key_func=<function
make_change_case_func.<locals>.change_case>)

Geef een lĳst met auteurs, terugkeren naar auteur_sorteren string voor de auteurs, voorkeur dat de auteur
sortering geassocieerd is met de auteur over het berekende string.
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books_for_field(name, item_id)
Geeft alle die boeken terug die in verband staan met het item geïdentificeerd door item_id, waar het item
behoord tot het veld naam.
Geeft als waarde terug een set boeken id’s of een leeg set indien het item of het veld niet bestaat.

books_in_virtual_library(vl, search_restriction=None, virtual_fields=None)
Keer terug het set van boeken in het gespecificeerd virtueel bibliotheek

compress_covers(book_ids, jpeg_quality=100, progress_callback=None)
Comprimeer de omslagafbeeldingen voor de gespecificeerde boeken. Een compressiekwaliteit van 100 voert
een verliesvrĳe compressie uit, anders met verlies.
De vooruitgang callback wordt aangeroepen met het book_id en de oude en nieuwe groottes voor elk boek
dat verwerkt werd. Als er een fout is, zal de nieuwe grootte een string met de foutdetails zĳn.

copy_cover_to(book_id, dest, use_hardlink=False, report_file_size=None)
Kopieer de opslag naar het bestandsobject doel. Geeft Onwaar indien geen omslag bestaat, of doel gelĳk is
aan de huidige omslag. Doel kan ook een pad zĳn, waarbĳ de omslag ernaartoe wordt gekopieerd indien het
pad anders is dan het huidige pad (rekening houdend met hoofdlettergevoeligheid).

copy_format_to(book_id, fmt, dest, use_hardlink=False, report_file_size=None)
Kopieer het formaat fmt naar het bestand als object dest. Als het gespecificeerd formaat niet bestaat, ver-
hoogd :class:’NoSuchFormat’ fout. dest kan ook een pad zĳn (naar een bestand), in dat geval is het formaat
ernaar gekopieerd, als het pad verschillend is van de huidige pad (hoofdlettergevoeligheid in het account
meegenomen).

cover(book_id, as_file=False, as_image=False, as_path=False, as_pixmap=False)
Geeft omslagfoto terug of None. Standaard geeft de omslag terug als een reeks bytes.
WAARSCHUWING: Het gebruik van as_path maakt een kopie van de omslag in een temp-bestand en geeft
het pad terug naar het temp-bestand. U moet het temp-bestand verwĳderen wanneer u er klaar mee bent.

Parameters
• as_file – Indien TRUE de afbeelding teruggeeft als een open file object (een Spooled-

TemporaryFile)
• as_image – Indien waar, geef de afbeelding terug als een QImage object
• as_pixmap – If True return the image as a QPixmap object
• as_path – Indien TRUE de afbeelding teruggeeft als een pad die verwĳst naar een temporair

bestand
data_for_find_identical_books()

Geeft data terug die gebruikt kunnen worden om find_identical_books() (pagina 357) toe te passen
in een worker process zonder toegang tot de database. Bekĳk db.utils voor een toepassing.

data_for_has_book()

Geeft data terug die gebruikt kunnen worden om has_book() (pagina 359). Dit kan gebruikt worden voor
een toepassing van has_book() (pagina 359) in een worker process zonder toegang tot de database.

delete_annotations(annot_ids)
Delete annotations with the specified ids.

delete_custom_book_data(name, book_ids=())
Verwĳder data voor naam. Verwĳdert standaard alle data, als u enkel data voor sommige boek ID’s wilt
verwĳderen, geef een lĳst met boek ID’s in.
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delete_trash_entry(book_id, category)
Delete an entry from the trash. Here category is ‘b’ for books and ‘f’ for formats.

embed_metadata(book_ids, only_fmts=None, report_error=None, report_progress=None)
Update metadata in alle formaten van het gespecificeerde book_ids tot huidige metadata in de database.

expire_old_trash()

Expire entries from the trash that are too old
export_note(field, item_id)→ str

Export the note as a single HTML document with embedded images as data: URLs
fast_field_for(field_obj, book_id, default_value=None)

Hetzelfde als field_for, behalve dat het de extra opzoek vermĳdt voor het veld object
field_for(name, book_id, default_value=None)

Geeft waarde van het veld name voor boek geïdentificeerd door book_id terug. Als zo geen boek bestaat
of geen gedefinieerde waarde heeft voor het veld name of zulk veld bestaat niet, wordt default_value
teruggegeven.
default_value wordt niet gebruikt voor title, title_sort, authors, author_sort and series_index omdat deze
altĳd waardes hebben in de db. default_value wordt gebruikt voor alle aangepaste kolommen.
The returned value for is_multiple fields are always tuples, even when no values are found (in other words,
default_value is ignored). The exception is identifiers for which the returned value is always a dictionary. The
returned tuples are always in link order, that is, the order in which they were created.

field_ids_for(name, book_id)
Geef de id’s terug (als een tupel) voor de waardes dat het veld name heeft voor het boek geïdentificeerd door
book_id. Als er geen waardes zĳn, of zo geen boek, of zo geen veld, wordt een lege tupel teruggegeven.

field_supports_notes(field=None)→ bool
Return True iff the specified field supports notes. If field is None return frozenset of all fields that support
notes.

find_identical_books(mi, search_restriction='', book_ids=None)
Vindt boeken die een auteur superset hebben in mi en dezelfde titel (titel komt fuzzy overeen). Bekĳk ook
data_for_find_identical_books() (pagina 356).

format(book_id, fmt, as_file=False, as_path=False, preserve_filename=False)
Geef het boekformaat terug als een byte string of Geen als het formaat niet bestaat of we geen toestemming
hebben om naar het e-boek bestand te schrĳven.

Parameters
• as_file – Indien Waar wordt het e-boek formaat teruggegeven als bestandsobject. Merk

op dat het bestandsobject een SpooledTemporaryFile is dus als u het formaat naar een ander
bestand wil kopiëren, gebruik in plaats daarvan copy_format_to() (pagina 356) voor
prestatie.

• as_path – Kopieert het formaat bestand naar een tĳdelĳk bestand en geeft het pad naar het
tĳdelĳk bestand terug

• preserve_filename – If True and returning a path the filename is the same as that used
in the library. Note that using this means that repeated calls yield the same temp file (which
is re-created each time)
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format_abspath(book_id, fmt)
Geeft absolute pad terug aan het e-boek bestand in formaat format. Dit mag u maar zelden gebruiken want
het breekt de threadveilige belofte van deze API. Gebruik beter copy_format_to() (pagina 356).
Currently used only in calibredb list, the viewer, edit book, compare_format to original format, open with,
bulk metadata edit and the catalogs (via get_data_as_dict()).
Apart from the viewer, open with and edit book, I don’t believe any of the others do any file write I/O with
the results of this call.

format_hash(book_id, fmt)
Return the hash of the specified format for the specified book. The kind of hash is backend dependent, but
is usually SHA-256.

format_metadata(book_id, fmt, allow_cache=True, update_db=False)
Return the path, size and mtime for the specified format for the specified book. You should not use path
unless you absolutely have to, since accessing it directly breaks the threadsafe guarantees of this API. Instead
use the copy_format_to() (pagina 356) method.

Parameters
• allow_cache – If True cached values are used, otherwise a slow filesystem access is done.

The cache values could be out of date if access was performed to the filesystem outside of
this API.

• update_db – If True The max_size field of the database is updated for this book.
formats(book_id, verify_formats=True)

Return tuple of all formats for the specified book. If verify_formats is True, verifies that the files exist on
disk.

get_all_items_that_have_notes(field_name=None)→ set[int] | dict[str, set[int]]
Return all item_ids for items that have notes in the specified field or all fields if field_name is None

get_all_link_maps_for_book(book_id)
Returns all links for all fields referenced by book identified by book_id. If book_id doesn’t exist then the
method returns {}.
Example: Assume author A has link X, author B has link Y, tag S has link F, and tag T has link G. If book 1
has author A and tag T, this method returns {‘authors’:{‘A’:’X’}, ‘tags’:{‘T’, ‘G’}}. If book 2’s author is neither
A nor B and has no tags, this method returns {}.

Parameters
book_id – the book id in question.

Returns
{field: {field_value, link_value}, … for all fields with a field_value having a non-empty link
value for that book

get_categories(sort='name', book_ids=None, already_fixed=None, first_letter_sort=False,
uncollapsed_categories=None)

Intern gebruikt om de labelbrowser te implementeren
get_custom_book_data(name, book_ids=(), default=None)

Get data for name. By default returns data for all book_ids, pass in a list of book ids if you only want some
data. Returns a map of book_id to values. If a particular value could not be decoded, uses default for it.

get_id_map(field)
Return a mapping of id numbers to values for the specified field. The field must be a many-one or many-many
field, otherwise a ValueError is raised.
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get_ids_for_custom_book_data(name)
Return the set of book ids for which name has data.

get_item_id(field, item_name, case_sensitive=False)
Return the item id for item_name or None if not found. This function is very slow if doing lookups for multiple
names use either get_item_ids() or get_item_name_map(). Similarly, case sensitive lookups are faster than
case insensitive ones.

get_item_ids(field, item_names, case_sensitive=False)
Return a dict mapping item_name to the item id or None

get_item_name(field, item_id)

Return the item name for the item specified by item_id in the specified field. See also get_id_map()

(pagina 358).
get_item_name_map(field, normalize_func=None)

Return mapping of item values to ids
get_link_map(for_field)

Return a dictionary of links for the supplied field.
Parameters

for_field – the lookup name of the field for which the link map is desired
Returns

{field_value:link_value, …} for non-empty links
get_metadata(book_id, get_cover=False, get_user_categories=True, cover_as_data=False)

Return metadata for the book identified by book_id as a calibre.ebooks.metadata.book.base.

Metadata (pagina 212) object. Note that the list of formats is not verified. If get_cover is True, the cover
is returned, either a path to temp file as mi.cover or if cover_as_data is True then as mi.cover_data.

get_next_series_num_for(series, field='series', current_indices=False)
Return the next series index for the specified series, taking into account the various preferences that control
next series number generation.

Parameters
• field – The series-like field (defaults to the builtin series column)
• current_indices – If True, returns a mapping of book_id to current series_index value

instead.
get_notes_resource(resource_hash)→ dict | None

Return a dict containing the resource data and name or None if no resource with the specified hash is found
get_proxy_metadata(book_id)

Like get_metadata() (pagina 359) except that it returns a ProxyMetadata object that only reads values
from the database on demand. This is much faster than get_metadata when only a small number of fields
need to be accessed from the returned metadata object.

get_usage_count_by_id(field)
Return a mapping of id to usage count for all values of the specified field, which must be a many-one or
many-many field.

has_book(mi)

Geeft Waar desda de gegevensbank een item bevat met dezelfde titel als meegegeven in het metadata object.
De vergelĳking is niet hoofdlettergevoelig. Zie ook data_for_has_book() (pagina 356).
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has_format(book_id, fmt)
Geeft Waar desda het formaat bestaat op disk

has_id(book_id)

Geeft Waar desda het boek_id bestaat in de db
import_note(field, item_id, path_to_html_file, path_is_data=False)

Import a previously exported note or an arbitrary HTML file as the note for the specified item
init()

Initialize this cache with data from the backend.
items_with_notes_in_book(book_id: int)→ dict[str, dict[int, str]]

Return a dict of field to items that have associated notes for that field for the specified book
link_for(field, item_id)

Return the link, if any, for the specified item or None if no link is found
list_extra_files(book_id, use_cache=False, pattern='')→ tuple[ExtraFile, ...]

Get information about extra files in the book’s directory.
Parameters

• book_id – the database book id for the book
• pattern – the pattern of filenames to search for. Empty pattern matches all extra files.

Patterns must use / as separator. Use the DATA_FILE_PATTERN constant to match files
inside the data directory.

Returns
A tuple of all extra files matching the specified pattern. Each element of the tuple is Extra-
File(relpath, file_path, stat_result). Where relpath is the relative path of the file to the book
directory using / as a separator. stat_result is the result of calling os.stat() on the file.

merge_annotations_for_book(book_id, fmt, annots_list, user_type='local', user='viewer')
Merge the specified annotations into the existing annotations for book_id, fm, user_type, and user.

merge_extra_files(dest_id, src_ids, replace=False)
Merge the extra files from src_ids into dest_id. Conflicting files are auto-renamed unless replace=True in
which case they are replaced.

move_book_from_trash(book_id)

Undelete a book from the trash directory
move_format_from_trash(book_id, fmt)

Undelete a format from the trash directory
multisort(fields, ids_to_sort=None, virtual_fields=None)

Return a list of sorted book ids. If ids_to_sort is None, all book ids are returned.
fields must be a list of 2-tuples of the form (field_name, ascending=True or False). The most significant field
is the first 2-tuple.

notes_data_for(field, item_id)→ str
Return all notes data as a dict or None if note does not exist

notes_for(field, item_id)→ str
Return the notes document or an empty string if not found
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notes_resources_used_by(field, item_id)
Return the set of resource hashes of all resources used by the note for the specified item

pref(name, default=None, namespace=None)

Return the value for the specified preference or the value specified as default if the preference is not set.
read_backup(book_id)

Return the OPF metadata backup for the book as a bytestring or None if no such backup exists.
remove_books(book_ids, permanent=False)

Remove the books specified by the book_ids from the database and delete their format files. If permanent
is False, then the format files are placed in the per-library trash directory.

remove_extra_files(book_id: int, relpaths: Iterable[str], permanent=False)→ dict[str, Exception | None]
Delete the specified extra files, either to Recycle Bin or permanently.

remove_formats(formats_map, db_only=False)
Verwĳder de specifieke formaten van de specifieke boeken

Parameters
• formats_map – A mapping of book_id to a list of formats to be removed from the book.
• db_only – If True, only remove the record for the format from the db, do not delete the

actual format file from the filesystem.
Returns

A map of book id to set of formats actually deleted from the filesystem for that book
remove_items(field, item_ids, restrict_to_book_ids=None)

Delete all items in the specified field with the specified ids. Returns the set of affected book ids. re-
strict_to_book_ids is an optional set of books ids. If specified the items will only be removed from
those books.

rename_extra_files(book_id, map_of_relpath_to_new_relpath, replace=False)
Rename extra data files

rename_items(field, item_id_to_new_name_map, change_index=True, restrict_to_book_ids=None)
Rename items from a many-one or many-many field such as tags or series.

Parameters
• change_index – When renaming in a series-like field also change the series_index values.
• restrict_to_book_ids – An optional set of book ids for which the rename is to be

performed, defaults to all books.
restore_book(book_id, mi, last_modified, path, formats, annotations=())

Restore the book entry in the database for a book that already exists on the filesystem
restore_original_format(book_id, original_fmt)

Restore the specified format from the previously saved ORIGINAL_FORMAT, if any. Return True on suc-
cess. The ORIGINAL_FORMAT is deleted after a successful restore.

property safe_read_lock

A safe read lock is a lock that does nothing if the thread already has a write lock, otherwise it acquires a read
lock. This is necessary to prevent DowngradeLockErrors, which can happen when updating the search cache
in the presence of composite columns. Updating the search cache holds an exclusive lock, but searching a
composite column involves reading field values via ProxyMetadata which tries to get a shared lock. There
may be other scenarios that trigger this as well.
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This property returns a new lock object on every access. This lock object is not recursive (for performance)
and must only be used in a with statement as with cache.safe_read_lock: otherwise bad things will
happen.

save_original_format(book_id, fmt)
Save a copy of the specified format as ORIGINAL_FORMAT, overwriting any existing ORIGI-
NAL_FORMAT.

search(query, restriction='', virtual_fields=None, book_ids=None)
Search the database for the specified query, returning a set of matched book ids.

Parameters
• restriction – A restriction that is ANDed to the specified query. Note that restrictions

are cached, therefore the search for a AND b will be slower than a with restriction b.
• virtual_fields – Used internally (virtual fields such as on_device to search over).
• book_ids – If not None, a set of book ids for which books will be searched instead of

searching all books.
search_annotations(fts_engine_query, use_stemming=True, highlight_start=None, highlight_end=None,

snippet_size=None, annotation_type=None, restrict_to_book_ids=None,
restrict_to_user=None, ignore_removed=False)

Return of a tuple of annotations matching the specified Full-text query.
search_notes(fts_engine_query='', use_stemming=True, highlight_start=None, highlight_end=None,

snippet_size=None, restrict_to_fields=(), return_text=True, result_type=<class 'tuple'>,
process_each_result=None, limit=None)

Search the text of notes using an FTS index. If the query is empty return all notes.
set_annotations_for_book(book_id, fmt, annots_list, user_type='local', user='viewer')

Set all annotations for the specified book_id, fmt, user_type and user.
set_conversion_options(options, fmt='PIPE')

options must be a map of the form {book_id:conversion_options}
set_cover(book_id_data_map)

Set the cover for this book. The data can be either a QImage, QPixmap, file object or bytestring. It can also
be None, in which case any existing cover is removed.

set_field(name, book_id_to_val_map, allow_case_change=True, do_path_update=True)
Set the values of the field specified by name. Returns the set of all book ids that were affected by the change.

Parameters
• book_id_to_val_map – Mapping of book_ids to values that should be applied.
• allow_case_change – If True, the case of many-one or many-many fields will be changed.

For example, if a book has the tag tag1 and you set the tag for another book to Tag1 then
the both books will have the tag Tag1 if allow_case_change is True, otherwise they will both
have the tag tag1.

• do_path_update – Intern gebruikt, u dient dit nooit te wĳzigen.
set_link_map(field, value_to_link_map, only_set_if_no_existing_link=False)

Sets links for item values in field. Note: this method doesn’t change values not in the value_to_link_map
Parameters

• field – the lookup name
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• value_to_link_map – dict(field_value:link, …). Note that these are values, not field ids.
Returns

books changed by setting the link
set_metadata(book_id, mi, ignore_errors=False, force_changes=False, set_title=True, set_authors=True,

allow_case_change=False)

Set metadata for the book id from the Metadata object mi

Setting force_changes=True will force set_metadata to update fields even if mi contains empty values. In
this case, ‘None’ is distinguished from ‘empty’. If mi.XXX is None, the XXX is not replaced, otherwise it
is. The tags, identifiers, and cover attributes are special cases. Tags and identifiers cannot be set to None so
they will always be replaced if force_changes is true. You must ensure that mi contains the values you want
the book to have. Covers are always changed if a new cover is provided, but are never deleted. Also note that
force_changes has no effect on setting title or authors.

set_notes_for(field, item_id, doc: str, searchable_text: str = '', resource_hashes=(),
remove_unused_resources=False)→ int

Set the notes document. If the searchable text is different from the document, specify it as searcha-
ble_text. If the document references resources their hashes must be present in resource_hashes. Set remo-
ve_unused_resources to True to cleanup unused resources, note that updating a note automatically cleans up
resources pertaining to that note anyway.

set_pref(name, val, namespace=None)
Stel de opgegeven voorkeur aan de opgegeven waarde. Zie ook: meth: pref.

split_if_is_multiple_composite(f, val)
If f is a composite column lookup key and the column is is_multiple then split v into unique non-empty values.
The comparison is case sensitive. Order is not preserved. Return a list() for compatibility with proxy metadata
field getters, for example tags.

tags_older_than(tag, delta=None, must_have_tag=None, must_have_authors=None)
Return the ids of all books having the tag tag that are older than the specified time. tag comparison is case
insensitive.

Parameters
• delta – A timedelta object or None. If None, then all ids with the tag are returned.
• must_have_tag – If not None the list of matches will be restricted to books that have this

tag
• must_have_authors – A list of authors. If not None the list of matches will be restricted

to books that have these authors (case insensitive).
unretire_note_for(field, item_id)→ int

Unretire a previously retired note for the specified item. Notes are retired when an item is removed from the
database

update_annotations(annot_id_map)

Update annotations.
user_categories_for_books(book_ids, proxy_metadata_map=None)

Return the user categories for the specified books. proxy_metadata_map is optional and is useful for a perfor-
mance boost, in contexts where a ProxyMetadata object for the books already exists. It should be a mapping
of book_ids to their corresponding ProxyMetadata objects.

14.9. API installatie voor diverse onderdelen van Calibre 363



calibre Gebruikershandleiding, Release 8.7.0

14.9.2 API documentatie voor e-book bewerking functies
De hulpmiddelen voor het bewerken van e-boeken bestaan uit een: class: Calibre.ebooks.oeb.polish.container.Container-
object dat een boek vertegenwoordigt als een verzameling HTML + bronbestanden en verschillende hulpmiddelen die
kunnen worden gebruikt om bewerkingen uit te voeren op de houder. Alle tools zĳn in de vorm van moduleniveaufuncties
in de verschillende `` Calibre.ebooks.oeb.polish. * `` Modules. U verkrĳgt een containerobject voor een boek op een pad
als dit:

from calibre.ebooks.oeb.polish.container import get_container

container = get_container('Path to book file', tweak_mode=True)

Als u een plug-in schrĳft voor de E-book-editor, krĳgt u de huidige container voor het bewerken van het boek zoals dit:

from calibre.gui2.tweak_book import current_container

container = current_container()

if container is None:

report_error # No book has been opened yet

Het container object
class calibre.ebooks.oeb.polish.container.Container(rootpath=None, opfpath=None,

log=<calibre.utils.logging.Log object>,
clone_data=None)

Een container stelt een open e-boek voor als een map vol bestanden en een OPF-bestand. Er zĳn twee belangrĳke
concepten:

• De hoofdmap. Dit is de basis van het e-boek. Alle e-boek bestanden bevinden zich in deze map of in zĳn
submappen.

• Namen: Dit zĳn paden naar boekbestanden relatief aan de hoofdmap. Ze bevatten altĳd POSIX separatoren
en hebben geen aanhalingstekens. Zie ze als canonieke identificatoren voor bestanden in het boek. Meeste
methodes op het containerobject werken met namen. Namen zĳn altĳd in de NFC Unicode normale vorm.

• Klonen: Het containerobject ondersteunt efficiënt op-schĳf klonen, gebruikt om controlepunten toe te passen
in de e-boek editor. Om dit te laten werken, mag u nooit bestanden direct in het bestandssysteem benaderen.
In plaats daarvan, gebruik raw_data() (pagina 367) of open() (pagina 366) om te lezen/schrĳven naar
onderdelen in het boek.

Bĳ converteren tussen hrefs en namen, gebruik de methodes voorzien in deze class, ze gaan ervan uit dat alle hrefs
tussen aanhalingstekens staan.
abspath_to_name(fullpath, root=None)

Converteer een absoluut pad naar een canonieke naam relatief ten opzichte van root

Parameters
root – De hoofdmap, Standaard wordt de root voor dit containerobject gebruikt.

add_file(name, data=b'', media_type=None, spine_index=None, modify_name_if_needed=False,
process_manifest_item=None, suggested_id='')

Bestand aan deze container toevoegen. Vermeldingen worden automatisch aangemaakt in het OPF manifest
en de spine (als het bestand een tekstdocument is)

add_name_to_manifest(name, process_manifest_item=None, suggested_id='')
Vermelding toevoegen aan het manifest voor een bestand met de gespecificeerde naam, Geeft het manifest
ID terug.
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add_properties(name, *properties)
De gespecificeerde eigenschappen toevoegen aan het manifest item geïdentificeerd bĳ naam.

apply_unique_properties(name, *properties)
Zorg ervoor dat de gespecificeerde eigenschappen enkel geplaatst zĳn op het manifest item geïdentificeerd
bĳ naam. U kan Geen doorgeven als naam om de eigenschap van alle items te verwĳderen.

book_type = 'oeb'

Het type boek (epub voor EPUB bestanden en azw3 voor AZW3 bestanden)
commit(outpath=None, keep_parsed=False)

Commit all dirtied parsed objects to the filesystem and write out the e-book file at outpath.
Parameters

• output – Het pad om het opgeslagen e-boekbestand naar toe te schrĳven. Indien Geen,
wordt het pad van het originele boekbestand gebruikt.

• keep_parsed – If True the parsed representations of committed items are kept in the cache.
commit_item(name, keep_parsed=False)

Commit a parsed object to disk (it is serialized and written to the underlying file). If keep_parsed is True
the parsed representation is retained in the cache. See also: parsed() (pagina 367)

dirty(name)
Mark the parsed object corresponding to name as dirty. See also: parsed() (pagina 367).

exists(name)
True iff a file/folder corresponding to the canonical name exists. Note that this function suffers from the
limitations of the underlying OS filesystem, in particular case (in)sensitivity. So on a case insensitive filesystem
this will return True even if the case of name is different from the case of the underlying filesystem file. See
also has_name() (pagina 365)

filesize(name)
Return the size in bytes of the file represented by the specified canonical name. Automatically handles dirtied
parsed objects. See also: parsed() (pagina 367)

generate_item(name, id_prefix=None, media_type=None, unique_href=True)
Add an item to the manifest with href derived from the given name. Ensures uniqueness of href and id
automatically. Returns generated item.

get_file_path_for_processing(name, allow_modification=True)
Similar to open() except that it returns a file path, instead of an open file object.

property guide_type_map

Mapping of guide type to canonical name
has_name(name)

Return True iff a file with the same canonical name as that specified exists. Unlike exists() (pagina 365)
this method is always case-sensitive.

href_to_name(href, base=None)
Convert an href (relative to base) to a name. base must be a name or None, in which case self.root is used.

insert_into_xml(parent, item, index=None)
Insert item into parent (or append if index is None), fixing indentation. Only works with self closing items.

is_dir = False

If this container represents an unzipped book (a directory)
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iterlinks(name, get_line_numbers=True)
Iterate over all links in name. If get_line_numbers is True the yields results of the form (link, line_number,
offset). Where line_number is the line_number at which the link occurs and offset is the number of characters
from the start of the line. Note that offset could actually encompass several lines if not zero.

make_name_unique(name)
Ensure that name does not already exist in this book. If it does, return a modified version that does not exist.

manifest_has_name(name)
Return True if the manifest has an entry corresponding to name

property manifest_id_map

Mapping of manifest id to canonical names
manifest_items_of_type(predicate)

The names of all manifest items whose media-type matches predicate. predicate can be a set, a list, a string
or a function taking a single argument, which will be called with the media-type.

manifest_items_with_property(property_name)
Alle manifest items die de gespecificeerde eigenschap hebben

property manifest_type_map

Mapping van manifest mediatype naar lĳst van canonieke namen van dat mediatype
property mi

De metadata van dit boek als een Metadata object. Merk op dat dit object on the fly wordt samengesteld elke
keer om deze eigenschap wordt gevraagd, zuinig gebruiken dus.

name_to_abspath(name)
Converteer een canonieke naam naar een absoluut OS afhankelĳk pad

name_to_href(name, base=None)
Converteer een naam naar een href relatief aan de basis, wat een naam moet zĳn of Geen in welk geval
self.root wordt gebruikt als basis.

property names_that_must_not_be_changed

Set namen die nooit hernoemd mag worden. Afhankelĳk van het e-boekbestandsformaat.
property names_that_must_not_be_removed

Set namen die nooit uit de container verwĳderd mag worden. Afhankelĳk van het e-boekbestandsformaat.
property names_that_need_not_be_manifested

Set namen die mag ontbreken in het manifest. Afhankelĳk van het e-boekbestandsformaat.
open(name, mode='rb')

Open het bĳ naam aangewezen bestand voor direct lezen/schrĳven. Merk op dat dit het bestand commit als
het vuil is en het uit de verwerkingscache verwĳderd. U moet dit bestand afwerken vooraleer de verwerkte
versie weer te betreden of er dreigt onheil.

property opf

Het verwerkte OPF bestand
opf_get_or_create(name)

Gemakzuchtige manier om ofwel terug te keren naar het eerste XML element met de gespecificeerde naam
of het te creëren onder het opf:package element en het dan terug te geven, als het al niet bestaat.

property opf_version

De versie ingesteld op de OPF’s <package> element
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property opf_version_parsed

De versie ingesteld op de OPF’s <package> element als een tupel van gehele getallen
opf_xpath(expr)

Gemakzuchtige manier om een XPath expressie te evalueren in het OPF bestand, heeft de opf: en dc: naam-
ruimte voorvoegsels voor-gedefinieerd.

parsed(name)
Return a parsed representation of the file specified by name. For HTML and XML files an lxml tree is retur-
ned. For CSS files a css_parser stylesheet is returned. Note that parsed objects are cached for performance.
If you make any changes to the parsed object, you must call dirty() (pagina 365) so that the container
knows to update the cache. See also replace() (pagina 367).

raw_data(name, decode=True, normalize_to_nfc=True)

Geef de rauwe data terug overeenkomstig met het bestand gespecificeerd bĳ naam
Parameters

• decode – Als Waar en het bestand heeft een tekst gebaseerd MIME type, decodeer het en
geef een Unicode object terug i.p.v. rauwe bytes.

• normalize_to_nfc – Als Waar is het teruggegeven Unicode object genormaliseerd volgens
de NFC vorm zoals vereist voor de EPUB en AZW3 bestandsformaten.

relpath(path, base=None)
Converteer een absoluut pad (met OS separators) naar een pad relatief naar basis (standaard naar self.root).
Het relatieve pad is geen naam. Gebruik daarvoor abspath_to_name() (pagina 364).

remove_from_spine(spine_items, remove_if_no_longer_in_spine=True)
Verwĳder de gespecificeerde items (per canonieke naam) uit de opbouw. Als remo-

ve_if_no_longer_in_spine Waar is, worden de items ook uit het boek verwĳderd, niet enkel uit
de opbouw.

remove_from_xml(item)
Verwĳdert item van ouder, inspringing herstellend ( werkt enkel met zelksluitende items)

remove_item(name, remove_from_guide=True)
Verwĳder het bĳ naam genoemde item uit deze container. Dit verwĳdert alle referenties naar het item in het
OPF manifest, gids en opbouw, zowel als elke interne cache.

rename(current_name, new_name)

Renames a file from current_name to new_name. It automatically rebases all links inside the file if the folder
the file is in changes. Note however, that links are not updated in the other files that could reference this file.
This is for performance, such updates should be done once, in bulk.

replace(name, obj)
Vervang het verwerkte object overeenkomend op naam met obj, wat een gelĳkaardig object moet zĳn, bv. een
lxml boom voor HTML/XML of een css_parser stĳlblad voor een CSS bestand.

replace_links(name, replace_func)
Replace all links in name using replace_func, which must be a callable that accepts a URL and returns the
replaced URL. It must also have a ‘replaced’ attribute that is set to True if any actual replacement is done.
Convenient ways of creating such callables are using the LinkReplacer and LinkRebaser classes.

serialize_item(name)

Converteer een verwerkt object (geïdentificeerd met canonieke naam) in een bytestring. Bekĳk parsed()

(pagina 367).
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set_spine(spine_items)
Set the spine to be spine_items where spine_items is an iterable of the form (name, linear). Will raise an error
if one of the names is not present in the manifest.

property spine_items

An iterator yielding the path for every item in the books’ spine. See also: spine_iter (pagina 368) and
spine_items (pagina 368).

property spine_iter

An iterator that yields item, name is_linear for every item in the books’ spine. item is the lxml element, name
is the canonical file name and is_linear is True if the item is linear. See also: spine_names (pagina 368)
and spine_items (pagina 368).

property spine_names

An iterator yielding name and is_linear for every item in the books’ spine. See also: spine_iter (pagina 368)
and spine_items (pagina 368).

Component bestanden in een container beheren
calibre.ebooks.oeb.polish.replace.replace_links(container, link_map, frag_map=<function

<lambda>>, replace_in_opf=False)
Vervang links naar bestanden in de container. Gaat over alle bestanden in de container en verandert de gespecifi-
ceerde links erin.

Parameters
• link_map – A mapping of old canonical name to new canonical name. For example:
{'images/old.png': 'images/new.png'}

• frag_map – A callable that takes two arguments (name, anchor) and returns a new anchor.
This is useful if you need to change the anchors in HTML files. By default, it does nothing.

• replace_in_opf – Indien Onwaar worden links in het OPF bestand niet vervangen.
calibre.ebooks.oeb.polish.replace.rename_files(container, file_map)

Hernoem bestanden in de container. update links naar hen automatisch.
Parameters

file_map – Mapping van oude canonieke namen naar nieuwe canonieke namen, bv. {'text/
chapter1.html': 'chapter1.html'}.

calibre.ebooks.oeb.polish.replace.get_recommended_folders(container, names)
Geef de mappen terug aanbevolen voor de gegeven bestandsnamen. De aanbeveling is gebaseerd op waar de meer-
derheid van bestanden van hetzelfde type staan in de container. Als geen bestanden van een bepaald type aanwezig
zĳn, wordt de aangewezen map veronderstelt de map te zĳn met het OPF bestand.

Netjes afdrukken en auto-herstellen verwerkingsfouten
calibre.ebooks.oeb.polish.pretty.fix_html(container, raw)

Herstel alle verwerkingsfouten in de HTML voorgesteld als een rauwe string. Herstellen wordt gedaan met het
HTML5 verwerkingsalgoritme.

calibre.ebooks.oeb.polish.pretty.fix_all_html(container)
Herstel alle verwerkingsfouten in alle HTML bestanden in de container. Herstellen wordt gedaan met het HTML5
verwerkingsalgoritme.

calibre.ebooks.oeb.polish.pretty.pretty_html(container, name, raw)
Druk de HTML voorgesteld als een string in rauw netjes af
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calibre.ebooks.oeb.polish.pretty.pretty_css(container, name, raw)
Druk de CSS voorgesteld als een string in rauw netjes af

calibre.ebooks.oeb.polish.pretty.pretty_xml(container, name, raw)
Druk de XML voorgesteld als een string in rauw netjes af. Als name de naam is van de OPF, extra OPF specifiek
netter maken is gedaan.

calibre.ebooks.oeb.polish.pretty.pretty_all(container)
Druk alle HTML/CSS/XML bestanden in de container netjes af

Boekomslagen beheren
calibre.ebooks.oeb.polish.jacket.remove_jacket(container)

Remove an existing jacket, if any. Returns False if no existing jacket was found.
calibre.ebooks.oeb.polish.jacket.add_or_replace_jacket(container)

Either create a new jacket from the book’s metadata or replace an existing jacket. Returns True if an existing jacket
was replaced.

Splitsen en samenvoegen van bestanden
calibre.ebooks.oeb.polish.split.split(container, name, loc_or_xpath, before=True, totals=None)

Split the file specified by name at the position specified by loc_or_xpath. Splitting automatically migrates all links
and references to the affected files.

Parameters
• loc_or_xpath – Should be an XPath expression such as //h:div[@id=”split_here”]. Can also

be a loc which is used internally to implement splitting in the preview panel.
• before – If True the split occurs before the identified element otherwise after it.
• totals – Intern gebruikt

calibre.ebooks.oeb.polish.split.multisplit(container, name, xpath, before=True)
Split the specified file at multiple locations (all tags that match the specified XPath expression). See also: split()
(pagina 369). Splitting automatically migrates all links and references to the affected files.

Parameters
before – If True the splits occur before the identified element otherwise after it.

calibre.ebooks.oeb.polish.split.merge(container, category, names, master)
Merge the specified files into a single file, automatically migrating all links and references to the affected files. The
file must all either be HTML or CSS files.

Parameters
• category – Must be either 'text' for HTML files or 'styles' for CSS files
• names – De lĳst van bestanden om samen te voegen
• master – Which of the merged files is the master file, that is, the file that will remain after

merging.

Omslagen beheren
calibre.ebooks.oeb.polish.cover.set_cover(container, cover_path, report=None, options=None)

Set the cover of the book to the image pointed to by cover_path.
Parameters
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• cover_path – Either the absolute path to an image file or the canonical name of an image in
the book. When using an image in the book, you must also set options, see below.

• report – An optional callable that takes a single argument. It will be called with information
about the tasks being processed.

• options – None or a dictionary that controls how the cover is set. The dictionary can ha-
ve entries: keep_aspect: True or False (Preserve aspect ratio of covers in EPUB) no_svg:
True or False (Use an SVG cover wrapper in the EPUB titlepage) existing: True or False
(cover_path refers to an existing image in the book)

calibre.ebooks.oeb.polish.cover.mark_as_cover(container, name)

Mark the specified image as the cover image.
calibre.ebooks.oeb.polish.cover.mark_as_titlepage(container, name, move_to_start=True)

Mark the specified HTML file as the titlepage of the EPUB.
Parameters

move_to_start – If True the HTML file is moved to the start of the spine

Werken met CSS
calibre.ebooks.oeb.polish.fonts.change_font(container, old_name, new_name=None)

Change a font family from old_name to new_name. Changes all occurrences of the font family in stylesheets, style
tags and style attributes. If the old_name refers to an embedded font, it is removed. You can set new_name to None
to remove the font family instead of changing it.

calibre.ebooks.oeb.polish.css.remove_unused_css(container, report=None,
remove_unused_classes=False, merge_rules=False,
merge_rules_with_identical_properties=False,
remove_unreferenced_sheets=False)

Remove all unused CSS rules from the book. An unused CSS rule is one that does not match any actual content.
Parameters

• report – An optional callable that takes a single argument. It is called with information about
the operations being performed.

• remove_unused_classes – If True, class attributes in the HTML that do not match any
CSS rules are also removed.

• merge_rules – If True, rules with identical selectors are merged.
• merge_rules_with_identical_properties – If True, rules with identical properties

are merged.
• remove_unreferenced_sheets – If True, stylesheets that are not referenced by any con-

tent are removed
calibre.ebooks.oeb.polish.css.filter_css(container, properties, names=())

Remove the specified CSS properties from all CSS rules in the book.
Parameters

• properties – Set of properties to remove. For example: {'font-family', 'color'}.
• names – The files from which to remove the properties. Defaults to all HTML and CSS files

in the book.
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Werken met de inhoudsopgave
calibre.ebooks.oeb.polish.toc.from_xpaths(container, xpaths, prefer_title=False)

Generate a Table of Contents from a list of XPath expressions. Each expression in the list corresponds to a level
of the generate ToC. For example: ['//h:h1', '//h:h2', '//h:h3'] will generate a three level Table of
Contents from the <h1>, <h2> and <h3> tags.

calibre.ebooks.oeb.polish.toc.from_links(container)

Generate a Table of Contents from links in the book.
calibre.ebooks.oeb.polish.toc.from_files(container)

Generate a Table of Contents from files in the book.
calibre.ebooks.oeb.polish.toc.create_inline_toc(container, title=None)

Create an inline (HTML) Table of Contents from an existing NCX Table of Contents.
Parameters

title – De titel voor deze inhoudsopgave.

Bewerken Boekhulpmiddel
class calibre.gui2.tweak_book.plugin.Tool

Basisklassen: object
The base class for individual tools in an Edit Book plugin. Useful members include:

• self.plugin: A reference to the calibre.customize.Plugin (pagina 258) object to which this tool
belongs.

• self. boss (pagina 371)
• self. gui (pagina 371)

Methods that must be overridden in sub classes:
• create_action() (pagina 372)
• register_shortcut() (pagina 371)

name = None

Set this to a unique name it will be used as a key
allowed_in_toolbar = True

If True the user can choose to place this tool in the plugins toolbar
allowed_in_menu = True

If True the user can choose to place this tool in the plugins menu
toolbar_button_popup_mode = 'delayed'

The popup mode for the menu (if any) of the toolbar button. Possible values are ‘delayed’, ‘instant’, ‘button’
property boss

The calibre.gui2.tweak_book.boss.Boss (pagina 372) object. Used to control the user interface.
property gui

The main window of the user interface
property current_container

Return the current calibre.ebooks.oeb.polish.container.Container (pagina 364) object that
represents the book being edited.
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register_shortcut(qaction, unique_name, default_keys=(), short_text=None, description=None,
**extra_data)

Register a keyboard shortcut that will trigger the specified qaction. This keyboard shortcut will become
automatically customizable by the user in the Keyboard shortcuts section of the editor preferences.

Parameters
• qaction – A QAction object, it will be triggered when the configured key combination is

pressed by the user.
• unique_name – A unique name for this shortcut/action. It will be used internally, it must

not be shared by any other actions in this plugin.
• default_keys – A list of the default keyboard shortcuts. If not specified no default

shortcuts will be set. If the shortcuts specified here conflict with either builtin short-
cuts or shortcuts from user configuration/other plugins, they will be ignored. In that ca-
se, users will have to configure the shortcuts manually via Preferences. For example: de-
fault_keys=('Ctrl+J', 'F9').

• short_text – An optional short description of this action. If not specified the text from
the QAction will be used.

• description – An optional longer description of this action, it will be used in the prefe-
rences entry for this shortcut.

create_action(for_toolbar=True)
Create a QAction that will be added to either the plugins toolbar or the plugins menu depending on
for_toolbar. For example:

def create_action(self, for_toolbar=True):

ac = QAction(get_icons('myicon.png'), 'Do something')

if for_toolbar:

# We want the toolbar button to have a popup menu

menu = QMenu()

ac.setMenu(menu)

menu.addAction('Do something else')

subaction = menu.addAction('And another')

# Register a keyboard shortcut for this toolbar action be

# careful to do this for only one of the toolbar action or

# the menu action, not both.

self.register_shortcut(ac, 'some-unique-name', default_keys=('Ctrl+K',

↪→))

return ac

Zie ook

Method register_shortcut() (pagina 371).

Controlling the editor’s user interface
The e-book editor’s user interface is controlled by a single global Boss object. This has many useful methods that can be
used in plugin code to perform common tasks.
class calibre.gui2.tweak_book.boss.Boss(parent, notify=None)
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add_savepoint(msg)
Create a restore checkpoint with the name specified as msg

apply_container_update_to_gui(mark_as_modified=True)

Update all the components of the user interface to reflect the latest data in the current book container.
Parameters

mark_as_modified – If True, the book will be marked as modified, so the user will be
prompted to save it when quitting.

close_editor(name)
Close the editor that is editing the file specified by name

commit_all_editors_to_container()

Commit any changes that the user has made to files open in editors to the container. You should call this
method before performing any actions on the current container

property currently_editing

Return the name of the file being edited currently or None if no file is being edited
edit_file(name, syntax=None, use_template=None)

Open het bestand op basis van naam in een beweker
Parameters

• syntax – The media type of the file, for example, 'text/html'. If not specified it is
guessed from the file extension.

• use_template – A template to initialize the opened editor with
open_book(path=None, edit_file=None, clear_notify_data=True, open_folder=False, search_text=None)

Open the e-book at path for editing. Will show an error if the e-book is not in a supported format or the
current book has unsaved changes.

Parameters
edit_file – The name of a file inside the newly opened book to start editing. Can also be a
list of names.

rewind_savepoint()

Undo the previous creation of a restore checkpoint, useful if you create a checkpoint, then abort the operation
with no changes

save_book()

Save the book. Saving is performed in the background
set_modified()

Boek markeren als bewerkt
show_current_diff(allow_revert=True, to_container=None)

Show the changes to the book from its last checkpointed state
Parameters

• allow_revert – If True the diff dialog will have a button to allow the user to revert all
changes

• to_container – A container object to compare the current container to. If None, the pre-
viously checkpointed container is used
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show_editor(name)
Show the editor that is editing the file specified by name

sync_preview_to_editor()

Sync the position of the preview panel to the current cursor position in the current editor
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Digital Rights Management (DRM)

Digital Rights Management (DRM) is een generische term voor toegangscontroletechnologieën die hardwarefabrikanten,
uitgevers, copyrighthouders en individuen kunnen gebruiken om te proberen beperkingen op te leggen op het gebruik
van digitale inhoud en toestellen. Het wordt ook, soms, neerbuigend beschreven als Digital Restrictions Management.
Het wordt gebruikt voor elke technologie die gebruik verhindert (gepast of anders) van digitale inhoud niet gewenst of
voorzien door de inhoudsleverancier. De term verwĳst normaal niet naar andere vormen van kopieerbeveiliging die kan
omzeild worden zonder het bestand of toestel te wĳzigen, zoals serienummers of sleutelbestanden. Het kan ook verwĳzen
naar beperkingen geassocieerd met bepaalde instanties van digitale werken of toestellen. DRM technologieën proberen het
gebruik van digitale media te controleren door toegang, kopiëren of converteren naar andere formaten door eindgebruikers
te voorkomen. Kĳk op Wikipedia124.

15.1 Wat betekent DRM voor mij persoonlijk?
Wanneer u een e-boek met DRM koopt, bezit u het niet echt, maar heeft u de toestemming gekocht om het te gebruiken
op een manier die de verkoper u heeft voorgeschreven. DRM beperkt wat u kunt doen met e-books die u heeft “gekocht”.
Vaak zĳn mensen die boeken met DRM kopen niet op de hoogte van de omvang van deze beperkingen. Deze beperkingen
voorkomen dat u het e-boek naar uw wens opnieuw formatteert, inclusief het aanbrengen van stilistische wĳzigingen
zoals het aanpassen van de lettergroottes, hoewel er software is die u in staat stelt dergelĳke dingen te doen voor niet-
DRM-boeken. Mensen zĳn vaak verbaasd dat een e-book dat ze in een bepaald formaat hebben gekocht niet kan worden
geconverteerd naar een ander formaat als het e-book DRM heeft. Dus als je een Amazon Kindle hebt en een boek koopt
dat door Barnes and Nobles wordt verkocht, moet je weten dat als dat e-boek DRM heeft, je het niet op je Kindle kunt
lezen. Merk op dat ik het heb over een boek dat je koopt, niet steelt of piraat maar KOOPT.

15.2 Wat doet DRM voor auteurs?
Uitgevers van DRMed-e-books beweren dat de DRM er alleen is voor de auteurs en om hun artistieke integriteit te
beschermen en piraterĳ te voorkomen. Maar DRM voorkomt piraterĳ NIET. Mensen die inhoud willen pirateren of
illegale inhoud willen gebruiken, doen het nog steeds en slagen daarin. De drie belangrĳkste DRM-schema’s voor e-books
van vandaag worden beheerd door Amazon, Adobe en Barnes en Noble en alle drie de DRM-schema’s zĳn gekraakt. Alles
wat DRM doet is het ongemak van legitieme gebruikers. Er kan worden beweerd dat het auteurs in feite schaadt, aangezien

124 https://en.wikipedia.org/wiki/Digital_rights_management
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mensen die het boek zouden hebben gekocht ervoor kiezen om een illegale versie te vinden, omdat ze niet bereid zĳn
om DRM te accepteren. Degenen die zouden piraten zonder DRM, doen dat ook in haar aanwezigheid. Nogmaals, het
belangrĳkste punt is dat DRM * piraterĳ * niet voorkomt. DRM is dus niet alleen zinloos en schadelĳk voor kopers van
e-books, maar ook geldverspilling.

15.3 DRM en vrijheid
Hoewel digitale inhoud zowel informatie als creatieve werken gemakkelĳk voor iedereen beschikbaar kan maken en de
mensheid kracht kan geven, is dit niet in het belang van sommige uitgevers die mensen van deze mogelĳkheid van vrĳheid
willen afhouden, simpelweg om hun relevantie te behouden in een wereld die zo snel ontwikkelt dat ze het niet kunnen
bĳhouden.

15.4 Waarom ondersteunt Calibre DRM niet?
calibre is open source software terwĳl DRM van nature gesloten is. Als calibre openen/bekĳken van DRM-bestanden
zou ondersteunen, kan het gemakkelĳk aangepast worden tot hulpmiddel voor het verwĳderen van DRM, illegaal volgens
huidige wetten. Open source software en DRM zĳn een botsing van principes. Bĳ DRM draait alles om het controleren
van de gebruiker, bĳ open source-software om het versterken van de gebruiker. De twee kunnen niet samen bestaan.

15.5 Wat is de mening van calibre over contentproviders?
We geloven vast dat auteurs en andere inhoudsleveranciers gecompenseerd moeten worden voor hun werk, maar DRM
is daar niet de manier voor. We ontwikkelen deze database met DRM-vrĳe e-boeken uit verschillende bronnen om u te
helpen DRM-vrĳe alternatieven te vinden en om onafhankelĳke auteurs en uitgevers van DRM-vrĳe e-boeken te helpen
hun inhoud te publiceren. We hopen dat u dit nuttig zult vinden en we verzoeken u de inhoud die u hier ter beschikking
wordt gesteld, niet te piraten.

15.6 Hoe kan ik DRM helpen bestrijden?
Als e-boek koper/lezer kan u helpen DRM te bestrĳden. Koop geen e-boeken met DRM. Er zĳn uitgevers die DRM vrĳe
e-boeken uitgeven. Doe een inspanning om te zien of zĳ het e-boek dat u zoekt, aanbieden. Houdt u van boeken van
bepaalde onafhankelĳke auteurs die DRM-vrĳe e-boeken verkopen, en het kan eraf, doe een donatie. Dit is goed besteed
geld omdat hun e-boeken meestal goedkoper zĳn (er zĳn uitzonderingen) dan wat u zou kopen van DRM boekenuitgevers
en werken waarschĳnlĳk op alle toestellen die u in de toekomst zal hebben, u de kost besparend ze terug te moeten kopen.
Ontmoedig geen uitgevers en auteurs van DRM-vrĳe boeken door hun inhoud te piraten. Inhoudsleveranciers verdienen
een vergoeding voor hun werk. Straf hen niet voor hun poging uw leeservaring beter te maken door het aanbieden van
DRM-vrĳe -boeken. Op de lande duur is dit nadelig voor u. Als u boeken heeft gekocht van verkopers die boeken met en
zonder DRM aanbieden, niet wetend of ze DRM aanbieden of niet, let erop een commentaar na te laten op hun site om
toekomstige klanten te informeren over hun DRM status. Veel verkopers vinden het niet belangrĳk om duidelĳk aan te
geven of een boek geDRMed is of niet. `Hier <https://www.defectivebydesign.org/guide/ebooks>`_vind u een gids voor
DRM-vrĳ leven.
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Woordenlĳst

RSS
RSS (Really Simple Syndication) is een web feed formaat gebruikt om vaak geüpdatete inhoud te publiceren, zoals
nieuwsartikelen, blogposts, enz. Het is een formaat dat bĳzonder geschikt is om door computers gelezen te worden
en dus de beste manier om inhoud van het web in een e-boek te krĳgen. Er zĳn veel andere feed formaten in
gebruik op het internet en calibre begrĳpt de meeste. Het heeft met name een goede ondersteuning voor het ATOM
formaat, vaak gebruikt voor blogs.

recept
Een recept is een reeks instructies dat calibre aanleert hoe het een online nieuwsbron, zoals een tĳdschrift of een
blog, omzet in een e-boek. Een recept is in hoofdzaak Python <https://www.python.org> _ code. Als zodanig is het
in staat willekeurig complexe nieuwsbronnen om te zetten in e-boeken. Op het eenvoudigste niveau is het slechts
een set variabelen, zoals URL’s, die calibre genoeg informatie geven om op het internet te gaan en het nieuws te
downloaden.

HTML
HTML (Hyper Text Mark-Up Language), een subset van Standard Generalized Mark-Up Language (SGML) voor
elektronische publicatie, is de standaard gebruikt op het World Wide Web.

CSS
CSS (Cascading Style Sheets) is een taal gebruikt om te beschrĳven hoe een HTML document moet worden weer-
gegeven (visuele weergave).

API
API (Application Programming Interface) is een broncode interface aangeboden door een bibliotheek om vragen
voor diensten van computerprogramma’s te ondersteunen.

LRF
LRF Het e-boek formaat gelezen door de SONY e-boek readers.

URL
URL (Uniform Resource Locator) bĳvoorbeeld: http://example.com

regexp
Reguliere expressies lever een bondige en flexibele manier om tekststrings of interest, zoals bepaalde karakters,
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woorden of karakterpatronen te identificeren. Kĳk op regexp syntax125 voor de syntax van reguliere expressies
gebruikt in Python.

125 https://docs.python.org/library/re.html
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calibredb-catalog command line option,
322

--get-cover

ebook-meta command line option, 338
--gui

calibre-debug command line option, 308
--gui-debug

calibre-debug command line option, 308
--header-note-source-field

calibredb-catalog command line option,
322

--help

calibre command line option, 306
calibre-customize command line option,

306
calibre-debug command line option, 308
calibre-server command line option, 310
calibre-smtp command line option, 313
command line option, 315
ebook-convert command line option, 328
ebook-edit command line option, 337
ebook-meta command line option, 338
ebook-polish command line option, 339
ebook-viewer command line option, 340
fetch-ebook-metadata command line opti-

on, 341
lrf2lrs command line option, 342
lrfviewer command line option, 342
lrs2lrf command line option, 343
web2disk command line option, 344

--html-unwrap-factor

ebook-convert command line option, 333
--identifier

calibredb-add command line option, 317
ebook-meta command line option, 338
fetch-ebook-metadata command line opti-

on, 341
--ids

calibredb-catalog command line option,
320

--ignore

calibredb-add command line option, 318
--ignore_extensions

calibredb-check_library command line

option, 324
--ignore_names

calibredb-check_library command line

option, 324
--ignore-plugins

calibre command line option, 306
--ignored-fields

calibre-server command line option, 310
--implode-book

calibre-debug command line option, 308
--import-calibre-data

calibre-debug command line option, 308
--include-snippets

calibredb-fts_search command line opti-

on, 327
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--index

ebook-meta command line option, 338
--indexing-speed

calibredb-fts_index command line option,
326

--indexing-threshold

calibredb-fts_search command line opti-

on, 327
--input-encoding

ebook-convert command line option, 329
--input-profile

ebook-convert command line option, 328
--insert-blank-line

ebook-convert command line option, 331
--insert-blank-line-size

ebook-convert command line option, 331
--insert-metadata

ebook-convert command line option, 334
--inspect-mobi

calibre-debug command line option, 308
--is-multiple

calibredb-add_custom_column command li-

ne option, 323
--isbn

calibredb-add command line option, 317
ebook-convert command line option, 335
ebook-meta command line option, 338
fetch-ebook-metadata command line opti-

on, 341
--item_count

calibredb-list_categories command line

option, 325
--jacket

ebook-polish command line option, 339
--keep-ligatures

ebook-convert command line option, 331
--kepubify

calibre-debug command line option, 308
--language

ebook-convert command line option, 335
ebook-meta command line option, 338

--languages

calibredb-add command line option, 317
--level1-toc

ebook-convert command line option, 335
--level2-toc

ebook-convert command line option, 335
--level3-toc

ebook-convert command line option, 335
--library-path

command line option, 315
--limit

calibredb-list command line option, 316
calibredb-search command line option, 326

--line-height

ebook-convert command line option, 331
--line-width

calibredb-list command line option, 316
--linearize-tables

ebook-convert command line option, 331
--list-fields

calibredb-set_metadata command line op-

tion, 319
--list-plugins

calibre-customize command line option,
307

--list-recipes

ebook-convert command line option, 328
--listen-on

calibre-server command line option, 311
--localhost

calibre-smtp command line option, 313
--log

calibre-server command line option, 311
--lrf-bookid

ebook-meta command line option, 338
--lrs

lrs2lrf command line option, 343
--manage-users

calibre-server command line option, 311
--margin-bottom

ebook-convert command line option, 331
--margin-left

ebook-convert command line option, 331
--margin-right

ebook-convert command line option, 331
--margin-top

ebook-convert command line option, 331
--match-end-marker

calibredb-fts_search command line opti-

on, 327
--match-regexp

web2disk command line option, 344
--match-start-marker

calibredb-fts_search command line opti-

on, 327
--max-files

web2disk command line option, 344
--max-header-line-size

calibre-server command line option, 311
--max-job-time

calibre-server command line option, 311
--max-jobs

calibre-server command line option, 311
--max-log-size

calibre-server command line option, 311
--max-opds-items

calibre-server command line option, 311
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calibre-server command line option, 311
--max-recursions

web2disk command line option, 344
--max-request-body-size

calibre-server command line option, 311
--max-toc-links

ebook-convert command line option, 335
--merge-comments-rule

calibredb-catalog command line option,
322

--minimum-line-height

ebook-convert command line option, 332
--new-instance

ebook-viewer command line option, 340
--no-chapters-in-toc

ebook-convert command line option, 335
--no-default-epub-cover

ebook-convert command line option, 329
--no-svg-cover

ebook-convert command line option, 329
--no-update-check

calibre command line option, 306
--num-per-page

calibre-server command line option, 311
--one-book-per-directory

calibredb-add command line option, 318
--only-formats

calibredb-embed_metadata command line

option, 326
--open-at

ebook-viewer command line option, 341
--opf

ebook-polish command line option, 339
fetch-ebook-metadata command line opti-

on, 341
--outbox

calibre-smtp command line option, 313
--output

lrf2lrs command line option, 342
lrs2lrf command line option, 343

--output-format

calibredb-fts_search command line opti-

on, 327
--output-profile

calibredb-catalog command line option,
322

ebook-convert command line option, 328
--page-breaks-before

ebook-convert command line option, 334
--password

calibre-smtp command line option, 313
command line option, 315

--paths

calibre-debug command line option, 308
--permanent

calibredb-remove command line option, 318
--pidfile

calibre-server command line option, 311
--port

calibre-server command line option, 311
calibre-smtp command line option, 313

--prefer-metadata-cover

ebook-convert command line option, 334
--prefix

calibredb-list command line option, 316
--prefix-rules

calibredb-catalog command line option,
322

--preserve-cover-aspect-ratio

ebook-convert command line option, 330
--preset

calibredb-catalog command line option,
322

--pretty-print

ebook-convert command line option, 330
--profile

lrfviewer command line option, 342
--progress

calibredb-export command line option, 320
--pubdate

ebook-convert command line option, 336
--publisher

ebook-convert command line option, 336
ebook-meta command line option, 338

--raise-window

ebook-viewer command line option, 341
--rating

ebook-convert command line option, 336
ebook-meta command line option, 338

--read-metadata-from-opf

ebook-convert command line option, 336
--really-do-it

calibredb-restore_database command line

option, 324
--recurse

calibredb-add command line option, 318
--relay

calibre-smtp command line option, 313
--remove-first-image

ebook-convert command line option, 334
--remove-jacket

ebook-polish command line option, 339
--remove-paragraph-spacing

ebook-convert command line option, 332
--remove-paragraph-spacing-indent-size

ebook-convert command line option, 332
--remove-plugin
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calibre-customize command line option,
307

--remove-soft-hyphens

ebook-polish command line option, 339
--remove-unused-css

ebook-polish command line option, 339
--replace-scene-breaks

ebook-convert command line option, 333
--replace-whitespace

calibredb-export command line option, 320
--report

calibredb-check_library command line

option, 324
--restrict-to

calibredb-fts_search command line opti-

on, 327
--run-plugin

calibre-debug command line option, 308
--run-test

calibre-debug command line option, 308
--run-without-debug

calibre-debug command line option, 308
--search

calibredb-catalog command line option,
321

calibredb-list command line option, 316
--search-replace

ebook-convert command line option, 333
--search-the-net-urls

calibre-server command line option, 311
--select-text

ebook-edit command line option, 337
--separator

calibredb-list command line option, 316
--series

calibredb-add command line option, 317
ebook-convert command line option, 336
ebook-meta command line option, 338

--series-index

calibredb-add command line option, 317
ebook-convert command line option, 336

--shutdown-running-calibre

calibre command line option, 306
calibre-debug command line option, 308

--shutdown-timeout

calibre-server command line option, 312
--single-dir

calibredb-export command line option, 320
--smarten-punctuation

ebook-convert command line option, 332
ebook-polish command line option, 340

--sort-by

calibredb-list command line option, 316
--sr1-replace

ebook-convert command line option, 333
--sr1-search

ebook-convert command line option, 333
--sr2-replace

ebook-convert command line option, 333
--sr2-search

ebook-convert command line option, 333
--sr3-replace

ebook-convert command line option, 333
--sr3-search

ebook-convert command line option, 333
--ssl-certfile

calibre-server command line option, 312
--ssl-keyfile

calibre-server command line option, 312
--start-in-tray

calibre command line option, 306
--start-reading-at

ebook-convert command line option, 334
--subject

calibre-smtp command line option, 313
--subset-embedded-fonts

ebook-convert command line option, 332
--subset-font

calibre-debug command line option, 309
--subset-fonts

ebook-polish command line option, 340
--tags

calibredb-add command line option, 317
ebook-convert command line option, 336
ebook-meta command line option, 338

--template

calibredb-export command line option, 320
calibredb-list command line option, 316

--template_file

calibredb-list command line option, 316
--template_heading

calibredb-list command line option, 316
--test-build

calibre-debug command line option, 309
--thumb-width

calibredb-catalog command line option,
322

--timefmt

calibredb-export command line option, 320
--timeout

calibre-server command line option, 312
calibre-smtp command line option, 313
command line option, 315
fetch-ebook-metadata command line opti-

on, 341
web2disk command line option, 344

--timestamp

ebook-convert command line option, 336
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--title

calibredb-add command line option, 317
ebook-convert command line option, 336
ebook-meta command line option, 338
fetch-ebook-metadata command line opti-

on, 341
--title-sort

ebook-convert command line option, 336
ebook-meta command line option, 338

--to-dir

calibredb-export command line option, 320
--to-lowercase

calibredb-export command line option, 320
--to-opf

ebook-meta command line option, 338
--toc-filter

ebook-convert command line option, 335
--toc-threshold

ebook-convert command line option, 335
--toc-title

ebook-convert command line option, 330
--transform-css-rules

ebook-convert command line option, 332
--transform-html-rules

ebook-convert command line option, 332
--trusted-ips

calibre-server command line option, 312
--un-kepubify

calibre-debug command line option, 309
--unsmarten-punctuation

ebook-convert command line option, 332
--upgrade-book

ebook-polish command line option, 340
--url-prefix

calibre-server command line option, 312
--use-auto-toc

ebook-convert command line option, 335
--use-existing-cover

calibredb-catalog command line option,
322

--userdb

calibre-server command line option, 312
--username

calibre-smtp command line option, 314
command line option, 315

--vacuum-fts-db

calibredb-check_library command line

option, 324
--verbose

calibre command line option, 306
calibre-smtp command line option, 313
calibredb-catalog command line option,

321
ebook-convert command line option, 336

ebook-polish command line option, 340
fetch-ebook-metadata command line opti-

on, 342
lrf2lrs command line option, 342
lrfviewer command line option, 342
lrs2lrf command line option, 343
web2disk command line option, 344

--version

calibre command line option, 306
calibre-customize command line option,

307
calibre-debug command line option, 309
calibre-server command line option, 312
calibre-smtp command line option, 313
command line option, 315
ebook-convert command line option, 328
ebook-edit command line option, 337
ebook-meta command line option, 338
ebook-polish command line option, 340
ebook-viewer command line option, 341
fetch-ebook-metadata command line opti-

on, 342
lrf2lrs command line option, 342
lrfviewer command line option, 343
lrs2lrf command line option, 343
web2disk command line option, 344

--viewer

calibre-debug command line option, 309
--visual-debug

lrfviewer command line option, 343
--wait-for-completion

calibredb-fts_index command line option,
327

--white-background

lrfviewer command line option, 343
--width

calibredb-list_categories command line

option, 325
--with-library

calibre command line option, 306
command line option, 315

--worker-count

calibre-server command line option, 312
-a

calibre-customize command line option,
306

calibre-smtp command line option, 313
calibredb-add command line option, 317
calibredb-set_custom command line opti-

on, 324
ebook-meta command line option, 337
fetch-ebook-metadata command line opti-

on, 341
-b
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calibre-customize command line option,
306

-c

calibre-debug command line option, 307
calibredb-add command line option, 317
calibredb-check_library command line

option, 324
calibredb-list_categories command line

option, 325
ebook-meta command line option, 337
ebook-polish command line option, 339
fetch-ebook-metadata command line opti-

on, 341
-d

calibre-debug command line option, 307
calibredb-add command line option, 317
calibredb-custom_columns command line

option, 323
ebook-convert command line option, 336
ebook-meta command line option, 337
ebook-polish command line option, 339
fetch-ebook-metadata command line opti-

on, 341
web2disk command line option, 343

-e

calibre-debug command line option, 307
calibre-smtp command line option, 313
calibredb-add command line option, 317
calibredb-check_library command line

option, 324
ebook-polish command line option, 339

-f

calibre-debug command line option, 309
calibre-smtp command line option, 313
calibredb-embed_metadata command line

option, 326
calibredb-list command line option, 316
calibredb-remove_custom_column command

line option, 323
calibredb-set_metadata command line op-

tion, 319
ebook-polish command line option, 340
ebook-viewer command line option, 340

-g

calibre-debug command line option, 308
-h

calibre command line option, 306
calibre-customize command line option,

306
calibre-debug command line option, 308
calibre-server command line option, 310
calibre-smtp command line option, 313
command line option, 315
ebook-convert command line option, 328

ebook-edit command line option, 337
ebook-meta command line option, 338
ebook-polish command line option, 339
ebook-viewer command line option, 340
fetch-ebook-metadata command line opti-

on, 341
lrf2lrs command line option, 342
lrfviewer command line option, 342
lrs2lrf command line option, 343
web2disk command line option, 344

-i

calibre-debug command line option, 308
calibredb-add command line option, 317
calibredb-catalog command line option,

320
calibredb-list_categories command line

option, 325
ebook-meta command line option, 338
ebook-polish command line option, 339
fetch-ebook-metadata command line opti-

on, 341
-j

ebook-polish command line option, 339
-k

ebook-meta command line option, 337
-l

calibre-customize command line option,
307

calibre-smtp command line option, 313
calibredb-add command line option, 317
calibredb-search command line option, 326
calibredb-set_metadata command line op-

tion, 319
ebook-meta command line option, 338

-m

calibre-debug command line option, 308
calibredb-add command line option, 317
ebook-convert command line option, 336

-n

calibredb-check_library command line

option, 324
web2disk command line option, 344

-o

calibre-smtp command line option, 313
ebook-polish command line option, 339
fetch-ebook-metadata command line opti-

on, 341
lrf2lrs command line option, 342
lrs2lrf command line option, 343

-p

calibre-smtp command line option, 313
ebook-meta command line option, 338
ebook-polish command line option, 340
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fetch-ebook-metadata command line opti-

on, 341
-r

calibre-customize command line option,
307

calibre-debug command line option, 308
calibre-smtp command line option, 313
calibredb-add command line option, 318
calibredb-check_library command line

option, 324
calibredb-list_categories command line

option, 325
calibredb-restore_database command line

option, 324
ebook-meta command line option, 338
web2disk command line option, 344

-s

calibre command line option, 306
calibre-debug command line option, 308
calibre-smtp command line option, 313
calibredb-add command line option, 317
calibredb-catalog command line option,

321
calibredb-list command line option, 316
ebook-meta command line option, 338

-t

calibre-debug command line option, 308
calibre-smtp command line option, 313
calibredb-add command line option, 317
calibredb-list command line option, 316
ebook-meta command line option, 338
fetch-ebook-metadata command line opti-

on, 341
web2disk command line option, 344

-u

calibre-smtp command line option, 314
ebook-polish command line option, 339

-v

calibre command line option, 306
calibre-smtp command line option, 313
calibredb-catalog command line option,

321
ebook-convert command line option, 336
fetch-ebook-metadata command line opti-

on, 342
-w

calibre-debug command line option, 309
calibredb-list command line option, 316
calibredb-list_categories command line

option, 325
-x

calibre-debug command line option, 307

A
abort_article() (calib-

re.web.feeds.news.BasicNewsRecipe methode),
42

abort_recipe_processing() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
42

abspath_to_name() (calib-
re.ebooks.oeb.polish.container.Container me-
thode), 364

accept_drag_move_event() (calib-
re.gui2.actions.InterfaceAction methode), 285

accept_enter_event() (calib-
re.gui2.actions.InterfaceAction methode), 284

accepts_drops (calibre.gui2.actions.InterfaceAction at-
tribuut), 284

action_add_menu (calibre.gui2.actions.InterfaceAction
attribuut), 284

action_menu_clone_qaction (calib-
re.gui2.actions.InterfaceAction attribuut),
284

action_shortcut_name (calib-
re.gui2.actions.InterfaceAction attribuut),
284

action_spec (calibre.gui2.actions.InterfaceAction attri-
buut), 284

action_type (calibre.gui2.actions.InterfaceAction attri-
buut), 284

add_annotation_to_library() (calib-
re.devices.usbms.device.Device methode),
281

add_book() (calibre.devices.interface.BookList methode),
277

add_books() (calibre.db.cache.Cache methode), 354
add_books_to_metadata() (calib-

re.devices.interface.DevicePlugin klassemethode),
274

add_books_to_metadata() (calib-
re.devices.usbms.driver.USBMS methode),
282

add_custom_book_data() (calibre.db.cache.Cache me-
thode), 354

add_extra_files() (calibre.db.cache.Cache methode),
354

add_file() (calibre.ebooks.oeb.polish.container.Container
methode), 364

add_format() (calibre.db.cache.Cache methode), 354
add_listener() (calibre.db.cache.Cache methode), 355
add_name_to_manifest() (calib-

re.ebooks.oeb.polish.container.Container me-
thode), 364

add_notes_resource() (calibre.db.cache.Cache me-
thode), 355

add_or_replace_jacket() (in module calib-
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re.ebooks.oeb.polish.jacket), 369
add_properties() (calib-

re.ebooks.oeb.polish.container.Container me-
thode), 364

add_savepoint() (calibre.gui2.tweak_book.boss.Boss
methode), 372

add_toc_thumbnail() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
42

adeify_images() (calib-
re.web.feeds.news.BasicNewsRecipe klasse-
methode), 41

all_annotation_types() (calibre.db.cache.Cache me-
thode), 355

all_annotation_users() (calibre.db.cache.Cache me-
thode), 355

all_annotations() (calibre.db.cache.Cache methode),
355

all_annotations_for_book() (calib-
re.db.cache.Cache methode), 355

all_book_ids() (calibre.db.cache.Cache methode), 355
all_field_for() (calibre.db.cache.Cache methode),

355
all_field_ids() (calibre.db.cache.Cache methode),

355
all_field_keys() (calib-

re.ebooks.metadata.book.base.Metadata me-
thode), 212

all_field_names() (calibre.db.cache.Cache methode),
355

all_non_none_fields() (calib-
re.ebooks.metadata.book.base.Metadata me-
thode), 212

allowed_in_menu (calibre.gui2.tweak_book.plugin.Tool
attribuut), 371

allowed_in_toolbar (calib-
re.gui2.tweak_book.plugin.Tool attribuut),
371

annotation_count_for_book() (calib-
re.db.cache.Cache methode), 355

annotations_map_for_book() (calib-
re.db.cache.Cache methode), 355

API, 377
apply_container_update_to_gui() (calib-

re.gui2.tweak_book.boss.Boss methode), 373
apply_unique_properties() (calib-

re.ebooks.oeb.polish.container.Container me-
thode), 365

articles_are_obfuscated (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
46

ASK_TO_ALLOW_CONNECT (calib-
re.devices.interface.DevicePlugin attribuut),
271

author (calibre.customize.InterfaceActionBase attribuut),
286

author (calibre.customize.MetadataReaderPlugin attri-
buut), 262

author (calibre.customize.MetadataWriterPlugin attri-
buut), 263

author (calibre.customize.Plugin attribuut), 258
author (calibre.customize.PreferencesPlugin attribuut),

287
author (calibre.devices.usbms.driver.USBMS attribuut),

281
author (calibre.ebooks.metadata.sources.base.Source at-

tribuut), 264
author_data() (calibre.db.cache.Cache methode), 355
author_sort_from_authors() (calib-

re.db.cache.Cache methode), 355
auto_cleanup (calibre.web.feeds.news.BasicNewsRecipe

attribuut), 46
auto_cleanup_keep (calib-

re.web.feeds.news.BasicNewsRecipe attribuut),
46

auto_repeat (calibre.gui2.actions.InterfaceAction attri-
buut), 284

auto_trim_covers (calib-
re.ebooks.metadata.sources.base.Source at-
tribuut), 264

B
BasicNewsRecipe (klasse in calibre.web.feeds.news), 41
BCD (calibre.devices.interface.DevicePlugin attribuut), 270
BCD (calibre.devices.usbms.device.Device attribuut), 279
bevat(), 161
book_class (calibre.devices.usbms.driver.USBMS attri-

buut), 281
book_created (calibre.db.cache.Cache.EventType attri-

buut), 353
book_edited (calibre.db.cache.Cache.EventType attri-

buut), 353
book_type (calibre.ebooks.oeb.polish.container.Container

attribuut), 365
BookList (klasse in calibre.devices.interface), 277
booklist_class (calibre.devices.usbms.driver.USBMS

attribuut), 281
books() (calibre.devices.interface.DevicePlugin methode),

274
books() (calibre.devices.usbms.driver.USBMS methode),

282
books_for_field() (calibre.db.cache.Cache methode),

355
books_in_virtual_library() (calib-

re.db.cache.Cache methode), 356
books_removed (calibre.db.cache.Cache.EventType attri-

buut), 353
boss (calibre.gui2.tweak_book.plugin.Tool property), 371
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Boss (klasse in calibre.gui2.tweak_book.boss), 372
browser_type (calibre.web.feeds.news.BasicNewsRecipe

attribuut), 46
BuiltinAdd (klasse in calibre.utils.formatter_functions),
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BuiltinAnd (klasse in calibre.utils.formatter_functions),
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BuiltinAnnotationCount (klasse in calib-

re.utils.formatter_functions), 195
BuiltinApproximateFormats (klasse in calib-

re.utils.formatter_functions), 195
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re.utils.formatter_functions), 204
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re.utils.formatter_functions), 195
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re.utils.formatter_functions), 195
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re.utils.formatter_functions), 188
BuiltinBooksize (klasse in calib-

re.utils.formatter_functions), 195
BuiltinBookValues (klasse in calib-

re.utils.formatter_functions), 188
BuiltinCapitalize (klasse in calib-

re.utils.formatter_functions), 187
BuiltinCeiling (klasse in calib-

re.utils.formatter_functions), 186
BuiltinCharacter (klasse in calib-

re.utils.formatter_functions), 207
BuiltinCheckYesNo (klasse in calib-

re.utils.formatter_functions), 207
BuiltinCmp (klasse in calibre.utils.formatter_functions),

206
BuiltinConnectedDeviceName (klasse in calib-

re.utils.formatter_functions), 196
BuiltinConnectedDeviceUUID (klasse in calib-

re.utils.formatter_functions), 196
BuiltinContains (klasse in calib-

re.utils.formatter_functions), 207
BuiltinCount (klasse in calib-

re.utils.formatter_functions), 201
BuiltinCurrentLibraryName (klasse in calib-

re.utils.formatter_functions), 196
BuiltinCurrentLibraryPath (klasse in calib-

re.utils.formatter_functions), 196
BuiltinCurrentVirtualLibraryName (klasse in cali-

bre.utils.formatter_functions), 196
BuiltinDateArithmetic (klasse in calib-

re.utils.formatter_functions), 191
BuiltinDaysBetween (klasse in calib-

re.utils.formatter_functions), 191
BuiltinDivide (klasse in calib-

re.utils.formatter_functions), 186
BuiltinEncodeForURL (klasse in calib-

re.utils.formatter_functions), 209
BuiltinEval (klasse in calibre.utils.formatter_functions),

205
BuiltinExtraFileModtime (klasse in calib-

re.utils.formatter_functions), 189
BuiltinExtraFileNames (klasse in calib-

re.utils.formatter_functions), 189
BuiltinExtraFileSize (klasse in calib-

re.utils.formatter_functions), 189
BuiltinField (klasse in calib-

re.utils.formatter_functions), 196
BuiltinFieldExists (klasse in calib-

re.utils.formatter_functions), 207
BuiltinFieldListCount (klasse in calib-

re.utils.formatter_functions), 201
BuiltinFinishFormatting (klasse in calib-

re.utils.formatter_functions), 191
BuiltinFirstMatchingCmp (klasse in calib-

re.utils.formatter_functions), 206
BuiltinFirstNonEmpty (klasse in calib-

re.utils.formatter_functions), 199
BuiltinFloor (klasse in calib-

re.utils.formatter_functions), 186
BuiltinFormatDate (klasse in calib-

re.utils.formatter_functions), 192
BuiltinFormatDateField (klasse in calib-

re.utils.formatter_functions), 193
BuiltinFormatDuration (klasse in calib-

re.utils.formatter_functions), 193
BuiltinFormatNumber (klasse in calib-

re.utils.formatter_functions), 194
BuiltinFormatsModtimes (klasse in calib-

re.utils.formatter_functions), 196
BuiltinFormatsPaths (klasse in calib-

re.utils.formatter_functions), 197
BuiltinFormatsPathSegments (klasse in calib-

re.utils.formatter_functions), 197
BuiltinFormatsSizes (klasse in calib-

re.utils.formatter_functions), 197
BuiltinFractionalPart (klasse in calib-

re.utils.formatter_functions), 186
BuiltinGetLink (klasse in calib-

re.utils.formatter_functions), 189
BuiltinGetNote (klasse in calib-

re.utils.formatter_functions), 190
BuiltinGlobals (klasse in calib-

re.utils.formatter_functions), 205
BuiltinHasCover (klasse in calib-

re.utils.formatter_functions), 198
BuiltinHasExtraFiles (klasse in calib-

re.utils.formatter_functions), 190
BuiltinHasNote (klasse in calib-
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re.utils.formatter_functions), 190
BuiltinHumanReadable (klasse in calib-

re.utils.formatter_functions), 194
BuiltinIdentifierInList (klasse in calib-

re.utils.formatter_functions), 200
BuiltinIfempty (klasse in calib-

re.utils.formatter_functions), 207
BuiltinInList (klasse in calib-

re.utils.formatter_functions), 200
BuiltinIsDarkMode (klasse in calib-

re.utils.formatter_functions), 205
BuiltinIsMarked (klasse in calib-

re.utils.formatter_functions), 198
BuiltinLanguageCodes (klasse in calib-

re.utils.formatter_functions), 198
BuiltinLanguageStrings (klasse in calib-

re.utils.formatter_functions), 198
BuiltinListCountMatching (klasse in calib-

re.utils.formatter_functions), 201
BuiltinListDifference (klasse in calib-

re.utils.formatter_functions), 201
BuiltinListEquals (klasse in calib-

re.utils.formatter_functions), 201
BuiltinListIntersection (klasse in calib-

re.utils.formatter_functions), 201
BuiltinListitem (klasse in calib-

re.utils.formatter_functions), 200
BuiltinListJoin (klasse in calib-

re.utils.formatter_functions), 202
BuiltinListRe (klasse in calib-

re.utils.formatter_functions), 202
BuiltinListReGroup (klasse in calib-

re.utils.formatter_functions), 202
BuiltinListRemoveDuplicates (klasse in calib-

re.utils.formatter_functions), 202
BuiltinListSort (klasse in calib-

re.utils.formatter_functions), 203
BuiltinListSplit (klasse in calib-

re.utils.formatter_functions), 203
BuiltinListUnion (klasse in calib-

re.utils.formatter_functions), 203
BuiltinLookup (klasse in calib-

re.utils.formatter_functions), 199
BuiltinLowercase (klasse in calib-

re.utils.formatter_functions), 187
BuiltinMakeUrl (klasse in calib-

re.utils.formatter_functions), 209
BuiltinMakeUrlExtended (klasse in calib-

re.utils.formatter_functions), 210
BuiltinMod (klasse in calibre.utils.formatter_functions),

186
BuiltinMultiply (klasse in calib-

re.utils.formatter_functions), 186
BuiltinNot (klasse in calibre.utils.formatter_functions),

187
BuiltinOndevice (klasse in calib-

re.utils.formatter_functions), 198
BuiltinOr (klasse in calibre.utils.formatter_functions),

187
BuiltinPrint (klasse in calib-

re.utils.formatter_functions), 205
BuiltinQueryString (klasse in calib-

re.utils.formatter_functions), 211
BuiltinRange (klasse in calib-

re.utils.formatter_functions), 203
BuiltinRatingToStars (klasse in calib-

re.utils.formatter_functions), 194
BuiltinRawField (klasse in calib-

re.utils.formatter_functions), 198
BuiltinRawList (klasse in calib-

re.utils.formatter_functions), 198
BuiltinRe (klasse in calibre.utils.formatter_functions),

207
BuiltinReGroup (klasse in calib-

re.utils.formatter_functions), 208
BuiltinRound (klasse in calib-

re.utils.formatter_functions), 186
BuiltinSelect (klasse in calib-

re.utils.formatter_functions), 200
BuiltinSeriesSort (klasse in calib-

re.utils.formatter_functions), 199
BuiltinSetGlobals (klasse in calib-

re.utils.formatter_functions), 205
BuiltinShorten (klasse in calib-

re.utils.formatter_functions), 208
BuiltinStrcat (klasse in calib-

re.utils.formatter_functions), 208
BuiltinStrcatMax (klasse in calib-

re.utils.formatter_functions), 208
BuiltinStrcmp (klasse in calib-

re.utils.formatter_functions), 206
BuiltinStrcmpcase (klasse in calib-

re.utils.formatter_functions), 206
BuiltinStrInList (klasse in calib-

re.utils.formatter_functions), 200
BuiltinStrlen (klasse in calib-

re.utils.formatter_functions), 208
BuiltinSubitems (klasse in calib-

re.utils.formatter_functions), 204
BuiltinSublist (klasse in calib-

re.utils.formatter_functions), 204
BuiltinSubstr (klasse in calib-

re.utils.formatter_functions), 208
BuiltinSubtract (klasse in calib-

re.utils.formatter_functions), 187
BuiltinSwapAroundArticles (klasse in calib-

re.utils.formatter_functions), 209
BuiltinSwapAroundComma (klasse in calib-
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re.utils.formatter_functions), 209
BuiltinSwitch (klasse in calib-

re.utils.formatter_functions), 199
BuiltinSwitchIf (klasse in calib-

re.utils.formatter_functions), 199
BuiltinTemplate (klasse in calib-

re.utils.formatter_functions), 206
BuiltinTest (klasse in calibre.utils.formatter_functions),

209
BuiltinTitlecase (klasse in calib-

re.utils.formatter_functions), 187
BuiltinToday (klasse in calib-

re.utils.formatter_functions), 191
BuiltinToHex (klasse in calib-

re.utils.formatter_functions), 211
BuiltinTransliterate (klasse in calib-

re.utils.formatter_functions), 209
BuiltinUppercase (klasse in calib-

re.utils.formatter_functions), 188
BuiltinUrlsFromIdentifiers (klasse in calib-

re.utils.formatter_functions), 211
BuiltinUserCategories (klasse in calib-

re.utils.formatter_functions), 199
BuiltinVirtualLibraries (klasse in calib-

re.utils.formatter_functions), 199

C
Cache (klasse in calibre.db.cache), 353
Cache.EventType (klasse in calibre.db.cache), 353
cached_cover_url_is_reliable (calib-

re.ebooks.metadata.sources.base.Source at-
tribuut), 264

calibre command line option

--detach, 306
--help, 306
--ignore-plugins, 306
--no-update-check, 306
--shutdown-running-calibre, 306
--start-in-tray, 306
--verbose, 306
--version, 306
--with-library, 306
-h, 306
-s, 306
-v, 306

calibre.customize

module, 258
calibre.customize.conversion

module, 267
calibre.db.cache

module, 353
calibre.devices.interface

module, 270
calibre.ebooks.metadata.book.base

module, 212
calibre.ebooks.metadata.sources.base

module, 264
calibre.ebooks.oeb.polish.container

module, 364
calibre.ebooks.oeb.polish.cover

module, 369
calibre.ebooks.oeb.polish.css

module, 370
calibre.ebooks.oeb.polish.jacket

module, 369
calibre.ebooks.oeb.polish.pretty

module, 368
calibre.ebooks.oeb.polish.replace

module, 368
calibre.ebooks.oeb.polish.split

module, 369
calibre.ebooks.oeb.polish.toc

module, 371
calibre.gui2.tweak_book.boss

module, 372
calibre.utils.formatter_functions

module, 185
calibre.web.feeds.news

module, 41
calibre-customize command line option

--add-plugin, 306
--build-plugin, 306
--customize-plugin, 306
--disable-plugin, 306
--enable-plugin, 306
--help, 306
--list-plugins, 307
--remove-plugin, 307
--version, 307
-a, 306
-b, 306
-h, 306
-l, 307
-r, 307

calibre-debug command line option

--add-simple-plugin, 307
--command, 307
--debug-device-driver, 307
--default-programs, 307
--diff, 307
--edit-book, 307
--exec-file, 307
--explode-book, 307
--export-all-calibre-data, 308
--gui, 308
--gui-debug, 308
--help, 308
--implode-book, 308
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--import-calibre-data, 308
--inspect-mobi, 308
--kepubify, 308
--paths, 308
--run-plugin, 308
--run-test, 308
--run-without-debug, 308
--shutdown-running-calibre, 308
--subset-font, 309
--test-build, 309
--un-kepubify, 309
--version, 309
--viewer, 309
-c, 307
-d, 307
-e, 307
-f, 309
-g, 308
-h, 308
-i, 308
-m, 308
-r, 308
-s, 308
-t, 308
-w, 309
-x, 307

calibre-server command line option

--access-log, 309
--ajax-timeout, 309
--auth-mode, 309
--auto-reload, 309
--ban-after, 309
--ban-for, 309
--book-list-mode, 309
--compress-min-size, 310
--custom-list-template, 310
--daemonize, 310
--disable-allow-socket-preallocation,

310
--disable-auth, 310
--disable-fallback-to-detected-

interface, 310
--disable-local-write, 310
--disable-log-not-found, 310
--disable-use-bonjour, 310
--disable-use-sendfile, 310
--displayed-fields, 310
--enable-allow-socket-preallocation, 310
--enable-auth, 310
--enable-fallback-to-detected-

interface, 310
--enable-local-write, 310
--enable-log-not-found, 310
--enable-use-bonjour, 310

--enable-use-sendfile, 310
--help, 310
--ignored-fields, 310
--listen-on, 311
--log, 311
--manage-users, 311
--max-header-line-size, 311
--max-job-time, 311
--max-jobs, 311
--max-log-size, 311
--max-opds-items, 311
--max-opds-ungrouped-items, 311
--max-request-body-size, 311
--num-per-page, 311
--pidfile, 311
--port, 311
--search-the-net-urls, 311
--shutdown-timeout, 312
--ssl-certfile, 312
--ssl-keyfile, 312
--timeout, 312
--trusted-ips, 312
--url-prefix, 312
--userdb, 312
--version, 312
--worker-count, 312
-h, 310

calibre-smtp command line option

--attachment, 313
--cafile, 313
--dont-verify-server-certificate, 313
--encryption-method, 313
--fork, 313
--help, 313
--localhost, 313
--outbox, 313
--password, 313
--port, 313
--relay, 313
--subject, 313
--timeout, 313
--username, 314
--verbose, 313
--version, 313
-a, 313
-e, 313
-f, 313
-h, 313
-l, 313
-o, 313
-p, 313
-r, 313
-s, 313
-t, 313
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-u, 314
-v, 313

calibredb-add command line option

-1, 318
-I, 317
-S, 317
-T, 317
--add, 317
--authors, 317
--automerge, 317
--cover, 317
--duplicates, 317
--empty, 317
--identifier, 317
--ignore, 318
--isbn, 317
--languages, 317
--one-book-per-directory, 318
--recurse, 318
--series, 317
--series-index, 317
--tags, 317
--title, 317
-a, 317
-c, 317
-d, 317
-e, 317
-i, 317
-l, 317
-m, 317
-r, 318
-s, 317
-t, 317

calibredb-add_custom_column command line

option

--display, 323
--is-multiple, 323

calibredb-add_format command line option

--as-extra-data-file, 318
--dont-replace, 318

calibredb-backup_metadata command line op-

tion

--all, 325
calibredb-catalog command line option

--catalog-title, 321
--cross-reference-authors, 321
--debug-pipeline, 321
--exclude-genre, 321
--exclusion-rules, 321
--generate-authors, 321
--generate-descriptions, 321
--generate-genres, 321
--generate-recently-added, 321
--generate-series, 321

--generate-titles, 322
--genre-source-field, 322
--header-note-source-field, 322
--ids, 320
--merge-comments-rule, 322
--output-profile, 322
--prefix-rules, 322
--preset, 322
--search, 321
--thumb-width, 322
--use-existing-cover, 322
--verbose, 321
-i, 320
-s, 321
-v, 321

calibredb-check_library command line option

--csv, 324
--ignore_extensions, 324
--ignore_names, 324
--report, 324
--vacuum-fts-db, 324
-c, 324
-e, 324
-n, 324
-r, 324

calibredb-custom_columns command line opti-

on

--details, 323
-d, 323

calibredb-embed_metadata command line opti-

on

--only-formats, 326
-f, 326

calibredb-export command line option

--all, 319
--dont-asciiize, 319
--dont-save-cover, 320
--dont-save-extra-files, 320
--dont-update-metadata, 320
--dont-write-opf, 320
--formats, 320
--progress, 320
--replace-whitespace, 320
--single-dir, 320
--template, 320
--timefmt, 320
--to-dir, 320
--to-lowercase, 320

calibredb-fts_index command line option

--indexing-speed, 326
--wait-for-completion, 327

calibredb-fts_search command line option

--do-not-match-on-related-words, 327
--include-snippets, 327
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--indexing-threshold, 327
--match-end-marker, 327
--match-start-marker, 327
--output-format, 327
--restrict-to, 327

calibredb-list command line option

--ascending, 316
--fields, 316
--for-machine, 316
--limit, 316
--line-width, 316
--prefix, 316
--search, 316
--separator, 316
--sort-by, 316
--template, 316
--template_file, 316
--template_heading, 316
-f, 316
-s, 316
-t, 316
-w, 316

calibredb-list_categories command line op-

tion

--categories, 325
--csv, 325
--dialect, 325
--item_count, 325
--width, 325
-c, 325
-i, 325
-r, 325
-w, 325

calibredb-remove command line option

--permanent, 318
calibredb-remove_custom_column command line

option

--force, 323
-f, 323

calibredb-restore_database command line op-

tion

--really-do-it, 324
-r, 324

calibredb-search command line option

--limit, 326
-l, 326

calibredb-set_custom command line option

--append, 324
-a, 324

calibredb-set_metadata command line option

--field, 319
--list-fields, 319
-f, 319
-l, 319

calibredb-show_metadata command line option

--as-opf, 319
can_be_disabled (calib-

re.customize.conversion.InputFormatPlugin
attribuut), 267

can_be_disabled (calib-
re.customize.conversion.OutputFormatPlugin
attribuut), 269

can_be_disabled (calib-
re.customize.InterfaceActionBase attribuut),
286

can_be_disabled (calibre.customize.Plugin attribuut),
259

can_be_disabled (calibre.customize.PreferencesPlugin
attribuut), 287

CAN_DO_DEVICE_DB_PLUGBOARD (calib-
re.devices.interface.DevicePlugin attribuut),
270

can_get_multiple_covers (calib-
re.ebooks.metadata.sources.base.Source at-
tribuut), 264

can_handle() (calibre.devices.interface.DevicePlugin
methode), 272

can_handle_windows() (calib-
re.devices.interface.DevicePlugin methode),
272

can_handle_windows() (calib-
re.devices.usbms.device.Device methode),
280

CAN_SET_METADATA (calib-
re.devices.interface.DevicePlugin attribuut),
270

CAN_SET_METADATA (calib-
re.devices.usbms.driver.USBMS attribuut),
281

canonicalize_internal_url() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
42

capabilities (calibre.ebooks.metadata.sources.base.Source
attribuut), 264

card_prefix() (calibre.devices.interface.DevicePlugin
methode), 273

card_prefix() (calibre.devices.usbms.device.Device me-
thode), 279

CatalogPlugin (klasse in calibre.customize), 263
category (calibre.customize.PreferencesPlugin attribuut),

287
category_order (calibre.customize.PreferencesPlugin at-

tribuut), 287
center_navbar (calib-

re.web.feeds.news.BasicNewsRecipe attribuut),
47

change_font() (in module calib-
re.ebooks.oeb.polish.fonts), 370
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changed_signal (calib-
re.gui2.preferences.ConfigWidgetBase attribuut),
288

changed_signal (calib-
re.gui2.preferences.ConfigWidgetInterface
attribuut), 288

clean_downloaded_metadata() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 265

cleanup() (calibre.web.feeds.news.BasicNewsRecipe me-
thode), 42

CLI (klasse in calibre.devices.usbms.cli), 281
cli_main() (calibre.customize.Plugin methode), 260
cli_options (calibre.customize.CatalogPlugin attribuut),

263
clone_browser() (calib-

re.web.feeds.news.BasicNewsRecipe methode),
42

close_editor() (calibre.gui2.tweak_book.boss.Boss
methode), 373

command line option

--help, 315
--library-path, 315
--password, 315
--timeout, 315
--username, 315
--version, 315
--with-library, 315
-h, 315

commit() (calibre.ebooks.oeb.polish.container.Container
methode), 365

commit() (calibre.gui2.preferences.ConfigWidgetBase me-
thode), 289

commit() (calibre.gui2.preferences.ConfigWidgetInterface
methode), 288

commit_all_editors_to_container() (calib-
re.gui2.tweak_book.boss.Boss methode), 373

commit_item() (calib-
re.ebooks.oeb.polish.container.Container me-
thode), 365

common_options (calib-
re.customize.conversion.InputFormatPlugin
attribuut), 268

common_options (calib-
re.customize.conversion.OutputFormatPlugin
attribuut), 269

compress_covers() (calibre.db.cache.Cache methode),
356

compress_news_images (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
47

compress_news_images_auto_size (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
47

compress_news_images_max_size (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
47

config_help_message (calib-
re.ebooks.metadata.sources.base.Source at-
tribuut), 264

config_widget (calibre.customize.PreferencesPlugin at-
tribuut), 287

config_widget() (calibre.customize.Plugin methode),
259

config_widget() (calib-
re.devices.interface.DevicePlugin klassemethode),
275

config_widget() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 265

ConfigWidgetBase (klasse in calibre.gui2.preferences),
288

ConfigWidgetInterface (klasse in calib-
re.gui2.preferences), 287

Container (klasse in calibre.ebooks.oeb.polish.container),
364

conversion_options (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
47

convert() (calibre.customize.conversion.InputFormatPlugin
methode), 268

convert() (calibre.customize.conversion.OutputFormatPlugin
methode), 269

copy_cover_to() (calibre.db.cache.Cache methode),
356

copy_format_to() (calibre.db.cache.Cache methode),
356

core_usage (calibre.customize.conversion.InputFormatPlugin
attribuut), 267

cover() (calibre.db.cache.Cache methode), 356
cover_margins (calib-

re.web.feeds.news.BasicNewsRecipe attribuut),
47

create_action() (calibre.gui2.tweak_book.plugin.Tool
methode), 372

create_inline_toc() (in module calib-
re.ebooks.oeb.polish.toc), 371

create_menu_action() (calib-
re.gui2.actions.InterfaceAction methode), 285

create_widget() (calibre.customize.PreferencesPlugin
methode), 287

CSS, 377
current_container (calib-

re.gui2.tweak_book.plugin.Tool property),
371

currently_editing (calib-
re.gui2.tweak_book.boss.Boss property), 373

custom_field_keys() (calib-
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re.ebooks.metadata.book.base.Metadata me-
thode), 212

customization_help() (calibre.customize.Plugin me-
thode), 260

customization_help() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 264

D
data_for_find_identical_books() (calib-

re.db.cache.Cache methode), 356
data_for_has_book() (calibre.db.cache.Cache metho-

de), 356
debug_managed_device_detection() (calib-

re.devices.interface.DevicePlugin methode),
272

deepcopy() (calibre.ebooks.metadata.book.base.Metadata
methode), 212

default_cover() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
42

delay (calibre.web.feeds.news.BasicNewsRecipe attri-
buut), 47

delete_annotations() (calibre.db.cache.Cache me-
thode), 356

delete_books() (calibre.devices.interface.DevicePlugin
methode), 274

delete_books() (calibre.devices.usbms.driver.USBMS
methode), 283

delete_custom_book_data() (calibre.db.cache.Cache
methode), 356

delete_trash_entry() (calibre.db.cache.Cache me-
thode), 356

description (calibre.customize.conversion.OutputFormatPlugin
property), 269

description (calibre.customize.Plugin attribuut), 258
description (calibre.customize.PreferencesPlugin attri-

buut), 287
description (calibre.devices.usbms.driver.USBMS attri-

buut), 281
description (calibre.web.feeds.news.BasicNewsRecipe

attribuut), 47
detect_managed_devices() (calib-

re.devices.interface.DevicePlugin methode),
271

Device (klasse in calibre.devices.usbms.device), 278
DevicePlugin (klasse in calibre.devices.interface), 270
dirty() (calibre.ebooks.oeb.polish.container.Container

methode), 365
do_user_config() (calibre.customize.Plugin methode),

259
dont_add_to (calibre.gui2.actions.InterfaceAction attri-

buut), 284

dont_remove_from (calibre.gui2.actions.InterfaceAction
attribuut), 284

download() (calibre.web.feeds.news.BasicNewsRecipe
methode), 42

download_cover() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 266

drop_event() (calibre.gui2.actions.InterfaceAction me-
thode), 285

E
ebook-convert command line option

--add-alt-text-to-img, 334
--asciiize, 330
--author-sort, 335
--authors, 335
--base-font-size, 330
--book-producer, 335
--change-justification, 330
--chapter, 334
--chapter-mark, 334
--comments, 335
--cover, 335
--debug-pipeline, 336
--disable-dehyphenate, 332
--disable-delete-blank-paragraphs, 332
--disable-fix-indents, 333
--disable-font-rescaling, 330
--disable-format-scene-breaks, 333
--disable-italicize-common-cases, 333
--disable-markup-chapter-headings, 333
--disable-remove-fake-margins, 334
--disable-renumber-headings, 333
--disable-unwrap-lines, 333
--dont-split-on-page-breaks, 329
--duplicate-links-in-toc, 334
--embed-all-fonts, 330
--embed-font-family, 330
--enable-heuristics, 333
--epub-flatten, 329
--epub-inline-toc, 329
--epub-max-image-size, 329
--epub-toc-at-end, 329
--epub-version, 329
--expand-css, 330
--extra-css, 330
--extract-to, 329
--filter-css, 331
--flow-size, 329
--font-size-mapping, 331
--from-opf, 336
--help, 328
--html-unwrap-factor, 333
--input-encoding, 329
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--input-profile, 328
--insert-blank-line, 331
--insert-blank-line-size, 331
--insert-metadata, 334
--isbn, 335
--keep-ligatures, 331
--language, 335
--level1-toc, 335
--level2-toc, 335
--level3-toc, 335
--line-height, 331
--linearize-tables, 331
--list-recipes, 328
--margin-bottom, 331
--margin-left, 331
--margin-right, 331
--margin-top, 331
--max-toc-links, 335
--minimum-line-height, 332
--no-chapters-in-toc, 335
--no-default-epub-cover, 329
--no-svg-cover, 329
--output-profile, 328
--page-breaks-before, 334
--prefer-metadata-cover, 334
--preserve-cover-aspect-ratio, 330
--pretty-print, 330
--pubdate, 336
--publisher, 336
--rating, 336
--read-metadata-from-opf, 336
--remove-first-image, 334
--remove-paragraph-spacing, 332
--remove-paragraph-spacing-indent-size,

332
--replace-scene-breaks, 333
--search-replace, 333
--series, 336
--series-index, 336
--smarten-punctuation, 332
--sr1-replace, 333
--sr1-search, 333
--sr2-replace, 333
--sr2-search, 333
--sr3-replace, 333
--sr3-search, 333
--start-reading-at, 334
--subset-embedded-fonts, 332
--tags, 336
--timestamp, 336
--title, 336
--title-sort, 336
--toc-filter, 335
--toc-threshold, 335

--toc-title, 330
--transform-css-rules, 332
--transform-html-rules, 332
--unsmarten-punctuation, 332
--use-auto-toc, 335
--verbose, 336
--version, 328
-d, 336
-h, 328
-m, 336
-v, 336

ebook-edit command line option

--detach, 337
--help, 337
--select-text, 337
--version, 337
-h, 337

ebook-meta command line option

--author-sort, 337
--authors, 337
--book-producer, 337
--category, 337
--comments, 337
--cover, 337
--date, 337
--disallow-rendered-cover, 337
--from-opf, 338
--get-cover, 338
--help, 338
--identifier, 338
--index, 338
--isbn, 338
--language, 338
--lrf-bookid, 338
--publisher, 338
--rating, 338
--series, 338
--tags, 338
--title, 338
--title-sort, 338
--to-opf, 338
--version, 338
-a, 337
-c, 337
-d, 337
-h, 338
-i, 338
-k, 337
-l, 338
-p, 338
-r, 338
-s, 338
-t, 338

ebook-polish command line option
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-H, 339
-U, 340
--add-soft-hyphens, 339
--compress-images, 339
--cover, 339
--download-external-resources, 339
--embed-fonts, 339
--help, 339
--jacket, 339
--opf, 339
--remove-jacket, 339
--remove-soft-hyphens, 339
--remove-unused-css, 339
--smarten-punctuation, 340
--subset-fonts, 340
--upgrade-book, 340
--verbose, 340
--version, 340
-c, 339
-d, 339
-e, 339
-f, 340
-h, 339
-i, 339
-j, 339
-o, 339
-p, 340
-u, 339

ebook-viewer command line option

--continue, 340
--detach, 340
--force-reload, 340
--full-screen, 340
--fullscreen, 340
--help, 340
--new-instance, 340
--open-at, 341
--raise-window, 341
--version, 341
-f, 340
-h, 340

edit_file() (calibre.gui2.tweak_book.boss.Boss metho-
de), 373

eject() (calibre.devices.interface.DevicePlugin methode),
273

eject() (calibre.devices.usbms.device.Device methode),
281

embed_metadata() (calibre.db.cache.Cache methode),
357

encoding (calibre.web.feeds.news.BasicNewsRecipe attri-
buut), 48

exists() (calibre.ebooks.oeb.polish.container.Container
methode), 365

expire_old_trash() (calibre.db.cache.Cache metho-
de), 357

export_note() (calibre.db.cache.Cache methode), 357
extra_css (calibre.web.feeds.news.BasicNewsRecipe at-

tribuut), 48
extract_readable_article() (calib-

re.web.feeds.news.BasicNewsRecipe methode),
42

F
fast_field_for() (calibre.db.cache.Cache methode),

357
feeds (calibre.web.feeds.news.BasicNewsRecipe attri-

buut), 48
fetch-ebook-metadata command line option

-I, 341
--allowed-plugin, 341
--authors, 341
--cover, 341
--help, 341
--identifier, 341
--isbn, 341
--opf, 341
--timeout, 341
--title, 341
--verbose, 342
--version, 342
-a, 341
-c, 341
-d, 341
-h, 341
-i, 341
-o, 341
-p, 341
-t, 341
-v, 342

field_for() (calibre.db.cache.Cache methode), 357
field_ids_for() (calibre.db.cache.Cache methode),

357
field_supports_notes() (calibre.db.cache.Cache me-

thode), 357
file_type (calibre.customize.conversion.OutputFormatPlugin

attribuut), 269
file_types (calibre.customize.CatalogPlugin attribuut),

263
file_types (calibre.customize.conversion.InputFormatPlugin

attribuut), 267
file_types (calibre.customize.FileTypePlugin attribuut),

260
file_types (calibre.customize.MetadataReaderPlugin at-

tribuut), 262
file_types (calibre.customize.MetadataWriterPlugin at-

tribuut), 262
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filename_callback() (calib-
re.devices.usbms.device.Device methode),
281

filesize() (calibre.ebooks.oeb.polish.container.Container
methode), 365

FileTypePlugin (klasse in calibre.customize), 260
filter_css() (in module calibre.ebooks.oeb.polish.css),

370
filter_regexps (calib-

re.web.feeds.news.BasicNewsRecipe attribuut),
48

find_identical_books() (calibre.db.cache.Cache me-
thode), 357

fix_all_html() (in module calib-
re.ebooks.oeb.polish.pretty), 368

fix_html() (in module calibre.ebooks.oeb.polish.pretty),
368

for_viewer (calibre.customize.conversion.InputFormatPlugin
attribuut), 267

format() (calibre.db.cache.Cache methode), 357
format_abspath() (calibre.db.cache.Cache methode),

357
format_added (calibre.db.cache.Cache.EventType attri-

buut), 354
format_field() (calib-

re.ebooks.metadata.book.base.Metadata me-
thode), 213

format_hash() (calibre.db.cache.Cache methode), 358
format_metadata() (calibre.db.cache.Cache methode),

358
FORMATS (calibre.devices.interface.DevicePlugin attribuut),

270
FORMATS (calibre.devices.usbms.driver.USBMS attribuut),

281
formats() (calibre.db.cache.Cache methode), 358
formats_removed (calibre.db.cache.Cache.EventType

attribuut), 354
free_space() (calibre.devices.interface.DevicePlugin

methode), 274
free_space() (calibre.devices.usbms.device.Device me-

thode), 280
from_files() (in module calibre.ebooks.oeb.polish.toc),

371
from_links() (in module calibre.ebooks.oeb.polish.toc),

371
from_xpaths() (in module calib-

re.ebooks.oeb.polish.toc), 371

G
generate_item() (calib-

re.ebooks.oeb.polish.container.Container me-
thode), 365

genesis() (calibre.gui2.actions.InterfaceAction metho-
de), 286

genesis() (calibre.gui2.preferences.ConfigWidgetInterface
methode), 288

get_all_items_that_have_notes() (calib-
re.db.cache.Cache methode), 358

get_all_link_maps_for_book() (calib-
re.db.cache.Cache methode), 358

get_all_standard_metadata() (calib-
re.ebooks.metadata.book.base.Metadata me-
thode), 213

get_all_user_metadata() (calib-
re.ebooks.metadata.book.base.Metadata me-
thode), 213

get_annotations() (calib-
re.devices.usbms.device.Device methode),
281

get_article_url() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
43

get_author_tokens() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 265

get_book_url() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 265

get_book_url_name() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 265

get_book_urls() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 265

get_browser() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
43

get_cached_cover_url() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 265

get_categories() (calibre.db.cache.Cache methode),
358

get_collections() (calibre.devices.interface.BookList
methode), 278

get_cover_url() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
43

get_custom_book_data() (calibre.db.cache.Cache me-
thode), 358

get_device_information() (calib-
re.devices.interface.DevicePlugin methode),
273

get_device_information() (calib-
re.devices.usbms.driver.USBMS methode),
282

get_device_uid() (calib-
re.devices.interface.DevicePlugin methode),
276
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get_driveinfo() (calib-
re.devices.interface.DevicePlugin methode),
273

get_extra_css() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
43

get_feeds() (calibre.web.feeds.news.BasicNewsRecipe
methode), 43

get_file() (calibre.devices.interface.DevicePlugin me-
thode), 275

get_file_path_for_processing() (calib-
re.ebooks.oeb.polish.container.Container me-
thode), 365

get_id_map() (calibre.db.cache.Cache methode), 358
get_identifiers() (calib-

re.ebooks.metadata.book.base.Metadata me-
thode), 212

get_ids_for_custom_book_data() (calib-
re.db.cache.Cache methode), 358

get_images() (calibre.customize.conversion.InputFormatPlugin
methode), 268

get_item_id() (calibre.db.cache.Cache methode), 359
get_item_ids() (calibre.db.cache.Cache methode), 359
get_item_name() (calibre.db.cache.Cache methode),

359
get_item_name_map() (calibre.db.cache.Cache metho-

de), 359
get_link_map() (calibre.db.cache.Cache methode), 359
get_masthead_title() (calib-

re.web.feeds.news.BasicNewsRecipe methode),
43

get_masthead_url() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
44

get_metadata() (calib-
re.customize.MetadataReaderPlugin methode),
262

get_metadata() (calibre.db.cache.Cache methode), 359
get_next_series_num_for() (calibre.db.cache.Cache

methode), 359
get_notes_resource() (calibre.db.cache.Cache me-

thode), 359
get_obfuscated_article() (calib-

re.web.feeds.news.BasicNewsRecipe methode),
44

get_open_popup_message() (calib-
re.devices.interface.DevicePlugin klassemethode),
271

get_option() (calibre.devices.interface.DevicePlugin
methode), 276

get_proxy_metadata() (calibre.db.cache.Cache me-
thode), 359

get_recommended_folders() (in module calib-
re.ebooks.oeb.polish.replace), 368

get_standard_metadata() (calib-
re.ebooks.metadata.book.base.Metadata me-
thode), 212

get_title_tokens() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 265

get_url_specific_delay() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
44

get_usage_count_by_id() (calibre.db.cache.Cache
methode), 359

get_user_blacklisted_devices() (calib-
re.devices.interface.DevicePlugin methode),
276

get_user_metadata() (calib-
re.ebooks.metadata.book.base.Metadata me-
thode), 213

gui (calibre.gui2.tweak_book.plugin.Tool property), 371
gui_category (calibre.customize.PreferencesPlugin attri-

buut), 287
gui_configuration_widget() (calib-

re.customize.conversion.InputFormatPlugin
methode), 268

gui_configuration_widget() (calib-
re.customize.conversion.OutputFormatPlugin
methode), 269

gui_layout_complete() (calib-
re.gui2.actions.InterfaceAction methode), 286

gui_name (calibre.customize.PreferencesPlugin attribuut),
287

guide_type_map (calib-
re.ebooks.oeb.polish.container.Container proper-
ty), 365

H
handle_gzip (calibre.web.feeds.news.BasicNewsRecipe

attribuut), 48
has_book() (calibre.db.cache.Cache methode), 359
has_format() (calibre.db.cache.Cache methode), 359
has_html_comments (calib-

re.ebooks.metadata.sources.base.Source at-
tribuut), 264

has_id() (calibre.db.cache.Cache methode), 360
has_name() (calibre.ebooks.oeb.polish.container.Container

methode), 365
href_to_name() (calib-

re.ebooks.oeb.polish.container.Container me-
thode), 365

HTML, 377

I
icon (calibre.customize.PreferencesPlugin attribuut), 287
icon (calibre.devices.interface.DevicePlugin attribuut), 270

Index 403



calibre Gebruikershandleiding, Release 8.7.0

id_from_url() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 266

identify() (calibre.ebooks.metadata.sources.base.Source
methode), 266

identify_results_keygen() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 266

ignore_connected_device() (calib-
re.devices.interface.DevicePlugin methode),
276

ignore_duplicate_articles (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
48

ignore_ssl_errors (calib-
re.ebooks.metadata.sources.base.Source at-
tribuut), 264

image_url_processor() (calib-
re.web.feeds.news.BasicNewsRecipe klasse-
methode), 41

import_note() (calibre.db.cache.Cache methode), 360
index_to_soup() (calib-

re.web.feeds.news.BasicNewsRecipe methode),
44

indexing_progress_changed (calib-
re.db.cache.Cache.EventType attribuut), 354

init() (calibre.db.cache.Cache methode), 360
initial_tab_changed() (calib-

re.gui2.preferences.ConfigWidgetInterface
methode), 288

initialization_complete() (calib-
re.gui2.actions.InterfaceAction methode), 286

initialize() (calibre.customize.CatalogPlugin metho-
de), 263

initialize() (calibre.customize.Plugin methode), 259
initialize() (calibre.gui2.preferences.ConfigWidgetBase

methode), 289
initialize() (calibre.gui2.preferences.ConfigWidgetInterface

methode), 288
InputFormatPlugin (klasse in calib-

re.customize.conversion), 267
insert_into_xml() (calib-

re.ebooks.oeb.polish.container.Container me-
thode), 365

installation_type (calibre.customize.Plugin attri-
buut), 259

InterfaceAction (klasse in calibre.gui2.actions), 283
InterfaceActionBase (klasse in calibre.customize), 286
InternalMetadataCompareKeyGen (klasse in calib-

re.ebooks.metadata.sources.base), 267
is_configured() (calib-

re.ebooks.metadata.sources.base.Source me-
thode), 264

is_dir (calibre.ebooks.oeb.polish.container.Container at-

tribuut), 365
is_dynamically_controllable() (calib-

re.devices.interface.DevicePlugin methode),
276

is_image_collection (calib-
re.customize.conversion.InputFormatPlugin
attribuut), 267

is_link_wanted() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
44

is_null() (calibre.ebooks.metadata.book.base.Metadata
methode), 212

is_running() (calibre.devices.interface.DevicePlugin
methode), 277

is_usb_connected() (calib-
re.devices.interface.DevicePlugin methode),
271

items_removed (calibre.db.cache.Cache.EventType attri-
buut), 354

items_renamed (calibre.db.cache.Cache.EventType attri-
buut), 354

items_with_notes_in_book() (calib-
re.db.cache.Cache methode), 360

iterlinks() (calibre.ebooks.oeb.polish.container.Container
methode), 365

K
keep_only_tags (calib-

re.web.feeds.news.BasicNewsRecipe attribuut),
48

L
language (calibre.web.feeds.news.BasicNewsRecipe attri-

buut), 49
library_about_to_change() (calib-

re.gui2.actions.InterfaceAction methode), 286
library_changed() (calib-

re.gui2.actions.InterfaceAction methode), 286
link_for() (calibre.db.cache.Cache methode), 360
links_changed (calibre.db.cache.Cache.EventType attri-

buut), 354
list_extra_files() (calibre.db.cache.Cache metho-

de), 360
load_actual_plugin() (calib-

re.customize.InterfaceActionBase methode),
287

load_resources() (calibre.customize.Plugin methode),
259

load_resources() (calibre.gui2.actions.InterfaceAction
methode), 285

location_selected() (calib-
re.gui2.actions.InterfaceAction methode), 286

LRF, 377
lrf2lrs command line option
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--dont-output-resources, 342
--help, 342
--output, 342
--verbose, 342
--version, 342
-h, 342
-o, 342

lrfviewer command line option

--disable-hyphenation, 342
--help, 342
--profile, 342
--verbose, 342
--version, 343
--visual-debug, 343
--white-background, 343
-h, 342

lrs2lrf command line option

--help, 343
--lrs, 343
--output, 343
--verbose, 343
--version, 343
-h, 343
-o, 343

M
make_name_unique() (calib-

re.ebooks.oeb.polish.container.Container me-
thode), 366

MANAGES_DEVICE_PRESENCE (calib-
re.devices.interface.DevicePlugin attribuut),
271

manifest_has_name() (calib-
re.ebooks.oeb.polish.container.Container me-
thode), 366

manifest_id_map (calib-
re.ebooks.oeb.polish.container.Container proper-
ty), 366

manifest_items_of_type() (calib-
re.ebooks.oeb.polish.container.Container me-
thode), 366

manifest_items_with_property() (calib-
re.ebooks.oeb.polish.container.Container me-
thode), 366

manifest_type_map (calib-
re.ebooks.oeb.polish.container.Container proper-
ty), 366

mark_as_cover() (in module calib-
re.ebooks.oeb.polish.cover), 370

mark_as_titlepage() (in module calib-
re.ebooks.oeb.polish.cover), 370

masthead_url (calibre.web.feeds.news.BasicNewsRecipe
attribuut), 49

match_regexps (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
49

max_articles_per_feed (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
49

MAX_PATH_LEN (calibre.devices.usbms.device.Device attri-
buut), 279

merge() (in module calibre.ebooks.oeb.polish.split), 369
merge_annotations_for_book() (calib-

re.db.cache.Cache methode), 360
merge_extra_files() (calibre.db.cache.Cache metho-

de), 360
Metadata (klasse in calibre.ebooks.metadata.book.base),

212
metadata_changed (calibre.db.cache.Cache.EventType

attribuut), 354
metadata_for_field() (calib-

re.ebooks.metadata.book.base.Metadata me-
thode), 212

MetadataReaderPlugin (klasse in calibre.customize),
262

MetadataWriterPlugin (klasse in calibre.customize),
262

mi (calibre.ebooks.oeb.polish.container.Container proper-
ty), 366

minimum_calibre_version (calibre.customize.Plugin
attribuut), 259

model_metadata() (calib-
re.devices.interface.DevicePlugin klassemethode),
271

model_metadata() (calibre.devices.usbms.device.Device
klassemethode), 279

module

calibre.customize, 258
calibre.customize.conversion, 267
calibre.db.cache, 353
calibre.devices.interface, 270
calibre.ebooks.metadata.book.base, 212
calibre.ebooks.metadata.sources.base,

264
calibre.ebooks.oeb.polish.container, 364
calibre.ebooks.oeb.polish.cover, 369
calibre.ebooks.oeb.polish.css, 370
calibre.ebooks.oeb.polish.jacket, 369
calibre.ebooks.oeb.polish.pretty, 368
calibre.ebooks.oeb.polish.replace, 368
calibre.ebooks.oeb.polish.split, 369
calibre.ebooks.oeb.polish.toc, 371
calibre.gui2.tweak_book.boss, 372
calibre.utils.formatter_functions, 185
calibre.web.feeds.news, 41

move_book_from_trash() (calibre.db.cache.Cache me-
thode), 360
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move_format_from_trash() (calibre.db.cache.Cache
methode), 360

multisort() (calibre.db.cache.Cache methode), 360
multisplit() (in module calibre.ebooks.oeb.polish.split),

369

N
naam(), 161
name (calibre.customize.Plugin attribuut), 258
name (calibre.gui2.actions.InterfaceAction attribuut), 284
name (calibre.gui2.tweak_book.plugin.Tool attribuut), 371
name_order (calibre.customize.PreferencesPlugin attri-

buut), 287
name_to_abspath() (calib-

re.ebooks.oeb.polish.container.Container me-
thode), 366

name_to_href() (calib-
re.ebooks.oeb.polish.container.Container me-
thode), 366

names_that_must_not_be_changed (calib-
re.ebooks.oeb.polish.container.Container proper-
ty), 366

names_that_must_not_be_removed (calib-
re.ebooks.oeb.polish.container.Container proper-
ty), 366

names_that_need_not_be_manifested (cali-
bre.ebooks.oeb.polish.container.Container
property), 366

needs_subscription (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
49

NEWS_IN_FOLDER (calibre.devices.usbms.device.Device
attribuut), 279

no_stylesheets (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
49

normalize_path() (calib-
re.devices.usbms.driver.USBMS klassemethode),
283

notes_changed (calibre.db.cache.Cache.EventType attri-
buut), 354

notes_data_for() (calibre.db.cache.Cache methode),
360

notes_for() (calibre.db.cache.Cache methode), 360
notes_resources_used_by() (calibre.db.cache.Cache

methode), 360
NUKE_COMMENTS (calibre.devices.interface.DevicePlugin

attribuut), 271

O
oldest_article (calib-

re.web.feeds.news.BasicNewsRecipe attribuut),
49

on_import (calibre.customize.FileTypePlugin attribuut),
260

on_postconvert (calibre.customize.FileTypePlugin attri-
buut), 260

on_postdelete (calibre.customize.FileTypePlugin attri-
buut), 260

on_postimport (calibre.customize.FileTypePlugin attri-
buut), 260

on_postprocess (calibre.customize.FileTypePlugin attri-
buut), 260

on_preprocess (calibre.customize.FileTypePlugin attri-
buut), 260

open() (calibre.devices.interface.DevicePlugin methode),
272

open() (calibre.devices.usbms.device.Device methode),
280

open() (calibre.ebooks.oeb.polish.container.Container me-
thode), 366

open_book() (calibre.gui2.tweak_book.boss.Boss metho-
de), 373

OPEN_FEEDBACK_MESSAGE (calib-
re.devices.interface.DevicePlugin attribuut),
271

opf (calibre.ebooks.oeb.polish.container.Container proper-
ty), 366

opf_get_or_create() (calib-
re.ebooks.oeb.polish.container.Container me-
thode), 366

opf_version (calibre.ebooks.oeb.polish.container.Container
property), 366

opf_version_parsed (calib-
re.ebooks.oeb.polish.container.Container proper-
ty), 366

opf_xpath() (calibre.ebooks.oeb.polish.container.Container
methode), 367

options (calibre.customize.conversion.InputFormatPlugin
attribuut), 268

options (calibre.customize.conversion.OutputFormatPlugin
attribuut), 269

options (calibre.ebooks.metadata.sources.base.Source at-
tribuut), 264

OSX_MAIN_MEM_VOL_PAT (calib-
re.devices.usbms.device.Device attribuut),
279

output_encoding (calib-
re.customize.conversion.InputFormatPlugin
attribuut), 267

OutputFormatPlugin (klasse in calib-
re.customize.conversion), 268

P
parse_feeds() (calib-

re.web.feeds.news.BasicNewsRecipe methode),
44
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parse_index() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
44

parsed() (calibre.ebooks.oeb.polish.container.Container
methode), 367

path_sep (calibre.devices.interface.DevicePlugin attri-
buut), 270

Plugin (klasse in calibre.customize), 258
populate_article_metadata() (calib-

re.web.feeds.news.BasicNewsRecipe methode),
45

popup_type (calibre.gui2.actions.InterfaceAction attri-
buut), 284

post_yank_cleanup() (calib-
re.devices.interface.DevicePlugin methode),
273

post_yank_cleanup() (calib-
re.devices.usbms.device.Device methode),
281

postadd() (calibre.customize.FileTypePlugin methode),
261

postconvert() (calibre.customize.FileTypePlugin me-
thode), 261

postdelete() (calibre.customize.FileTypePlugin metho-
de), 261

postimport() (calibre.customize.FileTypePlugin metho-
de), 261

postprocess_book() (calib-
re.customize.conversion.InputFormatPlugin
methode), 268

postprocess_book() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
45

postprocess_html() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
45

pref() (calibre.db.cache.Cache methode), 361
prefer_results_with_isbn (calib-

re.ebooks.metadata.sources.base.Source at-
tribuut), 264

PreferencesPlugin (klasse in calibre.customize), 287
prepare_addable_books() (calib-

re.devices.interface.DevicePlugin methode),
275

preprocess_html() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
45

preprocess_image() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
45

preprocess_raw_html() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
46

preprocess_regexps (calib-

re.web.feeds.news.BasicNewsRecipe attribuut),
49

pretty_all() (in module calib-
re.ebooks.oeb.polish.pretty), 369

pretty_css() (in module calib-
re.ebooks.oeb.polish.pretty), 368

pretty_html() (in module calib-
re.ebooks.oeb.polish.pretty), 368

pretty_xml() (in module calib-
re.ebooks.oeb.polish.pretty), 369

print_version() (calib-
re.web.feeds.news.BasicNewsRecipe klasse-
methode), 41

priority (calibre.customize.Plugin attribuut), 259
priority (calibre.gui2.actions.InterfaceAction attribuut),

284
PRODUCT_ID (calibre.devices.interface.DevicePlugin attri-

buut), 270
PRODUCT_ID (calibre.devices.usbms.device.Device attri-

buut), 279
publication_date() (calib-

re.web.feeds.news.BasicNewsRecipe methode),
46

publication_type (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
49

R
raw_data() (calibre.ebooks.oeb.polish.container.Container

methode), 367
re:test(), 161
read_backup() (calibre.db.cache.Cache methode), 361
recept, 377
recipe_disabled (calib-

re.web.feeds.news.BasicNewsRecipe attribuut),
49

recipe_specific_options (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
49

recommendations (calib-
re.customize.conversion.InputFormatPlugin
attribuut), 268

recommendations (calib-
re.customize.conversion.OutputFormatPlugin
attribuut), 269

recursions (calibre.web.feeds.news.BasicNewsRecipe at-
tribuut), 50

refresh_gui() (calib-
re.gui2.preferences.ConfigWidgetInterface
methode), 288

regexp, 377
register() (calibre.gui2.preferences.ConfigWidgetBase

methode), 289
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register_shortcut() (calib-
re.gui2.tweak_book.plugin.Tool methode),
371

relpath() (calibre.ebooks.oeb.polish.container.Container
methode), 367

remove_attributes (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
50

remove_book() (calibre.devices.interface.BookList me-
thode), 278

remove_books() (calibre.db.cache.Cache methode), 361
remove_books_from_metadata() (calib-

re.devices.interface.DevicePlugin klassemethode),
275

remove_books_from_metadata() (calib-
re.devices.usbms.driver.USBMS methode),
283

remove_empty_feeds (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
50

remove_extra_files() (calibre.db.cache.Cache me-
thode), 361

remove_formats() (calibre.db.cache.Cache methode),
361

remove_from_spine() (calib-
re.ebooks.oeb.polish.container.Container me-
thode), 367

remove_from_xml() (calib-
re.ebooks.oeb.polish.container.Container me-
thode), 367

remove_item() (calib-
re.ebooks.oeb.polish.container.Container me-
thode), 367

remove_items() (calibre.db.cache.Cache methode), 361
remove_jacket() (in module calib-

re.ebooks.oeb.polish.jacket), 369
remove_javascript (calib-

re.web.feeds.news.BasicNewsRecipe attribuut),
50

remove_stale_user_metadata() (calib-
re.ebooks.metadata.book.base.Metadata me-
thode), 213

remove_tags (calibre.web.feeds.news.BasicNewsRecipe
attribuut), 50

remove_tags_after (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
50

remove_tags_before (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
50

remove_unused_css() (in module calib-
re.ebooks.oeb.polish.css), 370

rename() (calibre.ebooks.oeb.polish.container.Container
methode), 367

rename_extra_files() (calibre.db.cache.Cache me-
thode), 361

rename_files() (in module calib-
re.ebooks.oeb.polish.replace), 368

rename_items() (calibre.db.cache.Cache methode), 361
replace() (calibre.ebooks.oeb.polish.container.Container

methode), 367
replace_links() (calib-

re.ebooks.oeb.polish.container.Container me-
thode), 367

replace_links() (in module calib-
re.ebooks.oeb.polish.replace), 368

requires_version (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
51

reset() (calibre.devices.interface.DevicePlugin methode),
272

reset() (calibre.devices.usbms.device.Device methode),
279

resolve_internal_links (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
51

restart_critical (calib-
re.gui2.preferences.ConfigWidgetBase attribuut),
289

restart_critical (calib-
re.gui2.preferences.ConfigWidgetInterface
attribuut), 288

restore_book() (calibre.db.cache.Cache methode), 361
restore_defaults() (calib-

re.gui2.preferences.ConfigWidgetBase methode),
289

restore_defaults() (calib-
re.gui2.preferences.ConfigWidgetInterface
methode), 288

restore_defaults_desc (calib-
re.gui2.preferences.ConfigWidgetInterface
attribuut), 288

restore_original_format() (calibre.db.cache.Cache
methode), 361

reverse_article_order (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
51

rewind_savepoint() (calib-
re.gui2.tweak_book.boss.Boss methode), 373

RSS, 377
run() (calibre.customize.CatalogPlugin methode), 263
run() (calibre.customize.FileTypePlugin methode), 261

S
safe_read_lock (calibre.db.cache.Cache property), 361
sanitize_callback() (calib-

re.devices.usbms.device.Device methode),
281
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sanitize_path_components() (calib-
re.devices.usbms.device.Device methode),
281

save_book() (calibre.gui2.tweak_book.boss.Boss metho-
de), 373

save_original_format() (calibre.db.cache.Cache me-
thode), 362

save_settings() (calibre.customize.Plugin methode),
259

save_settings() (calib-
re.devices.interface.DevicePlugin klassemethode),
275

save_settings() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 265

scale_news_images (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
51

scale_news_images_to_device (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
51

search() (calibre.db.cache.Cache methode), 362
search_annotations() (calibre.db.cache.Cache me-

thode), 362
search_notes() (calibre.db.cache.Cache methode), 362
serialize_item() (calib-

re.ebooks.oeb.polish.container.Container me-
thode), 367

set_all_user_metadata() (calib-
re.ebooks.metadata.book.base.Metadata me-
thode), 213

set_annotations_for_book() (calib-
re.db.cache.Cache methode), 362

set_conversion_options() (calibre.db.cache.Cache
methode), 362

set_cover() (calibre.db.cache.Cache methode), 362
set_cover() (in module calibre.ebooks.oeb.polish.cover),

369
set_driveinfo_name() (calib-

re.devices.interface.DevicePlugin methode),
275

set_driveinfo_name() (calib-
re.devices.usbms.driver.USBMS methode),
282

set_field() (calibre.db.cache.Cache methode), 362
set_identifier() (calib-

re.ebooks.metadata.book.base.Metadata me-
thode), 212

set_identifiers() (calib-
re.ebooks.metadata.book.base.Metadata me-
thode), 212

set_library_info() (calib-
re.devices.interface.DevicePlugin methode),
276

set_link_map() (calibre.db.cache.Cache methode), 362
set_metadata() (calib-

re.customize.MetadataWriterPlugin methode),
263

set_metadata() (calibre.db.cache.Cache methode), 363
set_modified() (calibre.gui2.tweak_book.boss.Boss

methode), 373
set_notes_for() (calibre.db.cache.Cache methode),

363
set_option() (calibre.devices.interface.DevicePlugin

methode), 277
set_plugboards() (calib-

re.devices.interface.DevicePlugin methode),
275

set_pref() (calibre.db.cache.Cache methode), 363
set_progress_reporter() (calib-

re.devices.interface.DevicePlugin methode),
273

set_progress_reporter() (calib-
re.devices.usbms.device.Device methode),
279

set_spine() (calibre.ebooks.oeb.polish.container.Container
methode), 367

set_user_blacklisted_devices() (calib-
re.devices.interface.DevicePlugin methode),
276

set_user_metadata() (calib-
re.ebooks.metadata.book.base.Metadata me-
thode), 213

settings() (calibre.devices.interface.DevicePlugin klas-
semethode), 275

show_current_diff() (calib-
re.gui2.tweak_book.boss.Boss methode), 373

show_editor() (calibre.gui2.tweak_book.boss.Boss me-
thode), 373

shutdown() (calibre.devices.interface.DevicePlugin me-
thode), 276

shutting_down() (calibre.gui2.actions.InterfaceAction
methode), 286

simultaneous_downloads (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
51

skip_ad_pages() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
46

SLOW_DRIVEINFO (calibre.devices.interface.DevicePlugin
attribuut), 271

smart_update() (calib-
re.ebooks.metadata.book.base.Metadata me-
thode), 213

sort_index_by() (calib-
re.web.feeds.news.BasicNewsRecipe methode),
46

Source (klasse in calibre.ebooks.metadata.sources.base),
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264
specialize() (calibre.customize.conversion.InputFormatPlugin

methode), 268
specialize_css_for_output() (calib-

re.customize.conversion.OutputFormatPlugin
methode), 269

specialize_global_preferences() (calib-
re.devices.interface.DevicePlugin methode),
276

specialize_options() (calib-
re.customize.conversion.OutputFormatPlugin
methode), 269

spine_items (calibre.ebooks.oeb.polish.container.Container
property), 368

spine_iter (calibre.ebooks.oeb.polish.container.Container
property), 368

spine_names (calibre.ebooks.oeb.polish.container.Container
property), 368

split() (in module calibre.ebooks.oeb.polish.split), 369
split_if_is_multiple_composite() (calib-

re.db.cache.Cache methode), 363
split_jobs() (calibre.ebooks.metadata.sources.base.Source

methode), 265
standard_field_keys() (calib-

re.ebooks.metadata.book.base.Metadata me-
thode), 212

STANDARD_METADATA_FIELDS (in module calib-
re.ebooks.metadata.book.base), 213

start_plugin() (calibre.devices.interface.DevicePlugin
methode), 276

startup() (calibre.devices.interface.DevicePlugin metho-
de), 276

stop_plugin() (calibre.devices.interface.DevicePlugin
methode), 276

summary_length (calib-
re.web.feeds.news.BasicNewsRecipe attribuut),
51

supported_platforms (calib-
re.customize.conversion.InputFormatPlugin
attribuut), 267

supported_platforms (calib-
re.customize.conversion.OutputFormatPlugin
attribuut), 269

supported_platforms (calib-
re.customize.InterfaceActionBase attribuut),
286

supported_platforms (calib-
re.customize.MetadataReaderPlugin attribuut),
262

supported_platforms (calib-
re.customize.MetadataWriterPlugin attribuut),
262

supported_platforms (calibre.customize.Plugin attri-
buut), 258

supported_platforms (calib-
re.customize.PreferencesPlugin attribuut),
287

supported_platforms (calib-
re.devices.usbms.driver.USBMS attribuut),
281

supported_platforms (calib-
re.ebooks.metadata.sources.base.Source at-
tribuut), 264

supports_collections() (calib-
re.devices.interface.BookList methode), 277

supports_gzip_transfer_encoding (calib-
re.ebooks.metadata.sources.base.Source at-
tribuut), 264

supports_restoring_to_defaults (calib-
re.gui2.preferences.ConfigWidgetBase attribuut),
288

supports_restoring_to_defaults (calib-
re.gui2.preferences.ConfigWidgetInterface
attribuut), 288

sync_booklists() (calib-
re.devices.interface.DevicePlugin methode),
275

sync_booklists() (calib-
re.devices.usbms.driver.USBMS methode),
283

sync_preview_to_editor() (calib-
re.gui2.tweak_book.boss.Boss methode), 374

synchronize_with_db() (calib-
re.devices.interface.DevicePlugin methode),
277

T
tag_browser_context_action() (calib-

re.gui2.actions.InterfaceAction methode), 286
tag_to_string() (calib-

re.web.feeds.news.BasicNewsRecipe klasse-
methode), 42

tags_older_than() (calibre.db.cache.Cache methode),
363

template_css (calibre.web.feeds.news.BasicNewsRecipe
attribuut), 51

template_to_attribute() (calib-
re.ebooks.metadata.book.base.Metadata me-
thode), 213

temporary_file() (calibre.customize.Plugin methode),
260

test_fields() (calib-
re.ebooks.metadata.sources.base.Source me-
thode), 265

THUMBNAIL_COMPRESSION_QUALITY (calib-
re.devices.interface.DevicePlugin attribuut),
270

THUMBNAIL_HEIGHT (calib-
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re.devices.interface.DevicePlugin attribuut),
270

timefmt (calibre.web.feeds.news.BasicNewsRecipe attri-
buut), 51

timeout (calibre.web.feeds.news.BasicNewsRecipe attri-
buut), 51

title (calibre.web.feeds.news.BasicNewsRecipe attri-
buut), 51

to_html() (calibre.ebooks.metadata.book.base.Metadata
methode), 213

Tool (klasse in calibre.gui2.tweak_book.plugin), 371
toolbar_button_popup_mode (calib-

re.gui2.tweak_book.plugin.Tool attribuut),
371

total_space() (calibre.devices.interface.DevicePlugin
methode), 273

total_space() (calibre.devices.usbms.device.Device me-
thode), 280

touched_fields (calib-
re.ebooks.metadata.sources.base.Source at-
tribuut), 264

type (calibre.customize.CatalogPlugin attribuut), 263
type (calibre.customize.conversion.InputFormatPlugin at-

tribuut), 267
type (calibre.customize.conversion.OutputFormatPlugin at-

tribuut), 268
type (calibre.customize.FileTypePlugin attribuut), 261
type (calibre.customize.InterfaceActionBase attribuut), 286
type (calibre.customize.MetadataReaderPlugin attribuut),

262
type (calibre.customize.MetadataWriterPlugin attribuut),

263
type (calibre.customize.Plugin attribuut), 259
type (calibre.customize.PreferencesPlugin attribuut), 287
type (calibre.devices.interface.DevicePlugin attribuut), 270
type (calibre.ebooks.metadata.sources.base.Source attri-

buut), 264

U
unretire_note_for() (calibre.db.cache.Cache metho-

de), 363
update_annotations() (calibre.db.cache.Cache me-

thode), 363
upload_books() (calibre.devices.interface.DevicePlugin

methode), 274
upload_books() (calibre.devices.usbms.driver.USBMS

methode), 282
upload_cover() (calibre.devices.usbms.driver.USBMS

methode), 282
URL, 377
USBMS (klasse in calibre.devices.usbms.driver), 281
use_embedded_content (calib-

re.web.feeds.news.BasicNewsRecipe attribuut),
51

user_categories_for_books() (calib-
re.db.cache.Cache methode), 363

user_feedback_after_callback (calib-
re.devices.interface.DevicePlugin attribuut),
271

UserAnnotation (calibre.devices.interface.DevicePlugin
attribuut), 271

V
VENDOR_ID (calibre.devices.interface.DevicePlugin attri-

buut), 270
VENDOR_ID (calibre.devices.usbms.device.Device attri-

buut), 278
version (calibre.customize.MetadataReaderPlugin attri-

buut), 262
version (calibre.customize.MetadataWriterPlugin attri-

buut), 262
version (calibre.customize.Plugin attribuut), 258
VIRTUAL_BOOK_EXTENSION_MESSAGE (calib-

re.devices.interface.DevicePlugin attribuut),
271

VIRTUAL_BOOK_EXTENSIONS (calib-
re.devices.interface.DevicePlugin attribuut),
271

W
WANTS_UPDATED_THUMBNAILS (calib-

re.devices.interface.DevicePlugin attribuut),
270

web2disk command line option

--base-dir, 343
--delay, 343
--dont-download-stylesheets, 343
--encoding, 344
--filter-regexp, 344
--help, 344
--match-regexp, 344
--max-files, 344
--max-recursions, 344
--timeout, 344
--verbose, 344
--version, 344
-d, 343
-h, 344
-n, 344
-r, 344
-t, 344

WINDOWS_CARD_A_MEM (calib-
re.devices.usbms.device.Device attribuut),
279

WINDOWS_CARD_B_MEM (calib-
re.devices.usbms.device.Device attribuut),
279
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WINDOWS_MAIN_MEM (calibre.devices.usbms.device.Device
attribuut), 279

windows_sort_drives() (calib-
re.devices.usbms.device.Device methode),
280
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